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About This Manual

The Aspen Plus User Guide consists of three volumes that provide step-by-step
instructions for using Aspen Plus® to build and use a process simulation model.

Volume 1 describes the Aspen Plus user interface and explains how to perform
the basic tasks for creating and running simulations. Topics include:
• Creating a simulation model
• Defining the flowsheet
• Entering the required information, such as components, streams and physical

property data
• Running the simulation
• Examining results

Volume 2 contains procedures for using additional Aspen Plus capabilities:
• Convergence
• Sensitivity
• Design specifications
• Optimization
• Property analysis
• Data regression

Volume 3 contains information about:
• Pressure relief calculations
• Stream libraries

• Working with other Windows™ programs

• The Aspen Plus ActiveX® automation interface
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For More Information

Online Help  Aspen Plus has a complete system of online help and
context-sensitive prompts. The help system contains both context-sensitive help
and reference information. For more information about using Aspen Plus help,
see the Aspen Plus User Guide, Chapter 3.

Aspen Plus application examples  A suite of sample online Aspen Plus
simulations illustrating specific processes is delivered with Aspen Plus.

Aspen Plus Installation Guide for Windows   This guide provides instructions on
installation of Aspen Plus.

Aspen Plus Getting Started Building and Running a Process Model  This
tutorial includes several hands-on sessions to familiarize you with Aspen Plus.
The guide takes you step-by-step to learn the full power and scope of Aspen Plus.

Aspen Plus Getting Started Modeling Processes with Electrolytes  This tutorial
includes several hands-on sessions to familiarize you with simulating electrolyte
systems with Aspen Plus.

Aspen Plus Getting Started Modeling Petroleum Processes  This tutorial
includes several hands-on sessions to familiarize you with simulating petroleum
processes with Aspen Plus.

Aspen Plus Getting Started Customizing Unit Operation Models  This tutorial
includes several hands-on sessions to familiarize you with the customization of
unit operation models with Aspen Plus.

Aspen Plus Getting Started Modeling Processes with Solids  This tutorial
includes several hands-on sessions to familiarize you with simulating systems
containing solids with Aspen Plus.

Aspen Plus User Guide  The three-volume Aspen Plus User Guide provides
step-by-step procedures for developing and using an Aspen Plus process
simulation model. The guide is task-oriented to help you accomplish the
engineering work you need to do, using the powerful capabilities of Aspen Plus.
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Aspen Plus reference manual series  Aspen Plus reference manuals provide
detailed technical reference information. These manuals include background
information about the unit operation models and the physical properties methods
and models available in Aspen Plus, tables of Aspen Plus databank parameters,
group contribution method functional groups, and a wide range of other reference
information. The set comprises:
• Unit Operation Models

• Physical Property Methods and Models

• Physical Property Data

• User Models

• System Management

• System Administration

• Summary File Toolkit

• Input Language Guide

The Aspen Plus manuals are delivered in Adobe portable document format (PDF)
on the Aspen Plus Documentation CD.

Technical Support

World Wide Web  For additional information about AspenTech products and
services, check the AspenTech World Wide Web home page on the Internet at:
http://www.aspentech.com/

Technical resources  AspenTech customers with a valid license and software
maintenance agreement can register to access the Online Technical Support
Center at http://support.aspentech.com/

This web support site allows you to:
• Access current product documentation
• Search for tech tips, solutions and frequently asked questions (FAQs)
• Search for and download application examples
• Submit and track technical issues
• Send suggestions
• Report product defects
• Review lists of known deficiencies and defects
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Registered users can also subscribe to our Technical Support e-Bulletins. These
e-Bulletins are used to proactively alert users to important technical support
information such as:
• Technical advisories
• Product updates and Service Pack announcements

The most up-to-date contact information for your nearest support office is also
available on AspenTech's web page at http://support.aspentech.com/

The following contact information was current when this product was released:

If you are located in: Phone Number Fax Number E-Mail Address

North America & the Caribbean +1-617/949-1021

+1-888/996-7001
     (toll free)

+1-617/949-1724 support@aspentech.com

South America
   (Argentina office)

   (Brazil office)

+54-11/4393-5308

+55-11/5012-0321

+54-11/4394-8621

+55-11/5012-4442

tecnoba@aspentech.com

tecnosp@aspentech.com

Europe, Gulf Region, & Africa
   (Brussels office)

   (UK office)

+32-2/724-0100

+44-1223/312220

+32-2/705-4034

+44-1223/366980

atesupport@aspentech.com

Japan +81-3/3262-1743 +81-3/3262-1744 atjsupport@aspentech.com

Asia &  Australia
(Singapore office)

+65/295-83-30 +65/295-83-25 atasupport@aspentech.com

❖     ❖     ❖     ❖ 
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1 The User Interface

This chapter provides basic information on the Aspen Plus user interface. For
information on how to use Aspen Plus to create a simulation model, see
Chapter 2. If you are new to Aspen Plus, do the exercises in Aspen Plus Getting
Started Building and Running a Process Model before using this manual.

This chapter explains the following topics:
• Starting Aspen Plus
• Aspen Plus windows
• Displaying, browsing, and completing forms
• Using Next—the Expert Guidance System

For more information on getting help on buttons, menus and other screen items,
see Chapter 3.
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Starting Aspen Plus

To start Aspen Plus:

1. Click Start, and then point to Programs

2. Point to AspenTech, point to Aspen Plus and then click Aspen Plus User
Interface.

3. In the startup dialog box, choose whether you want to create a new
simulation using a blank simulation or a Template, or open an existing
simulation.
If you choose to create a new run from a Template, you will be prompted to
specify the Template and Run Type for the new run . See Chapter 2 for more
information on creating a new run.
Perform the remaining steps only if you are opening an existing run.

4. To open an existing simulation, either select the filename from the list in the
startup dialog box, or select More Files, and click OK.
If you select a file from the startup dialog box, the Aspen Plus main window
appears with the chosen file displayed. If you choose More Files, the Open
dialog box appears.
Perform the remaining steps only if you chose More Files.

5. In the Open dialog box, in the Files of Type box, select the file format in
which the run was saved. For example, Aspen Plus Document format (.apw)
or Backup file format (.bkp).  See Chapter 16 for more information on file
formats and saving runs.

6. Use the Look In list box to locate the directory where the file is stored, then
click the file you want to open, and click Open.
If the Connect to Engine dialog box appears, see Connecting to the
Aspen Plus Host Computer on page 1-3.

Tip  To open an existing file quickly, just double-click the file from Windows
Explorer.
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Connecting to the Aspen Plus Host
Computer

Use this section if:
• The Aspen Plus simulation engine is not installed on your PC
• The Aspen Plus simulation engine is installed on your PC and you are using

the network license manager.

Skip this section if you are using the Activator security device on your PC.

These instructions assume that you are connected to the computer where the
Aspen Plus simulation engine will run. See your Aspen Plus system
administrator for information specific to your installation.

1. Start Aspen Plus and select a previous run, template, or blank simulation.
The Connect to Engine dialog box appears.

2. Specify where the Aspen Plus engine will run:

Server Type If the Aspen Plus engine runs on

Local PC Your PC, using the network license manager

Windows NT server A Windows NT server

3. If you specified Windows NT server, enter the following information in the
dialog box:

Enter this information In this box

The type of Aspen Plus engine you want to connect to Server Type

Node name of the computer the Aspen Plus simulation will run on Node Name

Your logon name on the host computer User Name

Password for your account on the host computer Password

Working directory on the host computer for Aspen Plus runs Working Directory

4. When the network connection is established, a message box appears saying
Connection Established.
If the Connection Established box does not appear, see the Aspen Plus system
administrator at your site for more information on network protocols and
Aspen Plus host computers.
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Tip It is possible to change the Connection by selecting Connect to Engine
from the Run menu.

Tip You can specify additional host settings in the Settings dialog box. To do
this, from the Run menu, click Settings.

The Aspen Plus Main Window

When you start Aspen Plus, the main window appears:

Titlebar Menu bar

Toolbars

Next
button

Process
Flowsheet
window

Select
Mode
button

Model Library

Status Bar

Use the workspace to create and display simulation flowsheets and PFD-style
drawings. You can open other windows, such as Plot windows or Data Browser
windows, from the Aspen Plus main window.

Tip  You can display a window by selecting it from the Window menu. You can
arrange the windows by selecting Tile or Cascade from the Window menu.
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The parts of the Aspen Plus main window are:

Window Part Description

Titlebar Horizontal bar at top of window that displays the Run ID.
Simulation 1 is the default ID until you give the run a name.

Menubar Horizontal bar below the titlebar. Gives the names of the available menus.

Toolbar Horizontal bar below the menubar. Contains buttons that when clicked, perform commands.

Next Button Invokes the Aspen Plus expert system. Guides you through the steps required to complete
your simulation.

Status Area Displays status information about the current run.

Select Mode button Turns off Insert mode for inserting objects, and returns you to Select mode.

Process Flowsheet Window Window where you construct the flowsheet

Model Library Area at the bottom of the main window. Lists available unit operation models.

Use the buttons on the toolbars to perform actions quickly and easily.

The default toolbars are shown here:

Standard toolbar
Data Browser
toolbar

Simulation Run
toolbar

Process Flowsheet toolbar CAPE-OPEN toolbar Detherm toolbar

For information on viewing different toolbars, click here. see chapter 16

The Process Flowsheet Window

The Process Flowsheet window is where you create and display simulation
flowsheets and PFD-style drawings.
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You can display the process flowsheet window in three different ways:

To display the
Process Flowsheet window as

From the Window menu, click

A normal window Normal

A window always in the background Flowsheet as Wallpaper

A sheet of a workbook Workbook mode

The Model Library

Use the Model Library to select unit operation models and icons that you want
placed on the flowsheet. The Model Library appears at the bottom of the
Aspen Plus main window.
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To select a unit operation model:

1. Click the tab that corresponds to the type of model you want to place in the
flowsheet.

2. Click the unit operation model on the sheet.

3. To select a different icon for a model, click the down arrow next to the model
icon to see alternate icons. The icon you select will appear for that model in
the Model Library.

4. When you have selected a model, click the flowsheet where you want to place
the model.
When you place blocks this way, you are in Insert mode.  Each time you click
in the Process Flowsheet window, you place a block of the model type that you
specified.  To exit Insert mode and return to Select mode, click the Mode
Select Button on the upper left of the Model Library.

Tip  You can also place blocks in your flowsheet by dragging and dropping from
the Model Library to the Process Flowsheet window.

To select the stream type:

1. Click the down arrow next to the stream type displayed in the Model Library.

2. Select the stream type you want to place in the flowsheet.

3. Once a stream type is selected, simply click the ports on the flowsheet where
you want to connect the stream.

When placing blocks and streams, the mouse pointer changes to the crosshair
shape, indicating Insert Mode. After placing each block or stream, you remain in
Insert Mode until you click the Select Mode button in the upper right corner of
the Model Library.  For more information on what the mouse pointers mean, see
Chapter 4.

Tip   You can undock the Model Library and use it as a floating palette. You can
also dock the Model Library under the toolbar.

For more details and examples for setting up a flowsheet, see Getting Started,
Building and Running a Process Model.



The User
Interface

1-8 Aspen Plus User Guide
Version 10.2

The Data Browser

The Data Browser is a sheet and form viewer with a hierarchical tree view of the
available simulation input, results, and objects that have been defined.

To open the Data Browser:

➤ Click the Data Browser button  on the Data Browser toolbar.
– or –

➤ From the Data menu, click Data Browser.

The Data Browser also appears when you open any form.

Go to a
different
folder

Menu tree

Folder list

Up One
L l

Units
box

Go
 forward

Go
back

Previous
 sheet

Input/Results
 View menu

Next sheet

Next

Status

Comments

Form
(consisting
of sheets)

Prompt areaStatus bar

Use the Data Browser to:
• Display forms and sheets and manipulate objects
• View multiple forms and sheets without returning to the Data menu, for

example, when checking Properties Parameters input
• Edit the sheets that define the input for the flowsheet simulation
• Check the status and contents of a run
• See what results are available
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The parts of the Data Browser window are:

Window Part Description

Form Displays sheets where you can enter data or view results

Menu Tree Hierarchical tree of folders and forms

Status Bar Displays status information about the current block, stream
 or other object

Prompt Area Provides information to help you make choices or perform tasks

Go to a Different Folder Enables you to select a folder or form to display.

Up One Level Takes you up one level in the Menu Tree

Folder List Displays or hides the Menu Tree

Units Units of measure used for the active form

Go Back button Takes you to the previously viewed form

Go Forward button Takes you to the form where you last chose the Go Back Button

Input/Results View Menu Allows you to view folders and forms for Input only, Results only, or All

Previous Sheet button Takes you to the previous input or result sheet for this object

Next Sheet button Takes you to the next input or result sheet for this object

Comments button Allows you to enter comments for a particular block, stream,
or other object

Status button Displays any messages generated during the last run related to a
particular form

Next button Invokes the Aspen Plus expert system. Guides you through the
steps required to complete your simulation.

Displaying Forms and Sheets in the Data Browser
Use the Data Browser to view and edit the forms and sheets that define the input
and display the results for the flowsheet simulation. When you have a form
displayed, you can view any sheet on the form by clicking on the tab for that
sheet.
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There are several ways to display forms. You can display a form in a new Data
Browser by using:
• The Data menu
• Block or stream popup menus
• The Check Results button on the Control Panel, the Check Results command

from the Run menu, or the Check Results button on the Simulation Run
toolbar

• The Setup, Components, Properties, Streams, or Blocks buttons on the Data
Browser toolbar

• The Next button on the Data Browser toolbar
• The Data Browser button on the Data Browser toolbar

You can move to a new form within the same data browser by using the:
• Menu tree
• Object Managers
• Next button on the Data Browser
• Previous Form and Next Form buttons (<<, >>)
• Go Back and Go Forward buttons (�, �)
• Select View menu
• Up One Level button

For example, the Components Specifications Selection form looks like this:

Note A form is a collection of sheets.
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Status Indicators
Status indicators display the completion status for the entire simulation as well
as for individual forms and sheets.

The status indicators appear:
• Next to sheet names on the tabs of a form
• As symbols representing forms in the Data Browser menu tree

This table shows the meaning of the symbols that appear:

This Symbol On an Means

Input form Required input complete

Input form Required input incomplete

Input form No data entered

Mixed form Input and Results

Results form No results present (calculations have not been run)

Results form Results available without Errors or Warnings (OK)

Results form Results available with Warnings

Results form Results available with Errors

Results form Results inconsistent with current input (input changed)

 Input folder No data entered

 Input folder Required input incomplete

 Input folder Required input complete

 Results folder No results present

 Results folder Results available – OK

 Results folder Results available with Warnings

 Results folder Results available with Errors

 Results folder Results inconsistent with current input (input changed)

Using Next

Click the Next button  to move to the next input form or menu at any point in
Aspen Plus. The Next button is on the Data Browser toolbar in the main window
and the toolbar of the Data Browser.
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Use Next to:
• Guide you through the required and optional input for a run by displaying

messages
• Tell you what you need to do next
• Ensure you do not make incomplete or inconsistent specifications, even when

you change options and specifications you have already entered

This table shows what happens if you click Next:

If Using Next

The sheet you are on is incomplete. Displays a message listing the input you must provide to complete
the sheet

The sheet you are on is complete. Takes you to next required input sheet for the current object

You have selected an object that is complete Takes you to next object or the next step in making a run.

You have selected an object that is incomplete Takes you to the next sheet you must complete.

Using the Previous and Next Sheet Buttons
You can browse through sheets and forms sequentially by using the Previous
Sheet and Next Sheet buttons on the Data Browser toolbar. These buttons take
you through input sheets, results sheets, or both, depending on the current
selection of the Input/Results View menu button in the Data Browser toolbar.

To view the next sheet in a series, click the Next Sheet button .

To view the previous sheet, click the Previous Sheet button .

Using the Go Back and Go Forward Buttons

You can trace through previously viewed forms using the Go Back button .
The Go Back button can be clicked many times to continue through a reverse
sequence of the forms you have viewed.

When you have gone back once, the Go Forward button  is enabled, so you can
return to the form that you were on.
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Using the Object Manager

Every block, stream, and other simulation object has a unique ID. When you
select a folder in the Data Browser tree which contains several simulation
objects, an Object Manager form appears in the form area of the Data Browser.
For example:

Use the Object Manager buttons to perform the following functions:

Button Description

New Create a new object.  You will be prompted for the ID for the object.
The forms for the object will display.

Edit Display the forms for the object

Delete Delete the object

Clear Delete the data for an object.  The object still exists.

Rename Rename the object

Hide Temporarily remove an object from the simulation, without deleting it.

Reveal Put a hidden object back into the simulation

Not all functions are available for all objects.  For example, New is inactive on
the Block Object Manager.  Use the Process Flowsheet window and the Model
Library to create a new block.
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Deleting Objects and Clearing Forms
You can delete the following from a simulation:
• A component, from the Components Specification Selection sheet
• Blocks and streams, from the flowsheet
• Other input, such as a design specification, using the Data Browser or an

Object Manager

When you delete input, all references to the deleted object (even on other forms)
are automatically deleted. If this results in an inconsistent or incomplete
specification, the Expert System marks the affected forms as incomplete, and the
Next function takes you to any incomplete sheets.

You cannot delete:
• Sheets that do not represent objects, such as the Setup forms
• Properties Parameters (Binary or Pair) and Molecular Structure objects

However, you can clear these sheets of all existing input and restore their default
values. To do this, click Clear from an Object Manager or from the menu that
appears when you click the right mouse button on an item in the menu tree.

Using the Expert System When You Make
Changes

The Aspen Plus Expert System (the Next function):
• Tells you when your specifications are inconsistent or incomplete
• Guides you through reconciling changes

If the field where you want to enter data is inactive, the Prompt for the field tells
you why. To make the field active, delete any conflicting entries or options. For
example, if you are using RadFrac to model a distillation column and specify
None for the Reboiler, one of the Operating Specifications fields will become
inactive since there is only one degree of freedom in the column specifications.  If
you change the Reboiler field, the other Operating Specification field will become
active.

If you change an option or specification that makes other entries inconsistent,
Aspen Plus displays a dialog box asking if you want to temporarily override the
error.
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Click Yes if you want to continue without correcting the inconsistency error.
Then go to the affected fields and make them consistent with the new
specification.

The affected forms are marked incomplete until you reconcile the specifications.
The Expert System guides you to incomplete sheets.

Using Shortcut Keys

The following tables show the shortcut keys that are available in Aspen Plus.
• General shortcut keys
• Working with blocks and streams
• Editing
• Working with files
• Working with flowsheets
• Help
• Plotting
• Regions
• Running simulations
• Viewing
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General Shortcut Keys
This table shows general shortcut keys:

Item Shortcut Key

Close active window ALT+F4

Copy CTRL+C

Context Help F1

Cut CTRL+X

Display popup menu SHIFT+F10

Display next MDI-child window CTRL+F6

Paste CTRL+V

Print CTRL+P

Redo CTRL+Y

Save CTRL+S

Select All CTRL+A

Switch to next window ALT+F6

What's This Help SHIFT+F1
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Shortcut Keys for Working with Blocks and Streams
This table shows the shortcut keys for working with blocks and streams:

Item Shortcut Key

Align Blocks CTRL+B

Center View CTRL+HOME

Change Section CTRL+F11

Change Stream Class CTRL+Q

Delete Blocks or Streams DEL

Exchange Icon CTRL+K

Hide Annotation CTRL+L

Hide Global Data CTRL+G

Hide ID CTRL+H

Input CTRL+I

Rename Block or Stream CTRL+M

Reroute Streams CTRL+J

Results CTRL+R

Stream Results CTRL+D

Unplace Block or Group CTRL+U

Shortcut Keys for Editing
This table shows the shortcut keys for editing:

Item Shortcut Key

Copy CTRL+C

Delete DEL

Paste CTRL+V

Rename CTRL+M

Select All CTRL+A
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Shortcut Keys for Working with Files
This table shows the shortcut keys for working with files:

Item Shortcut Key

Export CTRL+E

Import CTRL+T

New CTRL+N

Open CTRL+O

Print CTRL+P

Save CTRL+S

Shortcut Keys for Working with Flowsheets
This table shows the shortcut keys for working with flowsheets:

Item Shortcut Key

Align Blocks CTRL+B

Change Section CTRL+F11

Change Stream Class CTRL+Q

Exchange Icons CTRL+K

Flowsheet Sections F11

Hide Annotation CTRL+L

Hide Global Data CTRL+G

Hide ID CTRL+H

Reroute Streams CTRL+J

Unplace Blocks CTRL+U
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Shortcut Keys for Help
This table shows the shortcut keys for help:

Item Shortcut Key

Context Help F1

Display popup menu SHIFT+F10

What's This Help SHIFT+F1

Shortcut Keys for Plotting
This table shows the shortcut keys for plotting:

Item Shortcut Key

Display Plot CTRL+ALT+P

Parametric Variable CTRL+ALT+Z

Plot Wizard CTRL+ALT+W

 X-Axis Variable CTRL+ALT+X

 Y-Axis Variable CTRL+ALT+Y
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Shortcut Keys for Working with Regions
This table shows the shortcut keys for working with regions:

Item Shortcut Key

Bookmarks F3

Center View CTRL+HOME

Page Break Preview F2

Pan CTRL+F3

Print CTRL+P

Reset Page Breaks SHIFT+F2

Select All CTRL+A

Zoom Full CTRL+END

Zoom In CTRL+UP ARROW

Zoom Out CTRL+DOWN ARROW

Shortcut Keys for Running Simulations
This table shows the shortcut keys that you can use when running simulations:

Item Shortcut Key

Check Results CTRL+F8

Connect to Engine SHIFT+F7

Move To CTRL+F9

Reinitialize SHIFT+F5

Run F5

Settings CTRL+F7

Step CTRL+F5

Stop Points F9
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Shortcut Keys for Viewing
This table shows the shortcut keys that you can use for viewing:

Item Shortcut Key

Annotation CTRL+ALT+L

Bookmarks F3

Center View CTRL+HOME

Control Panel F6

Current Section Only SHIFT+F11

Global Data CTRL+ALT+G

History CTRL+ALT+H

Input Summary CTRL+ALT+I

OLE Objects CTRL+ALT+F

Model Library F10

Page Break Preview F2

Pan CTRL+F3

PFD Mode F12

Redraw CTRL+W

Refresh PFD SHIFT+F12

Report CTRL+ALT+R

Reset Page Breaks SHIFT+F2

Zoom Full CTRL+END

Zoom In CTRL+UP ARROW

Zoom Out CTRL+DOWN ARROW

Supplying Comments

You can write notes or keep track of information by entering comments for
particular forms. Each object has just one Comments form which you can access
from any input or results form for the object.
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To enter comments on a form:

1. Click the Comments button on the Data Browser toolbar.

If there are no existing comments, the button looks like this:  .

If there are existing comments, the button looks like this: 

2. Enter your one line description in the Description box of the Comments form.

The description is printed in the Aspen Plus report.

3. Enter your comments in the Comments area of the Comments form.

4. Click OK to close the Comments form.
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2 Creating a Simulation
Model

This chapter describes how to use Aspen Plus to create a simulation model, including the
following topics:
• Creating a new run
• Selecting a Template
• Selecting a Run Type
• Completing the input specifications for a run
• About the templates
• The Aspen Plus online applications library

Process Simulation Using Aspen Plus

Process simulation with Aspen Plus allows you to predict the behavior of a process using
basic engineering relationships such as mass and energy balances, phase and chemical
equilibrium, and reaction kinetics. Given reliable thermodynamic data, realistic operating
conditions, and the rigorous Aspen Plus equipment models, you can simulate actual plant
behavior. Aspen Plus can help you design better plants and increase profitability in
existing plants.

With Aspen Plus you can interactively change specifications, such as flowsheet
configuration, operating conditions, and feed compositions, to run new cases and
analyze alternatives. To analyze your results, you can generate plots, reports,
PFD-style drawings, and spreadsheet files.
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Aspen Plus allows you to perform a wide range of additional tasks. You can:
• Perform sensitivity analyses and case studies
• Generate custom graphical and tabular output
• Estimate and regress physical properties
• Fit simulation models to plant data
• Optimize your process
• Interface results to spreadsheets
• Share input and results among other Windows applications using OLE

Aspen Plus contains data, properties, unit operation models, built-in defaults,
reports, and other features and capabilities developed for specific industrial
applications, such as petroleum simulation. For more information about
industry-specific defaults and features, see
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Selecting a Template on page 2--6.

Creating a New Run

Follow these instructions to either:
• Start Aspen Plus and create a new run
• Create a new run when you are already in Aspen Plus

Starting Aspen Plus and Creating a New Run
To start Aspen Plus and create a new run:

1. Start Aspen Plus from the Start Menu or by double-clicking the Aspen Plus
icon on your desktop.

2. On the Aspen Plus Startup dialog box, click the appropriate button to create a
new simulation using a Blank Simulation or a Template, then click OK.

3. If you choose a blank simulation, the Aspen Plus main window opens and you
can begin building your new model.

4. If you choose a Template, follow the steps below.

5. In the New dialog box, select the type of simulation template and the units
you wish to use, from the list. For more information on choosing a Template,
see
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Selecting a Template on page 2-6.

6. Choose the desired Run Type in the Run Type list box. For more information,
see Selecting a Run Type on page 2-7.

7. Click OK.

8. If the Connect to Engine dialog box appears, specify where the Aspen Plus
engine will execute. See Chapter 1 for more information.

Creating a New Run in Aspen Plus
To create a new run if you are already in Aspen Plus:

1. Save the current run if you want to open it later.

2. From the File menu, click New.

3. A dialog box appears, asking if you want to close the current run before
opening a new run. Click Yes, No, or Cancel:

If you choose This happens

Yes The current run will be closed, and the new run will open in the existing Aspen Plus window.

You will be given the option to save the current run before the new run opens.

No The current run will remain active in the existing window, and a new run will open in a second Aspen Plus window.

Cancel You will be returned to the current run.

4. In the New dialog box, select the type of simulation Template and the units
you wish to use, from the list. For more information on choosing a Template,
see
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Selecting a Template on page 2-6.

5. Choose the desired Run Type in the Run Type list box. For more information
on Run Types, see Selecting a Run Type on page 2-7.

6. Click OK.
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Selecting a Template

When starting a new simulation, you can start with a blank simulation or you
can begin with a Template. Templates set defaults commonly used by specific
industries for:
• Units of measurement
• Stream composition information and properties to report
• Stream report format
• Default setting for Free-Water option
• Property method
• Other application-specific defaults

For information about creating your own templates, see Chapter 16.

There are built-in Templates for the following applications:
• Air Separation
• Chemicals
• Electrolytes
• Gas Processing
• General
• Hydrometallurgy
• Petroleum
• Pharmaceuticals
• Pyrometallurgy
• Solids
• Specialty Chemicals

For each Template, you can select either metric or English units of measurement
as a default units set. Other units sets are also available.

See the sections at the end of this chapter for a description of the Templates.
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Selecting a Run Type

When creating a new run, you must select a Run Type from the Run Type list box
on the New dialog box.

Use the Flowsheet run type for flowsheet simulations (including sensitivity
studies and optimization). Flowsheet runs can also include the following
calculations integrated with a flowsheet simulation:
• Property constant estimation
• Assay data analysis/pseudocomponents generation
• Property analysis

Other run types are used to run Aspen Plus without performing a flowsheet
simulation:

Run Type Description Use to

Assay Data Analysis A standalone assay data
analysis/pseudocomponents
generation run

Analyze assay data when you do not want to
perform a flowsheet simulation in the same run. See
Chapter 32.

Data Regression A standalone data regression
run. Can contain property
constant estimation and property
analysis calculations.

Fit physical property model parameters required by
Aspen Plus to measured pure component, VLE, LLE
and other mixture data. Aspen Plus cannot perform
data regression in a Flowsheet run. See Chapter 31.

PROPERTIES PLUS A PROPERTIES PLUS setup
run

Prepare a property package for use with Aspen
Custom Modeler or ADVENT, with third-party
commercial engineering programs, or with your
company's in-house programs.

You must be licensed to use PROPERTIES PLUS.

Property Analysis A standalone property analysis
run. Can contain property
constant estimation and assay
data analysis calculations.

Perform property analysis by generating tables of
physical property values when you do not want to
perform a flowsheet simulation in the same run. See
Chapter 29.

Property Estimation A standalone property constant
estimation run

Estimate property parameters when you do not want
to perform a flowsheet simulation in the same run.
See Chapter 30.
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Completing Input Specifications for a
Run

For Flowsheet runs, follow these basic steps to complete the required and
optional input specifications:

1. Define the simulation flowsheet (blocks, streams, and connectivity) in the
Process Flowsheet window. See Chapter 4.

2. Enter required input specifications on the following forms in the Data
Browser:

Forms Specify

Setup Global simulation options (see Chapter 5)

Components Conventional chemical components, petroleum assays, and pseudocomponents in
the simulation. For information on working with components, see Chapter 6. For more
information on petroleum assays and pseudocomponents, see Chapter 32.

Physical Properties Methods and data to use for calculating physical properties. For more information on
entering property methods and entering property parameters and data, see Chapters 7 and 8
respectively.

Streams Feed stream compositions, flows, and conditions. For more information, on specifying
streams,  see Chapter 9.

Blocks Design and operating conditions for each unit operation block in the flowsheet (see
Chapter 10).

3. Provide additional specifications if needed by opening the Data Browser and
using the forms shown in this table:

Use these forms To

Reactions Define electrolytes chemistry; specify reaction kinetics for use in reactor and
reactive distillation models (see Chapter 27)

Convergence Specify automatic flowsheet analysis options; specify user-defined tear streams,
convergence blocks, and sequences (see Chapter 17)

Flowsheeting Options Add additional constraints and specifications to the flowsheet model.
Request pressure relief calculations

Model Analysis Tools Specify sensitivity studies, optimization runs, and Data-Fit problems. Data-Fit is
used to fit simulation models to plant or laboratory data.

Setup ReportOptions Specify options for generating the Aspen Plus report. For more information on
specifying the elements in the Report file and on generating the report file, see Chapters 5
and 12 respectively.
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Tip   Although you can enter most specifications in any order, it is best to use
Next and let the Aspen Plus Expert System guide you. For more information on
using Next see Chapter 1.

Completion Status for the Flowsheet
The completion status for the overall flowsheet appears in the status bar of the
main window. When completing specifications for a run, you see the following
status messages:

This status message Means You can

Flowsheet Not Complete The simulation flowsheet has not been
defined or the flowsheet connectivity is
incomplete.

Use Next on the Data Browser
toolbar to find out why
connectivity is incomplete.

Required Input Incomplete Input specifications for the run are
incomplete.

Use Next from the main window
or Data Browser toolbars to find
out what you must specify to
complete the input specifications
and to go to forms that are
incomplete.

Required Input Complete Required input specifications for the run are
complete.

Run the simulation or enter
optional specifications.

Completion Status on Forms
The completion status for the active form or menu appears in the status bar of
the Data Browser. When completing specifications for a new run, you see the
following status messages:

This status message Means You can

Required Input Incomplete Input specifications for the form or
object are incomplete.

Use Next from the Data Browser toolbar to find
out what you must specify to complete the input
specifications.

Input Complete Required input specifications for the
form or object are complete.

Enter specifications for other forms or run the
simulation.



Creating a
Simulation
Model

2-10 Aspen Plus User Guide
Version 10.2

Completion Status Indicators in the Data Browser Menu
Tree

In the Data Browser menu tree, the following symbols indicate the input
completion status:

Symbol In an Means

Input form Required Input Complete

Input form Required Input Incomplete

Input form No data entered

Mixed form Input and Results

Results form No results present (calculations have not been run)

Results form Results available without Errors or Warnings (OK)

Results form Results available with Warnings

Results form Results available with Errors

Results form Results inconsistent with current input (input changed)

 Input folder No data

 Input folder Input Incomplete

 Input folder Input complete

 Results folder No results present

 Results folder Results available without Errors or Warnings (OK)

 Results folder Results available with Warnings

 Results folder Results available with Errors

 Results folder Results inconsistent with current input (input changed)
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Completion Status Indicators on Sheets

On forms, the completion status for each individual sheet is displayed on the
sheet tab:

Symbol Means

Input specifications for the sheet are incomplete.

Click the tab of the incomplete sheet and complete the input

– or –
Use Next

Input specifications for the sheet are complete.
The required input has been entered by the user.

 (blank) Input for this sheet is optional.

Completion Status for Objects

When you are on an Object Manager for a block or other object, the completion
status for each object appears in the Status column.

Status message Means You can

Input Incomplete Input specifications for the object are
incomplete.

Use Next from the Data Browser toolbar
to go to an incomplete form, or
select an incomplete object from the
Object Manager, and click Edit.

Input Complete Required input specifications for the
object are complete.

Use Next from the Data Browser toolbar
to go to the next step, or enter
optional specifications by selecting an object
from the Object Manager and clicking Edit.

Results Present Results are present View results, make input changes,
and re-run the simulation

Input Changed Results are present, the input
specifications have been changed and
the input is complete.

View results, make further input changes,
and re-run the simulation

About the Templates

There are built-in Templates for the following applications:
• Air Separation
• Chemicals
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• Electrolytes
• Gas Processing
• General
• Hydrometallurgy
• Petroleum
• Pharmaceuticals
• Pyrometallurgy
• Solids
• Specialty Chemicals

About the General Template
Use the General Template for a wide range of vapor-liquid applications. The
General Template defines the following units sets. These units sets are also
available in all other Templates. For more information on units sets, see
Chapter 5.

Unit-Set Temp Pres Mass Flow Mole Flow Enthalpy Flow Volume Flow

G† F psi lb/hr lbmol/hr Btu/hr cuft/hr

MET K atm kg/hr kmol/hr cal/sec l/min

METCBAR†† C bar kg/hr kmol/hr MMkcal/hr cum/hr

METCKGGM C kg/sqcm kg/hr kmol/hr MMkcal/hr cum/hr

SI K n/sqm kg/sec kmol/sec watt cum/sec

SI-CBAR C bar kg/hr kmol/hr watt cum/hr

† 
Default English units set for General Template

†† 
Default metric units set for General Template
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General Template Defaults

The General Template sets the following defaults. See Chapter 5 for information
about setting and changing defaults.

Specification Default

Physical property method None

Flow-basis for input Mole

Stream report composition Mole flow

Stream report format General purpose with enthalpy and density on a mass basis.
Entropy is not reported.

Stream class Conventional.
Appropriate for systems containing vapor, liquid, and salts.
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General Template Property Set

The General Template defines the following property sets. These property sets
are also available in many of the other Templates. For more information about
property sets, see Chapter 28.

Property Set Description

HXDESIGN Thermal and transport properties in SI units needed by
heat exchanger design programs and ADVENT, including:

Mass vapor fraction

Mass flow rate for total, vapor, and liquid phases

Mass enthalpy for total, vapor, and liquid phases

Mass density for total, vapor, and liquid phases

Mass heat capacity for total, vapor, and liquid phases

Pseudo-critical pressure for total, vapor, and liquid phases:

Viscosity for vapor and liquid phases

Thermal conductivity for vapor and liquid phases

Average molecular weight for total, vapor, and liquid phases

THERMAL Thermal properties, including:

Vapor and liquid phase enthalpy

Vapor and liquid phase heat capacity

Vapor and liquid phase thermal conductivity

TXPORT Transport properties, including:

Vapor and liquid phase mass density

Vapor and liquid phase viscosity

Liquid phase surface tension

VLE Vapor-liquid equilibrium component information, including:

Component fugacity coefficient in vapor and liquid phases

Component activity coefficient in liquid phase

Pure component vapor pressure

VLLE Vapor-liquid-liquid equilibrium component information, including:

Component fugacity coefficient in each phase

Component activity coefficient in each liquid phase

Pure component vapor pressure
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About the Petroleum Template
The Petroleum Template defines defaults commonly used in the petroleum
industry. It is also appropriate for petrochemical applications such as ethylene
plants, which involve petroleum fractions as feedstocks.

This table shows the defaults used:

Specification English Default Metric Default

Units F, psi, lb/hr, lbmol/hr, MMBtu/hr,
bbl/day

C, bar, kg/hr, kmol/hr,
MMkcal/hr, bbl/day

Physical property method None None

Free water Yes (see Chapter 5) Yes (see Chapter 5)

Flow basis Standard liquid volume Mass

Stream report composition Standard liquid volume flow Mass flow

Because petroleum applications encompass a wide range of boiling fractions/
components and process conditions, this Template does not have a default
physical property method. These methods are used most frequently:
• BK10
• CHAO-SEA
• GRAYSON
• RK-SOAVE
• PENG-ROB
• IDEAL

You should consider additional methods for various operations within a refinery
(such as ELECNRTL for sour water strippers and amine treatment units, and
UNIFAC for aromatic extraction). For information to help you determine which
property method is best for your application, see Chapter 7.

Aspen Plus provides comprehensive methods for analyzing assay data and
automatically generating pseudocomponents. You can select from five built-in
pseudocomponent property methods to characterize pseudocomponents. You can
also enter curves of petroleum properties, such as sulfur and metal contents.
Aspen Plus tracks these properties throughout the flowsheet. You can use them
in design specifications, optimization constraints, and objective functions. See
Chapter 32 for more information.
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The Aspen Plus PetroFrac model simulates a wide range of fractionation units
within a refinery. PetroFrac can model a tower with any number of:
• Side strippers, including the bottom liquid return to the main tower
• Pumparounds and bypasses
• Partial and total drawoffs

PetroFrac can model the feed furnace as an integral part of the tower, including
the slop cut recycle for a vacuum unit. It lets you enter petroleum-specific
property specifications, such as ASTM distillation temperatures, gaps, and
overlaps. It also offers extensive column sizing and rating capabilities, including
the ability to handle structured packings and integrated pressure drop
calculations. For complete information on PetroFrac, see the Aspen Plus Unit
Operation Models manual.

Petroleum Property Sets

In Aspen Plus, many properties can be used to characterize streams in a refinery.
Chapter 28 lists these properties and explains how to use them.
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The Petroleum Template includes property sets for many widely used
petroleum-related properties.

Property Set Description

CUTS-E Standard liquid volume flow of petroleum cuts at 100º F intervals.
Valuable for concise reporting of stream composition.

CUTS-M Mass flow rate of petroleum cuts at 50º C intervals. Valuable for
concise reporting of stream composition.

D86-5 ASTM D86 temperature at 5 liquid volume %

D86-95 ASTM D86 temperature at 95 liquid volume %

GASPROPS Vapor phase properties, including:

Compressibility factor for a mixture

Actual volume flow

Standard vapor volume flow

Heat capacity ratio (CP/CV)

KINVISC Kinematic viscosity at 100°F and 212°F or 40°C and 100°C (dry
basis)

LIGHT Petroleum characteristics for light distillates (dry basis), including:

Reid vapor pressure

Flash point based on API method

Aniline point

MIDDLE Petroleum characteristics for middle distillates (dry basis),
including:

Cetane number

Flash point based on API method

Pour point based on API method

Aniline point

PETRO† General petroleum properties on dry basis, including:

Standard liquid volume flow (bbl/day) and (bbl/hr)

Standard API gravity

Standard specific gravity

Watson UOP K-factor

True boiling point distillation curve

ASTM D86 distillation curve

ASTM D1160 distillation curve

TBP-5 True boiling point temperature at 5 liquid volume %

TBP-95 True boiling point temperature at 95 liquid volume %

† 
Default for stream results
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Petroleum Stream Report Options

The large number of pseudocomponents and distillation curves in a petroleum
application can result in a lengthy stream report.

The Petroleum Template defines several stream report format (TFF) options so
you can view or print subsets of stream information:

TFF Displays

PETRO-E State variables, stream flows, properties, distillation curves,
component flows. Standard volume flows of the 100°F petroleum cuts
if CUTS-E property set was selected

PETRO-M State variables, stream flows, properties, distillation curves,
component flows. Mass flows of the 50°C petroleum cuts if CUTS-M
property set was selected

PET-COMP Only component flow and total flow results

PET-CURVE Only distillation curve stream results

PET-PROP Only state variables, stream flows, properties, and flows of petroleum
cuts

About the Gas Processing Template
The Gas Processing Template defines defaults commonly used in the gas
processing industry. For example, stream flows are standard vapor volume flows
in millions of standard cubic feet per day or millions of standard cubic meters per
hour.

The gas processing defaults are:

Specification Default

English units F, psi, lb/hr, MMscfd, MMbtu/hr, MMcuft/hr

Metric units C, bar, tonne/hr, MMscmh, MMkcal/hr, cum/hr

Physical property method Peng-Robinson

Flow basis Mole with MMscfd† or MMscmh††

Stream report compositions Mole flow with MMscfd† or MMscmh††

† 
MMscfd is millions of standard cubic feet per day.

††
MMscmh is millions of standard cubic meters per hour.
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Peng-Robinson is the default method for calculating physical properties. For
many gas processing applications, such as gas sweetening, gas dehydration, and
the Claus process, you may want to select other physical property methods. For
help selecting physical property methods for your application, see Chapter 7. For
example, you may want to use the ELECNRTL method together with the special
amines data package for gas sweetening.

Gas Processing Property Sets

This Template also provides property sets commonly needed in gas processing
applications:

Property Set Description

CRITICAL Pseudo critical properties, including:

Pseudo critical temperature

Pseudo critical pressure

Pseudo critical volume

GASPROPS† General gas properties, including:

Compressibility factor

Actual volume flow

Standard vapor volume (MMscfd†† or MMscmh†††)

Heat Capacity Ratio (CP/CV) for mixture

TDEW Dew point temperature

†
Default for stream results

††
MMSCFD is millions of standard cubic feet per day.

†††
MMSCMH is millions of standard cubic meters per hour.
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About the Air Separation Template
Use the Air Separation Template for cryogenic air separation simulations. The
defaults are:

Specification Default

English units F, psi, lb/hr, lbmol/hr, Btu/hr, cuft/hr

Metric units C, bar, kg/hr, kmol/hr, watt, cum/hr

Physical property method Peng-Robinson

Components included O2, N2, AR

Flow basis Mole

Stream report composition Mole flow and mole fraction

These Aspen Plus unit operation models are used extensively in air separation
simulations:

Model Description

RadFrac Rigorous distillation

MultiFrac Multiple column simulation

HeatX Rigorous heat exchange

MHeatX Cold box heat exchange

Air plants are highly heat-integrated. You can specify heat streams to model the
complex heat integration between units.
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Air Separation Property Sets

The air separation property sets are:

Property Set Description

CRITICAL Pseudo critical properties, including:

Pseudo critical temperature

Pseudo critical pressure

Pseudo critical volume

GASPROPS† General gas properties, including:

Compressibility factor

Actual volume flow

Standard vapor volume (MMscfd†† or MMscmh†††)

Heat Capacity Ratio (CP/CV) for mixture

TBUBBLE Bubble point temperature

TDEW Dew point temperature

†
Default for stream results

††
MMscfd is millions of standard cubic feet per day.

†††
MMSCMH is millions of standard cubic meters per hour.

About the Chemicals Template
The Chemicals Template is suitable for a wide range of chemical (non-electrolyte)
applications. It is also appropriate for petrochemical applications, such as MTBE
production and VCM plants, where feedstocks are defined in terms of chemical
components.

The defaults are:

Specification Default

English units F, psi, lb/hr, lbmol/hr, Btu/hr, cuft/hr

Metric units C, bar, kg/hr, kmol/hr, MMkcal/hr, cum/hr

Physical property method NRTL

Flow basis Mole

Stream report composition Mole flow
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The default base property method is NRTL, which has wide application for
low-pressure ideal and non-ideal chemical systems. Aspen Plus has several
additional activity coefficient models and equations of state for modeling
chemical systems. For example, for systems containing organic acids, use
NRTL-HOC, WILS-HOC, or UNIQ-HOC methods. For chemical systems at high
pressures, use an equation-of-state method, such as RK-ASPEN, SR-POLAR,
PRWS, PRMHV2, or PSRK. For more information on Aspen Plus physical
property methods, see Chapter 7.

Each activity coefficient and equation-of-state model has a large databank of
binary interaction parameters suitable for modeling chemical systems.
Aspen Plus automatically retrieves and displays these binary parameters. If the
database does not have binary parameters for a component pair, Aspen Plus can
estimate the missing binary parameters for your application (see Chapter 30).

If you have measured data for your chemical system you can use Aspen Plus to
regress model parameters. For more information on regressing property data, see
Chapter 31. Aspen Plus has interactive tools for analyzing the properties and
vapor-liquid equilibrium of chemical systems. For more information on property
analysis, see Chapter 29.

The built-in property sets are the same as for the General Template.

About the Electrolytes Template
The Electrolytes Template is used for applications that require rigorous modeling
of electrolyte species. You can use this Template in any application where
electrolytes are important.

The defaults are:

Specification Default

English units F, psi, lb/hr, lbmol/hr, Btu/hr, cuft/hr

Metric units C, bar, kg/hr, kmol/hr, MMkcal/hr, cum/hr

Physical property method ELECNRTL

Components included H2O

Flow basis Mass

Stream report composition Mass flow

Stream report format Displays all electrolyte properties that are requested in
property sets
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The ELECNRTL property method model is recommended for rigorously modeling
electrolyte systems. This property method is described in more detail in
Chapter 7.

Aspen Plus has a large built-in databank of electrolyte reactions and interaction
parameters for many electrolyte systems. The Aspen Plus Electrolytes Wizard
generates electrolytes chemistry automatically and interactively, so you can
control the species and reactions to include in your simulation. See Chapter 6
and Aspen Plus Getting Started Modeling Processes with Electrolytes for
instructions on how to build an electrolytes application.

Electrolytes Property Sets

The built-in property sets are:

Property Set Property Description

FAPP Apparent component mole flow

FTRUE True component mole flow

LVOLFLOW Liquid volumetric flow

MASSCONC Mass concentration

MOLECONC Mole concentration

PH pH at current temperature

SOLINDEX Solubility index

TBUBBLE Bubble point temperature

VMOLFLOW Component mole flows in vapor phase

VMOLFRAC Component mole fractions in vapor phase

WXAPP Apparent component mass fraction

WAPP Apparent component mass flow

XTRUE True component mole fraction

About the Specialty Chemicals Template
The Specialty Chemicals Template is for specialty chemical applications, with or
without electrolytes. You can view stream results on a:
• Concentration basis
• Per batch basis, if you select the Batch-Operations report option (see

Chapter 12)
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The defaults for this Template are:

Specification Default

English units F, psi, lb/hr, lbmol/hr, Btu/hr, gal/hr

Metric units C, bar, kg/hr, kmol/hr, kcal/hr, l/hr

Physical property method NRTL

Flow basis Mass

Stream report composition Mass flow

Stream report format Displays standard properties, plus concentration and batch
stream report, if requested. Electrolyte properties are also
displayed if an electrolyte method and electrolyte property set
are selected.

Aspen Plus has two batch unit operation models that are especially useful for
specialty chemicals applications:
• RBatch, a batch reactor
• BatchFrac, for batch distillation

See Chapter 10 or Aspen Plus Unit Operation Models for more information.

The default base property method is NRTL, which has wide application for
low-pressure ideal and non-ideal chemical systems. Aspen Plus has additional
activity coefficient models and equations of state for modeling chemical systems.
For more information on Aspen Plus physical property methods, see Chapter 7.

Each activity coefficient model has a large databank of binary interaction
parameters suitable for modeling chemical systems. Aspen Plus automatically
retrieves and displays these binary parameters. If the database does not have
binary parameters for a component pair, Aspen Plus can estimate the missing
binary parameters for your application.

If you have measured data for your chemical system, you can use Aspen Plus to
regress model parameters. Aspen Plus has interactive tools for analyzing the
properties and vapor-liquid equilibrium of chemical systems. For more
information on property analysis, see Chapter 29.

If your process involves electrolytes, use the Electrolytes Wizard to define the
reactions and ionic species. For more information on the Electrolytes Wizard, see
Chapter 6. The NRTL method will be replaced by ELECNRTL, and the
electrolytes database will be used.

The built-in property sets are the same as for the Electrolytes Template.
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About the Pharmaceuticals Template
The Pharmaceuticals Template uses NRTL as the default base property method.
You can use this method for two-liquid-phase systems, or vapor and liquid
systems at low pressure. This Template reports stream composition on a mass
concentration and mass flow basis. You can also view the vapor-liquid-liquid
equilibrium for any stream and examine results on a per batch basis, if you select
the Batch-Operations report option.

The defaults for this Template are:

Specification Default

English units F, psi, lb/hr, lbmol/hr, Btu/hr, gal/hr

Metric units C, bar, kg/hr, kmol/hr, kcal/hr, l/hr

Physical property method NRTL

Flow basis Mass

Stream report composition Mass flow and mass concentration

Stream report format Displays standard properties, plus batch stream report if requested

Aspen Plus has two batch unit operation models that are especially useful for
pharmaceutical applications:
• RBatch, a batch reactor
• BatchFrac, for batch distillation

For more information, see Chapter 10 or Aspen Plus Unit Operation Models.

The built-in property sets are:

Property Set Description

LVOLFLOW Liquid volumetric flow

MASSCONC† Mass concentration

MOLECONC Mole concentration

VMOLFLOW Component mole flows in vapor phase

VMOLFRAC Component mole fractions in vapor phase

†
Default for stream report

About the Hydrometallurgy Template
Use the Hydrometallurgy Template to model electrolytes and solids in
hydrometallurgical processes.
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The defaults for this Template are:

Specification Default

English units F, psi, lb/hr, lbmol/hr, Btu/HR, cuft/hr

Metric units C, bar, kg/hr, kmol/hr, MMkcal/HR, cum/hr

Physical property method ELECNRTL

Component included H2O

Flow basis Mass

Stream class MIXCISLD, for modeling hydrometallurgy systems with vapor, liquid,
electrolytes, salts, and inert molecular solids.

Stream report composition Not displayed with default stream report format

Stream report format Displays all substreams together

The ELECNRTL property method is recommended for rigorously modeling the
electrolyte systems present in hydrometallurgy processes. This property method
is described in more detail in Chapter 7 and in Aspen Plus Physical Property
Methods and Models, Chapter 2.

Aspen Plus has a large built-in databank of electrolyte reactions and interaction
parameters for many electrolyte systems. The Aspen Plus Electrolytes Wizard
generates electrolytes chemistry automatically and interactively, so you can
control the species and reactions to include in your simulation. See Chapter 6
and Aspen Plus Getting Started Modeling Processes with Electrolytes for
instructions on how to build an electrolytes application.
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Property Sets for Hydrometallurgy

The built-in property sets for hydrometallurgical simulations include all property
sets listed for Electrolytes Simulation, plus the following:

Property Set Description

ALL-SUBS Characteristics for entire stream, including:

Temperature

Pressure

Volumetric flow

Mass vapor fraction

Mass solids fraction

Mass density

Mass flow

This property set is the default for stream report

About the Pyrometallurgy Template
Use the Pyrometallurgy Template to model high temperature metals processing
applications. The defaults are:

Specification Default

English units F, psi, lb/hr, lbmol/hr, Btu/hr, cuft/hr

Metric units C, bar, tonne/hr, kmol/hr, MMkcal/hr, cum/hr

Physical property method SOLIDS

Flow basis Mass

Stream class MIXCISLD, for modeling pyrometallurgy systems with only molecular
species. If you have ores that must be defined as non-conventional
components or if you need to model particle size distribution, you will
need a different stream class (see Chapter 9).

Stream report composition Not displayed with default stream report format

Stream report format Displays all substreams together
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Pyrometallurgical processes often involve chemical and phase equilibrium
between multiple liquid phases and a vapor phase. Aspen Plus uses the RGibbs
model to simulate these multiphase operations. Pyrometallurgical applications
often require different activity coefficient models for different liquid phases in the
system. You can create multiple methods, based on the SOLIDS method, to use
different activity coefficient models. You can then assign the new method to
specified liquid phases. For more details on how to modify a physical property
method, see Chapter 7.

Pyrometallurgy Property Sets

The pyrometallurgy property sets are:

Property Set Description

ALL-SUBS† Characteristics for entire stream, including:

Temperature

Pressure

Volumetric flow

Mass vapor fraction

Mass solids fraction

Mass density

Mass flow

VMOLFLOW Vapor mole flow

VMOLFRAC Vapor component mole fractions

†
Default for stream results

About the Solids Template
Aspen Plus can model solids anywhere in a process flowsheet. A wide range of
unit operation models for solids handling equipment is available, including
crystallizers, crushers, screens, and cyclones. See Aspen Plus Unit Operation
Models for more information on the models. See Getting Started Modeling
Processes with Solids to learn how to model solids processes step-by-step.
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The Solids Template reports the properties and component flows of all types of
components (vapor, liquid, and solid) together. You can also request Aspen Plus
to report:
• Overall stream concentrations
• Vapor fractions
• Solid fractions

If you use attributes in your simulation, substream and component attributes
appear in the default stream report.

The defaults for this Template are:

Specification Default

English units F, psi, lb/hr, lbmol/hr, Btu/hr, cuft/hr

Metric units C, bar, kg/hr, kmol/hr, MMkcal/hr, cum/hr

Physical property method None, but SOLIDS is recommended

Flow basis Mass

Stream class MIXCISLD, but you will often want to select a different
stream class based on your application

Stream report composition Not displayed with default stream report format

Stream report format Displays all substreams together



Creating a
Simulation
Model

2-30 Aspen Plus User Guide
Version 10.2

Solids Property Sets

The built-in property sets for solids are:

Property Set Description

ALL-SUBS† Characteristics for entire stream, including:

Temperature

Pressure

Volumetric flow

Mass vapor fraction

Mass solids fraction

Mass density

Mass flow

MASSCONC Mass concentration

MOLECONC Mole concentration

VMOLFLOW Component mole flows in vapor phase

VMOLFRAC Component mole fractions in vapor phase

†
Default for stream results

Using the Online Applications Library

Aspen Plus includes a library of Application Examples to illustrate how
Aspen Plus is used to solve a range of industrial problems.

These application examples cover a range of process industries, including gas
processing, petroleum refining, petrochemicals, chemicals, pharmaceuticals, and
metals processing. You can examine the input and results for these applications,
see how to use various Aspen Plus features, and modify and run these
applications to simulate your own processes.

These examples demonstrate the value of many Aspen Plus features, including
residue curves, three-phase reactive distillation, rigorous heat exchange rating,
and extraction with user liquid-liquid distribution correlations.
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Accessing the Online Applications Library
To access the online applications library in Aspen Plus:

1. From the File menu, click Open.
– or –
If you have just started Aspen Plus, from the Aspen Plus Startup dialog box,
click Open an Existing Simulation, select More Files… from the list of files,
and Click OK.

2. In the Open dialog box, click the Favorites button .

3. Click the app directory.

4. To view a description of a file, click the file then click the Preview button 
on the Open dialog box toolbar.

5. Click the file you want to open, then click Open.

6. The input and results are then loaded. You can examine, modify, and run the
simulation.

Examining Descriptions of Files

To view a description of a file before opening it:

➤ Click the file then click the Preview button (button that is furthest right) on
the Open dialog box toolbar.

To view a description of an open file:

1. From the Data menu, click Setup, then click Specifications.

2. Click the Description sheet.

To examine available comments for blocks and other objects, click the Comments
button from the toolbar of the Data Browser.

If comments are available, the Comments button looks like this: 

If there are no comments available, the Comments button looks like this: 
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3 Using Aspen Plus Help

Aspen Plus has online Help, prompts, and expert system messages to give you
information as you use the program.

This chapter explains how to use Help including:
• Getting online Help
• Using hypertext links
• Using the Back button
• Searching for help on a topic
• Printing help

Getting Help

There are several ways to get help in Aspen Plus:

If you want help about Do this

A particular topic On the Help menu, click Help Topics.
From the Help Topics dialog box, click the Index tab.

A form or field On the Aspen Plus toolbar, click the What's This button
then click the field or form.

A dialog box Click the Help button on the dialog box.

The item the cursor or mouse pointer is on Press F1.
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About The Help Window
Aspen Plus help topics appear in Help windows.

Help Topics
button displays
the Help
Contents window

Title of Help topic

Hypertext links

This table provides more information about elements you might find on a Help
window:

Window Element Description

Help title Title of the help topic currently displayed in the Help window. For example, Aspen Plus Help.

Hyperlink A word or phrase that displays information on a related topic when you click it

See Also hyperlink An additional topic you can move to by clicking  it

Help Topics button or Contents
button

Displays the Help Contents window, including Contents,  Index and Find tabs

Back button Returns you to the last help topic you viewed

Search button Displays the Index. You can enter a topic you want more information about.

Options button Displays options you can use to change your view of Help

Menus Contains commands to print help topics, close the Help window, and so on

Browse buttons (<< and >>) Enables you to browse forward and back through help topics

Note Not all buttons are available in all help windows:
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To keep the Help window on top of any other open windows:

1. In the Help window, click the Options button or menu.

2. Point to Keep Help On Top, and then click On Top.

Hypertext Links
You can move directly from one help topic to a related topic by clicking on a
hypertext link. Any underlined text (green on a color monitor) in the Help
window is a hypertext link.

Hypertext links can be:
• Words in a paragraph
• Topics listed at the end of a help topic

To jump to the topic indicated by the hypertext link, click the underlined text.

Using the Back Button
Use the Back button to move back through help screens you have seen. If there is
no previous topic to view, the Back button is unavailable. Back keeps a complete
record of all the help topics you view. This list is cleared each time you exit help.
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Searching for Help on a Topic

You can find specific information quickly by searching for it. To search for a topic
or keyword:

1. From the Help menu, click Help Topics, then click the Index tab.
The Index dialog box appears.:

2. Start typing a word or phrase to display a list of index entries that match
what you are looking for.

3. Click Display or double-click on the entry in the list.
Either the topic appears, or a dialog box containing a list of topics appears.:

4. To display the topic you want, click the topic, then click Display.
The help topic appears in the Help window.
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Displaying Help on Dialog Boxes, Forms
and Sheets

To access online Help that gives you an overview of a dialog box, form or sheet:

➤ Click the Help button on the dialog box, form or sheet.
– or –
Press F1 on the dialog box, form or sheet.

Displaying Help on Screen Elements

To access online Help on buttons, fields, commands on menus, and similar screen
elements:

➤ Click the What's This button  or on the window toolbar and then click
the element.
– or –
Select the element, then press F1.

Getting Step by Step Help

To get help on preparing, specifying, and running simulations, and reviewing
results:

1. From the Help Topics dialog box, click the Contents tab.

2. Double-click Using Aspen Plus, then click the topic you want.
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Getting Reference Information

To obtain reference information:

➤ From the Help Topics dialog box, click the Contents tab, then click the
appropriate topic.

Printing Help

To print a help topic:

1. Make sure the printer settings are correct.
To check this, Click Start, then point to Settings then Printers.

2. Display the Help topic you want to print.

3. Click the Print button.
– or –
Click the Options button, then click Print Topic.
– or –
From the File menu, click Print Topic.

Printing Popup Help

To print popup help windows:

1. Click with the right mouse button on the Help window.

2. From the popup menu, click Print Topic.
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Improving Help

We value your comments, suggestions, and criticisms. If you couldn’t find the
Help you were looking for, needed more assistance that the online help provided,
or have any suggestions for future improvements to our online information, we
want to know.

Please email your comments to Docs@Aspentech.com

Note If you have a query about Aspen Plus itself and want to email the
AspenTech Support team, please email your local Technical
Support office.
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4 Defining the Flowsheet

This chapter describes defining a process flowsheet in Aspen Plus including:
• Creating a process flowsheet
• Using heat and work streams
• Using pseudoproduct streams
• Viewing a process flowsheet
• Checking flowsheet completeness
• Modifying a process flowsheet
• Using flowsheet sections
• Printing

For descriptions and information about the user interface, see Chapter 1.

Creating a Process Flowsheet

To define a process flowsheet:

1. From the View menu, ensure that PFD mode is turned off. Otherwise, the
blocks and streams you place graphically, do not become part of your
simulation model. For more information, see Chapter 14.

2. Select the unit operation blocks and place them in the Process Flowsheet
Window.

3. Connect the streams to the blocks.
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After placing blocks and streams, you can:
• Delete blocks and streams
• Rename the blocks and streams
• Change stream connections

You can also improve the appearance of your flowsheet in many different ways.
For more information, see Modifying the Flowsheet on page 4-11.

When you are defining your flowsheet, the shape of the mouse pointer changes,
indicating the particular mode Aspen Plus is in:

Pointer Shape Function Use

Select mode Click an object to select it.
Click and hold an object to enter Move mode.
Click and drag to select a region or to move or resize a region
(The pointer changes to the Resize shape).

Insert mode Click to place a model of the type selected in the Model Library.
Note  After placing each block, you remain in Insert Mode until you click
the Select Mode button in the upper left corner of the Model Library.

Connect mode Click a port to connect the stream to it
Click a blank area of the flowsheet to to place a feed or product

Move mode Click and hold to move the object to a desired location

 Port move mode Click and hold to move the port to a desired location
Drag the port away from the model to enter Disconnect mode

Disconnect mode Click and hold on a stream while dragging it away from a block to
disconnect it. Release the mouse button to enter Connect mode.

 Resize mode Click and drag to resize a model or region

Use the Model Library to select unit operation models to be used in the
simulation.

Placing Blocks
To place a unit operation block in a simulation flowsheet:

1. Click a model category tab in the Model Library to display a list of models in
that category.

2. In the Model Library, select the unit operation model that you want to place
in your process flowsheet. To choose a different icon for the model, click the
down arrow, and click an icon to select it. The icon you select will remain the
default icon when placing that model, until you change the icon.
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3. Click and hold down the mouse button on the unit operation model, and drag
it to the Process Flowsheet window.

4. The mouse pointer is in the shape of a box with an arrow,  which indicates
that only one block will be placed.

5. In the Process Flowsheet window, release the mouse button where you want
to place the block.

If you have switched off Automatically Assign Block Names, you are
prompted to enter the Block ID. For more information on IDs, see Options for
Naming Blocks and Streams on page 4-12. The icon that you selected appears
on the flowsheet.

6. Continue creating your flowsheet. To place another block repeat steps 1
through 4.

When you place or move blocks, the center of the block icon snaps to a grid
location if Snap to Grid is enabled on the Grid/Scale tab of the Tools Options
dialog box.

Placing Multiple Blocks

To place multiple blocks of the same type in the flowsheet:

1. Click a model category tab in the Model Library to display a list of models in
that category.

2. In the Model Library, select the unit operation model that you want to place
in your process flowsheet. To choose a different icon for the model, click the
down arrow, and click an icon to select it. The icon you select will remain the
default icon when placing that model, until you change the icon.

3. Click the unit operation model (click the icon then release the mouse button.)

The pointer appears in the shape of a crosshair, representing Insert mode.

4. In the Process Flowsheet window, click where you want to place the block.
The icon that you selected appears on the flowsheet.
If you have switched off Automatically Assign Block Names, you are
prompted to enter the Block ID. For more information on IDs, see Options for
Naming Blocks and Streams on page 4-12. The icon that you selected appears
on the flowsheet.
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5. Continue creating your flowsheet.

If you want to Do this

Place another block for the same model Click in a new location on the flowsheet.

Place a block for a different model Repeat steps 1 to 4.

Stop placing blocks
Click the Select Mode button  in the upper left corner of
the Model Library. This turns off insert mode. Insert mode is
on when the Select Mode button is raised, and off when the
button is depressed.

When you place or move blocks, the center of the block icon snaps to a grid
location if Snap to Grid is enabled on the Grid/Scale tab of the Tools Options
dialog box.

Placing Streams and Connecting Blocks
To place a stream:

1. Click the STREAMS icon on the left side of the Model Library.

2. If you want to select a different stream type (Material, Heat or Work), click
the down arrow next to the icon and choose a different type.

Move the mouse pointer to the Process Flowsheet window. For each block in
the Process Flowsheet window, all ports that are compatible with that stream
type are highlighted.
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Ports that must have at least one stream connected are shown in red. Other
optional ports are shown in blue. If you position the mouse over a displayed
port, the arrow is highlighted and a text box with the description of the port
appears.

3. Click a highlighted port to make the connection.

If the port is not at the location you want it, click and hold the mouse button
on the port. When the mouse pointer changes to the port move shape (  )
drag to relocate the port on the icon.

4. Repeat step 4 to connect the other end of the stream.

Only those ports that you can connect the other end of the stream to remain
highlighted. For example, if you connect a stream to an outlet port, inlet ports
remain highlighted but outlet ports are no longer highlighted.

If you have switched off Automatically Assign Stream Names on the
Flowsheet tab of the Tools Options box, then you will be prompted for a
Stream ID.
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5. To place one end of the stream as either a process flowsheet feed or product,
click a blank part of the Process Flowsheet window.
If the stream’s source is already connected, then a product will be placed. If
the stream’s destination is already connected, then a feed will be placed. By
default, if you click a blank part of the window before connecting either
stream end, a feed is placed.

6. To stop placing streams click the Select Mode button  in the upper left
corner of the Model Library:

To cancel connecting the stream at any time, press ESC or click the right
mouse button.

To place another stream of the same type, repeat steps 4 through 6.

To place a stream of a different type, repeat steps 2 through 6.

You can also use drag and drop to connect streams.  The procedure is similar to
the one described above.

1. Select the stream type you want, by clicking the Material Stream icon in the
Model Library or using the down arrow next to the icon to select a Heat or
Work stream.

2. Click and hold down the mouse button on the stream icon.

Tip   Hold down the CTRL key during drag and drop to remain in Insert
mode after completing connections for the first stream.

3. Move the cursor to the Process Flowsheet Window.

The compatible ports are highlighted.
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4. Release the mouse button on:
• A port to make a connection
• A blank part of the flowsheet to place a feed

5. Move the mouse and click:
• Another highlighted port to connect the other end of the stream
• A blank part of the flowsheet to place a product

Using Heat and Work Streams

You can define heat and work streams to transfer heat and power between
blocks, or for duty and power specifications. For example, you can use a work
stream to transfer power from a turbine to a compressor. For more information
on Heat and Work streams, see Chapter 9.

When creating a heat or work stream:
• Select the heat or work icon from the Model Library.
• Use a port labeled Heat Stream(s) or Work Streams(s).

Heat and work streams appear as dashed lines in the flowsheet.

Using PseudoProduct Streams

You can define pseudoproduct streams to represent column internal flows,
compositions, thermodynamic conditions streams for some unit operations
models. For more information, see Chapter 9.

Pseudoproduct streams from one block may be an inlet to another block. Using a
pseudo-stream as a block inlet results in an imbalance in the overall flowsheet
material and energy balance report.

To define a pseudoproduct stream:

➤ When creating the stream select a port labeled Pseudo Streams.
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Viewing The Flowsheet

If your flowsheet contains more than a few blocks, your workspace will soon be
full.

Sometimes block and stream IDs appear off the screen, so it is difficult to locate a
particular block or stream.

To display a block that is off the screen or a specific part of the flowsheet, you can
use the:
• Zoom level
• Scrollbars
• Data Browser
• Bookmarks
• Pan

Adjusting the Zoom Level
To change your view of the flowsheet by zooming:

➤ From the View menu point to Zoom, then the option you require.
– or –

1. Position the mouse pointer in an empty area of the Process Flowsheet window
and click the right mouse button.

2. From the menu that appears, click:

This zoom option To

Zoom In Zoom in

Zoom Out Zoom out

Zoom Full Show the full flowsheet

With the view zoomed in, you can display a specific part of the flowsheet by using
the scroll bars.

Adjust the effect of Zoom In and Zoom Out by selecting Options from the Tools
menu and changing the value of the Zoom Scale Factor on the Grid/Scale tab.
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Using the Scrollbars
If you are working in a large flowsheet, the block you want to connect to may be
off the screen. You can use the scrollbars to display:
• A block that is off the screen
• A specific part of the flowsheet

To use the Workspace scrollbars:

➤ Click a scrollbar arrow.
The amount that this moves the view is determined by the Scroll Step Size on
the Grid/Scale tab of the Tools Options dialog box.
– or –

➤ Click between the slider and an arrow.
This moves the view by a set amount.

Using the Data Browser to Find Blocks in a Large
Flowsheet

If you are working in a large flowsheet, it may be difficult to locate a particular
block. You can use the Data Browser to find a block:

1. From the Data menu, click Data Browser (or press F8).

2. Expand the Blocks folder.

3. Select the block that you want to find.

4. Return to the Process Flowsheet window, without clicking it. To do this:

If you are in this view Do this

Normal From the Window menu, click Process Flowsheet window
– or –
Click the titlebar of the Process Flowsheet window

Flowsheet as Wallpaper Minimize or close the Data Browser

Workbook Click the Process Flowsheet tab

The block you selected is highlighted.

5. Click the block with the right mouse button and from the menu that appears,
click Center View.

6. Click an empty part of the flowsheet and click with the right mouse button,
and from the menu that appears, click Zoom In if you want a closer view.
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Using Bookmarks
If you are working in a large flowsheet, there may be sections that you want to
look at frequently. Use Bookmarks to save these views.

To create a bookmark:

1. While in Select mode, click and drag to select an area of the flowsheet.

2. Click the right mouse button and from the menu that appears, click
Bookmarks.

Tip  You can also press F3 to access Bookmarks.

3. Type a name for the Bookmark in the Name box, then click Add to add the
bookmark to this list.

4. To exit the Bookmarks dialog box, click Close.

To go to a bookmarked view:

1. In the Process Flowsheet window, click the right mouse button.

2. From the menu that appears, click Bookmarks.

Tip   You can also press F3 to access Bookmarks.

3. Click the name of the desired Bookmark, then click Go To.

4. The flowsheet appears in the predefined view you selected.

Using Pan
Use Pan to select a view of the flowsheet at the current zoom level.

1. In the Process Flowsheet window, click the right mouse button.

2. A full view of the flowsheet appears and a dashed rectangle

3. Move the rectangle to an area that you wish to zoom in on and click the left
mouse button.

4. To cancel pan, click the right mouse button.
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Checking Flowsheet Completeness

To check completeness for the entire flowsheet, look at the status indicator in the
bottom right of the main window.

If the status is Flowsheet Not Complete, then flowsheet connectivity is incomplete
because:
• Additional streams must be connected to one or more blocks in the flowsheet.
• Streams have been disconnected but not reconnected.
• No blocks have been defined.
• To find out why the connectivity is incomplete:

➤ Click the Next button  on the Data Browser toolbar.

A Flowsheet Not Complete window indicates what is required to complete the
flowsheet definition.

If any other status message appears, then flowsheet connectivity is complete.
All required streams are connected to flowsheet blocks.

Modifying the Flowsheet

You can modify the flowsheet at any time to:
• Change its connectivity
• Improve the appearance
• Redraw all or part of the flowsheet

Changing Flowsheet Connectivity
To change the flowsheet connectivity, you can:
• Delete blocks and streams
• Rename blocks and streams
• Change stream connections
• Insert a block into a stream
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Deleting Blocks and Streams

To delete a block or stream:

1. Click the block or stream to select it.

2. Click with the right mouse button on the block or stream.

3. From the popup menu that appears, click Delete Block or Delete Stream

4. When prompted, click OK.

Tip   You can also select the block or stream, then press Delete on the
keyboard.

Renaming Blocks and Streams

To rename a block or stream from the flowsheet:

1. Select the block or stream you want to rename.

2. Click the right mouse button on the block or stream.

3. From the menu that appears, click Rename Block or Rename Stream.

4. When prompted, enter the new name and click OK.

You can also rename blocks and streams using the Data Browser.

Options for Naming Blocks and Streams

By default, Aspen Plus automatically assigns IDs to blocks and streams. You can
either:
• Supply prefixes for the automatic naming
• Turn off the automatic naming and be prompted for a name for each block

and stream as you place it

To specify the naming options:

1. From the Tools menu, click Options.

2. Click the Flowsheet tab.

3. Select the Automatically Assign Block Name with Prefix and/or Automatically
Assign Stream Name with Prefix check box(es).

4. If desired, you can also type a prefix in the field. A sequential number is
added to the prefix. If no prefix is supplied, the blocks or streams are
numeric.
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For more information on flowsheeting options, see Chapter 16.

Changing Stream Connections

You can disconnect the end of a stream from a unit operation block and then
connect it to another port on the same or a different block. To change the port
that a stream is connected to:

Method 1:

1. Click to select the stream that you want to move or click the block to which
the streams is connected.

2. Position the mouse pointer where the end of the stream connects to the block,
so the arrow is highlighted and a text box with the name of the port appears.

3. Hold down the left mouse button and the mouse pointer changes to the port
move shape.

4. Move the stream end away from the block. The mouse pointer changes to the
disconnect shape indicating that the stream is about to be disconnected.

5. Click the mouse button to disconnect.
For each block all available ports are highlighted. For example, for a feed
stream, the outlet ports are highlighted. The ID of the stream appears in a
text box by the end that is being reconnected. Ports that must have at least
one stream connected are shown in red. Others are shown in blue.

6. Click the port to which you want to connect the stream end.

Method 2:

1. Click the stream.

2. Click the right mouse button.

3. From the menu that appears, click:
• Reconnect Source to disconnect the source end of the stream
• Reconnect Destination to disconnect the output end of the stream

For each block all available ports are highlighted. For example, for a feed
stream, the outlet ports are highlighted. The ID of the stream appears in a
text box by the end that is being reconnected. Ports that must have at least
one stream connected are shown in red. Others are shown in blue.
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4. Continue as you would for a new stream. Click the port to which you want to
connect the stream end, or click a blank part of the flowsheet to place a feed
or product.

Inserting a Block into a Stream

To insert a block into a stream:

1. Place the new block on the flowsheet by selecting a unit operation model from
the Model Library and dragging it to the flowsheet. For more information, see
Placing Blocks on page 4-2.

2. Select the desired stream and click the right mouse button on the stream.

3. From the menu that appears, click Reconnect Source or Reconnect
Destination.

4. Click a port on the new block to reconnect the stream to it.

5. Connect a new stream from the new block to the original source or
destination, by clicking the STREAMS icon and clicking the inlet or outlet
port. For more information, see Placing Blocks on page 4-2.
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Improving the Appearance of the Flowsheet
You can change the flowsheet layout at any time to improve the appearance of
your drawing. You can move:
• Blocks
• Multiple blocks and streams at once
• Block IDs
• Stream segments
• Stream corners
• Streams IDs
• Stream connnection locations

You can also:
• Hide block and stream IDs
• Reroute streams
• Align blocks
• Change icons
• Resize icons
• Rotate icons
• Use Place to redraw flowsheets automatically

Many commands and actions can apply to multiple blocks or streams as well as
to an individual one. .

You can select multiple blocks and streams in several ways:
• Click and hold the mouse button while dragging the mouse over a region.
• Hold down the Ctrl key while clicking on the blocks or streams
• Click the right mouse button in the Process Flowsheet window.  From the

menu that appears, click Select All
Click here for information on moving multiple objects at once.

Moving Multiple Objects at Once

To move multiple objects at once:

1. Select the objects you want to move.

2. Hold down the mouse button on any object within the region.

The mouse pointer changes to the move shape ( ).

3. Drag the objects to the location you want, and release the mouse button.
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Tip   You can also select multiple objects and then use the arrow keys
(←↑→↓) to move them to the new location.

Moving a Block

To move a block:

1. Press and hold down the mouse button on the unit operation block (but not on
the block ID) that you want to move.

The outline of the block is highlighted and the mouse pointer changes to the
move shape. Also a text box appears showing information about the block,
including name, section and status of the block.

2. Drag the block to the location you want and release the mouse button.

When you place or move blocks, the center of the block icon snaps to a grid
location if Snap to Grid is enabled. For information on changing the grid
options, see Chapter 16.

Tip   You can also select the block and then use the arrow keys
(←↑→↓) to make minor adjustments to the position of the block.
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Moving a Block ID

To move a Block ID:

1. Press and hold down the mouse button on the block ID.

The mouse pointer changes to the move shape ( ).

2. Drag the block to the location you want and release the mouse button.

Tip   You can also select the block ID and then use the arrow keys
(←↑→↓) to move the block ID.

If you later move the block, the ID maintains its position relative to the block.

Hiding a Block or Stream ID

To hide a block or stream ID:

1. Click the block or stream in the flowsheet to select it.

2. From the Flowsheet menu, point to Hide and then ensure ID is checked.

– or –

Click the right mouse button and from the menu that appears, point to Hide
and then ID.

– or –

Press CTRL + H on the keyboard.

Tip   To hide the block IDs for all future blocks created, clear the Display
Block Name checkbox on the Flowsheet tab of the Tools Options dialog box.
For more information, see Chapter 16.

Changing the Icon

To change an icon:

1. Click the block whose icon you wish to change.

2. Click with the right mouse button on the block.

3. From the popup menu that appears, click Exchange Icon.

4. The icons for the block changes to the next icon in the list for the model.
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Tip   You can also change the icon by clicking the block, then pressing the
letter n to change to the next icon available for the block, or p to change to the
previous available icon.

Rotating Icons

To rotate an icon:

1. Click the block whose icon you wish to rotate.

2. Click with the right mouse button on the block.

3. From the menu that appears, click Rotate Icon.

4. A submenu appears, allowing you to rotate the icon to the right (clockwise) or
left, or flip the icon around either axis (for example, to reverse flow direction).

Tip   You can also use the buttons on the Process Flowsheet toolbar

 to rotate and flip an icon.

Resizing Icons

To resize an icon:

1. Click the block whose icon you wish to resize.

2. Click with the right mouse button on the block.

3. From the menu that appears, point to Resize Icon, then Shrink or Enlarge to
shrink or enlarge the icon by a built-in factor.

– or –

Position the mouse pointer over one of the corners of the block icon until the
Resize mode pointers appear. Drag the mouse pointer until the icon until it is
the desired size.

Aligning Blocks

To align two blocks:

1. Click the stream between the two blocks.

2. Click with the right mouse button on the stream.

3. From the menu that appears, click Align Blocks.

Tip   You can also select one or more streams and press CTRL + B.
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Note  Blocks attached to selected streams are aligned on a grid if Snap to
Grid is enabled on the Grid/Scale tab. For information on this, see
Chapter 16.

Moving Stream Connection Locations

To move the point where a stream connects to a unit operation block without
changing the stream's connection to its current port on the icon:

1. Click the stream that you want to move or click the block to which it is
connected. The stream is selected.

2. Position the mouse pointer where the end of the stream connects to the block.

3. The arrow is highlighted and a text box with the descriptions of the port
appears.

4. Hold down the left mouse button. The mouse pointer changes to the move
shape.

5. Drag the stream end to the preferred point on the block and release the
mouse button.

Moving the stream end does not move the port to which the stream is
connected. Consequently, the point where the stream end is now attached to
the block is not a port and may not be used to directly connect further
streams.

6. To display the location of the port, click the stream end:
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port

Relocated
stream end

Tip   You can also move any part of the stream by selecting it and dragging
the part of the stream you want to move to its new location.

Moving a Stream Segment

To move a stream segment:

1. Press and hold down the mouse button on the segment of the stream you wish
to move (but not on the stream ID).

2. The mouse pointer changes to the move shape.

3. Drag the segment of the stream to the location you want and release the
mouse button.

Tip  You can also select the stream and then use the arrow keys (←↑→↓)
to make minor adjustments to the position of the stream.

Moving a Stream Corner

To move a stream corner:

1. Press and hold down the mouse button on the corner of the stream (but not on
the stream ID).
The mouse pointer changes to the move shape.

2. Drag the corner of the stream to the location you want and release the
mouse button.

Tip   You can also select the stream and then use the arrow keys (←↑→↓) to
make minor adjustments to the position of the stream.
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Moving a Stream ID

You cannot move a stream ID off a stream but you can move a stream ID along a
stream. To do this:

1. Press and hold down the mouse button on the stream ID, until the mouse

pointer changes to the move shape ( ).

2. Drag the block to the location you want and release the mouse button.

Rerouting Streams

To reroute a stream automatically:

1. Click the stream you wish to reroute.

2. Click the right mouse button on the stream.

3. From the menu that appears, click Reroute Stream.

Tip   You can also select one or more streams and then press CTRL + J to
reroute them.

Using Place and Unplace to Redraw the Flowsheet

When you want to make several changes to the layout of all or part of a
flowsheet, you might find it easier to temporarily remove (unplace) one or more
blocks and then replace them.

To do this, use Place and Unplace to redraw all or part of the flowsheet at any
time. You can place:
• All of the blocks at once and let Aspen Plus choose the layout
• Blocks one at a time to create the layout you want

Before you can redraw the flowsheet, you need to temporarily remove (or
unplace) one or more blocks:

To remove Do this

A group of blocks Select a group of blocks.
Click the right mouse button on one of the blocks and
from the menu that appears, click Unplace Blocks..

 A single block Select a block.
Click the right mouse button and
from the menu that appears, click Unplace Blocks.
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The unplaced blocks appear in the Unplaced Blocks dialog box.

Tip   You can also select one or more blocks and then press CTRL + U to
unplace them.

Using Place to Place a Block on the Flowsheet

Use Place to place an individual block on the flowsheet. Do this when you want to
achieve a specific layout.

To place an unplaced block on the flowsheet yourself:

1. In the Unplaced Blocks dialog box, click and hold down the mouse button on
the ID of the block that you want to place.

2. Drag the block to the flowsheet and drop it where you want the block located.

If you want Aspen Plus to place the next block automatically:

➤ In the Unplaced Blocks dialog box, click Place Next.
Aspen Plus selects the block that logically should appear next in the
flowsheet and places it in the appropriate position. This will not necessarily
be the block listed first in the Unplaced Blocks dialog box.
If you do not like where Aspen Plus has placed the block, move it to a
different location.

As you place blocks, the streams that connect them also appear. You can move
stream segments or corners to achieve the desired routing.

Using Place All to Place All the Blocks at Once

If the number of unplaced blocks is small or you are not concerned about the
layout of the flowsheet, you can place any unplaced blocks quickly by using Place
All to place all the blocks on your flowsheet at once.

Aspen Plus chooses the layout for you.
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To place all the blocks at once:

1. Select a block or group of blocks.

2. Click the right mouse button.

3. From the popup menu that appears, click Unplace Blocks.

4. In the Unplaced Blocks dialog box, click Place All.

5. Move individual blocks and reroute streams if necessary.

About Flowsheet Sections

A flowsheet section is a group of blocks and streams within the flowsheet. Use
flowsheet sections to:
• Enhance clarity
• Simplify viewing and printing large flowsheets
• Simplify assignments of physical property specifications or stream classes

A stream belongs to a flowsheet section if it is an outlet of a block in the section.
A process feed stream belongs to a section if it is an inlet to a block in the section.

To see which section a block or stream belongs to, select the block or stream and
a text box with the information will be displayed while the pointer is over the
selected item.

Aspen Plus predefines a default section GLOBAL for your convenience. It assigns
all blocks to GLOBAL unless you create additional sections.

Use the Properties Specifications Flowsheet Section sheet to specify physical
property options for sections.

The remaining sections of this chapter describe how to create and use flowsheet
sections.

Creating a Flowsheet Section
To create a new flowsheet section:

1. From the Flowsheet menu, click Flowsheet Sections.

2. On the Flowsheet Sections dialog box, click New.
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3. Enter an ID or accept the default ID then click OK.

The new section becomes the current section. Any additional blocks you create
are assigned to this section, until you select a new current section.

Tip   You can use this button  on the Section toolbar to quickly open the
Flowsheet Sections dialog box.

Specifying the Current Section
The current section is shown by the Section box on the Section toolbar. All new
blocks defined using graphics are assigned to the current section.

To change the current section:

1. From the Flowsheet menu, click Flowsheet Section.

2. In the Flowsheet Sections dialog box, select a section from the list or click the
New button and create a new section.

3. Click the Make Current button.

4. Click OK to close the Flowsheet Sections dialog box.

The section you selected becomes the current section. Any additional blocks you
create are assigned to this section, until you select a new current section.

Tip   You can use the current section list  on the Section toolbar
quickly specify the current section.

Using the Section Toolbar
The Section toolbar can be used to quickly change some options on the flowsheet
sections.

Specifies the
current selection

Display only the
current flowsheet
section

Opens the
Flowsheet
Sections dialog
box
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Moving Blocks to a New Section
To move blocks from one section to another:

1. In the Process Flowsheet window, select one or more blocks.

2. Click the right mouse button on a selected block and from the menu that
appears, click Change Section.

3. To move the block or blocks to a different section, select the Move to section
option and select a section from the list.

– or –

To create a new section, select the Create new section option and enter a
section ID or accept the default ID.

4. Click OK to close the Change Section dialog box.

The selected block or blocks are moved to the section you selected or created.

Specifying the Stream Class for a Section
The stream class assigned to section GLOBAL is the default stream class. By
default, Aspen Plus assigns the stream class for section GLOBAL to any new
sections you create.

To assign a different stream class to a section:

1. If the stream class you want to assign to the section does not contain the
appropriate substreams, use the Setup StreamClass form to modify it. For
more information, see Chapter 5.

2. From the Flowsheet menu, click Flowsheet Sections.

3. In the Flowsheet Sections dialog box, do one of the following:
• Select a section from the list
• Click the New button and create a new section

4. Click the Stream class button.

5. Select a stream class using the list. Click OK.

You can also use the Setup Specifications Global sheet to assign the GLOBAL
stream class.
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Viewing the Current Section
To view only the current section:

1. Click the Process Flowsheet window.

2. From the View menu, click Current Section Only.

Only the blocks and streams in the current section appear on the screen. Streams
to and from other sections are terminated by icons containing the ID of the other
sections.

To specify what is the current section see Specifying the Current Section on page
4-24.

Tip   You can use the   button on the Section toolbar to quickly view only the
current Flowsheet Section.

Printing a Flowsheet
To print a flowsheet:

1. Click in the Process Flowsheet Window to make it active.

2. Click the Printer button on the Standard toolbar.

– or –

From the File menu, select Print.

3. Choose the printer and desired settings in the Print dialog box.

4. Click OK.

Printing a Section of Flowsheet

To print a section of flowsheet:

1. From the Flowsheet menu, click Flowsheet Sections.

2. Choose the flowsheet section you want to print and click OK.

3. From the View menu, click Current Section Only.
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4. Click the Printer button on the toolbar.

– or –

From the File menu, select Print.

5. Choose the printer and desired settings in the Print dialog box.

6. Click OK.

For more information on printing, see Chapter 14.
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5 Global Information for
Calculations

This chapter explains how to specify and change all types of global information,
including:
• About global information
• Entering global specifications
• Overriding default simulation options
• Units of measure
• Report options

About Global Information

Global specifications establish defaults for an entire run. Specify global
information before entering any engineering specifications for your Aspen Plus
run.

You can override these defaults for specific objects on other sheets. Although you
can return to these forms and change entries at any time, it is recommended that
you use them before any others when starting a new run.
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Enter global specifications on the Setup forms. To access the Setup forms:

1. From the Data menu, click Setup.

2. The following table shows which form to use to enter information:

Use this form To

Specifications Enter global information

Simulation Options Specify calculations, flash convergence, and system options,
and time and errors limits

Stream Class Define stream class and stream properties

Substream Define substreams and attributes

Units Sets Define units-of-measurement sets

Report Options Specify report options

All of the global information you normally need to specify is on the Setup
Specifications Global sheet. When you create a new run, the Application Type
you choose establishes the defaults for the Global sheet. The Aspen Plus expert
system takes you to the Global sheet so you can view the defaults and change or
supplement them if you want to. For most simulations, it should not be necessary
to change the defaults on the other Setup sheets.

Entering Global Specifications

Use the Setup Specifications form to enter global specifications, accounting
report information, diagnostic levels, and a run description for reports. The
following table shows the information you can enter on each sheet:

On this sheet of the
Specifications form

Enter this information

Global Run type, run title, run description, global defaults (units, flow basis, phase equilibrium,
calculation options, stream class)

Accounting Run accounting information (required at some installations)

Diagnostics Simulation history and Control Panel diagnostic message levels

Description User supplied description of the simulation problem
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Global Sheet
Use this sheet to enter a run title, specify default input and output units of
measurement for the run, and specify global settings. The global settings include
Run Type, Input Mode, Stream Class, Flow Basis, Ambient Pressure, Valid
Phases, and Use Free Water Calculation.

You can override global specifications for individual unit operations blocks using
the Block Options form for each block.

Changing the Run Type

You specify a Run Type when you create a new run. You can change this run type
at any time.See Chapter 2 for a description of the available run types.

To change the run type:

1. On the Data menu, select Setup.

2. Click the Global sheet.

3. In the Run-Type box, select a run type.

Because each run type has different input requirements, changing the run type
may cause the input for the run to become incomplete. Use Next to guide you
through the required forms.

You can change the run type even after you have entered specifications for a
different run type. Aspen Plus hides forms that the new run type does not allow.
But if you switch back to the original run type, data entered on these hidden
forms are not lost.

Examples of when you might want to change the run type are:

• You used a Property Estimation run to estimate and examine properties for a
non-databank component. Now you want to run a flowsheet simulation using
that component. If you change the run type to Flowsheet, Aspen Plus retains
the component information and prompts you for the flowsheet information.

• You used a Property Estimation run to estimate and examine properties for a
non-databank component. Now you want to run property analysis or property
data regression involving that component. If you change the run type to
Property Analysis or Data Regression, Aspen Plus retains the component
information, and prompts you for additional information to complete your run
specifications.
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Specifying the Run Title

To specify the run title:

1. From the Data menu, click Setup.

2. Select the Global sheet.

3. In the Title box, specify a brief run title.

You can supply additional descriptive information about the run on the Setup
Specification Description sheet, and on the Comment forms available from any
input sheet.

Specifying Global Units Sets

You can specify separate global input and output units sets. For more
information about how to customize an existing unit set, see Units of Measure on
page 5-16.

This global units set Becomes the default for all

Input Data Input sheets in the run

Output Results Results sheets

To specify global units sets:

1. From the Data menu, click Setup.

2. Select the Global sheet.

3. Specify the global units sets in the Input data and Output results boxes.

You can change the global units set specifications at any time. When you change
the Input Data set, all new input forms you display default to the new units set.
Aspen Plus does not change the units on forms you have already completed.
When you change the Output Results units set, all results sheets default to the
new units set after you complete a run.

Selecting a Default Stream Class

Stream classes define structures for simulation streams when solid substreams
are present. When you create a new run, Aspen Plus chooses a default stream
class based on the application type. You can change the default stream class on
the Setup Specifications Global sheet.

To change the default stream class:

1. From the Data menu, click Setup.

2. Select the Global sheet.
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3. In the Stream Class box, select a stream class.

All streams in the simulation are assigned to the default stream class, unless you
assign a stream class to one of the following:
• A flowsheet section
• An individual stream, on the Stream-Class Streams sheet

For more information on using and creating stream classes, see Chapter 9.

Selecting the Simulation Flow Basis

You can enter specifications for most flows on a molar, mass, or standard liquid
volume basis. For example, you can enter total stream flow rate on any of these
bases.

To select the global basis for flow-related information:

1. On the Data menu, select Setup.

2. Select the Global sheet.

3. In the Flow-Basis box, specify Mass, Mole, or StdVol.

The basis you select becomes the default basis for the run. You can override the
basis locally on most forms.

You can return to the Setup Specifications Global sheet and change the default
basis at any time. The basis for previously entered values does not change.

Specifying Ambient Pressure for Gauge Pressure Units

Aspen Plus accepts gauge pressure units for all pressure variables. The default
value for the ambient pressure is 1 atm.

To change the ambient pressure:

1. From the Data menu, click Setup.

2. Select the Global sheet.

3. In the Ambient Pressure box, type a pressure. Change the units if necessary.

Specifying Valid Phases

Aspen Plus performs phase equilibrium calculations throughout a simulation run
for blocks, streams, and other objects. You can specify the valid phases to be used
in these calculations. Choose from Vapor-Only, Liquid-Only, Vapor-Liquid, and
Vapor-Liquid-Liquid.
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To change the valid phases:

1. From the Data menu, click Setup.

2. Select the Global sheet.

3. In the Valid phases box, select either Vapor-Only, Liquid-Only, Vapor-Liquid,
or Vapor-Liquid-Liquid.

You can override the global setting locally, at the individual block or stream
level, using the Valid Phases box.

Requesting Free Water Calculations

Aspen Plus can handle the presence and decanting of water as a second liquid
phase in water-hydrocarbon systems. Free-water calculations:
• Assume the water phase is pure
• Use special methods for calculating the solubility of water in the organic

phase

To request free-water calculations globally:

1. From the Data menu, click Setup.

2. Select the Global sheet.

3. Select the Use Free Water Calculations check box.

You can override the global setting locally, at the individual block or stream
level, using the Valid Phases box to select Vapor-Liquid-Free Water.

Description Sheet
Use this sheet to enter the description for the simulation. The description you
enter on this sheet will be printed once, at the beginning of the report. You can
enter any amount of text in uppercase and lowercase letters to document your
run in more detail. You can use any number of lines to enter text. However, you
cannot exceed the maximum length of each line (72 characters): the excess will be
truncated.
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Specifying a Run Description

To specify a run description:

1. From the Data menu, click Setup.

2. Select the Description sheet on the Setup Specifications form.

3. Enter a description in the Description box.

Tip You can write a description in your text editor (for example,
Notepad) and then copy and paste it onto the Description sheet.

Accounting Sheet
Use this sheet to enter run accounting information (required at some
installations). The accounting information includes: a user name, an account
number, a project ID, and a project name. This information is stored for the run
by the Aspen Plus Run Accounting System, if it is active for your installation.

Accounting Report Information

Accounting report information tracks the use of Aspen Plus at your installation.
This information may be required at some installations.

To specify run accounting information:

1. From the Data menu, click Setup.

2. Select the Accounting sheet on the Setup Specifications form.

3. In the User Name box, specify a username.

4. In the Account Number box, specify an account number.

5. In the Project ID box, specify a project ID.

6. In the Project Name box, specify a project name.

The Aspen Plus Run Accounting System logs this information for the run, if it is
active for your installation.
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Diagnostic Sheet
Aspen Plus writes progress and diagnostic messages to the Control Panel and the
History File during a run. The default for all types of messages is level 4. You can
control the amount of diagnostic information produced, although it is generally
not necessary. It is sometimes necessary to increase the level in order to converge
a flowsheet or to debug user Fortran.

Use this sheet to override defaults for simulation history diagnostic message
levels and Control Panel message levels printed. You can set message levels and
diagnostics for input translation, simulation, physical properties, stream,
convergence, Fortran variables, cost and economics.

Specifying Global Defaults for Diagnostic Information

To specify global defaults for diagnostic information:

1. From the Data menu, click Setup.

2. Click the Diagnostics sheet.

3. Use the slider controls to adjust the message levels you want to change. The
slider on the top of each line is for the Control Panel messages, and the slider
on the bottom is for the History File messages.

4. Click the History Options button to change the print options for the History
file. Check Insert files used in the simulation or Sorted input if this
information is desired in the History file.

Tip You can override the global defaults locally, using the Block
Options sheets for streams, blocks, property tables, and other
objects that perform calculations.

Setup Simulation Options

Use the Setup Simulation Options form to override defaults for simulation
options set by Aspen Plus. Aspen Plus provides defaults for performing energy
balances and convergence calculations. Aspen Plus also has default time limits.
You can use this form to override these defaults. You also can specify simulation
options at the individual block level.
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This table shows which sheets are used for which information:

Sheet Information

Calculations Options for Heat and mass balances, molecular weight from formula,
reinitialize calculations, bypass Prop-Set calculations, reaction stoichiometry checking

Flash Convergence Global temperature and pressure limits, maximum iterations, flash tolerance, extrapolation
threshold for equations of state

System Interpret or compile Fortran, unit operation model and Fortran error checking

Limits Simulation time and error limits

Calculations Sheet
Use this sheet to specify calculation options for:
• Checking mass balances around blocks
• Performing mass-balance-only calculations
• Calculating component molecular weight from atomic formula
• Using results from a previous convergence pass
• Bypassing prop-set calculations if flash fails

You can also use this sheet to specify reactions stoichiometry error checking
options.

Checking Mass Balances Around Blocks

Aspen Plus performs a mass balance check around each block as it is executed
and at the end of the simulation. Mass balance checking is performed with a
relative tolerance of 0.0001.

Imbalances can occur for numerous reasons — for instance, improper
stoichiometry or yield fraction specifications, loose convergence tolerances,
inconsistent user kinetic rates, or flows changed by Calculator, Transfer, or
Balance blocks. Mass balance checking will point out these imbalances and in
many cases provide the reason for the imbalance.

You can turn off this checking to lower the number of error or warning messages
generated during a simulation. To disable mass balance checking around blocks:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser window, select the Simulation Options
form.

3. Click to clear the Check Mass Balance Error Around Blocks check box.
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About Mass-Balance-Only Simulations

Mass-balance-only simulations:
• Are appropriate when energy balances are not required
• Do not calculate enthalpies, entropies, or free energies, thus reducing

calculation time
• Reduce data input requirements for physical property parameters

Mass-balance-only simulations do not require:
• CPIG, DHFORM, and DGFORM parameters
• Parameters for models that calculate only enthalpy, entropy, or free energy

To request a mass-balance-only simulation:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser window, select the Simulation Options
form.

3. Click to clear the Perform Heat Balance Calculations check box.

In a mass-balance-only run, you can use these unit operation models without
restriction:

CFuge HyCyc

Crusher Mixer

Cyclone Mult

Dupl Screen

ESP Sep

FabFl Sep2

Filter SSplit

FSplit VScrub

You can use these models only if you do not specify heat duty:

CCD RBatch

Decanter RCSTR

Distl RPlug

DSTWU RSstoic

Flash2 RYield

Flash3 SWash

Heater
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You cannot use these models in a mass-balance-only run:

BatchFrac PetroFrac

Compr Pipeline

Crystallizer Pump

Extract RadFrac

HeatX RateFrac

MCompr REquil

MHeatX RGibbs

MultiFrac SCFrac

Heat and work streams are not allowed in a mass-balance-only simulation.

Calculating Molecular Weight from Formula

The molecular weight is available in Aspen Plus databanks (parameter MW).
However, the databank molecular weight value may not contain enough
significant figures for certain applications for which atomic balance is important,
such as reactor modeling.

Aspen Plus calculates the molecular weight for all components in the simulation
from the molecular formula (parameters ATOMNO and NOATOM) and the
atomic weight. The calculated molecular weight is more accurate than the
databank molecular weight. By default, the calculated molecular weight is used
in the simulation.

To request to calculate from the formula in a simulation:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser window, select the Simulation Options
form.

3. Click the Calculate Component Molecular Weight from Atomic Formula check
box.

Reinitializing Calculations

By default, iterative calculations in Aspen Plus use any available previous
results as an initial guess. If necessary, you can override this default and request
that all calculations be reinitialized each calculation pass.

Request reinitialization when:
• A block has multiple solutions and you can obtain the one you want only by

starting from your own initial estimate.
• A block or flowsheet fails to converge for no apparent reason, after one or

more successful passes.
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To request reinitialization globally:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser window, select the Simulation Options
form.

3. On the Calculations sheet, click to clear the Use Results from Previous
Convergence Pass check box.

If the Use Results from Previous
Convergence Pass check box is

Then Aspen Plus

Selected Uses results from a previous calculation pass as the initial guess for the new pass

Clear Performs initialization or uses initial estimates at every new calculation pass

You can override the global setting:
• At the block level, on the Block Options sheet for the block
• Interactively, using the Reinitialize commands from the Run menu

If the reinitialization option for a block is clear when you request
reinitialization interactively, reinitialization occurs only on the next
calculation pass.

Bypassing Prop-Set Calculations When Flash Fails

By default, Aspen Plus will not calculate the property sets if a flash error occurs.

If the property sets are calculated when severe flash errors occurs, the property
set calculations may be unreliable, and may cause further errors.

To request to calculate the prop-set calculations even when the flash fails:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser window, select the Simulation Options
form.

3. On the Calculations sheet, clear the Bypass Prop-Set Calculations if Flash
Failure Occurs checkbox.

Checking Reaction Stoichiometry

If reactions stoichiometry (such as Reactors, Chemistry, Reaction) is specified,
Aspen Plus checks the mass-balance of stoichiometry based on the stoichiometric
coefficient and molecular weight of the components.
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You can use the option button to select whether Aspen Plus gives an error or a
warning during Input translation if mass imbalance occurs. Simulation will not
proceed if an error occurs during Input translation.

You can also use the Mass Balance Error Tolerance box to specify the absolute
tolerance of the mass balance check of stoichiometry. The default value of the
tolerance is 1 kg/kgmole.

The error severity depends on the Mass Balance Error Tolerance and what
checking option you specify:

Checking Option Absolute Error Error Severity

Issue Error When Mass Imbalance Occurs > Tolerance Error

Issue Error When Mass Imbalance Occurs < Tolerance and  > 0.01 Warning

Issue Warning When Mass Imbalance
Occurs

> Tolerance Warning

To request a warning rather than an error to be issued when a mass imbalance
occurs:

1. On the Data menu, click Setup.

2. In the left pane of the Data Browser window, click the Simulation Options
form.

3. On the Calculations sheet, select the Issue Warning when Mass Imbalance
Occurs check box.

4. The tolerance can be changed by typing a new tolerance in the Mass Balance
Error Tolerance box.

Flash Convergence Sheet
Use the Flash Convergence sheet to specify calculation options for setting:
• Upper and lower limits of temperature for flash calculations
• Upper and lower limits of pressure for flash calculations
• Flash options for flash calculations
• Extrapolation threshold for equations of state
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Specifying Temperature and Pressure Limits

To specify upper and lower limits on the temperature and pressure variables
used in iterative flash and distillation calculations:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser window, select the Simulation Options
form.

3. Select the Flash Convergence sheet on the Simulation Options form.

4. Use the Lower Limit and Upper Limit boxes to specify upper and lower limits
for temperature and pressure.

These limits apply to the entire simulation. You cannot override them locally.

Specifying Global Flash Options

Aspen Plus performs phase equilibrium (flash) calculations throughout a
simulation run, for blocks, streams, and other objects. You can specify global
values for the maximum number of iterations and the convergence tolerance to
be used in these calculations.

The flash tolerance may need to be tightened (lowered) in complex simulations
with a number of recycle loops in order to help the convergence For more
information on convergence, see Chapter 18.

To specify global flash options:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser window, select the Simulation Options
form.

3. Select the Flash Convergence sheet.

4. In the Maximum Number of Iterations box, specify the default for the
maximum number of flash iterations.

5. In the Tolerance box, specify the default flash tolerance.

You can override the maximum number of flash iterations and flash tolerance on
forms for blocks, streams, and other calculations.
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Specifying Extrapolation Threshold for Equations of
State

All equations of state in Aspen Plus use a root finder to calculate the molar
volume iteratively at given temperature, pressure and mole fractions. Given
physically meaningful conditions, the real molar volume root can always be
located by the root finder. However, during iterative calculations in flash or a
distillation model, the temperature, pressure, compositions and phase
specification may be such that a real molar volume root does not exist.
Aspen Plus provides an estimate of the molar volume that is reasonable, allowing
the flash or distillation algorithm to converge to a physically meaningful solution.

If you encounter convergence problems due to extrapolation of an equation of
state root finder, you can improve performance by changing the extrapolation
threshold. A smaller value of the threshold makes it less likely for the
extrapolation to occur.

To specify the extrapolation threshold for equations of state:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser window, select the Simulation Options
form.

3. Select the Flash Convergence sheet.

4. In the Extrapolation Threshold for Equation of State box, specify a value for
the extrapolation threshold.

This limit applies to the entire simulation. You cannot override it locally.

System Sheet
Use this sheet to override the defaults for system options that affect error
checking and handling of in-line Fortran statements:

You can override these defaults:
• Interpret all in-line Fortran statements at execution time
• Compile all Fortran statements into the Aspen Plus main program
• Check unit operation block for errors and inconsistencies
• Print Fortran tracebacks when a Fortran error occurs
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Limits Sheet
Use this sheet to specify limits for:
• Maximum CPU time for a batch run
• Maximum number of severe errors for a batch run
• Maximum number of Fortran errors for a batch run
• Maximum number of errors and warnings printed in the History file

Units of Measure

Use the Units Sets form to create new user-defined units sets and to view
existing units sets. A units set is a collection of units for each dimensional
quantity in Aspen Plus.

A units set defined using this form can be specified in the Input Data or Output
Results boxes on the Setup Specifications Global Sheet or on the Units box on the
toolbar of the Data Browser.

Sheet Information

Standard List and select an existing units set as a base for a new units set;
search for all the dimensional quantities alphabetically;
specify flow, temperature, and pressure-related units

Heat Specify enthalpy, heat, heat capacity, and entropy-related units

Transport Specify volume, density, transport-related and miscellaneous thermo units

Concentration Specify energy/power, time, concentration, and composition-related units

Size Specify size, equipment sizing, cost, and column sizing-related units

Miscellaneous Specify miscellaneous units

Selecting Units of Measure
A units set is a collection of units specifications for each dimensional quantity
used in Aspen Plus. Aspen Plus provides these basic units sets:
• International system units (SI)
• English engineering units (ENG)
• Metric engineering units (MET)
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Additional built-in units sets are available, depending on which Application Type
you choose when you create a new run.

In Aspen Plus you have complete flexibility in specifying units of measure. You
can specify units on three different levels:

Level For For input sheets For results sheet

Global units sets Entire run Yes Yes

Sheet units set Individual form or object Yes Yes

Field units Individual fields or a group of
fields

Yes Yes

Viewing Units Specifications

To see what units are specified by a units set:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser window, select the Units Sets folder.

3. In the Units Sets object manager, select the units set you want to view and
click Edit.

The unit types used by Aspen Plus appear on six sheets: Standard, Heat,
Transport, Concentration, Size, and Miscellaneous.

4. Select a sheet and view the units specifications.

You can create your own units sets on the Setup Units Set sheets. The following
sections describe how to specify units for each level, andhow to define your own
units set.

Specifying Units Sets for Forms or Objects

You can override the global units sets for individual forms and objects, such as
for a block, stream, or property table. To do this:

➤ On the Data Browser toolbar, use the Units box to select a units set.

A units set specification applies to all forms for an object.

For example, if you specify a units set on the Data Browser toolbar while the
RadFrac Setup Streams sheet is active, the new units set applies to all input
forms for the block. For each object, you specify units sets separately for input
forms and results forms.
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Specifying Units Sets for Fields

You can specify units for individual fields and groups of fields on an input form.
Selects units in the units fields next to the data fields.

Changing the units for an individual data field does not convert any value
entered previously. Aspen Plus assumes you entered the numeric value you
intend to use and that you will specify appropriate units for the value.

Defining Your Own Units Set

To define your own units set:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser, select the Units Sets form.

3. On the Units-Sets Object Manager, click New.

4. In the Create dialog box, enter an ID or accept the default ID for the units set
and click OK.

The unit types you can specify are on six sheets: Standard, Heat, Transport,
Concentration, Size, and Miscellaneous.

5. On the Standard sheet, use the drop down arrow in the Copy From/View box
to select an existing units set as the starting point for your new units set.
Choose the units set that is closest to the new set you are creating.

Aspen Plus fills in the units for each units type and a dialog box appears.

6. Click Yes or No.

7. If you select Yes, the global units of measurement for both Input data and
Output results are changed to the new units set.

8. Click the appropriate sheet and go to the units type you want to modify. Use
the drop down arrow to select the units option you want.

9. Repeat Step 6 for all units types you want to modify.

Tip To see all of the units types arranged alphabetically click the
Search button.

Example of Defining a New Units Set

1. Create a new units set, US-1, that is identical to the ENG units set, except
US-1 uses units of ATM for pressure and C for temperature.

2. From the Data menu, click Setup.
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3. In the left pane of the Data Browser, click the Units Sets form.

4. In the Units-Sets Object Manager that appears, click the New button.

5. Accept the default ID in the Create New ID dialog box (US-1).

6. Click OK. The Units-Sets Form appears with the Standard sheet displayed.

7. Aspen Plus asks if you want to make your new units set the global default for
subsequent specifications. After you have defined the new units set, you can
specify US-1 in the Units box in the Data Browser toolbar.

8. On the Copy From box, use the drop down arrow and select ENG as the set to
copy from. The ENG units set values appear in the units box.

9. On the Temperature box, use the drop down arrow and select C as the
temperature.

10. On the Pressure box, use the drop down arrow and select atm as the pressure.
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Report Options

Use the Setup ReportOptions form to customize the simulation report. See
Chapter 12, for more information on generating and accessing the reports.

Click one of the following for help on customizing the stream report:
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The following table shows what you can specify and where it is located:

On this sheet Specify

General Which sections of the report are included or suppressed

The major sections of the report are input summary, flowsheet, block, stream profiles, properties, sensitivity block, assay
data analysis, and inserts.

You can select if a report is generated at all. If this option is not selected, you cannot select any other report options.

You can also specify the number of lines that are printed on a page. The default number is 60 lines.

Flowsheet What flowsheet information is included

The items that can be included in the flowsheet report are the total mass and energy balance around the blocks, the
component mass balance around the blocks, the descriptions of all flowsheeting options, and the input and results of
convergence blocks, sequence, Calculator, Design specifications, constraints, optimization problems, and transfer
blocks.

These options are only available when the Flowsheet option is checked on the General sheet.

Block Which blocks and how much information to include or suppress from the report

Use the right arrow button to move blocks from the Available blocks list to the Selected blocks list to be included in the
report. The left arrow button is used to remove blocks from the Selected block list. The double arrows are used to move
all of the blocks in a list at once.

Items that can be included are a summary of user input and system defaults for each block, block results.

Also, each block report can be started  on a new page, and blocks can be listed alphanumerically or in the order that they
are listed on the flowsheet form.

These options are only available when the Block option is checked on the General sheet.

Stream What stream information is included and in what format. You can use the Standard form to tailor the Stream-Summary
report.

Use the Batch Operation button to select options for batch streams

Items that can be included in the stream report are any combination of Mole, Mass, or Standard Liquid Volume flow or
fraction, any number of property sets, component attributes, substream attributes, particle size distribution size limits and
stream structure information.

Streams can be listed alphanumerically or in the order that they are listed on the flowsheet form.

These options are only available when the Stream option is checked on the General sheet.

Property The property information to be included

Items that can be included are List of component IDs, formulas and names, the values in SI units of all physical property
parameters used in the simulation, property constant estimation results, and the values of all physical property
parameters along with the property parameters’ descriptions, equations and sources of data.

Additional property files [DMS format input file (*.DFM), Project data file (*.PRJ), and/or Property data format file (*.PRD)]
can also be generated automatically when you export a report file.

All of these options are only available when the Property option is checked on the General sheet.

ADA What assay data analysis information is included

Items that can be included are the list of generated pseudocomponents, a distillation curve report, and the values of all
pseudocomponent property parameters in SI units.

All of these options are only available when the ADA option is checked on the General sheet.
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Customizing the Stream Report
You can customize the stream format using these options:

Stream Report Options Description

Flow basis Display flow rate of each component in each streams in the basis
specified. Any combination of Mole, Mass, or Standard Liquid Volume
can be chosen.

Fraction basis Display fraction of each components in each streams in the basis
specified. Any combination of Mole, Mass, or Standard Liquid Volume
can be chosen.

TFF Table Format File used to specify the order and format of values printed
in the stream report. For more information, see Specifying Stream
Results Format on page 5-22.

Report width Print five streams (80 column) or ten streams (132 column) across a
page. Applies only to Report file.

Sort stream alphanumerically Streams sorted alphanumerically. Applies only to Report file.

Include components with zero flow or
fraction

Include components in the stream report, even if they have zero flow or
fraction.
If this option is not selected, components with zero flow or fraction are
not printed for that stream

Include Streams Specify which streams are printed in the report and order the streams.
Applies to the Report file and does not apply to the Stream Results Summary.

Property Sets Specify property sets for additional properties to be calculated and
printed for all of the streams.

Component Attributes Component attributes, particle size distribution values, particle size
distribution size limits and stream structure information can be printed
for all of the streams. Applies to the Report file and does not apply to the
Stream Results Summary.

Batch Operations Designated streams can be reported on a batch basis. For more
information, see Specifying Batch Streams on page 5-24.

Supplementary stream Specify additional (supplementary) stream reports.  A supplementary
report can have different options from the standard report.  A
supplementary stream report can be generated even if you suppress
the standard stream report. Applies to the Report file and does not apply to
the Stream Results Summary.

Specifying Stream Results Format

The table format file (TFF) determines the format (order, labels, precision, and
other options) of the stream results shown on the Stream Summary sheet.
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Aspen Plus provides built-in TFFs tailored to each Application Type, and chooses
an appropriate TFF for the Application Type you choose when you create a new
run. You can also create your own TFFs. For more information on this, see
Chapter 36.

You can specify the TFF in either of these places:
• Format box of the Results Summary Streams Material sheet
• Stream Format box on Setup ReportOptions Stream sheet

Aspen Plus uses the TFF you select in either box for all Results Summary
Streams Material sheets you display, until you select another TFF.

It is not necessary to re-run the simulation in order to see the results in another
format.

Including Streams

By default, all of the streams are included in the report.

To customize the list of streams to be included in the report:

1. Click the Include Streams button Setup ReportOptions Stream sheet.

2. The right arrow button can be used to move streams from the Available
streams list to the Selected streams list to be included in the report. The left
arrow button is used to remove streams from the Selected streams list. The
double arrows are used to move all of the streams in a list at once.

Designating Property Sets

In addition, you may designate property set IDs for additional stream properties
to be included in the report.

To customize the list of property sets to be included in the report:

1. Click the Property Sets button on the Setup ReportOptions Stream sheet.

2. The right arrow button can be used to move Property Sets from the Available
property sets list to the Selected property sets list to be included in the
report. The left arrow button is used to remove property sets from the
Selected property sets list. The double arrows are used to move all of the
property sets in a list at once.

Component Attributes

Use the Component Attribute button to select options for component attributes.

Any combination of the following can be printed for all of the streams:



Global
Informatio
n for
Calculatio
ns

5-24 Aspen Plus User Guide
Version 10.2

• Component attributes
• Substream attributes
• Particle size distribution (PSD) values
• Particle size distribution size limits
• Stream structure information

Specifying Batch Streams

Use the Batch Operation button to select options for batch streams. The Batch-
Operation form is used to designate streams as batch streams and to specify
• Cycle times
• Down times
• Operation times
• Number of parallel trains for these streams

You can specify just cycle time or any two of the three times.

An Aspen Plus simulation computes the average flow of all streams, assuming
continuous steady-state flows. You can designate any type of stream (material,
heat, or work) as a batch stream, to report it on a batch basis. Batch stream
reporting is used to represent:
• Batch charges
• Batch discharges
• Semi-continuous streams (streams that operate for only a portion of a

complete batch cycle)

Each batch stream can have different time specifications, such as cycle time or
down time.

All batch stream results appear in the standard stream report of the Aspen Plus
report file. The following information is reported:
• Cycle time
• Operation time
• Number of trains
• All material and energy flows in three ways:

• Average flow rate over entire cycle for all trains
• Total amount of material and energy per cycle per parallel production

train (average flow rate * cycle time / number of trains)
• Flow rate per train during actual operation

[ amount / cycle / train / operation time ]
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The Stream Results Summary sheet displays all batch stream results if you
select the FULL Table Format File (TFF) on the Format box. If you select
PHARM-E, PHARM-M, SPEC-E, or SPEC-M in the Format box, Aspen Plus
excludes the operating time, number of trains, and flowrate during actual
operation from the stream summary. If you select any other built-in TFF, the
stream summary form displays average flow rate of material and energy only. It
does not display batch stream results.

To designate a stream as a batch stream:

1. Click the Batch Operation button on the Setup ReportOptions Streams sheet.

2. In the stream box, select a stream ID from the list.

3. You can specify cycle time only, or two of the following times:
• Cycle time
• Down time
• Operation time (Zero indicates an instantaneous charge or discharge.)

4. You can also specify the number of parallel trains. The default is one.

About Supplementary Stream Reports

A supplementary stream report can be generated in the Report file. This
selection only applies to the Report file and does not affect the Stream Results
Summary in the graphical user interface.

You can print the standard stream report whether a supplementary stream
report is to be generated or not. A supplementary stream report can be generated
even if you suppress the standard stream report.

The options available for the Standard stream report are also available for the
Supplementary stream report. In addition, a subroutine can be used to generate
a user stream report. The subroutine is specified by clicking on the Subroutine
button.
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6 Specifying Components

This chapter explains how to define the components in your simulation and includes
information on:
• Forms for specifying component information
• Specifying databank and non-databank components
• Adding, deleting, and changing components
• Generating electrolyte components and reactions
• Identifying solid components
• Assigning attributes for conventional and nonconventional components
• Specifying supercritical (HENRY) components
• Specifying UNIFAC groups
• Defining component groups

Use these forms to specify component information:

Form Sheet What is Specified

Specifications Selection
Petroleum
Nonconventional
Databanks

All components used in a simulation
Assays, blends, and pseudocomponents
Nonconventional components
Pure component databanks to search for property parameters

Assay/Blend
Petro characterization

– Assays and blends. For more details, see Chapter 32.
Pseudo component characterization. For more details, see Chapter 32.

Pseudocomponents – Pseudocomponents data. For more details, see Chapter 32.

Attr-Comps Selection Component attributes assigned to conventional components

Henry Components Selection Sets of supercritical components for which Henry’s law is used in
activity coefficient property methods

UNIFAC Groups Selection UNIFAC functional groups

Comp-Group – Groups of components considered as a unit for tear stream
convergence
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About Databanks

Aspen Plus stores physical property parameters for a large number of
components in several databanks. In addition to the standard Aspen Plus
databanks, in-house databanks may be available at your site.

To see the available pure component databanks, and to see or change which
databanks are active for a simulation:

1. From the Data menu, click Components.

2. On the Specifications form, click the Databanks sheet.

3. Aspen Plus searches the databanks in the order listed in the Selected
Databanks list on this sheet. The default order is appropriate for most
simulations.

To change the search order for databanks in this simulation, click a databank
in the Selected Databanks list, and then click the up and down arrow keys to
move the databank higher or lower in the list.

Click here for information about changing search order globally.

4. You can choose additional databanks from the Available Databanks list and
add them to the Selected Databanks list using the right arrow button.

To remove a databank from the search, in the Selected Databanks list, click a
databank then click the left arrow button to move it to the Available
Databanks list.
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This table shows the contents and use of the pure component databanks included
with Aspen Plus:

Databank Contents Use

PURE10 Pure component parameters for
mostly organic components

Primary component databank in Aspen Plus

AQUEOUS Pure component parameters for ionic
and molecular species in aqueous
solution

Simulations containing electrolytes

SOLIDS Pure component parameters for strong
electrolytes, salts, and other solids

Simulations containing electrolytes and solids

INORGANIC Pure component parameters for
inorganic and organic components

Solids, electrolytes, and metallurgy applications

PURE856 Version of main pure component
databank delivered with Aspen Plus
Release 8.5-6

For upward compatibility with previous releases
of Aspen Plus

PURE93 Version of main pure component
databank delivered with Aspen Plus
Release 9.3

For upward compatibility with previous releases
of Aspen Plus

AQU92 Version of AQUEOUS delivered with
Aspen Plus Release 9.2

For upward compatibility with previous releases
of Aspen Plus

ASPENPCD Version of main pure components
databank delivered with Aspen Plus
Release 8.5-6

For upward compatibility with previous releases
of Aspen Plus.

COMBUST Pure component parameters for
combustion products, including free
radicals

For high temperature, gas phase calculations

For information on customizing the default order of the databanks, see Chapter
16.

Specifying Components from a Databank

You must:
• Ensure your simulation contains at least one component.
• Provide Aspen Plus with a list of all the components in the simulation
• Assign a component ID to each component. This ID will refer to the

component on all subsequent input forms, results forms, and reports.
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To specify the components:

1. From the Data menu, click Components.

2. In the Component ID box of the Selection sheet, type an ID for the component
you want to add. Every component must have a Component ID.

Exact match found in databank? Then Aspen Plus

Yes Fills in the Formula and Component name. Omit the remaining steps.

If you choose not to retrieve data, delete the formula or component name with the
backspace key.

No Requires you to enter the formula or component name, if you want to retrieve data from
the databank.

To specify the Formula or Component Name yourself, go to Step 3.

To use Find, click the Find button and go to Step 4.

3. This table shows what happens:

If you enter a And an exact match is Then Aspen Plus

Formula Found Fills in the Component Name. You need to specify the Component ID if it
has not already been done. Omit the remaining steps.

Formula Not found Displays the Find dialog box with any partial match results displayed. See
Step 4 for using the Find dialog box. Omit the remaining steps.

Component name Found Fills in the Formula. You need to specify the Component ID if it has not
already been done.

Component name Not found Displays the Find dialog box with any partial match results displayed. See
Step 4 for using the Find dialog box.

4. Use the Find dialog box to enter search criteria for your component.
On the Name or Formula sheet, you can search for strings contained in the
name or formula of a component. Using the Advanced sheet, any combination
of these items can be entered and used to search for a component:

If you enter a Then Aspen Plus searches for

Component name or formula Any components that include the string in any part of the component name or formula

Match only components beginning
with this string

Any components that include the string in the beginning of the component name or
formula

Component class A component that is in the component class category

Molecular weight Components in that molecular weight range

Boiling Point Components in that boiling point range

CAS number Component with that Chemical Abstracts Service registry number
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5. Click the Find Now button to display all of the components with your find
criteria. Then, select a component from the list and click Add to add it to the
components list. Click here to see an example of using Find.

6. When you finish searching for components, click Close to return to the
Selection sheet.
You can return to the Components Specifications Selection sheet at any time
while building your simulation, to add or delete components.

Example of Specifying Components

In this example, the Formula and Component Name for component CH4 are
automatically retrieved from the databanks. Data for components CH4 and
C4H10 is retrieved from the databanks. Component C3 is a non-databank
component.

Example of Using the Find Dialog Box

In this example, the advanced component Find dialog box is used to locate a
component that includes C3 in its formula and has a boiling point between 200
and 250 K.

To do this:

1. On the Components Specifications Selection sheet, select an empty
component ID field, then click Find.

2. In the Component Name or Formula box, enter C3.
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3. Select the Advanced sheet where you can also search for components based on
the chemical class, molecular weight range, boiling point range and CAS
number.

4. In the Boiling Point boxes, enter from 200 to 250 K.

5. Click Find Now.

Aspen Plus searches its databanks for components that contain the
characters C3 in the name or formula and have a Boiling point between 200
and 250 K and then displays the results in the bottom half of the window.

6. To include a component from the search results in your simulation, select a
component name from the list, and click Add. From the Find dialog box, you
can continue to select component names and click the Add button to select
multiple components from the search results to be added to your simulation.
You can also modify your search criteria and click Find Now again to
generate new search results.

7. When finished, click Close to return to the Components Specifications
Selection sheet.

Click here to see the Find dialog box for this example.
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Specifying Non-Databank Components

To define a component that is not in the databanks:

1. From the Data menu, click Components.

2. On the Specifications Selection sheet, enter only the Component ID.

3. If Aspen Plus finds a match in a databank for the ID you enter, delete the
Formula or Component Name. Aspen Plus then recognizes the component as
a non-databank component.
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4. You must supply all required property parameters for non-databank
components. You can supply the parameters yourself using the Properties
Data and Parameters forms.

– or –

Combine user-input parameters and data with one or both of the following:
• Property Estimation to estimate the required parameters using the

Properties Estimation forms
• Data Regression to regress data to obtain the parameters using the

Properties Regression forms

For information on See

Physical property data requirements Chapter 8

Estimating property parameters Chapter 30

Regressing property parameters Chapter 31

Tip Use the User Defined Component Wizard to help you enter some
of the commonly available data, such as normal boiling point and
vapor pressure data.

Using the User Defined Component Wizard
You can use the User Defined Component Wizard to define the properties needed
for conventional, solid, and nonconventional components. You can modify the
parameters supplied at any time by returning to the User Defined Component
Wizard or by going to the forms where the information is saved.

Use this wizard to define components that are not in any pure component
databanks. You can define conventional components, solid components, and
nonconventional components. The wizard also helps you enter commonly
available data for the components, such as molecular weight, normal boiling
point, vapor pressure and heat capacity data.

Tip You can also select a databank on the Components Specifications
Selection sheet and give it a different chemical formula. This
special formula can be used to identify the component in user-
written subroutines. This allows property parameters for the
component to be retrieved from the databanks.

To open the User Defined Component Wizard:
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1. From the Data menu, click Components.

2. On the Specifications Selection sheet, click the User Defined button.

The User Defined Component Wizard appears.

Tip For help on the wizard, click the What’s This button in the right
hand corner of the wizard dialog box, then click any part of the
wizard.

Defining a Conventional Component

To define a conventional component, open the user defined component wizard
then:

1. Enter the Component ID. Every component in the flowsheet must have a
Component ID. This ID is used to refer to the component throughout the
simulation.

2. From the Type list, click Conventional.

3. Optionally, enter a formula for the component. The formula can identify the
component in user-written property or unit operation model subroutines. If
the formula for the component exists in an Aspen Plus databank, a warning
message appears.

4. Click Next.
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5. Enter the molecular weight and normal boiling point in the respective boxes
on the Conventional Components Basic Data dialog box.

The molecular structure, molecular weight, and normal boiling point are the
most fundamental information required in group-contribution and
corresponding-states methods used in property estimation.

Molecular weight is required in all simulations. If the Molecular structure is
later entered, the molecular weight used in the simulation can be calculated
from the atoms.

Normal boiling point is not required per se in property calculations, but is
used to estimate many other parameters such as critical temperature and
critical pressure, if they are missing.

6. Optionally enter the data shown in  the following table. This data can be
found later on the Properties Parameters Pure Component USRDEF-1 form.

Physical Property Information

Specific gravity at 60°F (SG)

Standard enthalpy of formation (DHFORM) Most simulations involve energy balance calculations therefore enthalpy is
required.

Standard enthalpy of formation of ideal gas at 25°C (DHFORM) is used in
the enthalpy calculation, but is not required unless the simulation contains
chemical reactions, because DHFORM defaults to zero.

Standard Gibbs energy of formation (DGFORM) Enter the standard Gibbs energy of formation of ideal gas at 25°C
(DGFORM) if either:

• The simulation contains chemical reactions.

• You use the RGibbs unit operation model.

7. If you wish to enter additional property information, such as molecular
structure, vapor pressure or ideal gas heat capacity data, click Next. The
wizard will help you enter property data, property parameters, and molecular
structure or activate property estimation.

– or –

Click Finish to save the data you have entered and exit the wizard.
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8. If you clicked Next to enter additional property data, this dialog box appears:

9. Click the buttons to enter additional properties or data.
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This table provides information about the properties or data:

Type Description

Molecular structure Component Molecular Structure

Molecular structure is required in all group-contribution methods used to estimate
missing property parameters.

If you enter molecular structure, you should also request estimation of parameters by
selecting the Estimate All Missing Parameters From Molecular Structure check box.

The structure can be modified later if needed, on the Properties Molecular Structure
form. For details on entering molecular structure or Property Estimation, see Chapter
30.

Vapor pressure data Vapor pressure data used to determine extended Antoine vapor pressure coefficients
(PLXANT) from Property Estimation using the Data method.

If you enter vapor pressure data, you should also request estimation of parameters by
selecting the Estimate All Missing Parameters From Molecular Structure check box.

The data you enter can be modified later on the Properties Data form with the name
you defined.

The data can also be used with Data Regression. For information on entering pure
component data or Data Regression, see Chapter 31.

Extended Antoine vapor
pressure coefficients

Coefficients for the extended Antoine vapor pressure equation (PLXANT)

These parameters can be modified later on the Properties Parameters Pure
Components PLXANT-1 form. For more information on entering or modifying property
parameters, see Chapter 8.

Ideal gas heat capacity
data

Ideal gas heat capacity data used to determine coefficients for the ideal gas heat
capacity equation (CPIG) from Property Estimation using the Data method. (For more
information see Chapter 30.)

If you enter Ideal gas heat capacity data, you should also request estimation of
parameters by selecting the Estimate All Missing Parameters From Molecular
Structure check box.

The data you enter can be modified later on the Properties Data form with the name
you defined.

The data can also be used with Data Regression. For information on Data
Regression, or entering pure component data, see Chapter 31.

Ideal gas heat capacity
polynomial coefficients

Coefficients for the ideal gas heat capacity equation (CPIG)

These parameters can be modified later on the Properties Parameters Pure
Components CPIG-1 form. For more information on entering or modifying property
parameters, see Chapter 8.

10. Optionally, select the Estimate All Missing Parameters From Molecular
Structure check box.

11. Click Finish to close the wizard and return to the Components Specifications
Selection sheet.
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Defining a Solid Component

The steps used to define a solid component are almost the same as those for
conventional components. You must select Solid from the Type list in Step 2
above, and the types of data or parameters you can enter are pertinent to solid
components.

Normal boiling point is not required per se in property calculations, but is used to
estimate many other parameters such as critical temperature and critical
pressure if they are missing. If you have an experimental normal boiling point,
you should enter it.

Since most simulations involve energy balance calculations, enthalpy is required.
Solid enthalpy of formation of solids (DHSFRM) is used in the enthalpy
calculations, but is not required unless the simulation contains chemical
reactions, because DHSFRM defaults to zero.

Defining a Nonconventional Component

To define a nonconventional component, open the User Defined Component
wizard, then:

1. Enter the Component ID. Every component in the flowsheet must have a
Component ID. This ID is used to refer to the component throughout the
simulation.

2. Select Nonconventional from the Type list.

3. Click Next.

4. Choose Enthalpy and Density models by selecting from the Enthalpy and
Density lists respectively. The required component attributes for the selected
models are shown below the model selections.
For more information on properties for nonconventional components, see
Chapter 7.

5. Click Finish to close the wizard and return to the Components Specifications
Selection sheet.
The nonconventional property specifications you entered are saved under the
Properties Advanced NC-Props form.
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Adding a Component

To add a component to the existing component list:

1. From the Data menu, click Components.

2. On the Specifications Selection sheet, move to the first blank row.

3. Enter a Component ID, name or formula.
Follow the next two steps if you wish to move the component within the list.

4. Click the Reorder button to open the Reorder Components dialog box.

5. Select the new component and move it up in the sequence with the up arrow
to the right of the components list.

Inserting a Component
To insert a component:

1. From the Data menu, click Components.

2. On the Specifications Selection sheet, move to the row where you want the
new component inserted.

3. Click the right mouse button and from the menu that appears, click Insert
Row.

4. Enter a Component ID, name or formula in the new row.

Renaming a Component

To rename an existing component:

1. From the Data menu, click Components.

2. On the Specifications Selection sheet, move to the Component ID box for the
component you want to rename.

3. Type over the existing ID.
Aspen Plus prompts you to either delete or rename the existing component.
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4. Select Rename.
The component is renamed on this form and on all other forms where it
appears. No data is lost.
If you select Delete, both the Component ID and its data is deleted.

Deleting a Component

To delete a component:

1. From the Data menu, click Components.

2. On the Specifications Selection sheet, click the right mouse button on the row
selector for the component you want to delete

3. Choose Delete Row from the menu that appears.
When you delete a component, all references to the component on other
sheets are automatically deleted. For example, if you entered component
flows on a Stream form, then you deleted a component on the Components
Specifications Selection sheet. Aspen Plus automatically deletes the
component ID and flow from the Stream form.

Reordering the Component List

To reorder the list of components on the Components Specifications Selection
sheet:

1. From the Data menu, click Components.

2. On the Specifications Selection sheet, click the Reorder button.

3. Click the ID of the component you wish to move.

4. Move the component in the appropriate direction, by clicking the up or down
arrows to the right of the list.

5. Repeat Steps 3 and 4 until all components are ordered as desired.

6. Click Close to return to the Specifications Selection sheet which displays the
components with the new order.
Aspen Plus retains all original data and references for the components on this
and other forms.
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Generating Electrolyte Components and
Reactions

Electrolyte systems involve ionic components and reactions that must be defined
to complete the components specification. You can use the Electrolyte Wizard to
generate ionic reactions and additional components that might be formed by the
reactions.

Before opening the Electrolyte Wizard:

1. From the Data menu, click Components.

2. On the Specifications Selection sheet, enter the component Water (H2O).
Electrolyte systems must have water present.

3. Enter the additional molecular components that define the system. Some
examples are:

System Molecular Components

Sour water system CO2, H2S, O2S (for SO2)

Brine system NACL (use Type = Conventional, do not identifyType as
Solid)

4. Click the Elec Wizard button.

5. On the Electrolytes Wizard dialog box, click Next.

Tip For Help on the Wizard click the What’s This button in the
wizard and then click any active field in the Wizard.

Generating the List of Components
To generate the list of required components:

1. From the left pane of the Data Browser, double-click the Components folder,
then click Specifications.

2. On the Selection form, click the Elec Wizard button.

3. Click Next on the first Electrolyte wizard dialog box that appears.

4. On the Base Components and Reactions Generation Option dialog box, select
the components from which you want to generate reactions and ionic species.
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5. To move an individual component from the Available Components list, click
an individual component and then click the single right arrow.
To move all components to the Selected components list, click the double
arrow.

6. Turn the other options on or off to match your preferences.
The recommended hydrogen ion type is Hydronium ion H3O+.  You may
toggle this to use Hydrogen ion H+.

Select this option To

Include Salt Formation Include solid salts when new species are generated. Default (On) is to include salts.

Include Water Dissociation
Reaction

Include water dissociation in the list of generated reactions. Default (Off) is not to include
water dissociation reaction.

7. Click Next.
On the Generated Species and Reactions dialog box, Aspen Plus displays lists
of aqueous species, salts, and reactions.



Specifying
Components

6-18 Aspen Plus User Guide
Version 10.2

For reactions, arrows pointing in both directions mean ionic equilibrium or
salt precipitation. An arrow pointing in one direction means complete
dissociation. Generated solid salt components are assigned component IDs
with (S) to indicate the solid type.

8. Remove any unwanted items by selecting them and clicking Remove.
Removing any species will remove all reactions containing that species.

9. Click Next.

10. On the Simulation Approach dialog box, choose the simulation approach.

Choose this approach To have The Calculation method is

True † All calculated results displayed in terms of the
actual species present (molecular, ionic, and
solid forms of the same electrolyte will each be
shown separately).

Electrolyte reactions solved simultaneously with
phase equilibrium equations in unit operation
models

Apparent All forms of the same electrolyte show up as a
single component

Electrolyte reactions solved during property
evaluations

†  
The default true component approach is generally preferred for calculation efficiency.

Both approaches give the same results. You are also shown the name of the
Chemistry ID (GLOBAL) and the Henry-Comps ID (also GLOBAL).

11. Click Next to create the Chemistry and Henry-Comps forms and go on to the
Summary sheet.
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The Summary dialog box summarizes the modifications made by the
Electrolyte Wizard to your properties, components, databanks, and chemistry
specifications. Review or modify the generated specifications for Henry
components or for electrolyte reactions on the Summary dialog box.

Reviewing Generated Henry Components

To review or modify the Henry Components list generated by the Electrolytes
Wizard:

1. Click the Review Generated Henry-Comps List button on the Summary dialog
box.

2. On the Henry Components Global dialog box, select components and use the
right and left arrow buttons to add or remove from the Selected Components
list.

3. Click the X in the upper right corner of the dialog box when finished to close
the dialog box.

4. Note that Henry component specifications can be modified later using the
Components Henry-Comps forms.

Reviewing Generated Electrolyte Reactions

To review or modify the electrolyte reactions generated by the Electrolyte
Wizard:

1. Click the Modify/Add Reactions button on the Summary dialog box.

2. On the Modify/Add Reactions Global dialog box, the Stoichiometry sheet
displays the reactions, their type, and their stoichiometry. To modify reaction
stoichiometry for a reaction, select it from the list, and click Edit. When you
finish modifying the stoichiometry, click Close.

3. Use the Equilibrium Constants sheet to enter, review, or change the
Equilibrium constants, their concentration basis, or the temperature
approach to equilibrium. To view or modify equilibrium constant information
for other reactions, select the desired reaction from the Equilibrium Reaction
list.

4. Click the X in the upper right corner of the dialog box when finished.
Electrolyte chemistry specifications can be modified later using the Reactions
Chemistry forms.
After reviewing the information on the Summary dialog box, click Finish to
save all the changes to the appropriate forms and to return to the
Components Specifications Selection sheet.
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For more information about modeling your process with electrolytes, see
Aspen Plus Physical Property Methods and Models or the Getting Started guide.

Identifying Solid Components

To identify components as solids:

1. From the Data menu, click Components.

2. On the Specifications Selection sheet, specify the Component ID.

3. If the component is a databank component, specify the formula and
component name. For more information, see Specifying Components from a
Databank on page 6-1.

4. In the Type box, specify Solid for a conventional solid or Nonconventional for
a nonconventional solid.

Conventional Solids
Conventional solids are pure materials. These solids may be present in mixtures
in phase and/or chemical equilibrium, including electrolyte salts. For example,
NaCl can be a conventional solid precipitating from an electrolyte solution. These
solids are present in the MIXED substream.

Conventional solids are characterized in terms of properties, such as:
• Molecular weight
• Vapor pressure
• Critical properties

Conventional solids that do not participate in phase equilibrium calculations are
conventional inert solids. Conventional inert solids:
• Can participate in chemical equilibrium, modeled by the RGibbs unit

operation model. None of the other unit operation models handles solid
equilibrium.

• Are assigned the substream type CISOLID to distinguish them from other
conventional solids
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Nonconventional Solids
Nonconventional solids are materials characterized in terms of empirical factors
called component attributes. Component attributes represent component
composition by one or more constituents.

Nonconventional solids never participate in phase or chemical equilibrium
calculations. Aspen Plus always assigns substreams of type NC to
nonconventional solids.

Examples of nonconventional solids are coal and wood pulp.

About Component Attributes

Component attributes represent component composition in terms of one or more
sets of constituents. For example, coal is often characterized in terms of ultimate
and proximate analyses, as well as several other types of analysis.

You can assign component attributes to non-solid conventional components (Type
is Conventional).

The standard Aspen Plus property models and unit operation models do not use
these attributes in any calculations. But assigning attributes lets you keep track
of properties that do not affect material and energy balance calculations. For
example, you could assign component attributes to account for the color or odor of
a component. You can use component attributes in Fortran subroutines for
property models or unit operation calculations that you write.
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The following table describes available component attributes:

Component Attribute Description Elements

PROXANAL Proximate analysis, weight % 1 Moisture (moisture-included basis)
2 Fixed carbon (dry basis)
3 Volatile Matter (dry basis)
4 Ash (dry basis)

ULTANAL Ultimate analysis, weight % 1 Ash (dry basis)
2 Carbon (dry basis)
3 Hydrogen (dry basis)
4 Nitrogen (dry basis)
5 Chlorine (dry basis)
6 Sulfur (dry basis)
7 Oxygen (dry basis)

SULFANAL Forms of sulfur analysis, weight %
of original coal

1 Pyritic (dry basis)
2 Sulfate (dry basis)
3 Organic (dry basis)

GENANAL General constituent analysis,
weight %

1 Constituent 1
2 Constituent 2
.
.
20 Constituent 20

For information on entering component attribute values in streams, see
Chapter 9, Specifying Streams.

Assigning Attributes to Conventional Components
To assign attributes to a conventional or conventional solid component:

1. From the Data menu, click Components.

2. In the left pane of the Data Browser, click Attr-Comps.

3. On the Selection sheet, choose a Component ID from the Component list. You
may select more components by listing them below the first one.

4. Select a component attribute from the Attributes list. You may list multiple
component attributes for each component.

In most cases, the conventional components to which you assign attributes will
be solids (Type is Solid on the Components Specifications Selection sheet).

For information on entering component attribute values in streams, see
Chapter 9, Specifying Streams.
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Assigning Attributes to Nonconventional Components
Attributes for nonconventional components are automatically assigned when you
select nonconventional enthalpy and density models on the Properties Advanced
NC-Props form, or use the User Defined Components wizard with a
nonconventional component.

You can assign additional component attributes to nonconventional components.
To do this:

1. From the Data menu, select Physical Properties.

2. In the left pane of the Data Browser, double-click the Advanced folder

3. Click NC-Props.

4. Select a component from the Component list.

5. Enter the enthalpy and density model names for that component, if this has
not already been done.
The required component attributes for the selected models will be
automatically listed at the bottom of the sheet.

6. Add component attributes to the Required Component Attributes For The
Selected Models box by selecting them from the list.

For more information on See

Property methods for nonconventional components Chapter 7, Physical Property Methods

Parameters for nonconventional components Chapter 8, Physical Property Parameters and Data

Entering component attribute values Chapter 9, Specifying Streams
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Specifying Supercritical (HENRY)
Components

In the activity-coefficient approach for computing vapor-liquid equilibrium,
Henry's law is used to represent the behavior of dissolved gases or other
supercritical components.

To use Henry's law in Aspen Plus, you must define one or more sets of
supercritical (or Henry’s) components.

For Henry's law to be used during property calculations, you must also specify a
Henry Components ID on one of these sheets:
• Properties Specifications Global sheet
• Properties Specifications Flowsheet Sections sheet
• A unit operation BlockOptions Properties sheet
• A Property Analysis Properties sheet

Aspen Plus has built-in Henry’s law parameters for a large number of component
pairs. The solvents are water and other organic compounds.

These parameters are used automatically on the Properties Parameters Binary
Interaction HENRY-1 form when you specify a property method that uses Henry
Comps. For components that do not have Henry's law parameters available, you
must enter Henry's law parameters on the Properties Parameters Binary
Interaction HENRY-1 form. See Chapter 8 for a discussion of physical property
parameter requirements.

To define a set of Henry's components:

1. From the Data menu, click Components.

2. In the left pane of the Data Browser, click Henry Comps.

3. On the Henry Components Object Manager, click New.

4. In the Create New ID dialog box, enter an ID for a new list of Henry
Components, or accept the default ID.

5. Specify the Component IDs in Selected components list.
Select the components to include as Henry components from the Available
components list and use the right arrow button to move them into the
Selected components list. The left arrow can be used to remove components
from the Selected components list. The double arrow can be used to move all
of the components in a list at one time.
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Example of Specifying Henry's Components

In this example, N2, CO2, and H2S are identified as Henry’s components. BZ,
CH, and H2O are not selected as Henry components.

Specifying UNIFAC Groups

Use the Components UNIFAC Groups Selection sheet to identify UNIFAC groups
or to introduce new groups. If you want to enter UNIFAC group parameters or
group-group interaction parameters, you must assign an ID to each group. Use
the group ID on the Properties Parameters UNIFAC Group form or UNIFAC
Group Binary form to enter group parameters.

To specify UNIFAC groups:

1. From the Data menu, choose Components.

2. In the left pane of the Data Browser, click UNIFAC Groups.

3. On the UNIFAC Groups Selection sheet, type a name for the group in the
Group ID box. Every group needs a name that can be referenced on other
forms.
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4. Select a number from the Group number list. As you scroll, a brief description
of each group appears in the description area.
If you want to define a new UNIFAC group, type in a number between 4000
and 5000 in the Group number box.

Defining Component Groups

You can specify a group of components to be converged in a tear stream.

A component group consists of either a:
• List of components
• Range of components from the Components Specifications Selection sheet
• Combination of component lists and ranges

To define a component group:

1. From the Data menu, click Components.

2. In the left pane of the Data Browser, click Comp-Group.

3. In the Component Group Object Manager, click New.

4. In the Create New ID dialog box, enter an ID for the new Component Group
or accept the default.

5. A component group consists of either a:

6. List of components

7. Range of components from the Components Specifications Selection sheet

8. Combination of component lists and ranges

9. On the Component List sheet, choose a substream from the Substream list.

10. Specify the components to be included in the component group.
Select the components to include from the Available components list and use
the right arrow button to move them into the Selected components list. The
left arrow can be used to remove components from the Selected components
list. The double arrows can be used to move all of the components in a list at
one time.
Alternatively, you can click the Component Range sheet, and enter a range of
components that represent your component group.

11. If you want to create a component group containing components from more
than one substream, repeat steps 5 and 6.
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Using a component group can aid tear stream convergence when you use the
NEWTON, BROYDEN, or SQP convergence methods and your flowsheet has all
of the following:
• Recycles
• A large number of components
• Some components known to have zero or constant flow rates

A component group reduces the problem matrix size and the number of
numerical derivative perturbations (if performed). This makes convergence faster
and more stable.

To use a component group for a convergence method, you must specify the
Component Group ID in one of the following sheets:
• Convergence Convergence Input Tear Streams sheet
• Convergence Conv-Options Defaults Tear Convergence sheet
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7 Physical Property
Methods

Choosing the appropriate property method is often the key decision in
determining the accuracy of your simulation results. This chapter provides
guidelines for choosing appropriate property methods and models including:
• What is a property method
• Available property methods
• Choosing a property method
• Creating new property methods
• Specifying the global property method
• Specifying a property method for a flowsheet section
• Specifying a local property method
• Defining supercritical components
• Specifying properties for the free-water phase
• Special method for K-value of water in the organic phase
• Specifying electrolyte calculations
• Modifying property methods
• Property methods for nonconventional components

What Is a Property Method?

A property method is a collection of methods and models that Aspen Plus uses to
compute thermodynamic and transport properties.
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The thermodynamic properties are:
• Fugacity coefficient (K-values)
• Enthalpy
• Entropy
• Gibbs free energy
• Volume

The transport properties are:
• Viscosity
• Thermal conductivity
• Diffusion coefficient
• Surface tension

Aspen Plus includes a large number of built-in property methods that are
sufficient for most applications. However, you can create new property methods
to suit your simulation needs.

Available Property Methods

You must select one or more Property Methods to model the properties of specific
systems in your flowsheet. Each property method has a unique approach to
representing K-values.

The following tables list all of the property methods available in Aspen Plus.

You can modify these existing methods or create new methods. For more
information, see Modifying Property Methods on page 7-18.

Property Methods

Ideal Property Methods

Ideal Property Method K-Value Method

IDEAL Ideal Gas/Raoult's law/Henry's law

SYSOP0 Release 8 version of Ideal Gas/Raoult's law
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Equation-of-State Property Methods

Equation-of-State Property Method K-Value Method

BWR-LS BWR Lee-Starling

LK-PLOCK Lee-Kesler-Plöcker

PENG-ROB Peng-Robinson

PR-BM Peng-Robinson
with Boston-Mathias alpha function

PRWS Peng-Robinson
with Wong-Sandler mixing rules

PRMHV2 Peng-Robinson
with modified Huron-Vidal mixing rules

PSRK Predictive Redlich-Kwong-Soave

RKSWS Redlich-Kwong-Soave
with Wong-Sandler mixing rules

RKSMHV2 Redlich-Kwong-Soave
with modified Huron-Vidal mixing rules

RK-ASPEN Redlich-Kwong-ASPEN

RK-SOAVE Redlich-Kwong-Soave

RKS-BM Redlich-Kwong-Soave
with Boston-Mathias alpha function

SR-POLAR Schwartzentruber-Renon

Activity Coefficient Property Methods
Activity Coefficient
Property Method

Liquid Phase Activity
Coefficient Method

Vapor Phase Fugacity
Coefficient Method

B-PITZER Bromley-Pitzer Redlich-Kwong-Soave

ELECNRTL Electrolyte NRTL Redlich-Kwong

ENRTL-HF Electrolyte NRTL HF Hexamerization model

ENRTL-HG Electrolyte NRTL Redlich-Kwong

NRTL NRTL Ideal gas

NRTL-HOC NRTL Hayden-O'Connell

NRTL-NTH NRTL Nothnagel

NRTL-RK NRTL Redlich-Kwong

NRTL-2 NRTL (using dataset 2) Ideal gas

PITZER Pitzer Redlich-Kwong-Soave

PITZ-HG Pitzer Redlich-Kwong-Soave

continued
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Activity  Coefficient
Property Method

Liquid Phase Activity Coefficient
Method

Vapor Phase Fugacity
Coefficient Method

UNIFAC UNIFAC Redlich-Kwong

UNIF-DMD Dortmund-modified UNIFAC Redlich-Kwong-Soave

UNIF-HOC UNIFAC Hayden-O'Connell

UNIF-LBY Lyngby-modified UNIFAC Ideal gas

UNIF-LL UNIFAC for liquid-liquid systems Redlich-Kwong

UNIQUAC UNIQUAC Ideal gas

UNIQ-HOC UNIQUAC Hayden-O'Connell

UNIQ-NTH UNIQUAC Nothnagel

UNIQ-RK UNIQUAC Redlich-Kwong

UNIQ-2 UNIQUAC (using dataset 2) Ideal gas

VANLAAR Van Laar Ideal gas

VANL-HOC Van Laar Hayden-O'Connell

VANL-NTH Van Laar Nothnagel

VANL-RK Van Laar Redlich-Kwong

VANL-2 Van Laar (using dataset 2) Ideal gas

WILSON Wilson Ideal gas

WILS-HOC Wilson Hayden-O'Connell

WILS-NTH Wilson Nothnagel

WILS-RK Wilson Redlich-Kwong

WILS-2 Wilson (using dataset 2) Ideal gas

continued
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Activity Coefficient
Property Method

Liquid Phase Activity
Coefficient Method

Vapor Phase Fugacity
Coefficient Method

WILS-HF Wilson HF Hexamerization model

WILS-GLR Wilson (ideal gas and liquid enthalpy
reference state)

Ideal gas

WILS-LR Wilson (liquid enthalpy reference
state)

Ideal gas

WILS-VOL Wilson with volume term Redlich-Kwong

Property Methods for Special Systems
Property Methods for Special
Systems

K-Value Method System

AMINES Kent-Eisenberg amines model H2S, CO2, in MEA, DEA,  DIPA, DGA
solution

APISOUR API sour water model Sour water with NH3, H2S, CO2

BK-10 Braun K-10 Petroleum

SOLIDS Ideal Gas/Raoult's law/Henry's law/solid activity
coefficients

Pyrometallurgical

CHAO-SEA Chao-Seader corresponding states model Petroleum

GRAYSON Grayson-Streed corresponding states model Petroleum

STEAM-TA ASME steam table correlations Water/steam

STEAMNBS NBS/NRC steam table equation of state Water/steam

Choosing a Property Method

Use the tables starting on page 7-6 and the figures on page 7-10 to select the best
property method for your simulation. For more information, see also Chapter 8
for detailed descriptions of the data requirements for each property method.
Many methods contain extensive built-in binary parameters, so they are
essentially predictive.
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Recommended Property Methods for Different
Applications

Use these tables as guidelines for selecting the best property method for your
simulation.

Oil and Gas Production
Application Recommended Property Methods

Reservoir systems PR-BM, RKS-BM

Platform separation PR-BM, RKS-BM

Transportation of oil and gas by pipeline PR-BM, RKS-BM

Refinery

Application Recommended Property Methods

Low pressure applications
(up to several atm)

Vacuum tower, atmospheric crude tower

BK10, CHAO-SEA, GRAYSON

Medium pressure applications
(up to several tens of atm)

Coker main fractionator,
FCC main fractionator

CHAO-SEA, GRAYSON, PENG-ROB, RK-SOAVE

Hydrogen-rich applications
Reformer, Hydrofiner

GRAYSON, PENG-ROB, RK-SOAVE

Lube oil unit, De-asphalting unit PENG-ROB, RK-SOAVE
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Gas Processing
Application Recommended Property Methods

Hydrocarbon separations
Demethanizer
C3-splitter

PR-BM, RKS-BM, PENG-ROB, RK-SOAVE

Cryogenic gas processing
Air separation

PR-BM, RKS-BM, PENG-ROB, RK-SOAVE

Gas dehydration with glycols PRWS, RKSWS, PRMHV2, RKSMHV2, PSRK, SR-POLAR

Acid gas absorption with
Methanol (RECTISOL)
NMP (PURISOL)

PRWS, RKSWS, PRMHV2, RKSMHV2, PSRK, SR-POLAR

Acid gas absorption with
Water
Ammonia
Amines
Amines + methanol (AMISOL)
Caustic
Lime
Hot carbonate

ELECNRTL

Claus process PRWS, RKSWS, PRMHV2, RKSMHV2, PSRK, SR-POLAR

Petrochemicals
Application Recommended Property Methods

Ethylene plant
Primary fractionator

Light hydrocarbons
Separation train
Quench tower

CHAO-SEA, GRAYSON

PENG-ROB, RK-SOAVE

Aromatics
BTX extraction

WILSON, NRTL, UNIQUAC and their variances †

Substituted hydrocarbons
VCM plant
Acrylonitrile plant

PENG-ROB, RK-SOAVE

Ether production
MTBE, ETBE, TAME

WILSON, NRTL, UNIQUAC and their variances †

Ethylbenzene and styrene plants PENG-ROB, RK-SOAVE
–or–
WILSON, NRTL, UNIQUAC and their variances †

Terephthalic acid WILSON, NRTL, UNIQUAC and their variances †

(with dimerization in acetic acid section)

†
See the figures on pages 7-11 through 7-12 for recommendations based on pressure and vapor phase association.
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Chemicals
Application Recommended Property Methods

Azeotropic separations
Alcohol separation

WILSON, NRTL, UNIQUAC and their variances†

Carboxylic acids
Acetic acid plant

WILS-HOC, NRTL-HOC, UNIQ-HOC

Phenol plant WILSON, NRTL, UNIQUAC and their variances†

Liquid phase reactions
Esterification

WILSON, NRTL, UNIQUAC and their variances†

Ammonia plant PENG-ROB, RK-SOAVE

Fluorochemicals WILS-HF

Inorganic Chemicals
Caustic
Acids
Phosphoric acid
Sulphuric acid
Nitric acid
Hydrochloric acid

ELECNRTL

Hydrofluoric acid ENRTL-HF

†
See the figures on pages 7-11 through 7-12 for recommendations based on pressure and vapor phase association

Coal Processing
Application Recommended Property Methods

Size reduction crushing, grinding SOLIDS

Separation and cleaning sieving,

cyclones, precipitation, washing

SOLIDS

Combustion PR-BM, RKS-BM (combustion databank)

Acid gas absorption with
Methanol (RECTISOL)
NMP (PURISOL)

PRWS, RKSWS, PRMHV2, RKSMHV2, PSRK, SR-POLAR

Acid gas absorption with
Water
Ammonia
Amines
Amines + methanol (AMISOL)
Caustic
Lime
Hot carbonate

ELECNRTL

Coal gasification and liquefaction See Synthetic Fuels table.
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Power Generation
Application Recommended Property Methods

Combustion
Coal
Oil

PR-BM, RKS-BM (combustion databank)

Steam cycles
Compressors
Turbines

STEAMNBS, STEAM-TA

Acid gas absorption See gas processing.

Synthetic Fuel
Application Recommended Property Methods

Synthesis gas PR-BM, RKS-BM

Coal gasification PR-BM, RKS-BM

Coal liquefaction PR-BM, RKS-BM, BWR-LS

Environmental
Application Recommended Property Methods

Solvent recovery WILSON, NRTL, UNIQUAC  and their variances †

(Substituted) hydrocarbon stripping WILSON, NRTL, UNIQUAC  and their variances †

Acid gas stripping from
Methanol (RECTISOL)
NMP (PURISOL)

PRWS, RKSWS, PRMHV2, RKSMHV2, PSRK, SR-POLAR

Acid gas stripping from:
Water
Ammonia
Amines
Amines + methanol (AMISOL)
Caustic
Lime
Hot carbonate

ELECNRTL

Acids
Stripping
 Neutralization

ELECNRTL

†
See the figures on pages 7-11 through 7-12 for recommendations based on pressure and vapor phase association.

Water and Steam
Application Recommended Property Methods

Steam systems
Coolant

STEAMNBS, STEAM–TA
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Mineral and Metallurgical Processes
Application Recommended Property Methods

Mechanical processing:
Crushing
Grinding
Sieving
Washing

SOLIDS

Hydrometallurgy
Mineral leaching

ELECNRTL

Pyrometallurgy
Smelter
Converter

SOLIDS

Guidelines for Choosing a Property Method
The following diagrams show the process for choosing a property method.

Polar

Non-electrolyte

Electrolyte

Real

Vacuum

ELECNRTL

CHAO-SEA, GRAYSON,
BK10

BK10, IDEAL

PENG-ROB, RK-SOAVE,
LK-PLOCK, PR-BM,
RKS-BM

Pseudo &
Real

Nonpolar

Real or Pseudocomponents

Electrolyte

Pressure

Polarity

*

> 1atm

* See the figure  on page 7-11.
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Guidelines for Choosing a Property Method

P < 10 bar

P > 10 bar

Polar,
non-electrolyte

PSRK, RKSMHV2

SR-POLAR, PRWS,
RKSWS, PRMHV2,
RKSMHV2

UNIFAC, UNIF-LBY,
UNIF-DMD

UNIF-LL

NRTL, UNIQUAC,
and their variances

WILSON, NRTL, UNIQUAC,
and their variances

Pressure

Interaction parameters available

Liquid-Liquid

Y

Y

N

N

Y

N

Y

N

* See the figure on page 7-12 .
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Guidelines for Choosing a Property Method for Polar
Non-Electrolyte Systems

Guidelines for Choosing an Activity Coefficient Property
Method

Vapor phase association

Degrees of polymerization

Dimers

WILS-HF

WILS-NTH, WILS-HOC
NRTL-NTH, NRTL-HOC
UNIQ-NTH, UNIQ-HOC
UNIF-HOC

WILSON, WILS-RK,
WILS-LR, WILS-GLR,
NRTL, NRTL-RK, NRTL-2
UNIQUAC, UNIQ-RK,
UNIQ-2, UNIFAC, UNIF-LL,
UNIF-LBY, UNIF-DMD

WILSON
NRTL
UNIQUAC
UNIFAC

N

Y

VAP?

Hexamers

DP?

General Guidelines for Choosing an Activity Coefficient Property
Method

Specifying the Global Property Method
Aspen Plus uses the global property method for all property calculations, unless
you specify a different property method for a specific flowsheet section, unit
operation block, or property analysis.

To specify the global property method:

1. From the Data menu, click Properties.

2. On the Global sheet, in the Property Method list box, specify the property
method.
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3. You can also use the Process Type list box to help you select an appropriate
property method. In the Process Type list box, select the type of process you
want to model. Each process type has a list of recommended property
methods. For more information on process types, see Chapter 2.

4. In the Base Method list box, select a base property method.

5. If you are using an activity coefficient property method and want to use
Henry's law for supercritical components, specify the Henry component list
ID in the Henry Components list box. For more information on Henry's
components, see Defining Supercritical Components on page 7-15.

6. If you have a petroleum application that requires free water calculations,
specify the property method for the free water phase in the Free-Water
Method list box and water solubility option in the Water Solubility list box.
For more information, see Using Free Water Calculations on page 7-16.

7. For electrolyte applications, you must select an electrolytic property method,
then select the Chemistry ID in the Chemistry ID list box. You can also
specify the electrolyte computation method in the Use True-Components
check box.

Specifying a Property Method for a Flowsheet Section
Use flowsheet sections to simplify the assignment of property methods when you
are using more than one property method in a simulation. For example, you could
divide a flowsheet into high pressure and low pressure sections, and assign an
appropriate property method to each section.

See Chapter 3 for more information on flowsheet sections, including how to
create a flowsheet section.

To specify a property method for a flowsheet section:

1. From the Data menu, click Properties

2. On the Flowsheet Sections sheet, select a flowsheet section from the
Flowsheet Section ID list box.

3. Specify the property method in the Property Method list box.

4. You can also use the Process Type list box to help you select an appropriate
property method. In the Process Type list box, select the type of process you
want to model. Each process type has a list of recommended property
methods. For more information on process types, see Chapter 2.

5. In the Base Method list box, select a base property method.
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6. If you are using an activity coefficient property method and want to use
Henry's Law for supercritical components, specify the Henry component list
ID in the Henry Components list box. For more information on Henry's
components, see Defining Supercritical Components on page 7-15.

7. For petroleum applications, you may want free water calculations. Specify the
free water property method in the Free-Water Method list box and water
solubility option in the Water Solubility list box. For more information, see
Using Free Water Calculations on page 7-16.

8. For electrolyte applications, you must select an electrolytic property method,
then select the Chemistry ID in the Chemistry ID list box. You can also
specify the electrolyte computation method in the Use True-Components
check box.

Specifying a Local Property Method
You can override the global property method by specifying a local property
method on:
• The BlockOptions Properties sheet, for a unit operation block
• The Properties sheet, for a Properties Analysis

The specifications you enter on the Properties sheet apply only to that unit
operation block or property analysis.

For the following unit operation models, you can specify different property
methods for streams or sections in the block:

Model Sheet Allows you to specify property methods for

Decanter Decanter Properties Phase Property Liquid1 and liquid2 phases

RadFrac Radfrac Properties Property Sections Column segments, decanters,
thermosyphon reboiler

RGibbs Rgibbs Setup Products Each phase

MultiFrac Multifrac Properties Property Sections Column segments

PetroFrac Petrofrac Properties Property Sections
Petrofrac Stripper Properties Property Sections

Column segments for main column
Column segments for stripper

HeatX Heatx BlockOptions Properties Hot and cold sides of the exchanger

MHeatX Mheatx BlockOptions Properties Each stream in the exchanger

RPlug Rplug BlockOptions Properties Reactant and external coolant streams

Use the Properties Specifications Referenced sheet to enter additional property
methods for use in the unit operation blocks or in property analysis calculations.
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When performing an interactive property analysis, you can select any property
method that has been specified on the Properties Specifications Referenced
sheets.

Defining Supercritical Components

Activity coefficient property methods handle supercritical components present in
the liquid phase by the asymmetric convention for activity coefficient
normalization (Henry's law).

To use Henry's law for supercritical components:

1. Select an appropriate property method. These property methods allow
Henry's law:

B-PITZER NRTL-2 UNIQUAC VANL-2

IDEAL PITZER UNIQ-HOC WILSON

ELECNRTL PITZ-HG UNIQ-NTH WILS-HF

ENRTL-HF SOLIDS UNIQ-RK WILS-HOC

ENRTL-HG UNIFAC UNIQ-2 WILS-NTH

NRTL UNIF-DMD VANLAAR WILS-RK

NRTL-HOC UNIF-HOC VANL-HOC WILS-2

NRTL-NTH UNIF-LBY VANL-NTH WILS-GLR

NRTL-RK UNIF-LL VANL-RK WILS-LR

2. Define a Henry's component group using the Henry Comps forms. For more
information, see Chapter 6.

3. Enter the ID of the Henry's component group on the Properties Specifications
Global sheet (Use the Flowsheet Sections sheet for flowsheet sections
specifications) or BlockOptions Properties sheet (local specification for unit
operation models).

For more information on Henry's law, see Aspen Plus Physical Property
Methods and Models, Chapter 2.

Equation-of-state property methods do not require special treatment for
supercritical components.
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Using Free Water Calculations

For water-hydrocarbon applications, two liquid phases often coexist with a vapor
phase. Aspen Plus has two approaches for modeling these types of vapor-liquid-
liquid equilibrium simulations:
• Rigorous three-phase calculations
• Calculations with a free water approximation. When you use free water

approximation, Aspen Plus assumes the water phase is pure liquid water
(free water).

Free water calculations are:
• Normally adequate for water-hydrocarbon systems, where the hydrocarbon

solubility in the water phase is generally negligible.
• Always faster than rigorous three-phase calculations, and require minimal

physical property data.

For more information on requesting free water calculations, see Chapter 5.

Note   You can also specify free water calculations on a local basis in individual
streams and blocks. For more information on free-water calculations. see
Aspen Plus Physical Property Methods and Models.

Specifying Properties for the Free-Water Phase
When you use the free water approximation, you must specify the property
method to be used for the free-water phase. This property method calculates all
thermodynamic and transport properties for the free-water phase.

To choose a property method:

1. Go to the Properties Specifications Global sheet or Flowsheet Sections sheet,
or the BlockOptions Properties sheets for a unit operation model.

2. In the Free-Water Method list box, select one:

Property Method Description Merits

STEAM-TA 1967 ASME steam table correlations (default) -

STEAMNBS NBS/NRC steam table correlations More accurate than the ASME steam table

IDEAL or SYSOP0 For systems at low or moderate pressures More efficient calculations than
STEAM-TA or STEAMNBS
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Special Method for K-Value of Water in the Organic
Phase

The global property method calculates the K-value of water unless you specify
another method.

In free water calculations, you can use a special method to calculate the K-value
of water in the organic phase:

v
w

*,l
ww

w
γK

ϕ
ϕ

=

Where:

wγ = Activity coefficient of water in the organic phase

l
w
*,ϕ = Fugacity coefficient of pure liquid water calculated using

the free-water phase property method
v
wϕ = Fugacity coefficient of water in the vapor phase mixture

To select a calculation method for γw and ϕwv:

1. Go to the Properties Specifications Global or Flowsheet Sections sheet, or the
BlockOptions Properties sheet for a unit operation model.

2. In the Water Solubility list box, select one:
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γ Primary property method

3† The K-value of water is calculated by the primary property method

†  
Water solubility option 3 is not recommended unless binary interaction parameters regressed from liquid-liquid
equilibrium data are available.
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Note  Xw
sol

is solubility of water in the organic phase, calculated using the
water-solubility correlation. (WATSOL).

Specifying Electrolyte Calculations

To model an electrolyte system, you must:
• Use an electrolyte property method. ELECNRTL is recommended. Other

property methods are PITZER, B-PITZER, ENRTL-HF, ENRTL-HG AND
PITZ-HG.

• Define the solution chemistry on the Reactions Chemistry Stoichiometry
sheet.

• Select the solution chemistry ID to be used with the electrolyte property
method in the Chemistry ID list box on the Properties Specifications Global
sheet or the Flowsheet Sections sheet or the BlockOptions Properties sheet of
a unit operation model.

• Specify either the true or apparent component simulation approach using the
Use True Components check box.

Use the button on the Components Specifications Selection sheet to open the
Electrolytes Wizard which can set up all of these specifications for you. For
information on how to use the Electrolyte Wizard, see Chapter 6.

Modifying Property Methods

Property methods are defined by calculation paths (routes) and physical property
equations (models), which determine how properties are calculated.

Built-in property methods are sufficient for most applications. However, you can
modify a property method to include, for example:
• A route that calculates liquid fugacity coefficients without the Poynting

correction
• A route that calculates liquid enthalpy without heat of mixing
• A different equation-of-state model for all vapor phase property calculations
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• A different set of parameters (for example, dataset 2) for an activity
coefficient model

• A route that calculates liquid molar volume using the Rackett model, instead
of a cubic equation of state

For more information on property models and model option codes, and on routes
and how to create them, see Aspen Plus Physical Property Methods and Models.

Modifying a Built-in Property Method
You can make the above common modifications to a property method on the
Properties Specifications Global sheet or the Flowsheet Section sheet:

1. From the Data menu, click Properties.

2. On the Global or the Flowsheet Sections sheet, select the property method
you want to modify in the Base Method list box.

3. Check the Modify Property Models check box.

4. When prompted, enter a new name for your modified property method and
click OK. Although it is not required, it is highly recommended that you
specify a new name for the modified property method.

You can make these modifications:

In this box To do this

Vapor EOS Select an equation of state model for all vapor phase properties calculations

Liquid gamma Select an activity coefficient model

Data set Specify parameter data set number for the EOS or liquid gamma model

Liquid enthalpy Select a route to calculate liquid mixture enthalpy

Liquid volume Select a route to calculate liquid mixture volume

Poynting correction Specify whether or not the Poynting correction is used in calculating liquid frugacity
coefficients. When selected, the Poynting correction is included.

Heat of mixing Specify whether or not heat of mixing is included in liquid mixture enthalpy. When
selected, heat of mixing is included.
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Making Advanced Modifications to a Property Method
For additional and advanced modifications, use the Properties Property Methods
form:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Property Methods
folder.

The Object Manager appears.

3. Select the Property Method you want to modify and click Edit.

– or –

To create a new property method, click New, then specify the new property
method.

4. Use the Routes sheet to specify property routes and the Models sheet to
specify property models.

The Routes sheet displays the base property method, the properties and route ID
used to calculate each property. For convenience, properties are categorized as
follows:
• Pure thermodynamic
• Mixture thermodynamic
• Pure transport
• Mixture transport

To modify a route in the property method, select a desired route in the Route ID
box. You can also:

Click this button To do this

Create Create a new route for the selected property

Edit Modify a selected route

View View the structure of a selected route. The structure shows exactly how the route is
calculated and by what methods and models.

The Models sheet displays the property models used for calculation of the
properties in the property method. To modify a property model, select the desired
model in the Model Name column.
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This table describes the different boxes on the Models sheet:

Use this box To specify

Model name The model you want to use to calculate each property

Data set The data set number for the parameters for the model

For a given model:

Use this button To Get

Affected properties A list of properties affected by the model. Models such as equation of state
are used to calculate more than one property.

Option codes Model option codes. Option codes are used to specify special calculation options.

Property Methods for Nonconventional
Components

The only properties calculated for nonconventional components are enthalpy and
density. The folllowing tables list the models available. See Aspen Plus Physical
Property Methods and Models, Chapter 3, for detailed descriptions of these
models.

Nonconventional Property Models

This table shows the general models:

Property Model Attribute Requirements

ENTHALPY ENTHGEN GENANAL

DENSITY DNSTYGEN GENANAL
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This table shows the special models for coal and coal-derived materials:

Property Model Attribute Requirements

ENTHALPY HCOALGEN
HCJ1BOIE
HCOAL-R8
HBOIE-R8

ULTANAL, PROXANAL, SULFANAL
ULTANAL, PROXANAL, SULFANAL
ULTANAL, PROXANAL, SULFANAL
ULTANAL, PROXANAL, SULFANAL

DENSITY DCOALIGT
DCHARIGT

ULTANAL, SULFANAL
ULTANAL, SULFANAL

The tabular models for nonconventional components are:

Property Model

ENTHALPY ENTHLTAB

DENSITY DNSTYTAB

Specifying the Models for Nonconventional
Components

To specify the models used to calculate physical properties for nonconventional
components:

1. From the Data menu, click Properties.

2. Double-click the Advanced folder.

3. Select the NC-Props form.

4. Select a component in the Component list box of the Property Methods sheet.

5. Specify the models for enthalpy and density.

Aspen Plus automatically fills in the required component attributes for the
models you specified.

❖     ❖     ❖     ❖ 
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8 Physical Property
Parameters and Data

This chapter explains how to evaluate property parameter requirements,
determine parameters available from databanks, and enter additional
parameters and data.

Topics include:
• About parameters and data
• Determining property parameter requirements
• Retrieving parameters from databanks
• Entering property parameters
• Using tabular data and polynomial coefficients
• Using property data packages

About Parameters and Data

When beginning any new simulation, it is important to check that you have
correctly represented the physical properties of your system. After you select the
property methods for a simulation as described in the previous chapter, you must
determine property parameter requirements and ensure that all required
parameters are available.
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In order to understand this and subsequent chapters, it is important to
distinguish between the terms Parameters and Data:

Item Definition Example

Parameters The constants used in the many different
physical property models, or equations,
used by Aspen Plus to predict physical
properties

These can be scalar constants such as
molecular weight (MW) and critical temperature (TC),
or they can be temperature-dependent property correlation
parameters such as the coefficients for the
extended Antoine vapor pressure equation (PLXANT).

Data Raw experimental property data that can
be used for estimation or regression of
parameters

Vapor pressure vs. Temperature data could be used to
estimate or regress the extended Antoine
parameters (PLXANT).

Determining Property Parameter
Requirements

Depending on the type of simulation, your model will require different
parameters. The following sections  describe the parameter requirements for some
basic property calculations, that is, for:
• Mass and energy balance simulations
• Henry's law
• Thermodynamic reference state

Most equation-of-state and activity coefficient models require binary parameters
for meaningful results. To determine parameter requirements based on your
chosen property methods, see the Property Method Tables in Aspen Plus Physical
Property Methods and Models for each property method you select.



Chapter  8

Aspen Plus User Guide 8-3
Version 10.2

Parameter Requirements for Mass and Energy Balance
Simulations

For simulations that involve both mass and energy balance calculations, you
must enter or retrieve from the databanks these required parameters:

Enter or retrieve
this parameter

For On this type of
Properties Parameters form

MW Molecular weight Pure Component Scalar

PLXANT Extended Antoine vapor pressure
model

Pure Component T-Dependent

CPIG or CPIGDP Ideal gas heat capacity model Pure Component T-Dependent

DHVLWT or DHVLDP Heat of vaporization model Pure Component T-Dependent

This table gives further information:

If you These parameters are required Enter them on this type of
Properties Parameters form

Use the standard liquid volume basis
for any flowsheet or unit operation
model specification

Standard liquid volume parameters
(VLSTD)

Pure Component Scalar

Request free-water calculations Parameters for the water solubility
model (WATSOL)

Pure Component T-Dependent

Tip If you deselect the Perform Heat Balance Calculations option on
the Setup Simulation Options Calculations sheet, Aspen Plus
does not calculate enthalpies, entropies, or Gibbs free energies. It
does not require the parameters used to compute these
properties.

Parameter Requirements for Henry's Law
If you use Henry's law for supercritical components (or dissolved-gas
components), Henry's constant model parameters (HENRY) are required for all
dissolved-gas components with the solvents. You must list the supercritical
components on the Components Henry Comps Selection sheet.
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If You require these parameters

More than one solvent is in the mixture Henry's constant parameters for each
dissolved-gas solvent pair.

Henry's constants are not available for all solvents Henry's constants for the major solvents.
Aspen Plus uses a rigorous defaulting procedure
when Henry's constants are missing
for a minor solvent component.

Enter Henry's constant model parameters on the Input sheet of the HENRY-1
object on the Properties Parameters Binary Interaction HENRY-1 form.

Parameter Requirements for Thermodynamic
Reference State

The reference state for thermodynamic properties is the constituent elements in
an ideal gas state at 25° C and 1 atm. To calculate enthalpies, entropies, and
Gibbs free energies, Aspen Plus uses:
• Standard heat of formation (DHFORM)
• Standard Gibbs free energy of formation (DGFORM)

For systems that do not involve chemical reaction, you may allow DHFORM and
DGFORM to default to zero.

Values of Must be available for all components

DHFORM Participating in chemical reactions

DGFORM Involved in equilibrium reactions modeled by the RGibbs reactor model

Reference State for Conventional Solid Components

Conventional solid components may require:
• Standard solid heat of formation (DHSFRM)
• Standard solid Gibbs free energy of formation (DGSFRM)

Enter them on the Properties Parameters Pure Component Scalar Input sheet.
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Reference State for Ionic Species

The reference state for ionic species is infinite dilution in water. To calculate
enthalpy, entropy, and Gibbs free energy of ions, Aspen Plus uses:
• Standard heat of formation in water at infinite dilution (DHAQFM)
• Standard Gibbs free energy of formation in water at infinite dilution

(DGAQFM)

Retrieving Parameters from Databanks

For many components, Aspen Plus databanks store all required parameter
values. This chapter explains how to retrieve these built-in parameters from
Aspen Plus databanks:
• Pure component parameters
• Equation-of-state binary parameters
• Activity coefficient binary parameters
• Henry’s Law constants
• Electrolyte and binary pair parameters

Retrieving Pure Component Parameters
For many components, Aspen Plus retrieves pure component parameters
automatically from its pure component databanks. Use the Components
Specifications Databanks sheet to specify the databanks to search and their
search order. Parameters missing from the first selected databank will be
searched for in subsequent selected databanks.

To enter your own parameter values, use the Properties Parameters Pure
Component Scalar Input and T-Dependent Input sheets. See Entering Pure
Component Constants on page 8-11.

Since built-in pure component databanks reside with the simulation engine, the
available parameters do not appear automatically on any Parameters Pure
Component Input sheets.

User entered parameters override values retrieved from the Aspen Plus
databanks.
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To generate a report of all available pure component parameters that will be
used in the simulation for the components and property methods specified:

1. From the Tools menu, click Retrieve Parameters Results.

2. On the Retrieve Parameter Results dialog box, click OK to generate a report.

3. On the next Retrieve Parameter Results dialog box, click OK to view the
results.

The Data Browser automatically opens at the Properties Parameters Results
folder.

4. In the left pane of the Data Browser, choose the Pure Component form from
the Results folder.

The Parameters Results Pure Components form contains a sheet for scalar
parameters and a sheet for T-Dependent parameters. On each sheet you can
choose to view the actual parameter values, or the status. For the status of
parameter results, the following status is possible:

Status Indicates the parameter is

Available Available in the databank, entered on the Paramters Input sheet, estimated, or regressed

Default A system default value

Missing Missing

In addition to retrieving parameter results with the method described above, you
can also generate a detailed parameter report in the Aspen Plus report file. For
details on this and other report options see Chapter 12.

Retrieving Equation-of-State Binary Parameters
For many component systems, binary parameters are available for these models:

Model Parameter name

Standard Redlich-Kwong-Soave RKSKIJ

Standard Peng-Robinson PRKIJ

Lee-Kesler-Plöcker LKPKIJ

BWR-Lee-Starling BWRKV, BWRKT

Hayden-O'Connell HOCETA
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Aspen Plus retrieves any databank values and uses them automatically. Whether
you enter these parameters yourself or retrieve them from a databank, you can
view them from the appropriate Properties Parameters Binary Interaction Input
sheet.  Aspen Plus creates one form for each binary parameter.

If you do not want to retrieve built-in equation-of-state binary parameters,
remove the databank name from the Selected Databanks list on the Databanks
sheet of the Properties Parameters Binary Interaction form for your equation-of-
state model. Use the Input sheet to enter your own binary parameter values. For
more information see Entering Scalar Binary Parameters on page 8-16.

Retrieving Activity Coefficient Binary Parameters
For many component pairs, binary parameters are available for the following
property methods for vapor-liquid applications:

Property method Parameter name

NRTL NRTL

NRTL-HOC NRTL

NRTL-RK NRTL

UNIQUAC UNIQ

UNIQ-HOC UNIQ

UNIQ-RK UNIQ

WILSON WILSON

WILS-HOC WILSON

WILS-GLR WILSON

WILS-LR WILSON

WILS-RK WILSON
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For liquid-liquid applications, binary parameters are available for the following
property methods:

Property method Parameter name

NRTL NRTL

NRTL-HOC NRTL

NRTL-RK NRTL

UNIQUAC UNIQ

UNIQ-HOC UNIQ

UNIQ-RK UNIQ

AspenTech developed these parameters using data from the Dortmund
Databank. See Aspen Plus Physical Property Data for details.

Whenever you select these property methods, Aspen Plus retrieves these
parameters automatically and displays them on the Input sheet of the Properties
Parameters Binary Interaction forms. Aspen Plus creates a form for each binary
parameter.

If you do not want to retrieve built-in binary parameters, remove the databank
name from the Selected Databanks list on the Databanks sheet of the Properties
Parameters Binary Interaction form. Use the Input sheet to enter your own
binary parameter values.

For more information, see Entering Temperature-Dependent Binary Parameters
on page 8-17.

For binary parameters retrieved from a databank, use Help to obtain information
about the quality of the parameters—for example, sum of squares error and
average and maximum deviations of the fit.

Retrieving Henry’s Law Constants
Henry's law constants are available for a large number of solutes in solvents. The
solvents are water and many organic components.

If you use an activity coefficient property method and define a set of Henry's
components, Aspen Plus retrieves the Henry's constants automatically and
displays them on the Input sheet of the Properties Parameters Binary
Interaction HENRY-1 form.
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If you do not want to retrieve built-in Henry's law constants, remove both the
BINARY and HENRY databanks from the Selected Databanks list on the
Databanks sheet of the HENRY-1 form.

Retrieving Electrolyte Binary and Pair Parameters
Binary and pair parameters of the Electrolyte NRTL model are available for
many industrially important electrolyte systems.

Aspen Plus retrieves the binary parameters and displays them on the Properties
Parameters Binary Interaction forms. For pair parameters, Aspen Plus displays
them on the Properties Parameters Electrolyte Pair forms.

If you do not want to retrieve built-in parameters, remove the databank name
from the Selected Databanks list on the Databanks sheet of the applicable form.

See Aspen Plus Physical Property Data, Chapter 2, for details about electrolyte
systems, the sources of data used, and the application range.

Entering Property Parameters

If any parameters required by your simulation are missing from the databanks,
or if you do not want to use databank values, you can:
• Enter any parameters or data directly.
• Estimate parameters using Property Estimation. For more information, see

Chapter 30.
• Regress parameters from experimental data using Data Regression. For more

information, see Chapter 31.

This section explains how to enter the following parameters directly:
• Pure component constants
• Pure component correlation parameters
• Parameters for nonconventional components
• Scalar binary parameters
• Temperature-dependent binary parameters
• Binary parameters from Dechema
• Electrolyte pair parameters
• Ternary parameters
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Forms for Entering Property Parameters
The table below shows where to enter the different types of property parameters:

Use the Input sheet of this Properties
Parameters form

To enter

Pure Component Scalar Scalar pure component parameters, such as critical temperature (TC) or molecular weight
(MW)

Pure Component T-Dependent Temperature-dependent pure component property correlation parameters, such as
PLXANT for the extended Antoine vapor pressure model

Pure Component Nonconventional Unary parameters for nonconventional components

Binary Interaction Scalar binary parameters, such as the RKSKIJ binary parameters
for the Redlich-Kwong-Soave equation-of-state model

Temperature-dependent binary parameters (that is, parameters
defined with more than one element) such as the
NRTL binary parameters or Henry's law constants

Electrolyte Pair Electrolyte-molecule and electrolyte-electrolyte pair parameters
required by the electrolyte NRTL model, such as the
GMELCC parameters

Electrolyte Ternary Electrolyte ternary parameters required by the Pitzer model,
such as the cation1-cation2-common anion parameters
and anion1-anion2-common cation parameters (GMPTPS)

UNIFAC Group Area and volume parameters for the UNIFAC functional groups

UNIFAC Group Binary Scalar group-group interaction parameters for the original
UNIFAC model (GMUFB)

T-Dependent group-group interaction parameters for the
modified UNIFAC models, such as the Dortmund-modified
UNIFAC and the Lyngby-modified UNIFAC models

How to Enter Property Parameters
The general procedure for entering all property parameters is as follows. For
details on entering the specific types of parameter, see the appropriate sections
later in this chapter.

To enter property parameters:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Parameters folder.
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3. Click the folder for the type of parameters you want to enter (Pure
Component, Binary Interaction, Electrolyte Pair, Electrolyte Ternary,
UNIFAC Group, or UNIFAC Group Binary). Descriptions for these parameter
types are in the above table.

Aspen Plus automatically creates parameter sets for any binary interaction,
electrolyte pair, and parameters required by the property methods specified
on the Properties Specifications form. The Object Manager for the appropriate
parameter type displays the IDs for these parameter sets.

4. On the Object Manager for the parameter type you choose, you can
• Enter parameters for an existing parameter set by selecting the

parameter and clicking Edit.
– or –

• Create a new parameter set. In the Object Manager, click New. If
prompted, select the appropriate parameter type and parameter name,
and click OK.

5. Use the Parameter input sheet to:
• Enter parameters that are not in the Aspen Plus databanks
• Override defaults or databank values by entering parameter values

You can enter parameter values in any units. After you specify a parameter
name, Aspen Plus automatically fills in the default units.

If you change the units of measurement for the parameter after you enter the
parameter value, Aspen Plus does not convert the displayed value.

Tip When defining non-databank components using the Components
Specifications Selection sheet, you can use the User Defined
Components Wizard. The wizard guides you through entering the
basic pure component parameters required.

For more detailed information on the User Defined Components Wizard, see
Chapter 6.

Entering Pure Component Constants
To enter pure component constants:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Parameters folder.

3. Click the Pure Component folder.
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4. In the Parameters Pure Component Object Manager, you can create new
parameter IDs, or modify existing IDs.

5. To create a new parameter set, on the Object Manager click New.

6. In the New Pure Component Parameters dialog box, the default parameter
type is Scalar. Enter an ID or accept the default ID and click OK.

7. To modify an existing parameter ID, on the Object Manager select the name
of the parameter set, and click Edit.

8. On the Input sheet for pure component scalar parameters, define the matrix
of components and parameters for which you are entering data values, and
specify the appropriate units.

Example of Entering Pure Component Constants

Enter critical temperature (TC) and critical pressure (PC) of 410.2 K and 40.7
atm for component C1. Enter critical pressure of 36.2 atm for component C2.

Entering Pure Component Correlation Parameters
To enter coefficients for temperature-dependent pure component property
correlations:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Parameters folder.
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3. Click the Pure Component folder.

4. In the Parameters Pure Component Object Manager, you can create new
parameter IDs, or modify existing IDs.

5. To create a new parameter set, on the Object Manager click New.

The New Pure Component Parameters dialog box appears:

6. In the New Pure Component Parameters dialog box, select T-dependent
correlation, and choose the appropriate parameter name from the list.

7. Click OK.

8. To modify an existing parameter ID, on the Object Manager select the name
of the parameter set, and click Edit.

9. On the Input sheet, choose a component from the Component list. For the
chosen temperature dependent parameter, use this sheet to enter values for
all components for which you have parameters.

10. Specify the appropriate units and enter the coefficients of each parameter as
sequential elements. For a more detailed description of models and
parameters, see Aspen Plus Physical Property Methods and Models.

You cannot enter more than one set of values for the same parameter on the
same form.
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Example for Entering Ideal Gas Heat Capacity Coefficients

For component CLP, enter the coefficients for the Ideal Gas Heat Capacity
Polynomial model (CPIG):

C
P 

IG  = –2001.2 + 358.9T – 0.515T2 + 4.41 x 10–4T3 –1.58 x 10–7 T4

CPIG has units of J/kmol-K. T is in units of K.

Entering Parameters for Nonconventional Components
To enter parameter values for nonconventional components:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Parameters folder.

3. Click the Pure Component folder.

4. In the Parameters Pure Component Object Manager, you can create new
parameter IDs, or modify existing IDs.

5. To create a new parameter set, on the Object Manager click New.

The New Pure Component Parameters dialog box appears:
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6. In the New Pure Component Parameters dialog box, select Nonconventional.

7. Enter an ID or accept the default ID, then click OK.

8. To modify an existing parameter ID, on the Object Manager select the name
of the parameter set, and click Edit.

9. On the Input sheet, choose a parameter from the Parameter list.

10. Enter components, parameters, and units.

When you use the general enthalpy and density models shown in this table
Aspen Plus requires at least the first element of the heat capacity polynomial
(HCGEN) and density polynomial (DENGEN), for each constituent of each
nonconventional component. The heat of formation (DHFGEN) is required
when reactions occur involving nonconventional components:

General Models

Property Model Attribute Requirements

ENTHALPY ENTHGEN GENANAL

DENSITY DNSTYGEN GENANAL
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Special Models for Coal and Coal-Derived Materials

Property Model Attribute Requirements

ENTHALPY HCOALGEN
HCJ1BOIE
HCOAL-R8
HBOIE-R8

ULTANAL, PROXANAL, SULFANAL
ULTANAL, PROXANAL, SULFANAL
ULTANAL, PROXANAL, SULFANAL
ULTANAL, PROXANAL, SULFANAL

DENSITY DCOALIGT
DCHARIGT

ULTANAL, SULFANAL
ULTANAL, SULFANAL

Alternatively, you can enter tabular data directly for enthalpy and density.
Polynomial TABPOLY models are not available for nonconventional
components.

Property Model

ENTHALPY ENTHLTAB

DENSITY DNSTYTAB

For more information on using tabular data and polynomial coefficients see
Using Tabular Data and Polynomial Coefficients on page 8-24.

Entering Scalar Binary Parameters
To enter scalar binary parameters:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Parameters folder.

3. Click the Binary Interaction folder to open the Object Manager containing the
binary parameter sets used by your specified property methods.

4. On the Object Manager, select the scalar parameter of interest and click Edit.

5. Define the ij matrix of components for which you are entering binary
parameter values.

6. Enter the parameter values.

Example for Entering Redlich-Kwong-Soave Binary Parameters

Binary parameters for the Redlich-Kwong-Soave equation of state, RKSKIJ, are
symmetric (that is, kij = kji). Enter the following values for the binary parameters
in the three-component system C1-C2-C3:
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Component Pair RKSKIJ

C1-C2 0.097

C1-C3 0

C2-C3 -0.018

Note You will not see the RKSKIJ-1 parameter in the Binary
Interaction Object Manager unless you have previously chosen
the RK-SOAVE property method. (See Chapter 7 for specifying
property methods.)

Entering Temperature-Dependent Binary Parameters
To enter temperature-dependent binary parameters:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Parameters folder.

3. Click the Binary Interaction folder to open the Object Manager containing the
binary parameter sets used by your specified property methods.

4. On the Object Manager, select the temperature-dependent parameter of
interest (for example, NRTL-1) and click Edit.

5. On the Input sheet, enter component pairs in the Component i and
Component j boxes.
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6. Specify the units for the binary parameters.

7. Enter the coefficients of the parameters as sequential elements for each
component pair.

Example for Entering NRTL Binary Parameters

The NRTL binary parameters aij and bij are asymmetric, that is, aij ≠ aji and bij ≠
bji. The binary parameter cij and dij are symmetric; eij and fij  default to zero.
Enter the following NRTL binary parameters for the components C1-C2. The
units for the binary parameters are in Kelvins.

a12 = 0

a21 = 0

b12 = -74.18

b21 = 270.8

c12 = 0.2982

Note You will not see the NRTL-1 parameters in the Binary
Interaction Object Manager, unless you have previously chosen
an NRTL-based property method. (For information on specifying
property methods, see Chapter 7.)
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Entering Binary Parameters from DECHEMA
The DECHEMA Chemistry Data Series contains a large number of binary
parameters for the Wilson, NRTL, and UNIQUAC models. These binary
parameters are not compatible with the form of the equations used in
Aspen Plus. However, you can enter them directly, without any conversion, using
the Dechema button on the Properties Parameters Binary Interaction Input
sheet for temperature dependent parameters.

To enter binary parameters from DECHEMA:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Parameters folder.

3. Click the Binary Interaction folder to open the Object Manager containing the
binary parameter sets used by your specified property methods.

4. On the Object Manager, select NRTL-1, WILSON-1, or UNIQ-1 and choose
Edit.

5. On the Input sheet, enter component pairs in the Component i and
Component j boxes.

6. With the appropriate component pair selected, click the Dechema button.

7. In the Dechema Binary Parameters dialog box, enter the binary parameter
values. You can also specify whether the parameters came from the VLE or
LLE collection.

8. Click OK.

Aspen Plus converts the binary parameters you enter and displays the
converted values on the Input sheet.

Aspen Plus databanks contain both parameters developed by Aspen
Technology, Inc. and those obtained from the DECHEMA Chemistry Data
Series (databank name = VLE-LIT). You will seldom need to enter binary
parameters from the DECHEMA Chemistry Data Series.

Example of Entering NRTL Binary Parameters from DECHEMA

Enter the following binary parameters for ethanol (i) and water (j), as reported in
the DECHEMA Chemistry Data Series, Vol. I, Part 1A, p. 129:

aij = -517.9603 cal/mol

aji = 1459.309 cal/mol

αij = 0.0878
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Estimating Binary Parameters for Activity Coefficient
Models

You can request the estimation of missing binary parameters for the Wilson,
NRTL, and UNIQUAC models, using the Properties Parameters Binary
Interaction form. For convenience, Aspen Plus provides this capability in
addition to the Property Constant Estimation System (PCES). For more
information about PCES, see Chapter 30.

To estimate binary parameters:

1. Go to the Properties Parameters Binary Interaction Object Manager.

2. Select the WILSON-1, NRTL-1 or UNIQ-1 binary parameter form of interest
and choose Edit.

3. On the Input sheet, check the Estimate All Missing Parameters by UNIFAC
check box.

Entering Electrolyte Pair Parameters
Use the Properties Parameters Electrolyte Pair form to enter values for
molecule-electrolyte and electrolyte-electrolyte pair parameters for the
Electrolyte NRTL model.
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To enter electrolyte pair parameters:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Parameters folder.

3. Click the Electrolyte Pair folder.

4. On the Electrolyte Pair Object Manager, select a parameter name, and click
Edit.

5. On the Input sheet, define the molecule-electrolyte or electrolyte-electrolyte
pairs for which you are entering values.

6. Enter the parameter values for the specified pairs.

Example of Entering Electrolyte NRTL Pair Parameters

Enter the following electrolyte NRTL pair parameters (GMELCC) for the brine
system:

τH2O,NaCl = 8.572

 τNaCl,H2O = -4.435

NaCl dissociates completely into Na+ and Cl-.
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Entering Ternary Parameters
Use the Properties Parameters Electrolyte Ternary form to enter values for the
Pitzer ternary parameters when using the Pitzer electrolyte activity coefficient
model.

For example, you can enter cation1-cation2-common anion parameters and
anion1-anion2-common cation parameters (GMPTPS).

To enter electrolyte pair parameters:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Parameters folder.

3. Click the Electrolyte Ternary folder.

4. In the Electrolyte Ternary Object Manager, you can create new parameter
IDs, or modify existing IDs.

5. To create a new parameter set, on the Object Manager click New.

6. In the Create New ID dialog box, enter an ID in the Enter ID box, or accept
the default ID.

7. Click OK.

8. To modify an existing parameter ID, on the Object Manager select the name
of the parameter set, and click Edit.
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9. Select an electrolyte ternary parameter from the Parameter list.

10. With Cation selected in the View list, enter the cation1-cation2-common anion
parameters by listing two cations, the common aion(s), and the respective
parameter values. Enter all cation1-cation2-common anion parameters with
the Cation view selected.

11. Select Anion from the View list.

12. Enter the anion1-anion2-common cation parameters by listing two anions, the
common cation(s), and the respective parameter values. With the Anion view
selected, continue to list all anion1-anion2-common cation parameters.

For more information on using the electrolyte features with Aspen Plus, see
Chapter 6.

Example for Entering Electrolyte Pitzer Ternary Parameters

Enter the following Pitzer ternary parameters (GMPTPS) for the NaCl/CaSO4
system:

i j k ψψψψijk

Na+ Ca+2 Cl- -0.014

Na+ Ca+2 SO4-2 -0.023

Cl- SO4-2 Na+ 0.0014

Cl- SO4-2 Ca+2 0.0

Cation view:
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Anion view:

Using Tabular Data and Polynomial
Coefficients

In addition to the standard Aspen Plus physical property methods and models,
you can represent some properties through:
• Direct use and interpolation of user-supplied tabular data
• Calculation from a general polynomial model

This section describes:
• Entering tabular data
• Entering polynomial coefficients for general polynomial model
• Adjusting reference states for tabular data and polynomials
• Adjusting tabular data or polynomials for the effect of pressure
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This table shows the Tabpoly properties:

Property Model Form†

Density for non-conventional components Normal

Enthalpy for non-conventional components Normal

Enthalpy of fusion Normal

Enthalpy of sublimation Normal

Enthalpy of vaporization Normal

Henry's constant Logarithmic

Ideal gas enthalpy Normal

Ideal gas heat capacity Normal

Liquid diffusion coefficient Normal

Liquid enthalpy Normal

Liquid enthalpy departure Normal

Liquid entropy Normal

Liquid entropy departure Normal

Liquid fugacity coefficient for a component in a mixture Logarithmic

Liquid Gibbs free energy Normal

Liquid Gibbs free energy departure Normal

Liquid heat capacity Normal

Liquid-Liquid K-value Logarithmic

Liquid thermal conductivity Normal

Liquid viscosity Logarithmic

Liquid volume Normal

Pure component liquid fugacity coefficient Logarithmic

Pure component vapor fugacity coefficient Logarithmic

Solid enthalpy Normal

Solid enthalpy departure Normal

Solid entropy Normal

Solid entropy departure Normal

Solid fugacity coefficient Logarithmic

Solid Gibbs free energy Normal

Solid Gibbs free energy departure Normal

continued
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Property Model Form†

Solid heat capacity Normal

Solid thermal conductivity Normal

Solid vapor pressure Logarithmic

Solid volume Normal

Surface tension Normal

Vapor diffusion coefficient Normal

Vapor enthalpy Normal

Vapor enthalpy departure Normal

Vapor entropy Normal

Vapor entropy departure Normal

Vapor fugacity coefficient for a component in a mixture Logarithmic

Vapor Gibbs free energy Normal

Vapor Gibbs free energy departure Normal

Vapor heat capacity Normal

Vapor-Liquid K-value Logarithmic

Vapor pressure Logarithmic

Vapor thermal conductivity Normal

Vapor viscosity Normal

Vapor volume Normal

† If the model form is logarithmic, the tabular model uses the logarithmic transformation of the property to interpolate and
extrapolate. The polynomial model is the logarithmic form of the equation.

How Aspen Plus Uses Your Tabular Data and
Polynomial Coefficients

Aspen Plus calculates the property for the component, using the tabular data and
polynomial coefficients you enter. If you do not provide data for all components,
Aspen Plus uses the property models of the ideal property method (IDEAL), for
the components without data. For most properties, Aspen Plus calculates
mixture properties using mole fraction average ideal mixing.

Aspen Plus uses your tabular data directly—Aspen Plus does not fit a polynomial
equation to the data. When necessary, Aspen Plus uses a quadratic interpolation
method to determine the property value at a given temperature. You should
provide tabular data at small temperature intervals.
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When the temperature is outside the lowest or highest temperature data that you
entered, Aspen Plus calculates the property by linear extrapolation. If the model
form is logarithmic, Aspen Plus uses the logarithmic transformation of the
property to interpolate and extrapolate. For polynomial models when
temperature is outside the lower and upper limits of the correlation, Aspen Plus
also calculates the property by linear extrapolation.

If you enter Then

Enthalpy or heat capacity data You can use the Data Generation Options on the Specifications sheet
to generate entropy and Gibbs free energy.

Vapor enthalpy data Also enter ideal gas enthalpy data to ensure consistency.

Enthalpy, entropy, and Gibbs free energy Make sure they are consistent (G = H – TS).

To enter experimental data for use with Property Estimation or Data Regression,
use the Properties Data forms. For information on entering data for use in
estimation or regression, see Chapters 30 and 31.

Entering Tabular Data
To enter tabular data:

1. From the Data menu, click Properties.

2. From the left pane of the Data Browser, go to the Properties Advanced
Tabpoly Object Manager.

3. Click New to create a new object.

4. Enter an ID or accept the default ID, and then click OK.

5. On the Specifications sheet, choose the property for which you are entering
data in the Property list. You can enter data for only one property on each
Tabpoly form. Use as many forms as needed to enter your data.

6. In the For Property Method list, choose the property method for which the
Tabpoly property is to be used. Specify All to use the data for all property
methods in the simulation.

7. On the Data sheet, choose the component for which you have data, from the
Component list box.

8. Select data type tabular Data, then enter the tabular data (property versus
temperature) for the component.
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You must enter the temperature-dependent tabular data in order of
ascending temperature points. Aspen Plus determines the units for the
temperature and the property data from the Units-Set you specify in the
Units list box on the Data Browser toolbar.

Example of Entering Vapor Pressure Data for Component CLP

This example assumes that the Units list box on the Data Browser toolbar is
referencing a new Units-Set defined with temperature units of C and pressure
units of mmHg.

Enter the following tabular data:

Vapor pressure (mmHg) Temperature (C)

70 0

177 20

390 40

760 59.4

2358 100

8200 160
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Entering Polynomial Coefficients for the General
Polynomial Model

To enter polynomial coefficients for a general polynomial model:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Advanced folder.

3. Click the Tabpoly folder.

4. On the Tabpoly Object Manager, click New to create a new object.

5. Enter an ID or accept the default ID, and then click OK.

6. On the Specifications sheet, specify the property for which you are entering
polynomial coefficients in the Property list box. You can enter polynomial
coefficients for only one property on each form. Use as many forms as needed
to enter your coefficients.

7. In the For Property Method list box, choose the property method for which
the Tabpoly property is to be used. Specify All to use the data for all property
methods in the simulation.

8. On the Data sheet, choose the component for which you have coefficients,
from the Component list.
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9. Select the data type: Polynomial Coefficient, then enter the general
polynomial coefficients for the selected component.
The polynomial model is of the form:

Ta
T
a
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a

T
aTaTaTaa

property

property
ln

)ln(
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2
653
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2

321 +++++++=�
�
�

or

See the Tabpoly Properties table on page 8-25 to determine whether the
property you want to enter uses the normal or logarithmic form.

The coefficients a2 through a8 default to zero. The lower temperature limit of
the correlation (Min. temperature) defaults to 0 K. The upper temperature
limit (Max. temperature) defaults to 1000 K. When the temperature is outside
the limits, Aspen Plus calculates the property by linear extrapolation.

The Units-Set you specify in the Units list box on the Data Browser toolbar
determines the units for the coefficient values. If a5, a6, a7, or a8 is non-zero,
Aspen Plus assumes absolute temperature units for all parameters.

Adjusting Reference States for Tabular Data and
Polynomials

Aspen Plus can adjust the reference state of the enthalpy, entropy, and Gibbs
free energy data that you entered. To specify this:

1. On the Tabpoly Specifications sheet, deselect the Do Not Adjust Reference
State check box for your Tabular data or your Polynomial data.

2. Specify the basis (Mole or Mass) for your reference value and for the data, in
the Basis list box.

3. On the Reference Points sheet, select the component for which you want to
adjust the reference state, in the Component list box.

4. In the Reference Points boxes enter a reference Temperature and a reference
value for Enthalpy, Entropy, or Gibbs free energy.

5. If you want to enter reference values and have Aspen Plus generate entropy
and Gibbs free energy data from the enthalpy or heat capacity data that you
enter, you must enter reference values for two of the three properties. The
reference values are at the same temperature.
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6. To use the Aspen Plus default reference state, do not enter any data on the
Reference Points sheet. However, you must supply these parameter values for
(or they must be available in the databanks):
• DHFORM, DGFORM, PLXANT
• DHVLWT (or DHVLDP)
The Aspen Plus thermodynamic reference state is the component’s
constituent elements in an ideal gas state at 25°C and 1 atm.

If a simulation has Then

No chemical reactions You can select the reference states arbitrarily.

Chemical reactions You must select reference states that include DHFORM
for all components undergoing reaction.

Equilibrium reactions You must select reference states that include DGFORM
for all components undergoing reaction.

Adjusting Tabular Data or Polynomials for the Effect of
Pressure

Aspen Plus adjusts vapor-liquid K-values, Gibbs free energies, and entropies for
the effect of pressure using the following relationships:
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Where:

P ref = Reference pressure (the pressure at which the data was
obtained.)

P = Actual system pressure

T = Temperature

K(T,Pref) = K-value at T and the reference pressure

s(T,Pref) = Entropy at T and the reference pressure

g(T,Pref) = Gibbs free energy at T and the reference pressure
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Requesting Pressure Adjustment

To request pressure adjustment:

1. Go to the Reference Points sheet of the Tabpoly form.

2. Choose the component for which you want to specify the reference pressure,
from the Component list box.

3. In the Pressure box, enter the reference pressure.

For K-values, Aspen Plus makes no adjustment for the pressure effect, unless
you supply the reference pressure. You should always enter a reference pressure,
unless the pressure range of the simulation matches that of the data.

If you use the Aspen Plus thermodynamic reference state for entropy and Gibbs
free energy, an adjustment for the pressure effect is always performed using Pref

= 101325 N/m2. If you do not use the Aspen Plus reference state, Aspen Plus
adjusts for the pressure effect only if you supply the reference pressure.

Using Property Data Packages

This section describes the Property Data Packages available in Aspen Plus.

You can use these data packages to model many important industrial processes.
Theses data packages have been developed using publicly available literature
data. They will be updated as new data becomes available. For your particular
process, you may need to add or remove components and provide additional
interaction parameters.
• Ammonia-water
• Ethylene
• Flue gas treatment
• Formaldehyde-methanol-water
• Glycol dehydration of natural gas
• Mineral solubilities in water using the Pitzer model
• Gas treating processes using amines: MDEA, DEA, DGA, AMP and MEA
• Methyl-amine
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Using a Data Package
To use a data package:

1. From the File menu, click Import.

2. In the Import dialog box, click the Look In Favorites button.

3. From the list of favorite folders, select Data Packages.

4. Select the data package that you want and click Open.

Ammonia-Water Data Package
Use this data package for ammonia and water. This data package uses the
Electrolyte NRTL model.

This data package is applicable from 5 - 250 C with pressure up to 100 bar.

Ethylene Data Package
Use this data package to model Ethylene processes. This data package uses the
SR-POLAR equation of state model because of its versatility in representing both
hydrocarbons and polar components such as water.

Pure component parameters were evaluated using experimental data for vapor
pressure, liquid heat capacity and liquid density.

Binary parameters were evaluated from experimental VLE and LLE data.

This data package should provide a very good starting point for building the
Ethylene process model. Simulation results can be improved by regressing
missing binary parameters or updating the existing parameters with the new
ones based on latest experimental data.

Using Electrolyte Amines Data Packages
Aspen Plus provides special data packages (inserts) for amines systems:  MDEA,
DEA, MEA, DGA and AMP (2-amino-2-methyl-1-propanol, C4H11NO-1).

These packages allow you to accurately model amines gas treating processes.
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These inserts use the electrolyte capabilities, but also take into consideration
kinetic reactions of CO2 in the liquid phase. The reaction kinetics can be used in
either the RADFRAC or RATEFRAC distillation models. This modeling approach
is fundamentally sound and has been validated through industrial applications.
These data packages give more accurate results than those that do not consider
kinetics reactions.

The following table shows the range of applications:

System Insert Name Temperature Amines Concentration

AMP KEAMP 40-100 C 2.47 to 4.44 molal

MDEA KEMDEA 25 - 120 C Up to 50 weight %

DEA KEDEA Up to 140 C Up to 30 weight %

DGA KEDGA Up to 100 C Up to 65 weight %

MEA KEMEA Up to 120 C Up to 50 weight %

Using an Amines Data Package

To use an amines insert:

1. From the File menu, click Import.

2. In the Import dialog box, click the Look In Favorites button.

3. From the list of favorite folders, select Data Packages.

4. Select the desired data package and click Open.

5. In the Parameter Values dialog box, enter the component IDs you are using
for the amine, CO2 and H2S by first selecting the Parameter then clicking the
Edit Value button.

Make sure that you use the true component approach on the Properties
Specifications Global sheet or the Block Options Properties sheet of a unit
operation model. This is required for all the amines data packages that use
kinetic reactions.
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6. If you are using RADFRAC or RATEFRAC, specify one of the following
Reaction IDs on the Reactions form for the model:

Reaction ID For modeling When using this data package

 MDEA-CO2 CO2 absorption KEMDEA

 MDEA-ACID CO2/H2S absorption KEMDEA

 MEA-CO2 CO2 absorption KEMEA

 MEA-ACID CO2/H2S absorption KEMEA

 DEA-CO2 CO2 absorption KEDEA

 DEA-ACID CO2/H2S  absorption KEDEA

Flue Gas Treatment Data Package
Use this data package to model flue-gas purification process. The data package
uses the Electrolyte NRTL model.

The apparent components are:

H2O, N2, O2, CO2, CO, SO2, SO3, NO, NO2, HCL, HF, HNO3, HNO2, H2SO4,
H2SEO3, HGCL2, HG2CL2, HG, C, SE, SEO2, HG(OH)2, CASO4*2W, CAF2,
CAO, CA(OH)2

The Henry-components are:

CO CO2 SO2 HCL O2 N2 NO HG

Valid temperature range from: 273.15 K to  373.15 K

Formaldehyde-Methanol-Water Data Package
Use this data package to model Formaldehyde-Methanol-Water system. This
system is highly non-ideal because the three components form multiple
complexes.

The vapor phase is modeled using the Hayden-O'Connell model. This model
properly accounts for the strong association in the vapor phase.
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The liquid phase is modeled using the UNIFAC model with special group-group
interaction parameters determined from regression of experimental data. The
complexes such as methylene glycol and hemiformal are formed using the
Chemistry reactions.

Valid temperature range: 0 to 100 C

Mole fraction of Formaldehyde: 0 - 0.6

Pressure: 0 - 3 bar

Glycol Dehydration Data Package
Use this data package to model natural gas dehydration processes using glycols
(Ethylene glycol (EG): C2H6O2, Di-ethylene glycol  (DEG): C4H10O3, or Tri-
ethylene glycol (TEG): C6H14O4)

The data package uses the Schwartzentruber-Renon equation-of-state (SR-
POLAR) model.

The components included in this package are:

EG, DEG, TEG, WATER,  METHANOL, CO2, N2, H2S, METHANE, ETHANE,
PROPANE, N-BUTANE, N-PENTANE, N-HEXANE, N-HEPTANE, N-OCTANE,
N-NONANE, N-DECANE, BENZENE, TOLUENE, O-XYLENE, ISO-BUTANE,
ISO-PENTANE, ETHYLENE, PROPYLENE

The experimental data used to develop the data package cover very wide range of
temperatures and pressures.

Pitzer Data Packages
There are four data packages for calculating mineral solubilities in water using
the Pitzer electrolyte model:

1. PITZ_1: for prediction of mineral solubilities in water at 25 C. The system is
Na-K-Mg-Ca-H-Cl-SO4-OH-HCO3-CO3-CO2-H2O.

2. PITZ_2: for prediction of mineral solubilities in water for systems:

Na-K-Ca-Ba-Cl-H2O and Na-Ca-Cl-SO4-H2O.
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The apparent components are:

H2O, NACL,  KCL, CACL2,  ACL2*4H2O, CACL2*6H2O, BACL2,
ACL2*2H2O

Valid temperature range: up to 200 C

Valid pressure: equilibrium to 1 atmosphere

3. PITZ_3: for Na-K-Ca-Cl-SO4-NO3-H2O system

The apparent components are:

H2O, NA2SO4, NACL, NA2SO4*10H2O, NA2CA(SO4)2,
NA4CA(SO4)3*2H2O, NANO3, K2SO4, KCL, K2CA(SO4)2*H2O, KNO3,
CACL2, CASO4, CACL2, CACL2*6H2O, CASO4*2H2O, 2(CASO4)**H2O,
CACL2*4H2O,CA(NO3)2, CA(NO3)2*4H2O

Valid temperature range: 0 - 250 C

4. PITZ_4 for H2O- NaCl- Na2SO4- KCl- K2SO4- CaCl2- CaSO4- MgCl2-
MgSO4- CaCl2*6H2O- MgCl2*6H2O- MgCl2*8H2O- MgCl2*12H2O-
KMgCl3*6H2O- Mg2CaCl6*12H2O- Na2SO4*10H2O- MgSO4*6H2O-
MgSO4*7H2O- K2Mg(SO4)2*6H2O

Valid temperature range : -60 to 25 C

Methyl-amine Data Package
Use this data package to model methyl-amines process. This system is highly
non-ideal. The components included are: ammonia, water, methanol, methyl-
amine, dimethylamine and trimethyl-amine.

The property model used for representing VLE data is the SR-POLAR equation of
state. High pressure VLE data for NH3-H2O and Methanol-Water were used in
the regression. This model is particularly good for high pressure column. The
results may be improved by adding additional binary parameters for the EOS
based on new VLE data.

Pure component parameters were evaluated using liquid Density, Heat Capacity,
and Vapor pressure data.
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Using Other Electrolyte Data Packages
The following tables show electrolyte data packages that are available in the
ELECINS sub-directory.

This table shows electrolyte data packages, available in the ELECINS sub-
directory, that use the ELECNRTL property method:

Property Method ELECNRTL
Filename Electrolyte System

h2ohc.bkp H2O - HCL (as Henry-comps)

ehno3.bkp H2O - HNO3

enaoh.bkp H2O - NAOH

eso4br.bkp H2O - H2SO4 - HBR

ehbr.bkp H2O - HBR

ehi.bkp H2O - HI

eh2so4.bkp H2O - H2SO4

ehclmg.bkp H2O - HCL - MGCL2

enaohs.bkp H2O - NAOH - SO2

eso4cl.bkp H2O - H2SO4 - HCL

ecauts.bkp H2O - NAOH - NACL - NA2SO4 -NA2SO4.10H2O -NA2SO4.NAOH - NA2SO4.NAOH.NACL

ekoh.bkp H2O - KOH

ecaust.bkp H2O - NAOH - NACL - NA2SO4

ehcl.bkp H2O - HCL (as solvent)

ehclle.bkp H2O - HCL (as solvent, recommend for LLE)

edea.bkp H2O - DEA - H2S - CO2

ehotde.bkp H2O - DEA - K2CO3 - H2S - CO2

emea.bkp H2O - MEA - H2S - CO2

ecl2.bkp H2O - CL2 - HCL

enh3co.bkp H2O - NH3 - CO2

enh3so.bkp H2O - NH3 - SO2

esouro.bkp H2O - NH3 - H2S - CO2 - NAOH

edga.bkp H2O - DGA - H2S - CO2

enh3h2.bkp H2O - NH3 - H2S

eamp.bkp H2O - AMP - H2S - CO2

ehotca.bkp H2O - K2CO3 - CO2

enh3hc.bkp H2O - NH3 - HCN

continued
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Filename Electrolyte System

ebrine.bkp H2O - CO2 - H2S - NACL

ebrinx.bkp H2O - CO2 - H2S - NACL  (extended Temperature range)

eclscr.bkp H2O - CL2 - CO2 - HCL - NAOH - NACL - NA2CO3

ekohx.bkp H2O - KOH (high concentration)

ehf.bkp H2O - HF

ehotcb.bkp H2O - K2CO3 - CO2 - KHCO3

emdea.bkp H2O - MDEA - CO2 - H2S

enh3po.bkp H2O - NH3 - H3PO4 - H2S

esour.bkp H2O - NH3 - H2S - CO2

This table shows electrolyte data packages, available in the ELECINS sub-
directory, that use the SYSOP15M property method:

Property Method SYSOP15M
Filename Electrolyte System

brine.bkp H2O - CO2 - H2S - NACL

caust.bkp H2O - NAOH - NACL - NA2SO4

causts.bkp H2O - NAOH - NACL - NA2SO4 -NA2SO4.10H2O -NA2SO4.NAOH - NA2SO4.NAOH.NACL

dea.bkp H2O - DEA - H2S - CO2

dga.bkp H2O - DGA - H2S - CO2

h2ohbr.bkp H2O - HBR

h2ohcl.bkp H2O - HCL

h2ohf.bkp H2O - HF

h2ohi.bkp H2O - HI

hotca.bkp H2O - K2CO3 - CO2

hotcb.bkp H2O - K2CO3 - CO2 - KHCO3

hotdea.bkp H2O - DEA - K2CO3 - H2S - CO2

mcl2.bkp H2O - CL2

mdea.bkp H2O - MDEA - H2S - CO2

mea.bkp H2O - MEA - H2S - CO2

mh2so4.bkp H2O - H2SO4

mhbr.bkp H2O - HBR

mhcl.bkp H2O - HCL

continued
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Filename Electrolyte System

mhcl1.bkp H2O - HCL

mhclmg.bkp H2O - HCL - MGCL2

mhf.bkp H2O - HF

mhf2.bkp H2O - HF (to 100% HF)

mhno3.bkp H2O - HNO3

mnaoh.bkp H2O - NAOH

mnaoh1.bkp H2O - NAOH

mso4br.bkp H2O - H2SO4 - HBR

mso4cl.bkp H2O - H2SO4 - HCL

naohso.bkp H2O - NAOH - SO2

nh3co2.bkp H2O - NH3 - CO2

nh3h2s.bkp H2O - NH3 - H2S

nh3hcn.bkp H2O - HCN

nh3po4.bkp H2O - NH3 - H2S - H3PO4

nh3so2.bkp H2O - NH3 - SO2

sour.bkp H2O - NH3 - H2S - CO2

souroh.bkp H2O - NH3 - H2S - CO2 - NAOH

This table shows electrolyte data packages, available in the ELECINS sub-
directory, that use the SYSOP16 property method:

Property Method SYSOP16
Filename Electrolyte System

pnh3co.bkp H2O - NH3 - CO2

pnh3h2.bkp H2O - NH3

pnh3so.bkp H2O - NH3 - SO2

psour.bkp H2O - NH3 - H2S - CO2

❖     ❖     ❖     ❖ 
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9 Specifying Streams

Streams connect unit operation blocks in a flowsheet and carry material and
energy flow from one block to another. Streams can be:
• Feed streams to the flowsheet
• Internal (interconnecting) streams within the flowsheet
• Product streams from the flowsheet
• Pseudo-product streams representing flows internal to a block

Use the Stream forms to enter data for the feed streams and to give initial
estimates for any internal streams that are tear (recycle) streams.

This chapter includes information about:
• Specifying material streams
• Analyzing stream properties interactively
• Specifying stream classes and substreams
• About particle size distributions
• Accessing stream libraries
• Specifying work streams
• Specifying heat streams
• Using pseudoproduct streams
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Specifying Material Streams

For all material process feed streams, you must specify:
• Flow rate
• Composition
• Thermodynamic condition

You can provide initial guesses of these variables for tear (recycle) streams.

Entering Specifications for Streams
To enter specifications for a stream:

1. Double-click the stream in the flowsheet.

– or –

From the Data menu, click Streams. In the Streams Object Manager, select
the stream and click Edit.

2. On the Specifications sheet, specify any two of three State Variables to set the
thermodynamic condition of your stream. For example, you could specify
temperature and pressure, or temperature and vapor fraction. For the
available options, see
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Possible Stream Thermodynamic Condition Specifications on page 9-4.

3. Specify the stream composition using flow rates or flow fractions or flow
concentrations of each component in the Composition frame. See Entering
Stream Composition on page 9-5.

Perform Steps 4 through 6 only if the stream contains solids substreams.

4. If you want to specify solids substreams, use the Substream field to display
different substreams.

5. Specify temperature, pressure, and composition for each solids substream.
You must specify the same pressure for each substream.

6. If any components in the stream have component attributes, or any
substreams have particle size distributions, you must specify values for them.
For more information, see Specifying Particle Size Distribution

To specify the particle size distribution for a solid substream:

1. Double-click the stream in the flowsheet

– or –

From the Data menu, click Streams. In the Streams Object Manager select
the stream and click the Edit button.

2. On the Stream Input form, click the Stream PSD sheet.

3. Enter the weight fractions for the particle sizes. The total should be 1.0.
For more information about particle size distribution in Aspen Plus, and how
to define your own particle size ranges, see Defining New Substreams on page
9-21.

4. Specifying Component Attribute Values on page 9-8 and Specifying Particle
Size Distribution on page9-8.
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Possible Stream Thermodynamic Condition
Specifications

This table describes possible stream thermodynamic condition specifications:

Phases Free Water State Specification Stream Properties Calculated by

Vapor only No Temperature, Pressure Vapor phase thermodynamic
calculations

Solid only No Temperature, Pressure Solid phase thermodynamic
calculations

Liquid only No Temperature, Pressure Liquid phase thermodynamic
calculations

Liquid-freewater Yes Temperature, Pressure Liquid phase thermodynamic
calculations with free water
considered

Vapor-liquid or vapor-liquid-
liquid

No Temperature, Pressure TP flash

Vapor-liquid or vapor-liquid-
liquid

No Temperature, Molar Vapor
fraction

TV flash

Vapor-liquid or vapor-liquid-
liquid

No Pressure, Molar Vapor
fraction

PV flash

Vapor-liquid-freewater Yes Temperature, Pressure TP flash with free water
considered

Vapor-liquid-freewater Yes Temperature, Molar Vapor
fraction

TV flash with free water
considered

Vapor-liquid-freewater Yes Pressure, Molar Vapor
fraction

PV flash with free water
considered

Aspen Plus calculates unspecified temperature, pressure, or molar vapor
fraction, as well as the stream enthalpy, entropy, and density.

Mass-Balance-Only Calculations

If you are performing a mass-balance-only simulation:

1. Double-click the stream in the flowsheet

– or –

From the Data menu, click Streams. In the Streams Object Manager select
the stream and click the Edit button.
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2. Ensure the Calculate Stream Properties check box on the Stream Input Flash
Options sheet is clear.

3. Enter values for two of the following: Temperature, Pressure, and Vapor
fraction as State Variables on the Stream Input Specifications sheet.

For more information on checking mass balances around blocks, see Chapter 5.

Aspen Plus does not calculate stream properties in mass-balance-only
simulations.

Entering Stream Composition

You can specify the stream composition in terms of component flows, fractions, or
concentrations.

For Enter values on this basis

Component flows or fractions† Mole, mass, or standard liquid volume

Concentrations Mole or mass

†
For nonconventional components, you can enter only mass flows and fractions.

If you specify component fractions, you must specify the total mole, mass, or
standard liquid volume flow. Component fractions must sum to 1.0 or 100.0.

You can enter both component flows and total flow. Aspen Plus normalizes the
component flows to match the total flow.

If you specify component concentrations, you must enter a component ID for the
solvent and the total flow. The stream must be single phase. You can select
Vapor-Only or Liquid-Only in the Valid Phases list on the Stream Input Flash
Options sheet, and temperature and pressure as State Variables on the Stream
Input Specifications sheet. Or you can specify the stream at its bubble point
(Vapor Fraction is 0).

If you use the standard liquid volume basis for component flows, fractions or
total stream flow, you need to enter the standard liquid volume of a component
(VLSTD) on the Properties Parameters Pure Component Input form. For more
information, see Chapter 8. The values for VLSTD in the databanks are from the
API databook. The standard liquid volume is not used to calculate densities in
Aspen Plus.
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The standard liquid volume flow (Stdvol-Flow) can be very different from the
volumetric flow rate of a stream. The standard liquid volume is defined at
approximately 60ºF and 1 atm. The difference increases as the conditions diverge
from 60ºF and 1 atm. If the stream is a vapor or has a significant amount of
vapor, the volumetric flow rate of a stream is extremely different from the
standard liquid volume flow. You can enter standard vapor volume flows as mole-
flow. Select the appropriate units (for example scfm).

To report the Std.liq. Volume Flow or Std.liq.Volume Fraction in the stream
report, select the appropriate options on the Setup ReportOptions Stream sheet.
You can also calculate these Property Sets:
• VLSTDMX (standard liquid volume of a mixture)
• VLSTD (standard liquid volume of a component)

StdVol-Flow and StdVol-Frac are accessible variables that can be used in design
specifications and Calculator blocks.

The Stream Input Specifications sheet displays the total of the component flows,
fractions, or concentrations entered for the stream. Use this value to check your
input.

Example for Specifying a Process Feed Stream

A process feed stream (FEED) contains 2 lbmol/hr of hydrogen (H2) and
3 lbmol/hr of methane (CH4), at 100F and 14.7 psia. Aspen Plus performs a
two-phase flash to determine stream properties and phase conditions.
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Example for Specifying a Stream with Two Liquid Phases

A process feed stream contains 5 lbmol/hr of C1, 5 lbmol/hr of C2, and
10 lbmol/hr of H2O. Two partially miscible liquid phases are anticipated. The
vapor-liquid-liquid equilibrium is treated rigorously. Aspen Plus performs a
three-phase flash to determine phase condition.
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Specifying Particle Size Distribution

To specify the particle size distribution for a solid substream:

1. Double-click the stream in the flowsheet

– or –

From the Data menu, click Streams. In the Streams Object Manager select
the stream and click the Edit button.

2. On the Stream Input form, click the Stream PSD sheet.

3. Enter the weight fractions for the particle sizes. The total should be 1.0.
For more information about particle size distribution in Aspen Plus, and how
to define your own particle size ranges, see Defining New Substreams on page
9-21.

Specifying Component Attribute Values

Use the Stream Input Component Attr. sheet to specify values of component
attributes. You must specify values for each attribute defined on the Components
Attr-Comps selection sheet or Properties Advanced NC-Props PropertyMethods
sheet (see  Chapter 5).

To specify values of component attributes for a stream:

1. On the Stream Input form, click the Component Attr. sheet.

2. Enter values for each attribute listed.

Example of Specifying the GENANAL Component Attributes for a
Nonconventional Substream

On the Stream Input Component Attr. sheet, the elements of the GENANAL
component attribute are specified for the NCPSD substream.
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On the Properties Advanced NC-Props form, the GENANAL component attribute
is defined as required for the selected Nonconventional Component Property
models.
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About Stream Property Analysis

You can calculate and display stream properties interactively as you create your
simulation model. You do not have to complete the flowsheet definition or input
specifications first.

For example, you can flash a feed stream as soon as you define it, to check your
property model. As you develop a flowsheet model interactively, you can check
the phase behavior of intermediate streams to help you determine feasible
specifications.

The following table shows the types of stream analysis you can perform:

Stream Analysis Types

Type Description

Point Stream properties for the total stream and each of the phases present.
Properties include temperature, pressure, phase fractions, flow rate,
heat capacity, density, and transport properties.

Component Flow Component flow rates for the total stream and each of the phases present.
Mole, mass, and standard volume fractions are available.

Composition Component fractions for the total stream and each of the phases present.
Mole, mass, and standard volume fractions are available.
Partial pressure is also available.

Petroleum Point properties, plus API gravity, specific gravity, Watson K factor, and
kinematic viscosity

Dist-Curve† Petroleum distillation curves (TBP, D86, D160, and vacuum)

Bubble/Dew†† Bubble point temperature and dew point temperature versus pressure curves

PV Curve†† Vapor fraction versus pressure curves at stream temperature

TV Curve†† Vapor fraction versus temperature curves at stream pressure

PT-Envelope†† Pressure-temperature envelope curves For more information, see Generating PT-Envelopes on
page 9-14.

†
Plots can be generated from this analysis.

††
These analyses automatically display plots of the curves.

You can also perform stream property analyses using property tables. The
Analysis commands automate many of the steps required to generate a property
table, and define built-in plots appropriate for the analysis.

Use the Property Table forms when you need flexibility not provided by the
Analysis commands.
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Analyzing Stream Properties

To calculate and display stream properties interactively:

1. Make sure your Setup, Components, and Properties specifications are
complete.

2. Make sure the specifications or results for the stream you want to analyze are
complete. Either the Stream Input Specifications sheet for the stream must
be complete or the stream must have results that were calculated in the
current session.

3. Click the stream to select it.

4. On the Tools menu, point to Analysis, then Stream, then choose the type of
calculation you want to perform.

This command will be inactive if the conditions in Steps 1 and 2 are not
satisfied.

5. Make any selections and specifications you want in the appropriate dialog
box.

If you selected Bubble/Dew or PV curve, you must specify a pressure range. If
you selected TV curve, you must specify a temperature range.

6. Click Go.

7. Print or view results and plots that appear when calculations are complete.

8. Close the form and plot when you are sure you are finished with the results.
The results are not saved. You must redo the calculations if you want to
look at them again, once you close the form.

Example of Generating Point Analysis of a Stream

Stream 1 is a 50-50 mixture of ethane and heptane.



Specifying
Streams

9-12 Aspen Plus User Guide
Version 10.2



Chapter  9

Aspen Plus User Guide 9-13
Version 10.2

Example of Generating PV Curve

Stream 1 is a 50-50 mixture of ethane and heptane.

Stream Temperature is 270 F.
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Generating PT-Envelopes

Pressure-temperature (PT) envelopes are generated by following curves of
constant vapor fraction, through the critical point and back out the
complementary branch. (The complementary branch for Vapor fraction = 0.75 is 0.25.)
These plots are parametric, consisting of one curve for each vapor fraction and its
complementary branch.

You can generate PT-Envelopes from any property method, except electrolyte
property methods. But PT-Envelopes generated from activity coefficient-based
and other non-equation-of-state property methods will not pass through the
critical point. Instead there will be separate curves for each vapor fraction and its
complementary branch.

For more information about PT-envelopes, see Chapter 27.

Creating a PT-Envelope from a Stream
To create a PT-Envelope from a stream:

1. Make sure your Setup, Components, and Properties specifications are
complete.

2. Make sure the specifications or results for the stream you want to analyze are
complete. Either the Stream Input Specifications sheet for the stream must
be complete or the stream must have results that were calculated in the
current session.

3. Click the stream to select it.

4. From the Tools menu, point to Analysis, then Stream. This command will be
inactive if the conditions in Steps 1 and 2 are not satisfied.

5. Choose PT-Envelope.

6. Select the vapor fraction branches.

The Dew/Bubble point curves correspond to vapor fractions of 0 and 1.0.
Additional vapor fractions can be specified. The complementary vapor fraction
is automatically calculated for each vapor fraction specified.

7. Click Go to create the PT-Envelope table and plot. For more information on
customizing the plot, see Chapter 13.
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8. Close the form and plot when you are sure you are finished with the results.
The results are not saved. You must redo the calculations if you want to
look at them again, once you close the form. To save the input and the table of
results, click the Save as Form button before closing the PT-Envelope
Analysis form and the a form with the input and results will be saved in the
Property Analysis folder.

Example of Creating a PT Envelope

For example, a table of values and a plot for a P-T envelope is generated for
vapor fractions of 0.0, 0.2, 0.4, 0.6, 0.8, and 1.0 for a 50-50 mixture of ethane and
heptane in stream 2.
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About Stream Classes

You do not need to specify stream classes if:
• Your simulation does not involve solids
• The only solids are electrolytes salts defined using Chemistry forms or the

Electrolytes Expert System

Stream classes define structures for simulation streams when solids are present.
Solids are:
• Carried in substreams
• Characterized as either conventional or nonconventional components. For

more information, see Chapter 6.
• May have a particle size distribution (PSD)

A stream class defines a stream structure in terms of:
• Number of substreams
• Type of component carried in each substream (conventional or

nonconventional)
• Whether the substream carries particle size distribution information

Use this Setup StreamClass
sheet

To

Flowsheet Assign a new Stream Class to a flowsheet section,
and define the substreams in a stream class

Streams Assign streams to a stream class,
and define the substreams in a stream class

Use the Stream Input PSD sheet to define the particle size distribution weight
fractions for a substream.

The following sections describe how you can:For help on using Stream Classes,
click one of the following topics:
• Use predefined stream classes
• Create your own stream classes
• Assign stream classes globally
• Assign stream classes to flowsheet sections
• Assign stream classes to individual streams
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Using Predefined Stream Classes
These stream classes are predefined in Aspen Plus and should be sufficient for
most applications:

Use this stream class When

CONVEN The simulation does not involve solids, or the only solids are electrolytes salts.

MIXCISLD Conventional solids are present, but there is no particle size distribution.

MIXNC Nonconventional solids are present, but there is no particle size distribution.

MIXCINC Both conventional and nonconventional solids are present, but there is no particle size
distribution.

MIXCIPSD Conventional solids are present, with a particle size distribution.

MIXNCPSD Nonconventional solids are present, with a particle size distribution.

All unit operation models (except Extract) can handle stream classes with solid
substreams:

These models Require

All except Mixer and ClChng All inlet and outlet streams belonging to the same stream class

CFuge, Filter, SWash, CCD At least one solids substream

Crusher, Screen, FabFl, Cyclone, VScrub,
ESP, HyCyc

At least one solids substream with a particle size distribution

Crystallizer At least one solids substream with a particle size distribution, if particle sizes are
calculated

You can also assign stream classes globally, or to flowsheet sections or individual
streams.

Creating or Modifying Stream Classes
You need to create or modify a stream class to:
• Add new substreams to a stream class
• Create a stream class with PSD attributes for both CISOLID and NC type

substreams
• Use two or more particle size distribution definitions in a simulation

The number and types of substreams, together with their attributes, define a
stream class. A stream class can have any number of substreams but the first
substream for each Stream Class must be of type MIXED.



Chapter  9

Aspen Plus User Guide 9-19
Version 10.2

Each substream:
• Must be assigned a type (MIXED, CISOLID, or NC)
• Can be assigned a particle size distribution (PSD)

You can create a new stream class by listing all its substreams, or you can modify
the substreams in an existing stream class. You cannot modify a MIXED type
substream.

Use the Define StreamClass button on the Flowsheet or Streams sheet of the
Setup StreamClass form, to assign a new stream class to the structure of a
stream by listing its constituent substreams or to modify the substreams in an
existing stream class.

To create or modify a substream:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser, select the Setup Stream Class form.

3. On the Flowsheet sheet, click the Define StreamClass button.

4. On the Define StreamClass dialog box, select <new> from the list in the
Stream Class field.

–or–

Use the list in the StreamClass box to select the name of the Stream Class to
be modified.

5. Select the substreams to include in the stream class from the Available
substreams list and use the right arrow button to move them into the
Selected substreams list. The left arrow can be used to remove substreams
from the Selected substream list. The double arrow can be used to move all of
the substreams in a list at one time.

6. Use the up and down arrow buttons to rearrange the list. Note that the first
substream must be of type MIXED.

7. When finished, on the Define StreamClass dialog box, click Close.
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Specifying a Global Stream Class
You can specify the default stream class globally for all streams in a simulation.
You can override the global default for a flowsheet section or for an individual
stream.

The default stream class is the stream class for flowsheet section GLOBAL. The
default stream class is established by the Application Type you choose when
creating a new run. You can change this default on the Setup Specifications
Global sheet.

To specify the default stream class using the Setup Specifications Global sheet:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser, click the Specifications folder.

3. On the Global sheet, select a stream class in the Stream Class field.

Specifying Stream Classes for Flowsheet Sections
When using more than one stream class in a simulation, divide the flowsheet into
sections and specify a stream class for each section.

A stream that connects blocks from different sections keeps the stream class of
the section where it originates.

For example, a flowsheet might have an upstream section that involves solids
and a downstream section that does not (after all solids have been removed). You
can assign stream class MIXCISLD to the upstream section and CONVEN to the
downstream section.

You must use the Mixer and ClChng models to transition between flowsheet
sections that are assigned different stream classes.

To assign a Stream Class to a flowsheet section:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser window, select the StreamClass form.

3. Click the Flowsheet sheet.

4. Use the list to select the name of the Stream Class associated with a given
flowsheet section.
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Specifying Stream Classes for Individual Streams
You can override the global or section stream class by specifying a stream class
for one or more individual streams. To do this, use the StreamClass Streams
sheet.

To assign streams to a Stream Class:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser window, click the StreamClass form.

3. Click the Streams sheet.

4. Select the streams to include in the stream class from the Available streams
list and use the right arrow button to move them into the Selected streams
list.
Use the left arrow button to remove streams from the stream class. Use the
double arrow button to move all of the streams in a list at one time.
Streams that are left in the Available streams list will have the stream class
for the flowsheet section (from the Flowsheet sheet).

Defining New Substreams

You need to define a new substream if:
• A simulation has more than one CISOLID or NC substream.
• You want to add a new PSD definition to a substream.

To create a new substream:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser, select the Substreams folder.

3. On the Substreams sheet, enter a new substream name in the Substream
field.
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4. In the Type field, select a substream type.

Use this type For

MIXED Conventional components that reach vapor-liquid-solid phase equilibrium

CISOLID
(conventional inert solids)

Conventional components that appear in the solid phase but do not  participate in phase
equilibrium

NC (nonconventional) Nonconventional components

5. If the substream type is CISOLID or NC, select a PSD in the Attribute field if
desired.

6. Assign the substream to one or more stream classes. For more information,
see Creating or Modifying Stream Classes on page 9-18.

About Particle Size Distributions

In Aspen Plus, particle size distribution is represented by the weight fractions
per particle size interval, given the number of intervals and the size range for
each interval.

The built-in Aspen Plus particle size distribution has 10 predefined size
intervals. You can modify the built-in particle size distribution by changing the
number of intervals or the size ranges for the intervals.

In some simulations you may want to have two or more particle size distribution
definitions, with different size ranges. This is useful if different sections of your
flowsheet have very different particle sizes.

For help on particle size distributions, click one of these topics:
• Specifying particle size distribution
• Changing particle size distribution intervals
• Creating new particle size distributions

Use the Setup Substreams form to create particle size distribution for a
substream. You can specify the number of discrete intervals into which the
particle size distribution is to be divided, and to specify the upper and lower size
limits for each interval.
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Changing Particle Size Distribution Intervals
To specify the number of intervals for the particle size distribution:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser window, select the Substreams folder.

3. In the Substreams Object Manager on the PSD sheet, select the name of the
attribute set you want to modify and click Edit.

4. Type the number of intervals for the particle size distribution. You can also
select the size units.

5. Type the limits for the particle size in all of the intervals.
The Lower limit is automatically updated with the value of the Upper limit
for the previous interval and vice versa.

Creating New Particle Size Distributions
You can create one or more new particle size distribution attributes, in addition
to the built-in PSD:

1. From the Data menu, click Setup.

2. In the left pane of the Data Browser, select the Substreams folder.

3. In the Substreams Object Manager, on the PSD sheet, click New.

4. In the Create New ID dialog box, enter a PSD ID or accept the default ID.

5. On the PSD sheet, in the Interval Number column, enter the number of
discrete intervals in the particle size distribution. You can also select the size
units.

6. In the Lower Limit column, specify the lower size limit for each interval.
Aspen Plus fills in the corresponding upper limit value automatically.

7. In the Upper Limit column, specify the upper size limit for the last interval.

8. You must assign the new PSD attribute to a substream class, on the Setup
Substreams Substreams sheet.

For more information on defining a new substream, see Defining New
Substreams on page 9-21 and Creating or Modifying Stream Classes on page 9-18.



Specifying
Streams

9-24 Aspen Plus User Guide
Version 10.2

Specifying Heat Streams

In Aspen Plus, material and energy balance reports consider only energy flows
represented by streams. Any duty or power not represented by a heat or work stream
appears on the report as an imbalance.

Any model that Can have

Calculates heat duty Outlet heat streams

Allows duty input specifications Inlet heat streams

You can use an inlet heat stream to supply a heat duty specification to a unit
operation block:

To display the Specifications sheet for the heat stream:

1. Double-click the stream in the flowsheet to select it.
– or –
From the Data menu, click Streams. In the Streams Object Manager, select
the stream and click Edit.

2. On the Specifications sheet, specify the heat duty.

If the heat duty is Then heat is

Positive Supplied to the block

Negative Removed from the block

3. In the destination block of the heat stream, leave the corresponding duty field
blank. If you specify both an inlet heat stream and the heat duty in the
destination block, the block specification is used.

Specifying Work Streams

In Aspen Plus, material and energy balance reports consider only energy flows
represented by streams. Any duty or power not represented by a heat or work stream
appears on the report as an imbalance.
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Any model that Can have

Allows power input specifications Inlet work streams

Calculates power requirements Outlet work streams

To use an inlet work stream to supply a power specification to a pump or
compressor block:

1. Double-click the stream in the flowsheet to select it.
– or –
From the Data menu, click Streams. In the Streams Object Manager, select
the stream and click Edit.

2. On the Specifications sheet, specify the power.

If the power is Then work is

Negative Supplied to a block

Positive Removed from a block

3. In the destination block of the work stream, leave the corresponding power
field blank. If you specify both an inlet work stream and the power in the
destination block, the block specification is used.

Example of a Heat Stream to the Reboiler of a Column

Stream QREB supplies 1 MMBtu/hr of external heat duty to a RADFRAC block.
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Using PseudoProduct Streams

You can define pseudoproduct streams to represent column internal flows,
compositions, and thermodynamic conditions for these unit operations models:
• PetroFrac
• RadFrac
• MultiFrac
• RateFrac
• Extract
• CCD

You can use pseudoproduct streams to represent interconnecting streams in:
• PetroFrac
• MultiFrac
• RateFrac

The stream report includes pseudoproduct streams. Mass balance calculations for
the block do not include the flow rates associated with pseudo-streams. The
presence of pseudo-streams does not affect block results.

Pseudoproduct streams from one block may be an inlet to another block. Using a
pseudo-stream as a block inlet results in an imbalance in the overall flowsheet
material and energy balance report.
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To define a pseudoproduct stream:

1. When creating the stream select a port labeled Pseudo Streams.

2. For each block that is connected to a pseudostream, complete the
PseudoStream sheet(s) when specifying the block.

About Stream Libraries

Stream libraries store information about the composition and condition of
material streams. If a stream is defined in a library, you can retrieve information
from the library instead of entering data on the Streams forms. You must specify
the stream library in the Run Settings dialog box before you run the simulation.

Use stream libraries to:
• Retrieve feed streams used frequently
• Transfer stream information from a previous simulation
• Initialize tear streams

A stream library can contain multiple cases. Each case usually represents the
results of a previous simulation. When you retrieve results from a stream library,
you specify the:
• Case(s) from which to retrieve results
• Streams in the current run that the stream library will fill in
• Substreams and components to be retrieved
• Component name translation, when the component IDs in the simulation are

different from those in the library

For more information on creating stream libraries, see Chapter 35.

Accessing Stream Libraries
To specify that a run retrieves information about stream composition and
conditions from a stream library:

1. From the Data menu, point to Flowsheeting Options, then Stream Library.

2. On the Specifications sheet, specify the case for the streams you want to
retrieve.
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3. If you are retrieving information for a single stream, enter the name of the
stream from the library in the Stream Name in Library box.

4. If you specified the Stream Name in Library in Step 3, use the Include
Stream option and enter the name of the stream in the current simulation.
Otherwise select one of these options in the Streams field:

Option To retrieve all streams with matching

All Streams Stream ID

Include Streams ID from a list you specify

5. In the Substreams and Components fields, specify the substreams and
components you want to retrieve from the streams library.
– or –
Retrieve all substreams and components by leaving the fields blank.

6. In the State Variables field, specify the stream state variables that you want
to retrieve from the stream library.

7. In the Component Mapping for Current Case section of the form, specify the
mapping between the component ID in the current simulation and the
component ID in the stream library. In the column on the left, enter the
component ID from the current simulation. In the column on the right, enter
the corresponding component IDs in the stream library.
– or –
On the Defaults sheet, define a default component mapping. Aspen Plus uses
this mapping as the default for all cases.

8. Repeat Steps 2 through 8 for each case.

❖     ❖     ❖     ❖ 
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10 Unit Operation Models

The unit operation models are used to represent actual pieces of equipment, such
as distillation columns or heat exchangers, commonly found in processing plants.
To run a flowsheet simulation you must specify at least one unit operation model.

You choose unit operation models for flowsheet blocks when you define your
simulation flowsheet (see Chapter 4).

Aspen Plus has a wide range of unit operation models to choose from. This
chapter explains how to:
• Select the right unit operation model
• Enter model specifications
• Override global specifications at the block level
• Request heating/cooling curve calculations

Choosing the Right Unit Operation Model

This chapter provides a brief description of each model. For more detailed information,
see the Aspen Plus reference manual Unit Operation Models.
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Select appropriate unit operation models from the following table:

Unit Operation Models

Type Model Description

Mixers/Splitters Mixer
FSplit
SSplit

Stream mixer
Stream splitter
Substream splitter

Separators Flash2
Flash3
Decanter
Sep
Sep2

Two-outlet flash
Three-outlet flash
Liquid-liquid decanter
Multi outlet component separator
Two-outlet component separator

Heat Exchangers Heater
HeatX
MheatX
HxFlux
Hetran †

Aerotran †

HTRIIST

Heater/cooler
Two-stream heat exchanger
Multistream heat exchanger
Interface to BJAC Shell & Tube heat exchanger program
Interface to BJAC air cooled heat exchanger program
Interface to the Aspen Aerotran program
Interface to the IST program

Columns DSTWU
Distl
RadFrac
Extract
MultiFrac
SCFrac
PetroFrac
RateFrac †

BatchFrac†

Shortcut distillation design
Shortcut distillation rating
Rigorous distillation
Rigorous liquid-liquid extractor
Rigorous distillation for complex columns
Shortcut distillation for petroleum
Rigorous distillation for petroleum
Rate-based distillation
Rigorous batch distillation

Reactors RStoic
RYield
REquil
RGibbs
RCSTR
RPlug
RBatch

Stoichiometric reactor
Yield reactor
Equilibrium reactor
Equilibrium reactor
Continuous-stirred tank reactor
Plug flow reactor
Batch reactor

Pressure Changers Pump
Compr
MCompr
Pipeline
Pipe
Valve

Pump/hydraulic turbine
Compressor/turbine
Multistage compressor/turbine
Multi segment pipeline pressure drop
Single segment pipeline pressure drop
Rigorous valve pressure drop

continued
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Unit Operation Models (continued)

Type Model Description

Manipulators Mult
Dupl
ClChng
Selector

Stream multiplier
Stream duplicator
Stream class changer
Stream selector

Solids Crystallizer
Crusher
Screen
FabFl
Cyclone
VScrub
ESP
HyCyc
CFuge
Filter
SWash
CCD

Mixed suspension mixed product removal crystallizer
Solids crusher
Solids separator
Fabric filter
Cyclone separator
Venturi scrubber
Electrostatic precipitator
Hydrocyclone
Centrifuge filter
Rotary vacuum filter
Single-stage solids washer
Counter-current decanter

User models User, User2
Excel Spreadsheets
ACM flowsheets
CAPE-OPEN unit
operation
Hierarchy

User-supplied Fortran unit operation models
Excel spreadsheets interfaced through User2
Flowsheet exported from ACM or AD
COM unit operations developed on VB or C++

Hierarchical structure

†
RateFrac, BatchFrac, Hetran, and Aerotran require a separate license and can be used only by customers who have
purchased the right to use them through specific license agreements with Aspen Technology, Inc.

Mixers and Splitters

This section describes the models that can be used to mix or split flowsheet
streams.

The Mixer unit operation model combines streams. FSplit and SSplit combine
feed streams and then split the resulting stream, based on your specifications.
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Mixer
Mixer combines material streams (or heat streams or work streams) into one
outlet stream. If material streams are mixed, you can use an optional water
decant stream to decant free water from the outlet. You can specify an outlet
pressure or pressure drop for material streams. The mixer model determines the
combined outlet stream temperature and phase condition by performing an
adiabatic phase equilibrium flash calculation on the composite feed streams.

Mixer can be used to model mixing tees, or other types of stream mixing
operations.

For more information on Mixer, click here.

FSplit
FSplit combines material streams (or heat streams or work streams) and divides
the resulting stream into two or more outlet streams. All outlets have the same
composition and properties.

Use FSplit to model flow splitters and purges or vents. You must provide
specifications for all but one outlet stream. FSplit calculates the flowrate of the
unspecified stream.

SSplit
SSplit combines material streams and divides the resulting stream into two or
more outlet streams. SSplit allows specification of streams with various
substreams.

You must specify the splits of each substream, for all but one outlet stream.
SSplit calculates the flowrate of each substream in the unspecified outlet stream.
For more information about substreams, see Chapter 9.

For example, you can use SSplit to perfectly separate a stream containing both
liquid and solid phases into two streams each containing only one pure phase.
You can also use SSplit to model other solid stream splitters, bleed valves, purges
or vents.
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Separators

The Separator Blocks, Sep and Sep2, combine feed streams and then split the
resulting stream, based on your specifications. When the details of the separation
are unknown or unimportant, you can use Sep and Sep2 instead of rigorous
separation models (such as distillation or absorption models) to save
computational time.

The flash models, Flash2 and Flash3, determine the thermal and phase
conditions of a mixture with one or more inlet streams. You can generate heating
or cooling curve tables for these models.

The flash models represent single stage separators such as knock-out drums.
They perform a phase equilibrium flash calculation based on your specifications.
Adiabatic, isothermal and isobaric flashes, and dew or bubble points, are among
the calculations these models perform.

In general, to fix the thermodynamic condition of inlet streams, you must specify
a combination of any two of:
• Temperature
• Pressure
• Heat duty
• Molar vapor fraction

This table shows you what to set the molar vapor fraction as:

To Determine Set the Molar Vapor Fraction

The dew point of a mixture 1

The bubble point of a mixture 0

The combination of heat duty and molar vapor fraction is not allowed in the flash
models.

Flash2
Flash2 performs rigorous 2 (vapor-liquid) or 3 (vapor-liquid-liquid) phase
equilibrium calculations. Flash2 produces one vapor outlet stream, one liquid
outlet stream, and an optional water decant stream.
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You can use Flash2 to model flashes, evaporators, knock-out drums, and any
other single-stage separators, with sufficient vapor disengagement space.
Optionally, you can specify a percentage of the liquid phase to be entrained in the
vapor stream.

Flash3
Flash3 performs rigorous 3 phase vapor-liquid-liquid equilibrium calculations, to
produce one vapor outlet stream and two liquid outlet streams.

You can use Flash3 to model any single-stage separator with sufficient vapor-
liquid disengagement space as well as two liquid phase settling space. You can
specify entrainment of each liquid phase in the vapor stream.

The vapor outlet stream can have a flow rate of zero for a decanter with no vapor-
liquid disengagement. If you do not know whether there is a vapor phase, use the
Flash3 model instead of the Decanter model.

.

Decanter
Decanter models knock-out drums, decanters, and other single-stage separators
with sufficient residence time for separation of two liquid phases but without a
vapor phase.

Decanter determines the thermal and phase conditions of a mixture with one or
more inlet streams, at the specified temperature or heat duty.

Decanter can calculate liquid-liquid distribution coefficients from:
• Physical property method
• User supplied distribution correlation
• User supplied Fortran subroutine

For information about writing Fortran subroutines, see Aspen Plus User Models.

Since the Decanter model assumes implicitly that there is no vapor phase
formation, use Flash3 if you suspect any vapor phase formation.
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Sep
Sep combines inlet streams and separates  the resulting stream into two or more
streams, according to splits you specify for each component. You can specify the
splits for each component in each substream.

You can use the Sep model to represent component separation operations such as
a distillation column when fractionation achieved or desired by the column is
known but the details of the column energy balance are unknown or
unimportant.

.

Sep2
Sep2 combines inlet streams and separates the resulting stream into two outlet
streams. Sep2 is similar to Sep, but offers a wider variety of specifications, such
as component purity or recovery. These specifications make it even easier to
represent component separation operations such as a distillation column when
fractionation achieved or desired by the column is known but the details of the
separation are unknown or unimportant.

.

Heat Exchangers

All heat exchangers determine the thermal and phase conditions of a mixture
with one or more inlet streams. The heat exchanger models simulate the
performance of heaters or two or multi stream heat exchangers. You can generate
heating or cooling curve tables for all models described in this section.

Heater
Heater performs these types of single phase or multiphase calculations:
• Bubble or dew point calculations
• Add or remove any amount of user specified heat duty
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• Match degrees of superheating or subcooling
• Determine heating or cooling duty required to achieve a certain vapor fraction

Heater produces one outlet stream, with an optional water decant stream. The
heat duty specification may be provided by a heat stream from another block.

You can use Heater to model:
• Heaters or coolers (one side of a heat exchanger)
• Valves when you know the pressure drop
• Pumps and compressors whenever you do not need work-related results

You can also use Heater to set or change the thermodynamic condition of a
stream.

.

HeatX
HeatX can perform shortcut or detailed rating calculations for most types of
two-stream heat exchangers. The main difference between the two calculation
methods is the procedure for the calculation of the overall heat transfer
coefficient.

The shortcut method always uses a user specified (or default) value for the
overall heat transfer coefficient.

The detailed method uses rigorous heat transfer correlations for film coefficients
and combines the resistances due to shell and tube side films with the wall
resistance to calculate the overall heat transfer coefficient. You need to know the
geometry to use the detailed method.

You must specify the hot and cold inlet streams and one of these performance
specifications for your heat exchanger:
• Outlet temperature or temperature change of the hot or cold stream
• Molar vapor fraction of the hot or cold stream
• Degree of superheating (subcooling) of cold (hot) stream
• Heat exchanger duty
• Surface heat transfer area
• Temperature approach at the hot or cold stream outlet

.
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Shortcut Method for HeatX

For the shortcut method you may specify a pressure drop for each side of the heat
exchanger. The HeatX model determines the outlet stream conditions based on
heat and material balances and uses a constant value for the heat transfer
coefficient to estimate the surface area requirement. You may also provide phase
specific heat transfer coefficients.

Detailed Method for HeatX

HeatX can also perform detailed rating calculations by modeling a wide variety of
shell and tube heat exchanger types rigorously, including:
• Countercurrent and co-current
• Segmental baffle TEMA E, F, G, H, J, and X shells
• Rod baffle TEMA E and F shells
• Bare and low-finned tubes

HeatX can perform a full zone analysis with heat transfer and pressure drop
estimation for single and two-phase streams. For rigorous heat transfer and
pressure drop calculations, you must supply the exchanger geometry.

HeatX has correlations to estimate sensible heat, nucleate boiling, and
condensation film coefficients.

HeatX cannot:
• Perform design calculations (use Hetran or Aerotran)
• Perform mechanical vibration analysis
• Estimate fouling factors

Example of Specification for a Shell and Tube Heat Exchanger

Use the detailed calculation type to rate the performance of countercurrent shell
and tube heat exchanger, where the hot fluid is on the shell side.
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Specify the shell TEMA type, diameter, and orientation.
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Specify tube side data.

Specify baffle type, spacing, and dimensions:
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Specify the shell and tube side nozzle diameters:

MHeatX
MHeatX represents heat transfer between multiple hot and cold streams, as in
an LNG exchanger. It can also model two-stream heat exchangers. You can
decant free water from any outlet stream. An MHeatX block is divided into
multiple heaters connected by heat streams. This configuration usually leads to
faster flowsheet convergence.

MHeatX does not use or calculate heat transfer coefficients, but it can calculate
the overall UA for the exchanger and perform a detailed zone analysis.

HxFlux
HxFlux is used to perform heat transfer calculations between a heat sink and a
heat source, using convective heat transfer.  The driving force for the convective
heat transfer is calculated as a function of log-mean temperature difference or
LMTD.

You can specify variables among the inlet and outlet stream temperatures, duty,
heat transfer coefficient, and heat transfer area. HxFlux calculates the unknown
variable and determines the log mean temperature differences, using either the
rigorous or the approximate method.
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.

Hetran
Hetran is the interface to the Aspen Hetran program for designing and
simulating shell and tube heat exchangers. Use Hetran to simulate shell and
tube heat exchangers with a wide variety of configurations.

To use Hetran:

1. Place the block in the flowsheet.

2. Connect inlet and outlet streams.

3. Specify the name of the B-JAC input file for that exchanger and a few
optional parameters.

Information related to the heat exchanger configuration and geometry are
entered through the Hetran program interface. The exchanger specification is
then saved in the Hetran input file format.

You do not have to enter information about the exchanger's physical
characteristics for the blocks or through input language. That information is
retrieved from the B-JAC input file that you specify.

Aerotran
Aerotran is the interface to the Aspen Aerotran program for designing and
simulating air-cooled heat exchangers.

Aerotran can be used to simulate air-cooled heat exchangers with a wide variety
of configurations. It can also be used to model economizers and the convection
section of fired heaters.

To use Aerotran:

1. Place the block in the flowsheet.

2. Connect the inlet and outlet streams.

3. Specify the name of the B-JAC input file for that exchanger and a few
optional parameters.
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Information related to the air cooler configuration and geometry are entered
through the Aerotran program interface. The air cooler specification is saved in
the Aerotran input file format. You do not have to enter information about the air
cooler's physical characteristics. That information is retrieved from the B-JAC
input file that you specify.

.

HTRIIST
HTRIIST is the interface to the IST program from the Heat Transfer Research
Institute (HTRI) for designing and simulating shell and tube heat exchangers.
Use HTRIIST to simulate shell and tube heat exchangers with a wide variety of
configurations.

To use HTRIIST:

1. Place the block in the flowsheet.

2. Connect inlet and outlet streams.

3. Specify the name of the IST input file for that exchanger and a few optional
parameters.

Information related to the heat exchanger configuration and geometry are
entered through the IST program interface. The exchanger specification is then
saved in the IST input file format.

You do not have to enter information about the exchanger's physical
characteristics for the blocks or through input language. That information is
retrieved from the IST input file that you specify.

Columns

The models for shortcut distillation are DSTWU, Distl, and SCFrac.

DSTWU and Distl:
• Are for single columns
• Can perform free-water calculations in the condenser
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• Allow you to use water decant streams to decant free water from the
condenser

SCFrac performs shortcut distillation calculations for petroleum refining units,
such as crude units and vacuum towers.

Aspen Plus provides four rigorous multistage separation models:

Model Purpose

RadFrac General vapor-liquid multistage separation

MultiFrac General systems of interlinked multistage distillation units

PetroFrac Petroleum refining fractionation units

RateFrac Rate-based non-equilibrium separation

Extract is a rigorous model for simulating liquid-liquid extractors. It is
appropriate only for rating calculations.

DSTWU
DSTWU performs a Winn-Underwood-Gilliland shortcut design calculation for a
single-feed, two-product distillation column, with a partial or total condenser. For
the specified recovery of the light and heavy key components, DSTWU estimates
the minimum for either:
• Reflux ratio
• Number of theoretical stages

DSTWU estimates one of the following requirements:
• Reflux ratio given the number of theoretical stages
• Number of theoretical stages given the reflux ratio

DSTWU also estimates:
• Optimum feed stage location
• Condenser and reboiler duties

DSTWU can produce tables and plots of reflux ratio versus number of stages.

Distl
Distl is a shortcut multicomponent distillation rating model. This model uses the
Edmister approach to separate an inlet stream into two products. You must
specify:
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• Number of theoretical stages
• Reflux ratio
• Overhead product rate

Distl estimates the condenser and reboiler duties. You can specify a partial or a
total condenser.

SCFrac
SCFrac models petroleum refining towers, such as crude units and vacuum
towers. SCFrac performs shortcut distillation calculations for columns with a
single feed, one optional stripping steam stream, and any number of products.

SCFrac models an n-product refining tower with n–1 sections.

Based on your product specifications and fractionation indices, SCFrac estimates:
• Product composition and flows
• Number of stages per section
• Heating or cooling duty for each section

SCFrac does not handle solids.

RadFrac
RadFrac is a rigorous model for simulating all types of multistage vapor-liquid
fractionation operations. In addition to ordinary distillation, it can simulate:
• Absorption
• Reboiled absorption
• Stripping
• Reboiled stripping
• Extractive and azeotropic distillation
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RadFrac is suitable for:
• Three-phase systems
• Narrow-boiling and wide-boiling systems
• Systems exhibiting strong liquid phase nonideality

RadFrac can detect and handle a free-water phase or other second liquid phase
anywhere in the column. You can decant free water from the condenser.

RadFrac can handle solids on every stage.

RadFrac can model columns where chemical reactions are occurring. Reactions
can have fixed conversions, or they can be:
• Equilibrium
• Rate-controlled
• Electrolytic

RadFrac can model columns where two liquid phases exist and different chemical
reactions occur in the two liquid phases. RadFrac can also model salt
precipitation.

RadFrac can operate in rating mode or design mode.

Rating Mode

In rating mode RadFrac calculates:
• Temperature
• Flow rate
• Mole fraction profiles

These profiles are based on specified column parameters, such as reflux ratio,
product rates, and heat duties.

All rating mode flow specifications can be in mole, mass, or standard liquid
volume units.

You can specify component or stage efficiencies.

RadFrac accepts both Murphree and vaporization efficiencies. You can
manipulate Murphree efficiencies to match plant performance.

.
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Design Mode

In design mode, you can specify temperatures, flow rates, purities, recoveries, or
stream properties anywhere in the column. Examples of stream properties are
volume flow and viscosity. You can specify all flow, flow ratio, composition, and
recovery specifications in mole, mass, or standard liquid volume units.

RadFrac has extensive capabilities for sizing and rating trays and packings. You
can choose from several common tray types, and random and structured
packings.

Example of Specifying a Reactive 3-phase Distillation Column

The following example shows the specifications for a reactive 3-phase distillation
column without a bottoms product and a reflux ratio of 45.  The column has 18
equilibrium stages and a total condenser and a kettle reboiler.

All stages from the condenser (stage 1) through stage 18 are checked for presence
of an aqueous second liquid phase.
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A liquid decanter is specified on equilibrium stage 10 which returns 30% of total
liquid flow.

The reactions occur only in the reboiler. The reaction rate and stoichiometry are
referenced from a Reaction ID defined in the Reactions folder.
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The total liquid holdup (reaction volume) is 1 m3.
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MultiFrac
MultiFrac is a rigorous model for simulating general systems of interlinked
multistage fractionation units. MultiFrac models a complex configuration
consisting of:
• Any number of columns, each with any number of stages
• Any number of connections between columns or within columns
• Arbitrary flow splitting and mixing of connecting streams

MultiFrac can handle operations with:
• Side strippers
• Pumparounds
• Bypasses
• External heat exchangers
• Single-stage flashes
• Feed furnaces

Typical MultiFrac applications include:
• Heat-integrated columns, such as Petlyuk towers
• Air separation column systems
• Absorber/stripper combinations
• Ethylene plant primary fractionators

You can also use MultiFrac for petroleum refining fractionation units, such as
atmospheric crude units and vacuum units. But for these applications PetroFrac
is more convenient to use. Use MultiFrac only when the configuration is beyond
the capabilities of PetroFrac.

MultiFrac can detect a free-water phase in the condenser or anywhere in the
column. It can decant the free-water phase on any stage.

Although MultiFrac assumes equilibrium stage calculations, you can specify
either Murphree or vaporization efficiencies. You can use MultiFrac for sizing
and rating trays and packings. MultiFrac can model both random and structured
packings.
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PetroFrac
PetroFrac is a rigorous model designed for simulating complex vapor-liquid
fractionation operations in the petroleum refining industry. Typical operations
include:
• Preflash tower
• Atmospheric crude unit
• Vacuum unit
• FCC main fractionator
• Delayed coker main fractionator
• Vacuum lube fractionator

You can also use PetroFrac to model the primary fractionator in the quench
section of an ethylene plant.

PetroFrac can model the feed furnace together with the fractionation towers and
strippers in an integrated fashion. With this feature, you can easily analyze the
effect of furnace operating parameters on tower performance.

PetroFrac can detect a free-water phase in the condenser or anywhere in the
column. It can decant the free-water phase on any stage.

Although PetroFrac assumes equilibrium stage calculations, you can specify
either Murphree or vaporization efficiencies.

You can use PetroFrac to size and rate columns consisting of trays and/or
packings. PetroFrac can model both random and structured packings.

Example of Specifying an Atmospheric Crude Oil Tower

This example illustrates the specifications for an atmospheric crude oil tower
consisting of 25 equilibrium stages (including a total condenser) in the main
column, 2 pumparounds, and three side strippers. The top distillate rate is set at
19,000 BPD.
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The column feed passes through a furnace which operates at 3.2 atm and the
overflash stream is specified to be 4% of the column feed by volume.

The first pumparound rate is 7,205 BPD and is a partial stream drawn from
stage 3 and is returned to stage 2 at 90 C.
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The first sidestripper has 2 equilibrium stages and strips light ends from the
7,200 BPD of Kerosene product stream which is drawn from stage of the main
column. The stripped vapors are returned to main column on stage 8. The
reboiler duty is 1.2 MMkcal/hr.

The main column is to be sized based on 2-pass Koch Flexitray trays on stages 2
through 21.
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RateFrac
RateFrac is a rate-based model for non-equilibrium separation. It simulates
actual tray and packed columns, rather than idealized representations.

RateFrac:
• Explicitly accounts for the interphase mass and heat transfer processes.
• Simulates single and interlinked columns involving vapor-liquid fractionation

operations such as absorption, distillation, and stripping.

Use RateFrac for
• Systems with both a vapor and a liquid phase. RateFrac can detect a

free-water phase only in the condenser.
• Nonreactive systems
• Reactive systems
• Electrolyte systems

RateFrac does not use empirical factors, such as efficiencies and the Height
Equivalent of a Theoretical Plate (HETP). RateFrac treats separation as a mass
and heat transfer rate process, instead of an equilibrium process. The degree of
separation achieved between the contacting phases depends on the extent of
mass and heat transfer between phases. The transfer rates between phases are
strongly affected by the extent to which the phases are not in equilibrium.
RateFrac assumes that thermodynamic equilibrium prevails only at the
vapor-liquid interface separating the contacting phases.
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Batch Distillation - BatchFracTM

BatchFrac is the unit operation model for batch distillation. It is a a rigorous
model for simulating multistage batch distillation columns.

BatchFrac uses a robust and efficient algorithm to solve the unsteady-state heat
and material balance equations that describe the behavior of batch distillation
processes. Rigorous heat balances, material balances, and phase equilibrium
relationships are applied at each stage.

BatchFrac can handle a wide variety of batch distillation problems, including
these systems:
• Narrow-boiling
• Wide-boiling
• Highly non-ideal
• Three-phase
• Reactive

BatchFrac can detect the presence of a free-water phase in the condenser, or of
any second liquid phase anywhere in the column. BatchFrac has complete
flexibility in handling interstage decanters.

Use BatchFrac to simulate batch distillation columns with equilibrium-controlled
reactions or rate-controlled reactions. These reactions can occur on any stage,
including the reboiler and condenser.

BatchFrac assumes:
• Equilibrium stages are used. (However, you can specify vaporization

efficiencies.)
• There is constant liquid holdup and no vapor holdup.
• Column hydraulics are not modeled.

Extract
Extract is a rigorous model for simulating liquid-liquid extractors. It is
appropriate only for rating calculations.

Extract can have multiple feeds, heater/coolers, and sidestreams. To calculate
distribution coefficients, use one of the following:
• An activity coefficient model
• An equation of state capable of representing two liquid phases
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• A built-in temperature-dependent polynomial
• A Fortran subroutine

Extract accepts specifications for component or stage efficiencies.

Reactors

Chemical reactions occur under diverse conditions in many different types of
equipment.

Aspen Plus provides seven models for chemical reactor simulations:

Model Purpose

RStoic Conversion reactor with known stoichiometry

RYield Yield reactor with known product yields

REquil Two-phase chemical equilibrium reactor (stoichiometric)

RGibbs Multiphase chemical equilibrium reactor (non-stoichiometric)

RCSTR Continuous stirred tank reactor with known kinetics

RPlug Plug flow reactor with known kinetics

RBatch Batch or semi-batch reactor with known kinetics

RStoic, RYield, RGibbs, and RCSTR can have any number of material feed
streams, which are mixed internally. Heats of reaction are not required for any
reactor model. Aspen Plus calculates heats of reaction using heats of formation.

For RCSTR, RPlug, and RBatch, you must provide reaction kinetics information
using:
• The built-in power law model
• The built-in generalized Langmuir-Hinschelwood-Hougen-Watson (LHHW)

model
• A user-written Fortran subroutine (For more information, see Aspen Plus

User Models)

RStoic
RStoic models a reactor when:
• Reaction kinetics are unknown or unimportant.
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• Stoichiometry is known.
• You can specify the extent of reaction or conversion.

Rstoic can handle reactions that occur independently in a series of reactors. It
can also perform product selectivity and heat of reaction calculations.

RYield
RYield models a reactor by specifying reaction yields of each component. This
model is useful when:
• Reaction stoichiometry and kinetics are unknown.
• Yield distribution data or correlations are available.

REquil
REquil models reactors when some or all reactions reach equilibrium. REquil can
calculate single-phase chemical equilibrium, or simultaneous phase and chemical
equilibria. REquil calculates equilibrium by solving stoichiometric chemical and
phase equilibrium equations.

RGibbs
RGibbs models single-phase chemical equilibrium, or simultaneous phase and
chemical equilibria. You must specify the reactor temperature and pressure, or
pressure and enthalpy. RGibbs minimizes Gibbs free energy, subject to atom
balance constraints. This model does not require reaction stoichiometry. RGibbs
can determine phase equilibrium without chemical reaction, particularly for
multiple liquid phases. Any number of liquid phases are allowed.

You can model solids in RGibbs either as single condensed species and/or as solid
solution phases.

You can also assign components to be in particular phases in equilibrium. You
can use different property models for each liquid or solid solution phase. This
capability makes RGibbs particularly useful for:
• Pyrometallurgical applications
• Modeling ceramics and alloys
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RGibbs accepts restricted equilibria specifications. You can restrict equilibrium
by specifying:
• Fixed moles of any product
• Percentage of a feed component that does not react
• Temperature approach to equilibrium for the entire system
• Temperature approaches for individual reactions
• Fixed extents of reaction

RCSTR
RCSTR rigorously models a continuous-stirred tank reactor. You can use this
model when:
• Reaction kinetics are known.
• The contents of the reactor have the same properties as the outlet stream.

RCSTR can model equilibrium reactions simultaneously with rate-based
reactions.

RCSTR computes one of the following for the reactor:
• Heat duty given the temperature
• Temperature given the heat duty

RPlug
RPlug rigorously models plug flow reactors. A cooling stream around the reactor
is optional. You can also use RPlug to model reactors with cocurrent and
countercurrent coolant streams. RPlug handles rate-based kinetic reactions only.

RBatch
RBatch rigorously models batch or semi-batch reactors. Holding tanks are used
to interface the batch reactor with the steady-state streams of an Aspen Plus
simulation.

For semi-batch reactors, you can specify a continuous vent and any number of
continuous or delayed feeds. RBatch handles rate-based kinetic reactions only.
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Pressure Changers

Pump and compressor models change pressures when energy-related
information, such as power requirement, is needed or known. Free water can be
decanted from the Pump or Compr products, or from the MCompr intercoolers.
For pressure changes only use other models, such as Heater or Valve.

Pipeline calculates the pressure drop and heat transfer in a pipe segment or a
pipeline. Pipeline can model any number of segments to describe the pipe
geometry.

Pipe calculates the pressure drop and heat transfer for a single pipe segment
with fittings.

Valve rigorously models the pressure drop in control valves.

Pump
Pump simulates a pump or hydraulic turbine. This model calculates either the
power requirement or the power produced, given an outlet pressure specification.
Pump can calculate the outlet pressure, given a power specification.

Compr
Compr simulates a:
• Polytropic compressor
• Polytropic positive displacement compressor
• Isentropic compressor
• Isentropic turbine

Compr calculates either the power requirement given an outlet pressure
specification, or the outlet pressure given a power specification.

MCompr
MCompr simulates a:
• Multistage polytropic compressor
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• Polytropic positive displacement compressor
• Isentropic compressor
• Isentropic turbine

MCompr has an intercooler between each compression stage. An aftercooler
following the last compression stage is optional. The coolers can have liquid
knockout outlet streams. You can introduce feed streams between stages. A
variety of specification options are available for both the compression and cooling
stages.

Pipeline
Pipeline calculates the pressure drop and heat transfer in a pipe segment or a
pipeline. Pipeline can model any number of segments to describe the pipe
geometry.

Pipeline handles a single inlet and outlet material stream. Pipeline assumes the
flow is one-dimensional, steady-state, and fully developed (no entrance effects are
modeled).

Pipeline can perform one- or two-phase calculations.

If the inlet pressure is known, Pipeline calculates the outlet pressure. If the
outlet pressure is known, Pipeline calculates the inlet pressure and updates the
inlet stream.

Pipe
Pipe calculates the pressure drop and heat transfer in a single pipe segment or
annular space. Multi-phase, one-dimensional, steady-state and fully developed
pipeline flow with fittings can be modeled.

Valve
Valve calculates the pressure drop or valve coefficient (Cv) for a control valve.
Multi-phase, adiabatic flow in ball, globe and butterfly valves can be modeled.
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Manipulators

Stream manipulators modify or change stream variables for convenience. They do
not represent real unit operations.

Mult
Mult multiplies streams by a factor you specify. The heat and material balances
are not maintained. The outlet stream has the same composition and properties
as the inlet.

Dupl
Dupl copies the inlet stream to any number of outlet streams. This model does
not satisfy material and energy balances. Dupl is useful for simultaneously
processing a given stream in different types of units.

ClChng
ClChng changes the class of streams between blocks and flowsheet sections. It
copies substreams from the inlet stream to the corresponding substreams of the
outlet stream.

Selector
Selector is a switch between different inlet streams. Any number of streams may
enter the block, and one designated stream from among these is copied to the
outlet stream. The Selector block can be used with material, heat, or work
streams.
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Solids

This table shows the solids models are what they do:

This model Models

CCD Multistage solids washers that recover dissolved components from
an entrained liquid of a solids stream

CFuge The separation of liquids from solids

Crystallizer A mixed suspension, mixed product removal (MSMPR) crystallizer.

Crusher Breaking solid particles in a crusher

Cyclone Solids separation from a gas stream

ESP Solids separation from a gas stream

FabFl Solids separation from a gas stream

Filter The separation of liquids from solids

HyCyc The separation of liquids from solids

Screen Separating solid particles in a screen

SWash Solids washers that recover dissolved components from
an entrained liquid of a solids stream

Vscrub Solids separation from a gas stream

Crystallizer
Crystallizer models a mixed suspension, mixed product removal (MSMPR)
crystallizer. It performs mass and energy balance calculations. You have the
option of determining the crystal size distribution.

Crystallizer assumes that the product magma leaves the crystallizer in
equilibrium. The mother liquor in the product magma is saturated.

The feed to Crystallizer mixes with recirculated magma and passes through a
heat exchanger before it enters the crystallizer. The product stream from
Crystallizer contains liquids and solids. You can pass this stream through a
hydrocyclone, filter, or other fluid-solid separator to separate the phases.
Crystallizer can have an outlet vapor stream.
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Crusher
Crusher simulates the breaking of solid particles.

Crusher models the wet or dry continuous operation of:
• Gyratory jaw crushers
• Single-roll crushers
• Multiple-roll crushers
• Cage mill impact breakers

Crusher assumes the feed is homogeneous. The breaking process creates
fragments in the outlet solids stream with the same composition as in the feed
stream.

Crusher does not account for heat produced by the breaking process.

Screen
Screen simulates the separation of various sizes of solid particles in a mixture.
Each of the two outlet streams contain particles of a more uniform size.

Screen calculates the separation efficiency of the screen from the sizes of screen
openings you specify.

FabFl
FabFl simulates baghouse fabric filter units.

A baghouse has a number of cells. Each cell contains a vertically-mounted,
cylindrical fabric filter bag. The filter bags work in parallel to separate solid
particles from a gas stream. Use FabFl to rate or size baghouses.

Cyclone
Cyclone simulates cyclone separators. Cyclone separators remove solid particles
from a gas stream using the centrifugal force of a gas vortex.

Use Cyclone to size or rate cyclone separators.
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VScrub
VScrub simulates venturi scrubbers.

Venturi scrubbers remove solid particles from a gas stream by direct contact with
an atomized liquid stream.

Use VScrub to rate or size venturi scrubbers.

ESP
ESP simulates dry electrostatic precipitators.

Dry electrostatic precipitators separate solids from a gaseous stream.
Electrostatic precipitators have vertically mounted collecting plates with
discharge wires. The wires are parallel and positioned midway between the
plates. The corona discharge of the high-voltage wire electrodes first charges the
solid particles in the inlet gas stream. Then the electrostatic field of the collecting
plate electrodes removes the solids from the gas stream.

Use ESP to size or rate electrostatic precipitators.

HyCyc
HyCyc simulates hydrocyclones. Hydrocyclones separate solids from the inlet
liquid stream by the centrifugal force of a liquid vortex. Use HyCyc to rate or size
hydrocyclones.

CFuge
CFuge simulates centrifuge filters. Centrifuge filters separate liquids and solids
by the centrifugal force of a rotating basket. CFuge assumes the separation
efficiency of the solids equals 1, so the outlet filtrate stream contains no residual
solids. Use CFuge to rate or size centrifuge filters.
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Filter
Filter simulates continuous rotary vacuum filters. Filter assumes the separation
efficiency of the solids equals 1, so the outlet filtrate stream contains no residual
solids. Use Filter to rate or size rotary vacuum filters.

SWash
SWash models the separation of solid particles from an entrained liquid of a
solids stream.

SWash does not consider a vapor phase.

CCD
CCD simulates a counter-current decanter or a multistage washer. CCD
calculates the outlet flow rates and compositions from:
• Pressure
• Mixing efficiency
• Number of stages
• The liquid-to-solid mass ratio of each stage

CCD can calculate the heat duty from a temperature profile. CCD does not
consider a vapor phase.

User Models

Aspen Plus provides several methods for you to create your own unit operation
models:
• Fortran
• Excel
• COM Models based on the CAPE-OPEN standard
• Exported Aspen Modeler flowsheets (from products such as Aspen Custom

Modeler and Aspen Dynamics)
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These models can simulate any unit operation model. For each type of model, you
write your own program or spreadsheet to calculate the values of outlet streams,
based on the specified inlet streams and parameters.

Fortran and Excel Unit Operation Models
Fortran unit operation models use a Fortran subroutine to perform the
calculations for the model. These models may be included in a simulation by
using the User or User2 block in Aspen Plus. See Aspen Plus User Models,
Chapter 5, for detailed information about writing these models.

Excel unit operation models use an Excel spreadsheet to perform the calculations
required by the model. These models also use the User2 block in Aspen Plus. See
Aspen Plus User Models, Chapter 5, for detailed information about writing these
models.

CAPE-OPEN COM Unit Operation Models
COM models written in Visual Basic implementing the CAPE-OPEN standard
can be imported into Aspen Plus.

To use these models in Aspen Plus:

1. Build a .dll file from Visual Basic.

2. Register that file on your computer as a CAPE-OPEN COM unit operation.

See Aspen Plus User Models, Chapter 26, for detailed information about writing
these models and registering them properly.

Registered CAPE-OPEN models appear in the CAPE-OPEN category of the
Model Library. Add them to the flowsheet as you would do with any other model.

Note If you do not see the CAPE-OPEN category on the Model Palette
in Aspen Plus, select References from the Library menu and
select the category in that dialog box.



Unit Operation
Models

10-38 Aspen Plus User Guide
Version 10.2

DAIS Trader Requirements of CAPE-OPEN Models

When you place a CAPE-OPEN unit operation on the Process Flowsheet in Aspen
Plus, you may notice a sequence of messages on the status bar. Aspen Plus shows
these messages because CAPE-OPEN unit operations work differently than other
Aspen Plus unit operations. These models require the DAIS Trader, a program
which provides CORBA services.

To create an instance of a CAPE-OPEN unit operation, Aspen Plus starts the
Simulation Engine, if necessary, and sends it an input file. The input file
contains the class id of the unit operation being created. The Simulation Engine
processes the file and creates an instance of the class identified by the class id.
Once the unit has been created, the Simulation Engine makes it available to
clients by telling the DAIS Trader that it exists. When the engine has created the
unit operation, the Aspen Plus User Interface connects to the trader and
establishes a connection with the unit operation. This connection is used to query
the unit for its list of ports, its list of parameters and to ask the unit to display
its own user interface forms.

If the DAIS Trader service is not running, the User Interface will not be able to
establish a connection and will display a dialog box saying that that it cannot
bind to the trader. In these circumstances, Aspen Plus will display the CAPE-
OPEN unit on the Process Flowsheet, but you will not be able to connect streams
to it, or to display any of its forms. In the Data Browser window the port and
parameter grids will be empty. If this happens, delete the CAPE-OPEN unit
operation and check that the DAIS Trader service is correctly installed and is
running.

Aspen Modeler Flowsheets
Flowsheets developed in Aspen Modeler products (such as Aspen Custom
Modeler [ACM] or Aspen Dynamics) can be exported and used as unit operations
in Aspen Plus. See the documentation for the Aspen Modeler product for detailed
information on exporting a flowsheet.

To use an exported Aspen Modeler flowsheet in Aspen Plus, the Aspen Plus
simulation needs to refer to the User Model Library containing the Aspen
Modeler flowsheet. In Aspen Plus follow these steps:

1. From the Library menu, click References.

2. Click Browse and navigate to the directory where your User Model Library is
located, select the file and use Open to load it into Aspen Plus. Also, select the
checkbox for ACM Flowsheets in the list of available libraries.
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3. Select the ACM Flowsheets tab on the Model Library and select the flowsheet
that you want to use.

You can edit the User Model Library in Aspen Plus by selecting the library name
on the Library menu and then selecting Edit from the pop-up menu. See Creating
and Manipulating User Libraries, Chapter 16 for more information on editing
library files.

Modifying an Exported Aspen Modeler Flowsheet

You may need to make changes to an Aspen Modeler flowsheet after you have
exported it. For example, you might want to use a different set of components or
you may need to change the specification of the variables. Some changes to the
flowsheet can be made within Aspen Plus, but others can only be made in your
Aspen Modeler product.

Within Aspen Plus you can use input forms from an exported Aspen Modeler
flowsheet to:
• Change the values of variables
• Change the bounds on variables
• Change the specification of variables
• Change flash calculation options

You must use your Aspen Modeler product if you want to:
• Change the value of a parameter
• Change the components used in the exported flowsheet
• Change the Physical Property options used in the flowsheet

If you make any of these changes in your Aspen Modeler product you will need to
export the flowsheet again for your changes to affect Aspen Plus runs.

Licensing of Exported Flowsheets

Exported Aspen Modeler flowsheets running in Aspen Plus may use an Aspen
Modeler license, depending upon your license agreement.

Important If an Aspen Modeler license is required, it is acquired using
the License Manager settings of Aspen Plus, not the
settings of the Aspen Modeler product. This means that if
Aspen Plus connects to a particular server to access an
Aspen Plus license, the same server must be able to provide
an Aspen Modeler license when an exported flowsheet is
used in an Aspen Plus simulation.
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Using Aspen Modeler Flowsheets Without the Aspen
Modeler Product

You can use an exported Aspen Modeler flowsheet in Aspen Plus without having
the Aspen Modeler product installed by copying to your machine:
• The flowsheet DLL
• The Aspen Plus User Model Library generated by Aspen Custom Modeler™
• Any other DLLs on which the flowsheet DLL is dependent

Put the extra DLLs in a directory which is always searched when the exported
DLL is loaded into Aspen Plus. Any directory on the path will be searched, as
will the Engine\xeq directory of the Aspen Plus installation.

Necessary DLLs

If the Aspen Modeler flowsheet uses procedure equations, the exported DLL will
depend on the DLLs containing their implementation. The flowsheet DLL will
not load correctly in Aspen Plus if these DLLs are not available, so you must copy
them in addition to the flowsheet DLL.

Exported Aspen Dynamics™ simulations depend on the following DLLs:
• Dynamics.DLL
• Modeler.DLL
• Gpp.DLL

Exported Aspen Custom Modeler simulations which use procedure calls defined
in the modeler.acml library depend on the following DLLs:
• Modeler.DLL
• Gpp.DLL

Tip Dynamics.DLL, Modeler.DLL, and Gpp.DLL can be found in
\Program Files\Common Files\Aspentech Shared\AmSystem\10.2\bin

on the Windows system drive.

When you generate a DLL in an Aspen Modeler application, the list of DLLs that
it depends on is shown in the Simulation Messages window. If you want to use
the exported DLL on a machine which does not have an Aspen Modeler
application installed, check the list in the Simulation Messages window to make
sure that the correct DLLs are available.
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Hierarchy

Use Hierarchy blocks to provide hierarchical structure to complex simulations.
Also, Hierarchy blocks may be added automatically when importing templates
into a simulation. Hierarchy blocks may contain streams and other blocks (even
other Hierarchy blocks), as well other features like design specifications and
sensitivity problems.

Specifying Unit Operation Models

For each unit operation block, you must enter specifications on Block forms. To
access these forms:

1. Select the block on the graphical flowsheet.

2. Click the right mouse button on the block.

3. From the popup menu that appears, click Input.

4. Select the appropriate form and sheet.



Unit Operation
Models

10-42 Aspen Plus User Guide
Version 10.2

Overriding Global Specifications for a
Block

You can use the BlockOptions form for a block to override global values for the
following parameters:

Option Specify globally on sheet Specify locally on Block sheet

Physical Property Method, Henry’s
Components

Properties Specifications Global BlockOptions Properties

Simulation Diagnostic Message Level Setup Specifications Diagnostics BlockOptions Diagnostics

Physical Property Diagnostic Message
Level

Setup Specifications Diagnostics BlockOptions Diagnostics

Stream Diagnostic Message Level Setup Specifications Diagnostics BlockOptions Diagnostics

Heat Balance Calculations Setup Simulation Options Calculations BlockOptions Simulation
Options

Use Results from Previous Convergence
Pass

Setup Simulation Options Calculations BlockOptions Simulation
Options

Valid Phases Setup Specifications Global Input Specifications

Example of Replacing a Global Properties Specification

Use the NRTL Method with Henry1 (Henry's Components) instead of the global
values in Base Method and Henry’s Components specified on the Properties
Specifications Global sheet.
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Requesting Heating/Cooling Curve
Calculations

Many unit operation models can generate heating/cooling curves.

These curves calculate the following at intermediate points between the inlet and
outlet conditions of a block, including phase transition points (bubble and dew
points):
• Temperature
• Pressure
• Vapor fraction
• Heat duty
• Optional additional properties

To request heating/cooling curves for a block:

1. From the Data Browser tree for the block, select the Hcurves folder.

2. In the Hcurves Object Manager, click New.

3. In the Create New ID dialog box, enter an ID or accept the default ID. The ID
must be an integer.
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4. Select an independent variable:
• Heat Duty
• Temperature
• Vapor Fraction

The selected variable is varied to generate the intermediate points.

5. To define the intermediate points, specify one of the following:

What to specify Where

Number of points Number of Data Points

Size of the increment between points Increment Size

List of values for the independent variable List of Values

If you specify Number of Data Points, the intermediate points will be equally
spaced between the inlet and outlet.

6. Select the pressure profile option in the Pressure Profile frame. Specify
Pressure Drop, if needed for the selected Pressure Profile option.

All of the pressure profiles are either constant or linear from the first
pressure point to the last pressure point. This table shows the points used for
each option:

Pressure Profile Option First Point Last Point

Constant Outlet pressure Outlet pressure

Linear Inlet pressure - Pressure drop Outlet pressure

Linear2 Inlet pressure Inlet pressure - Pressure drop

Linear3 Outlet pressure + Pressure drop Outlet pressure

Outlet Outlet pressure Outlet pressure

Inlet Inlet pressure Inlet pressure

Mid-point (Outlet pressure + Inlet pressure)/2 (Outlet pressure + Inlet pressure)/2

You can request additional properties to be calculated on the Additional
Properties sheet. Any number of the Property Sets in the Properties Prop-
Sets folder are available.

7. Select a Property set and click the left arrow to move the Property Set
between the Available Property Sets list and the Selected Property Sets list.
To move all of the property sets at once from one list to the other, click the
appropriate double arrow.
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If you will be using this heating/cooling curve for heat exchanger design,
select the built-in property set HXDESIGN. HXDESIGN calculates all of the
properties needed by design programs from HTRI, HTFS, and B-JAC.
Aspen Plus includes an interface program, HTXINT, for transferring
heating/cooling curve results to these programs. For information on how to
use HTXINT, see Chapter 39.

Example of Requesting a Heating Curve

Generate a heating curve that includes heat exchanger design properties. Points
are generated every ten degrees.
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A table of data is generated after the simulation has been run.
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A plot can be generated from the results.
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11 Running Your
Simulation

This chapter describes how to run your simulation including:
• Running the simulation interactively
• Reinitializing simulation calculations
• Viewing the run status of the simulation
• Checking simulation history
• Running the simulation on the Aspen Plus host computer
• Running a simulation in batch (background) mode
• Running Aspen Plus in standalone (text only) mode
• Specifying run settings and user databanks
• Activating and Deactivating blocks

When your problem specifications are complete, you are ready to run the
simulation. The status of your specifications is shown at all times in the status
bar of the main window and the Data Browser. You can run your simulation if
the status is any of these:
• Input Complete
• Input Changed
• Ready to Execute Block
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You can run your simulation in these ways:

Type of Run Information

Interactive When you run interactively you control the simulation completely. You can step
through the simulation, stop at any point, view any intermediate results, and
make changes.

Batch (background) mode When you run batch you cannot control the simulation. Batch simulations are
useful for long simulations or when you want to run several simulations (case
studies) simultaneously.

Standalone Aspen Plus (text only) mode Standalone runs are similar to batch runs, but are made outside of the user
interface.

Running the Simulation Interactively

You can interactively control the simulation execution by using:

• The Run buttons on the Simulation Run toolbar 
• The Run menu

You have the same flexibility in controlling the simulation whether the
simulation engine is on your local computer or on a remote computer.

You can modify any input specifications at any time before or after a simulation,
or when a simulation is paused.

You can view the progress of the simulation and control using the Control Panel.
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The Control Panel consists of:
• A message window showing the progress of the simulation by displaying the

most recent messages from the calculations
• A status area showing the hierarchy and order of simulation blocks and

convergence loops executed
• A toolbar which you can use to control the simulation

Commands for Controlling Simulations
You can control the simulation by using the commands on the Run menu, the
Simulation Run toolbar, or the Control Panel:

To Do this

Start or continue calculations
Click the Start button  on the toolbar.
– or –
From the Run menu, click Run.

Pause simulation calculations
Click the Stop button  on the toolbar.
– or –
Click anywhere while the cursor is a stop sign.

Step through the flowsheet one block at a time
Click the Step button  on the toolbar.
– or –
From the Run menu, click Step.

Set stop points in the simulation From the Run menu, click Stop Points.
– or –
On the Control Panel, select the block, click with the right mouse button,
and select Stop Point Before or Stop Point After.

Change the next block to be executed From the Run menu, click Move To.
– or –
On the Control Panel, select the block, click with the right mouse
button, and select Move To.

Update results From the Run menu, click Load Results to load
all results from the simulation engine if Interactive Load Results
is:

Off and you stopped the simulation

On and you want to load all results at one time

For more information, see Changing Run Settings and User
Databanks on page 11-14.

continued
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To Do this

Check simulation results
Click the Check Results button  on the toolbar.
– or –
From the Run menu, click Check Results
– or –
In the left pane of the Data Browser, click the Results Summary form.

Display block or stream results 1. On the flowsheet, click the block or stream.
2. Then click with the right mouse button on the block or stream.
3. From the popup menu that appears, click Results.

Purge simulation results
Click the Reinitialize button  on the toolbar.
– or –
From the Run menu, click Reinitialize.

Purge control panel messages Some large simulations can generate megabytes worth of control
panel messages, which consume memory and also disk space if
you save in quick restart (.apw) format. To purge the control
panel messages while keeping the simulation results, click the

Control Panel Purge button  on the toolbar.

Changing Interactive Simulation Speed
When running interactively you can usually increase the speed of the
calculations by selecting the Express Run option. For more information, see
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Changing Run Settings and User Databanks on page 11-14.

When the Express Run option is on, you cannot monitor the progress of the
simulation while it is running. However, once the simulation is complete or
stopped, you can check the Simulation History to see the progress and diagnostic
messages.

Reinitializing Simulation Calculations
When you change your simulation specifications, by default, Aspen Plus uses any
previously generated results as a starting point the next time you run the
simulation. You can override this default by reinitializing the entire simulation,
or specific blocks in the flowsheet, before rerunning the simulation.
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To reinitialize before rerunning a simulation:

1. From the Run menu, click Reinitialize.

2. Choose the items you want to reinitialize in the Reinitialize dialog box.

Tip   You can also do this from the Control Panel.  Select the block or item, click
with the right mouse button and click Reinitialize.

You may need to reinitialize if a block or the flowsheet:
• Fails to converge for no apparent reason, after you changed the block or

specifications that affect its inlet streams
• Has multiple solutions and you can obtain the one you want only by starting

from your specified initial block or stream estimates

When you
reinitialize a

Then

Block The next simulation of the block does not use previously calculated results, but its current results are retained.

Stream The stream results are cleared. This will trigger an inital flash calculation for an external feed stream or a tear stream.

Simulation All results are cleared.

Convergence The iteration counter is reset, the convergence block is tagged as Not Converged, and any previous iteration history is
not used to predict the next guesses for the convergence variables. However, its current results, such as the final
values for the convergence variables, are retained.

Viewing the Status of the Simulation
You can view the progress of a simulation in:
• The Status Bar
• Control Panel Status Messages

Viewing Simulation Status Using the Status Bar

The main window status bar shows the progress of a running simulation and the
current status of the simulation when it is not running. Status messages appear
on the right side of the status bar.



Chapter  11

Aspen Plus User Guide 11-7
Version 10.2

This table shows the meaning of the status messages:

Status message Meaning

Flowsheet Not Complete Flowsheet connectivity is incomplete. To find out why,
click the Next button in the toolbar.

Required Input Not Complete Input specifications for the run are incomplete.
Click Next on the toolbar to find out how to complete
the input specifications, and to go to sheets that are incomplete.

Required Input Complete The required input specifications for the run are complete.
You can run the simulation or enter optional specifications.

Ready to Execute Block The simulation is paused because you clicked the Stop
or Step buttons, or a stop point you set was encountered.
Click the Step or Run buttons to continue calculations.

Results Present The run has completed normally, and results are present.

Results With Warnings Results for the run are present.
Warning messages were generated during the calculations.
See the Control Panel for messages.

Results With Errors Results for the run are present.
Error messages were generated during the calculations.
See the Control Panel for messages.

Input Changed Results for the run are present, but you have changed
the input since the results were generated.
The results may be inconsistent with the current input.

Viewing Simulation Status Using the Control Panel
Status Messages

The Control Panel message area contains progress, diagnostic, warning, and
error messages generated during calculations.
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This table shows the message and the information that follows it:

Control Panel Message Information Displayed Following the Message

Processing input specifications Flowsheet analysis for tear streams and calculation sequence.
Errors associated with input specifications.

Calculations begin Identification of each block as it is calculated. Iteration-by-iteration
status of convergence blocks, and of column convergence. Errors
during simulation calculations.

Generating results Errors during the generation of results (heating and cooling
curves, stream properties, property tables and any block
calculations that were not needed during the simulation
calculations).

Problem specifications modified New flowsheet analysis for tear streams and calculation
sequence, caused by flowsheet modifications. Errors associated
with modified input specifications.

Checking the Status of Calculations
Use the Results Summary sheet to check the status of calculations. To do this:

1. On the Simulation Run toolbar, click the Check Results button .

– or –

From the Run menu, click Check Results.

2. Click the Results Summary sheet.

The Results Summary sheet appears. This sheet indicates whether the
calculations were completed normally and shows error or warning messages
resulting from the calculations.

To see error and warning messages for a specific object, click the Status

button  on the Data Browser toolbar when the forms for that object are
displayed.

For more information on checking the completion status of a run, click here.
see Chapter 12.
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Checking the Simulation History
Aspen Plus keeps a detailed history of your simulation run in a file that you can
view with your text editor. Input specifications, warning messages, error
messages, and block-by-block convergence information are available.

This table shows your options:

To Do this

View the history of the current run From the View menu, click History.

Save history to a file Use the save command for your text editor.

Return to Aspen Plus Use the exit command for your text editor.

Aspen Plus displays all results in the simulation history in SI units.

Running the Simulation on the Aspen
Plus Host Computer

If your network configuration and your Aspen Plus license permits, you can run
the Aspen Plus user interface on one computer and run the simulation engine on
a different computer (the remote Aspen Plus host).

You may be required to connect to a remote Aspen Plus host when you start
Aspen Plus. For more information on connecting to a host computer, see
Chapter 1.

To change the Aspen Plus host computer after you have started Aspen Plus:

1. From the Run menu, click Connect to Engine.

2. In the Connect to Engine dialog box, enter the Server Type.

If you choose your Local PC Host as the Aspen Plus host computer, you do not
need to enter any more information into the dialog box.
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3. For all Aspen Plus host computers except the PC, enter the following
information in the dialog box:

In this field Enter this information

Node Name Node name of the computer the Aspen Plus simulation will run on

User Name Your Logon name on the host computer

Password Password for your account on the host computer

Working Directory Working directory on the host computer for Aspen Plus runs

Aspen Plus creates files for the run in the Working Directory. Specify the
directory as you would in an operating system command.

4. Click OK.

5. When the network connection is established, a message box appears saying
Connection Established.

If the Connection Established box does not appear, see your on-site
Aspen Plus system administrator for more information on network protocols
and Aspen Plus host computers.

Communicating with a Remote Aspen Plus Host
Computer

You can use several commands to communicate with a remote Aspen Plus host
computer simulation engine:

To Do This

Check the status of a batch run From the Run menu, select Batch, then Jobstat,
and select the ID of the run you want information on.

Retrieve results from a batch run From the Run menu, point to Batch, then Load Results,
and select the ID of the run for which you want to retrieve results.
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Running a Simulation Batch
(Background)

There are times when you may not want to run the simulation interactively. For
example, when you use a Sensitivity block or an Optimization block, or if the
simulation is lengthy. In these cases you can submit a batch run.

Tip   To avoid inconsistent input and results, do not change the input
specifications for a run after you have submitted a batch run, until you have read
back the results.

To start a batch run:

1. On the Run menu, select Batch, then Submit.

2. Use the check box to specify whether or not you want to delete the temporary
files Aspen Plus generates after the run finishes.

3. You can specify Command Line Qualifiers, for the operating system (such as
batch queue name), and for Aspen Plus (such as user databank filenames).
You also can specify a working directory on the remote host in the Batch
Submit dialog box. The default directory is your home directory on the remote
host computer.

4. Click the Settings button if you want to change any run settings.

5. Click OK.

Aspen Plus submits the batch run.

To check the status of the batch run:

➤ From the Run menu, point to Batch, then Jobstat.

After the batch run is finished, you can load the results into the user interface.
To load the results into the interface:

1. From the Run menu, point to Batch, then Load Results.

2. Select the ID of the run for which you want to retrieve results.
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Running Aspen Plus Standalone

You can use the Aspen Plus user interface to develop the simulation model for a
run and view the results, but run the Aspen Plus simulation engine separately
from the user interface. You might want to do this to achieve maximum
performance for large flowsheets.

To run the Aspen Plus simulation engine standalone:

1. Complete the input specifications for the run in the user interface. When the
status indicator in the main window toolbar says  Required Input Complete or
Input Changed, you can run the simulation.

2. From the File menu, click Export.

3. In the Save As Type field, select Input File (.inp). Enter the Run ID for the
filename.

4. If you are running the simulation engine on a remote computer, transfer the
file runid.inp to the remote computer.

5. From the operating system prompt, enter the command:
aspen runid

6. If you are running the simulation engine on a remote computer, transfer the
file runid.sum from the remote computer to the local computer when the run
is complete.

7. When the run is complete, from the File menu, click Import and in the Files
Of Type box, select Summary file (.sum).

8. From the file list, select the Run ID and click OK.

9. You can now review the results and modify the input in the user interface, as
if you had made the run from within the user interface.

Editing the Input File for Standalone Runs
You can edit the input file outside the interface. The following instructions
ensure that:
• Any changes you make in the input file are reflected in the user interface.
• Your graphical flowsheet will be restored when you return to the user

interface.
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To edit the Aspen Plus input file outside of the interface:

1. Complete the input specifications for the run in the user interface. When the
status indicator in the main window toolbar says  Required Input Complete or
Input Changed, you can run the simulation.

2. From the File menu, click Export.

3. In the Save As Type field, select Input Files with Graphics (.inp). Enter the
Run ID for the filename.

4. If you are running the simulation engine on a remote computer, transfer the
file runid.inp to the remote computer.

5. Edit your input file to make the changes.

6. Use the aspen command option to create a backup file:

aspen runid /mmbackup

7. If you are running the simulation engine on a remote computer, transfer the
files runid.sum and runid.bkp to the local computer.

8. When the run is complete, start the Aspen Plus user interface.

9. From the File menu, click Open, and select Backup files (.bkp). Then select
the Run ID from the file list.

10. Click OK.

11. From the File menu, click Import, and in the Files Of Type field, select
Summary file (.sum).

12. Select the Run ID from the file list, and click OK.
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Changing Run Settings and User
Databanks

To display the Run Settings dialog box:

1. From the Run menu, click Settings.

2. On the Engine Files Tab, you can specify filenames for:

Item Information

User physical property databanks The property databanks are called USRPP1A, USRPP1B
USRPP2A, USRPP2B and USRPP2C. For more information, see
Aspen Plus Physical Properties Data.

User insert libraries and stream libraries In Aspen Plus, when referring to insert libraries or stream
libraries, you must use the file extension .ILB for insert libraries,
and .SLB for stream libraries.

Link Options The Dynamic Linking Options File (DLOPT) contains directives
for dynamic linking. For more information, see Aspen Plus User
Models.

Run Definition The User defaults file is used to override system defaults files
and specify default command options.

A user cost databank The  user cost databank is used to update the cost indices.

These filenames apply when you run the simulation interactively or in batch.

3. On the Options tab, use the Express Run option to achieve maximum
simulation speed when running the Aspen Plus simulation engine on a PC, or
when running interactively on other platforms. The Express Run option:
• Turns off the Animation option
• Sets the Control Panel message levels to 0
• Turns off interactively loading results
• Enables you to use History from the View menu to examine the progress

of a simulation
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Interactively Load Results
By default, Aspen Plus results are loaded into the user interface only when you
want to examine them.

To change whether Interactively Load Results is on or off:

1. From the Tools menu, click Options.

2. On the Run tab, check or clear Interactively Load Results.

Have Interactively
Load Results

If Then

On You want Aspen Plus to load only the
results you are interested in.

(You can still load all results by using
Load Results from the Run menu.)

Aspen Plus speeds up the processing time by
only loading particular results. This is useful if you
run a simulation several times, but are only
interested in the results on one particular form.

Off You want all results to be loaded
automatically at the end of a run

Aspen Plus loads all simulation results into
the user interface. This increases the time
required for a run to complete, but enables you to
examine results more quickly.

Note  Interactively Load Results only works with the Flowsheet Run Type.

Activating and Deactivating Blocks

Various simulation objects can be activated and deactivated.  When deactivated,
they still need to be completely specified to run the problem, but they are ignored
during simulation.  Blocks and Streams can be deactivated and activated by
clicking the right mouse button on the flowsheet object, and choosing
Deactivate/Activate.  The following objects can be deactivated and activated from
the data browser tree view right mouse button menu:
• Blocks and Streams
• Convergence blocks
• Sequence
• Most Flowsheeting Options: Design-Spec, Calculator, Transfer, Balance, and

Pres-Relief blocks
• Most Model Analysis Tools: Sensitivity, Optimization, Constraint, and Case-

Study blocks
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• Regression
• Properties Analysis (Prop-Table)

Explicitly deactivated items show up in the data browser with a pair of green

slashes through their icon:

In addition to items explicitly deactivated by the user, some objects are
deactivated by association.  That is, they are deactivated because they reference
deactivated objects.  The rules are:
• Deactivating the inlet or outlet stream of a block does not cause a block to be

deactivated, except as specified below.
• Streams with both source and destination deactivated or not present are

deactivated.
• Referencing a deactivated block or stream causes an HxFlux block to be

deactivated. The stream disabling logic is then repeated.
• Referencing a deactivated block or stream causes a Cost block, Pres-Relief

block, Calculator block, Transfer block, Design-Spec, Constraint,
Optimization, Data-Fit block, Sensitivity block, or Balance block to be
deactivated. Targets of a deactivated Calculator or Transfer block will not be
deactivated.

• Calculator, Transfer, and other blocks with Execute Before/After that
reference a deactivated block will be deactivated.

• Convergence blocks that reference a deactivated Tear Stream, Tear-Var,
Design-Spec, Constraint, or Optimization are deactivated.

• Sequences that reference deactivated blocks are ignored and revert back to
automatic sequencing.

• Deactivated Tear Streams or Tear-Vars are ignored.
• Deactivated Convergence blocks in Conv-Order are ignored.

Objects which are deactivated by association are listed in the history file.

Note Deactivating items does not change flowsheet connectivity (other
than effectively removing the deactivated items) and does not
automatically cause any streams to be reinitialized. Some uses of
deactivation may require reinitializing streams which were solved
in a run with different activation.

Selector Blocks

A Selector block can be used to model alternative simulation trains. Copy the
feed stream to the alternate trains with a Dupl block, and connect the products of
the alternate trains to a Selector block.  Deactivate all but one train, and choose
the stream from the active train in the Selector block.
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12 Examining Results and
Generating Reports

This chapter describes how to:
• View simulation results interactively
• Checking the completion status of a run
• Checking the convergence status of a run
• Displaying stream results
• Generate an Aspen Plus report file

Viewing Simulation Results Interactively

You can view results whenever the status message in the bottom window status
bar is one of the following:

Message Means

Results Available The run has completed normally, and results are present.

Results Available with Warnings Results for the run are present. Warning messages were generated
during the calculations. View the Control Panel or History for messages.

Results Available with Errors Results for the run are present. Error messages were generated during
the calculations. View  the Control Panel or History for messages.

Input Changed Results for the run are present, but you have changed the input since the
results were generated. The results may be inconsistent with the current
input.

Use the results status indicators, which appear in the Data Browser to guide you
to forms and objects. For a complete list of the status indicators, see Chapter 1.



Examinin
g Results and
Generating
Reports

12-2 Aspen Plus User Guide
Version 10.2

Viewing Current Simulation Results
You can view the current simulation results after using the Stop or Step
commands. To do this:

1. From the Run menu, click Settings.

2. In the Run Settings dialog box, ensure that the Interactively Load Results
option is cleared.

3. From the Run menu, click Check Results.

Use the results status indicators, which appear in the Data Browser, to guide you
to forms and objects with results.

Checking the Completion Status of a Run

Use the Results Summary sheet to examine summary information about the
convergence and completion status of a run. This form indicates whether the
calculations were completed normally.

To display the Results Summary sheet, do one of the following:
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From the Select

Simulation Run toolbar
or the Control Panel The Check Results button  

Data Browser Results Summary in the left pane of the Data Browser

Run menu Check Results

If errors or warnings exist:

1. When on a particular form, click the Status button  on the toolbar of the
Data Browser window to see specific messages.

2. Check the Control Panel and History file for information, diagnostic, warning,
and error messages generated during calculations.

Checking Completion Status in the Control Panel
The Control Panel displays error, warning and diagnostic messages from the run.

The number of messages can be controlled globally using the Setup Specifications
Diagnostics sheet or locally using the block BlockOptions Diagnostics sheet.

The messages on the control panel are similar to those printed in the history file
(*.his). The diagnostic level of the history file and the control panel can be
adjusted independently.

If a high level of diagnostics is needed, the diagnostics should be printed to the
history file and not to the control panel. This means you will not slow down
performance by writing a lot of information to the screen.

To view the Control Panel, do one of the following:

From the Select

View menu Control Panel

Simulation Run toolbar
Show/hide control panel window button 

The Run Messages file (*.cpm) is a text file that includes all of the messages
printed on the control panel. Run Messages files must be exported from the
simulation to be saved. For more information, see Chapter 15.
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Checking Completion Status in the History File
The History file displays error, warning and diagnostic messages from the run.

The number of messages can be controlled globally using the Setup Specifications
Diagnostics sheet or locally using the block BlockOptions Diagnostics sheet.

To check the History file:

➤ From the View menu, click History.

A history file cannot be directly saved or exported from the Aspen Plus User
Interface. However, the file is saved automatically when a run is saved as an
Aspen Plus document (*.apw). You can also save the viewed history file using the
text editor.

The history file is similar to the Run Messages file (*.cpm). The diagnostic level
of the history file and the control panel can be adjusted independently. If a high
level of diagnostics is needed, they should be printed to the history file and not to
the control panel so as to not inhibit performance by writing so much information
to the screen.

Checking the Convergence Status of a
Run

Design specifications and tear streams both have associated convergence blocks.
The Aspen Plus generated convergence block names begin with the character “$.”
User-defined convergence blocks must not begin with the character “$.” For more
information on Convergence, see Chapter 17.
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Summary of Convergence Block Results

To see a summary of all of the convergence blocks for a run:

1. In the left pane of the Data Browser, click Results Summary, then select
Convergence.

2. This table shows which sheets to use for summary information:

Select this sheet For a summary of

DesignSpec Summary The convergence status, final manipulated variable value, and final
errors for all design specifications in the simulation

Tear Summary The convergence status and final maximum errors for all tear streams
in the simulation

Detailed Convergence Block Results

To see detailed results for a convergence block and its iteration history:

1. From the Data menu, point to Convergence, the click Convergence.

2. From the Convergence Object Manager, select a convergence block ID.

3. Click the Edit button.

– or –

4. Double-click a convergence block ID.

5. From the Results form:

Select To see

Summary How tightly each tear variable or manipulated variable was converged

Spec History The errors at each iteration. You can plot the iteration history.

Tear History The maximum error at each iteration among all tear stream variables converged
by this block. You can plot the iteration history.

Max Error/Tol The maximum error divided by the tolerance at each iteration  for all tear streams
and design specifications.

Tear Variables The value at each iteration of all tear stream variables converged by this block.
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Displaying Stream Results

This table shows how to display stream results:

To display Do this

A single stream 1. Click the stream.
2. Click with the right mouse button on the stream.
3. From the popup menu that appears, click Results.

The inlet and outlet streams of a block 1. Click the block.
2. Click with the right mouse button on the block.
3. From the popup menu that appears, click Stream Results.

All streams From the Data Browser, point to Results Summary, then Streams.

On any Results Summary Streams sheet, click the down arrow in the Display box
to select whether all stream or selected streams are displayed:

To add a stream to the display on any Results Summary Streams sheet:

1. Move to a field in the top row of a column.

2. Click the arrow to see a drop down list of streams.

To remove a stream from the display:

1. Click the stream ID.

2. Click the right mouse button.

3. From the popup menu that appears, click Clear.

This table shows which sheets display which results:

Select this Results Summary
Stream sheet

To display

Material Results for all or selected material streams in a spreadsheet format

If you designate any batch streams, Aspen Plus displays the
batch stream results (such as cycles/day, cycle time, down time).

You can format the stream results, transfer the stream results to
the Process Flowsheet as a table, or print the results. For more information, see
Chapter 14 .

For more information about stream summary formats, see Formatting Stream Results
on page 12-7.

Heat Heat flow results for all or selected heat streams in a spreadsheet format

Aspen Plus uses heat streams to transfer duties to or from unit operation blocks.

Work Power results for all or selected work streams in a spreadsheet format
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Aspen Plus uses work streams to transfer power to or from pumps or compressors.

Vol. % Curves The Volume percent curves for all or selected streams.

TBP curve, ASTM D86 curve, ASTM D1160 curve, Vacuum at 10 mmHg curve,
API curve, and Specific gravity curve can be viewed.

For more information, see Chapter 32.

Wt. % Curves The Weight percent curves for all or selected streams.

TBP curve, ASTM D86 curve, ASTM D1160 curve, Vacuum at 10 mmHg curve,
API curve, Specific gravity curve, Molecular weight curve, and
ASTM D86CRK curve can be viewed.

For more information, see Chapter 32.

Petro. Curves Petroleum property curves for all or selected streams.

For more information, see Chapter 32.

Formatting Stream Results
The settings you specify on the Setup ReportOptions Stream sheet determine the
contents of the Results Summary Streams Material sheet. For more information
on specifying stream results, see Chapter 5.

The table format file (TFF) shown in the Format box of the Stream Summary
sheet determines the format (order, labels, precision, and other options) of the
stream results.

Aspen Plus provides built-in TFFs tailored to each Application Type. The default
is an appropriate TFF for the Application Type you choose when you create a new
run. You can also create your own TFFs. For more information on creating your
own TFFs, see Chapter 36.

Choosing a Table Format File

To choose a TFF:

1. From the Data menu, click Results Summary, then Streams.

2. Click the Material sheet.

3. In the Format box, click the drop down arrow and select a TFF from the List.

If you are using built-in TFFs, it is recommended that you select a TFF for
your Application Type. For example, if you are using a Petroleum Application
Type, choose a TFF beginning with PET.
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Tips

You can also specify the TFF on the Setup ReportOptions Streams sheet.
Aspen Plus uses the TFF you select for all Stream Summary sheets you display,
until you select another TFF.

Some TFFs filter the calculated stream results. If you want to make sure you see
all calculated properties, select TFF FULL.

Displaying Heat and Work Stream Results
To display results for heat and work streams, follow one of these procedures:

To display results for Do this

A single stream 1. Click the stream
2. Click the right mouse button and from the popup menu that appears, click Results.

All streams 1. From the Data Browser, click Results Summary, then Streams.
2. Click the Heat or Work tab.

Generating a Report

You can generate a report file documenting the complete input specifications and
simulation results for your Aspen Plus run. Use the Report Options forms to
control report contents. For more information about report options, see Chapter 5.

Before generating a report, the results of an interactive run must be available.
You need to make an interactive run if:
• You have not yet run the simulation.
• You changed input specifications since running the simulation.
• You changed settings on the Report Options forms since running simulation.
• You opened a run saved in backup format, and have not run the simulation in

the current session.

To make an interactive Run:

➤ On the Simulation Run toolbar, click the Run button .

– or –
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➤ From the Run menu, click Run.

To generate a report:

➤ From the View menu, click Report.

Export a Report File
To save the entire report file from an interactive run:

1. From the File menu, click Export.

2. In the Save As Type box, select Report files.

3. Enter a filename. The file can be in any directory on the local computer.

4. Select Save to create the report file.
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Aspen Plus generates a report automatically during a batch run. The filename is
the Run ID, with the .rep extension. The report file for a batch run is saved on
the computer running the Aspen Plus simulation engine. If Aspen Plus is
running on a remote computer, the report file is saved on that computer's file
system.

For more information on managing files, see Chapter 15.

Viewing a Section of the Report
To view the entire report or a selected portion of a report in a text editor:

1. From the View menu, click Report.

2. Select the part of the report that you would like to view:

Select To display

Block The results of a specified unit operation block

Convergence The results of a specified Convergence block

Sensitivity The results of a specified Sensitivity block

Transfer The results of a specified Transfer block

Calculator The results of a specified Calculator block

Streams The results of a specified stream or of all streams

Balance The results of a specified Balance block

Pressure Relief The results of a specified Pressure relief block

Regression The results of a specified Regression block

Simulation The entire Report file

Table Of Contents Table of contents for the report

Flowsheet Balance Material and energy balance for the flowsheet

Connecting Streams The connecting streams (feeds and products) for a selected block

3. If necessary, select the ID for the block, stream, or other object.

4. Click Apply to display your selection in the text editor.

5. Repeat steps 2-4 to display any additional sections of the report.

6. Click OK.



Chapter  12

Aspen Plus User Guide 12-11
Version 10.2

Tips

Any of the sections of the report can be saved or printed using the text editor.

Use Copy and Paste to copy results from any sheet into another Windows
program.

❖     ❖     ❖     ❖ 
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13 Working with Plots

This chapter describes how to generate, customize, and print plots from any input or
results sheet that has tabular data, including:
• Generating plots
• Working with plots
• Printing plots

About Plots

Aspen Plus plots are a useful way of viewing the date from a run.  You can use
plots to display:
• Input and results profiles for unit operation blocks
• The results of flowsheeeting options and model analysis tools such as

Sensitivity, Optimization, and Pres-Relief.

There are three steps involved in generating a plot:

1. Displaying the sheet containing the data you want to plot. The sheet may
contain either input or results data.

2. Generating the plot either by:
• Using the Plot Wizard

–or–
• Selecting the dependent, independent, and parametric variables

3. Customizing the plot appearance.
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Step 1: Displaying the Data

To display data:

1. From the Data menu, click Data Browser.

2. In the left hand pane, click the form containing the data that you want to
plot.

3. On the form, click the sheet to display the data.

This sheet can be either an input or a results sheet though it is much more
common to plot results.

4. To plot results, make sure that the simulation run has results available.

If results are available, the status message in the main window will be
Results Available, Results Available with Warnings, Results Available with
Errors, or Input Changed. For more information on status messages when
results are present, see Chapter 12 .

If results are not available, run the simulation.

Step 2: Generating a Plot

You can generate the plot in either of these ways:
• Using the Plot Wizard
• Selecting the dependent and independent variables

Using the Plot Wizard
Use the Plot Wizard to generate a plot quickly by selecting from a list of
predefined plots. The Plot Wizard is available for most blocks and other objects
which have tables of results.

After you have displayed the data:

1. From the Plot menu, click Plot Wizard.

Note   The Plot menu is only visible when you have the Data Browser in the
current window.



Chapter  13

Aspen Plus User Guide 13-3
Version 10.2

The Plot Wizard Step 1 appears.

2. Click Next.

3. Select the type of plot from the list of available plots, then click Next.

4. Select the options for the plot type you have selected.

The options that are available depend on the plot type selected.

5. Click Next.

6. Select the general options for the plot type you have selected.

The Plot Wizard guides you through the options.  These include:
• Changing the Plot type
• Modifying the Plot and Axis titles
• Choosing whether you want the plot updated when new results are

available
• Selecting if you want to display the plot legend
• Adding a time stamp

For further details on these, see Step 3: Customizing the Appearance of a Plot
on page 13-7.

7. To end the Plot Wizard and generate the plot, click Finish.
For information on changing the plot attributes after exiting the wizard, see
Step 3: Customizing the Appearance of a Plot on page 13-7.
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Example of Making a Plot of Flow Rate for a Radfrac Column
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The plot generated:

Generating a Plot by Selecting Variables
The Plot Wizard is usually the quickest way to generate a plot.  However, if the
plot you are interested in is not available in the Plot Wizard, you can generate
the plot by selecting the independent, dependent, and parametric variables.

To select variables:

1. Click the title of the column of data you want to plot on the X-Axis.

2. From the Plot menu, click X-Axis Variable.

3. Select all the dependent variables:
• Hold down Ctrl and click the title of each column of data you want to plot

on the Y-Axis.
• From the Plot menu, click Y-Axis Variable.

4. If you want to plot a parametric variable:

Click the title of the column of data you want to plot as the parametric
variable.

5. From the Plot menu, click Parametric Variable.

This table shows the types of variables available for a plot:
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This variable Is You can

Y-Axis variable The dependent
variable

Select as many Y-Axis dependent variables
as you like for a plot. You must select
at least one Y-Axis dependent variable.

X-Axis variable The independent
variable

Select only one X-axis independent variable
or accept the default independent variable
(usually the first column of data)

Parametric variable The third variable Use this variable to plot a dependent variable
against an independent variable for several values.
For example, you might use a sensitivity block
to generate a plot of reaction conversion (the dependent
variable to be plotted on the Y-axis) versus residence time
(the independent variable to be plotted on the X-axis)
for three temperatures (the parametric variable).

Step 3: Customizing the Appearance of a
Plot

You can customize the appearance of your plot by:
• Adding and modifying annotation text
• Changing the plot properties

Adding and Modifying Annotation Text
You can:

Do This And

Add text to annotate a plot The text can be attached or unattached.

Attach text to a point on a plot line The text moves with the point as you zoom in and out
and scroll through the plot workspace.

Place unattached text anywhere within the plot
workspace

The text stays in the same place within the window as
you zoom in and out and scroll through the workspace.
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To add text to a plot:

1. Display the plot on which you want to add text.

2. Click the right mouse button on a plot and from the popup menu that
appears, point to Modify, then click Add Text.

3. Use the Plot Text Setting dialog box to add or change the text.

Use this text sheet To

Text Enter the annotation text and specify color and orientation

Attribute Attach the text to data point. You can connect it without an arrow or
with a small, medium or large arrow.
The default is to attach it with a medium arrow.

Leave the text unattached. You can either left, center, or right justify it.
The default is to left justify the text.

Font Select the font, style and size for the text

4. Click OK.

5. Click the location on the plot where you would like to have the text placed.

6. If the text is attached to a data point, Aspen Plus automatically draws a line
to the nearest curve. If this location is not desired, the point of attachment
can be selected and dragged to any point on any curve in the plot.

To modify text on a plot:

1. Select the text that you want to modify. It will be highlighted once it is
selected.

2. Click the right mouse button and click Edit.

3. Use the Plot Text Settings dialog box to change the text.

4. Click OK.

You can also change the default text font on a plot.  For information on
changing plot defaults, see Changing Plot Defaults on page 13-18.
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Changing Plot Properties
Most of the elements of a plot can be modified using the Plot Control Properties
dialog box. To access this dialog box:

➤ Double-click the plot.

– or –

Click the right mouse button over the plot and from the menu that appears,
click Properties.

The following sections describes the changes you can make to a plot.

Changing Plot Attributes

You can change the appearance of data lines on a plot. The color, line, type and
marker type can be modified for each variable.

To change the attributes of the data lines on the plot:

1. Display the plot.

2. Click the right mouse button on the plot and from the menu that appears,
click Properties.

3. Click the Attribute tab.

4. Select the variable.

5. Select the Color, Marker, and Line type for that variable.
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Displaying the Plot Legend

To show a legend on a plot:

1. Display the plot.

2. Click the right mouse button on the plot and from the popup menu, point to
Modify, then click Show Legend.

Modifying the Plot Legend

You can modify the legend text and font:

1. Display the plot.

2. Double-click the legend.

– or –

When the cursor is positioned over the legend, click the right mouse button
and then click Edit.

3. On the Plot Legend dialog box, click the line of the legend that you want to
change and it appears in the Legend Text box.

4. In the Legend Text box, change the legend.

5. Click Replace.

6. Repeat steps 3–4 for every line of the legend that you want to change.
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7. On the Font tab, you can modify the font for the entire legend.

The legend can be hidden and then revealed, and all changes to the legend
will be preserved.

You can also change whether a legend appears by default on your plots. For
information on changing plot defaults, see Changing Plot Defaults on page 13-
18.

Changing the Axis Map

If a plot has more than one dependent variable, by default Aspen Plus displays
the plot with a separate Y axis scale for each dependent variable. You can map
all variables to a single axis, or you can map groups of variables to designated
axes.

For example, if you plot column mole fraction profiles for five components, you
can plot all components against a single Y axis scale. If you plot temperature,
liquid rate and vapor rate on the same plot, you can plot temperature on one axis
and both flow rates on another.

To specify axis mapping:

1. Display the plot.

2. Click the right mouse button on the plot and from the popup menu, click
Properties.

3. Click the AxisMap tab.

4. Select a dependent variable.

5. This table shows what you can do:

Use To

The Up and Down arrows Change the axis number the variable is mapped to. If you reduce an axis number to
zero, the plot of the dependent variable is not displayed.

The All in One button Map all dependent variable to a single axis.

The One for Each button Map each dependent variable to a separate axis.

6. Click OK.
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Changing Plot Titles

You can change the text on the plot titles at any time by customizing the font,
style, and size for the text.

To change the plot title for a specific plot:

1. Display the plot that you want to change.

2. Double-click the title that you want to change.

3. On the Text tab, enter the text for the title.

4. On the Font tab, select the font, style, and size for the text.

You can also change the default text font for plot titles. For information on
changing plot defaults, see Changing Plot Defaults on page 13-18.

Changing Plot Axis Labels

The text on the plot axis labels can be modified at any time. The font, style, and
size for the text can also be customized for each label.

To change the plot axis labels for a specific plot:

1. Display the plot.

2. Double-click the axis label that you want to change.

3. On the Text tab, enter the text for the axis label.

4. On the Font tab, select the font, style, and size for the text.
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5. Repeat steps 2–4 for any other axes that you wish to modify.

You can also change the default font for all plot axis labels. For information
on changing plot defaults, see Changing Plot Defaults on page 13-18.

Changing Plot Axes

The scale options for the X and Y axes can be changed in order that a specific
area of the plot can be viewed. If a plot has more than one Y axis scale, the scale
for each one can be changed separately.

To change scale options for the X or Y axis:

1. Display the plot.

2. Double-click the Axis values that you want to change.

3. Select whether you want a linear, log or inverse scale.

4. Change the Grid interval.

– or –

To return to the automatic grid interval determined by Aspen Plus, turn off
the Lock grid option.

5. Use the Axis Range settings to plot only a subset of the data, or to specify
endpoints for the axis scale. To return to the automatic range determined by
Aspen Plus, delete the entries from the Range text boxes.

6. The Value Range boxes (displayed below the Axis Range boxes) show the
range of data.

7. If you want to invert the axis to display the variable values decreasing from
the origin, check the Variable Descends box.

8. On the Font tab, select the font, style and size for the text.
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Changing the Grid Display for a Plot

To change the grid and line display options for a specific plot:

1. Display the plot.

2. Double-click the plot background.

3. Click the Grid tab.

4. Change the options desired.

This table shows the display settings that you can change:

Choose this Plot Option To

Grid Define the type of grid for the plot. Choose from:

Mesh (Horizontal and vertical grid)
Horizontal
Vertical
No grid

Line Select the line style for the data curves. Choose from:

Lines & markers
Lines
Markers

Flip coordinate Flip the x and y axes

Square plot Set the range of the x and y axes to be the same

Diagonal line Draw a diagonal line where x=y on the plot

Zero line Draw a horizontal line at the zero point of the x axis

Marker size Modify the size of the markers displayed in the plot

You can also change the default display options for plots. For information on
changing plot defaults, see Changing Plot Defaults on page 13-18.
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Adding a Time Stamp

A time stamp can be added to a plot to mark the date and time that the plot was
created. The time stamp can include any combination of:
• Date
• Time
• Version
• RunID
• Username

To add a time stamp to a plot:

1. Display the plot.

2. From the Edit menu, click Insert Time Stamp.

The time stamp is simply text. To modify the time stamp, use the same
instructions for modifying text.

You can also change the default time stamp for plots. For information on
changing plot defaults, see Changing Plot Defaults on page 13-18.

Working with Plots

This section describes working with plots, including:

Updating Plots When Results Change
If you leave a Plot window open when you rerun a simulation, by default
Aspen Plus does not redraw the plot using data from the new run.

To have a plot updated when results change:

1. Display the plot that you want to modify.

2. From the Edit menu, click Live Plot.

This option can also be selected in the Plot Wizard.
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Adding Data to Plots
You can add additional curves to existing plots.

To add data:

1. Display the sheet that contains the data you want to add to an existing plot.

2. Select the dependent and independent variables.

The selected data needs to have the same x-axis variable as the existing plot.
For example,  if the existing plot is temperature vs. stage number, the data
selected needs to be something vs. stage number.

3. From the Plot menu, click Add New Curve.

4. In the Plot Window List dialog box, click the Plot where you want to add the
new data.

5. Click OK.

The new curve is added to the plot.

Comparing Runs Using Plots
You can use the Add New Curve feature to compare the results from different
runs in a single plot.

1. After the first simulation, create the plot.

2. From the Plot menu, ensure that the Animate Plot option is not checked.

3. Change the input specifications and re-run the simulation.

4. Display the results sheet containing the data you want to compare against
the first run. Select the same independent and dependent variables as in the
first plot.

5. From the Plot menu, click Add New Curve.

6. In the Plot Window List dialog box, click the Plot where you want to add the
new data.

7. Click OK.

The new curve will be added to the plot.
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Deleting Data Points and Curves from Plots
From an existing plot, you can delete:
• Selected data points
• An entire curve

After you delete data points from a plot, Aspen Plus redraws the curve
automatically.

Note You cannot recover deleted data points. You must regenerate the
plot if you want to see them again.

To delete selected data points from a plot:

1. Display the plot.

2. Hold down the left mouse button and drag the cursor to form a rectangular
outline around the data points that you want to delete.

3. Click the right mouse button.

4. From the menu that appears, click Delete Points.

Note You cannot recover deleted data points.

To delete an entire curve:

1. Display the plot.

2. Click the right mouse button.

3. From the popup menu, point to Modify, then click Hide Variable.

4. Select a variable and use the Hide and Show arrow buttons to move the
desired variables from the Shown Variables list to the Hidden Variables list.

Hidden curves can later be revealed using these same steps.

Displaying a Different Range of Data on a Plot
Use the zoom commands to display a different range of data on a plot:

This zoom option Zooms

Zoom Auto In by an automatic amount

Zoom Out Out by an automatic amount

Zoom Full To the full plot
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For example, to zoom in on a specific range of data:

1. Display the plot.

2. Select the region of interest on the plot. To do this, hold down the left mouse
button and drag the cursor to form a rectangle outline.

3. Click the right mouse button in this region and from the menu that appears,
click Zoom In to display the region you selected.

4. To display the entire plot again, click the right mouse button in the plot and
from the popup menu, click Zoom Full.

Changing Plot Defaults
To change the defaults used to generate a plot:

1. From the Tools menu, click Options.

2. From the Plots tab, click the defaults that you want to change.

3. Click the Title, Axis label, Axis scale, or Annotation buttons to modify the
default font for the different types of text on a plot.

4. Use the lists to select the Grid Style and the Line Style used for new plots.

5. Use the Marker Size box to specify the size of data markers in plots.

6. Check the Show legend and/or Show Time Stamp boxes to display these
elements by default on a new plot. The components of the time stamp can also
be selected in this manner.

Printing a Plot
You can print a selected plot. To do this:

1. Display the plot that you want to print.

2. From the File menu, click Print.

For more information on printing, see Chapter 14.
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14 Annotating Process
Flowsheets

This chapter describes how you can annotate your flowsheets, including:
• Adding annotations
• Displaying global data
• Using PFD mode
• Printing

Adding Annotations

Additional text, graphics, and tables can be added to your flowsheets.

For example, this illustration shows annotation turned on to show a title and a
table of stream results.
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Adding Stream Tables
You can add stream tables to your flowsheets to display stream properties in a
birdcage format.

To generate a stream table in your flowsheet:

1. Ensure that the flowsheet has results available. If results are not available,
run the simulation.

2. From the View menu, ensure Annotation is selected.

3. Display the Results Summary Streams sheet. To do this, in the left pane of
the Data Browser, click Results Summary, then Streams.

Results for all of the streams are displayed. For more information see
Chapter 12.

If you only want selected streams to be displayed:
• In the Display box, select Streams instead of All Streams.
• Then select the desired stream from the list at the top cell of each column.

4. In the Format box, select the format you want. The format controls how
Aspen Plus displays results. Options include order, labels, units, and
precision. (See Chapters 12 and 36)
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The different formats are created using Stream Summary Format Files (*.tff
files). All of the files with this extension in the system directory or in the
working directory will appear in the Format list.

5. Click the Stream Table button.

Aspen Plus adds the stream table to your drawing.

The table is scaled for printing so if you cannot read its contents on screen,
you can zoom in on it, or resize it.

6. Move the table to the position you want, using the keyboard or mouse.

7. You can attach the table to a block or stream. From the Table popup menu,
click Attach.

8. To arrange the table in multiple rows of streams, from the Table popup menu,
click Stack Table.

Resizing Stream Tables

You can resize stream tables by changing the font size. To do this:

1. Click on the stream table to select it.

2. On the Draw toolbar, change the font size.

The stream table resizes accordingly.

Adding Graphics Objects
To add lines, circles, or boxes to a flowsheet:

1. From the View menu, ensure Annotation is selected.

2. Ensure the Draw toolbar is displayed. Click here for more information.

To do this, from the View menu, click Toolbar and ensure Draw is selected.

3. From the Draw toolbar, select the drawing tool that you want, and the line
style and fill color that you want.

4. Move the cursor to where you want to place the object.

5. Hold down the mouse button until the cursor changes to the resize shape (+).

6. Drag the cursor to create the object in the size you want, then release the
mouse button.
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7. To fill in the graphics object, select the object and check fill on the object’s
popup menu.

You can change the attributes of an object after you place it. Select the object,
then select the line style or fill color from the Draw toolbar.

Use the mouse or keyboard to move and resize graphics objects. You can attach
the graphics object to a block or stream by clicking the block or stream with the
right mouse button and from the popup menu that appears, clicking Attach.

It is helpful to show the grid and use grid options when placing, moving, and
resizing graphics objects. For more information see Aligning Objects in
Flowsheets on page 14-12. For information on how to use and customize the Grid
and Scale options, see Chapters 4 and 16.

Adding Text Objects
To add text annotations to a flowsheet:

1. On the View menu, ensure Annotation is selected.

2. Ensure the Draw toolbar is displayed. Click here for changing which toolbars
are displayed.

To do this, from the View menu, click Toolbar and ensure Draw is selected.

3. From the Draw toolbar, click the text button .

4. Move the cursor to where you want to place the text and click the mouse
button.

5. Type the text.

Use the mouse or keyboard to move and resize text you have placed.

You can also attach the object to a block or stream. To do this, click the block
or stream with the right mouse button and from the popup menu that
appears, click Attach.

It is helpful to show the grid and use grid options when placing, moving, and
resizing text. For more information see Aligning Objects in Flowsheets on page 14-
12. For information on how to use and customize the Grid and Scale options, see
Chapters 4 and 16.
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Specifying Text Attributes

You can change the appearance of text objects after you place them in your
flowsheet by selecting the text object then using the Draw toolbar to specify the
attributes.

To specify the default text attributes for all subsequent text that you add:

1. Ensure no text objects are selected in the drawing.

2. In the Draw toolbar, specify the attributes you want.

Editing Text Objects

In a flowsheet, you can edit a text object.

To edit a text string:

1. Select the text string and click the right mouse button.

2. From the popup menu that appears, click Edit.

About Global Data

Global data consists of simulation results for each stream, and for each block
that calculates duty or power.

You can display the following global data directly on a flowsheet:

This data Is displayed

Stream temperature, pressure, flow rate In symbols attached to stream IDs

Heat stream duty In symbols attached to stream IDs

Work stream power In symbols attached to stream IDs

Block heat duty and power Next to the block icon

This example shows a process flowsheet window where global data is turned on
to show temperature, pressure, and flow rate for each stream:
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Displaying Global Data
To display global data in a flowsheet:

1. From the View menu, ensure Global data is selected.

2. Ensure that the flowsheet has results available. If results are not available,
run the simulation.

3. From the Tools menu, click Options.

4. Click the Results View tab.

5. Select a units set for the data from the list.

6. Select the results you want to display.

For each result, specify a numerical format.

The recommended format is %10.2f. This format prints values with two digits
to the right of the decimal, if there is room. If the number is greater than
9,999,999, Aspen Plus eliminates the fractional digits, then spills over the
field range to the left.
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Other common formats used in stream tables are:

Stream table format Prints

%10.0f Whole numbers, with no decimal digits or exponents

%10.nf Numbers without exponents and with n digits to the right of the decimal point, if there is room.
Decimal points line up, unless decimal digits have been eliminated in some numbers.

%10.nE Numbers in exponential notation, with n+1 significant digits

7. Click OK to close the dialog box and display the data.

A legend box shows the global data symbols and units. You can move and
resize the legend in the same way that you move and resize blocks.

About PFD Mode

Aspen Plus has a special Process Flow Diagram (PFD) mode that enables you to
create customized diagrams from your simulation results. In this mode, you can
add or delete unit operation icons to the flowsheet for graphical purposes only.

Using PFD mode means that you can change flowsheet connectivity to match
that of your plant.

To use the PFD mode:

➤ Turn PFD mode on and off from the View menu.

The default is PFD Mode turned off.

Using PFD Mode to Change Flowsheet Connectivity
In the simulation flowsheet, you may need to use more than one unit operation
block to model a single piece of equipment in a plant. For example, a reactor with
a liquid product and a vent may need to be modeled using a RStoic reactor and a
Flash2 block. In the report, only one unit operation icon is needed to represent
the unit in the plant.

Alternatively, some pieces of equipment may not need to be explicitly modeled in
the simulation flowsheet. For example, pumps are frequently not modeled in the
simulation flowsheet; the pressure change can be neglected or included in
another unit operation block.
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When PFD mode is on, you can:
• Add blocks and streams that are not in the simulation flowsheet
• Delete blocks and streams that are in the simulation flowsheet

In summary:

Have PFD mode When you

Off Create a simulation flowsheet (default)

On Prepare customized PFD-style drawings for reports

Example of Aspen Plus in Simulation Mode and PFD Mode

When the PFD mode is on, PFD mode is shown on the status bar and a aqua
border is displayed at the edge of the Process Flowsheet Window.

Simulation Mode:

PFD mode:
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Creating a Process Flow Diagram
To create a process flow diagram:

1. Display the simulation flowsheet.

2. From the View menu, ensure PFD mode is checked.

You are now in PFD mode. Aspen Plus displays a copy of your simulation
flowsheet.

3. Modify the drawing, as described in subsequent sections of this chapter.

4. To exit PFD mode, from the View menu, clear the PFD mode checkbox.

Important PFD-style drawing is completely separate from the
graphical simulation flowsheet. You must return to
simulation mode if you want to make a change to the
simulation flowsheet.
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Grouping Objects

You can create temporary or permanent groups of text and graphics objects in
your flowsheet.

example,  this diagram shows  a temporary group that includes the text
“Methylcyclohexane Recovery Column” and the Unit Operation Icon for the
column:

You can select a region containing both the objects and flowsheet blocks and
streams. You can move the selected text, graphics, and flowsheet objects as a
unit. But you must perform all other operations separately for the different
groups in the region.

When you select a temporary group, you can move, resize, or change attributes of
all objects in the group together.

A permanent group becomes a single object in the drawing. You can select, move,
resize, rotate, or change the attributes of all objects in the group together.
Permanent groups may only contain text and graphic objects added to the
flowsheet in PFD mode, but you can attach the entire group to a flowsheet block
or stream. For more information, see Attaching Objects to the Flowsheet on page
14-13.
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Creating Temporary Groups
To create a temporary group in your flowsheet:

1. Select a region that contains text or graphics objects by using the mouse to
draw a box around the region.

2. You can add or remove objects by holding down Ctrl and clicking the mouse.

3. Work with the selected group to perform the operations you want. For more
information see Working with Temporary Groups on page 14-11.

4. To deselect the group, move the mouse away from the group and click.

Working with Temporary Groups

After creating a temporary group, you can perform these operations:

To do this Use the And

Move the group Keyboard or mouse Move the group as if it were a single object.

Resize the group Resize button or + and - keys Drag the mouse or hold down the key until
the group is the size you want

Change attributes Draw toolbar Select the attribute you want.

Zoom in or print Popup menu. Click the right mouse
button within the region, but outside
the group select buttons.

Select Zoom In or Print.

Use other group
commands

Popup menu. Click the right mouse
button on the group.

Select a command.

Creating Permanent Groups
To create a permanent group:

1. Select a temporary group.

2. Click with the right mouse button on an object in the group.

3. From the Group popup menu that appears, click Group.

Note A permanent group may only contain text and graphical objects
added to the flowsheet in PFD mode, but you can attach a
permanent group to a flowsheet block or stream. For more
information, see Attaching Objects to the Flowsheet on page 14-13.
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Making Permanent Groups into Temporary Groups

To convert a permanent group to a temporary group:

1. Click the right mouse button on the group

2. From the Group popup menu that appears, click Ungroup.

Aligning Objects in Flowsheets
If the Snap to Grid option is on, any text or graphics objects that you add or move
align to a grid.

To display the grid:

1. From the Tools menu, click Options.

2. Click Grid/Scale.

3. Check Show Grid to see the grid on the screen.

You may need to position or size objects more precisely than the default grid
allows.

You can turn off the Snap to Grid option, reduce the grid size and display a ruler.

You can also use the Process Flowsheet toolbar to perform all these operations
quickly.

To turn off the Snap to Grid option:

1. From the Tools menu, click Options.

2. Click the Grid/Scale tab.

3. Clear the Snap to Grid checkbox.

To change the grid size:

1. From the Tools menu, click Options.

2. Click the Grid/Scale tab.

3. Select the Grid Size from the list.

You can display a ruler to help you see where you are within the overall drawing
grid:

1. From the Tools menu, click Options.

2. Click the Grid/Scale tab.
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3. Check Show Scale to turn it on.

When precisely aligning text and graphics, it is helpful to zoom in on the area of
the flowsheet where you are working.

Attaching Objects to the Flowsheet
You can attach stream tables, permanent groups, and OLE objects to flowsheet
blocks or stream IDs. Attached objects move with the parent block or stream ID.
For example, text annotation attached to a block maintains its position relative to the
block, no matter where you move the block in a drawing.

To attach an object to a flowsheet:

1. Click the object to select it.

2. Click the right mouse button on the object.

3. From the popup menu that appears, click Attach.

The mouse changes to the connect pointer.

4. Click the block or stream to which you want the object connected.

5. Move the object where you want it, relative to the parent block or stream ID.

When you select an attached object, small boxes indicate the parent block or
stream.

To unattach an object:

➤ From the object's popup menu, deselect Attach.

Printing

This section contains information on:
• Specifying your print settings in the Page Setup dialog box
• Viewing the page layout and adjusting the page breaks

You can print the following in Aspen Plus:
• The entire flowsheet
• A section of a flowsheet
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• Plots
• Online Documentation and Help

Tip To print Aspen Plus forms, copy and paste the information into
Microsoft Excel, then print.

Using Page Setup
Use Page Setup to control the appearance of printed sheets, paper size, including
margins, orientation, and other printing options.

Aspen Plus uses the Number of Pages setting only when you print an entire
drawing or flowsheet section. Aspen Plus superimposes the drawing on a page
layout. The layout is defined by:
• Number of vertical and horizontal pages
• Page orientation
• Paper size

You can use Page Break Preview on the View menu to see where the page breaks
are located on the drawing.

Aspen Plus scales drawings proportionally to fill the page in the limiting
direction (horizontal or vertical), within built-in margins. It does not distort the
drawing to fill the page in both directions.

Specify your settings for printing the flowsheet window on the Page Setup dialog
box:

➤ From the File menu, click Page Setup.

Viewing Page Breaks

You can view the page breaks in order to visualize the layout and adjust what is
going to be printed. You should avoid printing drawings with icons or IDs
spanning page boundaries.

Adjust the position of the drawing on the page by:
• Repositioning the flowsheet objects on the individual pages
• Moving and resizing the page layout frame

You can change the page layout at any time by changing the settings on Page
Setup. Aspen Plus will redraw the page breaks.
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To view the page layout:

1. From the View menu, click Page Break Preview.

2. Complete the Page Setup dialog box or accept the defaults if this sheet has
not been viewed previously.

In the Page Setup dialog box, you can specify the number or horizontal and
vertical pages, the paper size and source, the paper orientation (portrait or
landscape), and the margins

3. When the flowsheet is superimposed on the current page layout, you can
select the borders to move the location of the pages, and you can select a
corner to change the size of the pages relative to the flowsheet.

Note   All the pages must remain equally sized.

4. You can also move elements of the flowsheet such as the unit operation icons,
tables, and annotation to a desired location. In this way, you can determine
what is present in the print area.

Tip   It is often helpful to select Zoom Full from the View menu in order to
view the entire Flowsheet before adjusting the page breaks.

Printing a Flowsheet
To print a flowsheet:

1. Click in the Process Flowsheet Window to make it active.

2. Click the Printer button on the Standard toolbar.

– or –

From the File menu, select Print.

3. Choose the printer and desired settings in the Print dialog box.

4. Click OK.

Printing a Section of Flowsheet
To print a section of flowsheet:

1. From the Flowsheet menu, click Flowsheet Sections.
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2. Choose the flowsheet section you want to print and click OK.

3. From the View menu, click Current Section Only.

4. Click the Printer button on the toolbar.

– or –

From the File menu, select Print.

5. Choose the printer and desired settings in the Print dialog box.

6. Click OK.

Displaying and Printing Attached Objects with
Flowsheet Sections

In a flowsheet divided into sections, when the View only current section option is
on in the Section Object Manager, attached objects display and print with the
section they are attached to.

For example, you can generate a stream table consisting of all the streams in a
section and attach it to a block in the section. If you print the section, the stream
table prints with it. Unattached annotation objects or OLD objects display and
print with all sections. For more information on flowsheet sections, see Chapter 4.

Printing Large Flowsheets
For large flowsheets, it is often necessary to print the flowsheet on multiple
pages. You may also want to only print one flowsheet section at a time.
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To print on multiple pages:

1. From the File menu, click Page Setup.

2. Specify the desired number of horizontal and vertical pages.

3. From the View menu, click Page Break Preview.

4. Select the page borders to move the location of the pages, or select a corner to
change the size of the pages relative to the flowsheet.

Note   All of the pages must remain equally sized.

5. You can also move elements of the flowsheet such as the unit operation icons,
tables, and annotation and arrange them to fit on a desired page.
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15 Managing Your Files

This chapter describes how to manage the files you create when running
Aspen Plus including:
• File formats used during Aspen Plus runs
• Saving Aspen Plus document files
• Exporting Aspen Plus files
• Importing Aspen Plus files
• Saving an Aspen Plus run
• Managing files in a client-server environment
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File Formats in Aspen Plus

These are the major types of files used in Aspen Plus:

File Type Extension Format† Description

Document *.apw Binary Quick restart file containing simulation input and results
and immediate convergence information

Backup *.bkp ASCII Archive file containing simulation input and results

Template *.apt ASCII Template containing default inputs

Input *.inp Text Simulation input

Run Message *.cpm Text Calculation history shown in the Control Panel

History *.his Text Detailed calculation history and diagnostic messages

Summary *.sum ASCII Simulation results

Problem Definition *.appdf Binary Binary file containing arrays and intermediate convergence
information used in the simulation calculations

Report *.rep Text Simulation report

Model Library *.apm Binary User-created model library consisting of pre-configured models or
flowsheets for distribution and re-use.

Embedded Backup File *.apmbd Binary Information on objects such as spreadsheets and pictures
embedded in the Aspen Plus simulation

†
In this context a “text” file is one that you can read using a standard editor such as Notepad®. A binary file cannot be read by
the user. An ASCII file can be opened in an editor, but is formatted to be read by a program, not a person. ASCII files are
portable across different hardware platforms.

Document Files ( *.apw)
Aspen Plus document files contain all input specifications, simulation results,
and intermediate convergence information. If you save a run as a Document file
before you exit from Aspen Plus, the next time you open the run it is in exactly
the same state as when you saved it. If you reopen a run saved as a Document
file, Aspen Plus restarts the calculations using the previous results.

Document files can be opened in the Aspen Plus User Interface and saved.

Disadvantages

Document files (.apw) are not compatible across different versions of Aspen Plus.
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Advantages

For longer simulations, Document files are much quicker to load into and save
from the Aspen Plus User Interface.

Because Document files contain intermediate convergence information, the run
can be started exactly where it was saved. Intermediate results are especially
useful when you save a file while in the process of trying to converge a large
flowsheet.

Backup Files (*.bkp)
Aspen Plus Backup files contain a compact version of your Aspen Plus run. They
occupy much less disk space than files saved in Document format, and are thus
preferable for long-term storage.

Backup files contain all input specifications and simulation results, but no
intermediate convergence information. If you reopen a converged run stored as a
backup file and rerun the simulation, Aspen Plus:
• Reinitializes the streams and blocks
• Reconverges the entire simulation

Backup files are ASCII files. You can use them to transfer runs between:
• Computers
• Versions of Aspen Plus

The advantage of the Backup (.bkp) files over Document (.apw) files is that the
Backup files are upwardly compatible through different versions of Aspen Plus
and are portable. For example, they can easily be emailed.

Backup files can be opened and saved in Aspen Plus. They can also be imported
into a current run, and partial or complete flowsheets can be exported. For more
information, see Exporting Aspen Plus File on page 15-9.

You can import runs saved in Backup format into your current run. Aspen Plus
merges the information and specifications contained in the backup file with your
current run.

For example, you can have two sections of a flowsheet stored in separate backup
files. You can import these two backup files into a single run, merging the two
flowsheet sections.

For information on inserts (partial backup files that you can import at any time),
see Chapter 34.



Managing Your
Files

15-4 Aspen Plus User Guide
Version 10.2

Maintaining Upward Compatibility

When importing a backup file, you can control compatibility between Aspen Plus
versions.

The Upward Compatibility dialog box appears when you open a backup file that
was created with the Aspen Plus simulation engine, or with a previous version of
Aspen Plus.

New features in Aspen Plus Version 10 may mean your results differ from those
of previous versions. To maintain upward compatibility and obtain the same
results as your previous version of Aspen Plus, ignore the new features of Version
10. To do this:

In the Upward Compatibility dialog box, select Maintain Complete Upward
Compatibility.

To use the new features of Version 10:

In the Upward Compatibility dialog box, select Use the Following New Features,
and check the features you want from:
• New pure component databanks
• New property methods
• New built-in binary parameters
• New ADA/PCS procedures
• Calculated molecular weight obtained from formula
• Checking of user-specified sequence

Note If you are opening a file created by Version 9 of the Aspen Plus
user interface, you will get only the option of using the new pure
component databank, PURE10.

Template Files (*.apt)
You can select a Template when creating a new run. Templates set defaults for
some or all of the following:
• Units of measurement
• Property sets for reporting stream properties
• Composition basis for stream reporting
• Stream report format
• Global flow basis for input specifications
• Setting for Free-Water option
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• Selection for Stream-Class
• Property option set
• Required components (such as water)
• Other application-specific defaults

For detailed information on the built-in template and creating templates, see
Chapter 2.

Input Files (*.inp)
Aspen Plus input files are compact summaries of the specifications for a
flowsheet simulation. An input file can include graphical information about the
layout of the unit operation blocks and streams in the Process Flowsheet
Window.

An input file can:
• Be used as the input file for a stand-alone Aspen Plus engine run
• Provide a compact summary of the input specifications for a simulation (for

example, to be included in a report)
• Provide the documentation of record for a simulation study (for example, as

part of the archives for a design project)
• Help expert users diagnose problems

You can generate an Aspen Plus input file from your simulation specifications at
any time. To save an input file, you must export it from the Aspen Plus user
interface.

The input file can be run directly by the simulation engine. Click here for
details.For more information on how to run an input file using the simulation
engine, see Chapter 11.

Import the backup file as described in Importing Aspen Plus File on page 15-10.

Report Files (*.rep)
Aspen Plus Report files document all of the input data and defaults used in an
Aspen Plus run, as well as the results of the simulation. These are text files that
can be read by the user.
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Report files must be exported from the simulation to be saved. Report files
cannot be opened in the Aspen Plus User Interface.

If applicable, the DFMS input file (*.dfm), the Prop-Data file (*.prd) and the
Project file (*.prj) are exported along with the report file.

Summary Files (*.sum)
Aspen Plus Summary files contain all the results from the simulation that are
displayed in the Aspen Plus user interface. Summary files are ASCII format files
used to load the results into the user interface. Summary files can also be used
by other programs to retrieve the results of the simulation.

Summary files must be exported from the simulation to be saved. For more
information, see Exporting Aspen Plus File on page 15-9. Summary files are
automatically generated when running the Aspen Plus simulation engine
standalone. The summary file generated is called runid.sum.

The results included in summary files can be imported in the Aspen Plus User
Interface. For more information, see Importing Aspen Plus File on page 15- 10.

Run Messages Files (*.cpm)
Aspen Plus Run Messages files are text files that include the error, warning, and
diagnostic messages from the run. These are the messages displayed on the
Control Panel during a run. The number of messages and the detail can be
controlled globally on the Setup Specifications Diagnostics sheet. You can also
control the messages locally for each block on the block BlockOptions Diagnostics
sheet.

Run Messages files are similar to history files (*.his). The diagnostic level for
history files and the control panel can be adjusted independently. If you need a
high level of diagnostics, print to the history file (not to the control panel). This
prevents any performance degradation that might result from lengthy
diagnostics on the screen.

Run Messages files must be exported from the simulation to be saved.
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History Files (*.his)
The History file is a text file that includes an echo of the input summary and the
error, warning, and diagnostic messages from the run. The number of messages
and the detail can be controlled globally on the Setup Specifications Diagnostics
sheet. You can also control the messages locally for each block on the block
BlockOptions Diagnostics sheet.

When you select History from the View menu, the Aspen Plus history file is
copied from the host computer to your local computer. Aspen Plus executes your
file editor to view the history file.

A history file cannot be saved or exported from the Aspen Plus User Interface.
Save the file using History from the View menu. A history file is saved
automatically when you save a run as a Document file.

The history file is similar to the Run Messages file. The diagnostic levels for the
history file and the control panel can be adjusted independently. If you need a
high level of diagnostics, print to the history file (not to the control panel). This
prevents any performance degradation that might result from lengthy
diagnostics on the screen.

Opening Aspen Plus Files

You can open an existing Aspen Plus file from within Aspen Plus.

1. From the File menu, click Open.

2. In the Open dialog box, select the file type from the Files of Type list.

3. Enter a filename or select a file from the available list, then click Open.

4. The message “Do you wish to close the current run before opening new run?”,
appears. Click No for the new simulation to be opened in a separate window.
Click Yes to close the current run.

Tip To speed up your search for files or directories, in the Open
dialog-box. click the Look in Favorites button to display a list of
pre-selected directories. Use the Add to Favorites button to place
frequently used directories into this list.
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Using the Favorites List
By default, the Favorites list contains 5 directories that are provided with
Aspen Plus. The files in these directories are designed to assist you in creating a
suitable simulation model in Aspen Plus.

This table shows the directories:

Directory Description

Assay Libraries Petroleum crude assays compiled from literature for  different regions of the world and
selected crude  assays from the Phillips Petroleum Crude Assay Library

Applications Application examples of real world problems covering gas processing, petroleum
refining, chemicals, pharmaceuticals, and metals processing industries

Data Packages Special property data packages for industrially important systems

Examples Selected examples

Electrolyte Inserts Electrolyte data packages for many industrially important systems

Saving a Run

To save a file in Aspen Plus:

1. From the File menu, click Save As.

2. In the Save As dialog box, select the appropriate file type from the Save as
Type list. You can save Document, Backup and Template files.

3. Enter a filename. The file can be saved in any directory.

4. Click Save.

You can save these types of files:

File Type Extension Description

Document .apw Quick restart file containing simulation input and results and intermediate convergence
information

Backup .bkp Archive file containing simulation input and results

Template .apt Template containing default inputs
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Exporting Aspen Plus Files

To generate and export an Aspen Plus file:

1. From the File menu, click Export.

2. In the Export dialog box, select the appropriate file type from the Save as
Type list. Click here to see a summary of the file types you can export.

3. Enter a filename. The file can be saved in any directory.

4. Click Save.

You can export the following types of Aspen Plus files:

File Type Extension Format Description

Backup .bkp ASCII Archive containing simulation input and results

Report .rep Text Report file

Summary .sum ASCII Simulation results

Input .inp Text Simulation input information without graphics

Input File with Graphics .inp Text Simulation input and graphical information

Run Messages .cpm Text Calculation history

Flow Driven Dynamic
Simulation

.spf

.inp
Text Aspen Dynamics input and Aspen Plus input

Pressure Driven
Dynamic Simulation

.spe

.inp
Text Aspen Dynamics input and Aspen Plus input

You can also export just the contents of a Hierarchy block as a backup file. None
of the global information is included in this backup file. To do this:

1. Click  to open the Data Browser.

2. Open Blocks.

3. Click the right mouse button on the Hierarchy block to be exported and select
Export.

4. Enter a filename and click Save.
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Importing Aspen Plus Files

To import an Aspen Plus file:

1. From the File menu, click Import.

2. In the Import dialog box, select the file type from the Files of Type list. Click
here to see a list of the files you can import.

3. Enter a filename. The file can be saved in any directory.

4. Click Open.

5. If the Resolve ID Conflicts dialog box appears, there are objects that have the
same ID as objects in the current run. For information about using the
Resolve ID Conflicts dialog box, see Chapter 38.

Tip To speed up your search for files or directories, in the Open
dialog-box. click the Look in Favorites button to display a list of
pre-selected directories. Use the Add to Favorites button to place
frequently used directories into this list.

You can import the following types of files:

File Type Extension Format Description

Backup *.bkp ASCII Archive containing simulation input and results

Template *.apt ASCII ASCII file used as a template

IK-Cape .ikc ASCII IK-Cape neutral file for physical property information

Summary *.sum ASCII Simulation results

To import the contents of a backup file into a Hierarchy block:

1. Click  to open the Data Browser.

2. Open Blocks.

3. Click the right mouse button on the Hierarchy block, and select Import.

4. In the Import dialog box, select the backup file to be imported, and click
Open.

5. If the Resolve ID Conflict dialog box appears, there are objects that have the
same ID as objects in the current run.
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Deciding How to Store a Simulation
Problem Definition

You can save an Aspen Plus simulation in the following threeways:
• Save the Aspen Plus Document file
• Save the Aspen Plus Backup file
• Export the file as an Input file

This table summarizes the characteristics of the file formats used to store the
simulation problem:

Characteristic Document Backup Input

Simulation Definition (input
specifications)

✓ ✓ ✓

Intermediate Convergence
Information

✓

Results ✓ ✓

Graphics ✓ ✓ ✓

User Readable ✓

ASCII Format ✓ ✓

Readable by Aspen Plus User
Interface

✓ ✓ ✓

Managing Files in a Client-Server
Environment

You can run the Aspen Plus user interface and the simulation engine:
• On the same computer
• On different computers in your network
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Usually, you do not need to be aware of how or where Aspen Plus is installed.
However, you should be aware of some file management issues, described in the
following sections.

The local computer is where the Aspen Plus user interface is running. The host
computer is where the Aspen Plus simulation engine is running.

Specifying the Working Directory on the Host
Computer

If you have not specified a working directory, files created by the Aspen Plus
simulation engine are stored in your default login directory on the host computer.
To specify the working directory where the simulation engine should execute:

From the Run menu, click Connect to Engine.

Saving Files
When you save a run as an Aspen Plus Document (.apw) file using Save or Save
As from the File menu, Aspen Plus creates these files in the following locations:

File Location

runid.apw Local directory where you are running the user interface,
or the directory specified on the Save As dialog box

runid.his Working directory on host computer specified in the Connect to Engine dialog box

runid.appdf Working directory on host computer specified in the Connect to Engine dialog box

View History
To copy the Aspen Plus history file from the host computer to your local
computer:

From the View menu, click History.

Aspen Plus executes your file editor to view the history file.
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Tip If the history file is large, copying the history file to your local
computer can take a long time. In such a case, you should log onto
the host computer and view the file.

Specifying the Text Editor

To specify the text editor:

1. From the Tools menu, click Options.

2. Click the Startup tab.

3. In the Text Editor box, type the name of the editor.

4. Click OK
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Chapter 16

16 Customizing Your Aspen
Plus Environment

Configuration options are default settings that affect how you use Aspen Plus.
For example, configuration options enable you to specify:
• Grid and scale settings
• Default Application Template file
• Which binary databanks are used as defaults

This chapter explains:
• Choosing settings for the current run
• Choosing settings for all runs
• Specifying your default options
• Customizing Application Template files
• Using user model libraries

Choosing Settings for the Current Run

To change your configuration option settings for the current run:

From the You can select

View menu Any command

Tools menu Options

Window menu Any command
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Customizing Settings for All Runs

To create a custom environment for subsequent Aspen Plus runs:

1. Open a blank run.

2. Customize the settings, then exit. You do not need to save the blank run.

Your customized settings are saved in the Windows registry and are used for all
subsequent runs. If you modify any settings, the new settings are used in
subsequent runs.

Note Some settings are saved with the simulation. If a setting that is
saved with a simulation differs from the setting in the registry,
the setting that is saved with the simulation will be used for that
simulation; however, subsequent simulations will use the setting
that is in the registry.
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Choosing View Options
You can change which elements are visible by using the options on the View
menu. Display or hide elements, depending upon what you need at any given
time. These options are available from the View menu:

Click this option To

Toolbar Select the toolbars that are displayed.

Status Bar Select if the status bar on the main window is displayed.

Model Library Select if the Model Library is displayed.

Control Panel Select if the Control Panel is displayed.

Zoom In Magnify a portion of the drawing on the screen. If a Group or Region has been selected, the selected region will be
expanded to fill the screen. When you zoom in on a selected region, the portion of the drawing displayed may not be
exactly what you selected, since proportional vertical/horizontal scaling is maintained at all times.

Zoom Out Shrink the drawing on the screen in order to show more of the drawing or to make room for more blocks or symbols.
As you shrink the drawing, text and some symbols will disappear from the screen due to the screen resolution.
These objects are not deleted, they reappear when you zoom in, and print.

Zoom Full Display the entire drawing as large as possible in the workspace.

Center View Display the selected object in the center of the screen.

Pan Choose a region of the flowsheet to display at the current zoom level.

Bookmarks Create bookmark views or go to a bookmark.

Page Break Preview Select if the page breaks are displayed in the Process Flowsheet window.
For more information see Chapter 14.

Reset Page Breaks Reset page breaks you have defined.

Current Section Only Select if only the current flowsheet section is displayed.
For more information on using flowsheet sections see Chapter 4.

PFD Mode Select whether PFD mode is on or off.

Reset PFD Delete the current PFD mode drawing and create a new one.

Global Data Select if global data is displayed for each stream.
See Results View Options for information about how to customize the global data.

Annotation Select if text annotation on the Process Flowsheet window is displayed.

OLE Objects Select if OLE objects are displayed.
For more information, see Chapter 38.

Input Summary View the input summary.
For more information about the input file, see Chapter 15.

History View the history file.
For more information about the history file, see Chapter 15.

Report View a section of the report file.
For more information about the report file, see Chapter 12.
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Using Toolbars
The buttons on a specific toolbars cannot be customized. However, the toolbars
can be viewed, hidden, or moved to another location.

Toolbar settings are not saved with the simulation file. The toolbar configuration
is saved in the registry and will be used for all subsequent files that are opened
in Aspen Plus.

These toolbars are available:

Toolbar Buttons

Standard Standard Windows buttons used for basic operations
New, Open, Save, Cut,  Print, Print Preview, Copy, Paste, Help

Data Browser Buttons used to display the next required step, the Data Browser,
or one of its various elements

Simulation Run Buttons used to control the execution of the simulation

Process Flowsheet (PFS) Buttons used to manipulate the unit operation, graphical or
text objects located in the process flowsheet

Dynamic Buttons used for dynamic simulations using Aspen Dynamics

Detherm Buttons used for Detherm application

Section Buttons used to manipulate flowsheet sections

CAPE-OPEN Buttons used to import and export CAPE-OPEN Property Packages

Draw Buttons used to add or modify graphical or text objects

Viewing Toolbars

You can choose which toolbars are shown in the main window of Aspen Plus. To
do this:

1. From the View menu, click Toolbar.

2. Select the check box of each toolbar you want to view.
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The toolbars that are checked are those that appear by default.

Moving Toolbars

Toolbars can be positioned elsewhere in the window. To do this:

1. Click and hold down the mouse button on the edge of the toolbar you wish to
move.

2. Drag the toolbar to the desired location, which can be either:
• On any edge (top, bottom, or sides) of the Aspen Plus window
• In the center of the window

Specifying Default Options

There are various options you can set as defaults. To do this:

➤ From the Tools menu, click Options.

The Options dialog box appears.
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This table shows which tab to use:

To Use this tab

Specify general options such as the default method to save
documents and if inline Fortran is checked for syntax errors

General

Specify the databank search order Component Data

Select what information is included when Global Data is
displayed

Results View

Control various naming, display and placement options on the
process flowsheet

Flowsheet

Set and display the grid and scale on the process flowsheet
window

Grid/Scale

Specify the default fonts, grid style, line style, marker size, and
time stamp components used when creating plots

Select if a legend and time stamp are displayed by default.

Plots

Select run options for interactive runs and specifications for a
remote server

Run

Specify startup options for a new flowsheet such as Run Type,
application template, and working directory

Startup

Using the General Tab
From the Tools menu, click Options, then click General. The General tab is used
to specify general options related to running simulation, saving Aspen Plus
documents, and making OLE links between an Aspen Plus run and another
application.
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The following parameters are available on the Tools Options General tab:

Use this box To Saved with Simulation?

Allow run only
when input is
complete

Allow a run only when input is complete

Turning off this option allows you to initiate an interactive or batch run even if the
status in the toolbar is not Required Input Complete.

This option is primarily for advanced users who are familiar with keyword input
language.

Yes

Check inline
Fortran for
syntax errors

Check inline Fortran for syntax errors

When this option is checked, basic Fortran syntax error checking is done on all the
Fortran and Declarations sheets. This option sometimes needs to be turned off when
advanced Fortran is used.

Yes

Accounting
information
required to
complete input

Allow a run only when accounting information has been completed.

When this option is checked, you are required to specify accounting information on
the Setup Specifications Accounting sheet. The accounting information includes an
account number, a project ID, a project name, and a user name. This is stored for
the run by the Aspen Plus Accounting System, if it is active for your installation.

No

Always create
backup copy

Always create backup copy.

When this option is checked, an Aspen Plus backup format file (*.bkp) is created whenever an
Aspen Plus document file (*.apw) is saved. This is used as an additional backup safety
mechanism. The document file (*.apw) allows you to quickly restart previously saved
simulation, using a binary file. The backup file (*.bkp) stores the same run information in a
condensed ASCII file.

No

Save
Aspen Plus
documents as

Specify the default method to save documents.

Saving documents as document files (*.apw) allows you to quickly restart previously saved
simulation, using a binary file. Saving as backup files (*.bkp) stores the same run information in
a condensed ASCII file.

No

Copy buffer
format

Specify what information is included when a cell is copied into the copy buffer.

Every variable, when copied for OLE links, occurs with four attributes: Value, Units, Label, and
Basis. You can set the default attributes here, or you can specify the attributes you need, from
the Edit menu by clicking Copy with Format.

Yes

Using the Component Data Tab
Use the Component Data tab to:
• Change the databanks search order
• Choose which databanks are searched
• Copy regression and estimation results onto Parameters forms
• Generate input language using component name or component alias
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Changing Databanks Search Order

The order in which the pure and binary components databanks are searched can
be changed using the Tools Options Components Data dialog box.

To change the pure and binary component databank search order:

1. From the Tools menu, click Options.

2. Click the Component Data tab.

3. In the Searched list, click the databank that you want to reorder.

4. Click the up or down arrow to reorder the databank.

The databank at the top of the list is searched first. The data found first for a
component or a component pair is the data that is used in the simulation.

Pure Component Databank Search Order—This specifies which pure component
databanks Aspen Plus will search and the search order for all simulations.

The order in which the databanks are listed is the order in which Aspen Plus
searches for data. For a specific simulation run, you may change the list and
order on the Components Specifications Databanks sheet.

Binary Databank Search Order—This specifies which binary parameter
databanks Aspen Plus will search and the search order for all simulations.

The order in which the databanks are listed is the order in which Aspen Plus
searches for data. These databanks contain:
• Binary parameters for equation of state models.
• Binary parameters for Wilson, NRTL, and UNIQUAC models.
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• Henry’s law constants.
• Binary and pair parameters for electrolyte NRTL models.

For a specific parameter in a particular run, you may change the list and order
on the Properties Parameters Binary Interaction and the Properties Parameters
Electrolyte Pair folders.

Choosing Which Databanks are Searched

To move a databank to the Searched list:

1. Click the databank you wish to move.

2. Click the right arrow to move the databank to the Searched list.

To move a databank from the Searched list:

1. Click the databank you wish to move.

2. Click the left arrow to move the databank to the Not Searched list.

To move all of the databanks at once from one list to the other:

1. Click the appropriate double arrow.

2. Reorder the databanks using .
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Example of Reordering Databanks

For pure component data, the PURE93 databank is searched first, the
AQUEOUS databank is searched second and then, the SOLIDS, INORGANIC,
and COMBUST databanks are searched, in that order.

The AQU92, ASPENPCD, PURE10, and PURE856 databanks are not searched at
all.

For binary data, the ENRTL-RK databank is searched followed by the VLE-IG,
VLE-RK, VLE-HOC, LLE-LIT and LLE-ASPEN databanks.

Copying Regression and Estimation Results

You can retrieve regression or estimation parameter results and display them on
the Parameters forms. To do this:

➤ On the Components Data tab, check the Copy regression and estimation
results onto Parameters forms box.

The parameters will be used in all subsequent runs.
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When this check box is clear, the parameters are available on the appropriate
Physical Properties Parameters form, using the drop down list, but are not
displayed on the forms. The parameters will not be used in subsequent runs.

Changing Defaults for Generating Input Language

You can use the Components Data tab to select whether you generate input
language using Component name or Component alias.

Use the Formula column (up to 12 characters) or the Component Name column
(up to 32 characters) on the Components Specifications Selection sheet to
generate the COMPONENTS paragraph in the Aspen Plus input file.

Using the Results View Tab
Global data such as stream temperature and pressure can be viewed by selecting
Global Data from the View menu. The data displayed can be customized using
the Tools Options Results View tab.

For more information on using global data see Chapter 14.

The following parameters are available on the Results View tab:

Use this box To Saved with simulation?

Output Units of
Measurement

Select the units of measure for the global data output. No

Heat/Work
Variables

Specify if Heat or Work is shown (if available for streams) when global data is
viewed.

Use the Format box to specify the variable format.

Yes

Temperature Specify if Temperature is shown (if available for streams) when global data is
viewed.

Use the Format box to specify the variable format.

Yes

Pressure Specify if Pressure is shown (if available for streams) when global data is viewed.

Use the Format box to specify the variable format.

Yes

Total Flow
Rate

Specify if Total flow rate is shown (if available for streams) when global data is
viewed.

Use the Format box to specify the variable format.

Yes

Duty/Power Specify if Duty or Power is shown (if available for heat and work streams) when
global data is viewed.

Use the Format box to specify the variable format.

Yes

†
These are shown if available for streams when global data is viewed.
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Format for Numbers

You can control the format of global data on the process flowsheet window. There
are three conversion formats:
• %-xx.yye
• %-xx.yyf
• %-xx.yyg

This table explains the variables:

Variable Explanation

% Percent character. Lead character for format specification.

- Optional minus sign, which left-justifies the number.
Without the minus sign, the number is right-justified.

Xx A digit string specifying a minimum field length for the converted number.
The number takes at least this much space to print, and more if necessary.

Yy A digit string specifying the precision, (that is, the number of digits)
to be printed to the right of the decimal point.

E Number is converted to the form [-]a.bbbbbbbe[+]cc.
Length of b is specified by yy (Default is 6).
Use upper case E in the format specification for upper case E in the printed numbers.

f Number is converted to the form [-]aaa.bbbbbb.
Length of b is specified by yy (Default is 6).

G The shorter of %e or %f is used.
Use upper case G in the format specification for upper case G in the printed numbers.

The recommended format is %0.f which prints whole numbers.

Other common formats used in stream tables are:

Format Explanation

%10.0f Whole numbers, with no decimal digits or exponents.

%10.nf Numbers without exponents and with n digits to the right of the decimal point,
if space permits. Decimal points line up, unless decimal digits have been
eliminated in some numbers.

Using the Flowsheet Tab
Use the Tools Options Flowsheet tab to set various naming, display, and
placement options on the Process Flowsheet.
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The following parameters are available on this tab:

Use this box To Saved with simulation

Automatically Assign Block Name
with Prefix

Have blocks automatically assigned a name
beginning with the specified character string. For
example, if B is entered, the blocks will be named
B1, B2, B3, etc.

When this option is off, Aspen Plus will prompt
you to enter an ID each time a block is created.

Yes

Display Block Name Have future block names displayed with the icon
on the Process Flowsheet.

Yes

Automatically Assign Stream Name
with Prefix

Have streams automatically assigned a name
beginning with the specified character string.
When this option is off, then Aspen Plus will
prompt you to enter an ID each time a stream is
created.

Yes

Display Stream Name Have future stream names displayed on the
streams in the Process Flowsheet.

Yes

Automatically Place Blocks When
Importing

Automatically place blocks when importing a
flowsheet

Use this option to specify whether or not
Aspen Plus automatically places any new blocks
when you import an Aspen Plus backup file that
does not contain graphics layout information.

When this option is off, the Unplaced Blocks menu
appears showing blocks that are not in the process
flowsheet .  You can later place these blocks
automatically or manually. Blocks and streams
already in the drawing and whose connectivity
has not changed are not affected by this option.

For more information on  placing and unplacing
blocks, see Chapter 4. For more information on
importing a flowsheet, see Chapter 15.

Yes

Lock Block Spacing Factor at Lock the block spacing factor at a specified value.
A spacing factor of 2.5 is generally appropriate for
flowsheets drawn with the block icons. For
flowsheets drawn with pictorial icons, a factor of
1.5 is often better.

No

Label Size Scale Factor Control the size of block and stream IDs for
printing.

When Global Data is on, this factor also controls
the size of the displayed global data values and
legend box.

This is a relative factor. Use a larger value for
larger IDs and global data values. A factor
between 2-3 is generally appropriate when
printing relatively large flowsheets.

Yes
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Using the Grid/Scale Tab
Use the Tools Options Grid/Scale tab to set and display the grid and scale on the
process flowsheet window.

The following parameters are available on the Grid/Scale tab:

Use this box To Saved with simulation?

Show Scale Display a scale at the top and left of the process flowsheet window Yes

Show Grid Display the grid in the process flowsheet window.
The grid lines can help you position objects, especially graphics and text objects.

Note  For the grid to be displayed, you must be zoomed in enough for the grid
points to be distinguishable.

Yes

Snap to Grid Align objects in the process flowsheet window to the grid when they are placed,
moved, or resized

No

Grid Size Specify the interval between grid points.

When Snap to grid is on, inserted graphic objects
are snapped to the grid lines.

If you are zoomed in, you may want to decrease the grid resolution factor to position
objects precisely.

The grid sizes to choose from are 0.2, 0.1, 0.05, 0.025, 0.0125

Yes

Zoom Out
Scale Factor

Set the degree for zooming in or out on the process flowsheet

Values range from 1.0 to 10.0. A value of 10.0 will zoom out in greater increments
than a value of 1.0.

No

Scroll Step
Size

Set the percentage for scroll bar stepping†

Scroll step affects only the scroll bars for the process flowsheet.

No

† 
A scroll bar step is the amount that the screen scrolls with one mouse click on a scroll bar arrow.

Using the Plots Tab
Use the Tools Options Plots tab to specify the default fonts, grid style, line style,
and marker size used when creating plots. This tab is also used to select if a
legend and time stamp are displayed by default.

The following parameters are available on the Tools Options Plots tab:

Use this box To Saved with simulation

Default Fonts Change the default font for the Title, Axis label, Axis scale, and Annotation No

Grid Style Define the type of grid for the plot. Mesh, Horizontal, Vertical, or No grid can be
selected.

No

Line Style Select the line style for the data curves. Lines & markers, Lines, or Markers can be No
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selected.

Marker Size Select the size for the markers. Values from 1-20 can be selected. No

Show Legend Show a legend No

Show Time
Stamp

Show a time stamp No
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Using the Run Tab
Use the Tools Options Run tab to select run options for interactive runs and
specifications for a remote server.

The following parameters are available on the Tools Options Run tab:

Use this box To Saved with Simulation

Express Run Use Express Run for maximum simulation speed when you run the Aspen Plus
simulation engine on a PC, or interactively on other platforms.

Express Run turns flowsheet animation off, and changes the Control Panel
(terminal) message levels to 0.

You can change the Control Panel message levels on the Setup Specifications
Diagnostics sheet.

If you change the Control Panel message levels on this sheet, and then turn on
Express Run, Aspen Plus will not save the values you entered. When you turn
Express Run off, all Control Panel message levels are set to 4.

Interactively
Load Results

Load results only for objects you select in an interactive run

When Interactively Load Results is off, Aspen Plus loads all simulation results into
the Graphical User Interface at the end of the simulation.

Interactively Load Results speeds up processing time by only loading the results you
are interested in. It is useful if you run a simulation several times, but are only
interested in the results on a few particular forms.
When Interactively Load Results is on, you can still load all results using Check
Results from the Run menu.

Interactively Load Results only works with the Flowsheet Run type.

Yes

Animate
Flowsheet
During
Calculations

Highlight blocks as they are executed during an interactive run

Turning animation off can sometimes result in a slight increase in simulation speed.

Yes

Edit Keyword
Input Before
Starting
Calculations

Edit the input language file before beginning an interactive run

Aspen Plus displays the generated input language file in your editor before starting
interactive calculations. This gives you a chance to make small modifications or
additions to the file, or to diagnose problems. These modifications will not be
reflected on the input forms.

This feature is intended for advanced users who are familiar with keyword input
language.

No

Server Type Specify the Server type for remote server. No

Server Name Specify the name of the remote server. No

Username Specify the Username for the account on the  remote server. No

Working
Directory

Specify the working directory on the remote server. No
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Using the Startup Tab
Use the Tools Options Startup tab to specify startup options for a new flowsheet.

The following parameters are available on the Tools Options Startup tab:

Use this box To

Run Type Select the default startup Run Type.

Application Template Select the default application template

Working Directory Select the default working directory for Aspen Plus simulation runs. All new
files will be created in the specified working directory.

This does not affect any existing files that you open - all the run files,
including temporary ones, will be created in the directory where the file is.

Enable forms for layered products Enable the forms for Aspen Plus layered products

The forms for BatchFrac, RateFrac, Aspen Dynamics, and POLYMERS
PLUS can be enabled.

This option is not available if the layered product is not installed.

When the Aspen Pinch checkbox† is selected, Aspen Plus calculates
mixture properties for Aspen Pinch when there are multiple feeds to a block.

Text Editor Select the default text editor

Specify the text editor to use for editing ASCII files that are obtained from
the View Input Summary, History and Report commands from the View
menu.

Print Text File Command Select the command used to print

†
When the Aspen Pinch checkbox is selected, Aspen Plus calculates mixture properties when there are multiple feeds to a
block. Then Aspen Pinch will use these mixture properties rather than mixing the streams itself. This option is useful when
you have distillation models with interheaters or intercoolers or feeds to condensers or reboilers and the heating or cooling
curve is non-linear. This option can also be used if there are stream mixing (flash) problems in Aspen Pinch. The results are
available only in the Variable Explorer, they are not included in the normal simulation results.

Using the Window Menu

The following parameters are available on the Window menu:

Use this option To

Cascade Create a cascade of all of the open windows

Tile Tile all of the open windows

Arrange Icons Arrange the icons of any minimized windows

Normal Display the Process Flowsheet in a normal window. The Process Flowsheet window can be moved,
brought to the top and minimized.
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Flowsheet as Wallpaper Always keep the flowsheet fully open at the back of the program window

Flowsheet as Wallpaper can only be used if Workbook Mode is off.

Workbook mode Select if the Windows are displayed using Workbook mode

Workbook mode can only be used if Flowsheet as Wallpaper is off.

Using Workbook Mode
Use Workbook mode to help organize all of your open windows.

In Workbook mode, each window has a tab that appears at the bottom of the
screen. This makes it easy to see which windows are open.

To use Workbook mode:

➤ From the Window menu, click Workbook Mode.

To make the desired window current:

➤ Click the appropriate tab at the bottom of your screen.
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Tip You can also select any visible part of a window behind the
current window by clicking it.

Customizing Application Template Files

An Application Template file contains simulation defaults commonly used by
specific industries or companies. You can select an Application Template when
you create a new run. You can use and modify a built-in file, or you can create
your own Application Template files. For detailed information on the Application
templates, see Chapter 2.

Use the built-in Application Templates as a guide when creating your own
customized Application Template files.

There is no limit to the amount of information that can be included in a template:
setup information, components, unit sets, property specifications, and even unit
operation models can all be saved in a template if desired. Too much information
may be inconvenient; however, objects or specifications in a template can be
deleted if they are not needed in a simulation.

If you want to customize the stream summary format, you will need to create or
modify a TFF file. For more information on how to create a TFF file, see Chapter
36.

Note Application Template files are not intended for problem
specifications, such as when you want to save defaults or partial
specifications for a particular process or unit. In such cases,
create a backup file or an insert instead of an Application
Template file.

Saving a Template File

To save an Aspen Plus template file:

1. From the File menu, select Save As.

2. Select Aspen Plus Templates (*.apt) from the Save as Type list.

3. Select the directory and enter a filename. The file can be in any directory.
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4. Click Save.

Tip If you save your customized templates in a folder inside the
Templates folder, they will appear as a separate tab on the New
dialog box.

Tip The format for a Aspen Plus template file is the same as for a
backup file; therefore, it is possible to create a template from a
backup file by simply changing the extension from .bkp to .apt.

Importing a Template File

To import an Aspen Plus template file:

1. From the File menu, select Import.

2. Select Aspen Plus Template (*.apt) from the Files of Type list.

3. Select the directory and enter a filename. The file can be in any directory.

4. Click Open.

5. If the Resolve ID Conflict dialog box appears, there are objects that have the
same ID as objects in the current run. For information on the Resolve ID
Conflict dialog box, see Chapter 38.

About User Model Libraries

Aspen Plus has the ability to create custom templates in user model libraries.
These libraries, which are stored as .apm files, allow you to add custom models to
the Model Library displayed in Aspen Plus, which may include multiple blocks,
streams, block and stream specifications, components, flowsheeting options like
Design-Spec and Fortran blocks, and almost any other Aspen Plus feature. PFD
diagrams, stream routing information, embedded objects, embedded links, and
custom user graphics drawn on the process flowsheet are not saved in .apm files
when they are first created.
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These custom templates may be added to a flowsheet in the same manner as any
other block. If a template contains anything besides a single unit operation
model, each instantiation of the model will appear on the flowsheet within a
Hierarchy block. If the custom template is created with the Multi Record Custom
User Model selection, then a hierarchy block will always be created when a
template is instanced.  By default, if you select multiple blocks or streams and
create a template, it will be a Multiple Record template. When a template is
added to the flowsheet, the data is from the template is copied into the flowsheet,
not linked to the template. Subsequent changes in either the flowsheet or the
template will not affect the other.

Creating and Manipulating User Libraries

To create a new user library:

1. Select New from the Library menu.

2. Specify a name for the library in the Display Name field.

3. Specify a filename for the library, and click the Create button.

4. From the Library menu, select the name of the new library, then Edit. The
Model Library Editor for the new library appears.

5. From the Categories menu, select New, and enter the name for the tab for the
new category. The new tab appears in the Model Library Editor.

To change the list of referenced libraries:

1. From the Library menu, select References...

2. Select the check boxes for libraries you wish to use, and clear the check boxes
for libraries you do not wish to use.

3. To add a library not displayed, click the Browse button and select the file
containing the library.

4. To reorder the displayed libraries, select the name of a library you wish to
reorder and click either of the Priority buttons.

5. Click OK when done.

6. To save these settings, from the Library menu, select Save Default.
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Tip Multiple users can share a set of user model templates which are
accessible via a public file server. Each user should perform this
procedure to access the templates.

To modify the arrangement of models in user libraries:

From the Library menu, select the name of the library, then Edit. The library
opens in the Model Library Editor.

Note The library must be writable in order for you to change it.

• To move a model from one category to another, select the model, then select
Move from the Model menu. Choose the new category for the model from the
dialog box, and click OK.

• To copy a model to another user library, select the model, then select Copy to
User Library from the Model menu. See To add a new model to a user
library:, this chapter, for more information.

• To add a new category, select New from the Category menu, then enter a
name for the new category.

• To delete a category, select its tab, then select Delete from the Category
menu. Any models in that category will be moved to the Uncategorized
category.

• To save a modified user library, from the Library menu, select the name of
the library, then Save.

To check or change the writable status of a user library:

From the Library menu, select the name of the library.  In the submenu,
Writable will be checked if the library is currently writable.  Select Writable to
change the writable status.

To add or remove categories from the display in the
Model Library:

1. From the Library menu, select Palette Categories...

2. Select the check boxes for categories you wish to display, and clear the check
boxes for categories you do not wish to display.

3. To reorder the displayed categories, select the name of a category you wish to
reorder and click either of the Priority buttons.

4. Click OK when done.

5. To save these settings, from the Library menu, select Save Default.
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Adding Models to User Model Libraries
To add a new model to a user library:

1. Define the blocks, streams, and other items for the new model.

2. Ensure that the library is referenced and writable.

3. Select the model(s) from the process flowsheet to add to the library.

4. From the Library menu, select Add Block. The User Model Library Wizard
appears. Click Next.

5. If there is more than one writable user library, select one and click Next. If
there is only one writable library, you will not see this screen.
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6. Choose a category for the new model. These categories are the tabs that
appear in the Model Library. To create a new category, click the Create New
Category button, enter a name, and click OK. Select the category and click
Next.

7. Select whether the block will be a Single or Multiple record template.
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Note If there are multiple records selected, you will not see this screen.

8. Type a name for the new model.
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9. Choose which objects to include in the new model. You may choose to delete
any unwanted items or to add items which are referenced by items currently
selected. Click Finish when done.

10. The new model should appear in its own category in the Model Library.

To edit the contents of a model in a user library as an
Aspen Plus simulation:

1. Start new simulations, select More Files….

2. In the File Types field, select Aspen Plus User Model Libraries (*.apm).

3. Select the template you wish to edit. The model opens as an Aspen Plus
simulation.

4. Make the desired changes in the model.

5. From the File menu, choose Save. The updated model is saved to the user
library.
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To add models and streams to a model in a user library
incrementally:

1. Define the blocks, streams, and other items to append to the library.

2. Ensure that the library is referenced and writable.

3. Select the model(s) from the process flowsheet to add to the library or select
the record from the databrowser and select Append to Template….

4. The User Model Library Wizard appears. Click Next.
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5. Choose a custom model type to append record(s) to and click Next.

6. Choose which objects to include in the new model. You may choose to delete
any unwanted items or to add items which are referenced by items currently
selected. Click Finish when done.
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Changing Icons for Models in User Libraries

To add, change, and delete icons for a model in a user
library:

1. Open the user library for editing.

2. Select the model in the Model Library Editor.

3. From the Model menu, select New Icon... to open the Icon Editor to create a
new icon for this model.

4. If more than one icon exists for the model, click the arrow to the left of the
model's current icon on the Model Library Editor to change the currently-
selected icon.

5. From the Model menu, select Edit Current Icon... to open the Icon Editor to
change the currently-selected icon.

6. From the Model menu, select Delete Current Icon to delete the currently-
selected icon. If the model has only one icon, that icon cannot be deleted.

Using the Icon Editor

In the Icon Editor, use the drawing toolbar to add text, lines, rectangles,
arbitrary polygons, circles, and arcs to the icon by clicking on the appropriate
drawing tool and clicking in the drawing area to specify the location and size of
the drawing objects. The list on the left side of the Icon Editor includes all the
defined ports for the block. Click one of these and click on the drawing area to
associate the port with a specific location on the icon.

You can also select objects already present in the drawing area and drag them
around, or resize them using their resize handles, or delete them by pressing the
Delete key.

There are also three special objects which are always pre-defined in the icon
editor. The green cross enclosed in a diamond is used to indicate the default
location for the block name. The two blue arrows are universal feed and product
ports. These ports represent feed and product ports which are not otherwise
specified for the block. If you cannot locate these objects, from the View menu of
the main Aspen Plus window, select Zoom, then Zoom Full.
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When you are satisfied with the icon's appearance, or if you would like to undo
your changes, close the Icon Editor. Aspen Plus will ask whether to save your
changes.
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17 Convergence

This chapter includes the following topics about convergence:
• Flowsheet recycles and design specifications
• Convergence Options
• Specifying tear streams
• User-defined convergence blocks
• Convergence Methods
• User-defined convergence order
• Specifying the calculation sequence
• Initial guesses
• Flowsheet sequencing
• Checking results
• Control panel messages
• Strategies for flowsheet convergence

Flowsheet Recycles and Design
Specifications

Aspen Plus performs flowsheet calculations using the sequential modular
method. Each unit operation block is executed in sequence. The calculated output
streams of each block are used as feed to the next block.

Flowsheets with recycle loops, design specifications, or optimization problems
must be solved iteratively. Execution requires that:
• Tear streams are chosen. A tear stream is a recycle stream with component

flows, total mole flow, pressure, and enthalpy all determined by iteration. It
can be any stream in a loop.
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• Convergence blocks are defined to converge the tear streams, design
specifications, or optimization problems. Convergence blocks determine how
guesses for a tear stream or design specification manipulated variable are
updated from iteration to iteration.

• A sequence is determined, which includes all of the unit operation and
convergence blocks.

If you do not specify the tear streams, convergence blocks, or sequence,
Aspen Plus determines them automatically. Every design specification and tear
stream has an associated convergence block. The Aspen Plus generated
convergence block names begin with the character "$". User-defined convergence
blocks should not begin with the character "$".

Aspen Plus automatically determines any additional specifications needed to
execute the flowsheet. By default, Aspen Plus also checks the user-specified
sequences to ensure that all loops are torn.

Convergence specifications you can make are:

If you want to specify Use this Convergence form For more details see this section in this chapter

Convergence parameters and/or methods for
convergence blocks

 Conv Options Convergence Options

Some or all of the tear streams needed for
system-generated convergence blocks

Tear Specifying Tear Streams

Some or all of the convergence blocks needed Convergence Specifying User-Defined Convergence Blocks

Convergence order for some or all of the user-
defined convergence blocks

Conv Order Specifying Convergence Order

Sequence for all or part of a flowsheet Sequence Specifying the Calculation Sequence

Convergence Options

Use the Convergence ConvOptions sheets to specify the following for convergence
blocks:
• Tear Convergence tolerance
• Convergence methods for tear streams, design specifications, and

optimization problems used in convergence blocks generated by Aspen Plus
• Parameters that affect sequencing
• Convergence parameters for each method. The specified parameters are used

as defaults for convergence blocks you define and convergence blocks
generated by Aspen Plus.
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Specifying Tear Convergence Parameters
A tear stream is converged when the following is true for all tear convergence
variables:

tol
X

XXtol
assumed

assumedcalculated ≤−≤−

For streams, the default convergence variables are total mole flow,all component
mole flows, pressure, and enthalpy. When the Trace Option is Cutoff (specified on
the Convergence ConvOptions Defaults TearConvergence sheet), Aspen Plus
bypasses this convergence test for components that have a mole fraction less
than the Trace threshold. The default Trace threshold is Tolerance/100. The
alternative trace option, Trace-option = Gradual, adds a 100*Trace threshold
term to the denominator. This setting gradually relaxes the convergence test for
trace components.

To specify tear convergence parameters for convergence blocks:

1. From the Data menu, point to Convergence, then Conv Options.

2. Click the Tear Convergence sheet.

3. Specify tolerance and other convergence parameters, such as Trace Threshold
and Trace Option.
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The following parameters are available on the Tear Convergence sheet:

Field Default To

Tolerance 0.001 Specify Tear convergence tolerance

A tear stream is converged when the following is true for all stream variables:

− ≤
−

≤tol
X X

X
tolcalculated assumed

assumed

Trace
Threshold

Tolerance/100 Specify the trace component threshold

Aspen Plus bypasses this convergence test for components that have a mole
fraction less than the Trace threshold.

Trace Option Cutoff Select the Convergence test option for trace components. Trace option =
Gradual adds 100*TraceThreshold term to the denominator. This setting
gradually relaxes the convergence test for trace components.

Component
Group

All components Identify the Component group ID for components to be converged in tear streams

Component groups are defined on the Components Comp-Group form (see
Chapter 6). Use a component group when you know that some components have
zero or constant flow rates. A Component Group may cause convergence
problems if the unconverged components have significant flow.

Component group specifications are intended primarily for use with the matrix
convergence methods (Broyden, Newton, and SQP) to reduce the matrix size
and the number of numerical derivative perturbations.

State Pressure & Enthalpy Select the State variables to be converged

You can select a State option other than the default (Pressure and enthalpy)
when pressure is known to be constant or enthalpy is not calculated
(mass-balance-only simulations).

State specifications are intended primarily for use with the matrix convergence
methods (Broyden, Newton, and SQP) to reduce the matrix size and the number
of numerical derivative perturbations.

Restore Tears
on Error

checked Restore tear to last guessed value when there is a convergence error.

Flash Tear
Streams

checked Flash tear streams after being updated by the convergence block.

Check Flash Tear Streams if you access the temperature, density or entropy of
the tear stream through in-line Fortran or Calculator blocks, or if you need to see
or use intermediate or partial convergence results. Do not check Flash Tear
Streams if you want to save calculation time or if you do not need intermediate
convergence results. Flashing tear streams is independent of the convergence
method, with one exception. If Chemistry is associated with the tear stream, then
the default is not to flash for tear streams, irrespective of your selection.

Diagnostics Display Maximum Error /
Tolerance

Specify whether tables of all variables or only the variable with the maximum
error should be generated
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Specifying Default Methods
You can specify the numerical methods to be used by the system-generated
convergence blocks. See Convergence Methods, this chapter, for information on
the numerical methods.

To specify the numerical methods to be used by the system-generated
convergence blocks:

1. From the Data menu, point to Convergence, the Conv Options.

2. Select the Default Methods sheet.

3. You can specify the numerical methods to be used by the convergence blocks.
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The following parameters are available on the Default Methods sheet:

Field Default To specify the convergence method for system-generated

Tears Wegstein Tear convergence blocks
The other methods available are Direct, Broyden, and Newton.

Single Design Spec Secant Single design-spec convergence blocks
The other methods available are Broyden and Newton.

Multiple Design
Specs

Broyden Multiple design-spec convergence blocks
The other method available is Newton.

Tears & Design
Specs

Broyden Combined tears and design-specs convergence blocks
The other method available is Newton.

Optimization SQP Optimization convergence blocks

Specifying Sequencing Parameters
You can specify parameters to control tear stream selection and automatic
sequencing.

To specify the tearing and sequencing parameters:

1. From the Data menu, point to Convergence, then Conv Options.

2. Select the Sequencing sheet.

3. You can specify the tearing and sequencing parameters.
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The following parameters are available on the Sequencing sheet:

Field Default To specify

Design Spec Nesting Inside Whether design specifications should be nested inside tear stream loops,
outside tear stream loops, or converged simultaneously with tear streams

Design Spec Nesting does not apply to convergence blocks specified in the
Convergence Order form.

When the tear of an outer loop is recalculated in an inner loop, the actual
sequence generated may not strictly follow the loop-order preference
specified in the Design Spec Nesting and User Nesting fields.

User Nesting Outside User Nesting lets you specify a preference for whether convergence blocks
specified on the Conv Order form should be nested inside or outside other
convergence blocks (user-defined or system-generated)

The User Nesting field has precedence over the Design Spec Nesting field.

When the tear of an outer loop is recalculated in an inner loop, the actual
sequence generated may not strictly follow the loop-order preference
specified in the Design Spec Nesting and User Nesting fields.

Variable Weight 1 Tear variable weighting factor for tearing algorithm

If Variable Weight is a large number, the tearing algorithm minimizes the
number of torn variables.

Loop Weight 1 Loop weighting factor for tearing algorithm

If Loop Weight is a large number, the tearing algorithm minimizes the
number of loops torn.

Tear Fortran Export Variables not checked Whether Fortran block variables can be torn when Fortran blocks appear in
feedback loops

See Chapter 19, Calculator, in the section, Converging Loops Introduced by
Calculator Blocks for more information and an example

Check Sequence checked Whether Aspen Plus checks a user-specified sequence to ensure that all
loops are torn

Specifying Convergence Method Parameters
You can specify additional parameters for each numerical method. Select the
appropriate tab for the convergence method. See Convergence Methods, this
chapter, for information on the numerical methods.

To specify the additional parameters:

1. From the Data menu, point to Convergence, then Conv Options.

2. In the left pane of the Data Browser window, select the Methods form.
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3. Select the appropriate sheet for the convergence method.

4. Specify the parameters for that method.

Specifying Tear Streams

Use the Tear Specifications sheet to identify tear streams to be converged by
system-generated convergence blocks. If you specify an incomplete tear set for
your flowsheet, Aspen Plus automatically chooses the remaining set of streams.
If you specify a redundant tear set (too many tear streams), Aspen Plus may
ignore some tears or find an inefficient sequence.

To specify a tear stream:

1. From the Data menu, point to Convergence, then Tear.

2. In the Stream field, use List and select a stream ID.
The stream must be in a recycle loop in the simulation flowsheet.
Note  When a Calculator block is in a recycle loop, you can tear variables
designated as Export Variables.

3. Specify any of the remaining optional fields, as you choose.
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The following parameters are available on the Tear Specifications sheet:

Field Default To

Tolerance 0.001 Specify Tear convergence tolerance

A tear stream is converged when the following is true for all stream variables:

− ≤
−

≤tol
X X

X
tolcalculated assumed

assumed

Trace Tolerance/100 Specify the trace component threshold

Aspen Plus bypasses this convergence test for components that have a mole
fraction less than the Trace threshold.

Component
Group

All components Identify the Component group ID for components to be converged in tear
streams

Component groups are defined on the Components Comp-Group form (see
Chapter 6). Use a component group when you know that some components
have zero or constant flow rates. A Component Group may cause
convergence problems if the unconverged components have significant flow.

Component group specifications are intended primarily for use with the matrix
convergence methods (Broyden, Newton, and SQP) to reduce the matrix size
and the number of numerical derivative perturbations.

State Pressure & Enthalpy Select the State variables to be converged

You can select a State option other than the default (Pressure and enthalpy)
when pressure is known to be constant or enthalpy is not calculated
(mass-balance-only simulations).

State specifications are intended primarily for use with the matrix
convergence methods (Broyden, Newton, and SQP) to reduce the matrix size
and the number of numerical derivative perturbations.

Initial Estimates for Tear Streams
You can use the Stream sheets to provide an initial estimate for the tear stream.
An initial estimate generally aids recycle convergence, and is sometimes
necessary, especially for recycle loops involving distillation blocks. For more
information on specifying streams see Chapter 9.
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Specifying User-Defined Convergence
Blocks

Use the Convergence sheets to specify convergence method, tolerance, and
convergence variables for user-defined convergence blocks. System-generated
convergence blocks generated by Aspen Plus do not use these specifications.

To define a convergence block:

1. From the Data menu, point to Convergence, then Convergence.

2. In the Convergence Object Manager click New.

3. In the Create New ID dialog box, enter an ID or accept the default name.

4. In the Create New ID dialog box, select the type of convergence block you
want to create.

Use this method To converge

BROYDEN or NEWTON Tear streams; two or more design specifications; or tear streams and design specifications
simultaneously. Use when the recycle loops and/or design specifications are highly interrelated.
Use Newton when Broyden is unable to converge.

COMPLEX Optimization with inequality constraints

DIRECT Tear streams by simple direct substitution. Convergence may be slow, but sure.

SECANT Single design specifications. Recommended for design specification convergence blocks.

SQP Sequential quadratic programming. Optimization with any combination of tear streams, equality
constraints, and inequality constraints.

WEGSTEIN Tear streams. You can apply Wegstein to any number of streams simultaneously. Recommended
tear stream convergence method.

For more information on the numerical methods, see Convergence Methods,
this chapter.

5. Click the Tear Streams, Design Specifications, Calculator Tears or
Optimization tab to select the elements that you want the convergence block
to solve.

6. To specify optional parameters, click the Parameters sheet.
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Convergence Methods

This section describes the convergence methods available in Aspen Plus.

The parameters for each method can be found on the Convergence ConvOptions
Methods form and on the form for the Convergence block.

WEGSTEIN Method
The classical bounded Wegstein method is usually the quickest and most reliable
method for tear stream convergence. It is an extrapolation of Direct substitution
iteration. Interactions between variables are ignored; therefore, it does not work
well when variables are strongly coupled.

Wegstein method can only be used for Tear streams. It is the default method for
Aspen Plus tear stream convergence. Apply it to any number of streams
simultaneously. You can control the Wegstein bounds and the frequency of
acceleration.

You can control the Wegstein method by specifying:

Field Default To specify the

Maximum Flowsheet
Evaluations

30 Maximum number of flowsheet evaluations

Wait 1 Number of direct substitution iterations before the first acceleration
iteration

Consecutive Direct Substitution
Steps

0 Number of direct substitution iterations between acceleration iterations

Consecutive Acceleration Steps 1 Number of consecutive acceleration iterations

Lower Bound -5 Minimum value for the Wegstein acceleration parameter (q)

Upper Bound 0 Maximum value for the Wegstein acceleration parameter (q)

Wegstein Acceleration Parameter

You can control the Wegstein method by specifying upper and lower limits for:
• Acceleration parameter q (Upper Bound and Lower Bound)
• Number of direct substitution iterations before the first acceleration (Wait)
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• Number of direct substitution iterations between acceleration iterations
(Consecutive Direct Substitution Steps)

• Number of consecutive acceleration iterations (Consecutive Acceleration
Steps).

In the bounded Wegstein method, the acceleration parameter q is calculated for
each tear stream variable as follows:

q
s
s

=
− 1

s
G X G X

X X
k k

k k
=

− −
− −

( ) ( )1

1

Where:

X = Estimate of the tear stream variable

G(X) = Resulting calculated value of the variable

k = Iteration number

The new estimate calculated by Wegstein is:

X qX q G X
X q G X X

k k k

k k k
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The following shows the effect of q on convergence:

q Convergence

q < 0 Acceleration

q = 0 Direct substitution

0 < q < 1 Damping

Because oscillation or divergence can occur if q is unbounded, limits are set on q.
The default lower and upper bounds on q are -5 and 0, respectively. For most
flowsheets, these limits work well and do not need to be changed.

Normally, you should use an Upper Bound of the Wegstein acceleration
parameter of 0. If iterations move the variables slowly toward convergence,
smaller values of the lower bound of the Wegstein acceleration parameter
(perhaps -25 or -50) may give better results. If oscillation occurs with direct
substitution, values of the lower and upper bounds between 0 and 1 may help.
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DIRECT Method
For direct substitution, the new value of the tear stream variable is the value
resulting from the previous flowsheet calculation pass:

X G Xk k+ =1 ( )

Where:

X = Estimate of tear stream variable

G(X) = Resulting calculated value of the variable

k = Iteration number

With direct substitution, convergence is slow but sure. It is available for those
rare cases where other methods may be unstable. Direct substitution can also
make it easy to identify convergence problems, such as component build-up in the
system. Direct substitution is equivalent to Wegstein with lower bound=upper
bound=0.

Secant Method
Secant is the secant linear approximation method, with higher order
enhancements. You can select a bracketing/interval halving option. Select this
option whenever the function is discontinuous, non-monotonic, or flat over a
region. Bracketing will eliminate the flat region and switch back to Secant
method if possible.

You can use Secant for converging single design specifications. Secant is the
default method for design specification convergence, and is recommended for
user-generated convergence blocks.
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You can control the Secant method by specifying:

Field Default To specify

Maximum Flowsheet
Evaluations

30 Maximum number of flowsheet evaluations

Step Size 0.01 Initial step size, as a fraction of range, for the design specification manipulated
variable

Maximum Step Size 1 Maximum step size, as a fraction of range, for the design specification
manipulated variable

X Tolerance 1e-8 Alternative tolerance on the manipulated variable

Iteration stops when the change in the scaled manipulated variable is less than
X Tolerance.

X Final on Error Last value Which value of manipulated variable to use as the final value when the
convergence block encounters an error

Options are Last value, Initial value, Minimum value of function, Lower bound,
and Upper bound.

Bracket No If the Secant algorithm should switch to a Bracketing algorithm.

Bracketing attempts to find a variable range where the design specification
function changes sign and performs interval halving when Secant is not
making progress.

When Bracket is specified as No, then Bracketing is not used. Since
bracketing may add extra iterations, in some cases, particularly with a nested
secant loop, you might want to specify Bracket as No.

When Bracketing is specified as Yes, Bracketing is tried if the function is not
changing. The Bracket = Yes option is useful for functions that are flat over a
portion of the variable range.

When Bracket is specified as Check Bounds, Bracketing is tried if the function
is not changing or if the Secant algorithm has moved to a variable bound. The
Bracket = Check Bounds option is useful for functions that are flat over a
portion of the variable range. It can also be useful for non-monotonic functions.
This option ensures that if the Secant algorithm becomes stuck at a variable
bound, the other variable bound will also be tried.

Find Minimum Function Value if
Bracketing Fails to Detect a Sign
Change.

Not checked Find the minimum function value if bracketing fails to detect a sign change.

BROYDEN Method
The Broyden method is a modification of Broyden's quasi-Newton method. The
Broyden method is similar to the Newton method, but it uses approximate
linearization. This approximation makes Broyden faster, but occasionally not as
reliable, as the Newton method.
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Use Broyden to converge tear streams, two or more design specifications, or tear
streams and design specifications simultaneously. Broyden is useful for multiple
tear streams and/or design specifications, tear variables that are highly
interdependent, or recycle loops and design specifications so interrelated that
nesting is impractical. When converging both tear streams and design
specifications, you can specify that tear streams be converged or partially
converged first. The simultaneous convergence of both tear streams and design
specifications then follows.

You can control the Broyden method by specifying:

Field Default To specify

Maximum Flowsheet Evaluations 30 Maximum number of flowsheet evaluations

X Tolerance 0.001 Alternative tolerance on the manipulated variables

The iteration stops when the change in the scaled manipulated variable
is less than X Tolerance

Wait 2 Number of direct substitution iterations before the first acceleration
iteration

Tear Tolerance (on Advanced Parameters
dialog box)

Tear tolerance. Used if initializing tears by converging tears (to
specified tolerance) before design specifications are included

Tear Tolerance Ratio (on Advanced
Parameters dialog box)

Tear tolerance ratio. Used if initializing tears by converging tears (to a
tolerance relative to the tear tolerance) before design specifications are
included

Maximum Iterations (on Advanced
Parameters dialog box)

Maximum number of flowsheet iterations to solve tears before design
specifications are included

Lower Bound (on Advanced Parameters
dialog box)

-5 Minimum value for the Wegstein acceleration parameter (q)

Upper Bound (on Advanced Parameters
dialog box)

0 Maximum value for the Wegstein acceleration parameter (q)
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NEWTON Method
NEWTON is an implementation of the modified Newton method for simultaneous
nonlinear equations. Derivatives are calculated only when the rate of
convergence is not satisfactory. The implementation allows bounds on the
variables, and includes a line search for improved stability. NEWTON is useful
when the recycle loops and/or design specifications are highly interrelated, but
convergence is not achieved using the Broyden method. Numerical derivatives
are calculated frequently. Use NEWTON for tear streams only when the number
of components is small or when convergence cannot be achieved by the other
methods. When converging both tear streams and design specifications, you can
specify that tear streams be converged or partially converged first. The
simultaneous convergence of both tear streams and design specifications then
follows.

When you use the Newton or Broyden methods to converge design specifications,
and one or more manipulated variables have reached their lower or upper limits,
a solution is found that minimizes the sum of squares of design specification and
tear stream errors, divided by their tolerances. Iterations stop when the root
mean square of the changes in the scaled manipulated variables is less than
X tolerance. Aspen Plus scales each manipulated variable, dividing it by the
absolute value of the lower or upper limit, whichever is larger.
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You can control the Newton method by specifying:

Field Default To specify

Maximum Newton Iterations 30 Maximum number of Newton iterations

Maximum Flowsheet
Evaluations

9999 Maximum number of flowsheet evaluations

Wait 2 Number of direct substitution iterations before the first acceleration iteration

X Tolerance 0.0001 Alternative tolerance on the manipulated variables

The iteration stops when the change in the scaled manipulated variable is less
than X Tolerance

Reduction Factor 0.2 Reduction factor which determines the number of Newton iterations used before
calculating a new Jacobian (derivative) matrix

With this option, the Jacobian is reused as long as it continues to decrease the
error each iteration by the Reduction Factor

Iterations to Reuse Jacobian Number of iterations to reuse the Jacobian (derivative) matrix

With this option, the Jacobian is reused a set number of times

The default is to base the reuse of the Jacobian on the Reduction Factor

Tear Tolerance (on Advanced
Parameters dialog box)

Tear tolerance. Used if initializing tears by converging tears (to specified
tolerance) before design specifications are included

Tear Tolerance Ratio (on
Advanced Parameters dialog
box)

Tear tolerance ratio. Used if initializing tears by converging tears (to a tolerance
relative to the tear tolerance) before design specifications are included

Maximum Iterations (on
Advanced Parameters dialog
box)

Maximum number of flowsheet iterations to solve tears before design
specifications are included

Lower Bound (on Advanced
Parameters dialog box)

-5 Minimum value for the Wegstein acceleration parameter (q)

Upper Bound (on Advanced
Parameters dialog box)

0 Maximum value for the Wegstein acceleration parameter (q)

COMPLEX Method
You can use the Complex method to converge optimization problems with bounds
on the manipulated variables and inequality constraints. COMPLEX is a direct
search method; it does not require numerical derivatives. It may be useful for
simple problems without recycle loops or equality constraints (design
specifications).
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SQP Method
You can use the state-of-the-art sequential quadratic programming (SQP)
method for flowsheet optimization for simultaneous convergence of optimization
problems with constraints (equality or inequality) and/or tear streams. The
algorithm generally follows an infeasible path (constraints and tear streams are
converged simultaneously with the optimization problem). But you can adjust it
to follow a feasible path (converging the tear streams at each iteration of the
optimization). SQP is used for system-generated optimization convergence blocks.
SQP is recommended for user-generated convergence blocks.

SQP-Biegler is an SQP implementation developed by Professor L. Biegler of
Carnegie-Mellon University and his students.

You can control the SQP method by specifying:

Field Default To specify

Maximum Optimization Iterations 30 Maximum number of SQP optimization iterations

Maximum Flowsheet Evaluations 9999 Maximum number of flowsheet evaluations

Each perturbation step for numerical derivatives is counted as
one evaluation.

Additional Iterations when Constraints are
not Satisfied

2 Number of additional iterations when constraints are not satisfied
after the convergence test is satisfied.

Iterations to Converge Tears for Each
Optimization Iteration

3 Number of iterations to take toward converging tears at each
iteration of the optimization

Iterations to Enforce Maximum Step Size 3 Number of iterations to enforce maximum step size on the
manipulated variables

Tolerance 0.001 Optimization convergence tolerance

Wait 1 Number of direct substitution iterations before the first
acceleration iteration

Lower Bound -5 Minimum value for the Wegstein acceleration parameter (q)

Upper Bound 0 Maximum value for the Wegstein acceleration parameter (q)
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SQP Wegstein Acceleration Parameters

When the SQP method is used to converge tears and optimization problems
simultaneously, the algorithm is a hybrid of an infeasible path method (where
the tears are not converged at each iteration but are converged at the optimum)
and a feasible path method (where the tears are converged at each iteration of
the optimization). You may control the degree to which the tears are converged
by specifying the number of iterations to take toward converging the tears
(Iterations To Converge Tears Each Optimization Iteration) and upper and lower
limits for the Wegstein acceleration parameter for the Wegstein iterations
(Upper Bound, Lower Bound).

 Specifying Convergence Order

You can specify the calculation order of convergence blocks you define if you use
more than one user-defined convergence block. Specify the convergence order on
the ConvOrder Specification or Sequence Specifications sheet.

To define a convergence order:

1. From the Data menu, point to Convergence, then Conv Order.

2. Select a block from the Available Blocks list. Use the arrow to move the block
that you want converged first to the top of the Convergence Order list.

3. Select any other blocks that you want in the order and move them to the
Convergence Order list. You can use the up and down arrows to rearrange the
order within the list. The first convergence block is converged first and nested
most deeply.

Specifying the Calculation Sequence

You can define the calculation order for all or part of the flowsheet. You supply
an ID for each sequence.

To define a sequence:

1. From the Data menu, point to Convergence, then Sequence.

2. In the Object Manager click the New button.
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3. In the Create New ID dialog box, enter an ID or accept the default ID and
click OK.

4. Specify the calculation sequence on the Specifications sheet. On each row of
the sheet, you can enter one of the following:
• The beginning of a loop
• The end of a loop
• A block ID
• A sequence ID for part of a flowsheet

For the beginning and end of a loop, specify Begin or Return To in the
Loop-Return field. Specify the block type in the Block Type field. The following
blocks begin loops:
• Convergence
• Sensitivity
• Data Fit

Calculator blocks can introduce loops only for the special case of loop control
Calculator blocks.

Specify the block type and block ID for the following block types:
• Unit operation
• Equipment
• Utility
• Transfer
• Calculator
• Balance
• Pres-Relief

For economic calculations, specify Economic for block type. There is no block ID
for economic calculations.

Within a sequence you can insert a subset of the flowsheet that already has an
ID and a defined sequence. For large flowsheets it is useful to build up the
sequence specification in this manner. Specify Sequence in the Block Type field.
Specify the sequence ID for the subset in the Block ID field.
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Aspen Plus executes the sequences exactly as you enter them, with these
exceptions:

If you Aspen Plus

Check the Check Sequence field on the
ConvOptions Defaults Sequencing sheet

Checks whether all loops in a sequence are torn. If a loop is not torn, Aspen Plus
displays an error message

Specify Execute Before or Execute After in a
Calculator block

Inserts the Calculator block into your sequence

Specify a Design-Spec Automatically generates convergence blocks for design specifications and inserts
them into your sequence

Using Initial Guesses

For many simulations with recycle streams, initial guesses for the tear streams
will help convergence. This is especially true for recycle systems with closed loops
or recirculating solvent loops. You can often provide a reasonable initial guess
from your knowledge of the process or through a simple mass-balance
calculation.

The sequence is displayed in the left pane of the Control Panel. If the left pane of
the Control Panel is empty, select Step from the Run menu.

Enter initial compositions and flow rates for the tear streams on Streams
Specification sheets, and run the simulation. Or select your own tear streams
using the Tear sheet, and provide initial estimates for them.

Flowsheet Sequencing

The tearing and sequencing of a flowsheet is complex and can require user input.
The following information on interacting with the Aspen Plus sequencing
algorithm is intended for advanced users. It is recommended that other users
accept the default sequencing.

Aspen Plus initially tears and sequences flowsheets in this sequence:

1. The information flow (incidence matrix) of unit operation blocks, Calculator
blocks, design specifications, constraints, optimizations, and cost blocks is
collected.
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2. Sequences you specify are checked for possible missing tears and are used to
generate a reduced incidence matrix. In the reduced incidence matrix,
subsequences you specify are collapsed and treated as a single block.

3. The reduced incidence matrix is partitioned into independent subsystems
that can be solved sequentially.

4. Tear streams or Calculator block tear variables are determined for each
subsystem, taking user-specified Tear, Tear Variable, and Convergence
specifications into consideration. The automatic sequencing algorithm in
Aspen Plus selects tear streams by minimizing a weighted combination of the
number of:
• Tear variables
• Times loops are torn

5. An initial sequence is determined as part of the tearing. For each subsystem,
Convergence blocks are created for design specifications, tear streams, and
tear variables that are not converged by user-specified convergence blocks.
Specifying Design Spec Nesting  as Inside on the Convergence ConvOptions
Defaults Sequencing sheet generates one tear convergence block for all tear
streams and tear variables, and generates an individual design specification
convergence block for each design specification. See Specifying Sequencing
Parameters, this chapter, for more information.

You can affect the automatic sequencing algorithm by:
• Adjusting the Variable Weight and Loop Weight parameters on the

Convergence ConvOptions Defaults Sequencing sheet.
• Specifying initial estimates for possible tear streams on the Streams forms.

The specifications for non-feed streams are used as initial guesses if possible.
Streams with data are weighted in the sequencing algorithm, so they are
more likely to be selected as tear streams.

• Specifying tear streams directly, using the Tear Specification sheet. You
should be careful not to specify more tear streams than required for
convergence. You can underspecify the number of tear streams, and
Aspen Plus will determine the additional tear streams needed.

Obtaining Final Convergence Sequence
To obtain the final convergence sequence:

1. All convergence blocks are ordered as they appear on the ConvOrder
Specification form and the current setting of User nesting on the
ConvOptions Defaults Sequencing sheet. Blocks not mentioned on the
ConvOrder Specification form are ordered according to the setting of Design
Spec Nesting on the ConvOptions Defaults Sequencing sheet and the span of
convergence blocks in the initial sequence.
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2. Aspen Plus obtains the final convergence sequence by repeatedly removing
tears and/or design specifications from the outermost convergence block and
partitioning the reduced flowsheet.

3. For Design specification nesting as Inside or Inside simultaneous on the
Convergence ConvOptions Defaults Sequencing sheet, you can define user-
specified convergence blocks for design specifications, and they will be
inserted automatically into the sequence.

Adding Special Options to the Sequence
At the end of the final convergence sequence, special options are added:

1. Blocks with Execute options are inserted into the sequence.

2. Sensitivity, Balance, and Data Fit blocks not already in the sequence are
inserted.

Because a design specification loop usually has a small span, the sequencing
algorithm does not nest them (for example, a tear loop outside and many
independent design specification loops inside). Since the algorithm does not take
numerical values into account, it sometimes places design specification loops
inside tear loops when they would perform better outside. Specifying Design Spec
Nesting as Outside on the Convergence ConvOptions Defaults Sequencing sheet
would alter the sequence but this often leads to deeply nested iteration loops for
large flowsheets.

Viewing the Sequence
To view the sequence along with the tear streams and the convergence blocks
determined by Aspen Plus:

➤ From the View menu, click Control Panel.
The sequence is displayed in the left pane of the Control Panel. If the left
pane of the Control Panel is empty, select Step from the Run menu.

Sequencing Example

This example describes steps to converge a simple flowsheet that does not
converge properly when automatic sequencing is used. It illustrates:
• Supplying initial estimates for recycle streams
• Altering the calculation sequence with Design spec nesting
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• Altering the calculation sequence with Conv Order
• Adjusting tolerances to account for nested loops

The flowsheet consists of:

Blocks Type

TOPCOL, BOTCOL Interconnected columns

HEATER Pre-heater

COOLER Product cooler

The mass flow of stream REFLUX, the inter-reflux stream from BOTCOL to
TOPCOL, is manipulated to meet a purity specification of component THF in
stream PROD. PROD is a product stream from BOTCOL/COOLER, in design
specification THF. PSPEC is the convergence block defined to converge THF.

When distillation columns appear in a recycle loop, it is often necessary to give
initial estimates for the tear stream. Aspen Plus makes this easy. Simply supply
data for a column feed or other stream in the loop on Streams forms, just as you
would for a feed stream, and Aspen Plus will preferentially select the stream as a
tear stream (your stream may not be selected if another stream is a better choice
by the tearing criteria).
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From initial estimates for the tear stream, the Aspen Plus sequencing algorithm
determines the following computation sequence:

HEATER
$OLVER01 TOPCOL
| PSPEC BOTCOL COOLER
| (RETURN PSPEC)
(RETURN $OLVER01)

$OLVER01 is defined to converge stream REFLUX, the inter-connecting stream,
with initial data provided. However, with this sequence the PSPEC and
$OLVER01 convergence blocks fail to converge, because the design specification
is nested inside the column recycle loop. The design specification THF does not
converge, because the purity specification is determined primarily by the inter-
reflux between the two columns (not the top product rate of the BOTCOL alone).

The inter-reflux between the columns should be converged before evaluation of the
design specification. The design specification should be nested outside the column
recycle loop. You can alter the nesting order of the convergence loops by either:
• Specifying Design Spec Nesting as Outside on the Convergence ConvOptions

Defaults Sequencing sheet, or
• Specifying PSPEC on the Convergence ConvOrder Specifications sheet.

Either specification would cause the sequencing algorithm to determine the
following computation sequence, which converges:

HEATER
PSPEC
| $OLVER01 TOPCOL BOTCOL
| (RETURN $OLVER01
| COOLER
(RETURN PSPEC)

Both methods of specifying the nesting order are equivalent for this simple
problem. But using the ConvOptions Defaults Sequencing form allows you to
change the computation sequence selectively when dealing with large flowsheets.
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In this flowsheet there is no need for special tolerance adjustments to account for
the nesting of iteration loops. For some flowsheets it is necessary to adjust
tolerances so the inner loops are calculated more accurately than outer loops;
otherwise the outer loops would be overwhelmed with errors from inner loops.
For the sequence above, use the following levels of calculation accuracy:

For these blocks Use this level of accuracy

HEATER, PSPEC Final

$OLVER01, COOLER Intermediate (higher)

TOPCOL, BOTCOL Highest

If the Error/Tolerance for PSPEC seems to go down to 10 quickly and stay there,
you should tighten tolerances for all the blocks inside the PSPEC loop or loosen
the tolerance for PSPEC. If you observe a similar problem in $OLVER01, you
could tighten the tolerances of TOPCOL and BOTCOL.

It is particularly important to ensure that any nested design specifications have
sufficiently tight tolerances, since these tolerances are specified by the user. If
problems occur, or if the design specification is nested deeply, a tighter tolerance
may be necessary.

Checking Convergence Results

After your simulation has completed or while it is paused, you can view
convergence block results to check the status or diagnose convergence problems.

1. If your simulation is paused, from the Run menu, click Load Results.

2. On the Data menu, point to Convergence, then Convergence.

3. In the Convergence Object Manager, select the convergence block and click
Edit. For system-generated convergence blocks, (names beginning with
$OLVER), the results sheets are displayed. For user-defined convergence
blocks, select Results on the left pane of the Data Browser window to display
the results sheets.
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4. Choose the appropriate sheet:

This sheet Contains the information

Summary Final convergence status, variable value, and Err/Tol for each variable converged by the
block

Tear History Table of maximum Err/Tol versus iteration number. Variable with maximum error at each
iteration. Plots of Err/Tol versus iteration number can be generated.

Spec History Table of manipulated variable values and design specification error versus iteration number.
You can generate plots of design specification error versus iteration number, or design
specification error versus manipulated variable value.

Use the Tear History and Spec History sheets and the Diagnosing Tear Stream
Convergence and Diagnosing Design-Spec Convergence tables, to help you
diagnose and correct tear stream and design specification convergence problems.
It is helpful to generate a plot of Err/Tol versus iteration number.

Increasing diagnostics can also help with diagnosing problems. See Convergence
Diagnostics, this chapter, for more information.
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Control Panel Messages

The Control Panel displays convergence diagnostics for each convergence block.
Each time the convergence block is executed in a recycle convergence loop,
messages appear with the following format:
> Loop CV Method: WEGSTEIN Iteration 9
Converging tear streams: 3
4 vars not converged, Max Err/Tol 0.18603E+02

Each time a convergence block for a design specification is executed in a
convergence loop, messages appear with the following format:
>> Loop CV Method: SECANT Iteration 2
Converging specs: H2RATE
1 vars not converged, Max Err/Tol 0.36525E+03

Where:

CV = Convergence block ID

Max Err/Tol = Maximum error/tolerance for the unconverged variables

> = Symbol indicating nesting level of the convergence loop
> Outside loop
>> Loop nested one deep
>>> Loop nested two deep

and so on

Convergence is achieved when the value of Max Err/Tol becomes less than 1.0.

Convergence Diagnostics

You can modify the diagnostic level for convergence globally on the Setup
Specifications Diagnostics sheet. For more details about how to change the
diagnostics level, see Chapter 5.

Use the Convergence sliders to modify the diagnostic level for convergence block
information in either the control panel and in the history file. You can also
specify the diagnostic level for a single convergence block using the Diagnostics
button on the Input Parameters sheet for any convergence block.

The default diagnostic level within Aspen Plus is 4. At a Convergence Diagnostics
Level of 4, a message is created in the Control Panel every time the convergence
block executes. This message contains the following information:
• Convergence block
• Convergence method
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• Iteration number
• What the convergence is trying to converge
• Number of unconverged variables
• Maximum error/tolerance for that iteration of the convergence block

Messages in the history file are similar, but not identical.

At a Convergence Diagnostics Level of 5, Aspen Plus creates a table of
convergence information in the Control Panel for all unconverged variables.

For example:

> Loop C-1 Method: BROYDEN Iteration 1

Converging tear streams: 4
Converging specs: H2RATE

NEW X G(X) X ERR/TOL
TOTAL MOLEFLOW (1) 0.135448E-01 0.135448E-01 0.000000E+00 10000.0
N2 MOLEFLOW (2) 0.188997E-03 0.188997E-03 0.000000E+00 10000.0
C1 MOLEFLOW (2) 0.755987E-03 0.755987E-03 0.000000E+00 10000.0
BZ MOLEFLOW (2) 0.314995E-03 0.314995E-03 0.000000E+00 10000.0
CH MOLEFLOW (2) 0.122848E-01 0.122848E-01 0.000000E+00 10000.0
PRESSURE (2) 0.217185E-01 0.217185E-01 0.100000E+36 0.100000E+07
MASS ENTHALPY (2)-0.137111E-01-0.137111E-01 0.100000E+36 0.100000E+07
TOTAL MOLEFL (3) 0.377994E-01 0.000000E+00 0.377994E-01 -375.000

8 vars not converged, Max Err/Tol 0.17679E+05

The value in parentheses indicates the type of variable:

Variable Type Description

1 Tear stream variable which is not updated by the convergence algorithm

2 Tear stream variable which is updated by the convergence method

3 Design specification manipulated variable. Updated by the algorithm

4 Calculator Tear Variable. Updated by the algorithm

New X is the value for the variable for the next iteration. X is the value of the
variable for the previous iteration. G(X) is the calculated value for the variable at
the end of the previous iteration. When a variable is converged, X and G(X)
should differ by less than the tolerance. All values are in SI units.

Setting the Convergence Diagnostics level to 6 or higher does not change the
amount of information reported in the Control Panel. However, it will affect the
amount of information reported in the history file, depending on the convergence
method in use.
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Strategies for Flowsheet Convergence

Often a flowsheet can be converged without changing any convergence
parameters.

Some general guidelines are:
• Start small. Make sure that individual blocks and elements of a flowsheet

behave as expected, before slowly combining them into a larger simulation. A
sensitivity block is useful for determining the results of other blocks under a
range of conditions.

• Start with the simplest blocks possible. For example, converge the flowsheet
with a simple HeatX before switching it to a rigorous HeatX.

• Give good initial guesses. Make sure the flowsheet starts converging from a
reasonable point. Aspen Plus gives tear streams a default value of zero, which
can cause problems. If possible, select a tear stream that remains relatively
constant.

• Check physical properties. Make sure they are calculated correctly in the
entire operating range of the simulation.

• Know how your flowsheet responds. Check the behavior of blocks and design
specifications using sensitivity analysis. Look for discontinuities and flat
regions that could cause convergence difficulties.

• Check for correctness, variable accessing, spelling, and unit specifications.
When accessing real variables, make sure your variable names do not begin
with I-N.
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Tear Convergence Suggestions
This table shows the possible causes and solutions of tear stream convergence
problems.

Diagnosing Tear Stream Convergence

If plot of Err/Tol vs. Iteration
number shows

A possible cause is To correct the problem

Steady convergence — Increase Maxit above 30 on the Conv Options or Convergence
block Parameters sheet.

Steady but slow convergence Component build-up

—

Check outlet streams from recycle loop to confirm that all
components have a way to leave the system. If there is not, the
problem may not be feasible from an engineering point of view.
(That is, there may not be a steady state solution.)

Allow for larger acceleration steps. For Wegstein, set Lower
bound of the Wegstein acceleration parameter = -20 on the
ConvOptions Wegstein sheet, or on the Convergence block
Wegstein Input Parameters sheet. If this change speeds
convergence, try lower bound = -50.

Oscillating convergence — For Wegstein, set upper bound to .5 to dampen the
oscillations.

Err/Tol down to a threshold level,
but no further

Nested loops, and the
convergence tolerance of the
inner loops is too loose 

Do one of the following:

• Set a tighter tolerance for the blocks and convergence
blocks in the inner loop, using the Tolerance field for
these blocks. Block tolerance can be changed globally
on the Setup SimulationOptions Flash Convergence
sheet or locally on the block’s Flash Options sheet.
Convergence block tolerances can be changed globally
on the Conv Options sheet for that method or locally on
the convergence block’s Parameter sheet.

• Relax the tolerance for the outside loop.

• Converge the inside and outside loops simultaneously,
using the Broyden or Newton method. Use the Design
Spec Nesting field on the ConvOptions Defaults
Sequencing sheet.

Broyden or Newton failing to
converge

— Increase the value of Wait to 4 (on the Convergence
ConvOptions sheet or Convergence block Parameters sheet).

If both tear streams and design-specs are specified in the
convergence block, solve only tear streams first by specifying
Tear Tolerance or Tear Tolerance Ratio. Click the Advanced
Parameters button on the Parameters sheet of the
convergence block. Switch to the Wegstein method.
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Some other general strategies for tear stream convergence are:
• Provide a good initial guess for the Tear stream on the Stream form. For more

information on specifying streams, see Chapter 9.
• Select a Tear stream that will not vary a great deal. For example, the outlet

stream of a Heater block is generally a better choice for a tear stream than
the outlet stream from a Reactor block.

• Disconnect the recycle stream to get a good initial estimate and to examine
the sensitivity.

• Try to simplify the problem. It may be possible to do one or more of the
following to reduce the complexity of the problem:
• Add a Mixer block to reduce the number of tear streams
• Replace a HeatX block with an MHeatX to reduce the number of tear

streams
• Define and use a Component Group to reduce the number of variables
• Choose a Tear stream that has fewer components present
• Choose a Tear stream from a block that sets an outlet temperature

• Reinitialize the simulation. Try to converge the simulation using a Wegstein
acceleration parameter equal to 0 (set the upper bound and lower bound to 0).
This is equivalent to direct substitution. Look for a continuing buildup of one
or more components as the iterations proceed.

• Try using a different convergence method such as Broyden or Newton rather
than the default Wegstein method.

• Confirm that the sequence for the simulation (either Aspen Plus defined or
user defined) is reasonable. See Specifying the Calculation Sequence, this
chapter.



Chapter  17

Aspen Plus User Guide 17-33
Version 10.2

Design Specification Convergence Suggestions
This table shows the possible causes and solutions of Design Specification
convergence problems.

Diagnosing Design Specification Convergence

If plot of Err/Tol vs. Iteration
number shows

A possible cause is To correct the problem

Steady convergence — Increase Maxit above 30 on the appropriate Conv Options or
Convergence block Parameters sheet.

Err/Tol not changing Spec function insensitive to
manipulated variable

Spec function flat over some
range of the manipulated
variable

1. Check if the formulation of the spec function is correct.
2. Check if the correct manipulated variable is being used.
3. Use Sensitivity study to determine the effect of the manipulated
variable on the spec function.

For the Secant method, select Bracket=Yes on the Conv Options
or Convergence block Parameters sheet, to use interval-halving
method.

Err/Tol down to a threshold
level, but no further

Nested loops, and the
convergence tolerance of the
inner loops is too loose

Do one of the following:

• Set a tighter tolerance for the blocks and convergence
blocks in the inner loop, using the Tolerance field for these
blocks.

• Relax the tolerance for the outside loop.

• Converge the inside and outside loops  simultaneously,
using the Broyden or Newton method. Use the Design Spec
Nesting  field on the ConvOptions Defaults Sequencing
sheet.

Converged to variable bound Non-monotonic Spec function 1. For the Secant method, select Bracket=Check bounds on the
Conv Options or Convergence block Parameters sheet, to use
interval-halving method.
2. Use Sensitivity study to determine the effect of the manipulated
variable on the spec function. Adjust the bounds on the
manipulated variable, or choose a better initial guess.

Some other general strategies for Design Specification convergence are:
• Formulate specifications to avoid discontinuities.
• Formulate specifications to reduce non-linearity with respect to design

variables. For example, set a specification on the log of a concentration when
it is near zero.
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• Make sure the limits are reasonable. Try to avoid limits spanning more than
one order of magnitude.

• Confirm the existence of a solution by replacing a Design specification with a
Sensitivity block.

• Make sure the tolerance is reasonable, especially when compared with the
tolerance of blocks inside the Design specification convergence block.

For more information on design specifications, see Chapter 21.

Calculator Block Convergence Suggestions
Some other general strategies for Calculator Block convergence are:
• Avoid iterative loops causing hidden mass balance problems. The sequencing

algorithm can detect Fortran tear variables if Tear Fortran Export Variables
is checked on the ConvOptions Defaults Sequencing sheet. It can converge
tear variables if any Calculator block is sequenced with Import and Export
variables. The tear variables are then solved along with the tear streams.

• Check the correctness of the Fortran statements or Excel formulas in the
Calculator block.

• Fortran Variables beginning with the letters I through N should be integer
variables, if they have not been declared otherwise.

• Increase the diagnostics to check the value of variables used in the
calculations. Click the Diagnostics button on the Sequence sheet. On the
Diagnostics dialog box, raise the level for Defined Variables to 5 or 6. This
will print out the value of the accessed variables.

• Add write statements to your Fortran block or macros to your Excel
spreadsheet to display intermediate values.

• If using Import and Export variables to determine the sequence, make sure
that all the variables are listed.

For more information on Calculator Blocks, see Chapter 19.
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Resolving Sequence and Convergence Problems
Use the following strategy to resolve sequence or convergence problems:

1. Run the simulation using the default sequence generated by Aspen Plus.

2. Examine simulation results, looking for skipped and unconverged unit
operation blocks. Check the Control Panel and results sheets for blocks that
did not complete normally, had errors, or had unexpected results that might
affect recycle convergence. See Checking Convergence Results, this chapter,
for more information.
Some common reasons for these problems are:

Problem Action

Incorrect block specifications Correct them.

Feed conditions too far off Provide better estimates for tear streams and/or design variables.

Convergence specifications Try different specifications, different algorithm options, or increase the number of
iterations.

Algorithm options Change options

Not enough iterations Increase number of iterations

If you make any corrections, go to step 9.

3. Check whether tolerance needs adjustment. If the maximum error/tol for
convergence blocks reduces to around 10 quickly, but fluctuates after that,
tolerance adjustments may be necessary. For more information, see the
Sequencing Example.
Another way to correct tolerance problems is to converge multiple design
specifications with a Broyden or Newton convergence block.

4. If Wegstein convergence blocks converge slowly, try some Wegstein
parameters, such as Wait=4, Consecutive Direct Substitution Steps=4, Lower
Bound=-50. Providing better estimates for tear streams would also help.

5. If tear stream convergence blocks oscillate, try using the Direct method for
convergence. If the problem persists, examine the flowsheet to determine if
every component has an outlet. The oscillation of a tear stream loop could also
be caused by the non-convergence of design specification loops inside the tear
stream loop; check for this next, if oscillation persists. If oscillation stops, try
the acceleration technique described in step 4.

6. Examine the Spec Summary and check for non-converged design
specifications. Some common reasons for a design specification that does not
converge are:
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Design Specification Problem Action

Not reachable within bounds on variable Accept the solution or relax the bounds.

Not sensitive to manipulated variable Select a different manipulated variable to meet the design
specification or delete the design specification.

Insensitive to manipulated variable in a certain range Provide a better initial guess, refine the bounds, and/or enable
the Bracket option of the Secant convergence method.

Not sensitive to the manipulated variable, because the design
specification loop is not nested properly

See Sequencing Example, this chapter. If it is necessary to alter
the calculation sequence, see step 7.

7. Alter the calculation sequence, if necessary, using one of the following
options. (This step requires a good understanding of the process you are
simulating and is intended for advanced users only):

If you want to Specify

Make one or more design specification loops the outermost
loops

These loops on the ConvOrder Specifications sheet (See
Specifying Convergence Order, this chapter)

Alter the nesting of a small section of the flowsheet A partial sequence on the Sequence Specifications sheet (see
Specifying the Calculation Sequence, this chapter)

Use specific tear streams These streams on the Tear Specifications sheet (see
Specifying Tear Streams, this chapter)

There are other options on the ConvOptions Defaults Sequencing sheet that
also affect the calculation sequence (see Convergence Options, this chapter).

8. If all convergence blocks are converged but the overall mass balance is not in
balance, check Calculator blocks for possible errors. It is recommended that
you use Import and Export Variables to sequence regular Calculator blocks,
and use Execute to sequence initialization Calculator blocks.

9. If the flowsheet is modified, rerun the simulation and go back to step 2.

Example of Err/Tol Going Down to a Threshold Value

After about 8 recycle convergence iterations, the Err/Tol value goes down to a
threshold value, but not lower. This recycle is nested outside of an inner design
specification loop. Set a tighter tolerance for the inner loop.
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Example of Err/Tol Value Not Changing

The Err/Tol value does not change for a design specification, where the
temperature of a reactor is being manipulated to control the conversion in the
reactor. A sensitivity analysis shows that the specification function (conversion)
is flat over some range of the manipulated variable. Specify Yes in the Bracket
field on the Convergence ConvOptions Methods Secant sheet or Secant Input
Parameters sheet for this design specification problem.
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18 Accessing Flowsheet
Variables

You access or manipulate flowsheet variables when using the following
capabilities:
• Design specifications
• Calculator blocks
• Optimization problems
• Data-Fit problems
• Sensitivity blocks
• Case study

This chapter describes:
• Accessing flowsheet variables
• Types of accessible flowsheet variables
• Choosing input and parameter variables
• The layout (or structure) of the vector variable types
• Examples of how the accessed variables are used in Fortran statements

Accessing Flowsheet Variables

When you run a simulation in Aspen Plus, you often need to record or modify the
value of quantities in the simulation, such as the temperature of a flash block or
the mass flow of a stream. References to flowsheet quantities are made by
“accessing” these variables.
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For example, to study the effect of a column reflux ratio on the mole fraction of a
component in the distillate, two flowsheet quantities (variables) would need to be
accessed: the reflux ratio of the column and the mole fraction of the component in
the distillate. Several features in Aspen Plus require you to access variables,
such as design specifications, Calculator blocks, optimization problems, data-fit
problems, and sensitivity blocks.

Most accessed variables have a user-specified name associated. For example, you
could associate the name “PRES” with a variable that points to the pressure in a
Flash2 block. However, variables that are to be varied by a design-spec, a
sensitivity block, or optimization do not have a name associated.

There are two kinds of variables in a simulation:

Type of Variable Information

Those which you enter You can manipulate directly any variables that you enter.
These variables may be either read or written.

Those calculated by Aspen Plus These variables should not be overwritten or varied directly,
as this would lead to inconsistent results.
These variables should only be read.

Accessed variables can be either scalar or vector. An example of a scalar variable
is the pressure for a specific stage in a RadFrac block. The pressure profile for a
column is an example of a vector variable. For more information, see Types of
Accessed Flowsheet Variables, this chapter.

It is important to make sure the correct variable is accessed. Look at the prompt
at the bottom of the form when you select a variable from a drop-down list.

For example, when you select the block variable for a Flash2 or a Heater called
PDROP, the prompt tells you that this is the pressure drop for the heating or
cooling curve (not the pressure drop for the block). When you select the variable
PRES, the prompt tells you that this variable is the pressure specification for the
block; the value will be negative if pressure drop was input.

Types of Accessed Flowsheet Variables

Values for accessed scalar variables are in the units specified in the Units field
(on the Data Browser toolbar). For example, you might define a variable as a
stream temperature on the Design Spec Define sheet. If the Units field for the
sheet says ENG, the accessed temperature value is in degrees Fahrenheit. Vector
variables are in SI units, regardless of the Units specified.
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There is only one set of units for an object. All accessed variables (both defined
and varied) for an object are in the same set of units.

You can access flowsheet variables for these variable types:
• Block variables
• Stream variables
• Other variables
• Property parameters

Block Variables

Variable type Description

Block-Var Unit operation block variable

Block-Vec Unit operation block vector

Stream Variables

Variable type Description

Stream-Var† Non-component-dependent stream variable

Stream-Vec Stream vector. See Accessing Stream and Substream Vectors

Substream-Vec Substream variable. See Accessing Stream and Substream Vectors

Mole-Flow Component mole flow in a stream

Mole-Frac†† Component mole fraction in a stream

Mass-Flow Component mass flow in a stream

Mass-Frac†† Component mass fraction in a stream

Stdvol-Flow Component standard liquid volume flow in a stream

Stdvol-Frac†† Component standard liquid volume fraction in a stream

Heat-Duty Heat stream duty

Work-Power Work stream power

Stream-Prop†† Stream property defined by a property set

Compattr-Var Component attribute element

Compattr-Vec Component attribute vector

PSD-Var Substream Particle Size Distribution (PSD) element

PSD-Vec Substream Particle Size Distribution (PSD)  vector

†
 These stream variables can be accessed only as results.You cannot change or set them.:
MOLE-ENTHALPY, MASS-ENTHALPY, MOLE-ENTROPY,  MASS-ENTROPY, MOLE-DENSITY,
MASS-DENSITY, LFRAC

††
Variables of this type can be accessed only as results. You cannot change or set them.
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Other Variables
Variable type Description

Balance-Var Balance block variable

Chem-Var Chemistry variable

Presr-Var Pressure relief variable

React-Var Reactions variable

Parameter User-defined parameter. See Using Parameter Variables

Property Parameters

Accessed property parameters are always in SI units.

Variable type Description

Unary-Param Scalar unary property parameter

Unary-Cor-El Temperature-dependent unary property parameter coefficient element

Un-Cpr-Vec Temperature-dependent unary property parameter coefficient vector. For more information, see
Accessing Property Parameter Vectors

Bi-Param Scalar binary property parameter

Bi-Cor-El Temperature-dependent binary property parameter coefficient element

Bi-Cor-Vec Temperature-dependent binary property parameter coefficient vector.

NC-Param Nonconventional component parameter

Variable Definition Dialog Box

When completing a Define sheet, such as on a Calculator, Design specification or
Sensitivity form, specify the variables on the Variable Definition dialog box. The
Define sheet shows a concise summary of all the accessed variables, but you
cannot modify the variables on the Define sheet.

When on any Define Sheet:

1. To create a new variable, click the New button.
– or –
To edit an existing variable, select a variable and click the Edit button.
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2. Type the name of the variable in the Variable Name field.

3. In the Category frame, use the option button to select the variable category.

4. In the Reference frame, select the variable type from the list in the Type field.
Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.

Example for Calculating Make-up Flow Rate

The mass flow rate of a make-up stream (MAKEUP) is determined by the
difference between the mass flow rate of the recycle stream (RECYCLE) and 120
lb/hr, using a Fortran Calculator block. Aspen Plus writes the make-up flow rate
to the Control Panel.

On the Calculator Define sheet, Fortran variables FMAKE and FRECYC are
defined for the two stream mass flow rates. The Variable Definition dialog box is
used to define the variables.
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On the Calculator Calculator sheet, these Fortran statements are included:
F FMAKE=120.0-FRECYC
C If no makeup is required, set
C the makeup to a small value
C to avoid losing the makeup
C stream composition

IF(FMAKE.LE.0.0) FMAKE=0.0001
WRITE(NTERM,10) FMAKE

10 FORMAT(1X,'MAKEUP FLOW RATE=', F10.2)
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Choosing Input or Results Variables

It is sometimes important to distinguish between input and results when
accessing:
• Block variables
• Pressure relief variables

For example, suppose you are sampling the calculated duty of a Heater block that
has temperature and vapor fraction specified. You must access the results
variable QCALC, not the input variable DUTY. DUTY will not have a value.

To determine whether a variable is an input or results variable:

1. In the Variable Definition dialog box where you are accessing the variable,
click the arrow in the Variable field, and select the variable from the list.

2. Check the prompt. If the prompt begins with Calculated, the variable is a
results variable. Otherwise it is an input variable.

Guidelines for Choosing Input or Results Variables
Follow these guidelines for choosing input or results variables:
• Choose input variables when setting or manipulating input specifications.
• Choose results variables for use in design specification expressions,

optimization objective functions, constraint expressions, and sensitivity
tabulations,.

• See Chapter 19 for special considerations when accessing variables in a
Data-Fit block.

• If a result is available in an outlet stream of a block, access the stream
variable. For example, to access the temperature calculated by a Heater
block, access the temperature of the outlet stream.

• If a result is not available in an outlet stream of a block, choose a block
variable with a prompt that begins with Calculated. For example, the prompt
for the variable QCALC (the duty calculated by a Heater block) is Calculated
heat duty.

• MASS-FRAC, MOLE-FRAC and STDVOL-FRAC are results variables and
cannot be changed.
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Using Parameter Variables

A parameter variable is a user-defined global variable you can use for temporary
storage of quantities not defined in Aspen Plus. For example, the temperature
difference between two blocks can be a parameter variable. You identify
parameter variables by variable number. There can be any number of parameter
variables in a simulation.

Example of Using a Parameter Variable for Temperature Difference

A design specification manipulates a user-defined variable (Parameter 1), which
represents the temperature difference between two heaters. A Fortran Calculator
block retrieves the parameter (DELT) and the temperature of the first heater
(T1), and uses these variables to set the temperature of the second heater (T2).
The Variable Definition dialog box is used to define the variables on the
Calculator Define sheet.

On the Design Spec form:
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On the Calculator form:
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Accessing Vectors

You can use the vector variable types to access an entire block profile, stream or
substream at once. Aspen Plus interprets the Fortran variable you assign to the
vector as an array variable. You do not need to dimension it.

Vector Variables

Variable type  Description

Block-Vec Unit operation block vector (see Accessing Block Vectors, this chapter)

Stream-Vec Stream vector (see Accessing Stream and Substream Vectors, this chapter)

Substream-Vec Substream variable (see Accessing Stream and Substream Vectors, this
chapter)

Compattr-Vec Component attribute vector (see Component Attributes and PSD, this
chapter)

PSD-Vec Substream Particle Size Distribution (PSD) vector (see Component
Attributes and PSD, this chapter)

Un-Cor-Vec Temperature-dependent unary property parameter vector (see Accessing
Property Parameter Vectors, this chapter)

Bi-Cor-Vec Temperature-dependent binary property parameter vector (see Accessing
Property Parameter Vectors, this chapter)
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Aspen Plus generates a variable by adding the letter L to the beginning of the
Fortran variable name which you assign to the vector. The value of this variable
is the length of the vector. You can use the variable in Fortran statements, but
you cannot change its value.

In Excel Calculator blocks, Aspen Plus assigns the data to a column, beginning in
the cell with the specified name.

Accessing Stream and Substream Vectors

You can use the Stream-Vec and Substrm-Vec variable types to access an entire
stream or substream at once. Aspen Plus interprets the Fortran variable you
assign to the stream as an array variable. You do not need to dimension it.

A stream vector contains all the substream vectors for that stream class. The
order of the substreams is defined on the Define Stream Class dialog box (click
the Define Stream Class button on the Setup StreamClass Flowsheet sheet).

The variables in a stream or substream vector are always in SI units.

Substream MIXED and Stream Class CONVEN
This is the layout of the substream vector for substream MIXED and for
Stream-Vec, when accessing the default stream class CONVEN:

Array Index Description

1, . . . , NCC Component mole flows (kg-moles/sec)

NCC + 1 Total mole flow (kg-moles/sec)

NCC + 2 Temperature (K)

NCC + 3 Pressure (N/m2)

NCC + 4 Mass enthalpy (J/kg)

NCC + 5 Molar vapor fraction

NCC + 6 Molar liquid fraction

NCC + 7 Mass entropy (J/kg-K)

NCC + 8 Mass density (kg/m3)

NCC + 9 Molecular weight (kg/kg-mole)
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NCC is the number of conventional components specified on the Components
Specifications Selection sheet. The order of the component mole flows is the same
as the order of components on that sheet. All values are in SI units, regardless of
the Units specification on the Define sheet.

Aspen Plus generates a variable by adding the letter L to the beginning of the
Fortran variable name, which you assign to the substream or stream vector. The
value of this variable is the length of the vector (NCC + 9). You can use the
variable in Fortran statements, but you cannot change its value.

In Excel Calculator blocks, Aspen Plus assigns the data to a column, beginning in
the cell with the specified name.

Example for Accessing a Stream Vector

A Fortran Calculator block is used to write the mole fractions of stream HX1-
OUT to the terminal. On the Define sheet of the Calculator block, Fortran
variable SOUT, of the type Stream-Vec, is defined.
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On the Calculator Calculator sheet, these Calculator statements are included:
NCOMP=LSOUT-9
WRITE(NTERM,30)
DO 10 I=1, NCOMP
X(I)=SOUT(I)/SOUT(NCOMP+1)
WRITE(NTERM, 20) I, X(I)

10 CONTINUE
20 FORMAT (10X, I3, 2X, F10.4)
30 FORMAT (‘STREAM HX1-OUT MOLE FRACTIONS’)

On the Declarations dialog box, the following statement allows for up to 20
components:

DIMENSION X(29)

Substream CISOLID
The layout of a substream vector for a CISOLID substream is the same as for a
MIXED substream, with one exception. If the CISOLID substream has a PSD, an
array of values for the PSD is appended to the vector. NCC is the number of
conventional components. Space for all conventional components is reserved in
both the MIXED and CISOLID substreams. The component order is the same as
on the Components Specifications Selection sheet. All values are in SI units,
regardless of the Units specification.
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In the following table, n represents the number of intervals in the particle size
distribution. For CISOLID substreams, vapor and liquid fractions have the value
0.0. This is the layout of a substream vector for a CISOLID substream:

Array Index Description

1, . . . , NCC Conventional component mole flows (kg-moles/sec)

NCC + 1 Total mole flow (kg-moles/sec)

NCC + 2 Temperature (K)

NCC + 3 Pressure (N/m2)

NCC + 4 Mass enthalpy (J/kg)

NCC + 5 Molar vapor fraction  (0.0)

NCC + 6 Molar liquid fraction (0.0)

NCC + 7 Mass entropy (J/kg-K)

NCC + 8 Mass density (kg/m3)

NCC + 9 Molecular weight (kg/kg-mole)

NCC + 10
     .   .
     .   .
     .   .
NCC + 9 + n

substream) the for defined is attribute PSD a (if values PSD

fracn

     

frac
�
�

�

Μ

Aspen Plus generates a variable by adding the letter L to the beginning of the
Fortran variable name which you assigned to the substream or stream vector.
The value of this variable is the length of the vector (NCC + 9 + n). You can use
the variable in Fortran statements, but you cannot change its value.

In Excel Calculator blocks, Aspen Plus assigns the data to a column, beginning in
the cell with the specified name.

Substream NC
A substream vector for an NC substream contains:
• Component flows
• Stream conditions
• Component attributes
• An array of values for the PSD (if the substream has a PSD)

NNCC is the number of nonconventional components.
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The component order for Is the same as on

Component flows Components Specifications Selection sheet

Component attributes Properties Advanced NC-Props Property Methods sheet  

Attributes for each component appear in the order specified on the Properties
Advanced NC-Props Property Methods sheet for that component. All values are
in SI units, regardless of the units specification.

This is the layout of a substream vector for an NC substream:

Array Index Description

1, . . . , NNCC Component mass flows (kg/sec)

NNCC + 1 Total mass flow (kg/sec)

NNCC + 2 Temperature (K)

NNCC + 3 Pressure (N/m2)

NNCC + 4 Mass enthalpy (J/kg)

NNCC + 5 Vapor fraction (0.0)

NNCC + 6 Liquid fraction (0.0)

NNCC + 7 Mass entropy (J/kg-K)

NNCC + 8 Mass density (kg/m3)

NNCC + 9 1.0

NINCC + 10
     .   .
     .   .
     .   .

value
     .    
     .    
     .    
value

Values for component attribute 1 of component 1 

1

k

�
��

�
�
�

value
     .   
     .   
     .   
value

Values for component attribute 2 of component 1 

1

l

�
��

�
�
�

value
     .   
     .   
     .   
value

Values for component attribute 1 of component 2 

1

m

�

�

�
��

�
�
�

frac
     .    
     .    
     .    
frac

PSD values (if a PSD attribute is defined for the substream) 

1

n

�
��

�
�
�
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Component Attributes and PSD
You can use the Compattr-Vec and PSD-Vec variable types to access component
attribute vectors and PSD vectors of streams. The layout of the vector is the list
of elements for the attribute. See Substream CISOLID and In Excel Calculator
blocks, Aspen Plus assigns the data to a column, beginning in the cell with the
specified name.

Substream NC for the layout for substream PSD, in this chapter. See Chapter 6
for a description of the elements for each component attribute. You can also
obtain information for the attribute from the Components Attr-Comps Selection
sheet and Properties Advanced NC-Props Property Methods sheet.

Accessing Block Vectors

You can use the Block-Vec variable type to access column profiles for the
following multi-stage separation models:

In this model Variables depend on

RadFrac Stage and composition

MultiFrac Stage, section, and composition

Extract Stage

PetroFrac Stage, composition, and stripper number

RateFracTM Segment, composition, and accumulator number

BatchFracTM Stage, composition, and operation step

SCFrac Section and composition

You can also use Block-Vec to access the following block result profiles:
• MHeatX zone analysis
• RBatch time profiles
• RPlug length profiles

Aspen Plus automatically:
• Interprets the Fortran variable you assign to the profile as an array variable
• Dimensions the variable
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Aspen Plus generates a variable by adding the letter L to the beginning of the
Fortran variable name which you assigned to the block vector. The value of this
variable is the length of the array. You can use the variable in Fortran
statements, but you cannot change its value.

The order of values in the Fortran array depends on which variable you select.
Subsequent sections of this chapter describe the order for variables. All values
are in SI units, regardless of the Units specifications on the Define sheet.

In Excel Calculator blocks, Aspen Plus assigns the data to a column, beginning in
the cell with the specified name.

Variables Dependent on Stage Number or Segment
Number

The layout for vector variables is dependent on stage, section or segment number
follows.

Array Index Value for

1 Stage or segment 1

2 Stage or segment 2

.

.

N Last stage or segment

N denotes the number of stages or segments in the column.

Examples of variables dependent on stage number are temperature and flow
profiles in RadFrac, MultiFrac Extract, PetroFrac, or BatchFrac. Examples of
vector variables dependent on segment number are temperature and flow profiles
for RateFrac.

Example for Accessing a Temperature Profile

The temperature profile of a RadFrac block is written to the Control Panel, using
a Fortran Calculator block.

On the Define sheet of the Calculator block, Fortran variable TPROF of the type
Block-Vec is defined using the Variable Definition dialog box.
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On the Calculator Calculator sheet, these Fortran statements are included:
WRITE(NTERM,20)

C* LTPROF IS AUTOMATICALLY GENERATED BY Aspen Plus *
DO 10 I = 1, LTPROF
WRITE(NTERM,30) I, TPROF(I)

10 CONTINUE
20 FORMAT (' *** TEMPERATURE PROFILE ***')
30 FORMAT (10X, I3, 2X, F10.2)
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Variables Dependent on Section Number
Examples of vector variables dependent on section number are fractionation
index and duty results for SCfrac, and the sizing/rating results for trays and
packings. The layout, where Nsec denotes the number of sections in the column,
is:

Array Index Value for

1 Section 1

2 Section 2

.

.

Nsec Last section

Variables Dependent on Operation Step Number
Examples of vector variables dependent on operation step number are distillate
and reflux ratio results for BatchFrac. The layout, where Nopstep denotes the
number of operation steps, is:

Array Index Value for

1 Operation step 1

2 Operation step 2

.

.

Nopstep Last operation step
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Variables Dependent on Component Number
Examples of vector variables dependent on component number are RadFrac
thermosyphon reboiler compositions. The layout follows, where NCC denotes the
number of components entered on the Components Specifications Selection sheet.
The component order is the same as on that sheet.

Array Index Value for

1 Component 1

2 Component 2

.

.

.

NCC Last component

Variables Dependent on Component Number and Stage
or Segment Number

Examples of vector variables dependent on component number and stage number
are liquid and vapor composition profiles in RadFrac, MultiFrac, Extract,
PetroFrac, or BatchFrac. Examples of vector variables dependent on component
number and segment number are liquid and vapor composition profiles for
RateFrac. The values are stored as one-dimensional arrays. All component values
for stage or segment 1 are at the beginning, followed by all of the component
values for stage or segment 2, and so on. The number of components and the
component order are the same as on the Components Specifications Selection
sheet.
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For a column with three components and five stages, the liquid composition
profile is stored as follows:

Array Index Value for

1 Component 1, stage or segment 1

2 Component 2, stage or segment 1

3 Component 3, stage or segment 1

4 Component 1, stage or segment 2

.

.

.

15 Component 3, stage or segment 5

Example for Accessing a Mole Fraction Profile

The entire liquid mole fraction profile of a RadFrac column with three
components is accessed. The value for the second component on the fifth stage is
written to the Control Panel, using a Fortran Calculator block.

On the Define sheet of the Calculator block, Fortran variable XPROF of the type
Block-Vec is defined using the Variable Definition dialog box.
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On the Calculator Calculator sheet, include these Fortran statements:
WRITE(NTERM,10)

C* TOTAL NUMBER OF COMPONENTS IS 3 *
NCOMP = 3

C* COMPONENT TO BE ACCESSED IS 2 *
ICOMP = 2

C* STAGE TO BE ACCESSED IS 5 *
ISTAGE = 5

C* CALCULATE INDEX INTO XPROF *
II = NCOMP*(ISTAGE-1) + ICOMP
WRITE(NTERM,20) XPROF(II)

10 FORMAT(' * MOLE FRACTION OF 2ND COMPONENT ON 5TH STAGE *')
20 FORMAT(10X,F10.2)

Variables Dependent on Stage Number and Section
Number

Examples of vector variables dependent on stage number and section number are
the profile results of tray rating calculations. The values are stored as 
one-dimensional arrays. All stage values for section 1 are at the beginning,
followed by all stage values for section 2, and so on. The number of components
and the component order are the same as on the Components Specifications
Selection sheet.
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For a column with five stages and three sections, the flooding approach profile is
stored as follows:

Array Index Value for

1 Stage 1, section 1

2 Stage 2, section 1

3 Stage 3, section 1

4 Stage 4, section 1

5 Stage 5, section 1

6 Stage 1, section 2

.

.

.

15 Stage 5, section 3

Variables Dependent on Stage Number and Operation
Step Number

Examples of vector variables dependent on stage number and operation step
number are temperature and flow profiles for BatchFrac. The values are stored
as one-dimensional arrays. All stage values for operation step 1 are at the
beginning, followed by all stage values for operation step 2, and so on.

For a BatchFrac block with four stages and three operation steps, the
temperature profile is stored as follows:

Array Index Value for

1 Stage 1, operation step 1

2 Stage 2, operation step 1

3 Stage 3, operation step 1

4 Stage 4, operation step 1

5 Stage 1, operation step 2

.

.

.

12 Stage 4, operation step 3
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Variables Dependent on Component Number, Stage
Number, and Stripper Number

Examples of vector variables dependent on component number, stage number,
and stripper number are the stripper composition profiles for PetroFrac. The
values are stored as one-dimensional arrays. All component values for stage 1 of
stripper 1 are at the beginning, followed by all component values for stage 2 of
stripper 1, and so on. When Nstot is reached for stripper 1, the component and
stage values for stripper 2 begin, and so on. Nstot denotes the total number of
stages for that stripper.

For a PetroFrac block with three components, six stripper stages, and three
strippers, the liquid composition profile is stored as follows:

Array Index Value For

1 Component 1, stage 1, stripper 1

2 Component 2, stage 1, stripper 1

3 Component 3, stage 1, stripper 1

4 Component 1, stage 2, stripper 1

.

.

18 Component 3, Nstot, stripper 1

19 Component 1, stage 1, stripper 2

.

.

54 Component 3, Nstot, stripper 3



Accessing
Flowsheet
Variables

18-26 Aspen Plus User Guide
Version 10.2

Variables Dependent on Component Number, Stage
Number, and Operation Step Number

Examples of vector variables dependent on component number, stage number,
and operation step number (opstep) are the composition profiles for BatchFrac.
The values are stored as one-dimensional arrays. All component values for stage
1 of opstep 1 are at the beginning, followed by all component values for stage 2 of
opstep 1, and so on. When Nstage is reached for opstep 1, the component and
stage values for opstep 2 begin, and so on. Nstage denotes the number of stages
in the column.

For a BatchFrac block with two components, three stages, and four opsteps, the
liquid composition profile is stored as follows:

Array Index Value for

1 Component 1, stage 1, opstep 1

2 Component 2, stage 1, opstep 1

3 Component 1, stage 2, opstep 1

.

.

6 Component 2, Nstage , opstep 1

7 Component 1, stage 1, opstep 2

.

.

24 Component 2, Nstage, opstep 3

Variables Dependent on Component Number,
Accumulator Number, and Operation Step Number

The accumulator composition profile in BatchFrac is the only vector variable
dependent on component number, accumulator number, and operation step
number (opstep). The values are stored as a one-dimensional array. All
component values for accumulator 1 of opstep 1 are at the beginning, followed by
all the component values for accumulator 2 of opstep 1, and so on. Naccum
denotes the total number of accumulators in the column. When Naccum is
reached for opstep 1, the component and accumulator values for opstep 2 begin,
and so on.
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For a BatchFrac block with two components, three accumulators, and four
opsteps, the accumulator composition profile is stored as follows:

Array Index Value for

1 Component 1, accumulator 1, opstep 1

2 Component 2, accumulator 1, opstep 1

3 Component 1, accumulator 2, opstep 1

.

.

6 Component 2, Naccum, opstep 1

7 Component 1, accumulator 1, opstep 2

.

.

24 Component 2, Naccum, opstep 4

MHeatX Profiles
You can use the Block-Vec variable type to access the temperature difference
between the hot side and cold side of an MHeatX block:

Variable Description

DT Temperature approach profile,
including points added for phase change points
and points for streams entering and leaving the exchanger

DTBASE Temperature approach profile for base points only. 
The length of the vector is the Number of Zones + 1. 
The Number of Zones is specified on the MHeatX Input ZoneAnalysis sheet.

Reactor Profiles
You can use the Block-Vec variable type to access RBatch time profiles and
RPlug length profiles for variables such as calculated temperature and pressure.
Values are stored at each output point. The length of the vector is the number of
output points +1.
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For example, the temperature profile for an RBatch reactor that runs for 10
hours with output points each hour would be stored as follows:

Array Index Temperature at

1 Initial conditions

2 1 hour

3 2 hours

.

.

.

11 10 hours

The output intervals are determined as follows:

Model Output Interval

RPlug Number of Profile Points along the reactor length, specified on the RPlug Report Profiles sheet

RBatch Time Interval Between Profile Points, specified on the RBatch Setup Operation Times sheet.

Accessing Property Parameter Vectors

You can access the vector of coefficients of temperature-dependent property
parameters.

Variable type Description

Un-Cor-Vec Temperature-dependent pure component property parameter vector

Bi-Cor-Vec Temperature-dependent binary property parameter vector

Aspen Plus automatically:
• Interprets the Fortran variable you assign to the profile as an array variable
• Dimensions the variable

Aspen Plus generates a variable by adding the letter L to the beginning of the
Fortran variable name you assigned to the vector. The value of this variable is
the length of the vector.
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In Excel Calculator blocks, Aspen Plus assigns the data to a column, beginning in
the cell with the specified name.

Accessed property parameter vectors are always in SI units.

See Aspen Plus Physical Property Methods and Models, Chapter 3, for the length
and contents of each temperature-dependent property parameter. You can also
obtain this information by using Help from the Properties Parameters
PureComponent and Properties Parameters Binary sheets.

Example for Accessing Property Parameters

On the following Define sheet all references are to dataset 1.

This variable Accesses the

TC Critical temperature of component TOLUENE

HVAP Heat of vaporization of component TOLUENE. Heat of vaporization is the first element of the
temperature-dependent Watson parameter DHVLWT.

ANTOIN Antoine vapor pressure coefficients parameter PLXANT as a vector.

REN12 NRTL parameter vector for the TOLUENE-PHENOL binary

REN21 NRTL parameter vector for the PHENOL-TOLUENE binary
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19 Calculator Blocks and
In-Line Fortran

The Aspen Plus Calculator block lets you insert your own Fortran statements or
Excel 97 spreadsheet calculations into flowsheet computations. This chapter
describes:
• Calculator blocks
• Using Fortran in Aspen Plus
• Using Fortran in Calculator blocks
• Using Excel in Calculator blocks
• Identifying flowsheet variables
• Entering Fortran statements or Excel formulas
• Specifying when to execute a Calculator block
• Rules for writing Fortran statements
• Writing to the screen and Aspen Plus files
• Interactive data input
• Retaining variables between iterations and blocks

About Calculator Blocks

Calculator blocks let you insert Fortran statements or Excel 97 spreadsheets into
flowsheet computations to perform user-defined tasks.
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Since Aspen Plus is a sequential modular simulator that executes one unit
operation at a time, you must specify where in the sequence of unit operations
each Calculator block is to be executed. You can do this by specifying one of
these:
• Which flowsheet variables are Imported from and Exported to Aspen Plus by

the Calculator block
• The position of the Calculator block in the list of unit operation blocks

Define a Calculator block by:

1. Creating the Calculator block.

2. Identifying the flowsheet variables that the block samples or manipulates.

3. Entering the Excel formulas or Fortran statements.

4. Specifying when the Calculator block is executed.

Related Topics:
Using Fortran in Aspen Plus
Using Fortran in Calculator Blocks
Using Excel in Calculator Blocks

Using Fortran in Aspen Plus

You can use Fortran in Aspen Plus to perform any task that can be written as
valid Fortran expressions.

You can input Fortran expressions in a number of ways in Aspen Plus:
• In Fortran Calculator blocks
• On the Fortran sheets of other blocks, such as design specifications,

sensitivity or optimization problems
• In external Fortran subroutines

Fortran Calculator blocks:
• Contain Fortran expressions used to perform user-defined tasks
• Can read and/or write flowsheet variables
• Are executed at a specific point in the simulation

Aspen Plus checks your Fortran code interactively as you enter it so most syntax
errors are detected before a run. If the status indicator on a Fortran sheet is ,
use Next to find out what is incomplete.
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You can write external User Fortran subroutines when the models provided by
Aspen Plus do not meet your needs. After you compile these subroutines, they are
dynamically linked when the simulation is run. Aspen Plus allows extensive
customization of the models through the use of these external user subroutines.
For more information on external user subroutines, see Aspen Plus User Models.

Aspen Plus can interpret most in-line Fortran. Fortran that cannot be
interpreted is compiled and dynamically linked to the Aspen Plus module.
Because dynamic linking is used, the overhead for in-line Fortran requiring
compilation is small.

Note If the Fortran cannot be interpreted, a Fortran compiler is
needed. For the recommended compiler for a given platform, see
the relevant Aspen Plus installation guide.

Using Fortran in Calculator Blocks

Calculator blocks let you insert Fortran statements into flowsheet computations
to perform user-defined tasks, such as:
• Calculating and setting input variables before they are used (feedforward

control)
• Writing information to the Control Panel
• Reading input from a file
• Writing results to the Aspen Plus report or to any external file
• Calling external subroutines
• Writing your own user models

Define a Fortran Calculator block by:

1. Creating the Calculator block.

2. Identifying the flowsheet variables that the block samples or manipulates.

3. Entering the Fortran statements on the Calculate sheet.

4. Specifying when the Calculator block is executed.
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Creating a Calculator Block Using Fortran
To create a Fortran Calculator block:

1. From the Data menu, point to Flowsheeting Options, then Calculator.

2. In the Calculator Object Manager, click New.

3. In the Create New ID dialog box, enter an ID or accept the default, and click
OK.

4. On the Calculate sheet, select Fortran (default).

The following sections describe how to complete the required sheets.

Using Excel in Calculator Blocks

Calculator Blocks let you insert Excel 97 Spreadsheets into flowsheet
computations to perform user-defined flowsheet manipulations.

Note Excel 97 is required to use this feature.

Note If you want to use Excel to simulate a unit operation block, use
the Excel interface of the User2 block instead of the Excel
Calculator. See Aspen Plus User Models, chapter 5.

Define an Excel Calculator block by:

1. Creating the Calculator block.

2. Identifying the flowsheet variables that the block samples or manipulates.

3. Entering the Excel formulas on the Calculate sheet.

4. Specifying when the Calculator block is executed.

Since the Excel spreadsheet is connected to Aspen Plus through the user
interface, the user interface must be running in order to run an Aspen Plus
simulation containing an Excel Calculator block.
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Creating a Calculator Block Using Excel
To create an Excel Calculator Block:

1. From the Data menu, point to Flowsheeting Options, then Calculator.

2. In the Excel Calculator Object Manager, click New.

3. In the Create New ID dialog box, enter an ID or accept the default, and click
OK.

4. On the Calculate sheet, select Excel.

The following sections describe how to complete the other required sheets.

Identifying Flowsheet Variables

You must identify the flowsheet variables used in a Calculator block and assign
them variable names. A variable name identifies a flowsheet variable on other
Calculator block sheets.

Using the Define Sheet to Identify Flowsheet Variables

Use the Define sheet to identify a flowsheet variable and assign it a variable
name. When completing a Define sheet, specify the variables on the Variable
Definition dialog box. The Define sheet shows a concise summary of all the
accessed variables, but you cannot modify the variables on the Define sheet.

1. To create a new variable, click the New button on the Define sheet.
– or –
To edit an existing variable, select a variable and click the Edit button on the
Define sheet.
– or –
To create or edit the variable from Excel, on the Calculate sheet, click the
Open Excel Spreadsheet button. In Excel, select the cell and click the Define
button on the Aspen Plus toolbar.

2. Type the name of the variable in the Variable Name field.

A Fortran variable name must:
• Be six characters or less for a scalar variable
• Be five characters or less for a vector variable
• Start with an alphabetic character (A – Z)
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• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

An Excel variable name must:
• Follow the above limitations on Fortran variable names
• Not be a cell reference, such as A1 or R1C1.

Variable names are not case-sensitive in either Fortran or Excel. For
instance, FLOW and Flow refer to the same variable.

3. In the Category frame, use the option button to select the variable category.

4. In the Reference frame, select the variable type from the list in the Type field.

Aspen Plus displays the other fields necessary to complete the variable
definition.

5. In the Information Flow frame, select whether the variable is to be imported
from Aspen Plus or exported to Aspen Plus from the Calculator block. For
more information on Import and Export variables, see Specifying When the
Calculator Block is Executed, this chapter.

Export variables in recycle loops may instead be marked as tear variables to
indicate that they should be torn for solving the loops. For more information,
see Converging Loops Introduced by Calculator Blocks, this chapter.

6. Click Close to return to the Define sheet.

For more information on accessing variables, see Chapter 18.

Tip Use the Delete button to quickly delete a variable and all of the
fields used to define it. Use the Edit button to modify the
definition of a variable in the Variable Definition dialog box.

Specifying Calculations

The Calculate sheet lets you enter the calculations to be performed. Select either
Excel or Fortran for specifying these calculations.
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Entering Fortran Statements and Declarations
You can enter Fortran statements:
• On the Calculate sheet
• In your text editor (for example, Notepad), and then copy and paste them onto

the Calculate sheet

Click the Fortran Declarations button to enter Fortran declarations in the
Declarations dialog box, in the same way you enter executable Fortran
statements on Calculate sheet.

You can include any Fortran declarations in a Calculator block, such as:
• Include statements
• COMMON definitions
• DIMENSION definitions
• Data type definitions (INTEGER and REAL)

If a Fortran variable meets one of these criteria, you should place it in a
COMMON:
• It is also used by another block.
• Its value must be retained from one iteration of a Calculator block to another.

Fortran variables that you defined on the Define sheet should not be declared in
the Declarations dialog box.

Using the Calculate Sheet to Enter Fortran Statements

To enter executable Fortran statements on the Calculate sheet:

1. Click the Calculate tab on the Calculator Input form.

To review rules and restrictions for in-line Fortran, see Rules for In-Line
Fortran Statements, this chapter.

2. Enter your Fortran statements.

3. To ensure that you enter accurate variable names, click the right mouse
button. In the popup menu, click Variable List.

The Defined Variable List window appears. You can drag and drop the
variables from the Defined Variable List to the Calculate sheet.
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Entering Excel Formulas
Use the Excel option on the Calculate sheet to create an Excel spreadsheet
embedded in your simulation to hold Excel calculation formulas.

Cells corresponding to defined variables will be outlined in a colored box. Import
variables will be outlined in green, Export variables will be outlined in blue, and
Tear variables will be outlined in red. If you define any variables on the Define
sheet, be sure to assign those names to cells in Excel.

Do not enter formulas in cells referenced by Import variables; these cells will be
overwritten by the values imported from Aspen Plus. In other cells on your
spreadsheet, enter the formulas necessary to calculate your results and place
them into the cells assigned to Export variables.

You may use VBA macros to perform some of your calculations or other tasks, if
you wish. Aspen Plus will only read and write values on the first sheet, and only
initiate calculations there, but you may use additional sheets to store data, or to
perform more involved calculations.
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Specifying When the Calculator Block is
Executed

You must specify when a Calculator block will be executed during calculations.
To do this:

1. On the Calculator Input form, click the Sequence sheet.

2. In the Import Variables field, specify which variables are used but not
changed. In the Export Variables field, specify which variables are changed.
You may have already made these specifications when you defined the
variables, but you may change them here.
– or –
In the Execute field on the Sequence sheet, specify when to execute the block.

Option When Executed

First At the beginning of a simulation

Before Before a block. Specify the block type and name.

After After a block. Specify the block type and name.

Last At the end of a simulation

Report While the report is being generated

Based on order in sequence As specified on the Convergence Sequence Specification sheet

Use Import/Export Variables Aspen Plus uses import and export variables to automatically sequence the Calculator block.

Import Variables and Export Variables are used to establish which of the
variables appearing on the Define sheet are only sampled variables, and which
are changed by the Calculator block.

Import Variables establish information flow from the block or stream containing
a sampled (read-only) variable to the Calculator block.

Export Variables establish information flow from the Calculator block to Aspen
Plus.

If the automatic sequencing logic using Import Variables and Export Variables
does not appear to work properly, use the Execute statement to specify explicitly
when the block is executed.

In Excel Calculator blocks, all variables must be specified as Import or Export
Variables.
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If you specify a variable as a Tear Variable on the Variable Definition dialog box,
that variable is also treated as an Export Variable.

Converging Loops Introduced by
Calculator Blocks

A Calculator block can introduce loops that must be solved iteratively.

For example, a Calculator block can change an upstream variable based on the
value of a downstream variable. This could occur if the Calculator block was
being used to set a makeup stream based on the product flowrates.

When you define Excel Calculator blocks, you must specify each variable as an
Import or Export variable. Aspen Plus uses these specifications to automatically
solve any loops introduced by the block.

In Fortran Calculator blocks that create loops, you must specify Import Variables
and Export Variables for Aspen Plus to detect the loops and produce correct
simulation results.

Aspen Plus automatically solves any loops introduced by the Calculator block, if
you:
• Check the Tear Calculator Export Variables on the Convergence Conv-

Options Defaults Sequencing sheet
• Specify Import Variables and Export Variables on the Calculator block

Variable Definition dialog boxes or Sequence sheet.

When a Calculator block creates a loop, variables entered as Export Variables
can be torn for convergence in the same way as recycle streams. Aspen Plus can
do this automatically, or you can specify tear variables.

To specify an Export Variable as a tear variable:

1. On the Calculator form, click the Tears tab.

2. In the Tear Variable Name field, select a variable you entered in the Export
Variable field on the Sequence sheet.

3. Enter lower and upper bounds for the tear variable in the Lower Bound and
Upper Bound fields.

You may also specify a variable as a tear variable when defining it in the
Variable Definition dialog box.
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The tear variable will be solved along with recycle tears to converge the
flowsheet. See Chapter 17, Convergence, for more information on flowsheet
convergence.

Example of Calculating Make-Up Flow Rate

The mass flow rate of make-up stream MAKEUP is determined by the amount of
benzene in the outlet streams from the flowsheet. The variables are selected
using the Variable Definition dialog box. In order for the simulation to converge
correctly, the Tear Fortran Export Variables needs to be selected on the
Convergence Conv-Options Defaults Sequencing sheet.

Using the specifications above, all five variables are defined as in the example
below:
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On the Calculate sheet, Fortran is selected, and these statements are entered:
F BMAKE = BZIPA + BZH2O + BZVAP
F MAKEUP = BMAKE / BFRAC

On the Declarations dialog box, this declaration is entered:
F REAL*8 BMAKE

On the Sequence sheet, Use import/export variables is selected for the execution
seqeunce. Also, BZIPA, BZH2O, and BZVAP are specified as Import variables,
and MAKEUP is specified as an Export variable.

On the Convergence Conv-Options Defaults Sequencing sheet, Tear Calculator
Export Variables is selected:



Chapter  19

Aspen Plus User Guide 19-13
Version 10.2

Example of Feedforward Control of Stream Feedrate

A Fortran block is used to set the feedrate of stream HX2 to equal 75% of the
stream HX1.

On the Calculate sheet, Fortran is selected, and this statement is entered:
F2 = 0.75 * F1

On the Sequence sheet, Use import/export variables is selected for the execution
sequence. Also, F1 is specified as an Import variable, and F2 is specified as an
Export variable.
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Rules for In-Line Fortran Statements

To achieve successful compilation of your Fortran statements, follow these rules:
• By default, variables beginning with A through H, or O through Z, are double

precision real. Variables beginning with I through N are integer. Use double
precision functions (for example, DSQRT) and double precision constants (for
example, 1D0).

• Do not use variable names beginning with IZ or ZZ.
• Because Fortran is column-sensitive, this table shows how to do certain

things:

To do this Use

Indicate comments Column one for C and leave column two blank

Enter statement labels Only columns three, four, and five

Begin executable statements Column seven or beyond

• You can call your own subroutines or functions. You can use labeled or blank
(unlabeled) COMMON blocks.

• Fortran variables you define on the Specification sheet cannot be placed in a
COMMON.

• Do not use IMPLICIT, SUBROUTINE, ENTRY, RETURN, END statements,
nor arithmetic statement functions.

Disabling Syntax Checking
By default, Aspen Plus interactively checks your Fortran statements. You can
turn off interactive syntax checking. You might need to do this, for example, if
you are using a compiler that accepts nonstandard Fortran extensions, or if the
syntax checker incorrectly flags correct Fortran as incomplete.

To turn off Fortran syntax checking:

1. From the Tools menu, click Options.

2. Ensure the Check Inline Fortran for Syntax Errors checkbox is clear.
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Writing to the Screen and Aspen Plus
Files

In Fortran WRITE statements, you can use the following predefined variables for
the unit number:

Unit Destination

NTERM Control Panel (if running from the user interface)
Terminal (if running interactively outside of the user interface), or
Log file (if running batch)

NRPT Aspen Plus report

NHSTRY Simulation history

Examples:

For writing to the Control Panel, enter:

WRITE(NTERM, *) A, B, C, X

For writing to the report file, enter:

WRITE(NRPT, *) A, B, C, X

If writing to the Aspen Plus report from a Fortran Calculator block, select Report
in the Execute field on the Sequence Sheet. Output written to the report file will
appear in the Flowsheet section of the Calculator block report.

When writing to a user-defined file, use a Fortran unit number between 50 and 100.

Excel Calculator blocks do not have the ability to write to the Control Panel or Aspen
Plus report or history files, but you may use VBA macros to display information in
dialog boxes.

Interactive Read Statements

In Fortran READ statements you can use the predefined variable NTERM for the
unit number for interactive input.
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This table shows what the predefined variable does:

If you are running interactively Then READ (NTERM †)

From the user interface Displays a dialog box accepting up to one line of input

Outside the user interface Pauses for input from the terminal

†
Do not read from NTERM when running batch.

In Excel Calculator blocks, use a VBA macro to create a dialog box for interactive
input.

Example of Interactive READ from a Fortran Calculator block

A Fortran Calculator block pauses for user input of the temperature for block
HX1 before executing the block.

The following form defines the variable HX1TEM as the temperature input
specification for block HX1:

These Fortran statements read HX1TEM from interactive screen input, and echo
the value to the control panel:

READ(NTERM,*) HX1TEM
WRITE(NTERM,*) 'TEMPERATURE ENTERED',
1' FOR BLOCK HX1 WAS ',HX1TEM,' F'
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The Sequence sheet specifies that HX1TEM is a write variable, so that
Aspen Plus can sequence the Calculator block, and Use import/export variables is
selected.

Retaining Variables Between Iterations
and Blocks

Place a Fortran variable in a COMMON (on the Declarations sheet) if you want
to do one of the following:
• Retain the value of the variable from one calculation pass to another
• Use the same variable in more than one block

The COMMON statement must appear in each block where the variable is used.

In Excel Calculator blocks, all data in the Workbook at the end of one calculation
pass is present when the block is next started, except that the Import variables
will be overwritten by new values from Aspen Plus.

About the Interpreter

By default, Aspen Plus will interpret in-line Fortran if it is possible. Fortran that
cannot be interpreted is compiled and linked into a shared library or dynamic
link library (DLL). A Fortran compiler is needed for compiling the code. (See the
appropriate installation guide for the recommended compiler for a given
platform.) It is possible to compile all of the Fortran by selecting Write Inline
Fortran to a Subroutine to be Compiled and Dynamically Linked on the Setup
SimulationOptions System sheet.

The following Fortran can be interpreted:
• All declarations besides COMMON statements
• Arithmetic expressions and assignment statements
• IF statements
• GOTO statements, except assigned GOTO
• WRITE statements that use the built-in unit number variables NTERM,

NRPT, or NHSTRY
• FORMAT statements
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• CONTINUE statements
• DO loops
• Calls to these built-in Fortran functions:

DABS DERF DMIN1 IDINT

DACOS DEXP DMOD MAX0

DASIN DFLOAT DSIN MIN0

DATAN DGAMMA DSINH MOD

DATAN2 DLGAMA DSQRT

DCOS DLOG DTAN

DCOSH DLOG10 DTANH

DCOTAN DMAX1 IABS

You can also use the equivalent single precision or generic function names. But
Aspen Plus always performs double precision calculations.

If you use the following statements, you must enter them on the Declaration
sheet:
• REAL or INTEGER statements
• DOUBLE PRECISION statements
• DIMENSION statements
• COMMON statements

The following statements require compilation:

CALL ENTRY PRINT

CHARACTER EQUIVALENCE RETURN

COMMON IMPLICIT READ

COMPLEX LOGICAL STOP

DATA PARAMETER SUBROUTINE

About External Fortran Subroutines

External user Fortran is an open and extensive customization capability in
Aspen Plus. An Aspen Plus user model consists of one or more Fortran
subroutines that you write yourself when the models provided by Aspen Plus do
not meet your needs. A proper argument list is needed in the subroutine to
interface your user model to Aspen Plus.
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You can write the following kinds of user models for use in Aspen Plus:

External Fortran Application Types Use

User Unit Operation Models Units not represented by Aspen Plus unit operation models

Kinetic Models Reactors, Reactive Distillation, Pressure Relief

Physical Property Models Pure and mixture, activity models, KLL, user equations-of-state

Stream Properties Special properties to be calculated for a stream

Unit Operation Customization Reactor heat transfer, column hydraulics, LMTD correction, pressure drop, liquid-
liquid distribution coefficients

Customized Reports User-defined stream report, user block reports, applications based on the
Summary File Toolkit

Sizing and Costing User cost blocks

Templates that include the argument list and other useful code for starting a
user model are provided in the Templates directories where Aspen Plus is
installed. For more information on how to write a user model, see Aspen Plus
User Models.
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20 Sensitivity

This chapter explains how to use sensitivity analysis to examine the sensitivity of
a process to key variables including:
• What is sensitivity analysis?
• Defining a sensitivity block
• Specifying sampled and manipulated variables
• Defining tabulated variables
• Optional Fortran statements
• Examples

About Sensitivity Analysis

Sensitivity analysis is a tool for determining how a process reacts to varying key
operating and design variables.  You can use it to vary one or more flowsheet
variables and study the effect of that variation on other flowsheet variables. It is
a valuable tool for performing “what if” studies. The flowsheet variables that are
varied must be inputs to the flowsheet. They can not be variables that are
calculated during the simulation.

You can use sensitivity analysis to verify if the solution to a design specification
lies within the range of the manipulated variable. You can also use it to perform
simple process optimization.
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You can use sensitivity blocks to generate tables and/or plots of simulation
results as functions of feed stream, block input, or other input variables.
Sensitivity analysis results are reported in a table on the Sensitivity Results
Summary sheet. The first n columns of the table list the values of the variables
that are varied, where n is the number of varied flowsheet variables entered on
the Sensitivity Input Vary sheet. The remaining columns in the table contain the
values of variables that you tabulated on the Tabulate sheet. The tabulated
results can be any flowsheet variable or any valid Fortran expression that may
depend on flowsheet variables that are either input or calculated.

The results can be plotted using the Plot Wizard from the Plot menu to easily
visualize the relationships between different variables. See Chapter 13 for more
information about the Plot Wizard.

Sensitivity blocks provide additional information to base-case results, but have
no effect on the base-case simulation. The simulation runs independently of the
sensitivity study.

Sensitivity blocks with more than one varied variable generate a row in the
sensitivity table for each combination of values. If you are interested in the
sensitivity to more than one variable with each varied independently, use a
separate sensitivity block for each varied variable.

Sensitivity blocks create loops that must be evaluated once for each row of the
sensitivity table. Aspen Plus sequences sensitivity blocks automatically. Or, you
can sequence a sensitivity block using the Convergence Sequence Specifications
sheet.

Accessed scalar flowsheet variables are in the units set selected for the
sensitivity block. You cannot modify the units individually for different variables
in the sensitivity. You can either change the unit set for the sensitivity block (on
the toolbar of the Data Browser), or enter an expression on the tabulate sheet to
convert the variable.  Accessed vector variables are always in SI units.
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Define a sensitivity block by:

1. Creating the sensitivity block

2. Identifying the sampled flowsheet variables

3. Identifying the input variables to manipulate to generate the table

4. Defining what you want Aspen Plus to tabulate

5. Entering optional Fortran statements

Creating a Sensitivity Block
To create a sensitivity block:

1. From the Data menu, click Model Analysis Tools, then Sensitivity.

2. On the Sensitivity Object Manager, click Create.

3. In the Create New ID dialog box, enter an ID or accept the default, and click
OK. In the Create dialog box, enter an ID and click OK.

Identifying the Sampled Flowsheet Variables
For each sensitivity block you must identify the flowsheet variables and assign
them variable names. You can either tabulate these variables or use them in
Fortran expressions to compute tabulated results. The variable name identifies
the flowsheet variable on other sensitivity sheets.

Use the Define sheet to identify a flowsheet variable and assign it a variable
name. When completing a Define sheet, specify the variables on the Variable
Definition dialog box. The Define sheet shows a concise summary of all the
accessed variables, but you cannot modify the variables on the Define sheet.

On the Define sheet:

1. To create a new variable, click the New button.
– or –
To edit an existing variable, select a variable and click the Edit button.

2. Type the name of the variable in the Variable Name field. 
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If you are editing an existing variable and want to change the variable name,
click the right mouse button on the Variable Name field.  On the popup menu,
click Rename.  A variable name must:
• Be six characters or less for a scalar variable
• Be five characters or less for a vector variable
• Start with an alphabetic character (A – Z)
• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

3. In the Category frame, use the option button to select the variable category.

4. In the Reference frame, select the variable type from the list in the Type field.
Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.
For more information on accessing variables, see Chapter 18.

Tip Use the Delete button to quickly delete a variable and all of the
fields used to define it.

Tip Use the Edit button to modify the definition of a variable in the
Variable Definition dialog box.

For more information about accessing flowsheet variables, see Chapter 18. For
more information about using the Define sheet to identify flowsheet variables,
see Chapter 19.

Identifying Manipulated Flowsheet Variables
Use the Vary sheet to identify the flowsheet variables to vary in generating a
table. You can only vary block input variables, process feed stream variables, and
other input variables. You must specify values, or a range of values, for the
varied variables.

You can manipulate integer variables, such as the feed location of a distillation
column. You can specify up to five manipulated variables.

To identify manipulated variables and specify values:

1. On the Sensitivity Input form, click the Vary sheet.

2. In the Variable Type field, select a variable type.
Aspen Plus takes you to the remaining fields necessary to uniquely identify
the flowsheet variable.
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3. Specify a list or range of values for the manipulated variable. You can enter
one of the following:
• List of values
• Lower limit, Upper limit, and number of equally spaced points (# Points)
• Lower limit, Upper limit, and increment between points (Incr)
You can enter either a constant or a Fortran expression.

4. You have the option of labeling the varied variables for the report and the
Results Summary sheet. Use the Line1 through Line4 fields to define these
labels.

5. To identify additional variables, select New from the list in the Variable
Number field. Repeat Steps 2 through 5.

Aspen Plus generates one row of the table for each combination of varied variable
values. The number of possible combinations can be large, resulting in excessive
computer time and storage requirements. For example, 10 points for each of the
maximum of five variables would result in 100,000 evaluations of the sensitivity
block loop.

Each manipulated variable must already have been entered as an input
specification, or it must have a default value.

Defining Tabulated Variables
Use the Tabulate sheet for defining the results you want Aspen Plus to tabulate,
and supplying column headings.

To define tabulated variables:

1. On the Sensitivity Input form, click the Tabulate sheet.

2. In the Column Number field, enter a column number.

3. In the Tabulated Variable or Expression field, enter a variable name or
Fortran expression.
Aspen Plus tabulates the variable, or the result of the expression, for each
combination of manipulated variables.
To ensure that you enter accurate variable names, click the right mouse
button. In the popup menu, click Variable List. The Defined Variable List
window appears. You can drag and drop the variables from the Defined
Variable List to the Fortran sheet.

4. To enter optional labels, click the Table Format button. In the first four rows,
supply column labels for any or all of the columns of tabulated results.

5. Use the two Unit Labels rows to enter units labels for the tabulated results.
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6. If the tabulated results expression is entered as a single variable name on the
Specification sheet, Aspen Plus generates unit labels automatically.

7. Click Close to close the Table Format dialog box.

8. Repeat Steps 2 through 6 until you define all the results you want to tabulate.
There is no limit.

Reinitializing Blocks and Streams
By default, Aspen Plus begins the calculations for a new row using the results of
the previous row. If blocks or recycle loops fail to converge for some rows, you can
specify that the calculations are to be reinitialized for each row.

Reinitializing Blocks

To reinitialize blocks:

1. On the Sensitivity Input form, select the Optional tab.

2. In the Blocks to be Reinitialized field, select either Include Specified Blocks or
Reinitialize All Blocks.

3. If you choose Include Specified Blocks, select the unit operation blocks and/or
the convergence blocks to be reinitialized.

Reinitializing Streams

To reinitialize streams:

1. On the Sensitivity Input form, select the Optional tab.

2. On the Streams To Be Reinitialized field select either Include Specified
Streams or Reinitialize All Streams.

3. If you choose Include Specified Streams, select the streams to be reinitialized.

Entering Optional Fortran Statements
You have the option of entering Fortran statements to compute tabulated results
and the varied variable range. Any variable computed by a Fortran statement
can be used in expressions on the Tabulate and Vary sheets. Fortran statements
are needed only if functions are too complex to enter on these sheets.
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You can enter Fortran statements:
• On the Fortran sheet
• In your text editor (for example, Notepad), and then copy and paste them onto

the Fortran sheet

Using the Sensitivity Input Fortran Sheet

To enter executable Fortran statements on the Fortran sheet:

1. On the Sensitivity Input form, click the Fortran sheet.

2. Review the rules and restrictions for in-line Fortran. For more information,
see Chapter 19.

3. Enter your Fortran statements.
To ensure that you enter accurate variable names, click the right mouse
button. In the popup menu, click Variable List. The Defined Variable List
window appears. You can drag and drop the variables from the Defined
Variable List to the Fortran sheet.

Fortran Declarations

Enter Fortran declarations in the same way as executable Fortran statements,
using the Declarations sheet instead of the Fortran sheet.

You can include any Fortran declaration in a Sensitivity block, including:
• COMMON definitions
• DIMENSION definitions
• Data type definitions (INTEGER and REAL)

If a Fortran variable meets one of these criteria, you should place it in a
COMMON:
• It is also used by another block.
• Its value must be retained from one iteration of a sensitivity block to another.

Fortran variables that you defined on the Define sheet should not be declared on
the Declarations sheet.
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Example for Tabulating Reaction Selectivity versus Reactor Temperature

Tabulate the effect of temperature in RGibbs block REACT on the selectivity of
component ESTER versus ETOH in the reactor outlet. Assume that an initial
specification for the temperature of block REACT has been entered on the
RGibbs Setup Specifications sheet.
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The selectivity which is the ratio of FESTER to FALC can be entered as a
Fortran expression FESTER/FALC on the Tabulate sheet.
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21 Design Specifications:
Feedback Control

Use design specifications as feedback controllers in your simulation. This chapter
describes:
• What are design specifications?
• Creating design specifications
• Specifying targeted variables
• Specifying manipulated variables
• Optional Fortran statements

About Design Specifications

A design specification sets the value of a variable that Aspen Plus would
otherwise calculate. For example, you may want to specify a product stream
purity or the permissible amount of an impurity in a recycle stream. For each
design specification, you identify a block input variable, process feed stream
variable, or other simulation input to be manipulated (adjusted) to meet the
specification. For example, you might manipulate a purge rate to control the level
of impurities in a recycle stream. Design specifications can be used to simulate
the steady state effect of a feedback controller.

When you use a design specification, you specify a desired value for a flowsheet
variable or some function of flowsheet variables. The flowsheet variables used in
a design specification are called sampled variables. For each design specification,
you must also select a block input variable or process feed stream variable to be
adjusted to satisfy the design specification. This variable is called the
manipulated variable.
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The design specification achieves its objective by manipulating an input variable
specified by the user. Quantities that are calculated during the simulation should
not be varied directly. For example, the stream flow rate of a recycle stream
cannot be varied; however, the split fraction of an FSplit block where the recycle
stream is an outlet can be varied. A design specification can only manipulate the
value of one input variable.

Design specifications create loops that must be solved iteratively. By default
Aspen Plus generates and sequences a convergence block for each design
specification. You can override the default by entering your own convergence
specifications. For a complete discussion of design specification convergence, see
Chapter 17.

The value of the manipulated variable that is provided in the Stream or Block
input is used as the initial estimate. Providing a good estimate for the
manipulated variable will help the design specification converge in fewer
iterations. This is especially important for large flowsheets with several
interrelated design specifications.

The objective of the specification is that it equals the calculated value (Specified
Value - Calculated Value = 0). The specification can be any valid Fortran
expression involving one or more flowsheet quantities. Specifications must also
have a tolerance within which the objective function relation must be satisfied.
Therefore, the actual equation that must be satisfied is

| Specified Value - Calculated Value | < Tolerance

There are no results associated directly with a specification other than whether
the objective function equation was satisfied or not. The final value of the
manipulated an/or sampled variables can be viewed directly on the appropriate
Stream or Block results sheets. The summary and iteration history of the
Convergence block can be found by selecting the Results sheet of the appropriate
Convergence block.

Defining a Design Specification

There are five steps involved in defining a design specification:

1. Creating the design specification

2. Identifying the sampled flowsheet variables used in the specification.

3. Specifying the target value for a sampled variable or some function of
sampled variables and a tolerance.
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4. Identifying a simulation input variable to be adjusted to achieve the target
value, and specifying the limits within which it can be adjusted.

5. Entering optional Fortran statements.

Subsequent sections of this chapter describe each of these steps.

Creating a Design Specification
To create a design specification:

1. From the Data menu, point to Flowsheeting Options, then Design Specs.
In the Design Specification Object Manager, click New.

2. In the Create New ID dialog box, enter an ID or accept the default, and click
OK.
The following sections describe how to complete the required sheets.

Identifying Sampled Flowsheet Variables
Use the Flowsheeting Options Design Spec Define sheet to identify the flowsheet
variables used in the design specification and assign them variable names. The
variable name identifies the flowsheet variable on other design specification
sheets.

Use the Define sheet to identify a flowsheet variable and assign it a variable
name. When completing a Define sheet, specify the variables on the Variable
Definition dialog box. The Define sheet shows a concise summary of all the
accessed variables, but you cannot modify the variables on the Define sheet.

On the Define sheet:

1. To create a new variable, click the New button.
or
To edit an existing variable, select a variable and click the Edit button.

2. Type the name of the variable in the Variable Name field. If you are editing
an existing variable and want to change the variable name, click the right
mouse button on the Variable Name field. On the popup menu, click Rename.
A variable name must:
• Be six characters or less for a scalar variable
• Be five characters or less for a vector variable
• Start with an alphabetic character (A – Z)
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• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

3. In the Category frame, use the option button to select the variable category.

4. In the Reference frame, select the variable type from the list in the Type field.
Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.

See Chapter 18, Accessing Flowsheet Variables for more information on accessing
variables.

Tip Use the Delete button to quickly delete a variable and all of the
fields used to define it.

Tip Use the Edit button to modify the definition of a variable in the
Variable Definition dialog box.

Entering the Design Specification
To enter the design specification:

1. On the Design Spec form, click the Spec sheet.

2. In the Spec field, enter the target variable or Fortran expression.

3. In the Target field, specify the target value as a constant or Fortran
expression.

4. In the Tolerance field, enter the specification tolerance as a constant or
Fortran expression.

The design specification is:

Spec expression = Target expression

The design specification is converged when:

– Tolerance < Spec expression – Target expression < Tolerance

If you need to enter more complex Fortran than can be handled in a single
expression, you can enter additional Fortran statements. See Entering Optional
Fortran Statements, this chapter.



Chapter  21

Aspen Plus User Guide 21-5
Version 10.2

Tip To ensure that you enter accurate variable names, click the right
mouse button on the Spec, Target, or Tolerance field. In the
popup menu, click Variable List. The Defined Variable List
window appears. You can drag and drop the variables from the
Defined Variable List to the Spec sheet.

Identifying the Manipulated Variable
Use the Vary sheet to identify the manipulated variable and specify its limits.
The limits for manipulated variables can be constants or functions of flowsheet
variables.

To identify the manipulated variable and specify limits:

1. On the Design Spec form, click the Vary sheet

2. In the Type field, select a variable type.
Aspen Plus takes you to the remaining fields necessary to uniquely identify
the flowsheet variable.

3. In the Lower field, enter a constant or Fortran expression as the lower limit
for the manipulated variable.

4. In the Upper field, enter a constant or Fortran expression as the upper limit
for the manipulated variable.

You must have already entered the manipulated variable as an input
specification, or it must have a default value. The initial guess used for the
manipulated variable is this specification or the default. You cannot manipulate
integer block input variables, such as the feed location of a distillation column.

If the design specification cannot be met because the solution is outside the limit
range, Aspen Plus chooses the limit that most closely meets the specification.

Entering Optional Fortran Statements
You have the option of entering any Fortran statements needed to compute the
design specification terms or manipulated variable limits. Any variable that is
computed by the Fortran statements can be used in the expressions on the Spec
and Vary sheets. Fortran statements are needed only if the functions involved
are too complex to enter on the Spec and Vary sheets.
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You can enter Fortran statements:
• On the Fortran sheet
• In your text editor (for example, Notepad), and then copy and paste them onto

the Fortran sheet

Enter Fortran declarations in the same way as executable Fortran statements,
using the Declarations sheet instead of the Fortran sheet.

You can include any Fortran declarations in a Design Spec block, such as:
• Include statements
• COMMON definitions
• DIMENSION definitions
• Data type definitions (INTEGER and REAL)

If a Fortran variable meets one of these criteria, you should place it in a
COMMON:
• It is also used by another block.
• Its value must be retained from one iteration of a block to another.

Fortran variables that you defined on the Specification sheet should not be
declared on the Declarations sheet.

Using the Fortran Sheet
To enter executable Fortran statements on the Fortran sheet:

1. On the Design Spec form, click the Fortran sheet.

2. Use Help to review rules and restrictions for in-line Fortran.

3. Enter your Fortran statements.
To ensure that you enter accurate variable names, click the right mouse
button. In the popup menu, click Variable List. The Defined Variable List
window appears. You can drag and drop the variables from the Defined
Variable List to the Fortran sheet.
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Troubleshooting Design Specifications

If the objective function was not satisfied, there are a number of options to
consider:
• Check to see that the manipulated variable is not at its lower or upper bound.
• Verify that a solution exists within the bounds specified for the manipulated

variable, perhaps by performing a sensitivity analysis.
• Check to ensure that the manipulated variable does indeed affect the value of

the sampled variable.
• Try providing a better starting estimate for the value of the manipulated

variable.
• Narrowing the bounds of the manipulated variable or loosening the tolerance

on the objective function might help convergence.
• Try changing the characteristics of the Convergence block associated with the

design specification (step size, number of iterations, etc.)
• Make sure that the objective function does not have a flat region within the

range of the manipulated variable.

Example for Feedback Control of Reactor Selectivity

Manipulate the temperature of RGibbs block REACT to control the selectivity of
component ESTER versus ETOH at a value of 2.50 +/- 0.01. This example
assumes that temperature was specified for block REACT on the RGibbs Setup
Specification sheet. The RGibbs specification becomes the initial estimate for the
design specification.
• The molar flow rate of ESTER and of ETOH in stream PROD are the sample

variables. These variables are called FESTER and FALC, respectively.
• The design specification is FESTER/FALC = 2.50.
• The design specification is satisfied when |FESTER/FALC -2.50| < 0.01.
• Fortran expressions such as FESTER/FALC can be used in any part of the

specification expression: the spec, the target or the tolerance.
• The reactor temperature is the manipulated variable. The design specification

convergence block will find the reactor temperature that makes
FESTER/FALC=2.5.

• The temperature is specified in the reactor block just as if there were no
design specification. The specified value is the initial estimate used by the
design specification convergence block.
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• The design specification convergence block will not try a temperature less
than 50F or greater than 150F, even if the solution to the objective function
lies outside this range. The limits become alternative specifications if the
design specification cannot be achieved. The initial estimate entered in the
reactor block lies within these limits.

• You do not have to specify convergence of the design specification. Aspen Plus
will automatically generate a convergence block to converge the specification.
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Example for Design Specification with Variable Tolerance and Limits

A design specification designates that the inlet and outlet entropies of a Heater
block HX1 are equal. The temperature of HX1 is chosen as the manipulated
variable. Temperature limits cannot be set a priori, but it is known that the
isentropic temperature will be within 75oF of the inlet temperature. The
tolerance for the specification is a function of the entropy.
• The inlet and outlet entropy and the inlet temperature of the block HX1 are

the sample variables. The entropy of the inlet stream HX1-IN is called SIN.
The outlet entropy of the outlet stream HX1-OUT is called SOUT. The
temperature of stream HX1-IN is called TIN.

• The design specification sets the inlet entropy SOUT equal to the inlet
entropy SIN.

• The tolerance is specified as the variable TOL. TOL is specified as 0.0001
times the absolute value of the entropy of the inlet stream SIN on the Design
Spec Fortran sheet.

• The design specification is satisfied when |SOUT - SIN| < TOL.
• The temperature is specified in the Heater block just as if there were no

design specification. The specified value is the initial estimate used by the
design specification convergence block.

• The design specification convergence block will not try a temperature less
than the inlet temperature TIN - 75F or greater than TIN + 75F, even if the
solution to the objective function lies outside this range. The limits become
alternative specifications if the design specification cannot be achieved. The
initial estimate entered in the reactor block lies within these limits.

• You do not have to specify convergence of the design specification. Aspen Plus
will automatically generate a convergence block to converge the specification.
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Example for Adjusting the Standard Enthalpy of Formation to Achieve a
Desired Heat of Reaction

The heat of reaction for the hydrogenation of ethylene is known to be -32700
cal/mol at 298 K. Aspen Plus predicts a value of -32570. Since it is possible to
access physical property parameters (see Chapter 19, Accessing Variables), a
design specification is used to adjust the Standard Enthalpy of Formation to
achieve the desired heat of reaction.

In Aspen Plus, the heat of reaction is calculated as the difference in enthalpy of
the pure components. Since the Standard Enthalpy of Formation (pure
component parameter DHFORM) is used to calculate vapor and liquid
enthalpies, adjusting DHFORM will similarly adjust the heat of reaction.
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22 Optimization

This chapter includes information on:
• About Optimization
• Recommended Procedure for Optimization
• Defining an Optimization Problem
• About Constraints
• Entering Optional Fortran Statements
• Fortran Declarations
• Convergence of Optimization Problems
• Troubleshooting Optimization Problems

About Optimization

Use optimization to maximize or minimize a user-specified objective function by
manipulating decision variables (feed stream, block input, or other input
variables).

The objective function can be any valid Fortran expression involving one or more
flowsheet quantities. The tolerance of the objective function is the tolerance of
the convergence block associated with the optimization problem.

You have the option of imposing equality or inequality constraints on the
optimization. Equality constraints within an optimization are similar to design
specifications. The constraints can be any function of flowsheet variables
computed using Fortran expressions or in-line Fortran statements. You must
specify the tolerance of the constraint.
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Tear streams and the optimization problem can be converged simultaneously or
separately. If they are converged simultaneously, the tear stream is treated as an
additional constraint.

Convergence of Optimization Problems
Aspen Plus solves optimization problems iteratively. By default Aspen Plus
generates and sequences a convergence block for the optimization problem. You
can override the convergence defaults, by entering convergence specifications on
Convergence forms. Use the SQP and Complex methods to converge optimization
problems. See Chapter 17 for a complete discussion of optimization convergence.

The value of the manipulated variable that is provided in the Stream or Block
input is used as the initial estimate. Providing a good estimate for the
manipulated variable helps the optimization problem converge in fewer
iterations. This is especially important for optimization problems with a large
number of varied variables and constraints.

There are no results associated directly with an optimization problem, except the
objective function and the convergence status of the constraints. You can view
the final value of the manipulated and/or sampled variables either directly on the
appropriate Stream or Block results sheets or summarized on the Results
Manipulated Variables sheet of the convergence block. To find the summary and
iteration history of the convergence block, select the Results form of the
appropriate Convergence block.

Recommended Procedure for
Optimization

Optimization problems can be difficult to formulate and converge. It is important
to have a good understanding of the simulation problem before adding the
complexity of optimization.

The recommended procedure for creating an optimization problem is:

1. Start with a simulation (instead of starting with optimization). There are a
number of reasons for this approach:
• It is easier to detect flowsheet errors in a simulation.
• You can determine reasonable specifications.
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• You can determine a reasonable range of decision variables.
• You can get a good estimate for the tear streams.

2. Perform sensitivity analysis before optimization, to find appropriate decision
variables and their ranges.

3. Evaluate the solution using sensitivity analysis, to find out if the optimum is
broad or narrow.

Defining an Optimization Problem

Define an optimization problem by:

1. Creating the optimization problem.

2. Identifying the sampled flowsheet variables used in the objective function.

3. Specifying the objective function for a sampled variable, or some function of
sampled variables, and identify the constraints associated with the problem.

4. Identifying the simulation input variables to be adjusted to maximize or
minimize the objective function, and specify the limits within which they can
be adjusted.

5. Entering optional Fortran statements.

6. Defining the constraints for the optimization problem.

Creating an Optimization Problem
To create an optimization problem:

1. From the Data menu, point to Model Analysis Tools, then Optimization.

2. In the Optimization Object Manager, click New.

3. In the Create New ID dialog box, enter an ID (or accept the default ID) and
click OK.
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Identifying Sampled Flowsheet Variables
Use the Model Analysis Optimization Define sheet to identify the flowsheet
variables used in setting up the optimization problem, and assign them variable
names. The variable name identifies the flowsheet variable that you can use
when defining the objective function, specifying bounds for the manipulated
vairables, or writing Fortran statements.

Use the Define sheet to identify a flowsheet variable and assign it a variable
name.  When completing a Define sheet, specify the variables on the Variable
Definition dialog box.  The Define sheet shows a concise summary of all the
accessed variables, but you cannot modify the variables on the Define sheet.

On the Define sheet:

1. To create a new variable, click the New button.
or
To edit an existing variable, select a variable and click the Edit button.

2. Type the name of the variable in the Variable Name field. If you are editing
an existing variable and want to change the variable name, click the right
mouse button on the Variable Name field. On the popup menu, click Rename.
A variable name must:
• Be six characters or less for a scalar variable
• Be five characters or less for a vector variable
• Start with an alphabetic character (A – Z)
• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

3. In the Category frame, use the option button to select the variable category.

4. In the Reference frame, select the variable type from the list in the Type field.
Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.

See Chapter 18, Accessing Flowsheet Variables for more information on accessing
variables.

Tip Use the Delete button to quickly delete a variable and all of the
fields used to define it.

Tip Use the Edit button to modify the definition of a variable in the
Variable Definition dialog box.
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Entering the Objective Function
If any constraints are associated with the optimization, define them before you
specify the Objective function. For more information, see Defining Constraints,
this chapter.

To enter the objective function for the optimization problem and identify the
constraints:

1. On the Optimization form, click the Objective & Constraints tab.

2. Select either Maximize or Minimize.

3. In the Objective Function field, enter the targeted variable or Fortran
expression.
To ensure that you enter accurate variable names, click the right mouse
button.  In the popup menu, click Variable List.  The Defined Variable List
window appears.  You can drag and drop the variables from the Defined
Variable List to the Objective Function field.

4. Select the constraints to be associated with the optimization, using the arrow
buttons to move them from the Available Constraints list to the Selected
Constraints list.

If you need to enter more complex Fortran than can be handled in a single
expression, you can enter additional Fortran statements. For more information,
see Entering Optional Fortran Statements, this chapter.

Identifying the Manipulated Variable
Use the Vary sheet to identify the manipulated variables and specify their limits.
The limits for manipulated variables can be constants or functions of flowsheet
variables.

To identify the manipulated variable and specify limits:

1. On the Optimization form, click the Vary tab.

2. In the Variable Number field, click on the down arrow and select <new>.

3. In the Type field, select a variable type.
Aspen Plus takes you to the remaining fields necessary to uniquely identify
the flowsheet variable. For more information on accessing variables, see
Chapter 18.

4. In the Lower field, enter a constant or Fortran expression as the lower limit
for the manipulated variable.
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5. In the Upper field, enter a constant or Fortran expression as the upper limit
for the manipulated variable.

6. You can label the decision variables for the report and the Results form. Use
the Line 1 to Line 4 fields to define these labels.

7. Repeat steps 2 though 6 until you identify all manipulated variables.

You must have already entered the manipulated variable as an input
specification, or it must have a default value. The initial guess used for the
manipulated variable is either this specification or the default. You cannot
manipulate integer block input variables, such as the feed location of a
distillation column.

About Constraints

You can choose to specify equality and inequality constraints for optimization
problems. Equality constraints are the same as design specifications in non-
optimization problems. Supply an ID for each constraint you define. Constraint
IDs identify constraints on the Optimization sheets.

Defining Constraints
Define a constraint by:

1. Creating the constraint.

2. Identifying the sampled flowsheet variables used in the constraint.

3. Specifying the constraint expression.

4. Ensuring the constraint has been selected on the Optimization Objective &
Constraints sheet.
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Creating Constraints
To create a constraint problem:

1. From the Data menu, point to Model Analysis Tools, then Constraint.

2. In the Constraint Object Manager, click New.

3. In the Create New ID dialog box, enter an ID (or accept the default ID) and
click OK.

Identifying Sampled Flowsheet Variables for
Constraints

Use the ModelAnalysis Constraint Define sheet to identify the flowsheet
variables used in the optimization problem and assign them variable names. The
variable name identifies the flowsheet variable that you can use on the Spec and
Fortran sheets.

Use the Define sheet to identify a flowsheet variable and assign it a variable
name.  When completing a Define sheet, specify the variables on the Variable
Definition dialog box.  The Define sheet shows a concise summary of all the
accessed variables, but you cannot modify the variables on the Define sheet.

On the Define sheet:

1. To create a new variable, click the New button.
or
To edit an existing variable, select a variable and click the Edit button.

2. Type the name of the variable in the Variable Name field. If you are editing
an existing variable and want to change the variable name, click the right
mouse button on the Variable Name field. On the popup menu, click Rename.
A variable name must:
• Be six characters or less for a scalar variable
• Be five characters or less for a vector variable
• Start with an alphabetic character (A – Z)
• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

3. In the Category frame, use the option button to select the variable category.
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4. In the Reference frame, select the variable type from the list in the Type field.
Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.

See Chapter 18, Accessing Flowsheet Variables for more information on accessing
variables.

Tip Use the Delete button to quickly delete a variable and all of the
fields used to define it.

Tip Use the Edit button to modify the definition of a variable in the
Variable Definition dialog box.

Specifying the Constraint Expression
You need to specify the constraint as a function of the sampled variable and
supply a tolerance on the constraint.

Constraint functions are defined as follows:
• For equality constraints:

-tolerance < expression1 - expression2 < tolerance

• For less than or equal to inequality constraints:
expression1 - expression2 < tolerance

• For greater than or equal to inequality constraints:
expression1 - expression2 > tolerance

To specify a constraint:

1. On the Constraint form, click the Spec tab.

2. In the two Constraint expression specification fields, enter expression1 and
expression2, as constants or Fortran expressions.
To ensure that you enter accurate variable names, click the right mouse
button. In the popup menu, click Variable List. The Defined Variable List
window appears. You can drag and drop the variables from the Defined
Variable List to the fields on the Spec form.

3. Select Equal to, Less than or equal to, or Greater than or equal to, for the
specification.

4. In the Tolerance field, enter the constraint tolerance as a constant or as a
Fortran expression.
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5. If the constraint is a vector, check the This is a Vector Constraint box, and
specify the elements of the vector that should be used.

If you need to enter more complex Fortran than can be handled in a single
expression, you can enter additional Fortran statements on the Constraint
Fortran sheet. (See Optional Fortran Statements, this chapter.)

Entering Optional Fortran Statements

You have the option of entering any Fortran statements needed to compute the
optimization objective function terms or manipulated variable limits. Any
variable computed by the Fortran statements can be used in the expressions on
the following sheets:
• Optimization Objective & Constraint
• Optimization Vary
• Constraint Spec

Fortran statements are needed only if the functions involved are too complex to
enter on these sheets.

You can enter Fortran statements:
• On the Fortran sheet
• In your text editor (for example, Notepad), and then copy and paste them onto

the Fortran sheet.

Using the Fortran Sheet
To enter executable Fortran statements on the Fortran sheet:

1. On the Optimization or Constraint form, click the Fortran tab.

2. Review the rules and restrictions for in-line Fortran. For more information,
see Chapter 19.

3. Enter your Fortran statements.
To ensure that you enter accurate variable names, click the right mouse
button.  In the popup menu, click Variable List.  The Defined Variable List
window appears.  You can drag and drop the variables from the Defined
Variable List to the Fortran sheet.



Optimization

22-10 Aspen Plus User Guide
Version 10.2

Fortran Declarations

You enter Fortran declarations in the same way as executable Fortran
statements, using the Declarations sheet instead of the Fortran sheet.

You can include any Fortran declarations in an optimization problem, including:
• COMMON definitions
• DIMENSION definitions
• Data type definitions (INTEGER and REAL)

If a Fortran variable meets one of these criteria, you should place it in a
COMMON:
• It is also used by another block.
• Its value must be retained from one iteration of an optimization problem to

another.

Fortran variables that you defined on the Define sheet should not be declared on
the Declarations sheet.

Convergence of Optimization Problems

Algorithms for solving process optimization problems can be divided into two
categories:

Path Method Information

Feasible Requires that tear streams and equality constraints (design specifications), if any, be converged at
each iteration of the optimization.

Infeasible Can converge tear streams, equality constraints, and inequality constraints simultaneously with the
optimization problem.

Two optimization algorithms are available in Aspen Plus:
• The COMPLEX method
• The SQP method

For more information, see Chapter 17.
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COMPLEX Method
The COMPLEX method uses the well-known Complex algorithm, a feasible path
“black-box” pattern search. The method can handle inequality constraints and
bounds on decision variables. Equality constraints must be handled as design
specifications. You must use separate convergence blocks to converge any tear
streams or design specifications.

The COMPLEX method frequently takes many iterations to converge, but does
not require numerical derivatives. It has been widely used for all kinds of
optimization applications for many years, and offers a well-established and
reliable option for optimization convergence.

Sequential Quadratic Programming (SQP) Method
The SQP method is a state-of-the-art, quasi-Newton nonlinear programming
algorithm. It can converge tear streams, equality constraints, and inequality
constraints simultaneously with the optimization problem. The SQP method
usually converges in only a few iterations but requires numerical derivatives for
all decision and tear variables at each iteration.

The SQP method as implemented in Aspen Plus includes a novel feature:  the
tear streams can be partially converged using Wegstein, each optimization
iteration and during line searches. This usually stabilizes convergence, and can
reduce the overall number of iterations.

You can specify the number of Wegstein passes. Choosing a large value
effectively makes SQP a feasible path (but not a black-box) method. The
Aspen Plus default is to perform three Wegstein passes.

You can also use the SQP method as a black-box or partial black-box method, by
converging tear streams and design specifications as an inside loop to the
optimization problem (using separate Convergence blocks). This reduces the
number of decision variables. The trade-off is the number of derivative
evaluations, versus the time required per derivative evaluation. Whether SQP is
the method of choice depends on your optimization problem.

The default optimization convergence procedure in Aspen Plus is to converge tear
streams and the optimization problem simultaneously, using the SQP method.
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Troubleshooting Optimization Problems

The convergence of an optimization problem can be sensitive to the initial values
of the manipulated variables. The optimization algorithm only finds local
maxima and minima in the objective function. Although it occurs rarely it is
possible to obtain a different maximum or minimum in the objective function by
starting at a different point in the solution space.

When an objective function is not satisfied, there are a number of options to
consider:

1. Make sure the objective function does not have a flat region within the range
of a manipulated variable. Avoid the use of objective functions and
constraints that contain discontinuities.

2. Linearize the constraints to the extent possible.

3. If the error improves initially, but then levels off, the derivatives calculated
are sensitive to step size. Some things to try are:
• Tighten tolerances of unit operation and convergence blocks within the

optimization convergence loop. The optimization tolerance should be equal
to the square root of the block tolerances. For example, if the optimization
tolerance is 10-3, then the block tolerances should be 10-6.

• Adjust the step size for better accuracy. The step size should be equal to
the square root of the inner tolerances.

• Check to see that the manipulated variable is not at its lower or upper
bound.

• Disable the Use Results from Previous Convergence Pass option on the
BlockOptions SimulationOptions sheet for blocks within the optimization
convergence loop.  You can also specify this globally on the Setup
SimulationOptions Calculations sheet

4. Check to ensure that the manipulated variables affect the value of the
objective function and/or the constraints, perhaps by performing a sensitivity
analysis.

5. Provide a better starting estimate for the values of the manipulated
variables.

6. Narrowing the bounds of the manipulated variables or loosening the tolerance
on the objective function might help convergence.

7. Modify the parameters of the convergence block associated with the
optimization (step size, number of iterations, etc.)
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Example for Maximizing Product Value

The value of a reactor product stream is a function of the flow rate of the desired
product, P, and the undesired byproduct, G.

Value = P - 30 * G

Optimization is used to find the reaction temperature that maximizes the
product value.
• The molar flow rate of components P and G in stream PROD are the sampled

variables for the optimization. These variables are called P and G,
respectively.

• The optimization objective function is ( P - 30*G ).
• You can use Fortran expressions, such as ( P - 30*G ) in any part of the

optimization problem.
• The reactor temperature is the manipulated variable. The optimization

convergence block finds the reactor temperature that makes ( P - 30*G ) a
maximum.

• The manipulated variable is specified in the reactor block, just as if there
were no optimization. The specified value is the initial estimate used by the
optimization convergence block.

• The optimization convergence block will not try a temperature less than 300F
or greater than 400F, even if the maximum of the objective function lies
outside this range.

• You do not have to specify convergence of the optimization. Aspen Plus
automatically generates a convergence block to converge the optimization.

• This optimization problem does not have any constraints associated with it.
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Example for Maximizing Operating Margin

The value of a process is calculated as the value of the product and the
byproduct, minus the cost of the raw material, and minus the cost of steam for
the reactor. The Fortran sheet is used to calculate the cost function:
C
C CPROD = PRICE OF PRODUCT, $/LB

CPROD = 1.30
C
C CBYPR = PRICE OF BYPRODUCT, $/LB

CBYPR = 0.11
C
C CFEED = PRICE OF FEED, $/LB

CFEED = .20
C
C CSTEAM = COST OF STEAM, $/MMBTU

CSTEAM = 4.00
C
C COST FUNCTION

CFUNC = CPROD * P + CBYPR * G - CFEED * A - CSTEAM * Q /1D6

There are two constraints:
• Maximum duty for the reactor
• Minimum product purity.

Optimization is used to find the reaction temperature and the feed flow rate that
maximizes the cost function.
• The molar flow rate of P and of G in stream PROD, the molar flow rate of A in

stream FEED and the reactor duty are the sampled variables for the
optimization. These variables are called P, G, A, and Q, respectively.

• The optimization problem is converged when CFUNC is at a maximum.
• There are two manipulated variables:  the reactor temperature and the flow

rate for the reactant A in the feed. The optimization convergence block finds
the combination of values that makes CFUNC a maximum subject to the
constraints.

• The Fortran sheet is used to calculate the cost function CFUNC.
• The manipulated variables are specified in the blocks just as if there were no

optimization. The specified value is the initial estimate used by the
optimization convergence block.

• You do not have to specify convergence of the optimization. Aspen Plus
automatically generates a convergence block to converge the optimization
problem.

• There are two constraints associated with the optimization problem.  They
are called DUTY and PURITY.

• The constraint DUTY is satisfied when the reactor duty is less than or equal
to 3 MMbtu/hr.

• The constraint PURITY is satisfied when mole fraction of P in the stream
PROD is greater or equal to than 0.9.
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On the Optimization sheets:
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On the DUTY constraint sheets:
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On the PURITY constraint form:
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23 Fitting a Simulation
Model to Data

You can fit Aspen Plus simulation models to plant or laboratory data using Data-
Fit. You provide one or more sets of measured data for input and results
variables of a simulation model. Data-Fit adjusts (or estimates) input parameters
to find the best fit of the model to the data. If you want Data-Fit to reconcile
measured data for input variables to match the fitted model, it can do this
simultaneously.

Data-Fit minimizes the weighted sum of squares of the differences between the
measured data and the model prediction. In statistical terms, Data-Fit performs
either ordinary least squares or maximum likelihood (errors-in-variables)
estimation.

This chapter discusses:
• Types of Data-Fit applications
• Defining a Data-Fit problem
• Creating Point-Data sets
• Creating Profile-Data data sets
• Defining Data-Fit regression cases
• Ensuring well-formulated Data-Fit problems
• Analyzing convergence problems
• Examining results

Two comprehensive examples are given.
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Types of Data-Fit Applications

Data-Fit applications fall into two main categories.

In the first type of application, Data-Fit determines coefficients for Aspen Plus
user or built-in kinetics models from laboratory kinetics data. For example, given
data for concentration versus time at one or more temperature, Data-Fit
determines coefficients of the power law kinetics model.

In the second type of application, Data-Fit matches an Aspen Plus simulation to
plant data as the first step in a simulation study. For example, given one or more
sets of distillation column feed and product measurements, Data-Fit finds the
column efficiency that best fits the measurements. At the same time, Data-Fit
can:
• Adjust the measurements to match the fitted model
• Estimate missing feed or product measurements
• Help identify poor measurements

Data-Fit is designed for off-line use in developing an Aspen Plus simulation
model that matches available data. Data-Fit is not designed for online plant data
reconciliation applications.

Defining a Data-Fit Problem

Fitting a simulation model to data involves three major steps:

1. Creating base-case Aspen Plus model.
For example, to fit concentration versus time kinetics data, create an RBatch
model. The kinetics model coefficients you enter for RBatch using the
Reactions forms become initial estimates for the Data-Fit problem.

2. Creating one or more Data-Fit data sets.

Use this Data Set type To fit

POINT-DATA • One or more steady-state experiments or operating points

• Initial charge and final products of a batch reactor, but not intermediate time points

• Feeds and products of a plug flow reactor, but not points along the length of the reactor

PROFILE-DATA • Time series data for a batch reactor

• Measurements along the length of a plug flow reactor
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3. Defining regression cases. Specify Data-Fit cases and input parameters to be
estimated. See Defining Data-Fit Regression Cases, this chapter.

Subsequent sections of this chapter describe each of these steps.

Creating Point-Data Data Sets

To create a Point-Data data set:

1. From the Data menu, point to Model Analysis Tools, then Data Fit.

2. On the left pane of the Data Browser, select Data-Set

3. In the Data-Set Object Manager, click New.

4. In the Create New ID dialog box, enter an ID or accept the default ID.

5. In the Select Type list, select Point-Data and click on OK.

6. On the Define sheet, identify the flowsheet variables for which you have
measurements (see Identifying Flowsheet Variables, this chapter).

7. On the Data sheet, enter the measured data (see Entering the Measured
Point-Data, this chapter).

Identifying Flowsheet Variables
You must identify the flowsheet variables for which you have measurements. Use
the Data-Fit Data-Set Define sheet to identify the flowsheet variables used in the
data set and assign them variable names. The variable name identifies the
flowsheet variable on other data set sheets.

Use the Define sheet to identify a flowsheet variable and assign it a variable
name. When completing a Define sheet, specify the variables on the Variable
Definition dialog box. The Define sheet shows a concise summary of all the
accessed variables, but you cannot modify the variables on the Define sheet.

On the Define sheet:

1. To create a new variable, click the New button.
or
To edit an existing variable, select a variable and click the Edit button.
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2. Type the name of the variable in the Variable Name field. If you are editing
an existing variable and want to change the variable name, click the right
mouse button on the Variable Name field. On the popup menu, click Rename.
A variable name must:
• Be six characters or less for a scalar variable
• Be five characters or less for a vector variable
• Start with an alphabetic character (A – Z)
• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

3. In the Category frame, use the option button to select the variable category.

4. In the Reference frame, select the variable type from the list in the Type field.
Aspen Plus displays the other fields necessary to complete the variable
definition.

5. Click Close to return to the Define sheet.

See Chapter 18, Accessing Flowsheet Variables for more information on accessing
variables.

Tip Use the Delete button to quickly delete a variable and all of the
fields used to define it.

Tip Use the Edit button to modify the definition of a variable in the
Variable Definition dialog box.

Types of Flowsheet Variables

You must identify the flowsheet variables for which you have measurements. You
can also identify results variables for which you have no measurements.
Aspen Plus will estimate the results variables and tabulate them for each data
point.

In Data-Fit, you cannot access vectors. You must access each stream variable or
each component in a composition vector as a different scalar variable.

Always access feed stream compositions as mole, mass, or standard volume
component flows. Do not access them as fractions. This avoids any problems with
normalizing fractions.

You can access both input values and results values for certain flowsheet
variables. For example, the condenser duty of a RadFrac block can be accessed
either as the input variable Q1 or the results variable COND-DUTY. The reboiler
duty can be accessed as the input variable QN or as the results variable REB-
DUTY. Select either the input or results variable as follows:
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Is the measured variable specified as an input
in the base case simulation?

Then select

Yes The input variable

No The results variable

For example, suppose:
• Your base-case model consists of a RadFrac block with Reflux Ratio and

Condenser Duty specified.
• The data you want to fit includes reboiler and condenser duty.

You must select the results variable REB-DUTY for the reboiler duty, since it is
not specified as an input in the base-case model. You must select the input
variable Q1 for the condenser duty, since it is specified as an input in the base-
case model.

If you want to reconcile the measurement for Q1, provide a non-zero standard
deviation. If you do not want to reconcile it, provide a zero standard deviation.

Entering the Measured Point-Data
Use the Data-Fit Data-Set Data sheet to enter measured data.

For each measured variable:

1. On the Data-Fit Data-Set form, click the Data tab.

2. Specify whether the variable is a simulation Input or Result for the Data-Fit
problem.

Specify these variables As

Measured feed stream Input

Measured product stream Result

Measured variables that were accessed as input variables on
the Define sheet

Input

All  other measured variables Result

Note Intermediate stream variables are usually results. However,
when a Data-Fit problem spans only a subset of the flowsheet,
you must specify intermediate streams that are inlets to the
Data-Fit subproblem as inputs.

3. Specify a standard deviation for the measurement in the first row of the data
table.
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4. Enter one or more data points (rows in the table). If a measurement is not
available for a Result variable, leave its Data field blank. Data-Fit will
estimate it. You must always enter a value for an Input variable.

You can introduce a new standard deviation row at any time. It will apply to
subsequent data points.

Standard Deviation

The standard deviation is the level of uncertainty in the measurement. You can
enter it as an absolute or percent error (append a percent sign (%) to the value).
Statistically determined standard deviations are seldom available. It is enough to
supply an approximate “expected error,” estimated from experiences or
instrument specifications. Each residual (measurement — model prediction)
term in the sum of squares function is weighted by 1/(standard deviation2).

You must specify a standard deviation greater than zero for each results variable
to be fit. If a zero value is entered for standard deviation, that results variable is
not included in the regression.

For inputs, a standard deviation greater than zero invokes maximum likelihood
(errors-in-variables) estimation:

If the standard deviation for an
input variable is

Then Aspen Plus

Zero Treats the measurement as exact and Data-Fit does not adjust it

Greater than zero Adjusts (reconciles) the measurement, along with results measurements, to match the fitted
model

Note  Reconciling inputs can increase solution time significantly, since each reconciled
input is treated as a decision variable by the least squares algorithm

Creating Profile-Data Sets

To create a Profile-Data data set:

1. On the Data menu, select Model Analysis Tools, then Data Fit.

2. On the left pane of the Data Browser, select Data-Set

3. In the Data-Set Object Manager, click New.

4. In the Create New ID dialog box, enter an ID or accept the default ID.



Chapter  23

Aspen Plus User Guide 23-7
Version 10.2

5. In the Select Type list, select Profile-Data and click on OK.

6. On the Define sheet, identify the flowsheet variables for which you have
measurements (see Identifying Profile Variables, this chapter).

7. On the Data sheet, enter the measured data (see Entering the Measured
Profile-Data, this chapter).

8. You can specify the charge (Rbatch) or feed (Rplug) on the Initial Conditions
sheet.

Identifying Profile Variables
Profile variables are available for the RBatch and RPlug unit operation models.

1. On the Data-Set form, click the Define tab.

2. In the Model and Block Name area, select either RBatch or the RPlug.

3. In the Block field, identify the block where the profiles have been measured.

4. In the Variable Name field, enter a variable name. A variable name must:
• Be six characters or less for a scalar variable
• Start with an alphabetic character (A – Z)
• Have subsequent alphanumeric characters (A – Z, 0 – 9)
• Not begin with IZ or ZZ

5. In the Variable list, select a variable. See the prompt for a description of each
variable.

6. For concentration or fraction profile variables, identify the component being
measured in the Component field. You must identify each component
concentration or fraction as a separate measured variable.

7. Repeat steps 4 through 6 for each measured variable.

You can identify profile variables for which you have no measurements. Data-Fit
will calculate and tabulate them.

Entering the Measured Profile-Data
Use the Data-Fit Data-Set Data sheet to enter measured data.

For each measured variable:

1. On the Data-Fit Data-Set form, click the Data tab.
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2. In the first row of the data table, specify a standard deviation greater than
zero for each measured variable to be fit. If a zero value is entered for the
standard deviation, that results variable is not included in the regression.

3. Enter the time or length and the measurements for each data point. Leave
missing measurements blank. Aspen Plus will estimate them.

You can introduce a new standard deviation row at any time. It will apply to
subsequent data points.

4. If you want to specify temperature and pressure values to replace those in the
base-case, enter the value(s) on the Initial Conditions sheet. Data-Fit does not
reconcile (adjust) these values. It assumes they are exact.

5. If the experiment was carried out with a feed or charge different than that in
the base-case model, specify the component flows on the Profile-Data Initial
Conditions sheet. Select the basis (Mole/Mass/StdVol) and the units. Enter
the component flows. Aspen Plus assumes the values you enter are exact and
does not adjust them. You can only specify flows for conventional components.
If the feed/charge specified in the base-case model contains nonconventional
components, Data-Fit will use:
• Base-case specifications for nonconventional components
• Conventional component flows entered on this form as feed/charge to

reactor

The standard deviation is the level of uncertainty in the measurement. See
Standard Deviation, this chapter, for more information.

Defining Data-Fit Regression Cases

You can fit both Point-Data and Profile-Data data sets in the same regression
case. For example, you might have time series data for a reaction at one
temperature (Profile-Data), and overall conversion data at several temperatures
(Point-Data).

A Data-Fit regression case must involve at least one of the following:
• An estimated parameter
• A reconciled input (with a standard deviation greater than zero)

Aspen Plus adjusts (reconciles) measured input variables when you specify non-
zero standard deviations for the input measurements on the Data-Set Data
sheet. There will be one estimate for a reconciled measured input for each data
point.
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For an estimated parameter, you must have already entered a value for it as an
input specification for the base simulation, or it must have a default value. Data-
Fit uses this specification as the initial guess for the variable.

If the base-case value lies outside the bounds you enter for the parameter on the
Regression Vary sheet or for a reconciled input, Data-Fit uses the nearest bound
as the initial guess.

There is no limit to the number of estimated parameters.

Data-Fit leaves a variable at its lower or upper limit if violating the limit would
further decrease the sum-of squares function.

Creating Data-Fit Regression Cases
To define a Data-Fit regression case:

1. On the Data menu, select Model Analysis Tools, then Data Fit.

2. On the left pane of the Data Browser, select Regression

3. In the Regression Object Manager, click New.

4. In the Create New ID dialog box, enter an ID or accept the default ID.

5. On the Specifications sheet, identify the data sets to be fit in the case (see
Creating Point-Data Data Sets and Creating Profile-Data Sets, this chapter).
You can also supply Weights to adjust the relative weighting of the data sets,
but this is usually not necessary. For more information on Weights see Data-
Fit Numerical Formulation.

6. On the Vary sheet, identify any simulation input parameters you want to
estimate. Data-Fit will adjust the variables to find the best fit to the Data-
Sets listed on the Specifications sheet.

7. On the Convergence sheet, you can select the Initialization Method when
reconciling input measurements.

To initialize the reconciled inputs to Use the initialization method

Base-case values Base Ccase Values (default)

Measured values Measurements

The default base-case initialization method is robust, but it can take a few
more iterations if the measurements are far off from the base case.
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Normally you do not need to change any other defaults on the Regression
Convergence sheet. See Convergence Parameters, this chapter, for more
information.

Convergence Parameters
The Regression Convergence sheet is used to specify optional Data-Fit
convergence parameters. In most cases, it is unnecessary to change these
parameters from their default values.

The following parameters are available on the Convergence sheet:

Field Default Used To

Maximum Algorithm Iterations 50 Specify the maximum number of optimizer iterations.

Maximum Passes Through
Flowsheet

1000 Set the maximum number of flowsheet passes allowed in a Data-Fit run.
Included in the count of flowsheet passes are the initial base case, passes
required to compute the residuals, and passes required to compute the
Jacobian matrix through perturbation.

Bound Factor 10 Lower and Upper bounds for reconciled input variables are computed using
Bound Factor times Standard Deviation for that variable.

See Bound Factor, this chapter, for more information about setting the Bound Factor.

Absolute Function Tolerance 0.01 Specify the absolute sum-of-squares objective function tolerance.

If the optimizer finds a point where the objective function value is less than
the Absolute Function Tolerance, the problem is converged.

Relative Function Tolerance 0.002 Specify the relative function convergence tolerance.

If the current model predicts a maximum possible function reduction of at
most the relative function tolerance times the absolute value of the function
value at the start of the current iteration, and if the last step attempted
achieved no more than twice the predicted function decrease, then the
problem is considered converged.

X Convergence Tolerance 0.002 Specify the X convergence tolerance.

If a step is tried that has a relative change in X less than or equal to the X
Convergence Tolerance and if this step decreases the objective function by
no more than twice the predicted objective function decrease, the problem
is considered converged.

Minimum Step Tolerance 1e-10 Data-Fit returns with suboptimal solution if a step of scaled length of at most
Minimum Step Tolerance is tried but not accepted.

Calculate Covariance Matrix checked Calculate covariance and correlation matrices and write correlation matrix
to report file.
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Advanced Parameters
The Regression Advanced sheet is used to specify additional Data-Fit
convergence parameters. In most cases, it is unnecessary to change these
parameters from their default values.

The algorithm maintains an estimate of the diameter of a region about the
current estimate of the vector of varied values in which it can predict the
behavior of the least-squares objective function, that is, a trust region.

The following parameters are available on the Convergence sheet:

Trust region tuning
parameters field

Default Used To

Switching Parameter 1.5 Data-Fit algorithm uses a trust-region strategy. Switching Parameter is used in a test
to decide when to switch the model for the trust region.

Adjustment Factor 0.75 If the decrease in the value of the objective function is at least Adjustment
Factor*inner product of the step and the gradient, then the trust region radius is
increased

Reduction Factor 0.5 The factor by which the trust region radius is shrunk if current X leads to errors in
function or Jacobian evaluation.

Minimum Reduction Factor 0.1 The minimum factor by which the trust region radius may be shrunk.

Minimum Expansion Factor 2 The minimum factor by which the trust region radius is increased if it is increased at
all.

Maximum Expansion Factor 4 The maximum factor by which the trust region radius may be increased at one time.

Step and tuning parameters
field

Default To

Initial Step Size 1 Factor determining the initial step size of the trust region.

The choice of Initial Step Size can profoundly affect the performance of the
algorithm - different values sometimes lead to finding different local minima. Too
small or too large a value of Initial Step Size causes the algorithm to spend several
function evaluations in the first iteration increasing or decreasing the size of the trust
region.

Size Control Parameter 0.0001 For the step to be accepted the actual function reduction must be more than Size
Control Parameter times its predicted value.

Adaptive Scaling Strategy 0.6 Tuning factor associated with adaptive scaling strategy in the algorithm

Relative Perturbation Size 0.005 Default perturbation size during Jacobian evaluation for variable X is Relative
Perturbation Size times the absolute value of X.

False Convergence Check
Parameter

0.1 Helps decide when to check for false convergence and to consider switching the
algorithm model for the current trust region.
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Data-Fit Numerical Formulation

Data-Fit solves a problem with the following formulation:
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subject to Xplb < Xp < Xpub

Xrilb < Xri < Xriub

Where:

Nsets = Number of data sets specified on the Regression Specifications
sheet

Nexpi = Number of experiments in data set i

Nri = Number of reconciled input variables

Nrr = Number of measure results variables

Wi = Weight for data set I specified on the Regression Specifications
sheet

Xp = Vector or varied parameters

Xmri = Measured values of the reconciled input variables

Xri = Calculated values of the reconciled input variables

Xmrr = Measured values of the results variables

Xrr = Calculated values of the results variables

Sigma = Standard deviation specified for the measured variables

Reconciled input variables are adjusted to minimize the sum of square of errors
for each experiment independently.
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Ensuring Well-Formulated Data-Fit
Problems

This section applies primarily to Point-Data data sets.

Although Data-Fit is extremely flexible, you must ensure that a Data-Fit problem
is well posed. Data-Fit does not check this for you. There are two basic rules you
must follow:
• When Data-Fit evaluates a data point, it merges the current values of the

measured inputs and the estimated parameters with the base-case
specifications. To avoid erroneous results, the set of measured inputs for a
data set must form a complete input specification for uniquely calculating the
measured results for that data set.

• The base-case simulation model must be formulated to have a solution, even
when the measurements are not in mass or energy balance.

The following example illustrates the application of both rules.

Example of a Well-Formulated Data-Fit Problem

Suppose you want to fit column efficiency to operating data for a distillation
column with one feed and two products. Data are available for several operating
points. Each operating point has:
• A different feed composition, flow rate, and temperature
• Different distillate and bottoms flow rates and temperatures
• The same reflux ratio and feed and column pressures

The feed data consists of component mole flow rates and temperatures. Product
stream data consists only of total flow rates and temperatures.
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The following table describes a well-posed Data-Fit formulation for this problem:

This Consists of

The base-case simulation model • A feed stream with temperature, pressure, and component mole flows specified

• A RadFrac block with Mole Reflux Ratio, Mole Distillate to Feed Ratio, and pressure
specified

The data set for the operating points Inputs:

• Mole flow rate for each component with a non-zero flow in the base-case feed stream

• Feed stream temperature

• Distillate-to-feed ratio, accessed as the RadFrac Mole-D:F input variable and entered
as an unmeasured input in the data set

Results:

• Distillate and bottoms temperature

• Distillate and bottoms flow rate

The pressure and Mole Reflux Ratio are fixed specifications for this problem.
Data-Fit overrides the base-case feed component flow rates, temperature, and
column distillate-to-feed ratio specification for the evaluation of each data point.
If any inputs were omitted from the data set, base-case values would be used for
the data point evaluations, causing incorrect results.

The distillate-to-feed ratio specification must be used so that RadFrac can solve
with most any feed. If the distillate flow specification were used instead, a
measure distillate rate that was not in good mass balance with the measured
feeds could result in an infeasible column specification that RadFrac could not
solve.

Bound Factor
When you specify non-zero standard deviations for measured inputs, Data-Fit
uses the following limits for the variable estimates:

Lower Bound = Measured value - (Bound Factor) * (Standard Deviation)

Upper Bound = Measured value + (Bound Factor) * (Standard Deviation)

Bound Factor has a default value of 10. You can enter a different value on the
Regression Convergence sheet.

Aspen Plus checks to see whether the lower bound for flows is negative. If so, a
warning is given and the lower bound is set to zero. Care should be taken in
setting the Bound Factor to avoid zero flow rates.
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Remember that setting bounds that are too tight or too loose could cause Data-
Fit to move into an infeasible region. For example, if you are reconciling the
reflux rate for a tower and using the reflux rate as a reconciled input variable,
and you allow the lower bound on the reflux rate to be zero, Data-Fit may drive
the reflux rate to zero during the solution process and cause severe errors in
RadFrac.

Instead of setting very tight bounds on the reconciled input variables, you should
treat them as fixed instead.

Estimating Unmeasured Variables
Data-Fit can estimate and tabulate any unmeasured result. Access the calculated
variable as a Result in a data set, enter a nonzero standard deviation, and leave
the data field blank.

Data-Fit can also estimate unmeasured input variables. Access the variable as
an Input in a data set. Enter a reasonable initial guess and a large standard
deviation (for example, 50%) for the variable. Make sure the standard deviation
gives reasonable lower and upper limits for the estimated variable.

Sequencing Data-Fit

For Data-Fit problems, Aspen Plus will:

1. Run the base-case simulation.

2. Execute the Data-Fit loop until it converges or fails to converge.

3. Replace the base-case values of fitted parameters with the regressed values,
and rerun the base-case simulation

If any Case-Study or Sensitivity blocks are present, Aspen Plus uses the fitted
parameters to generate the Case-Study and/or Sensitivity tables. The Data-Fit
problem is not re-executed each time.

The Aspen Plus automatic sequencing algorithm places Data-Fit loops outside
any flowsheet convergence loops.

In most cases, Data-Fit should be run standalone. For example, you may want to
estimate kinetic coefficients in the power-law expression, using a RCSTR block.
Run Data-Fit with RCSTR. Then use the regressed values as input in a larger
flowsheet with that RCSTR block.
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You can sequence the execution manually to suit your needs on the Convergence
Sequence form.

Using Data-Fit Results

The key Data-Fit results are:

Results On Data-Fit sheet

Chi-Square statistic for the fit Regression Results Summary

Final estimates and standard deviations for the estimated
parameters

Regression Results Manipulated Variables

Table of measured values, estimated values, and normalized
residuals for the data sets

Regression Results Fitted-Data

Table of iteration history of the function results or of the vary
results and reconciled input

Regression Results Iteration History

A Chi-Square value greater than the threshold value indicates the model does
not fit the data. This can occur due to errors in the measured data, or because the
model does not represent the data. You can use the Chi-Square statistic for
selecting between models. If you fit two or more models to the same data set(s),
the model with the lowest Chi-Square value fits the data best.

It is not uncommon for the standard deviations of estimated parameters to be
relatively large. This does not necessarily indicate a poor fit.

Review the Regression Results Fitted-Data sheet for large normalized residuals
(outliers). A residual value much larger than the others might indicate a bad
data point.

For measured inputs with standard deviations equal to zero, there are no
estimated values or residuals. Data-Fit does not adjust these measurements.

The Regression Results Fitted-Data sheet allows the plotting of results. These
plots can help you:
• Visualize how well your model fits the data
• Spot poor data points

For information about how to generate plots, see Chapter 13 .
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Troubleshooting

If Data-Fit fails to converge, look for:
• Large errors in the values entered for the measurements, such as data entry

errors or incorrect units
• Gross errors in source data

Errors may occur in the problem formulation. Check:
• Does the base-case simulation converge?
• Do measured inputs completely determine the measured results? See

Ensuring Well-Formulated Data-Fit Problems, this chapter.
• Is the base-case simulation formulated to handle measured data that are not

in good mass balance? See Ensuring Well-Formulated Data-Fit Problems, this
chapter.

• Do the values specified in the base-case simulation provide good estimates for
the estimated parameters?

• Do the estimated parameters affect the measured variables over the range
specified? You can check the sensitivity of the measured variables to the
estimated parameters with a sensitivity run. A different base-case parameter
value or a smaller parameter range may be needed.

• Do specified bounds allow the decision variables to take the model into
infeasible regions (leading to convergence failures for unit operation model
algorithms or internal convergence loops)? The recommended action is to
tighten the bounds.

• Do the fitted parameters have large differences in order of magnitude? If so,
it may be helpful to scale those values using a Calculator block.

• Does the model represent the data? If not, either choose another model or
enter new base-case specifications.

Example of Fitting Reaction Kinetics Data

Determine the coefficients of the Aspen Plus power law kinetics model for the
liquid phase reaction ALLYL + ACET � PROD. A backup file for this problem is
included in the Examples library as datafit1.bkp.

The following data is available:

Initial charge: 0.05 lb ALLYL

0.07 lb ACET

Reaction temperature: 30oC
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Mole fractions:

Time ALLYL PROD

600 seconds 0.30149 0.19745

900 seconds 0.25613 Unmeasured

1900 seconds 0.14938 0.45820

A base-case simulation is defined with the following specifications:

Feed Flow Rate

ALLYL 0.05 lb/hr

ACET 0.07 lb/hr

Rbatch Specification Value

Reactor Type Constant Temperature

Temperature 30.0oC

Cycle time 1900.0 seconds

Valid phases Liquid-Only

Power Law Kinetics Specifications Value

ALLYL exponent 1.0

ACET exponent 0.5

Pre-exponential factor 1.5E7

Activation energy 6.5E7

Time series data is entered in a Profile-Data data set.
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Because data is available at only one temperature, the pre-exponential factor is
fit with the activation energy fixed. The Regression case is entered as follows:
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After running the Data-Fit problem, the resulting estimate of the pre-exponential
factor appears on the Regression Results Manipulated Variable sheet:

The Regression Results Fitted-Data sheet displays the original measured values,
along with the final estimated values for these variables.
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These original measured values and the final estimated values can be plotted
against each other to see the fit of the data and identify any outliers.

Example for Matching a Column Model to Plant Data

This example reconciles measurements and fits column Murphree stage
efficiency to operating data for a binary distillation column with one feed and two
product streams. A backup file for this problem is in the Examples library as
datafit2.bkp.
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The following data is available:

Run 1 Run 2 Run 3

Feed

Water flow rate, lbmol/hr

Ethanol flow rate, lbmol/hr

Temperature, oF

55

45

77

45

55

75

50

50

80

Distillate

Total flow rate, lbmol/hr

Temperature, oF

45

175

55

170

50

174

Bottoms

Total flow rate, lbmol/hr

Temperature, oF

45

180

55

185

50

183

A base-case simulation is defined with the following specifications:

Feed Stream Specification Value

Water flow rate, lbmol/hr 50

Ethanol flow rate, lbmol/hr 50

Temperature, oF 77

Pressure, psia 15

RadFrac Specification Value

Number of stages 20

Feed stage 10

Pressure, psia 15

Distillate vapor fraction 0.0

Reflux ratio 3.0

Distillate-to-feed ratio 0.5

Murphree stage efficiencies 0.1

The column specifications (reflux ratio and distillate-to-feed ratio) ensure that
the column can be solved even if the measured feed and distillate flow rates are
not in mass balance.
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A Fortran Calculator block is defined to set the stage efficiency of the column and
is executed just before the RadFrac block. This Calculator block reads a
parameter being varied by Data-Fit and transfers this to the efficiency of the first
and last stages of the column. RadFrac automatically uses this efficiency for all
intermediate stages.

The Point-Data data set is:
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The distillate-to-feed ratio (COLDF) measurement is given an arbitrary value
(0.5) and a large standard deviation (100.0). This specification tells Data-Fit to
vary the distillate-to-feed ratio as needed for each data point to find the best fit
to the measured data. The initial guess is 0.5. The distillate-to-feed ratio is an
unmeasured input, to be estimated. Distillate and bottoms flow rate are treated
as measured results. This ensures a feasible solution for the column for each
Data-Fit data point.

The measured distillate or bottoms flow rate could have been used directly as an
input (the RadFrac specification). But, RadFrac would be unable to find a
solution if the flow rate measurements contained significant error and were not
in mass balance.

The Data-Fit Regression case is defined as follows:
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24 Transferring
Information Between
Streams or Blocks

Use a transfer block to copy the values of flowsheet variables from one part of the
flowsheet to another. You can copy to any number of destinations:
• Whole streams
• Stream composition and flow rate
• Any flowsheet variable (for example, block variables)

The most common application is to copy one stream into another.

This chapter describes:
• Defining transfer blocks
• Creating transfer blocks
• Copying streams
• Copying flowsheet variables
• Specifying when to execute a transfer block
• Entering flash specifications for destination streams
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Defining a Transfer Block

To define a transfer block:

1. Create the transfer block.

2. Copy either a stream, a stream flow, a substream or a block or stream
variable.

3. Optionally enter flash specifications for destination streams.
By default, Aspen Plus will flash modified streams automatically, using the
values present in the stream and the flash options established either on the
Streams form for process feeds, or by the source block for other streams.

4. Optionally specify when the transfer block is executed.
By default, Aspen Plus will sequence the block automatically.

Subsequent sections of this chapter describe each of these steps.

Creating a Transfer Block

To create a transfer block:

1. From the Data menu, point to Flowsheeting Options, then click Transfer.

2. In the Transfer Object Manager, click New.

3. In the Create New ID dialog box, enter an ID, or accept the default, and click
OK.

Copying Flowsheet Variables

The From and To sheets are used to specify what flowsheet variables are copied
from one place to another.
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The following information can be copied:

If you select on the From
sheet

Aspen Plus copies

Entire stream An entire stream

Stream flow Only the component flows and total flow of a stream

Substream An entire substream

Block or stream variable A scalar stream variable or block variable
When scalar variables are copied, the variable type does not have to be the same on each sheet, but
each variable type must have the same physical dimensions (for example temperature).

Copying Streams
To copy a stream:

1. On the Transfer form, click the From tab.

2. Click the Entire Stream option and specify the stream in the Stream Name
field. The information for an entire stream including all substreams will be
copied.

3. Click the To tab.

4. Specify any number of destination streams in the Stream field.

Copying Stream Flow
To copy component flows of a stream:

1. On the Transfer form, click the From tab.

2. Click the Stream Flow option and specify the stream in the Stream Name
field. The component and total flow rates of a stream will be copied, but not
the conditions (temperature, pressure, vapor fraction, and other intensive
variables).

3. Click the To tab.

4. Specify any number of destination streams in the Stream fields.
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Copying Substreams
To copy a substream:

1. On the Transfer form, click the From tab.

2. Click the Substream option and specify the stream and substream in the
Stream Name and Substream fields. The information for one substream of a
stream will be copied.

3. Click the To tab.

4. Specify any number of destination streams in the Stream and Substream
fields.

Copying Block or Stream Variables
To copy a block, stream, or other flowsheet variable:

1. On the Transfer form, click the From tab.

2. Select the Block or Stream Variable option.

3. In the Type field, select the type of variable you want to copy.

4. Aspen Plus takes you to the remaining fields necessary to completely identify
the variable. See Chapter 18 for more information on accessing variables.

5. Click the To tab.

6. On the Variable Number field, click the down arrow and select <new>.

7. In the Type field, select the type of variable for the destination of the copy.

8. Aspen Plus takes you to the remaining fields necessary to completely identify
the variable.
Repeat steps 6 to 8 for all the variables to which the From variable is to be
copied.
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Specifying Transfer Block Execution

Use the Transfer Sequence sheet to specify when the transfer block is executed.

You can do either of the following:
• Use the default, Automatically Sequenced, to let Aspen Plus sequence the

block automatically.
• Specify when the Transfer block is to be executed (Before or After a block, or

at the beginning (First) or end (Last) of a simulation).

To specify transfer block execution:

1. On the Transfer form, click the Sequence tab.

2. This table shows how to specify when the transfer block is to be executed:

Specify this in the Execute field To

Automatically sequenced Have the Transfer block sequenced automatically

First Have the Transfer block executed at the beginning of the simulation

Before Have the Transfer block executed before a specified Block, Convergence, Calculator,
Transfer, Balance, or Pressure Relief
The Block Type and Block Name must be specified.

After Have the Transfer block executed after a specified Block, Convergence, Calculator,
Transfer, Balance, or Pressure Relief
The Block Type and Block Name must be specified.

Last Have the Transfer block executed at the end of the simulation

3. If you entered Before or After, select the unit operation block, convergence
block, Calculator block, transfer block, balance block or pressure relief block
before or after which you want the transfer block to be executed.

4. Use the Diagnostics button on this sheet to set the levels of diagnostic output.
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Entering Flash Specifications for
Destination Streams

When you copy into a stream, Aspen Plus flashes the destination stream(s) to
calculate a new set of stream properties using the values present  in the stream
and the flash options established either on the Streams form for process feeds, or
by the source block for other streams.

You can use the optional Stream Flash sheet to specify the thermodynamic
condition and flash options for modified streams. For example, use it when you
copy stream flows and need to specify the temperature and pressure of the
destination stream.

The flash type must be specified. The possible flash types are:
• Temperature & Pressure
• Temperature & Vapor Fraction
• Temperature & Enthalpy
• Pressure & Vapor Fraction
• Pressure & Enthalpy
• Do not Flash Stream

Temperature or pressure estimates can be entered if desired.

Also specify the phases the flash calculation should consider and optionally the
maximum iterations and error tolerance for the flash calculation.

To enter flash specifications for a stream:

1. On the Transfer form, click the Stream Flash tab.

2. Specify the stream name in the Stream field.

3. Specify the Flash Type.

4. Specify the flash specifications, estimates and/or convergence parameters.

Example of a Stream Copied to Two Other Streams

A transfer block is used to copy stream F-STOIC into streams F-CSTR, F-PLUG,
and F-GIBBS.
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Example of Stream Conditions Copied to a Block

The transfer block TEMP sets the temperature of block TRANSFER equal to the
temperature in stream LIQUID2.

The stream LIQUID2 is an outlet from a Flash3 where the properties are being
calculated using the UNIF-LL physical property methods. Downstream from the
Flash3, the properties are being calculated using the NRTL physical property
methods.
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When two different physical property methods are being used in a flowsheet,
there may be inconsistencies where they meet. Often it is good practice to add in
a Heater block with a temperature and pressure specification between the two
sections with the different physical property methods. The Heater should use the
temperature and pressure of the inlet stream and the physical property method
of the new section or block to which the outlet from the Heater is connected. A
Transfer block can be used to transfer the temperature and pressure of the inlet
stream to the Heater block.

In this flowsheet, only the temperature is transferred since the pressures are all
ambient. A similar transfer block could be used to transfer the pressure from the
LIQUID2 stream to the TRANSFER Heater block.
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25 Balance Blocks

You can use a Balance block to calculate heat and material balances around an
envelope of one or more unit operation blocks. The Balance block updates stream
variables entering or leaving the envelope with the calculated results. For
example, the Balance block can calculate:
• Flow rate of make-up streams in recycle calculations. (This eliminates

Calculator blocks.)
• Feed stream flow rate and conditions, based on other stream and block

information. (This eliminates design specifications and convergence loops.)

This chapter includes the following topics about Balance blocks:
• Defining a Balance block
• Specifying blocks and streams for balance calculations
• Specifying and updating stream variables
• Sequencing Balance blocks
• Flash specifications
• Material and energy balance equations

Defining a Balance Block

Define a Balance block by:

1. Creating the Balance block.

2. Specifying blocks and streams for balance calculations.

3. Specifying and updating stream variables.

4. Sequencing balance blocks.

5. Optionally, specifying flash conditions.
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Creating a Balance Block

To create a Balance block:

1. From the Data menu, select Flowsheeting Options, then Balance.

2. On the Balance Object Manager, click the New button.

3. In the Create New ID dialog box, enter an ID or accept the Default ID and
click OK.

4. Select the Balance form you want to enter data on from left pane of the Data
Browser. See subsequent sections of this chapter for more information.

Form Sheet What is Specified

Setup Mass Balance Blocks or streams to include in each material balance
envelope

Energy Balance Blocks or streams to include in each energy balance
envelope

Equations Material and energy balance relationships in addition to
what is specified on the Mass Balance and Energy
Balance sheets

Calculate Stream variables to calculate and update after the mass
and energy balance calculations

Scale Stream scale factors

Advanced Parameters Optional convergence parameters, including relative
tolerance of balance equation residuals

Sequence Optional execution sequence for the balance block

Stream Flash Optional flash specifications for specified streams. This
sheet can also be used to suppress automatic flash
calculations for streams updated by the Balance block.

Diagnostics Levels of diagnostic output from the balance block
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Specifying Blocks and Streams for
Balance Calculations

Use the Mass Balance and Energy Balance sheets to specify blocks or streams for
a mass and energy balance envelope. The energy balance equations are overall
energy balances.

The mass balance equations can be any one of these:
• Overall. Do not specify Components, Component Groups, or Substreams.
• Substream. Do not specify Components or Component Groups.
• Component balances

To specify blocks or streams for mass balance calculations:

1. Select the Mass Balance sheet.

2. On the Mass Balance Number field, click the down arrow and select <new>.

3. In the New Item dialog box, specify an ID or accept the default ID.  The ID
must be an integer.

4. Specify blocks or streams (inlets and outlets) to include in the material
balance envelope.

5. Specify components, component groups, or substreams, depending on the
material balance type.

6. If you want to enter more than one material balance, repeat steps 2 through
5.

To specify blocks or streams for energy balance calculations:

1. Select the Energy Balance sheet.

2. On the Energy Balance Number field, click the down arrow and select <new>.

3. In the New Item dialog box, specify an ID or accept the default ID.  The ID
must be an integer.

4. Specify the blocks or streams (inlets and outlets) for the energy balance
envelope.

5. If you want to enter more than one energy balance, repeat steps 2 through 4.

Tip If you want to delete an mass balance or energy balance, click the
right mouse button on the Mass Balance Number or the Energy
Balance Number field.  From the popup menu, select Delete.



Balance
Blocks

25-4 Aspen Plus User Guide
Version 10.2

Use the Equations sheet to set up general molar/mass relationships among the
total or component flows of one or more streams. You can also specify the mole
and mass right hand side of a relation. See Material and Energy Balance
Equations, this chapter, for more information about the form of the equations.

Specifying and Updating Stream
Variables

Use the Calculate sheet to specify which stream variables to calculate by solving
the mass and energy balance relationships. You can specify to update these
variables after they are calculated. To solve the balance equations, the total
number of variables specified on this form must equal the total number of
equations specified on the Mass Balance and Energy Balance sheets. .

Aspen Plus can calculate these types of flow variables:
• Total flow rate. The stream composition remains the same.
• Substream flow rates. The stream composition remains the same.
• Component flow rates of all applicable substream/component combinations

If you do not specify substreams when you specify component flows, Aspen Plus
calculates the component flow rate of the default substream. The default
substream for a specified component is the first substream containing that
component.

Convergence Parameters

Use the Advanced Parameters sheet to:
• Specify Balance block convergence parameters
• Check additional implicit mass balance equations
• Adjust the maximum number of iterations, the relative tolerance of the

balance equation residuals, and the relative tolerance of calculated variables
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The implicit mass balance equations are any mass balance or mass/mole
relationships which do not involve any variables to be calculated or material
balance equations for the energy balance. The additional mass balance equations
are checked by default, and if they are out of balance, the calculated variables are
not updated. It is possible to update calculated variables even if the equations
are out of balance. You can choose not to check the additional mass balance
equations.

Sequencing Balance Blocks

Use the Advanced Sequence sheet to specify when to execute a Balance block.:

A Balance block can be sequenced automatically or manually. In automatic
sequencing the Balance block executes before any unit operation block with a
feed stream updated by this Balance block.

In some cases, Aspen Plus places the Balance block within a convergence loop.
You can control whether the block executes only once (for example, for
initializing a tear stream) or always (for example, for makeup calculations).
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Flash Specifications

Use the Stream Flash sheet to specify thermodynamic conditions or suppress
automatic flash calculations for streams updated by a balance block. Aspen Plus
automatically flashes an updated stream unless the only updated variable is the
total flow.

Material and Energy Balance Equations

When the number of variables exceeds the number of equations, you must enter
the unknown variables to be calculated on the Calculate form. Since the system
of equations is linear, Aspen Plus solves the unknown variables directly. You can
specify that the corresponding stream variables are updated.

Aspen Plus uses the following material and energy balance equations:

Overall mass balance:

S Fi i i
i

NM

σ =
=

0
1

Substream mass balance for j=1 to NSS:
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Overall energy balance:
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Where:

iS = +1 for inlet streams, -1 for outlet streams

iσ = Stream scale factor

iF = Mass flow of stream i

ijf = Mass fraction of substream j in stream i

ijkZ = Mass fraction of component k in substream j of stream i

NM = Number of combined inlet and outlet material streams

NH = Number of combined inlet and outlet heat streams

NW = Number of combined inlet and outlet work streams

NSS = Number of substreams within material streams

NC = Number of components specified on the Components
Specifications or  Components Comp-Group forms

ih = Mass enthalpy of stream i

jH = Heat flow of heat stream j

kW = Work of work stream k

RHS = Right-hand side of the energy balance equation

On the Equations sheet, you can specify additional material relationships, which
span components in various streams. This is useful for reactive systems. When
you specify additional relationships, Aspen Plus uses the following mole/mass
balance equations for the component mole/mass balance equation:

C F RHSij ij i
j

NTi

=
=1
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Where:

ijC = Coefficient of Term j in equation i

ijF = Mole/mass flow Term j in equation i as determined by
Stream, Substream, and Component of the term

iRHS = Right-hand side of mole/mass equation i

iNT = Number of terms in mole/mass equation i

Example of Backward Calculations Using a Balance Block

This example shows how to do a mass-only calculation around a HeatX block.
The objective is to demonstrate the capability of a balance block to do backward
calculations.

Flow rates of the two outlet streams from HeatX are given. Flow rates of the two
inlet streams into HeatX need to be calculated. Both the inlet and the outlet
streams are specified, but the flow rates specified for the two inlets are just
dummy numbers.
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On the results form, the final values for the calculated variables and for the
balance equations are tabulated.

The final values for the calculated variables are found on the Calculated
Variables sheet. In this example, the mass flow of the two inlet streams, H2OIN
and MECHIN are calculated.
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The final values for the balance equations are found on the Equations sheet. The
number of equation in the problems is shown; here there are two mass balance
equations.

Example of Calculating a Coolant Flow Rate

Use a balance block to calculate the required flow rate of cooling water in order to
cool a stream of methanol from 150 F to 100 F.  A Balance block will eliminate
the need for a Design specification and a convergence loop.
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MEOHIN

H2OOUT

MEOHOUT

H2OIN
Spec = 80 F

150 F, 14.7 PSI

50 F, 14.7 PSI

100 F, 14.7 PSI

Cold-Side

Hot-Side
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26 Case Study

This chapter includes information about:
• Using Case Study
• Creating a Case Study
• Identifying Case Study variables
• Specifying values for Case Study variables
• Specifying report options for Case Study

Using Case Study

After you run a base-case simulation, you may want to run several parametric
cases for the same flowsheet. You can use the Case Study tool to run multiple
simulation cases for the same flowsheet when you make batch runs. Case Study
will perform a flowsheet simulation for each case in a series. The Case Study
block does not affect the base-case simulation or the base-case report.

Aspen Plus generates a report for each case. You can tailor the case reports to
contain only those report sections of interest.

Aspen Plus ignores a Case Study block when you make interactive runs from the
user interface. See Chapter 11, Running Your Simulation for more information
on batch runs.
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Creating a Case Study

To create a Case Study:

1. From the Data menu, point to Model Analysis Tools, then Case Study.

2. On the Case Study Setup Vary sheet, identify the variables you want to
change from case to case. See Identifying Case Study Variables, this chapter.

3. On the Case Study Setup Specifications sheet, specify values for the case
study variables for each case. See Specifying Values for Case Study Variables,
this chapter.

4. If you want to specify report options, use the Case Study ReportOptions form.
See Specifying Report Options for Case Studies, this chapter.

Identifying Case Study Variables

Use the Case Study Setup Vary sheet to identify flowsheet variables you want to
change from case to case. You can only change block input, process feed stream,
and other input variables. Result variables cannot be modified directly.

To identify the variables you want to change from case to case:

1. On the Case Study Setup form, select the Vary tab.

2. On the Variable Number field, click the down arrow and select <new> from
the list.

3. In the Manipulated Variable Type field, select a variable type.

4. Aspen Plus automatically shows the fields necessary to uniquely identify the
flowsheet variables. Complete the fields to define the variable. See Chapter
18, Accessing Flowsheet Variables, for more information on accessing
variables.

5. You have the option of labeling the variables for the report. Use the Report
Labels Line 1 to Line 4 fields to define these labels.

6. Repeat steps 2-5 until you have identified all case study variables.
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Specifying Values for Case Study
Variables

Use the Case Study Setup Specifications sheet to specify values for the case
study variables.

To specify values for case study variables:

1. On the Case Study Setup form, select the Specifications tab.

2. On the Case Number field, click the down arrow and select <new> from the
list.

3. In the New Item dialog box, enter an ID or accept the default ID. The ID must
be an integer.

4. In the Values for Manipulated Variable field, enter a value for each variable.
Enter multiple variable values in the same order as you identified them on
the Vary sheet.

5. To enter another case, repeat steps 2 and 3 until you have defined all the
cases you want to run.

On the Case Study Setup Specifications sheet, you can also:
• Reset convergence and unit operation restart flags for blocks
• Restore initial values for tear streams and feed streams
• Enter the case report description

Resetting Initial Values
Use the Case Study Setup Specifications sheet to reset convergence and unit
operation reinitialization options for blocks. You can also restore initial values for
tear streams, feed streams manipulated by design specifications, optimization
blocks, and Calculator blocks. By default, blocks or streams are not reinitialized.
It is usually most efficient to begin the calculation for a new case with the results
of the previous case.

To reinitialize blocks:

1. On the Case Study Setup form, select the Specifications tab.

2. In the Blocks to be Reinitialized field, select either Include Specified Blocks or
Reinitialize All Blocks.
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3. If you choose Include Specified Blocks, select the unit operation blocks and/or
the convergence blocks to be reinitialized.

To reinitialize streams:

1. On the Case Study Setup form, select the Specifications tab.

2. In the Streams to be Reinitialized field, select either Include Specified
Streams or Reinitialize All Streams.

3. If you choose Include Specified Streams, select the streams to be reinitialized.

Entering a Description
Use the Case Study Setup Specifications sheet to enter the case report
description, which will appear as a title in the case report.

To enter a case report description:

1. On the Case Study Setup form, select the Specifications tab.

2. Click the Description button.

3. Enter the description

4. Click Close.

Specifying Report Options for Case
Studies

Use the Case Study ReportOptions form to specify which sections of the report to
include or suppress in the case reports. A separate report is generated for each
case and appended to the report file. If you specified report options for the base
case on the Setup ReportOptions form, and would like the same options for the
case reports, you must re-specify the report options on the Case Study
ReportOptions sheet.

Any options for Block reports which you specified for the base case on the Setup
ReportOptions Block sheet  or on the BlockOptions ReportOptions sheet for the
block also applies to the case reports.
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The following table shows what you can specify and where:

To specify ReportOptions Sheet

Whether to generate a report file and which sections of the report to
include

General

Which flowsheet option reports to include in the report file Flowsheet

Which block reports to include in the report file Block

Which streams to include in the report file and the format for the
streams

Stream

Whether to generate additional stream reports, and if so the streams to
include in the report file and the format for the streams

Supplementary Stream
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27 Specifying Reactions and
Chemistry

This chapter describes how to define reaction systems in Aspen Plus including:
• About Reactions and Chemistry
• About Electrolytes Chemistry
• Specifying Electrolytes Chemistry
• Specifying Power Law Reactions for Reactors and Pressure Relief Systems
• Reactions With Solids
• Specifying LHHW Reactions for Reactors and Pressure Relief Systems
• Specifying Reactions for Reactive Distillation
• Using a User Kinetic Subroutine

About Reactions and Chemistry

There are two types of reaction systems and Aspen Plus uses different methods
for simulating them:

Type of reaction system Description Use this Data Browser Form

Electrolytes solution chemistry Reactions involving the formation of ionic
species

Chemistry

Non-electrolyte reactions Rate-controlled or equilibrium limited.
For reactors and reactive distillation
modeling.

Reactions
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Reactions
Rate-controlled and non-electrolyte equilibrium reactions are specified as
Reaction IDs that can be referenced in kinetic reactors, columns, and pressure
relief calculations. These reactions can be used by:
• RadFrac, RateFrac, and BatchFrac for reactive distillation
• RBatch, RCSTR, and RPlug, the kinetics-based reactor models
• Pressure Relief model for pressure relief calculations in reactive systems

The reaction kinetics of rate-based reactions can be represented using any of the
following expressions:
• Power Law kinetic model
• Langmuir-Hinshelwood-Hougen-Watson (LHHW) kinetic model (not

applicable to reactive distillation systems)
• User-defined kinetic model

Chemistry
Electrolyte solution chemistry is specified as a Chemistry ID that can be
referenced on the Properties Specification Global sheet and on the BlockOptions
Properties sheets for individual unit operation blocks. Unlike non-electrolyte
reactions which are specified and executed only within certain unit operation
blocks and pressure relief calculations, electrolyte chemistry definitions become
part of the physical property specifications for a simulation or flowsheet section.
They are used for all calculations (in any stream or unit operation block ) which
use that property specification.

About Electrolytes Chemistry

In electrolyte systems, molecular species dissociate partially or completely in
solution and/or precipitate as salts. Examples include the following systems:
• Sour water (H2S-NH3-CO2-Water)
• Amines
• Acids (HCl-Water)
• Brine (NaCl-Water)
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Electrolyte systems are characterized by their base molecular components (the
apparent components), and by:
• Species resulting from dissociation and/or precipitation, such as ions and

salts
• Compounds formed through chemical reactions among the species

There are three types of electrolyte reactions:

Type Example

Partial dissociation equilibria † HCl + H2O  H3O+  +  Cl-

Salt precipitation equilibria † NaCl (Salt) �  Na+   + Cl-

Complete dissociation NaCl (liquid phase)  Na+ + Cl-

†
Equilibrium constants are required to model these reactions. They can be calculated from correlations (as a function of
temperature) or from Gibbs free energy.

Collectively the species and reactions are referred to as the electrolytes
chemistry. Electrolytes chemistry must be modeled correctly for accurate
simulation results. Normally this requires expert knowledge of the solution
chemistry. In most cases, however, the Aspen Plus Electrolytes Wizard can
generate the species and reactions for you, using a built-in knowledge base of
reactions, equilibrium constant data, and possible ionic species. For more
information on the Electrolytes Wizard, see Chapter 6.

Specifying Electrolytes Chemistry

To specify the electrolytes chemistry for a simulation, you must:

1. Define the complete set of components present (including ions, salts, and
other species generated by reaction) on the Components Specification
Selection sheet.

2. Define the stoichiometry and reaction type, using the Reactions Chemistry
Stoichiometry sheet.

3. Specify the concentration basis, the temperature approach to equilibrium,
and coefficients for the equilibrium constant expression, using the Reactions
Chemistry EquilibriumConstants sheet.
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It is recommended that you use the Electrolytes Wizard to define both the
components and reactions. The Electrolytes Wizard:
• Uses a built-in knowledge base to generate the electrolyte components and

reactions
• Accesses the Aspen Plus electrolytes reaction database for equilibrium

constant data

For information on the Electrolytes Wizard, see Chapter 6.

You can define your own electrolyte chemistry, or you can view or modify the
chemistry generated by the Electrolytes Wizard.

To define, view, or modify electrolyte chemistry:

1. From the Data menu, point to Reactions then Chemistry.

2. To create a new Chemistry ID, click New on the Reactions Chemistry Object
Manager. Enter an ID in the Create new ID dialog box or accept the default
ID, and click OK.

3. To modify an existing Chemistry ID, select its name in the Object Manager
and choose Edit.

4. Follow the instructions in subsequent sections of this chapter for details on
defining each type of reaction within a Chemistry ID.

The following sections explain how to create new reactions within an existing
Chemistry ID, by specifying stoichiometry and calculations options for the
equilibrium constant. You can specify any number of reactions within a
Chemistry ID.

You also can have any number of Chemistry IDs in your simulation. Because the
Chemistry ID becomes part of the total Property Method definition, you can
specify different Chemistry IDs anywhere you use different Property Methods,
such as flowsheet sections or individual unit operation blocks. For more
information on specifying multiple Property Methods within a flowsheet, see
Chapter 7.

Defining Stoichiometry for Electrolytes Chemistry

Equilibrium Ionic Reactions

Equilibrium ionic reactions describe the partial dissociation of weak electrolytes
and other liquid phase equilibria. Each equilibrium ionic reaction within a
Chemistry ID is referenced with a reaction number (for example, 1, 2, 3, etc.)
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To define a new reaction number and specify the stoichiometry for an ionic
equilibrium reaction:

1. On the Reactions Chemistry Stoichiometry sheet for your Chemistry ID, click
New.

2. On the Select Reaction Type dialog box, Equilibrium is the default reaction
type.  Enter an ID or accept the default ID and click OK.  The ID must be an
integer.

3. On the Equilibrium Reaction Stoichiometry dialog box, enter the components
and stoichiometric coefficients that make up your reaction. Coefficients
should be negative for reactants and positive for products.

4. Click Close when finished. You should see your new reaction listed on the
Stoichiometry sheet with the information displayed in equation form.

5. Repeat steps 1-4 for each additional ionic equilibrium reaction.

Salt Precipitation Reactions

Salt precipitation reactions describe the formation or dissolution of salts in
equilibrium with the liquid phase. Each salt precipitation reaction within a
Chemistry ID is referenced by the component name of the salt.

To define the stoichiometry for a new salt precipitation reaction:

1. On the Reactions Chemistry Stoichiometry sheet for your Chemistry ID, click
New.

2. On the Select Reaction Type dialog box, select Salt in the Choose Reaction
Type frame.

3. In the Enter Salt Component ID field, select the name of the salt for which
you are defining the reaction, and click OK.

4. On the Salt Dissolution Stoichiometry dialog box, enter the components and
stoichiometric coefficients for the products (ions) formed by the dissolution of
the salt.

5. Click Close when finished. You should see your new reaction listed on the
Stoichiometry sheet with the information displayed in equation form.

6. Repeat steps 1-5 for each additional salt precipitation reaction.
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Complete Dissociation Reactions

Complete dissociation reactions describe the complete dissociation of strong
electrolytes in the liquid phase. These reactions do not have equilibrium
constants. Each complete dissociation reaction within a Chemistry ID is
referenced by the name of the dissociating component.

To define the stoichiometry for a new complete dissociation reaction:

1. On the Reactions Chemistry Stoichiometry sheet for your Chemistry ID, click
New.

2. On the Select Reaction Type dialog box, select Dissociation in the Choose
Reaction Type frame.

3. In the Enter Dissociating Electrolyte field, select the name of the component
for which you are defining the reaction, and click OK.

4. On the Electrolyte Dissociation Stoichiometry dialog box, enter the
components and stoichiometric coefficients for the dissociation products.

5. Click Close when finished. You should see your new reaction listed on the
Stoichiometry sheet with the information displayed in equation form.

6. Repeat steps 1-5 for each additional complete dissociation reaction.

Defining Equilibrium Constants for Electrolytes
Chemistry

Equilibrium constants are required to model equilibrium ionic reactions and salt
precipitation reactions. Aspen Plus can calculate these equilibrium constants from
correlations (as a function of temperature) or from reference state Gibbs free
energy (available in the Aspen Plus databanks).
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To define how the equilibrium constants will be calculated for the equilibrium
ionic reactions and salt precipitation reactions within your Chemistry ID:

1. On the Reactions Chemistry form for your Chemistry ID, select the
Equilibrium Constants sheet.

2. Choose the concentration basis for equilibrium constants in the Concentration
Basis For Keq list. The concentration basis determines how the equilibrium
constant is calculated:

Concentration Basis Equilibrium Constant Definition †

Mole-Frac (default) i
iixK νγ )(Π=

Molal i
iimK νγ )(Π=

†   Where:
K = Equilibrium constant
x = Component mole fraction
m = Molality (gmole/kg-H2O)
γ = Activity coefficient
ν = Stoichiometric coefficient
i = Component index
Π  is the product operator.

All properties refer to the liquid phase.

3. You can specify a Temperature Approach to Equilibrium that applies to all
ionic equilibrium and salt precipitation reactions defined in the Chemistry
ID.  The temperature approach you specify is added to the stream or block
temperature to compute the equilibrium constants.  If you do not specify a
temperature approach, Aspen Plus uses a default value of 0.

4. Use the Hydrate-Check field to select the method that Aspen Plus uses to
determine which hydrate to precipitate when you have specified multiple
hydrates as precipitation reactions for a salt.

Hydrate-check Method Information

Rigorous (default) Uses Gibbs free energy minimization to select the hydrate.  Allows Aspen Plus to
predict the formation of the correct hydrate for salts with multiple hydrates.

Approximate Uses the lowest solubility product value at the system temperature to select the
hydrate.  Requires less computation time than the rigorous method.

5. Select the appropriate reaction type (Equilibrium Reaction or Salt), and
choose the appropriate reaction from the list.

6. Leave the equilibrium coefficients blank.
– or –
Enter coefficients for the built-in equilibrium constant expression:
ln (Keq) = A + B / T + C*ln (T) + D*T
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Where:

Keq = Equilibrium constant

T = Temperature in Kelvin

A, B, C, D = User supplied coefficients

The definition of K depends on the concentration basis selected.
If coefficients are not entered, Aspen Plus computes the equilibrium constant
from the reference state Gibbs free energies of formation.

Repeat steps 5 and 6 for all ionic equilibrium reactions and salt precipitation
reactions included in the Chemistry ID. Because complete dissociation reactions
do not have equilibrium constants, nothing on the Equilibrium Constants sheet
applies to reactions of this type.

Specifying Power Law Reactions for
Reactors and Pressure Relief Systems

Powerlaw Reaction IDs can represent equilibrium reactions, or rate-controlled
reactions represented by the power law. To use a Powerlaw Reaction ID in the
Aspen Plus reactor models RCSTR, RPlug, and RBatch, or for the pressure relief
calculations in Pres-Relief, you need to:
• Define the type and stoichiometry of the reactions
• Enter equilibrium or kinetic parameters

RPlug, RBatch, and Pres-Relief can handle rate-controlled reactions. RCSTR can
handle both rate-controlled and equilibrium reactions.

To create a new Powerlaw Reaction ID:

1. From the Data menu, point to Reactions then Reactions.

2. To create a new Reaction ID, click New in the Reactions Object Manager.

3. In the Create New ID dialog box, enter a reaction ID in the Enter ID field, or
accept the default ID.

4. Select Powerlaw in the Select Type list, and click OK.
Once the Reaction ID is created, Aspen Plus brings you to the Stoichiometry
sheet where you can begin defining reactions within the Reaction ID. There
are two types of reactions allowed in a Powerlaw type Reaction ID.
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Type For

Equilibrium Equilibrium reactions

Kinetic Rate-controlled reactions

 

5. To specify the individual reactions within your reaction ID, follow the
instructions in subsequent sections of this chapter for the type of reaction you
want to create.

Equilibrium Reactions (for RCSTR only)
To add equilibrium type reactions to your Powerlaw Reaction ID:

1. Click New on the Reactions Stoichiometry sheet of your Powerlaw Reaction
ID.

2. On the Edit Reaction dialog box, select Equilibrium from the Reaction Type
list. The reaction number is entered automatically.

3. Enter components and stoichiometric coefficients to define the reaction.
Coefficients should be negative for reactants and positive for products. You
should not specify exponents for equilibrium reactions.

4. Click Close when finished. You should see your new reaction number, type,
and equation displayed on the Stoichiometry sheet.

5. Repeat steps 1 through 4 for each additional equilibrium reaction.

6. Select the Equilibrium tab on the Reactions form to open that sheet.

7. On the Equilibrium sheet, select a reaction from the list at the top of the
sheet.

8. Specify the phase in which the reaction will occur in the Reacting Phase list.
The default is the liquid phase.

9. If the reaction does not actually reach equilibrium, you can enter a
temperature approach to equilibrium in the Temperature Approach to
Equilibrium field. The number of degrees you enter will be added to the
reactor temperature to compute the equilibrium constant.

10. Choose whether you want to compute Keq from Gibbs energies or from a built
in polynomial expression by selecting the appropriate option.
If you choose Compute Keq From Gibbs Energies, you do not need to enter
coefficients for the equilibrium constant. Aspen Plus will compute the Keq
from the reference state Gibbs free energy of the components.
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11. If you choose Compute Keq From Built-In Expression, enter coefficients for
the built-in equilibrium constant expression, and choose a basis for the
equilibrium constant:
ln Keq = A + B/T + C*ln(T) + D*T
Where:

Keq = Equilibrium constant

T = Temperature in Kelvin

A, B, C, D = User-supplied coefficients

The definition of Keq depends on the basis you select in the Keq Basis list.

Keq Basis Equilibrium Constant Definition†

Mole gamma (default) Keq = Π (xi γi)υi  (liquid only)

Molal gamma Keq = Π (mi γi)υi (electrolytes, liquid only)

Mole fraction Keq = Π (xi)υi

Mass fraction Keq = Π (xim)υi

Molarity Keq = Π (Ci)υi

Molality Keq = Π (mi)υi (liquid only)

Fugacity Keq = Π (fi)υi

Partial pressure Keq = Π (pi)υi (vapor only)

Mass concentration Keq = Π (Cim)υi

†  Where:
Keq = Equilibrium constant
x = Component mole fraction
xm = Component mass fraction
C = Molarity (kgmole/m3)
m = Molality (gmole/kg-H2O)
γ = Activity coefficient
f = Component fugacity (N/m2)
p = Partial pressure (N/m2)
Cm = Mass concentration (kg/m3)
υ = Stoichiometric coefficient (positive for products, negative for reactants)
i = Component index
Π  is the product operator

 

12. If solids are present, click the Solids button and select the appropriate options
for calculation of concentration. For more information, see Reactions With
Solids, this chapter.

13. Repeat steps 7 through 12 for each equilibrium reaction.
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Rate-Controlled Reactions
To add kinetic type reactions to your Powerlaw Reaction ID:

1. Click New on the Reactions Stoichiometry sheet of your Powerlaw Reaction
ID.

2. On the Edit Reaction dialog box, Reaction Type defaults to Kinetic, and the
reaction number is entered automatically. Enter components and
stoichiometric coefficients to define the reaction. Coefficients should be
negative for reactants and positive for products.

3. Specify power law exponents for the components. These exponents represent
the order of the reaction with respect to each component. If you do not specify
an exponent for a component, Aspen Plus uses a default value of 0.

4. Click Close when finished. You should see your new reaction number, type,
and equation displayed on the Stoichiometry sheet.

5. Repeat steps 1 through 4 for each additional kinetic reaction.

6. Select the Kinetic sheet.

7. On the Kinetic sheet, select a reaction from the list at the top of the sheet.

8. Specify in which phase the reaction will take place in the Reacting Phase
field. The default is the liquid phase.

9. Enter the pre-exponential factor (k), the temperature exponent (n), and the
activation energy (E) in the appropriate fields. The pre-exponential factor
must be in the SI units described later in this section. The temperature
exponent refers to temperature in Kelvin.

10. In the [Ci] Basis list, select the concentration basis. The concentration basis
determines which form of the power law expression will be used, as discussed
later in this section.

11. If solids are present, click the Solids button and select the appropriate options
for calculation of concentration. For more information, see Reactions With
Solids, this chapter.

12. Repeat steps 7 through 11 for each kinetic reaction.
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The power law expression depends on the concentration basis you select in the
[Ci] Basis list:

[Ci] Basis Power Law Expression†

(To is not specified)
Power Law Expression†

(To is specified)

Molarity (default) ( )∏−= i
i

RTEn CekTr α/ ( )∏−−= io
i

TTREn
o CeTTkr α]/1/1)[/()/(

Molality
(electrolytes only) ( )∏−= i

i
RTEn mekTr α/ ( )∏−−= io

i
TTREn

o meTTkr α]/1/1)[/()/(

Mole fraction ( )∏−= i
i

RTEn xekTr α/ ( )∏−−= io
i

TTREn
o xeTTkr α]/1/1)[/()/(

Mass fraction ( )∏−= im
i

RTEn xekTr
α/ ( )∏−−= io m

i
TTREn

o xeTTkr
α]/1/1)[/()/(

Partial pressure
(vapor only) ( )∏−= i

i
RTEn pekTr α/ ( )∏−−= io

i
TTREn

o peTTkr α]/1/1)[/()/(

Mass concentration ( )∏−= im
i

RTEn CekTr
α/ ( )∏−−= io m

i
TTREn

o CeTTkr
α]/1/1)[/()/(

† Where:
r = Rate of reaction
k = Pre-exponential factor
T = Temperature in degrees Kelvin
To = Reference temperature in degrees Kelvin
n = Temperature exponent
E = Activation energy
R = Universal gas law constant
x = Mole fraction
xm = Mass fraction
C = Molarity (kgmole/m3)
m = Molality (gmole/kg-H2O)
Cm = Mass concentration (kg/m3)
p = Partial pressure (N/m2)
α = Concentration exponent
i = Component index
Π is the product operator.

The units of the reaction rate and the pre-exponential factor depend on the:
• Order of the reaction
• Concentration basis selected in the [Ci] Basis list box
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The units for the pre-exponential factor are as follows:

When [Ci] Basis is Units are:
(To is not specified)

Units are:
(To is specified)
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Reactions With Solids

When modeling reactive systems containing solids, there are many ways to
account for the effect of these solids in your simulation. Aspen Plus provides
calculation options to appropriately model the effect of your solids on the reaction
stoichiometry, the reaction rate, and volume basis for concentrations. The
information in this section is designed to help you specify Reaction IDs that most
accurately reflect your reactions.
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Stoichiometry and Reaction Rate
When specifying a reaction on the Edit Reaction dialog box:

For Solids that Specify

Participate in reactions and control the reaction
rate.

Both stoichiometric coefficients and exponents.

Participate in reactions without controlling the
reaction rate.

Only the stoichiometric coefficients for these solids, without
entering exponents.

Act as  catalysts by controlling reaction rates
without participating in the reactions.

Only the exponents for these solids, without entering
stoichiometric coefficients.

Are inert.  Neither stoichiometric coefficients nor exponents.

Volume Basis for Concentrations
When specifying information for the calculation of an equilibrium constant for
equilibrium reactions, or a reaction rate for kinetic reactions, solid components
can either be included or ignored in the denominator term of concentrations. To
control how these calculations are performed, use the Solids button on
Equilibrium sheet or the Kinetic sheet of your Reaction ID.

The Solids dialog box allows the following specifications with regard to the
denominator term of component concentrations:
• For liquid and vapor component concentrations, you can include the reacting

phase only, or the reacting phase and the solid phase, by clicking the
appropriate option in the For Liquid or Vapor Component frame. The default
is to include only the reacting phase.

• For solid component concentrations, you can include the solid phase only, or
the solid and total liquid phases, by clicking the appropriate option in the For
Solid Component frame. The default is to include only the solid phase.

• For wolid component concentrations, you can also include solid components in
all substreams, or only those in the substream of the reacting solid, by click
the appropriate option.  The default is to include solids in all substreams.
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Specifying LHHW Reactions for Reactors
and Pressure Relief Systems

To specify Langmuir-Hinshelwood-Hougen-Watson (LHHW) kinetics for the
reactor models RCSTR, RPlug, and RBatch, or for the pressure relief calculations
in Pres-Relief, you need to:
• Define the type and stoichiometry of the reactions
• Enter equilibrium or kinetic parameters
• Specify optional adsorption expressions

To specify LHHW reactions:

1. From the Data menu, point to Reactions, then Reactions.

2. On the Reactions Object Manager, click New to create a new Reaction ID.

3. In the Create New ID dialog box, enter a reaction name in the Enter ID field,
or accept the default ID.

4. Select LHHW in the Select Type list, and click OK.
Once the Reaction ID is created, you can begin defining reactions within the
Reaction ID. There are two types of reactions allowed in a LHHW type
Reaction ID.

Type For

Equilibrium Equilibrium reactions

Kinetic Rate-controlled reactions

To specify the individual reactions within your LHHW Reaction ID, follow the
instructions in subsequent sections of this chapter for the type of reaction you
want to create.

Equilibrium Reactions for LHHW (for RCSTR only)
Specify equilibrium reactions for LHHW the same way as for Powerlaw
reactions. See Specifying Power Law Reactions for Reactors and Pressure Relief
Systems, this chapter.
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Rate-Controlled Reactions for LHHW
For rate-controlled reactions, the LHHW rate expression can be written as:

γ =
( )kinetic factor)(driving force expression 

(adsorption expression)

Where:

Kinetic factor (if To is
specified)

=
( )[ ]ToTRE

n

o

ae
T
Tk /1/1/ −−�

��
�

�

Kinetic factor (if To is
not specified)

= RTEn aekT /−

Driving force expression = ( ) ( )ji v
j

v
i CKCK ∏−∏ 21

Adsorption expression = ( ){ }mv
ji
jCK ∏Σ

Where:

r = Rate of reaction

k = Pre-exponential factor

T = Temperature in Kelvin

oT = Reference temperature in Kelvin

n = Temperature exponent

aE = Activation energy

R = Universal gas law constant

C = Component concentration

m = Adsorption expression exponent

iKKK ,, 21 = Equilibrium constants

υ = Concentration exponent

i, j = Component index

Π is the product operator, and Σ is the summation operator.
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The concentration terms Ci and Cj depend on the concentration basis you select:

[Ci] basis Concentration term C

Molarity Component molar concentration (kgmole/m3)

Molality Component molality (gmole/kg H2O)

Mole fraction Component mole fraction

Mass fraction Component mass fraction

Partial pressure Component partial pressure (N/m2)

Mass concentration Component mass concentration (kg/m3)

To add kinetic type reactions to your LHHW Reaction ID:

1. Click New on the Reactions Stoichiometry sheet of your LHHW Reaction ID.

2. On the Edit Reaction dialog box, Reaction Type defaults to Kinetic, and the
reaction number is entered automatically. Enter components and
stoichiometric coefficients to define the reaction. Coefficients should be
negative for reactants and positive for products.

3. Click Close when finished. You should see your new reaction number, type,
and equation displayed on the Stoichiometry sheet.

4. Repeat steps 1 through 3 for each additional kinetic reaction.

5. Select the Kinetic sheet.

6. On the Kinetic sheet, select a reaction from the list at the top of the sheet.

7. Specify in which phase the reaction will take place using the Reacting Phase
list. The default is the liquid phase.

8. Enter the pre-exponential factor (k), the temperature exponent (n), and the
activation energy (E) in the appropriate fields of the Kinetic Factor frame.
The pre-exponential factor must be in the SI units described in Specifying
Power Law Reactions for Reactors and Pressure Relief Systems, this chapter.
The temperature exponent refers to temperature in Kelvin.

9. If solids are present, click the Solids button and select the appropriate options
for calculation of concentration. For more information, see Reactions With
Solids, this chapter.

10. Click the Driving Force button.

11. On the Driving Force Expression dialog box, select the concentration basis in
the [Ci] Basis list. See Specifying Power Law Reactions for Reactors and
Pressure Relief Systems, this chapter, for the definitions of the concentration
basis options.
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12. With the Enter Term value at the default of Term 1, enter the concentration
exponents for reactants and products, and the coefficients for the driving
force constant (A, B, C, and D) for term 1 of the driving force.

13. Select Term 2 in the Enter Term list.

14. Enter the concentration exponents for reactants and products, and the
coefficients for the driving force constant (A, B, C, and D) for term 2 of the
driving force expression.

15. Click Close when finished with both terms.

16. To specify optional adsorption expressions, click the Adsorption button.

17. On the Adsorption Expression dialog box, enter the overall exponent for the
adsorption term in the Adsorption Expression Exponent field.

18. Specify concentration exponents by selecting components and entering an
exponent for each term in the adsorption expression.

19. Specify adsorption constants by entering the Term No. and specifying the
coefficients.
The coefficients are for the following correlation:

ln Ki = Ai + Bi/T + Ci * ln(T) + Di * T
Where:
Ki = Equilibrium constant
T = Temperature in Kelvin
Ai, Bi, Ci, Di = User-supplied coefficients

20. Repeat steps 6 through 19 for each additional LHHW kinetic reaction.

Specifying Reactions for Reactive
Distillation

To specify reactions for reactive distillation in the distillation models, RadFrac,
BatchFrac, and RateFrac, use the Reactions REAC-DIST forms to:
• Define reaction stoichiometry
• Enter equilibrium or kinetic parameters
• Specify parameters for user-defined kinetics
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For RadFrac and RateFrac, you can also use the Reactions User forms to specify
user-defined kinetics (see Using a User-Kinetics Subroutine, this chapter). The
Reactions User forms is preferred because you can use the same user-defined
kinetics in reactor or pressure relief calculations.

To create a new distillation reaction ID:

1. From the Data menu, point to Reactions then Reactions.

2. On the Reactions Object Manager, click New to create a new Reaction ID.

3. In the Create New ID dialog box, enter a reaction name in the Enter ID field,
or accept the default ID.

4. Select REAC-DIST in the Select Type list, and click OK.
Once the Reaction ID is created, you can begin defining reactions within the
Reaction ID. There are four types of reactions allowed in a Reac-Dist Reaction
ID.

Type For

Equilibrium Equilibrium  reactions

Kinetic Rate-controlled reaction

Conversion Fractional conversion reaction (RadFrac only)

Salt Electrolyte salt precipitation (RadFrac only)

5. To specify the individual reactions within your Reac-Dist reaction ID, follow
the instructions in subsequent sections of this chapter for the type of
reactions listed in the previous table.

Equilibrium Reactions
To add equilibrium type reactions to your Reaction ID:

1. Click New on the Reactions Stoichiometry sheet of your Reac-Dist Reaction
ID.

2. In the Select Reaction Type dialog box, Kinetic/Equilibrium/Conversion is the
default reaction type. Accept the default Reaction No. displayed or enter a
new Reaction No. Click OK.

3. On the Edit Reaction dialog box, Reaction Type defaults to Equilibrium.
Enter components and stoichiometric coefficients to define the reaction.
Coefficients should be negative for reactants and positive for products. You
should not specify exponents for equilibrium reactions.
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4. Click Close when finished. You should see your new reaction number, type,
and equation displayed on the Stoichiometry sheet.

5. Repeat steps 1 through 4 for each additional equilibrium reaction.

6. Click the Equilibrium sheet.

7. On the Equilibrium sheet, select a reaction from the list at the top of the
sheet.

8. Specify the phase in which the reaction will occur in the Reacting Phase list.
The default is the liquid phase.

9. Specify a calculation basis for the equilibrium constant by selecting an option
in the Keq Basis list. The basis you choose defines how the equilibrium
constant will be calculated, as discussed later in this section.

10. If the reaction does not actually reach equilibrium, you can specify
Temperature Approach to Equilibrium. The temperature approach you enter
will be added to the stage temperature to compute the equilibrium constant.

11. Choose whether you want to compute Keq from Gibbs energies or from a built
in polynomial expression by selecting the appropriate radio button.
If you choose Compute Keq From Gibbs Energies, you do not need to enter
coefficients for the equilibrium constant. Aspen Plus will compute Keq from
the reference state Gibbs free energy of the components. You can skip to step
12.

12. If you choose Compute Keq From Built-In Expression, you must enter
coefficients for the built-in equilibrium constant expression:
ln Keq = A + B/T + C*ln(T) + D*T
Where:
Keq = Equilibrium constant
T = Temperature in Kelvin
A, B, C, D = User-supplied coefficients
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The definition of Keq depends on the basis you select in the Keq Basis list
box.

Kbasis Equilibrium Constant Definition†

Mole gamma (default) ∏= i
iixK υγ )(   (liquid only)

Molal gamma ∏= i
iimK υγ )(   (electrolytes, liquid only)

Mole fraction ∏= i
ixK υ)(

Mass fraction ∏= im
ixK υ)(

Molarity ∏= i
iCK υ)(

Molality ∏= i
imK υ)(   (liquid only)

Fugacity ∏= i
ifK υ)(

Partial pressure ∏= i
ipK υ)(   (vapor only)

Mass concentration ∏= im
iCK υ)(

†  Where:
K = Equilibrium constant
x = Component mole fraction
xm = Component mass fraction
C = Molarity (kgmole/m3)
m = Molality (gmole/kg-H2O)
γ = Activity coefficient
f = Component fugacity (N/m2)
p = Partial pressure (N/m2)
Cm = Mass concentration (kg/m3)
υ = Stoichiometric coefficient (positive for products, negative for reactants)
i = Component index
Π = Product operator

All properties refer to the phase selected in the Reacting Phase field.

13. Repeat steps 7 through 12 for each equilibrium reaction.

Rate Controlled Reactions
Reactive distillation kinetics can be represented with a built-in Power Law
expression, or a user kinetics subroutine. The following procedure shows how to
use either method.
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To add kinetic type reactions to your Reaction ID:

1. Click New on the Reactions Stoichiometry sheet of your Reac-Dist Reaction
ID.

2. In the Select Reaction Type dialog box, Kinetic/Equilibrium/Conversion is the
default reaction type.  Accept the default Reaction No. displayed or enter a
new Reaction No. Click OK.

3. On the Edit Reaction dialog box, select Kinetic from the Reaction Type list.

4. Enter components and stoichiometric coefficients to define the reaction.
Coefficients should be negative for reactants and positive for products.

5. Specify Power Law exponents for each component. These exponents represent
the order of the reaction with respect to each component. If you wish to
specify a user kinetics subroutine to compute the reaction rates, do not enter
exponents on this sheet.

6. Click Close when finished. You should see your new reaction number, type,
and equation displayed on the Stoichiometry sheet.

7. Repeat steps 1 through 6 for each additional kinetic reaction.

8. Select the Kinetic sheet.

9. On the Kinetic sheet, select the appropriate option to use the built-in Power
Law expression, or a user kinetic subroutine to represent the kinetics for the
current Reaction ID.

10. Select a reaction from the list and specify in which phase the reaction will
take place using the Reacting Phase list. The default reacting phase is liquid.

11. To use a user kinetics subroutine, you do not need to enter any further
information on this sheet. Select the Subroutine tab of the reaction form, and
specify the subroutine name in the Name field.
For RadFrac and RateFrac, you can also specify user-defined kinetics on the
Reactions User forms (see Using a User-Kinetics Subroutine, this chapter).
The Reactions User forms is preferred because you can use the same user-
defined kinetics in reactor or pressure relief calculations. For more
information on using and writing user kinetics models, see Aspen Plus User
Models.
The rest of this procedure assumes you are using the built in Power Law.

12. To use the built-in Power Law expression, enter the pre-exponential factor
(k), the temperature exponent (n), and the activation energy (E) on the
Kinetic sheet of the Reactions form. The pre-exponential factor must be in the
SI units described later in this section.  The temperature exponent refers to
temperature in Kelvin.
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13. In the [Ci] Basis list, select the concentration basis. The concentration basis
determines which form of the power law expression will be used, as discussed
later in this section.

14. Repeat steps 10 through 13 for each kinetic reaction.

The power law expression depends on the concentration basis you select in the
[Ci] Basis list box:

[Ci] Basis Power Law Expression†

(To is not specified)
Power Law Expression†

(To is specified)

Molarity (default) ( )∏−= i
i

RTEn CekTr α/ ( )∏−−= io
i

TTREn
o CeTTkr α]/1/1)[/()/(

Molality
(electrolytes only) ( )∏−= i

i
RTEn mekTr α/ ( )∏−−= io

i
TTREn

o meTTkr α]/1/1)[/()/(

Mole fraction ( )∏−= i
i

RTEn xekTr α/ ( )∏−−= io
i

TTREn
o xeTTkr α]/1/1)[/()/(

Mass fraction ( )∏−= im
i

RTEn xekTr
α/ ( )∏−−= io m

i
TTREn

o xeTTkr
α]/1/1)[/()/(

Partial pressure
(vapor only) ( )∏−= i

i
RTEn pekTr α/ ( )∏−−= io

i
TTREn

o peTTkr α]/1/1)[/()/(

Mass concentration ( )∏−= im
i

RTEn CekTr
α/ ( )∏−−= io m

i
TTREn

o CeTTkr
α]/1/1)[/()/(

† Where:
r = Rate of reaction
k = Pre-exponential factor
T = Temperature in degrees Kelvin
To = Reference temperature in degrees Kelvin
n = Temperature exponent
E = Activation energy
R = Universal gas law constant
x = Mole fraction
xm = Mass fraction
C = Molarity (kgmole/m3)
m = Molality (gmole/kg-H2O)
Cm = Mass concentration (kg/m3)
p = Partial pressure (N/m2)
α = Concentration exponent
i = Component index
Π is the product operator.

The units of the reaction rate and the pre-exponential factor depend on the:
• Order of the reaction
• Holdup basis used by the distillation block
• Concentration basis selected in the [Ci] Basis list box
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The units for the pre-exponential factor are as follows:

When [Ci] Basis is Units are:
(To is not specified)

Units are:
(To is specified)

Molarity

i∑








−

3

-n

m

kgmole

unit) (holdup sec

K-kgmole

i∑








−

3m

kgmole

unit) (holdup sec

kgmole

Molality

i∑








−

OH kg

gmole

unit) (holdup sec

K-kgmole

2

-n

i∑








−

OH kg

gmole

unit) (holdup sec

kgmole

2

Mole fraction or Mass fraction

unit) (holdupsec

K-kgmole -n

− unit) (holdupsec

kgmole

−

Partial pressure

i∑








−

2

-n

m

N

unit) (holdup sec

K-kgmole

i∑








−

2m

N

unit) (holdup sec
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Mass concentration
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−

3

-n

m

kg
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−
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Where holdup unit is When this is specified in the distillation block that uses the reactions

kgmole Mole holdup or residence time

kg Mass holdup

m3 Volume holdup
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Fractional Conversion Reactions (for RadFrac only)
Another way to define reactions in a distillation column is to calculate a
conversion based on a built-in, temperature-dependent correlation.

To add conversion type reactions to your Reac-Dist Reaction ID:

1. Click New on the Reactions Stoichiometry sheet of your Reac-Dist Reaction
ID.

2. In the Select Reaction Type dialog box, Kinetic/Equilibrium/Conversion is the
default reaction type.  Accept the default Reaction No. displayed or enter a
new Reaction No. Click OK.

3. On the Edit Reaction dialog box, select Conversion from the Reaction Type
list.

4. Enter components and stoichiometric coefficients to define the reaction.
Coefficients should be negative for reactants and positive for products. You
should not specify exponents for conversion reactions.

5. Click Close when finished. You should see your new reaction number, type,
and equation displayed on the Stoichiometry sheet.

6. Repeat steps 1 through 5 for each additional conversion reaction.

7. Select the Conversion sheet.

8. If you have multiple conversion reactions within your Reaction ID, specify
whether you want the conversion reactions to be computed simultaneously, or
in series. By default, conversion reactions are assumed to occur
simultaneously. If you want the conversions to be calculated in series, check
the Reactions Occur in Series box. You must specify the same type for all
conversion reactions. Series reactions take place in the order they are entered.

9.  Select a reaction from the list.

10. In the Conversion Expression frame, select the component on which you will
base the conversion of the selected reaction, in the Key Component list.
Conversion is defined as the fractional conversion of the key component.

11. Enter the coefficients (A, B, C and D) for the fractional conversion correlation:
Conv = A +  B/T + C*ln(T) + D*T
You can also enter the conversion on the RadFrac Reactions Conversion
sheet, to override the value computed from the conversion correlation.
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Salt Precipitation Reactions (for RadFrac only)
In addition to liquid and vapor phase reactions, you also can specify salt
precipitation reactions. These reactions are liquid/solid phase equilibrium
reactions, where the solid phase consists of a single salt.

To add salt precipitation type reactions to your Reac-Dist Reaction ID:

1. Click New on the Reactions Stoichiometry sheet of your Reac-Dist Reaction
ID.

2. On the Select Reaction Type dialog box, select Salt Precipitation in the
Choose Reaction Type frame.

3. Select the component name of the salt in the Precipitating Salt list, and click
OK.

4. On the Edit Salt dialog box, enter components and stoichiometric coefficients
for the salt dissociation products.

5. Click Close when finished. You should see the new reaction displayed on the
Stoichiometry sheet referenced by the component name of the salt.

6. Repeat steps 1 through 5 for each additional salt precipitation reaction.

7. Select the Salt sheet.

8. On the Salt sheet, select a salt from the Salt list.

9. If the reaction does not actually reach equilibrium, you can specify the
Temperature Approach to Equilibrium. The temperature approach you enter
will be added to the stage temperature to compute the equilibrium constant.

10. Choose whether you want to compute the equilibrium constant (solubility
product) from Gibbs energies or from a built in polynomial expression by
selecting the appropriate radio button.
If you choose Compute Keq From Gibbs Energies, you do not need to enter
coefficients for the equilibrium constant. Aspen Plus will compute Keq from
the reference state Gibbs free energies of the components.

11. If you choose Compute Keq From Built-In Expression, you need to enter
coefficients for the built-in equilibrium constant expression, and choose a
concentration basis for the equilibrium constant in the Keq Basis field.

The expression and equilibrium constant definitions are the same as for fluid
phase equilibrium reactions. For more information, see Equilibrium Reactions,
this chapter.
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If no rate-controlled or fractional conversion fluid-phase reactions are present, it
is recommended that you specify salt precipitation reactions as electrolyte
chemistry reactions. The advantages are that Electrolyte Chemistry:
• Can be generated automatically by the Electrolytes Wizard
• Accesses the Aspen Plus electrolytes reaction database for equilibrium

constant data

See Specifying Electrolytes Chemistry, this chapter.

Using a User-Kinetics Subroutine

To use a user-supplied kinetics subroutine to calculate reaction rates, you need to
specify the Fortran subroutine name. Use the Reactions User forms to specify
user-defined kinetics for:
• Reactor models (RCSTR, RPlug, and RBatch)
• Distillation models (RadFrac and RateFrac)
• Pressure relief calculations in Pres-Relief

For RadFrac and RateFrac, you can also use the Reactions Reac-Dist forms to
specify user-defined kinetics (see Specifying Reactions for Reactive Distillation,
this chapter). You can define equilibrium reactions to be solved simultaneously
with rate-controlled reactions. Only RCSTR, RadFrac and RateFrac can handle
equilibrium reactions.

To specify a user Fortran subroutine for reaction rates:

1. From the Data menu, point to Reactions then Reactions.

2. On the Reactions Object Manager, click New to create a new Reaction ID.

3. In the Create New ID dialog box, enter a reaction name in the Enter ID field,
or accept the default ID.

4. Select User in the Select Type list, and click OK.

5. On the Reactions Stoichiometry sheet click New.

6. On the Edit Reaction dialog box, the default reaction type is Kinetic, and the
reaction number is entered automatically. Enter components and
stoichiometric coefficients to define the reaction. Coefficients should be
negative for reactants and positive for products.

7. Click Close when finished. You should see your new reaction displayed on the
Stoichiometry sheet.
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8. Repeat steps 7 through 9 for each additional user kinetic reaction.

9. Select the Kinetic sheet.

10. On the Kinetic sheet, select a reaction from the list and specify in which
phase the reaction will take place using the Reacting Phase list. The default
is the liquid phase.

11. If solids are present, click the Solids button and select the appropriate options
for calculation of concentration. See Reactions With Solids, this chapter for
details.

12. Select the Subroutine sheet.

13. On the Subroutine sheet, enter the name of the user subroutine, in the Name
field. For more information on using and writing user kinetics models, see
Aspen Plus User Models.
For any equilibrium reactions within a User type Reaction ID, specify them
as you would for equilibrium reactions within a Powerlaw Reaction ID. For
details, see Specifying Power Law Reactions for Reactors and Pressure Relief
Systems, this chapter.

❖     ❖     ❖     ❖ 
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28 Property Sets

This chapter describes:
• What is a property set?
• How to specify a new or existing property set
• How to specify user properties for use in property sets
• Examples

About Property Sets

A property set is a collection of thermodynamic, transport, and other properties
that you can use in:
• Stream reports
• Physical property tables and Analysis
• Unit operation model heating/cooling curve reports
• Distillation column stage property reports and performance specifications
• Reactor profiles
• Design specifications and constraints
• Calculator and sensitivity blocks
• Optimization and Data-Fit blocks

Aspen Plus has several built-in property sets that are sufficient for many
applications. The list of built-in property sets is determined by the Template you
choose when creating a new run. For more information on Templates, see
Chapter 2.

You can use a built-in property set and modify it to fit your needs, or you can
create your own property sets. To see the built-in sets available or select one, use
the drop-down list on any property set list box. The list prompts describe the
contents of each built-in property set.
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Defining a Property Set

To define a property set:

1. From the Data menu, click Properties.

2. Double-click on the Prop-Sets folder in the left pane of the Data Browser.

3. To create a new property set, click New. In the Create New ID dialog box,
enter a new property set ID or accept the default ID, and click OK.

4. Once the new property set has been created, to modify it (or any existing
property set), select the name from the Object Manager and click Edit.

5. On the Properties sheet of the Prop-Sets form, you can select properties from
the drop-down list in the Physical Properties field. Choose one or more
properties to be included in your property set. When you make a selection, a
prompt appears for each property.

Tip Use the Search button to find the properties you want included in
the property set. For information on using the search dialog box
see Using the Search Dialog Box, this chapter.

6. Select one or more units for the property, using the Units fields.

If you select multiple units the property is reported in each of the units
selected.

7. On the Prop-Sets Qualifiers sheet, specify the following qualifiers for the
properties to be calculated:
• Phase (total mixture, total liquid, vapor, 1st or 2nd liquid, and solid)
• Components
• 2nd liquid key components (key component to identify the 2nd liquid

phase)
• Temperature
• Pressure
• Percent distilled(points on petroleum distillation curves)
• Water basis (wet or dry)
Some qualifiers, such as temperature and pressure, are optional. For more
information, see Aspen Plus Physical Property Data, Chapter 4.

When you select multiple units and qualifiers, Aspen Plus computes the
properties for each units specification and each valid combination of qualifiers.
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Using the Search Dialog Box
If you want to search for a property by its common name, click the Search button
on the Prop-Sets Properties sheet. A dialog box appears where you can type the
name or a fragment of the name of the property you want. To add a property to
your property set, select the property you desire and click Add. Once you have
added all the properties you want, click OK to return to the Prop-Sets form.

Example of Using Search to Find Properties

Searching for the word “viscosity” shows a number of properties. Kinematic
viscosity has been selected and added to the property set.
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Specifying Phase Qualifiers
The default for phase is Total. If a property cannot accept Total phase as a
qualifier, you must enter an appropriate alternative (Liquid, Vapor, 1st liquid, 2nd

liquid, or Solid).

The phases you select should be consistent with the type of calculation desired.
For example, if you request 1st and 2nd liquid phase properties for a
heating/cooling curve for a Heater block, the block should perform either rigorous
three-phase or free-water calculations.

Specifying Temperature and Pressure Qualifiers
By default, Aspen Plus calculates properties at the stream conditions.
Alternatively, you can specify the temperature and pressure for property
calculations in the Temperature and Pressure fields of the Prop-Sets Qualifiers
sheet. These specifications do not affect the composition of vapor and liquid
phases, which are determined at the stream temperature and pressure.
Aspen Plus determines the units for the Temperature and Pressure specifications
from the Units-Set you specify.

Example of Property Set for Reporting Enthalpy

Define a property set consisting of the pure component liquid and vapor
enthalpies (H) of components C1, C2, and C3, as well as the mixture enthalpies
(HMX) for the vapor and liquid phases. HMX is calculated on both a mole and
mass basis.
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Example of Property Set for Activity Coefficients Over a Temperature
Range

Define a property set consisting of the activity coefficients for components C1 and
C2 in the liquid phase. The activity coefficients are evaluated at 100, 200, and
300°F.

The units for the temperatures entered will be the temperature units of the ENG
Units-Set, °F.
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User Defined Properties

You can define your own properties for use in property sets. You must supply a
Fortran subroutine to calculate each property. See Aspen Plus User Models for
more information about user subroutines.

To define an additional property for use in property sets:

1. From the Data menu, click Properties.

2. Open the Advanced folder by double-clicking on it in the left pane of the Data
Browser.

3. Select UserProperties.

4. On the UserProperties Object Manager, click New.

5. Enter a user property ID or accept the default ID, and click OK

6. On the Specifications sheet, select whether your user property will be a
standard property or an Assay curve property.

7. For standard properties, enter the name of the subroutine to be used for
calculating the property, in the User Subroutine Name field.

8. Use the remaining fields on the Specifications sheet to enter information
about the property.

9. On the Units sheet, specify whether you want any units conversion to be
performed automatically by Aspen Plus, or within your user subroutine.
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❖     ❖     ❖     ❖ 
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29 Analyzing Properties

After you complete property specifications, you should analyze the properties
predicted by your model to ensure correct results. You can do this using the
Aspen Plus Property Analysis feature. Property Analysis generates tables of
physical property values, which can be plotted to visualize and better understand
the behavior of properties as predicted by your property specifications.

You can access Property Analysis via the following methods:
• Many commonly used tables and plots can be generated quickly and easily

through an interactive method accessed from the Tools menu.
• Alternatively, generating Property Analyses from the Properties Analysis

folder in the Data Browser Menu provides the most flexibility.

You can also use Aspen Split™ (a separately-licensed product of the Aspen
Engineering Suite) to perform azeotrope searches and to construct ternary maps.

This chapter discusses each method of using the Property Analysis features and
includes several examples.

Topics include:
• About Property Analysis
• Generating Property Analyses Interactively
• Generating Property Analyses Using Forms
• Property Method Specifications for Property Analysis
• Examining Analysis Results
• Using Aspen Split
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About Property Analysis

The Property Analysis feature generates tables of properties from variations in:
• Temperature
• Pressure
• Vapor fraction
• Heat duty
• Composition

The tables include property values that are defined using Property Sets, and can
consist of thermodynamic, transport, and other derived properties. For more
information on Property Sets and the properties they can include, see chapters 7
and 28.

You can use Property Analysis:
• On a standalone basis
• In a Flowsheet run
• In a Data Regression run

To use Property Analysis on a standalone basis, specify Property Analysis in the
Run Type list on the Setup Specifications Global sheet. Or if you are creating a
new run, specify Property Analysis in the Run Type list of the New dialog box.

Generating Property Analyses
Interactively

This section describes how to generate many common analyses interactively,
using the Analysis commands from the Tools menu.

This method automates many of the steps required to generate a Property
Analysis, and defines built-in plots that provide quick and easy access to
commonly used information.

If the information you require can be generated from the interactive Analysis
commands, this is always quicker and easier than creating the Analysis using
forms.
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If you require property information that is not available from the interactive
Analysis commands, you should create the Analysis manually using forms. See
subsequent sections of this chapter for details on creating Analyses manually
using forms.

You can use the interactive Analysis commands at any time after you complete
the properties specifications.

The interactive Analysis commands can generate:
• Pure component properties
• Properties for binary systems
• Residue maps for ternary systems
• Stream properties. To generate stream properties, you must define at least

one material stream.

Pure Component Properties
Use the interactive Analysis Pure commands to calculate and display pure
component properties as a function of temperature to:
• Check pure component data and parameter values
• Compare properties for components that belong to the same family. Family

plots can reveal incorrect trends.
• Determine whether the property is extrapolated correctly when temperatures

are outside correlation limits
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To generate pure component properties as a function of temperature, using the
interactive Analysis Pure commands:

1. Ensure your Setup, Components, and Properties specifications are complete.

2. From the Tools menu, click Analysis, then Property, then Pure.
On the Pure Component Properties Analysis dialog box, most of the required
information is set to defaults, including:

Item Information

Property Method The global property method is used, as specified on the Properties
Specifications Global sheet. You can select any Property Method that appears
on the Properties Specifications form.

Temperature The default is a temperature range from 0 to 25°C. You can enter a new range
by modifying the lower and upper temperatures, or you can change from a
temperature range to a temperature list, and specify a list of discreet
temperature values.

Number of points to be tabulated The default is 41 points. You can change the number of points, or enter a
temperature increment

Pressure The default is 1 atm. You must change the default for vapor properties, for liquid properties
near the critical point., and properties generated from EOS property methods

3. From the Property list box, select the property to be tabulated.
The Property list box displays the properties of the type shown in the
Property Type list box.
To focus your search for a property, you can change the property type to
Thermodynamic or Transport. To see a list of all available properties, change
the property type to All.
This table shows the available thermodynamic properties:

Availability Free energy

Constant pressure heat capacity Enthalpy

Heat capacity ratio Fugacity coefficient

Constant volume heat capacity Fugacity coefficient pressure correction

Free energy departure Vapor pressure†

Free energy departure pressure correction Density

Enthalpy departure Entropy

Enthalpy departure pressure correction Volume

Enthalpy of vaporization† Sonic velocity

Entropy departure

†
Ideal and activity coefficient property methods only
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This table shows the available transport properties:

Thermal conductivity Surface tension

Viscosity

Optionally you can specify the units for the selected property in the Units list.
If you do not specify the units, they will be determined by the output results
Units-set specified on the Setup Specifications Global sheet.

4. Select the phase(s) for which you want the property to be reported, by clicking
one or more of the Phase check boxes: Vapor, Liquid or Solid. Liquid is the
default. Not all phases are valid for all properties. For a list of valid phases
for each property, see Aspen Plus Physical Property Data, chapter 4.

5. Choose components by selecting one or more from the Available Components
list, and clicking the right arrow button to move them to the Selected
Components list.

6. When finished, click Go to generate the results.

– or –

Click Save As Form to save the interactive Property Analysis you have
created to forms within the Properties Analysis section of the Data Browser
menu. Saving an interactive Property Analysis as forms, allows you to
preserve the input and results of this Property Analysis to view or modify at a
later time. For more information on using forms to create Property Analyses,
see Creating A Property Analysis, this chapter.
Aspen Plus calculates the property at the temperature values you specify.
Results appear in a form window and a plot. The plot displays results for all
components you select.

Example of Examining Component Vapor Pressures

Calculate and display the vapor pressures of CCL4, CH2CL2, and CHCL3, between
50 and 200°F, using the IDEAL Property Method. To do this:

1. From the Tools menu, point to Analysis, then Property, then Pure.

2. The Pure Component Properties Analysis dialog box appears.



Analyzing
Properties

29-6 Aspen Plus User Guide
Version 10.2

3. When you have finished choosing your components, click Go to generate the
results.

Tabular results form:
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Plotted Results:

Properties for Binary Systems
You can generate common phase diagrams for binary systems to:
• Check the validity of data and parameter values
• Assess the degree of nonideality
• Check for existence of azeotropes
• Check for existence of two liquid phases
• Check quality of extrapolation of the model

To generate properties for binary systems use the Analysis Binary commands. To
do this:

1. Ensure your Setup, Components, and Properties specifications are complete.

2. From the Tools menu, click Analysis, then Property, then Binary.
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3. On the Binary Analysis dialog box, choose the type of Analysis in the Analysis
Type list box:

Use analysis type To tabulate

Txy Temperature (T) versus liquid (x) and vapor (y) compositions at given pressures

Pxy Pressure (P) versus liquid (x) and vapor (y) compositions at given temperatures

Gibbs energy of mixing Gibbs energy of mixing versus liquid compositions at given temperatures and
pressures. Used to detect the formation of two liquid phases.

For all three types of Binary Analysis, you can accept the default settings or
specify the following information:

Item Information

Components Two are required. Use the Component 1 and Component 2
lists to choose the pair of components you wish to study. Only
conventional components that are not solids or ions are
allowed. Defaults are the first two conventional components
listed on the Components Specifications Selection sheet.

Composition basis - Mole fraction or mass fraction The default is mole fraction.

Composition component This designates which component’s composition is varied to
generate the results. The default is the component selected
as Component 1.

Composition - range or list To determine at what compositions Aspen Plus will perform
its calculations, you can specify a composition range or a
composition list. The default is the full composition range
between pure component 1 and pure component 2. You can
either modify the default composition range, or change to a
composition list, and specify a list of discreet compositions.

Number of points to generate The default is 41 points. You can modify the number of points,
or specify an increment of composition. Note that this only
applies when using a composition range.

Property Method, Henry Components, Chemistry ID, and
simulation approach

Defaults are obtained from the Properties Specifications
Global sheet. For electrolyte systems, you should use the
apparent components approach.

The remaining specifications for an interactive Binary Analysis depend on the
Analysis type. The following sections provide instructions for specifying each type of
Analysis.
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Completing the Specifications for Txy Binary Analysis

To complete the specifications for a Txy type Binary Analysis, you can either
modify the following specifications or accept the defaults.

For You can specify The default is

Valid Phases Rigorous Vapor-Liquid, Vapor-Liquid-
Liquid, or Vapor-Liquid-FreeWater
calculations

Vapor-Liquid

Pressure(s) You may specify a single pressure, or
multiple pressures by entering a list of
values, or by giving a range of values. If
you choose to specify a range of values,
you must enter number of points or an
increment size.

A single pressure of 1 atm

When finished, you can simply click the Go button to generate the Txy diagram,
or you can first click the Save As Form button to save the interactive Property
Analysis you have created, to forms within the Properties Analysis section of the
Data Browser menu.

Saving an interactive Property Analysis as forms allows you to preserve the
input and results of this Property Analysis to view or modify at a later time. For
more information on using forms to create Property Analyses, see Generating
Property Analyses Using Forms, later this chapter.

Aspen Plus displays the results in tabular form in a form window and as a plot. If
you specify more than one pressure, Txy diagrams for all the pressures appear on
a single plot. In addition to the Txy diagram, you can display other plots from the
Txy analysis results using the Plot Wizard. The following plots are available:

Type of Plot Description

TXY Temperature versus liquid and vapor composition

TX Temperature versus liquid composition

YX Vapor versus liquid composition

Gamma Liquid activity coefficients of both components versus liquid composition

KVL K-values of both components versus liquid composition
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Displaying Txy Plots

To display these plots:

1. On the Binary Analysis Results window containing the tabular data, click the
Plot Wizard button. The results window is behind the plot window.

2. On the Plot Wizard Step 1 window, click Next.

3. On the Plot Wizard Step 2 window, click the plot type you want.

4. To accept default plot settings, click Finish to generate the plot. Otherwise,
click Next to enter additional settings and follow the remaining steps.

5. On the Plot Wizard Step 3 window, in the Component to Plot list box choose a
component for which compositions will be displayed. If applicable, specify
units for the plot variables.

6. Click Finish to accept defaults for the remaining plot settings and generate
the plot.
– or –
Click Next to enter additional settings.

7. On the Plot Wizard Step 4 window, you can modify the defaults for plot title,
axis titles, display options, grid or line type. You can also specify whether you
want the plot to be automatically updated when new results are available.

8. Click Finish to generate the plot.

Example of Generating Txy Curves

Generate Txy curves at 1 atm and 2 atm for a mixture of HNO3 and water, using the
ELECNRTL property method and GLOBAL solution chemistry.
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Tabular results form:
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Plotted results:

Completing the Specifications for Pxy Binary Analysis

To complete the specifications for a Pxy type Binary Analysis, you can either
modify the following specifications or accept the defaults:

For You can specify The default is

Valid Phases Rigorous Vapor-Liquid, Vapor-Liquid-
Liquid, or Vapor-Liquid-FreeWater
calculations

Vapor-Liquid

Temperature(s) More than one temperature by entering a
list of values, or by giving a range of
values.

If you choose to specify a range of values,
you must enter number of points or an
increment size.

A single temperature of 25°C

When finished, click Go to generate the Pxy diagram, or click Save As Form to
save the interactive Property Analysis to forms within the Data Browser.

Saving an interactive Property Analysis as forms enables you to preserve the
input and results of this Property Analysis to view or modify at a later time.
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For more information on using forms to create Property Analyses, see Generating
Property Analyses Using Forms, this chapter.

Aspen Plus displays the results in tabular form in a form window and as a plot. If
you specify more than one temperature, Pxy diagrams for all the temperatures
appear on a single plot.

In addition to the Pxy diagram, you can display other plots from the Pxy analysis
results using the Plot Wizard. The following plots are available:

Type of Plot Description

PXY Pressure versus liquid and vapor composition

PX Pressure versus liquid composition

YX Vapor versus liquid composition

Gamma Liquid activity coefficients of both components versus liquid composition

KVL K-values of both components versus liquid composition

Displaying Pxy Plots

To display Pxy plots:

1. On the Binary Analysis Results window containing the tabular data, click the
Plot Wizard button. The results window is behind the plot window.

2. On the Plot Wizard Step 1 window, click Next.

3. On the Plot Wizard Step 2 window, click the plot type you want.

4. To accept default plot settings, click Finish to generate the plot. Otherwise,
click Next to enter additional settings.

5. On the Plot Wizard window, in the Component to Plot list box choose a
component for which compositions will be displayed. If applicable, specify
units for the resulting plot.

6. Click Finish to accept defaults for the remaining plot settings and generate
the plot.
– or –
Click Next to enter additional settings.
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7. On the Plot Wizard Step 4 window, you can modify the defaults for plot title,
axis titles, display options, grid type or marker size. You can also specify
whether you want the plot to be automatically updated when new results are
available.

8. Click Finish to generate the plot.

Completing the Specifications for Gibbs Energy of
Mixing

To complete the specifications for a Gibbs Energy of Mixing type Binary Analysis,
you can either modify the following specifications or accept the defaults.

Item Information

Units of Gibbs energy If you do not specify the units, they will be determined by the Units-set specified on the Setup
Specifications Global sheet.

Pressure The default is 1 atm

Temperature(s) The default is 25°C. You can specify more than one temperature, by entering a list of
temperatures, or you can specify a range of temperatures and a number of points or an
increment size.

When finished, click Go to generate the Gibbs energy of mixing versus x diagram,
or click Save As Form to save your interactive Property Analysis to forms within
the Data Browser.

Saving an interactive Property Analysis as forms enables you to preserve the
input and results of this Property Analysis to view or modify at a later time.

For more information on using forms to create Property Analyses, see Generating
Property Analyses Using Forms, this chapter.

Aspen Plus displays the results in tabular form in a form window and as a plot. If
you specify more than one temperature, Gibbs energy of mixing diagrams for all
the temperatures appear on a single plot.

Example of Generating Gibbs Energy of Mixing

Generate a Gibbs Energy of Mixing diagram for methanol-cyclohexane at 25°C,
using the UNIF-LL property method.
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Tabular results form:
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Plotted results:

Residue Curves
Residue Curves (or maps) plot the composition trajectories of a ternary mixture
undergoing distillation at total reflux. You can use them to visualize the presence
of azeotropes and the constraints azeotropes impose on the degree of separation.

Use Residue Curves to predict feasible splits, select entrainers, and analyze
potential column operability problems.

Use Residue Curves with nonideal chemical systems, and property methods that
represent such systems. Examples are activity-coefficient-based property
methods, such as NRTL, Wilson, UNIQUAC, and UNIFAC. Do not use electrolyte
property methods.
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Generating Residue Curves

To generate Residue Curves using the interactive Analysis Residue commands:

1. Make sure your Setup, Components, and Properties specifications are
complete.

2. From the Tools menu, point to Analysis, then Property, then Residue.

3. On the Residue Curves dialog box, Aspen Plus fills in defaults for all the
required information. You can accept the defaults, or make changes to any of
the following information:

Item Information

Components Three are required. Use the Component 1, Component 2, and
Component 3 lists to choose the three components you wish to study.
Only conventional components that are not solids or ions are allowed.
Defaults are the first three conventional components listed on the
Components Specifications Selection sheet.

Pressure The default is 1 atm

Valid Phases You can specify rigorous two phase (Vapor-Liquid) or three phase
(Vapor-Liquid-Liquid) calculations. The default is Vapor-Liquid.

Number of curves You can select 3-5 Curves, 10-15 Curves, or 15-20 Curves.

Property options Defaults are obtained from the Properties Specifications Global sheet.
For electrolyte systems, Aspen Plus uses the apparent components
approach.

4. When finished, click Go to generate the residue curves, or first click the Save
As Form button to save your interactive Property Analysis to forms within
the Data Browser.
Saving an interactive Property Analysis as forms enables you to preserve the
input and results of this Property Analysis to view or modify at a later time.
Aspen Plus displays the results in tabular form, in a form window and as a
triangular plot.

Example of Generating a Residue Map

Generate a residue map for the ternary system ethanol-water-ethyl acetate, at 1
atm, using the NRTL property method.



Analyzing
Properties

29-18 Aspen Plus User Guide
Version 10.2

Tabular results form:
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Plotted results:

Stream Properties
You can calculate and display stream properties interactively as you create your
simulation model. You do not have to complete the flowsheet definition or input
specifications first. For example, to check your Property Method, you can analyze
a feed stream as soon as you define it. As you develop a flowsheet model
interactively, you can check the phase behavior of intermediate streams to help
you determine feasible specifications.
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The following table shows the types of stream analyses you can perform:

Stream Analysis Types

Type Description

Point Stream properties for the total stream and each of the phases present. Properties include
temperature, pressure, phase fractions, flow rates, and many thermodynamic and transport
properties.

Component Flow Component flow rates for the total stream and each of the phases present. Mole, mass, and
standard liquid volume fractions are available.

Composition Component fractions for the total stream and each of the phases present. Mole, mass, and standard
liquid volume fractions are available. Partial pressure is also available.

Petroleum Point properties, plus API gravity, specific gravity, Watson K factor, and kinematic viscosity

Dist-Curve † Petroleum distillation curves (TBP, D86, D160, and vacuum)

Bubble/Dew†† Bubble point temperature and dew point temperature versus pressure curves

PV Curve†† Vapor fraction versus pressure curves at stream temperature

TV Curve †† Vapor fraction versus temperature curves at stream pressure

PT-Envelope†† Pressure-temperature envelope curves (For more information, see Pressure-Temperature
Envelopes on page 29-30.)

† Plots can be generated from this analysis.

†† These analyses automatically display plots of the curves.

Calculating and Displaying Stream Properties

To calculate and display stream properties interactively:

1. Ensure that Setup, Components, and Physical Properties specifications are
complete.

2. Ensure the Stream Specifications sheet for the stream is complete or the
stream has results that were calculated in the current session.

3. Click the stream on the flowsheet diagram to select it.

4. From the Tools menu, point to Analysis, then Stream, then the type of stream
analysis you want to perform. The Stream Analysis types will be inactive if
the conditions in steps 1,2 and 3 are not satisfied.

5. Make any selections and specifications in the dialog box for selecting options,
and click OK. Each stream analysis type has defaults for required input,
except temperature range for TV curves.
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Stream analysis results appear in a form window. For some analysis types, a plot
of the results also appears. Print or view these results and plots as you would
with simulation results.

With the exception of the PT-Envelope type stream analysis, when you close the
resulting forms and plots, the results are not saved. On the Ptenvelope dialog
box, you are given the option to Save as Form, which will save the stream
Property Analysis you have created interactively, to forms within the Properties
Analysis section of the Data Browser menu. In all other types of stream analysis,
you must redo the calculations if you want to look at them again, once you close
the results forms.

Saving an interactive Property Analysis as forms allows you to preserve the
input and results of this Property Analysis to view or modify at a later time. For
more information on using forms to create Property Analyses, see Generating
Property Analyses Using Forms, this chapter.

Example of Generating a Bubble/Dew Point Curve From Stream Analysis

The screens below show an example for generating a Bubble/Dew type stream
analysis for a stream containing an equimolar mixture of ethane and n-heptane.
The PENG-ROB property method is used.
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Tabular results form:

Plotted results:
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Generating Property Analyses Using
Forms

In addition to the many tables and plots available through interactive Property
Analysis, generating Property Analyses using forms provides the most flexibility
because it:
• Generates tables of physical property values using specifications you enter on

the Properties Analysis forms
• Allows you to report and study any property that you define in Property Sets

In general, you should only use manual Property Analysis when you need
functionality that is not available within the simpler interactive Analysis
commands.

The following Property Analyses types are available using forms:

Property Analysis Type For

Pure † Evaluation of pure component properties as a function of temperature and pressure

Binary † Generating common phase diagrams for binary systems, such as Txy, Pxy, or Gibbs energy of mixing
curves

Generic Property evaluations for multi-phase mixtures from flash calculations, or single-phase mixtures without
flash calculations

PT-Envelope Pressure-temperature envelopes and properties along a constant vapor fraction line

Residue Generating residue curve maps which plot the composition trajectories of a ternary mixture undergoing
distillation at total reflux

†
You cannot create these analysis types using forms. You must use the  interactive Analysis commands for these analysis
types because the appropriate property sets are defined automatically. You can modify these analysis types using forms, but
you should not modify the prop-sets created by the interactive Analysis because the Plot Wizard may not produce the correct
plots. .
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Unlike the interactive method for using Property Analysis, when generating
Analyses from forms, you must run the simulation to generate results. You can
run the Property Analyses:
• On a standalone basis (Property Analysis run type)
• In a Flowsheet run
• In a Data Regression run

To use Property Analysis on a standalone basis, specify Property Analysis in the
Run Type list on the Setup Specifications Global sheet (or the New dialog box
when creating a new run).

Creating A Property Analysis Using Forms
To manually create a Property Analysis using forms:

1. Make sure your Setup, Components, and Properties specifications are
complete.

2. From the Data menu, click Properties.

3. From the left pane of the Data Browser menu, click the Analysis folder.

4. On the Properties Analysis Object Manager, click New.

5. On the Create New ID dialog box, select the type of Analysis you want to
create in the Select Type list.

6. Enter an ID for the new Analysis, or accept the default ID.

7. Click OK.
The remaining specifications for using forms to generate a Property Analysis
depend on the Analysis type. The following sections provide instructions for
specifying each type of Analysis.
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Pure
You must use the interactive Analysis commands to define your analysis, save
the specifications as forms using the Save As Form button, then edit the form to
add additional specifications. Use forms to modify pure component Property
Analyses only when you need flexibility not afforded by the simpler interactive
Analysis commands (for example results at multiple pressures).

Binary
You must use the interactive Analysis commands to define your analysis, save
the specifications as forms using the Save As Form button, then edit the form to
add additional specifications.

Generic
Use the Property Analysis Generic form to generate tables of properties of either:
• Multi-phase mixtures (for example, vapor and liquid) resulting from flash

calculations
• Single-phase mixtures without flash calculations

The generic type of Property Analysis is the most flexible.

To generate a generic Property Analysis using forms:

1. On the System sheet of the Properties Analysis Generic Input form, click one
of the options in the Generate frame to specify whether you want to generate
properties at points along a flash curve for a multi-phase mixture resulting
from flash calculations, or at points for single-phase mixtures without flash
calculations.

Click either Points Along a Flash Curve or Point(s) Without Flash.

2. In the System section, choose either to Specify Component Flow or Reference
Flowsheet Stream. If you choose to specify component flow, enter the
flowrates of your system. If you choose to reference a flowsheet stream, enter
the Stream ID.

3. If you choose to specify component flow when generating points along a flash
curve, specify the valid phases for flash calculations in the Valid Phases list.
Choices are Vapor-Liquid, Vapor-Liquid-Liquid, or Vapor-Liquid-FreeWater.
The default is Vapor-Liquid.
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4. If you choose to reference a flowsheet stream when generating points along a
flash curve, you can optionally specify the type of flash for the flowsheet
stream, in the Flash Type list (see Notes in step 6.)

5. Click the Variable sheet.

6. On the Variable sheet, specify the Adjusted Variables and their values to be
used in calculations.
Notes:

If a stream is referenced on the System sheet, you must either:
• Vary two of temperature, pressure, vapor fraction, and duty

– or –
• Specify Flash Type on the System sheet
If Flash Type is specified, any varied state variable must be consistent with
that specification. Unspecified state variables default to the stream values.
The number of valid phases is determined by the type of calculation
performed to generate the referenced stream.
If a stream is not referenced, you must either vary or specify on this form two
of temperature, pressure, and vapor fraction.
You can define values for a varied variable by specifying either:
• A list of values

– or –
• Upper and lower limits for the variable and either the number of points or

the increment size.
 

7. Click the Tabulate sheet.

On the Tabulate sheet, specify the Property Set(s) that contain properties you
want to tabulate. To add a Property Set to the Selected Prop-Sets list, select it
from the Available Prop-Sets list, and click the right arrow button. To select
all available Property Sets, click the double right arrow button. Use the left
arrow buttons to remove items from the Selected Prop-Sets list. For more
information on creating Property Sets, see chapter 28.

Optionally you can click the Table Specifications button to enter a heading,
change the precision of the results, or specify the width of the tables
generated in the report file.

Further optional specifications include:
• Using the Properties sheet to change default property methods used to

generate the generic Property Analysis.
• Using the Diagnostics sheet to set how much information you receive

about warnings and errors from calculations.
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Results for the generic Analysis can be viewed on the Properties Analysis Generic
Results form. For more information on Analysis results see Examining Property
Analysis Results this chapter.

Example of Using Forms to Create a Generic Property Analysis to Study
Rigorous 3-Phase Flash Behavior

Generate a table of properties at four pressures, using rigorous isothermal
three-phase flash calculations. Tabulate vapor fraction, liquid-liquid ratio (beta),
component mass fractions, and component flows for each of the three phases
separately, and for the combined liquid phases.
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The following two screens shows the property set, LIST-4, that defines the
properties to be tabulated.
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Tabular results:

To generate a plot of these results, select the variable on the Results sheet, then
use Plot from the main menu bar to specify the x-axis or y-axis variable. Select
Display Plot to view the plot.

Pressure-Temperature Envelopes
Use the PT-Envelope Property Analysis type to generate pressure-temperature
envelopes. These tables are parametric, consisting of one curve for each vapor
fraction, through the critical point, and its complementary vapor fraction. For
example, the complementary branch for a vapor fraction of 0.75 is 0.25.

The interactive PT-Envelope Analysis command for streams also provides a
complete facility for generating PT-Envelopes. Use the Property Analysis forms
only if you want to tabulate properties in addition to temperature, pressure, and
vapor fraction, or if you do not want to reference a stream.

You can generate PT-Envelopes from any property method except electrolyte
property methods (for example, ELECNRTL). However, PT-Envelopes generated
from activity coefficient-based and other non-equation-of-state property methods
will not pass through the critical point. Instead there will be separate curves for
each vapor fraction and its complementary branch.
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To generate a PT-Envelope using forms:

1. On the System sheet of the Properties Analysis PTEnvelope Input form,
choose either to Specify Component Flow or Reference Flowsheet Stream. If
you choose to specify component flow, enter the flow rates of your system. If
you choose to reference a flowsheet stream, enter the Stream ID.

2. Click the Envelope sheet. By default this sheet is already complete.

3. On the Envelope sheet, specify the vapor fractions for which tables will be
generated. By default, Aspen Plus generates the dew and bubble point curves
(vapor fraction = 1 and 0, respectively.) You can specify additional vapor
fractions. Aspen Plus generates one curve for each vapor fraction, through the
critical point, and its complementary vapor fraction. For example, if you
specify a vapor fraction of 0.25, Aspen Plus will generate one curve for the
0.25 and 0.75 vapor fraction branches.

You can also specify these options:
• Temperature or pressure of the first point
• Maximum number of points
• Termination point

Further optional specifications include:
• Using the Tabulate sheet to specify properties to calculate in addition to the

default temperature and pressure tabulations. Specify any additional
properties by adding Property Set IDs to the Selected Prop-Sets list (see
Chapter 28). You can also click the Table Specifications button to enter a
heading, change the precision of the results, or specify the width of the tables
generated in the Report file.

• Using the Properties sheet to change default property methods used to
generate the PT envelope.

• Using the Diagnostics sheet to set how much information you receive about
warnings and errors from calculations.

Results for the PT-Envelope can be viewed on the Properties Analysis PT-
Envelope Results form. For more information on Analysis results see Examining
Property Analysis Results this chapter.

Example of Using Forms to Generate a Pressure-Temperature Envelope

Generate a PT-Envelope for an equimolar mixture of ethane and n-heptane using
the PENG-ROB property method. Generate the phase envelope for vapor
fractions of 1, 0.5, and 0. Tabulate the mole fractions of the vapor and liquid
phases, in addition to the default temperature and pressure.
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This is the property set, LIST-3, that defines the additional properties (mole
fraction) to be tabulated:
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Tabular Results:

To generate a plot of these results, choose Plot Wizard from the Plot menu of the
main menu bar, while viewing the above results form. This is the resulting
PT-Envelope plot, generated by accepting all the default settings of the Plot
Wizard:
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Residue Curves
Residue Curves (or maps) plot the composition trajectories of a ternary mixture
undergoing distillation at total reflux. You can use them to visualize the presence
of azeotropes and the constraints azeotropes impose on the degree of separation.
Use Residue Curves to predict feasible splits, select entrainers, and analyze
potential column operability problems (Doherty, 1978 and Wahnschaft, 1992).

Use Residue Curves with nonideal chemical systems, and Property Methods that
represent such systems. Examples are activity-coefficient-based Property
Methods, such as NRTL, Wilson, UNIQUAC, and UNIFAC.

To generate a Residue Curve using forms:

➤ On the System sheet of the Properties Analysis Residue Input form, specify:
• Components for the ternary mixture you want to analyze, using the

Component 1, Component 2, and Component 3 list boxes.
• System pressure using the Pressure field. The default is 1 atm.
• Whether you want Aspen Plus to perform rigorous two-phase or three-

phase calculations. Choose either Vapor-Liquid or Vapor-Liquid-Liquid in
the Valid Phases list. The default is Vapor-Liquid.
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• Number of curves to be generated. Choose either 3-5 Curves, 10-15
Curves, or 15-20 Curves. Note that more curves require more calculation
time. The default is 10-15 curves.

Optional specifications include:
• Using the Properties sheet to change default property methods used to

generate the Residue Curve.
• Using the Diagnostics sheet to set how much information you receive about

warnings and errors from calculations.

Results for the Residue Curve can be viewed on the Properties Analysis Residue
Results form. For more information on Analysis results see Examining Property
Analysis Results this chapter.

Property Methods Specifications for
Property Analysis

Property Analyses use default property methods. Aspen Plus determines these
defaults based on whether a flowsheet stream is referenced on the Property
Analysis System form.

Flowsheet stream referenced? Default property methods are

NO Specified on the Properties Specifications Global sheet.

YES The same as those used to calculate stream properties in the flowsheet simulation

You can override the default property specifications on the Properties Analysis
Properties sheet.
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Examining Property Analysis Results

To examine Property Analysis results:

1. From the Data menu, select Properties.

2. From the left pane of the Data Browser menu, double-click the Analysis
folder.

3. Double-click the folder for the Property Analysis you wish to examine.

4. Click the Results folder.

You can plot the results using the Plot Wizard from the Plot menu of the main
menu bar. For details on using the Plot Wizard, see chapter 13.

Using Aspen Split

If Aspen Split™ (a separately-licensed product in the Aspen Engineering Suite) is
installed, you may call it directly from Aspen Plus to perform azeotrope searches
and to construct ternary maps.

Aspen Split is AspenTech’s state-of-the-art software for the synthesis and
conceptual design of distillation processes. A new analysis component in Aspen
Split enables the user to:
• Locate all the azeotropes (homogeneous and heterogeneous) present in any

multicomponent mixture
• Automatically compute distillation boundaries and residue curve maps for

ternary mixtures
• Compute multiple liquid phase envelopes (liquid-liquid and vapor-liquid-

liquid) for ternary mixtures

The Aspen Split component has been fully integrated with Aspen Plus so that
these powerful analyses can be performed directly in the flowsheeting
environment. The results can then be used to:
• Access separation feasibility in azeotropic mixtures
• Synthesize feasible separation sequences for achieving a desired separation
• Develop strategies for retrofit of existing separation sequences
• Identify potential operating problems for distillation columns and strategies

for correcting them
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To perform these Aspen Split analyses, in the Aspen Plus click the Tools menu,
then point to Aspen Split, then select either Azeotrope Search or Ternary Maps.

If you select Azeotrope Search, the Azeotrope Analysis dialog box appears. The
Input sheet is open, and the components and property specifications from the
simulation are automatically loaded into Aspen Split. Select the checkboxes
beside the components you want Aspen Split to consider in its azeotrope search.
You may also change the property specifications. Then click the Azeotropes
output sheet in the pane on the left. Aspen Split will display a list of the
azeotropes found.

If you select Ternary Maps, the Ternary Maps dialog box appears. As in the
azeotrope search, the Input sheet is initially filled in with data from the
simulation. Select the components you want to map, and select the options at the
bottom of the sheet for the clalculations you want to perform, and click the
Ternary Plot sheet in the pane at the left to see the resulting plot.

See the Aspen Split documentation for more information about the capabilities of
these features.
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30 Estimating Property
Parameters

Aspen Plus stores physical property parameters in databanks for a large number
of components. If a required parameter is not in any Aspen Plus databank, it can
be:
• Entered directly (see Chapter 8)
• Estimated using Property Estimation
• Regressed from experimental data using Data Regression (see Chapter 31)

About Property Estimation

You can use Property Estimation in the following two ways:
• On a standalone basis
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• In a Flowsheet, Property Analysis, PROPERTIES PLUS, or Data Regression
run

This chapter includes the following information about estimating parameters
using Property Estimation:
• Property parameters Aspen Plus can estimate
• Defining molecular structure
• Estimating parameters
• Using experimental data to improve estimated parameters
• Comparing estimated parameters for components
• Examining parameter estimation results

Property Estimation on a Standalone Basis
Property Estimation estimates all missing parameters listed in the tables on
pages 30-3—30-6. To create a standalone estimation run, do one of the following:
• Select the Property Estimation Run Type when creating a new run.
• From the Data menu select Setup, then select the Specifications form. On the

Global sheet, select Property Estimation in the Run Type list box.

Property Estimation in a Flowsheet, Property Analysis,
PROPERTIES PLUS, or Data Regression Run

Property Estimation estimates all missing parameters from the tables on pages 30-
3—30-6 that are required in the run.

When using Property Estimation in Flowsheet, Property Analysis, Data
Regression, or Properties Plus run types, it is important understand which
parameters will be used if a parameter is available from multiple sources.

If you select Estimate All Missing Parameters on the Estimation Input form,
Aspen Plus will estimate and use all missing parameters that are required in the
run. Parameters that are estimated, but are not missing, will not be used in the
run.

If you selectively specify the estimation of an individual parameter that is
required by the simulation, this estimated parameter will be used regardless of
whether another value is available in a databank, or on a Properties Parameters
input form.
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What Property Parameters Can Aspen
Plus Estimate?

Property Estimation in Aspen Plus can estimate many of the property
parameters required by physical property models, including:
• Pure component thermodynamic and transport property model parameters
• Binary parameters for the Wilson, NRTL, and UNIQUAC activity coefficient

models

The following tables list the property parameters Aspen Plus can estimate.

Property Names and Estimation Methods for Pure Component
Constants

Description Parameter Method Information Required†

Molecular weight MW FORMULA Structure

Normal boiling point TB JOBACK
OGATA-TSUCHIDA
GANI
MANI

Structure
Structure
Structure
TC, PC, Vapor pressure data

Critical temperature TC JOBACK
LYDERSEN
FEDORS
AMBROSE
SIMPLE
GANI
MANI

Structure, TB
Structure, TB
Structure
Structure, TB
MW, TB
Structure
TC, PC, Vapor pressure data

Critical pressure PC JOBACK
LYDERSEN
AMBROSE
GANI

Structure
Structure, MW
Structure, MW
Structure

Critical volume VC JOBACK
LYDERSEN
AMBROSE
RIEDEL
FEDORS
GANI

Structure
Structure
Structure
TB, TC, PC
Structure
Structure

Critical compressibility factor ZC DEFINITION TC, PC, VC

Standard heat of formation DHFORM BENSON
JOBACK
BENSONR8
GANI

Structure
Structure
Structure
Structure
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Property Names and Estimation Methods for Pure Component
Constants (continued)

Standard Gibbs free energy of
formation

DGFORM JOBACK
BENSON
GANI

Structure
Structure
Structure

Acentric factor OMEGA DEFINITION
LEE-KESLER

TC, PC, PL
TB, TC, PC

Solubility parameter DELTA DEFINITION TB, TC, PC, DHVL, VL

UNIQUAC R UNIQUAC R BONDI Structure

UNIQUAC Q UNIQUAC Q BONDI Structure

Parachor PARC PARACHOR Structure

Solid enthalpy of formation at 25 C DHSFRM MOSTAFA Structure

Solid Gibbs energy of formation at
25 C

DGSFRM MOSTAFA Structure

Aqueous infinite dilution Gibbs
energy of formation for the
Helgeson model

DGAQHG AQU-DATA
THERMO
AQU-EST1
AQU-EST2

DGAQFM
DGAQFM, S025C
DGAQFM
S025C

Aqueous infinite dilution enthalpy of
formation for the Helgeson model

DHAQHG AQU-DATA
THERMO
AQU-EST1
AQU-EST2

DGAQFM
DGAQFM, S025C
DGAQFM
S025C

Entropy at 25 C for the Helgeson
model

S25HG AQU-DATA
THERMO
AQU-EST1
AQU-EST2

S025C
DGAQFM, DHAQFM
DGAQFM
DHAQFM

Helgeson OMEGA heat capacity
coefficient

OMEGHG HELGESON S25HG, CHARGE

† Structure indicates that molecular structure must be defined using the Properties Molecular Structure forms. Data
indicates that correlation parameters are determined directly from experimental data you enter on Properties Data forms.
When another parameter is required, such as TB, it can come from a databank or from another estimation method. Or you
can enter it on a Properties Parameters form.
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Property Names and Estimation Methods for Temperature-
Dependent Properties

Description Parameter Method Information Required†

Ideal gas heat capacity CPIG DATA
BENSON
JOBACK
BENSONR8

Ideal gas heat capacity data
Structure
Structure
Structure

Vapor pressure PL DATA
RIEDEL
LI-MA
MANI

Vapor pressure data
TB, TC, PC
Structure, TB
TC, PC, Vapor pressure data

Enthalpy of vaporization DHVL DATA
DEFINITION
VETERE
GANI
DUCROS
LI-MA

Heat of vaporization data
TC, PC, PL
MW, TB
Structure
Structure
Structure, TB

Liquid molar volume VL DATA
GUNN-YAMADA
LEBAS

Liquid molar volume data
TC, PC, OMEGA
Structure

Liquid viscosity MUL DATA
ORRICK-ERBAR
LETSOU-STIEL

Liquid viscosity data
Structure, MW, VL, TC, PC
MW, TC, PC, OMEGA

Vapor viscosity MUV DATA
REICHENBERG

Vapor viscosity data
Structure, MW, TC, PC

Liquid thermal conductivity KL DATA
SATO-RIEDEL

Liquid thermal conductivity data
MW, TB, TC

Vapor thermal conductivity KV DATA Vapor thermal conductivity data

Surface tension SIGMA DATA
BROCK-BIRD
MCLEOD-SUGDEN

Surface tension data
TB, TC, PC
TB, TC, PC, VL, PARC

Solid heat capacity CPS DATA
MOSTAFA

Solid heat capacity data
Structure

Helgeson C heat capacity coefficient CHGPAR HG-AQU
HG-CRIS

HG-EST

OMEGHG, CPAQ0
OMEGHG, S25HG, CHARGE, IONTYP

OMEGHG, S25HG

Liquid heat capacity CPL DATA
RUZICKA

Liquid heat capacity data
Structure

† Structure indicates that molecular structure must be defined using the Properties Molecular Structure forms. Data
indicates that correlation parameters are determined directly from experimental data you enter on Properties Data forms.
When another parameter is required, such as TB, it can come from a databank or from another estimation method. Or you
can enter it on a Properties Parameters form.
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In Flowsheet, Property Analysis, Properties PLUS, or Data Regression runs,
Aspen Plus estimates missing binary parameters only if you request them on the
Properties Estimation Input Binary sheet. If infinite dilution activity coefficients
are estimated or supplied on the Properties Data Mixture form at only one
temperature, then the parameters in brackets [ ] are set to zero.

Property Names and Estimation Methods for Binary Parameters

Description Parameter Method Information Required†

Wilson parameters WILSON/2
[WILSON/1]

DATA
UNIFAC
UNIF-LL
UNIF- LBY
UNIF- DMD
UNIF-R4

Data
Structure
Structure
Structure
Structure
Structure

NRTL parameters NRTL/2
[NRTL/1]

DATA
UNIFAC
UNIF-LL
UNIF- LBY
UNIF- DMD
UNIF-R4

Data
Structure
Structure
Structure
Structure
Structure

UNIQUAC parameters UNIQ/2
[UNIQ/1]

DATA
UNIFAC
UNIF-LL
UNIF- LBY
UNIF- DMD
UNIF-R4

Data
Structure, GMUQR, GMUQQ
Structure, GMUQR, GMUQQ
Structure, GMUQR, GMUQQ
Structure, GMUQR, GMUQQ
Structure, GMUQR, GMUQQ

† Structure indicates that molecular structure must be defined using the Properties Molecular Structure forms. Data
indicates that correlation parameters are determined directly from experimental data you enter on Properties Data forms.
When another parameter is required, such as TB, it can come from a databank or from another estimation method. Or you
can enter it on a Properties Parameters form.

Property Names and Estimation Methods for UNIFAC Group
Parameters

Description Parameter Method Information Required†

UNIFAC R UNIFACR BONDI Structure

UNIFAC Q UNIFACQ BONDI Structure

Lyngby UNIFAC R UNIFLR BONDI Structure

Lyngby UNIFAC Q UNIFLQ BONDI Structure

Dortmund UNIFAC R UNIFDR BONDI Structure

Dortmund UNIFAC Q UNIFDQ BONDI Structure

† Structure indicates that molecular structure must be defined using the Properties Molecular Structure forms. Data
indicates that correlation parameters are determined directly from experimental data you enter on Properties Data forms.
When another parameter is required, such as TB, it can come from a databank or from another estimation method. Or you
can enter it on a Properties Parameters form.
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Required Information for Parameter
Estimation

The minimum information required for parameter estimation is:
• Normal boiling point temperature (TB)
• Molecular weight (MW)
• Molecular structure, preferably entered using the General method

Property Estimation uses normal boiling point and molecular weight to estimate
many parameters. You can greatly reduce the propagation of errors in estimating
other parameters by using the experimental value of TB. If you do not supply TB
and MW but you enter the general molecular structure, Property Estimation can
estimate TB and MW.

To obtain the best possible estimates for all parameters, enter all the
experimental data that is available.

Defining Molecular Structure Using the
General Method

When you use the general method to describe the atoms and bonds in a
compound, Aspen Plus automatically generates the required functional groups
for the estimation methods used in a particular run.

To use the general method:

1. Sketch the structure of the molecule on paper.

2. Assign a number to each atom, omitting hydrogen. The numbers must be
consecutive, starting from 1.

3. From the Data menu, click Properties.
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4. In the left pane of the Data Browser, click Molecular Structure.

5. From the Molecular Structure Object Manager, select a component ID for
which you want to specify the molecular structure, then click Edit.

On the General sheet, define the molecule by its connectivity, one pair of
atoms at a time.

In this field Enter

Number Unique number identifying an atom in the molecule. This should be the atom number that you
assigned in your preliminary drawing.

Type Atom type (for example, carbon or oxygen)

Bond type Type of bond that connects a pair of atoms (for example, single or double)

Atom numbers and atom types appear on the correspondence list at the
bottom of the form.

Atoms Numbers and Types
When you enter an existing atom number, Aspen Plus displays the atom type
(except for the first pair of atoms). You can omit specifying values in the Number
and Type fields for the first atom of a pair. Aspen Plus will automatically use the
atom number and type of the second atom for the previously entered pair. Enter
a number for the second atom of the current pair.

You can use the following bond types to simplify the task of entering the
structure of common ring compounds and saturated hydrocarbons:

Special Bond Type Description

Benzene ring Benzene ring

Sat. 5-member ring Saturated 5-member ring

Sat. 6-member ring Saturated 6-member ring

Sat. 7-member ring Saturated 7-member ring

Sat. hydrocarbon chain Saturated hydrocarbon chain

When you use these special bond types, the atom numbers assigned to the
members of the carbon ring or carbon chain must be consecutive.
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Example of Defining Molecular Structure Using the General Method

Define the molecular structure of isobutyl alcohol (C4H10O) using the general
method.

CH3

CH     CH2         OH

CH3

Assign a number to each atom, omitting hydrogen.

Defining Molecular Structure Using
Method-Specific Functional Groups

Use the Properties Molecular Structure Functional Group sheet to enter
method-specific functional groups. For each group-contribution method, specify:
• Functional groups
• Number of times each group occurs in the compound
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Functional groups are defined and numbered differently for each method. For
functional group definitions, see Aspen Plus Physical Property Data, or browse
through the Group Number list.

You can enter any number of pairs for group numbers and number of
occurrences, with one exception. For the UNIFAC, UNIF-LL, UNIF-DMD, and
UNIF-LBY methods the limit is 12.

To specify method specific functional groups:

1. Sketch the structure of the molecule on paper.

2. From the Data menu, click Properties.

3. In the left pane of the Data Browser, click Molecular Structure.

4. From the Molecular Structure Object Manager, select a component ID for
which you want to specify the molecular structure, then click Edit.

5. Click the Functional Group sheet.

6. On the Functional Group sheet, select the estimation method from the
Method list box.

7. In the Group Number list, select a functional group for the method, that
represents a functional group contained in your molecule. The prompt area
displays a description of the functional group.

8. Count the number of times this group occurs in the molecule and enter that
number in the Number of Occurrences field. The default is one.

9. Repeat steps 7 and 8 until all functional groups in your molecule are
represented with the appropriate number of occurrences.

Example of Defining Molecular Structure Using Method-Specific
Functional Groups

The structure of isobutyl alcohol is defined using the Lydersen method. The
Lydersen functional groups are -CH3, >CH2, >CH-, and -OH. The corresponding
group numbers are 100, 101, 102, and 121, respectively.

CH3

CH     CH2         OH

CH3
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Identifying Parameters to be Estimated

In a standalone Property Estimation run, Aspen Plus estimates all missing
parameters listed in the tables on pages 30-3–30-6, using default methods. You
can use the Properties Estimation Input form to request parameter estimation and
to:
• Specify the properties and components for which parameters are to be

estimated
• Select estimation methods
• Request estimation for parameters that are not missing

In a Flowsheet, Data Regression, or Property Analysis run, you must request
estimation of missing parameters. Aspen Plus estimates all missing required
parameters using default methods, unless you specify otherwise on the Input
form..

To request parameter estimation:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser Menu, select Estimation then Input.
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3. On the Setup sheet, specify one of the following Estimation options.

Option Estimates

Do not estimate any parameters Nothing. This is the default.

Estimate all missing parameters All missing required parameters and any parameters you
request on the Pure Component, T-Dependent, Binary, and
UNIFAC Group sheets

Estimate only the selected parameters Only the types of parameters you specify on the Setup sheet.
Specific estimations must be specified on the sheets identified
by your parameter types selection on this sheet.

The Estimate All Missing Parameters option is strongly recommended unless
you:
• Know exactly what parameters are missing and want to estimate only

those parameters
• Want to evaluate the estimation methods only for certain parameters

4. If you selected Estimate Only the Selected Parameters, specify the type(s) of
parameters to estimate by checking the appropriate checkboxes. Go to the
appropriate sheet to specify the desired parameters and methods.
You must supply all information required to estimate the parameters.

5. If you selected Estimate All Missing Parameters, you can override default
estimation methods. Go to the appropriate sheet to specify parameters and
methods for the different types of parameters.
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Use these sheets to select parameters and methods:

Form What is Specified

Pure Component Parameter names and estimation methods for pure component constants

T-Dependent Parameter names and estimation methods for temperature-dependent parameters

Binary Parameter names and estimation methods for binary parameters

UNIFAC Group Parameter names for UNIFAC group parameters

See subsequent sections of this chapter for more information on these sheets.

When using Property Estimation in Flowsheet, Property Analysis, Data
Regression, or Properties Plus run types, if you manually request the estimation
of specific parameters using the sheets in the table above, these estimated values
are used preferentially over any values available in a databank or on a Properties
Parameters form.

You can specify more than one estimation method for a parameter. This allows
you to compare the estimates predicted by different methods.

When you specify multiple estimation methods for a parameter required in a
Flowsheet, Property Analysis, Data Regression, or Properties Plus run type, the
simulation uses the value estimated by the first estimation method selected.

The tables on pages 30-3—30-6 list the estimation methods Aspen Plus provides
for each parameter. For details on the accuracy and applicability of each
estimation method, see Aspen Plus Physical Property Methods and Models,
Chapter 8.

Estimating Pure Component Parameters
Use the Estimation Input Pure Component sheet to request estimation of pure
component constants, such as critical temperature (TC).

To request estimation of a pure component constant:

1. From the Data menu, click Properties

2. In the left pane of the Data Browser Menu, select Estimation, then Input.

3. On the Setup sheet, choose estimation options. For more information, see

4. Identifying Parameters to be Estimated on page 30-11.

5. Click the Pure Component sheet.
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6. On the Pure Component sheet, select a parameter you want to estimate using
the Parameter list box.

7. In the Component list box, select the component for which you want to
estimate the selected parameter. If you want to estimate the chosen
parameter for multiple components, you may continue to select additional
components individually, or you may select All to estimate the parameter for
all components.

8. In the Method list box for each selected component, choose the estimation
method you want to use. You can specify more than one method.

9. To request estimation of additional pure component parameters, select a
different parameter in the Parameter list box, and repeat steps 6 and 7.

If you specify more than one method, only the value estimated by the first
method is used. Results for all the methods specified are displayed on the
Estimation Results form. See Examining Parameter Estimation Results on page
30-23.

The only reason for specifying more than one method is to evaluate the accuracy
of methods used in estimating a given parameter. See Comparing Estimated
Parameters to Experimental Data on page 30-22.

Example for Estimating Critical Temperature

This estimation problem is set up to evaluate the accuracy of three methods
(Joback, Lydersen, and Ambrose) for estimating TC for isobutyl alcohol:
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Estimating Temperature-Dependent Properties
Use the Estimation Input T-Dependent sheet to request estimation of correlation
parameters for temperature-dependent properties (such as parameters for the
extended-Antoine vapor pressure). Property Estimation uses estimation methods
based on group contributions and corresponding-states theory. In addition,
Property Estimation accepts experimental property versus temperature data and
uses them to determine the correlation parameters by regression.

To request estimates of temperature-dependent properties:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, click the Estimation subfolder.

3. On the Setup sheet, choose estimation options. For more information, see

4. Identifying Parameters to be Estimated on page 30-11.

5. Click the T-Dependent sheet.

6. On the T-Dependent sheet, specify the property you want to estimate in the
Property list box.

7. In the Component list box, select the component for which you want to
estimate the selected property. If you want to estimate the chosen property
for multiple components, you may continue to select additional components
individually, or you may select All to estimate the property for all
components.

8. In the Method list box for each selected component, choose the estimation
method you want to use. You can specify more than one method for each
property. To do this, list the component again, and choose a different method.

9. To request estimation of additional temperature dependent properties, select
a different property in the Property list box, and repeat steps 6 and 7.
If you specify more than one method for a component, only the estimated
value of the first method is used. Results for all the methods specified are
displayed on the Results form.  See Examining Parameter Estimation Results
on page 30-23.
The only reason for specifying more than one method is to evaluate the
accuracy of methods used in estimating a given property. See Comparing
Estimated Parameters to Experimental Data on page 30-22.

10. If you want to restrict estimation to a temperature range, enter the lower
temperature limit in the Lower Temp. field, and enter the upper temperature
limit in the Upper Temp. field.
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11. If you have experimental property versus temperature data, enter them on
the Properties Data Pure-Comp form.

When you select Then Aspen Plus

DATA in the Method field Uses the experimental data you enter on the Properties Data
Pure-Comp form to determine the correlation parameters by
regression

DATA in the Method field, and Upper Temp. and Lower Temp. Uses only the experimental data within the temperature
ranges you specify

A method other than DATA Uses the specified method to estimate the property over a
range of temperatures (Upper Temp. and Lower Temp.).
Aspen Plus determines the correlation parameters that best fit
the estimated data

A method other than DATA and you check the Use Data
check box

Combines the experimental data you enter on the Properties
Data Pure-Comp form with the estimated values using the
method you specified to determine the best correlation
parameters

If you combine the experimental data and estimated values (by selecting the
Use Data check box), you can assign a weight to the experimental data in the
Weight field. The weight is relative to 1.0 for estimated values.

Estimating Binary Parameters
Use the Estimation Binary Input sheet to request estimates of binary
parameters, such as WILSON/1 and WILSON/2 for the Wilson model. Aspen Plus
estimates binary parameters using infinite-dilution activity coefficient data.

To request estimates of binary parameters:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser Menu, click Estimation then Input..

3. On the Setup sheet, choose estimation options. For more information, see

4. Identifying Parameters to be Estimated on page 30-11.

5. Click the Binary sheet.

6. On the Binary sheet, click New then specify the parameter you want to
estimate in the Parameter list box.

7. In the Method list box, choose the estimation method you want to use. You
can specify more than one method for each parameter.

When Method is Then Aspen Plus uses

DATA The infinite dilution activity coefficient data you enter on the Properties Data Mixture form.



Chapter  30

Aspen Plus User Guide 30-17
Version 10.2

For more information see Using Infinite Dilution Activity Coefficient Data on page 30-21.

A method other than DATA The method to estimate infinite dilution activity coefficients

8. In the Component i and Component j list boxes, specify two components for
which you want to estimate interaction parameters. If you want to estimate
the chosen parameter for multiple component pairs, you may continue to
select additional component pairs individually, or you may select All to
estimate the parameters for all component pairs.

9. In the Temp field, you can specify the temperature(s) of the infinite-dilution
activity coefficient data. The default temperature is 25 C. If you select DATA
in the Method field, the default is all the data you entered on the Properties
Data Mixture form.

When you Aspen Plus estimates

Enter no temperature value, or enter only one temperature
value

Only the second element of the parameter (for example,
WILSON/2 for Wilson)

Enter more than one temperature value Elements one and two of the parameter (for example,
WILSON/1, WILSON/2)

10. To request estimation of additional binary parameters, select a different
parameter in the Parameter list box, and repeat steps 6, 7 and 8.

Example for Estimating Binary Parameters

Estimate Wilson binary parameters from infinite-dilution activity coefficients
generated by UNIFAC. Estimate the infinite-dilution activity coefficients at 30
and 40°C for component pair C1-C2; and at 30°C for component pair C2-C3. For
C1-C2, the WILSON/1 and WILSON/2 binary parameters are estimated because
two temperatures are requested. For C2-C3, only the WILSON/2 parameter is
estimated because only one temperature is requested.
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Estimating UNIFAC Group Parameters
Use the Properties Estimation UNIFAC Group sheet to request parameter
estimation for UNIFAC functional groups. Group parameters for all UNIFAC
groups are built into Aspen Plus. You do not need to estimate them.

If you define a new UNIFAC group on the Components UNIFAC-Groups form:

Use this sheet To

Properties Molecular Structure Functional Group Define the structure of the UNIFAC group using the Bondi method

Properties Estimation Input UNIFAC Group Estimate group parameters

To request parameter estimation for UNIFAC functional groups:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser Menu, select Estimation then Input.

3. On the Setup sheet, choose estimation options. For more information, see

4. Identifying Parameters to be Estimated on page 30-11.

5. Click the UNIFAC Group sheet.
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6. In the Parameter list box, specify the UNIFAC group parameter you want to
estimate.

7. In the Group ID fields, enter the UNIFAC Group IDs for which you want to
estimate parameters.
UNIFAC group IDs must have been defined on the Components UNIFAC-
Groups form.

Using Experimental Data to Improve Estimated
Parameters

You can use any experimental property data available to improve the quality of
your parameter estimation. Whenever possible, supply experimental data to
minimize the propagation of errors due to the uncertainty of estimated values.

Temperature-dependent property data (such as vapor pressure versus
temperature data) can be used directly to determine correlation parameters by
regression. Infinite-dilution activity coefficient data are used to estimate binary
parameters.

Use this form To enter this type of property data

Properties Parameters Pure Component Scalar Scalar property constants, such as normal boiling point (TB) or
critical temperature (TC) (See Chapter 8)

Properties Parameters Pure Component T-Dependent Temperature-dependent correlation parameters, such as
PLXANT for the extended Antoine vapor pressure model  (See
Chapter 8)

Properties Data PURE-COMP Temperature-dependent property data, such as vapor pressure
versus temperature points (See Chapter 31))

Properties Data MIXTURE Infinite dilution activity coefficient data versus temperature for
binary systems  (See Chapter 31)

Using Temperature-Dependent Property Data

Use the Properties Data PURE-COMP form to enter temperature-dependent
property data.

Enter the data as pairs of temperature and property values.

To enter temperature-dependent property data: listed in the table on page 30-5:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, click the Data subfolder.
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3. To create a new Data ID, on the Data Object Manager, click New.

4. In the Create New ID dialog box, enter an ID for the data, or accept the
default ID. Choose PURE-COMP from the Select Type list box, and click OK.

5. To modify an existing Data ID, select the ID from the Data Object Manager,
and click Edit.

6. On the Setup sheet, select the category For Estimation, then specify the
property for which you have data, in the Property list box.

7. Select the component for which you have data, in the Component list box.

8. If your data was measured at a constant temperature or pressure, you can
enter this value in the Constant Temperature or Pressure frame.

9. Click the Data sheet.

10. On the Data sheet, enter the experimental data in the appropriate columns.
The first column in the data table, Usage, will be filled in automatically when
you begin entering your data points.
The first row of the data table is filled in with default values of standard
deviation. These standard deviations are not considered in Property
Estimation however. They are only used in Data Regression. (See Chapter 31)

To combine the experimental pure component data to estimate temperature-
dependent property parameters:

1. Select the Properties Estimation Input T-Dependent sheet.

2. Select the property you wish to estimate in the Property list box.

3. Specify the component then select DATA in the Method list box.

You can combine experimental temperature-dependent property data with
estimated data. For example, you can combine experimental vapor pressure data
with values estimated by the Riedel method. The combined data are then used to
determine the best set of PLXANT parameters. You can use this feature to
extrapolate limited experimental data. For more information, see Estimating
Temperature-Dependent Properties on page 30-15.

The experimental data you enter can be used in three ways:
• By Data Regression, to obtain correlation parameters by regression.
• By Property Estimation, to obtain correlation parameters by regression.
• By Property Estimation, together with other estimated values, to obtain

correlation parameters.
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Using Property Estimation is similar to using Data Regression to regress pure
component temperature-dependent property data or infinite-dilution activity
coefficient data. However, with Data Regression you can:
• Mix VLE and pure component data
• Regress any parameter, such as an equation-of-state parameter
• Control which parameters in a correlation to regress
• Provide standard deviations (weightings) for individual variables and data

points

For detailed information about data regression, see Chapter 31.

Using Infinite Dilution Activity Coefficient Data

Use the Properties Data MIXTURE form to enter infinite-dilution activity
coefficient (gamma infinity) data for binary systems.

To enter infinite-dilution activity coefficient data:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser Menu, select the Data subfolder.

3. To create a new Data ID, on the Data Object Manager, click New. On the
Create New ID dialog box, enter an ID for the data, or accept the default ID.
Choose MIXTURE from the Select Type list box, and click OK.

4. To modify an existing Data ID, select the ID from the Data Object Manager,
and click Edit.

5. On the Setup sheet, select the category For Estimation in the category list
box, then GAMINF in the Data Type list box.

6. Select the components for which you have data from the Available
Components list, and use the right arrow button to move the two components
of interest to the Selected Components list.

7. Click the Data sheet.

8. On the Data sheet, enter the experimental data in the appropriate fields as
described in the table below. The first column in the data table, Usage, will be
filled in automatically when you begin entering your data points.
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The first row of the data table is filled in with default values of standard
deviation. These standard deviations are not considered in Property
Estimation however. They are only used in Data Regression. (See Chapter 31)

Field Enter

TEMP1 Temperature corresponding to the infinite-dilution activity coefficient of component 1 (GAMINF1)

GAMINF1 Infinite-dilution activity coefficient of component 1

TEMP2 Temperature corresponding to the infinite-dilution activity coefficient of component 2 (GAMINF2)

GAMINF2 Infinite-dilution activity coefficient of component 2

If one infinite-dilution activity coefficient value is missing, leave both the
TEMP and GAMINF fields blank.

To use the experimental infinite-dilution activity coefficient data to estimate
binary parameters:

1. Select the Properties Estimation Input Binary sheet.

2. Select the parameter you want to estimate in the Parameter list box.

3. Select DATA in the Methods list box.

4. In the Component i and Component j fields, specify the two components for
which you have entered infinite-dilution activity coefficient data.

Comparing Estimated Parameters to Experimental
Data

Use the Properties Estimation Compare form to compare estimated parameters
to experimental data. You can also compare the estimated values of components
to results for other components. This feature can help you select the best method
for estimating parameters for a nondatabank component when only limited
experimental data is available.

To evaluate the accuracy of estimation methods used for a parameter and to
select the best methods for estimating parameters for a nondatabank component:

1. Identify databank components that are similar to the nondatabank
component in terms of molecular structure or functional groups.

2. Request parameter estimation for these databank components using all
methods available on the Estimation Input form.

3. Use the Estimation Compare form to compare the estimated parameters to
the experimental data.
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From the comparison you can determine the best method for each parameter.
The best methods for the databank components should also be best for the
nondatabank component.

To compare estimated parameters to experimental data:

1. From the Data menu, click Properties

2. In the left pane of the Data Browser Menu, double-click the Estimation
subfolder.

3. Select the Compare form.

4. On the Compare Setup sheet, use the Components and UNIFAC Group IDs
list boxes to enter components or groups to be compared with experimental
data.

Examining Parameter Estimation Results
To examine parameter estimation results:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser Menu, double-click the Estimation
subfolder.

3. Select the Results or the Compare Results form.

The Estimation Results form displays the estimated properties and parameters
that you requested on the Estimation Input form. Estimated parameters are also
placed on appropriate Properties Parameters forms. The Compare Results form
displays comparisons between estimated and experimental data , as requested on
the Estimation Compare form. Comparisons between components are not
displayed on the Compare Results form, they are contained in the reports.

To view comparisons between components:

From the View menu, click Reports.

Example of Pure Component Estimation Results

This example shows the estimated values of  TC for isobutyl alcohol using three
methods (Joback, Lydersen, and Ambrose).
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Using Estimated Parameters

If you estimate parameters, you can choose whether the results are automatically
written to Properties Parameters input forms or not.

If you estimate parameters in a standalone Property Estimation run, and then
want to use them in a Flowsheet, Property Analysis, Data Regression, or
Properties Plus run:

➤ On the Setup Specifications Global sheet, change the Run Type.

When using Property Estimation in Flowsheet, Property Analysis, Data
Regression, or Properties Plus runs, if you select Estimate All Missing
Parameters, Aspen Plus estimates and uses all missing parameters that are
required in the run. Aspen Plus does not estimate any parameters that are not
missing.

If you specifically request the estimation of an individual parameter, this
estimated parameter will be used preferentially over any databank value, or any
value entered on Properties Parameters forms.
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Saving Estimation Results Automatically
If you estimate parameters, by default the results are automatically written to
Properties Parameters input forms.

This means that when you are satisfied with your estimation results, you can
turn off Property Estimation because the estimated parameters have been
preserved on the Parameters forms for use in subsequent simulation runs.

To turn off Property Estimation:

➤ On the Setup sheet of the Properties Estimation Input form, check Do Not
Estimate Any Parameters.

Not Saving Estimation Results Automatically
If you do not want the estimation results to be written to the Parameters forms
automatically:

1. From the Tools menu, click Options.

2. Click the Component Data tab.

3. Clear the Copy Regression and Estimation Results onto Parameters Forms
checkbox.
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31 Regressing Property
Data

You can use experimental property data to determine the physical property
model parameters you need for an Aspen Plus simulation.

The Aspen Plus Data Regression System fits parameters of physical property
models to measured data for pure component or multicomponent systems. You
can enter almost any kind of experimental property data, such as:
• Vapor-liquid equilibrium
• Liquid-liquid equilibrium
• Density
• Heat capacity
• Activity coefficients

You can use Data Regression for all property models in Aspen Plus, including
electrolyte and user models.

This chapter includes the following information about Data Regression:
• Setting up a regression
• Entering pure component, phase equilibrium, and mixture data
• Plotting experimental data
• Formulating a regression case
• Evaluating the accuracy of known model parameters
• Examining and plotting regression results
• Comparing results from several cases
• Using the Dortmund Databank (DDB) interface
• Data regression example
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Setting Up a Regression

To set up a Data Regression:

1. Start Aspen Plus and create a new run from a Template as described in
Chapter 2.

2. On the New dialog box, select Data Regression in the Run Type list box.
– or –
From the Data menu, click Setup. Then choose Data Regression in the Run
Type list box on the Setup Specifications Global sheet.

3. Define components on the Components Specifications Selection sheet. See
Chapter 6.

4. Select a property method on the Properties Specifications Global sheet. See
Chapter 7.

5. Enter or estimate any supplemental property parameters on the Properties
Parameters and Properties Estimation forms. See Chapters 9 and 30.

6. Enter experimental data on the Properties Data forms, described later in this
/hapter.

7. Specify the regression case on the Properties Regression form. See
Formulating a Regression Case on page 31-12.
Use Next to guide you through these steps.

Selecting a Property Method

You must select a property method that uses the property model for which you
want to determine parameters.

For example, to fit UNIQUAC binary parameters, choose one of the following
property methods:
• UNIQUAC
• UNIQ-HOC
• UNIQ-NTH
• UNIQ-RK



Chapter  31

Aspen Plus User Guide 31-3
Version 10.2

Choose the same property method you will use for simulation runs using the
fitted parameters. For example, if you want to use UNIQUAC with the Hayden-
O'Connell vapor phase association property method (UNIQ-HOC) in a simulation
run, you must also use the UNIQ-HOC property method in your Data Regression
run.

There is one important exception. Do not use property methods ending in -2 in
Data Regression, even when fitting LLE data. For example, to determine
parameters to use with the UNIQ-2 property method, use the UNIQUAC
property method in the Data Regression run. In the simulation run, use the
UNIQ-2 property method. The binary parameters you determined in the Data
Regression run will be available on the Properties Parameters Binary Interaction
form.

Entering Supplemental Parameters

If any component being regressed is not in the Aspen Plus databank, do one of
the following:
• Enter the required parameters on Properties Parameters forms
• Estimate the parameters using the Properties Estimation forms

For example, suppose you are regressing binary VLE data using the WILSON
property method and a component is not in the databank. You must enter or
estimate the following parameters:  MW, TC, PC, ZC, DHVLWT, PLXANT, and
CPIG.

You can also enter values of the parameters to be determined on a Properties
Parameters form. Data Regression will use these values as initial guesses.

Fitting Pure Component Data

To fit pure component temperature-dependent property data, such as vapor
pressure data:

1. Use the Properties Data PURE-COMP form to enter the experimental data as
a function of temperature.

2. Use the Properties Regression Input form to specify the property method,
experimental data, and parameters to be regressed.
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Entering Pure Component Data

Use the Properties Data PURE-COMP form to enter experimental data for pure
component properties as a function of temperature. For example, you can enter
vapor pressure versus temperature data.

To enter pure component data:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, click the Data folder.

3. To create a new Data ID, click New on the Data Object Manager.

4. In the Create New ID dialog box, enter an ID or accept the default. Choose
PURE-COMP in the Select Type list box, and click OK.

5. To edit an existing ID, select the Data ID from the Object Manger, and click
Edit.

6. On the Setup sheet, select the type of property data in the Property list box.
Prompts describe each property. You can limit the types of property data
under the Property list box, by selecting a property category in the Category
list box. The default category is All.

7. In the Component list box, specify the component for which you have
experimental data.

8. In the Temperature and Pressure fields, if active, specify a constant
temperature or pressure. A value entered in these fields applies to all data
points, and simplifies the entering of isothermal or isobaric data.

9. Click the Data sheet.

10. On the Data sheet, enter the experimental data in the appropriate columns.

11. Enter standard deviation values for the property data or accept the system
defaults. See Entering Standard Deviations of Measurements, this chapter.

If you want Aspen Plus to ignore some data or standard deviations that have
already been entered, go to the Usage field, click on the row, and select Ignore.
Aspen Plus will not use the data point in any subsequent regressions.
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Fitting Phase Equilibrium and Mixture
Data

To fit phase equilibrium and mixture data, such as vapor-liquid equilibrium and
mixture density data:

1. Use the Properties Data MIXTURE form to enter experimental data. See the
following section.

2. Use the Properties Regression Input form to specify the property method,
experimental data, and the binary or pair parameters to be regressed. See
Formulating a Regression Case, this chapter.

Entering Phase Equilibrium and Mixture
Data

Use the Properties Data MIXTURE form to enter experimental data for phase
equilibrium and mixture properties as a function of temperature, pressure, and
composition. For example, you can enter Txy vapor-liquid equilibrium data for
two components.

To enter phase equilibrium and mixture data:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, click the Data folder.

3. To create a new Data ID, click New on the Data Object Manager. In the
Create New ID dialog box, enter and ID or accept the default. Choose
MIXTURE in the Select Type list box, and click OK.

4. To edit an existing ID, select the Data ID from the Object Manger, and click
Edit.

5. On the Setup sheet, choose the type of property data in the Data Type list
box, from the choices in Tables 31.1 and 31.2. You can limit the types of
property data under the Property list box, by selecting a property category in
the Category list box. The default category is All.
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6. Select the components from the Available Components list, and use the right
arrow button to move them to the Selected Components list.

7. In the Temperature and Pressure fields, if active, specify a constant
temperature or pressure. A value entered in these fields applies to all data
points.

8. In the Composition Basis list box, specify the basis of the composition data.
You can enter composition data as mole fraction, mass fraction, mole percent,
or mass percent. Mole fraction is the default.

9. Click the Data sheet.

10. On the Data sheet, enter the experimental data in the appropriate columns.

11. Enter standard deviations for the property data or accept the system defaults.
See Entering Standard Deviations of Measurements, this chapter.

If you want Aspen Plus to ignore some data or standard deviations that have
already been entered, go to the Usage field, click on the row, and select Ignore.
Aspen Plus will not use the data point in any subsequent regressions.

Data Types

Vapor-Liquid Equilibrium Data
Select For this data

TXY Isobaric VLE

PXY Isothermal VLE

TPXY T-P-x-y VLE

ALPHA Relative volatility. Defined with respect to the first component listed on the form.

Liquid-Liquid Equilibrium Data†

Select For this data

TXX T-x-x

PXX P-x-x

TPXX T-P-x-x

TPXXY† T-P-x-x-y

† Vapor-liquid-liquid equilibrium data

†† Use with NRTL or UNIQUAC-based property methods; the ELECNRTL property method; or SR-POLAR, PRWS,
PRMHV2, RKSWS, RKSMHV2, and PSRK equation-of-state property methods.
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Mixture Property Data
Select For this data

CPLMX Liquid heat capacity

CPVMX Vapor heat capacity

CPSMX Solid heat capacity

GLXS Excess liquid Gibbs free energy

HLMX Liquid enthalpy

HLXS Excess liquid enthalpy

HVMX Vapor enthalpy

HSMX Solid enthalpy

KLMX Liquid thermal conductivity

KVMX Vapor thermal conductivity

KSMX Solid thermal conductivity

MULMX Liquid viscosity

MUVMX Vapor viscosity

RHOLMX Liquid mass density

RHOVMX Vapor mass density

RHOSMX Solid mass density

SIGLMX Liquid surface tension

USER-X User property versus x

USER-Y User property versus y

VLMX Liquid molar volume

VVMX Vapor molar volume

VSMX Solid molar volume
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Partial Property Data (Data for Components in a Mixture)
Select For this data

DLMX Liquid diffusion coefficients

DVMX Vapor diffusion coefficients

GAMMA Liquid activity coefficients

GAMMAS Solid activity coefficients

HENRY Henry's constants

KLL Liquid-liquid distribution coefficients

KVL Vapor-liquid K-values

USERI-X User partial property versus x

USERI-Y User partial property versus y

Data Types for Electrolyte Systems

Select For this type of data To

GAMMAM Mean ionic activity coefficient† Determine parameters for the electrolyte activity coefficient model

HLMX Liquid molar enthalpy Determine the temperature dependency of binary or pair
parameters for the activity coefficient model††

OSMOT Osmotic coefficient Determine parameters for the electrolyte activity coefficient model

PH pH Determine chemical equilibrium constants (use only the apparent
component approach)

TPX Salt solubility††† Regress parameters for the electrolyte activity coefficient model
and chemical equilibrium constants for precipitating salts. Obtain
electrolyte-electrolyte pair parameters for the electrolyte NRTL
model

TX Salt solubility†††

TXY, PXY, or TPXY Vapor liquid equilibrium Regress electrolyte activity coefficient model parameters, Henry's
constants, and chemical equilibrium constants

TXX, TPXX, or TPXXY Liquid liquid equilibrium Regress electrolyte activity coefficient model parameters and
chemical equilibrium constants

VLMX Liquid molar volume Determine parameters for the Clarke density model

†
You can enter only the molality scale mean ionic activity coefficient data of single electrolyte systems.

††
Use data at several temperatures to ensure accurate representation of heat of mixing.

†††
Enter at saturation, for single or mixed electrolyte solutions. You must specify the salt precipitation reactions on the
Reactions Chemistry form.



Chapter  31

Aspen Plus User Guide 31-9
Version 10.2

Generating Binary VLE and LLE Data

You can generate VLE and LLE data for a two-component system, using a
specified property method. Aspen Plus can then use the generated data to regress
parameters for another property method. With this feature you can convert
parameters between different property models.

For example, you can generate VLE data using the UNIFAC predictive property
method, then use the generated data to determine the binary parameters for the
WILSON property method.

To generate binary VLE and LLE data:

1. From the Data menu, click  Properties.

2. In the left pane of the Data Browser, click the Data folder.

3. To create a new Data ID, click New on the Data Object Manager.

4. In the Create New ID dialog box, enter an ID or accept the default. Choose
MIXTURE in the Select Type list box, and click OK.

5. To edit an existing ID, select the Data ID from the Object Manger, and click
Edit.

6. On the Setup sheet, choose the type of property data in the Data Type list
box:

Select To generate this data

TXY, PXY, or TPXY VLE

TXX or TPXX LLE

Do not select the GEN-TPXY or GEN_TPXX data type

7. Select the components from the Available Components list and click the right
arrow button to move them to the Selected Components list.

8. In the Temperature and Pressure fields, if active, specify a constant
temperature or pressure at which the data will be generated.

9. Click the Data sheet.

10. On the Data sheet, click the Generate Data button.



Regressing
Property Data

31-10 Aspen Plus User Guide
Version 10.2

11. In the Generate Binary VLE or LLE Data dialog box, select a property
method, and a Henry’s Components ID and Chemistry ID, if applicable.

12. Click the Generate button to generate the data.
The Data sheet displays the liquid phase compositions for which data are to
be generated for the regression.

Entering Standard Deviations of
Measurements

The standard deviation of a measurement variable is an estimate of the
magnitude of random error. Data Regression assigns reasonable default values
for standard deviations, based on the property or data type you select. If you
know the standard deviations of your data, enter them on the Properties Data
Data sheet.

Data Regression assigns the following default standard deviation values:

For Value

Temperature 0.1 degrees†

Pressure 0.1%

Liquid compositions 0.1%

Vapor compositions 1.0%

Properties 1.0%

†
For Txx or TPxx data, the default is 0.01

You can assign a set of standard deviation values to:
• A single data point
• Several data points
• All data points in a data group

To enter a standard deviation row on a Properties Data Data sheet, go to the
Usage field, and select Std-Dev. The values you enter will apply to all subsequent
data points until another Std-Dev row is encountered. Enter the standard
deviation in percent or as an absolute value. Data Regression does not require
precise values of standard deviations. Usually you only need to determine the
appropriate order of magnitude and ratios.
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A variable that has a standard deviation value of zero is treated as error-free.
Only state variables with little or no random error can have standard deviations
of zero. Properties such as vapor pressure or density cannot. You cannot enter all
standard deviation values as zero.

For phase equilibrium data, such as TPXY data, the number of non-zero
standard deviations must be greater than or equal to the number of phase
equilibrium constraints (or equivalently, the number of components in the
mixture that participate in phase equilibrium). For example, for TPXY data of
two components, you can assign a standard deviation of zero to only two
variables. Either T or P, and either X(1) or Y(1) can have zero standard
deviations. An exception is TPX data. You can set the standard deviation of X
and either T or P to zero.

Unrealistically small standard deviations for "noisy" measurement variables
cause convergence problems.

Plotting Experimental Data

You can display a plot of the experimental data you entered using the Plot
Wizard from the plot menu.

Depending on the type of data you entered, the Plot Wizard allows the following
types:

Plot Typet Description

T-xy T-xy plot for isobaric VLE data

P-xy P-xy plot for isothermal VLE data

T-x T-x plot for isobaric VLE data

P-x P-x plot for isothermal VLE data

y-x y-x plot for VLE data

T-xx T-xx plot for LLE data

P-xx P-xx plot for LLE data

Prop-x Property vs. Composition

Prop-T Property vs. Temperature

Triangular Triangular diagram for ternary LLE data
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Formulating a Regression Case

Use the Properties Regression forms to formulate a regression case.

A regression case requires:
• Experimental data
• Parameters for regression

To formulate a regression case:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, click the Regression folder.

3. To create a new Regression ID, click New on the Regression Object Manager.
In the Create New ID dialog box, enter an ID or accept the default, and click
OK.

4. To edit an existing ID, select the Regression ID from the Object Manger, and
click Edit.

5. In the Property Options frame of the Regression Input Setup sheet, specify
property method, Henry Components ID, Chemistry ID, and electrolyte
calculation method. The global properties specifications you entered on the
Properties Specifications Global sheet are the default. You can select any
property method already entered on the Properties Specifications form.

6. At the bottom of the Setup sheet, use the Data Set list boxes to enter the Data
set IDs for the experimental data to be regressed. To assign more weight to
data sets, enter a value greater than 1 in the Weight field.

7. For each Binary VLE Data set referenced, you can choose whether you want a
thermodynamic consistency test performed, using the Perform Test check box.
If you choose to perform a consistency test, you can use the Test Method list
box to choose the type of consistency test. Also select whether you want to
reject data sets that fail the consistency test, using the Reject check box. For
more information see Thermodynamic Consistency Test for VLE Data, this chapter.

8. Click the Parameters sheet.

9. Enter the Parameters to be regressed, according to the procedure in the
following section, Specifying Parameters to be Regressed.
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In many cases Aspen Plus will automatically complete the Regression Input form
based on the property method and Data sets you have specified. For example,
suppose you select the NRTL property method and enter Txy data for a binary
system. Aspen Plus completes the Regression Input form by:
• Filling in the Data ID field
• Specifying that the NRTL binary parameters are to be regressed

Specifying Parameters to be Regressed
In cases where the parameters to be regressed are not specified automatically, or
when you want to modify the default parameters or add additional parameters,
you can use the Regression Input Parameters sheet.

To specify parameters to be regressed:

1. In the Type field of the Regression Input Parameters sheet, select one:

Option For

Parameter Pure component parameter

Binary parameter Binary parameter

Group parameter UNIFAC group parameter

Group binary parameter UNIFAC group binary parameter

Pair parameter Electrolyte NRTL model pair parameter

Chemistry Equilibrium constants for electrolyte chemistry

2. In the Name/Element list box, select the parameter names. The prompt
identifies parameters.

3. Enter the element number of the parameter in the field just to the right of the
parameter name. For group interaction parameters for the Lyngby-modified
UNIFAC and the Dortmund-modified UNIFAC models, only the first element
can be regressed.

4. Enter the component(s) or UNIFAC group IDs in the Component/Group list
boxes.
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5. For each parameter, use the Usage list box to:

Specify If you want the parameter to be

Regress† Used in the current regression case

Exclude Excluded from the current regression case.†† The value in the Initial Value field is ignored.

Fix Set to the fixed value given in the Initial Value field†††

† Default

†† If the parameter is in the databank or has been entered on the Properties Parameters forms, Aspen Plus uses this
value in the property calculation during the regression.

††† You can fix a parameter to a given value in one case, then set it to another value in another case to study the effect on
the fit. For example, you can fix the third element of the NRTL binary parameter (the nonrandomness factor) in a case
study to see which value gives the best results.

6. You can enter Initial Value, Lower Bound, Upper Bound, and Scale Factor for
the parameter.

Thermodynamic Consistency Test for
VLE Data

Aspen Plus tests the binary VLE data you enter on the Data Mixture form for
thermodynamic consistency when you supply both of the following:
• Composition data for both the liquid and vapor phases
• At least five data points, not counting pure component data points (x=0.0 and

x=1.0)

Aspen Plus provides two methods for testing consistency:
• The area test of Redlich-Kister
• The point test of Van Ness and Fredenslund

Both methods use the Gibbs-Duhem equation. For detailed information on both
tests, see J. Gmehling and U. Onken, Vapor-Liquid Equilibrium Data Collection,
DECHEMA Chemistry Data Series, Vol. I, Part 1, ed. Dieter Behrens and Reiner
Eckermann (Frankfurt/Main: DECHEMA, Deutsche Gesellschaft fur Chemisches
Apparatewesen, 1977).

By default, Aspen Plus performs the area test. To select another test method or
to change the test tolerance, use the Regression Input Setup sheet. On the Setup
sheet you can also specify whether you want to use or reject the data sets that
fail the consistency tests.
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The Consistency Tests sheet on the Regression Results form indicates whether
your data passes or fails the consistency test. Failed data can cause accuracy and
convergence problems in your simulation. The test can fail because:
• The data contains errors, either in the original data or occurring during data

entry
• The vapor phase equation-of-state model does not appropriately account for

the vapor phase nonideality
• You do not have enough data points or the data cover only a small

concentration range. To obtain meaningful consistency test results, enter data
for the entire valid composition range.

If your data fail the test, check the data values and units in the Txy, Pxy, or TPxy
data you entered on the Data Mixture form.

To obtain meaningful consistency test results, enter data for the entire valid
composition range. You can ignore the test results if your data covers only a
narrow composition range.

Evaluating the Accuracy of Known Model
Parameters

You can use Data Regression to evaluate the accuracy of known model
parameters. Compare the calculated results obtained using the model with your
experimental data.

1. Select a property method on the Properties Specifications Global sheet. See
Chapter 7.

2. Enter the experimental data on the Properties Data forms. See Entering Pure
Component Data, and Entering Phase Equilibrium and Mixture Data, this
chapter.

3. Enter the known model parameters on the Properties Parameters forms. See
Chapter 8. To evaluate parameters stored in the databanks, skip this step.

4. Specify the property method and experimental data to be used in the
evaluation on the Regression Input Setup sheet. See Formulating a
Regression Case, this chapter.

5. In the Calculation Type frame on the Regression Input Setup sheet, select
Evaluation.
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Running the Regression

To run the regression, select Run from the Run menu or the Control Panel. If you
have more than one regression case, the Data Regression Run Selection dialog
box appears. All cases are listed in the Run area. The Don't Run area is empty.
You can:
• Run all the cases by clicking on OK.
• Change the order in which the cases are executed. Select a case and use the

Up and Down arrows.
• Exclude certain Regression cases from the run. Select a case, then use the left

arrow to move the case into the Don't Run area.

The order in which the regression cases are run may be significant. The
regressed parameter values from a regression case are used automatically in all
subsequent regression cases. Aspen Plus will execute the regression cases in the
order they appear in the Run area.

Using Regression Results

This section discusses examining, plotting and comparing regression results.

Examining Regression Results
To examine regression results:

1. From the Data menu, click Properties.

2. In the left pane of the Data Browser, double-click the Regression folder.

3. From the Data Browser menu tree, double-click the Regression ID of interest,
and select Results.
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The Regression Results form appears, containing these sheets:

Sheet Shows

Parameters Final parameter estimates, final parameter standard deviations, number of iterations
and the property method used

Consistency Tests Thermodynamic consistency test results

Residual Residual for each property: the experimental value; regressed value; standard
deviation; difference between the experimental and regressed values; the percent
difference. A summary of the deviation, including average and maximum deviations can
be obtaining by clicking the Deviations button

Profiles All experimental and calculated values. These data are used on all pre-defined plots.
(see Plotting Regression Results this chapter)

Correlation Parameter correlation matrix: intercorrelation between the parameters

Sum of Squares Objective function, regression algorithm, initialization method, final weighted sum of
squares and residual root mean square error

Evaluation Property method, final weighted sum of squares and residual root mean square error
for the evaluation of experimental data. This result sheet is only active for Evaluation
cases.

Extra Property Residuals for extra properties when VLE data is used, as requested on the Regression
Input Report sheet (for example, activity coefficients and K-values)

Problems with Data Regression Results

If your Data Regression run fails to converge, the Properties Data forms probably
contain data entry errors. Check the data values and units. Plot the data to check
for errors or outliers using the Plot Wizard from the Plot menu.

Inappropriate standards deviations may have been used for the data. See
Entering Standard Deviations of Measurements on page 10, for guidelines.

If you use binary VLE data, the data may not be thermodynamically consistent.
Request consistency test on the Setup sheet. Rerun the regression. Examine the
test results on the Regression Results Consistency Tests sheet.

When fitting different models to the same data set, choose the model that gives
the smallest residual root mean square error value.

On the Regression Results Correlation sheet, the off-diagonal elements of the
matrix indicate the degree of correlation between any two parameters. When the
parameters are completely independent, the correlation coefficient is zero. A
number close to 1.0 or -1.0 indicates a high degree of correlation. If possible,
select parameters that are not correlated. An important exception: asymmetric
binary parameters for activity coefficient models are highly correlated. Both the
ij and ji parameters are required for best fits.
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How to Identify Unsatisfactory Data Regression Results

It is possible for your Data Regression run to converge without errors, but with
results unsuitable for use in a simulation run. Use these Regression Results
sheets to identify bad fits:
• Parameters
• Sum of Squares
• Consistency Tests

These signs indicate a bad fit:
• A standard deviation for a regressed parameter is 0.0, indicating the

parameter is at a bound.
• A large residual root mean square error value. Normally, this value should be

less than 10 for VLE data and less than 100 for LLE data.
• Your VLE data fail the thermodynamic consistency test.

If any of these conditions exist, check the original data source and the data and
units on the Properties Data forms for errors. Plot the data using the Plot Wizard
from the Plot menu. Use the Regression Results Residual sheet to see how well
each data point was fitted. Look for out-liers.

Plotting Regression Results
When viewing the Regression Results form, you can use the Plot Wizard to
generate useful plots of the regression results. Aspen Plus provides a number of
predefined plots.



Chapter  31

Aspen Plus User Guide 31-19
Version 10.2

To start the Plot Wizard, choose Plot Wizard from the Plot menu on the main
menu bar while viewing the Regression Results form. Depending on your type of
regression, some of the plots below will be available:

Name of Plot Description

T-xy Temperature versus liquid and vapor composition for isobaric VLE data

P-xy Pressure versus liquid and vapor composition for isobaric VLE data

T-x Temperature versus liquid composition for isobaric VLE data

P-x Pressure versus liquid composition for isobaric VLE data

y-x Vapor versus liquid composition

T-xx Temperature versus liquid 1 and liquid 2 composition for LLE data

P-xx Pressure versus liquid 1 and liquid 2 composition for LLE data

Prop-x Property versus liquid composition

Prop-T Property versus temperature

(y-x) vs. x Vapor minus liquid composition versus liquid composition

Triangular Triangular diagram for ternary LLE data

Exp vs. Est Experimental versus calculated

Residual Residual versus property

The residual versus property plot shows how the errors are distributed. If the
measurement data contain no systematic errors, the deviations should distribute
randomly around the zero axis.

Predefined plots such as T-xy or P-xy display the experimental data as symbols
and the calculated values as lines. These plots allow you to assess the quality of
the fit. You can also identify bad data points by comparing the experimental data
with the calculated results.

You can use the Property Analysis capabilities (see Chapter 29) to plot T-xy or P-
xy diagrams at other conditions to check the extrapolation of the regressed
parameters.

Comparing Results from Several Cases
You can plot the results from several Regression cases on a single plot. This
allows you to compare several property models in fitting the same sets of data. To
plot results from several cases, select Add to Plot on the Plot Wizard (step 3). For
example, you could make a Txy plot using results from two cases:
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1. From the Plot menu of a results form of the first case, use the Plot Wizard to
generate a T-xy plot.

2. Select the data group and component to plot. Click Next or Finish to display
the plot

3. Go to the Regression Results form. Do not close the plot.

4. Use the Plot Wizard from the Plot menu. Select the T-xy plot type. Click Next

5. Select the same data group and component as in step 2

6. For select Plot Mode, select Add to Plot, then select the first plot from the list
box

7. Click Next of Finish to display the combined plot.

You can change the plot attributes as necessary, by using the Properties option
from the right mouse button menu.

Using Regression Results in a Flowsheet Run
The parameters determined by regression are placed automatically on the
appropriate Properties Parameters forms. To use the regressed parameters in a
flowsheet run:

1. From the Data Browser, select the Setup Specifications Global sheet.

2. In the Run-type field, select Flowsheet.

You can copy regression and estimation results onto parameters forms on the
Component Data sheet:

1. From the Tools menu, select Options.

2. Click the Component Data tab.

3. Check the Copy Regression and Estimation Results Onto Parameters Forms
check box.
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Retrieving Data From DETHERM and the Internet
You can retrieve a wide range of experimental data from DETHERM and the
internet. DETHERM contains the world's most comprehensive collection of
thermo physical property and phase equilibrium data. If you have a valid license
to use DETHERM, click the DETHERM icon on the main application tool bar to
search for the experimental data you need. Experimental data you retrieve will
appear on the Properties Data forms and are ready for use in data regression.
Please call your account manger at Aspen Technology to register to use Internet
DETHERM.
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Example of Regressing Vapor Liquid Equilibrium Data for Ethanol and
Ethyl-Acetate

For an ethanol-ethyl acetate system, the following vapor liquid equilibrium data
are available.

40C and 70C data of Martl, Collect. Czech. Chem. Commun. 37,266 (1972):
T=40C T=70C

P MMHG X ETOAC Y ETOAC P MMHG X ETOAC Y ETOAC
136.600 0.00600 0.02200 548.600 0.00650 0.01750
150.900 0.04400 0.14400 559.400 0.01800 0.04600
163.100 0.08400 0.22700 633.600 0.13100 0.23700
183.000 0.18700 0.37000 664.600 0.21000 0.32100
191.900 0.24200 0.42800 680.400 0.26300 0.36700
199.700 0.32000 0.48400 703.800 0.38700 0.45400
208.300 0.45400 0.56000 710.000 0.45200 0.49300
210.200 0.49500 0.57400 712.200 0.48800 0.51700
211.800 0.55200 0.60700 711.200 0.62500 0.59700
213.200 0.66300 0.66400 706.400 0.69100 0.64100
212.100 0.74900 0.71600 697.800 0.75500 0.68100
204.600 0.88500 0.82900 679.200 0.82200 0.74700
200.600 0.92000 0.87100 651.600 0.90300 0.83900
195.300 0.96000 0.92800 635.400 0.93200 0.88800

615.600 0.97500 0.94800
Atmospheric data of Ortega J. and Pena J.A., J. Chem. Eng. Data 31, 339 (1986):
T C X ETOAC Y ETOAC T C X ETOAC Y ETOAC
78.450 0.00000 0.00000 71.850 0.44700 0.48700
77.400 0.02480 0.05770 71.800 0.46510 0.49340
77.200 0.03080 0.07060 71.750 0.47550 0.49950
76.800 0.04680 0.10070 71.700 0.51000 0.51090
76.600 0.05350 0.11140 71.700 0.56690 0.53120
76.400 0.06150 0.12450 71.750 0.59650 0.54520
76.200 0.06910 0.13910 71.800 0.62110 0.56520
76.100 0.07340 0.14470 71.900 0.64250 0.58310
75.900 0.08480 0.16330 72.000 0.66950 0.60400
75.600 0.10050 0.18680 72.100 0.68540 0.61690
75.400 0.10930 0.19710 72.300 0.71920 0.64750
75.100 0.12160 0.21380 72.500 0.74510 0.67250
75.000 0.12910 0.22340 72.800 0.77670 0.70200
74.800 0.14370 0.24020 73.000 0.79730 0.72270
74.700 0.14680 0.24470 73.200 0.81940 0.74490
74.500 0.16060 0.26200 73.500 0.83980 0.76610
74.300 0.16880 0.27120 73.700 0.85030 0.77730
74.200 0.17410 0.27800 73.900 0.86340 0.79140
74.100 0.17960 0.28360 74.100 0.87900 0.80740
74.000 0.19920 0.30360 74.300 0.89160 0.82160
73.800 0.20980 0.31430 74.700 0.91540 0.85040
73.700 0.21880 0.32340 75.100 0.93670 0.87980
73.300 0.24970 0.35170 75.300 0.94450 0.89190
73.000 0.27860 0.37810 75.500 0.95260 0.90380
72.700 0.30860 0.40020 75.700 0.96340 0.92080
72.400 0.33770 0.42210 76.000 0.97480 0.93480
72.300 0.35540 0.43310 76.200 0.98430 0.95260
72.000 0.40190 0.46110 76.400 0.99030 0.96860
71.950 0.41840 0.46910 77.150 1.00000 1.00000
71.900 0.42440 0.47300

1. Start Aspen Plus and create a new run, selecting Data Regression as the Run
Type.
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2. Enter the components on the Components Specifications Selection sheet:

Note  A complete backup file with results for this example is available in the
Aspen Plus Online Applications Library. The filename is DRS1.
In this example three activity coefficient models will be fitted to the VLE
data, each in a separate case.

3. Select the property method.

Use the Properties Specifications Global sheet to choose a property method.
This example compares fitting results for the Wilson, NRTL, and UNIQUAC
property methods. Select one of the three on the Global sheet and the
remaining two on the Referenced sheet. In this example, the Wilson model is
chosen on the Global sheet.
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4. Enter experimental data.

Use the Properties Data Mixture form to enter the vapor liquid equilibrium
data. Three data sets are required, one for each set of VLE data. The
following setup and Data sheets are for the 40°C isothermal data set.
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5. Specify the regression case.

Use the Properties Regression form to formulate a regression case. In this
example, Aspen Plus has already completed the Properties Regression Input
form. Since the WILSON property method is the Global property method, it is
used as the default in the regression. All the VLE data groups you entered in
Step 4 are on this form. Aspen Plus will test the data for thermodynamic
consistency, using the Area test.
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Since the VLE data cover a wide temperature range, Aspen Plus selects
elements 1 and 2 of the Wilson binary parameters for regression. Aspen Plus
uses the databank values for the binary parameters as initial guesses in the
regression.

6. Specify additional regression cases.

Use the Regression Object Manager to specify two additional cases. Use the
same set of experimental data, but with the NRTL and UNIQUAC property
methods. Again Aspen Plus completes the Regression Input form. However,
since the WILSON property method is the global property method , it is the
default. Specify NRTL in the Method list box on the Setup sheet, so that the
NRTL property method is used in the second case. When the NRTL property
method is used, the NRTL binary parameters must be regressed. Specify the
NRTL binary parameter elements 1 and 2 as the regression parameters.
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Repeat this step for the UNIQUAC property method.

7. Run the regression.

Run all three cases. Click OK on the Data Regression Run Selection dialog
box. You can also run selected cases. Move the cases you do not want to run
into the Don't Run area, using the left arrow.
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8. Examine the results on the Regression Results form.

Use the Regression Results Parameters sheet to examine the final parameter
values:

Use the Regression Results Sum of Squares sheet to examine the weighted
sum of squares and residual root mean square errors.
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Use the Regression Results Consistency Tests sheet to examine the results of
thermodynamic consistency tests. All data groups passed the Redlich Kister
area test.

Use the Regression Results Residual sheet to examine the residual for the fit
of pressure, temperature, and composition.

Use Plot Wizard from the Plot menu to plot the residual of pressure for case
VLE 1.
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You can also plot the residual of other variables.

It is most useful to compare experimental data with calculated results. From
the Plot menu, use the Plot Wizard to generate a P-xy plot for the first data
group.
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Add the results from the NRTL and UNIQUAC cases to the plot for WILSON.
(See Comparing Results From Several Cases, this chapter.)
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32 Petroleum Assays and
Pseudocomponents

This chapter explains how to use the Assay Data Analysis and Pseudocomponent
System (ADA/PCS) to define and characterize petroleum mixtures.

Topics include how to:
• Use ADA/PCS
• Create assays and enter assay data
• Create a blend and enter blend specifications
• Generate and define pseudocomponents
• Define and modify petroleum properties
• Examine ADA/PCS results

About ADA/PCS

You can use ADA/PCS for defining and characterizing petroleum mixtures.

You can enter data for any number of assays. The minimum assay data consists
of a distillation curve and a bulk gravity value. You can enter optional data, such
as:
• Light-ends analysis
• Gravity curve
• Molecular weight curve
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You can enter any number of petroleum property curves, such as:
• Sulfur content
• Metal content
• Freeze point
• Octane numbers

Given data for any number of assays, ADA/PCS:
• Converts the distillation data into the true boiling point basis
• Performs extrapolations on assay curves and estimates any missing data
• Generates blends from two or more assays
• Develops sets of pseudocomponents to represent the assays and blends
• Reports distillation curves for assays and blends in user-specified bases
• Estimates physical properties for each pseudocomponent

You can define your own pseudocomponents and use ADA/PCS to estimate their
physical properties.

Using ADA/PCS

You can use ADA/PCS in:
• A standalone Assay Data Analysis run
• A Flowsheet simulation run

To use ADA/PCS on a standalone basis, specify Assay Data Analysis in the Run
Type list on the Setup Specifications Global sheet. Or specify Assay Data
Analysis in the Run Type list on the New dialog box when creating a new run.

In an Assay Data Analysis run, only ADA/PCS calculations are performed. You
can display and plot the distillation curves for assays and blends in different
bases, and examine the generated pseudocomponents and their properties.

In a Flowsheet run, you can use assays, blends, and pseudocomponents to define
process feed streams for the simulation. If you entered petroleum properties,
Aspen Plus automatically associates these properties with the streams.
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Creating Assays

You can define an assay using one of the following:
• Components Specifications Selection sheet
• Assay-Blend Object Manager

Defining an Assay Using the Components Specifications
Selection Sheet

To define an assay using the Components Specifications Selection sheet:

1. From the Data menu, select Components, then Specifications.

2. On the Components Specifications Selection sheet, enter a name for the assay
in the Component ID field.

3. In the Type list, select Assay as the component type.

4. In the left pane of the Data Browser, click the Assay/Blend folder.

5. In the Assay/Blend Object Manager, select the Assay ID for which you are
entering assays, then click Edit. The Components Assay/Blend Basic Data
form appears:

Select the appropriate Assay sheet to enter assay data.
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Defining an Assay Using the Assay-Blend Object
Manager

To define an assay using the Assay-Blend Object Manager:

1. From the Data menu, select Components, then Assay/Blend.

2. On the Assay-Blend Object Manager, click New.

3. In the Create New ID dialog box, choose Assay in the Select Type list.

4. Enter an ID for the assay, or accept the default ID.

5. Click OK.

The Assay Input Menu appears. Select the appropriate Assay sheet to enter assay
data.

Entering Assay Data

For each assay you must enter:
• At least four points on a distillation curve
• Either a bulk gravity or a gravity curve

Instructions for enter this required data, as well as other optional data, are
contained in the subsequent discussions of sheets and forms.

Entering a Distillation Curve and Bulk Gravity Value
The assay distillation curve and bulk gravity value are entered on the Dist Curve
sheet of the Components Assay/Blend Basic Data form.

To enter the required distillation curve and gravity input:

1. From the Data menu, select Components, then Assay/Blend.

2. On the Assay-Blend Object Manager, select the assay for which you wish to
enter data, and click Edit.

3. On the Dist Curve sheet, select a type of curve in the Distillation Curve Type
list.
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4. In the Percent Distilled and Temperature columns, enter at least four pairs of
distillation percent and temperature values for the curve.

5. In the Bulk Gravity Value frame, enter either Specific Gravity or API
Gravity, by clicking the appropriate radio button, and typing in the value.
- or -
Click the Gravity/UOPK tab to open that sheet, and enter in a gravity curve.
(See next section for details on entering a gravity curve.)
By default Aspen Plus reports the distillation curve in the input and the true
boiling (liquid volume) basis. You can use the Optional sheet to request
additional distillation curves to be reported for the assay.
Use the remaining sheets on the Basic Data form, as well as the Property
Curves form, to enter optional information as described below.

Entering a Gravity Curve
If you do not enter a bulk gravity value on the Dist Curve sheet, you must enter a
gravity curve using the Gravity/UOPK sheet. You may enter either:
• Gravity curve data
• Watson UOP K curve data

Gravities you specify on this sheet are normalized to match the bulk gravity
value specified on the Dist Curve sheet.

To enter a gravity curve:

1. On the Gravity/UOPK sheet of the Components Assay/Blend Basic Data form,
select the type of gravity data you wish to enter by clicking one of the options
in the Type frame.

2. Enter at least four pairs of mid-percent and gravity values to define the
profile in the columns for data.

If you enter a Watson UOPK curve, you must enter an average gravity on the
Assay Basic Data Dist Curve sheet. If the distillation type is True Boiling Point
(weight basis) or Vacuum (weight basis), you cannot enter a Watson UOPK
curve.
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Entering a Molecular Weight Curve
You can enter a molecular weight curve using the Molecular Wt sheet of the
Assay/Blend Basic Input form. If you do not enter a molecular weight curve,
Aspen Plus estimates it from the distillation curve and gravity you specify.

To enter a molecular weight curve:

➤ On the Molecular Wt sheet, enter at least four pairs of values in the Mid
Percent Distilled and Molecular Weight fields to define the curve.

Entering Light-Ends Analysis
You can enter light-ends analysis for an assay in terms of the compositions of
light-ends components. If you enter light-ends analysis, Aspen Plus does not
generate pseudocomponents for the light-ends portion of the assay. If you wish to
specify light-ends analysis, do this on the Light Ends sheet of the Components
Assay/Blend Basic Data form.

To enter a light-ends analysis:

1. In the Light Ends Analysis frame of the Light Ends sheet, use the Component
and Fraction columns to enter the component IDs and light ends fractions
that make up the analysis. For your fractions, you can select a basis of Mass,
Mole, or Standard Liquid Volume at the top of the column.

2. If the light-ends component is not in the databank, specify gravity and
molecular weight in the Gravity and Molecular Weight fields of the analysis
table.

3. Optionally, at the top of the sheet, enter the light-ends fraction as a fraction
of the assay, in the Light Ends Fraction field.
If you enter this value, the specified individual component fractions are
normalized to this overall value. If you omit this value, individual component
fractions are treated as fractions of the entire assay mixture.

Entering Petroleum Property Curves
You can enter any number of petroleum property curves for an assay, using the
Petro Properties sheet of the Components Assay/Blend Property Curves form.
Aspen Plus allows a variety of built-in curve types. Based on these curves,
Aspen Plus assigns property values to individual pseudocomponents in the
simulation.
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Examples of petroleum properties include:
• Sulfur content
• Metal content
• Octane numbers

To enter petroleum property curves:

1. On the Petro Properties sheet, select a petroleum property in the Property
Type list.

2. In the Property Curve Data frame, enter at least four pairs of values in the
Mid Percent Distilled and Property Value fields, to define the curve.

3. Optionally, enter a bulk value for the property in the Bulk Value field. If you
enter a bulk value, Aspen Plus normalizes the individual curve values to the
bulk value.

4. To enter additional property curves, repeat steps 1 through 3 for each
additional property.

Entering Viscosity Curves
You can enter viscosity curves at different temperatures for an assay using the
Viscosity sheet of the Components Assay/Blend Property Curves form. Viscosity
curves can be entered as either absolute or kinematic viscosity values as a
function of percent distilled for the assay. Based on these curves, Aspen Plus will
assign viscosity to pseudocomponents generated for the assay.

To enter viscosity curves:

1. On the Viscosity sheet of the Components Assay/Blend Property Curves form,
choose a type of viscosity (Absolute or Kinematic) by clicking on the
appropriate option in the Type frame.

2. In the Temperature list, select New.

3. In the New Item dialog box, enter a temperature for the viscosity curve, and
click OK.

4. In the Mid Percent Distilled and Viscosity fields, enter at least four pairs of
values to define the curve.

5. To enter viscosity curves at additional temperatures, repeat steps 1 through 5
for each curve.

To compute viscosity at multiple temperatures from the curves in the simulation,
you must enter viscosity curves for at least two temperatures.
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Creating a Blend

You can create a blend from any number of assays.

Aspen Plus performs blending on all available assay data:
• Distillation curves
• Gravity curves
• Molecular weight curves
• Light-ends analysis
• Petroleum properties curves
• Viscosity curves

Petroleum and viscosity curves are blended using the built-in or user-supplied
blending rules. See Modifying Petroleum Property Definitions, this chapter.

When you define a stream using a blend, Aspen Plus automatically associates the
petroleum properties and viscosity for the blend with the stream.

You can define a blend using either of the following:
• Components Specifications Selection sheet
• Assay-Blend Object Manager

Defining a Blend Using the Components Specifications
Selection Sheet

To define a blend using the Components Specifications Selection sheet:

1. From the Data menu, select Components, then Specifications.

2. On the Components Specifications Selection sheet, enter a name for the blend
in the Component ID field.

3. In the Type list, select Blend as the component type.

4. In the left pane of the Data Browser, click the Assay/Blend folder.

5. In the Assay/Blend Object Manager, select the Blend ID you just created, and
click Edit. The Components Assay/Blend Mixture form appears:
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To enter the blend specifications, see Defining a Blend Using the Assay-Blend
Object Manager

To define a blend using the Assay-Blend Object Manager:

1. From the Data menu, select Components, then Assay/Blend.

2. On the Assay-Blend Object Manager, click New.

3. In the Create New ID dialog box, choose Blend in the Select Type list.

4. Enter an ID for the blend, or accept the default ID.

5. Click OK.

The Components Assay/Blend Mixture form appears. To enter the blend
specifications, see Entering Blend Specifications, this chapter..
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Entering Blend Specifications

To enter blend specifications, use the Specifications sheet of the Components
Assay/Blend Mixture form:

1. On the Specifications sheet, select two or more assays in the Assay ID
column, and specify the corresponding fraction of each assay, in the Fraction
column. You can enter the assay blending fractions on a mole, mass or
standard liquid volume basis.

2. By default Aspen Plus reports the distillation curve for the blend using the
input basis and the true boiling point (liquid volume) basis. If you want to
request additional distillation curve reports for the blend, you can specify this
by clicking the desired curves in the Report Distillation Curve As frame.

Specifying Assay Analysis Options

Aspen Plus provides several options for:
• The assay data analysis procedure
• Converting and extrapolating distillation curves
• The initial and final boiling points for distillation curves

The defaults are appropriate for most applications.

To override the default options:

1. From the Data menu, select Components, then Petro Characterization.

2. In the left pane of the Data Browser window, click the Analysis Options
folder.

3. On the Assay Procedures sheet, choose the preferred analysis procedure by
clicking one of the options in the Assay Data Analysis Procedure frame:

Version 9 or later
 – or –
Version 8 or earlier
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4. In the Curve Processing Options frame, you can optionally modify any of the
following specifications from their defaults:

Specification Default

Initial boiling point 0.5

Final boiling point 99

Extrapolation method Probability

Spline fitting method Harwell

5. In the Distillation Curve Conversion Method frame, you can optionally modify
the default conversion methods.

Modifying Petroleum Property
Definitions

Aspen Plus has a list of pre-defined petroleum properties. You can enter property
curves for these petroleum properties, as discussed in Entering Petroleum
Property Curves, this chapter.

Examples of the built-in petroleum properties include:
• Sulfur content
• Metal content
• Freeze point
• Octane numbers

You can modify the definition of these pre-defined properties, or you can define
new properties. See Defining a New Petroleum Property, this chapter.

To modify the definition of a petroleum property:

1. From the Data menu, select Components, then Petro Characterization.

2. In the left pane of the Data Browser window, click the Analysis Options
folder.

3. On the Analysis Options form, select the Blend Options sheet.

4. In the Property list, select a petroleum property you wish to modify.

5. In the Blend Method field, select a property blending method.
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6. If you are using a user blending subroutine, enter an option code in the Blend
Option field. See Aspen Plus User Models for instructions on writing this
subroutine.

7. If the property curve does not encompass 0 and 100 percent, specify whether
it is to be extrapolated in the Extrapolate field.

About Pseudocomponents

You can specify how assays and blends are used to generate pseudocomponents.
ADA/PCS can generate one or more sets of pseudocomponents for a group of
assays and blends. You can use a particular assay or blend to generate only one
set of pseudocomponents.

If you do not enter any specifications for pseudocomponent generation, ADA/PCS
generates one average set of pseudocomponents for all the assays and blends.
The average set uses equal weighting for each assay and blend.

You should use ADA/PCS to generate pseudocomponents only for assays and
blends used to define flowsheet streams. This achieves the best characterization
for a simulation. Typically you enter data for several assays to create a blend,
then use the blend to define flowsheet streams. Generate pseudocomponents for
the blend only.

In general, one average set of pseudocomponents for all assays and blends in the
simulation is sufficient. Assign weighting factors to assays and blends to reflect
their relative flow rates.

At times you can improve characterization accuracy by generating a separate set
of pseudocomponents for each assay and blend. Use separate sets of
pseudocomponents when multiple assays and blends define flowsheet streams,
and in the assay/blend:
• Distillation curves have significant overlaps.
• Gravities and Watson K factors are very different.

Multiple sets of pseudocomponents in the simulation increase computation time.
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Entering Specifications for Generation of
Pseudocomponents

To generate a set of pseudocomponents:

1. From the Data menu, select Components, then Petro Characterization.

2. In the left pane of the Data Browser window, select the Generation folder.

3. In the Generation Object Manager, click New.

4. In the Create New ID dialog box, enter an ID for the set of
pseudocomponents, or accept the default ID.

5. Click OK.
The Components Petro Characterization Generation form appears with the
Specifications sheet selected:

6. On the Specifications sheet, select the assays and blends for which an average
set of pseudocomponents is to be generated, using the Assay/Blend ID list.

7. In the Weighting Factor field, you can assign weighting factors to reflect the
relative importance of each assay or blend in the generation of
pseudocomponents. By default each assay or blend is given an equal weight of
one.
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8. At the bottom of the sheet, select a property method in the Property Method
list. This property method represents the models to be used in the estimation
of all pseudocomponent properties. By default ADA/PCS uses the ASPEN
pseudocomponent property method to estimate pseudocomponent properties.
See About Pseudocomponent Property Methods, this chapter, for a description
of the built-in property methods.

Specifying Cut Points

By default Aspen Plus generates pseudocomponents using a standard set of cut
points:

TBP Range ( F) Number of Cuts Increments ( F)

100 – 800 28 25

800 – 1200 8 50

1200 – 1600 4 100

To override the standard cut points, use the Cuts sheet on the Generation form to
specify a list for one of the following:
• Cut temperatures
• Cut ranges. For each range, enter either the number of cuts or the

temperature increment for each cut.

Pseudocomponent Naming Options

By default the generated pseudocomponents are named according to their mean
average normal boiling point. You can use the Naming Options sheet on the
Generation form to select from five built-in naming conventions. If you choose
User Defined List, you must enter the pseudocomponent IDs in the
Pseudocomponent fields of the Preview of Pseudocomponent Names frame. These
IDs then appear on the Stream Input Specifications sheets, allowing you to enter
pseudocomponent flows.

Defining Pseudocomponents and
Entering Pseudocomponent Properties

In addition to allowing Aspen Plus to automatically generate pseudocomponents
for your specified assays and blends, you also can choose to define
pseudocomponents directly.
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To create user-defined pseudocomponents, first enter them on the Components
Specifications form:

1. From the Data menu, select Components, then Specifications.

2. On the Selection sheet, enter the names for the user-defined
pseudocomponents in the Component ID fields.

3. Select PseudoComponent as the component type in the Type list. Leave the
Component Name and Formula fields blank for pseudocomponents.

Entering Basic Properties for Pseudocomponents
Once the pseudocomponents are defined on the Components Specifications form,
enter the basic properties for the pseudocomponent on the Components Pseudo
Components Specifications sheet:

1. From the Data menu, select Components, then PseudoComponents.
The Components PseudoComponents form appears with the Specifications
sheet displayed:

2. On the Specifications sheet, the pseudocomponents you defined on the
Components Specification form are listed in the Pseudocomponents column.
For each pseudocomponent, enter at least two of the following properties to
characterize the pseudocomponent:
• Average normal boiling point
• Gravity/Density
• Molecular weight
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Gravity or density can be entered in any of the following formats:
• API gravity
• Specific gravity
• Standard liquid density

3. If you wish to modify the default pseudocomponent property method, select a
new method in the Property Method list. About Pseudocomponent Property
Methods, this chapter, for descriptions of the built-in option sets.

The default view of the PseudoComponents Specification sheet is the Basic
Layout view. This view allows for a single pseudocomponent property method,
and a single type of gravity or density to represent all pseudocomponents. If you
wish to specify different property methods, or different types of gravity or density
for individual pseudocomponents, you can select Advanced Layout from the View
list at the top of the sheet. The Advanced Layout allows individual specifications
of property methods and gravity or density types for each pseudocomponent.

Entering Temperature-Dependent Properties for
Pseudocomponents

From the basic pseudocomponent properties you entered on the
PseudoComponents Specifications sheet, Aspen Plus estimates all pure
component properties needed for flowsheet simulation.

Optionally, you also can provide vapor pressure, viscosity, and water solubility
data as a function of temperature for pseudocomponents. This improves the
accuracy of the characterization.

To enter these temperature-dependent properties:

1. From the Data menu, select Components, then PseudoComponents.

2. On the Components PseudoComponents form, there are separate sheets for
Vapor Pressure, Viscosity, and Water Solubility. Click the appropriate sheet
for the type of data you wish to enter.

3. On the selected sheet, choose a pseudocomponent from the Component ID list.

4. In the frame below the Component ID, enter the property data as a function
of temperature.

5. To enter data for other components, repeat steps 3 and 4.

6. To enter another property, repeat steps 2 through 4.
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About Pseudocomponent Property
Methods

A pseudocomponent property method is a collection of models for estimating
pseudocomponent properties needed for flowsheet simulation. Pseudocomponent
properties that are estimated include:
• Molecular weight
• Critical properties
• Acentric factor
• Vapor pressure
• Liquid molar volume
• Water solubility
• Viscosity
• Ideal gas heat capacity
• Enthalpy of vaporization
• Standard enthalpy and free energy of formation
• Equation of state properties

You can use a pseudocomponent property method in one of two ways:

On sheet Specify a pseudocomponent property method for

Components Petro Characterization Generation
Specifications

Pseudocomponents generated from assays

Components PseudoComponents Specifications User-defined pseudocomponents

You can choose from five built-in pseudocomponent property methods:

Method Description

API-METH Uses procedures recommended by the American Petroleum Institute (API) Data Book.

COAL-LIQ Uses correlations developed for coal liquids.

ASPEN Based on the API-METH property method, with proprietary AspenTech enhancements for
selected properties. (Default option set)

LK Uses correlations by Lee and Kesler.

API-TWU Based on the ASPEN property method, but uses correlations by Twu for critical properties.

You also can create your own pseudocomponent property methods. Use your own
property methods in the same way as the built-in option sets. For details on
creating your own pseudocomponent property methods, see the following section.
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Creating Pseudocomponent Property
Methods

You can create your own pseudocomponent property methods by starting with a
built-in method, and modifying individual models for different pseudocomponent
properties.

Aspen Plus provides several built-in models for each pseudocomponent property.
Or you can supply your own model using a user-supplied subroutine. See
Aspen Plus User Models for instructions on writing this subroutine.

To create a new pseudocomponent property method:

1. From the Data menu, select Components, then Petro Characterization.

2. In the left pane of the Data Browser window, click the Properties folder.

3. In the Petro Characterization Properties Object Manager, click New.

4. In the Create New ID dialog box, enter an ID (name) for the new method, or
accept the default ID.

5. Click OK.

6. On the Basic sheet of the Properties form for the new method, select one of
the built-in methods, by selecting from the Copy All Models From list. The
chosen property method will be used as a basis for the new method.
The remaining fields on the sheet (as well as the Thermodynamic sheet and
the EOS sheet) display the models used by the base method for each property.

7. Use the remaining fields on the Basic sheet, the Thermodynamic sheet and
the EOS sheet, to specify the property models which make up the property
method.

Defining a New Petroleum Property

You can use a new petroleum property in the same ways as a pre-defined
petroleum property. You can enter the curve data of this property for any assay.
See Entering Petroleum Property Curves, this chapter.
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You can define any number of additional petroleum properties to be used on the
Prop-Sets Properties sheet and the Assay/Blend Property Curves form.

To define a new petroleum property:

1. From the Data menu, select Properties, then Advanced.

2. In the left pane of the Data Browser window, click the User Properties folder.

3. In the User Properties Object Manager, click New.

4. In the Create New ID dialog box, enter an ID (name) for the new property, or
accept the default ID.

5. Click OK.

6. On the Specifications sheet of the Properties Advanced User Properties form,
click the Assay Curve Property radio button at the top of the sheet.

7. In the Assay Curve Property Frame, select a blending method from the
choices provided. The default method is Standard Liquid Volume Averaging.
If you choose to use a user blending subroutine, enter an option code in the
Blending Option field. See Aspen Plus User Models for instructions on writing
this subroutine.

8. In the Default Property Used for Light Ends list, select a property to provide
values for light-ends components.

9. At the bottom of the sheet, you can choose whether you want to extrapolate
curve data that does not encompass the entire composition range (0-100%).
Extrapolation is turned on by default. To turn off this option, click the check
box to deselect it.

10. Click the Units sheet.

11. Click the appropriate check box to specify how you want the units conversion
to be calculated.

12. If you choose to let Aspen Plus perform the units conversion, select the type of
units in the Units type list.

13. If you choose to perform the units conversion in a user subroutine, enter a
units label in the Units Label field. This label will be used in stream reports
and property curve results.
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Examining ADA/PCS Results

Aspen Plus produces a variety of ADA/PCS results. You can examine
• ADA results
• Pseudocomponent property results

Examining ADA Results
To examine ADA results:

1. From the Data menu, select Components, then Assay/Blend.

2. On the Assay/Blend Object Manager, select the assay or blend for which you
want to display results, and click Edit.

3. In the left pane of the Data Browser window, click the Results form beneath
the selected assay or blend.
The Assay-Blend Results form appears, containing these sheets:

Sheet Shows

Light Ends Analysis Results of the light ends analysis

Pseudocomp Breakdown Pseudocomponent and light ends breakdown results

Curves Distillation curves and bulk properties results

Blend Fraction (Blends only) Compositions of blends

4. From the Curves sheet, you can generate plots of distillation temperatures
versus percent distilled. See chapter 13 for instructions on generating plots.

Examining Pseudocomponent Property Results
To examine pseudocomponent property results:

1. From the Data menu, select Components, then Petro Characterization.

2. In the left pane of the Data Browser, click the Results folder.
The Summary sheet on the Components Petro Characterization Results form
displays the key properties for each pseudocomponent in table format.

3. You can generate plots of pseudocomponent properties versus boiling points
or any other property. See Chapter 13 for instructions on generating plots.
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33 Pressure Relief
Calculations

This chapter describes how to use the Pressure Relief (Pres-Relief) features of
Aspen Plus to:
• Determine the steady-state flow rating of pressure relief systems
• Dynamically model vessels undergoing pressure relief due to a fire or heat

input specified by the user.

Topics in this chapter include:
• About pressure relief calculations
• Setting-up pressure relief calculations
• Specifying information for the scenarios
• Specifying the composition and conditions
• Defining the venting system
• Specifying chemical reactions
• Specifying when to stop the simulation (stop criteria)
• Specifying the over pressure factor and piping pressure drop rules
• Examining calculation results

About Pressure Relief Calculations

Use Pressure Relief to simulate a vessel undergoing pressure relief or for simple
valve rating. Pressure Relief uses the same physical property models and data as
other Aspen Plus flowsheet models.
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The modeling equations for nozzle flow, and for bubbly and churn-turbulent
disengagement are based on technology developed by the Design Institute for
Emergency Relief System (DIERS) Users Group of the AIChE. This technology is
considered the best available for pressure relief system design. The Aspen Plus
Pipeline model simulates flow through the inlet and tail pipes in the relief
system.

Pressure Relief always operates in rating mode. This means that the program
will calculate the pressure profile in the vessel and piping, given the size of the
relief device. In addition, you must specify the:
• Dimensions of the equipment being protected and a connecting nozzle if

present
• Pressure relief scenario
• Dimensions of inlet and tail piping, if present
• Dimensions of the relief device

Each Pressure Relief block models one scenario and one vessel. To model more
than one scenario or pressurized vessel in an Aspen Plus run, include more than
one Pressure Relief block in the simulation. Pressure Relief blocks are not part of
the simulation flowsheet (there is no icon needed), but they can reference
simulation streams.

Pressure Relief analyzes the specified scenario and reports:
• Rated capacity
• Results profiles (temperature, pressure, vapor fraction)
• Whether the system meets design rules that you select or that applicable

codes (such as ASME) require

Creating a Pressure Relief Block
To create a Pressure Relief block:

1. From the Data menu, point to Flowsheeting Options, then Pres-Relief.

2. In the Pressure Relief Object Manager, click New.

3. In the Create New ID dialog box, enter an ID (name) or accept the default ID.

4. Click OK.
See the remaining sections of this chapter for information on completing the
Pressure Relief specifications.
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About Pressure Relief Scenarios

A Pressure Relief scenario is a situation that causes venting to occur through the
relief system. There are four types of generic scenarios to choose from:
• Steady-state flow rating of relief system (valve and piping)
• Steady-state flow rating of relief valve (no piping)
• Dynamic run with vessel engulfed by fire
• Dynamic run with specified heat flux into vessel

Each scenario is described briefly below.

Steady-State Flow Rating of Relief System Scenario

Use this scenario to find the flow rate through an emergency relief system, given
the condition of the stream flowing into it and the upstream and downstream
pressures. The relief system may include a relief valve a vessel neck, and two
segments each, of inlet and tail pipes, as well as any number of block valves and
fittings. In this scenario the pressure relief model calculates the steady-state flow
rate through the specified system.

Steady-State Flow Rating of Relief Valve Scenario

Use the valve rating scenario when:
• You know the pressure, temperature, and stream composition
• You want to find out the valve capacity

The differences between the Valve rating scenario and the Relief System Rating
scenario are that in the Valve Rating scenario:
• No piping is allowed
• The relief device must be a Process Safety Valve (PSV) or a Process Safety

Valve-Process Safety Disk (PSV-PSD)

Dynamic Run With Vessel Engulfed by Fire Scenario

Pressure Relief provides three standards for computing the fire exposure
scenario:
• NFPA 30
• API 520
• API 2000
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The chosen fire standard determines which regulations are used to calculate fire
scenario factors such as vessel wetted area, energy input, and credit factors.

Pressure Relief assumes the calculated energy input is constant during the entire
venting transient. If appropriate, you can specify individual credit factors for
drainage, water spray, and insulation to reduce the energy input. Alternatively,
you can specify an overall credit factor.

Dynamic Run With Specified Heat Flux Into Vessel
Scenario

The heat input scenario is similar to the fire exposure scenario, except:
• You choose the energy input value
• Credit factors are not allowed

There is no cut-off time for the duration of the event. The specified heat flux can
be constant, from a constant temperature source, or a function of time.

This scenario can be used to model:
• Full-on electrical heaters or other constant energy sources, by selecting the

Constant Duty heat input method.
• Pressure relief caused by runaway reactions, by using the Constant Duty heat

input method and specifying a value of zero for heat duty.
• Heat input from a source such as heat exchanged by selecting the Calculated

from the Heat Source method and providing a source temperature, a heat
transfer coefficient and surface area.
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Selecting a Pressure Relief Scenario

To specify a pressure relief scenario:

1. On the Pressure Relief Setup Scenario sheet, click one of the four choices of
pressure relief scenario.

2. From the Capacity option list, select Code or Actual.

Choose this option To run the
simulation at

Meaning This option is useful for

Code (default) Code capacity De-rates capacity of relief device as
specified by ASME code
requirements.

Determining if a pressure relief valve or
rupture disk of a given size is adequate for
the chosen scenario.

Actual Actual capacity Produces best estimate of relief
system effluent. Does not de-rate
capacity.

Checking whether the inlet or tail pipe
sections meet the code compliant
requirements.

3. Specify the Vent Discharge Pressure. You need to specify this for all pressure
relief scenarios. If there are any tail pipe segments after the relief device the
discharge pressure refers to the pressure at the end of piping. This is
typically the atmospheric pressure of the flare header back pressure.

4. If you selected a steady state flow scenario, enter the Estimated Flow Rate.

5. The value you enter is used as a starting point to determine the rated flow for
the relief system or safety valve. You can enter this flow in a mass, mole or
standard liquid volume basis.
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The scenario you choose on the Setup Scenario sheet determines which of the
remaining Pressure Relief forms and sheets you need to complete to define your
system. The required forms will be displayed as incomplete in the left pane of the
Data Browser  Forms and sheets that do not apply to your chosen scenario are
inactive.

Use Next to guide you through the required forms.

Specifying the Inlet Stream for Steady State Scenarios
For the steady state scenarios of relief valve or relief system rating you must
provide the composition of the stream entering the relief valve or system.

You can:
• Specify the composition of a stream or vessel by referencing a stream from the

flowsheet
– or –

• Specify the stream composition directly in the pressure relief block

These specifications are entered on the Stream sheet of the Pressure Relief Setup
form

To specify the composition of a stream or vessel by referencing a stream from the
flowsheet:

1. Select the Stream tab from the Pressure Relief Setup form.

2. On the Stream sheet, click the Reference Stream Composition check box.
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3. In the field below the check box, select the desired stream.

To specify the stream composition directly in the pressure relief block:

1. Select the Stream tab from the Pressure Relief Setup form, to open that
sheet.

2. In the Stream Composition frame of the Stream sheet, choose a composition
basis from the Basis list.

3. Enter the component fractions in the Fraction fields next to each component
present in the stream.

In addition to the composition, you must specify the thermodynamic conditions of
the inlet stream. This involves specifying some combination of the three state
variables: temperature, pressure, and molar vapor fraction. These values can
either be entered directly on the Stream sheet, or referenced from the flowsheet
if you have referenced a stream composition.

To reference an inlet stream state variable from a flowsheet stream:

1. On the Stream sheet, first ensure that you have checked the Reference
Stream Composition check box. You cannot reference state variables from a
stream if you have not also referenced the composition.

2. In the Reference Stream frame of the Stream sheet, click the check box
indicating which stream variable you wish to reference:
• Reference Stream Temperature
• Reference Stream Pressure
• Reference Stream Vapor Fraction
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To specify a state variable for the inlet stream directly in the pressure relief
block:

1. On the Stream sheet, enter a value in one of the fields of the User Flash
Specifications frame:
• Temperature
• Pressure
• Vap. Fraction

2. Select the appropriate units for the entered value.
If you wish, you can reference one state variable, and enter the other directly.

Specifying Initial Vessel Contents for Dynamic
Scenarios

For the dynamic scenarios of fire or heat input, you must provide the initial
conditions of the vessel on the Vessel Contents sheet of the Pressure Relief Setup
form.

The initial conditions of the vessel can be specified in terms of:
• Composition
• Thermodynamic conditions (temperature, pressure or vapor fraction)
• Fillage
• Pad gas component



Chapter  33

Aspen Plus User Guide 33-9
Version 10.2

The composition of the vessel must be specified for all pressure relief blocks,
however the remaining specification can be specified using one of the following
three combinations:
• Two of temperature, pressure, and molar vapor fraction
• Two of temperature, pressure, and fillage
• All of temperature, pressure, fillage, and pad gas component

The pressure relief model uses this information and the volume you define on the
Pressure Relief ReliefDevice form to calculate the initial mass in the system.

Specifying Vessel Composition for Dynamic Scenarios

The vessel composition can be provided by either:
• Referencing a flowsheet stream composition
• Specifying values directly on the Vessel Contents sheet

To specify the composition of the vessel by referencing a stream from the
flowsheet:

1. Select the Vessel Contents tab from the Pressure Relief Setup form.

2. On the Vessel Contents sheet, click the Reference Stream Composition check
box.

3. In the field below the check box, select the desired stream ID.

To specify the stream composition directly in the pressure relief block:

1. Select the Vessel Contents tab from the Pressure Relief Setup form.

2. In the Vessel Composition frame of the Vessel Contents sheet, choose a
composition basis from the Basis list.

3. Enter the component fractions in the Fraction fields next to each component
present in the vessel.

Defining Thermodynamic Conditions for Dynamic
Scenarios

To define the thermodynamic conditions, you must specify some combination of
the state variables temperature, pressure, or vapor fraction. The required
combination depends on whether you specify fillage and pad gas component.

When specifying temperature, pressure, and molar vapor fraction, you can either:
• Enter a value directly on the Vessel Contents sheet
• Reference a flowsheet stream from which to retrieve the value
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To reference a vessel state variable from a flowsheet stream:

1. On the Vessel Contents sheet, first ensure that you have checked the
Reference Stream Composition check box. You cannot reference state
variables from a stream if you have not also referenced the composition.

2. In the Reference Stream frame of the Vessel Contents sheet, click the check
box indicating which stream variable you wish to reference:
• Reference Stream Temperature
• Reference Stream Pressure
• Reference Stream Vapor Fraction

To specify a state variable for the vessel directly on the Vessel Contents sheet:

1. On the Vessel Contents sheet, enter a value in one of the fields of the User
Flash Specifications frame:
• Temperature
• Pressure
• Vap. Fraction

2. Select the appropriate units for the entered value.
If you wish, you can reference one state variable, and enter another directly.

Fillage

Fillage is the initial fraction of the vessel volume filled with liquid (liquid
holdup). The fillage must be greater than zero and less than 0.994.

If you specify the fillage but not a pad-gas component, the temperature or
pressure specification will be used to determine the bubble point (vapor pressure
for pure components) of the initial mass.

To specify fillage:

➤ On the Vessel Contents sheet, enter a value in the Fillage field of the Vessel
Fillage frame.

Pad Gas Component

Pad Gas Component represents the component being added to bring the pressure
up to the specified level. For example, nitrogen is often used as a pad gas in
hydrocarbon storage tanks.

To specify a pad gas component:

➤ On the Vessel Contents sheet, choose a component from the Pad Gas
Component list in the Vessel Fillage frame.
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Design Rules

Use the Rules sheet of the Pressure Relief Setup form to specify rules regarding:
• Maximum vessel pressure (dynamic scenarios only)
• Inlet pipe pressure loss
• Tail pipe pressure loss
• Valve differential set pressure

Except for the limit on maximum vessel pressure, these rules apply only when
the relief device is selected to be a PSV (safety relief valve) or PSV in
combination with a PSD (rupture disk) for gas or two-phase service.

These rules have been included as an aid for good design practice. Pressure Relief
will generate warnings if any of the rules are violated. However, any design or
safety analysis decision involving these rules should be based on your own
interpretation of the relevant codes and design practices.

Each section of the Rules sheet is summarized below. See the Aspen Plus Unit
Operations manual for a detailed discussion of design rules.
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The following table summarizes the application of the design rules:

Rule Application Device

Inlet pressure loss At 10% over-pressure† Gas/2 phase service PSV

Tail pressure loss At 10% over-pressure†† Gas/2 phase service PSV

97% rule At or above 10% over-pressure† Gas/2 phase service PSV

Max vessel pressure Always All devices

†
If 10% over-pressure is not reached, the highest pressures are scaled to 10% over-pressure. If all pressures are above 10%
over-pressure, these rules are not applied and a warning is issued.

Maximum Vessel Pressure

For the dynamic scenarios of fire or heat input, you must provide the maximum
vessel pressure. This value can be expressed as an absolute value in the User
Specified field, or as a percentage of the maximum allowable working pressure
(MAWP) entered on the Design Parameters sheet of the Pressure Relief
DynamicInput form.

When using the Percent of MAWP specification, MAWP is converted to gauge
pressure before Aspen Plus applies the percentage entered.

Inlet Pipe Pressure Loss

Use this field to enter the maximum inlet piping pressure loss as a percentage of
differential set pressure. This is calculated at 10% over-pressure or maximum
pressure if 10% over-pressure is not reached. Aspen Plus generates a warning if
the total pressure loss in the inlet piping is greater than or equal to the specified
percentage of differential set pressure. The specified value is usually 3 (the
default), and this rule is often called the “3% rule.”

Tail Pipe Pressure Loss

Use this frame for specifying the method for setting the allowable tail pipe
pressure loss. You can do one of the following:
• Use the 97% Rule
• Enter the maximum loss expressed as a percentage of differential set

pressure (known as the X% Rule)
• Specify that Pressure Relief not model tail pipe pressure loss

When the 97% rule is used, Aspen Plus generates a warning if the valve pressure
drop is less than 97% of the valve's differential set pressure. When the X% rule is
used, Aspen Plus generates a warning if the pressure loss after the valve is equal
to or greater than X% of the valve differential set pressure.
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The following table suggests which rule should be used for the most common
types of safety valves:

Valve Type Suggested Tail Piping Rule

Standard spring loaded 97% Rule or X% with X=10

Pop action pilot with unbalanced pilot vented to discharge 97% Rule or X% with X=10

Balanced bellows spring loaded X% with X=30

Modulating pilot with balanced pilots or pilots vented to
atmosphere

X% with X=40

Valve Differential Set Pressure

You can specify whether the differential set pressure (DSP), changes when back
pressure changes (that is, whether the valve is balanced or vented).

The following tables indicates whether the DSP changes for the most common
types of safety valves:

Valve Type Does DSP change?

Standard spring loaded Yes

Pop action pilot with unbalanced pilot vented to discharge Yes

Balanced bellows spring loaded No

Modulating pilot with balanced pilots or pilots vented to
atmosphere

No

Specifying the Venting System

A Pressure Relief venting system can consist of the following components:
• A vessel neck (nozzle)
• Up to two lengths (segments) of inlet pipe connecting the vessel neck to the

pressure relief device
• The pressure relief device (safety valve, rupture disk, relief vent, or

combination rupture disk and safety valve)
• Up to two lengths (segments) of tail pipe from the relief device to the

atmosphere or to another piece of equipment
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You do not have to include all these components in a Pressure Relief calculation.
But the block must include at least a pipe section or a relief device.

Use the Configuration sheet on the ReliefDevice form to specify:
• Relief device type, including service for safety relief valves
• Number of inlet and tail pipe sections
• Whether the vessel neck is to be specified
• Whether the vessel neck and piping should be ignored during dynamic runs

If you choose Open Vent Pipe as the device, then:
• No relief device is allowed
• You must specify a vessel neck, inlet pipe, or tail pipe

For the Steady State Flow Rating of Relief Valve scenario, the venting system
consists only of a safety valve. No piping is allowed.

Specifying the Relief Device
The following types of relief devices are available:
• Safety relief valve (both liquid and gas/2-phase)
• Rupture disk
• Emergency relief vent
• Open vent pipe (pipe section or vessel neck)
• Relief valve / Rupture disk combination

On the Configuration Sheet of the ReliefDevice form, choose the type of relief
device you wish to simulate by clicking on one of the options above. The default
relief device is a safety relief valve.
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Depending on the type of relief device you choose on the Configuration sheet of
the ReliefDevice form, one or more additional sheets (tabs) on the ReliefDevice
form may become active for further specification of the device. For example, if
you select Rupture disk as your relief device on the Configuration sheet, the
Rupture Disk tab will become active and display an incomplete symbol indicating
that further specifications are required on this sheet.

Each of these additional sheets is explained later in this section.

Built-in tables within Aspen Plus contain:
• Several standard commercially available valves, rupture disks, and

emergency relief vents
• All the mechanical specifications and certified coefficients needed in the relief

calculations

You can customize Aspen Plus by modifying or adding tables of valve, disk, and
vent characteristics. For more information, see the Aspen Plus System
Management manual.

You can do one of the following:
• Choose a device from the tables
• Enter your own specifications and coefficients

For liquid service valves, you can specify the full-lift over-pressure factor. This
allows you to simulate some of the older-style valves, which do not achieve full
lift until 25% over-pressure is reached.
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Safety Valve

If you select Safety Relief Valve or Relief Valve / Rupture Disk Combination as the
type of relief device, you must complete the Safety Valve sheet to specify the
safety relief valve (PSV) to be used in the simulation. Define the valve in the
Manufacturer's Tables frame. Once the Type, Manufacturer, Series, and Nominal
Diameter have been selected, a unique valve is described and Aspen Plus fills in
the following data in the Valve Parameters frame:
• Inlet Diameter
• Throat Diameter
• Outlet Diameter
• Discharge Coefficient

If you want to use a valve not listed in the Manufacturer's Tables, you must type
in values for the Valve Parameters listed above. Note that if you select a valve
from the tables and then overwrite any of the Valve Parameters, all
Manufacturer's Tables fields will be blanked out.

To complete the form, enter the differential setpoint for the valve. This
represents the pressure difference across the valve which is needed for the valve
to start opening.

Rupture Disk

If you select Rupture Disk or Relief Valve / Rupture Disk Combination as the type
of relief device, you must complete the Rupture Disk sheet to specify the rupture
disk (PSD) to be used in the simulation. Define the rupture disk in the
Manufacturer's Tables frame. Once the Manufacturer, Style, and Nominal
Diameter have been selected, a unique PSD is described and Aspen Plus fills in
the following data in the Rupture Disk Parameters frame:
• Diameter
• Discharge Coefficient

If you want to use a PSD not listed in the Manufacturer's Tables, you must type
in values for the parameters listed above. Note that if you select a rupture disk
from the tables and then overwrite any of the rupture disk parameters, all
Manufacturer's Tables fields will be blanked out.

To complete the form, enter the differential setpoint for the rupture disk. This
represents the pressure difference across the rupture disk which is needed for
the disk to break.
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In an actual capacity run, the rupture disk is modeled as a pipe with an
equivalent length to diameter (L/D) ratio. If no test data is available, use L/D=8
for disk diameters larger than 2 inches (5.08 cm), and 15 for diameters 2 inches
and smaller. In a code capacity run, the rupture disk is modeled as an ideal
nozzle with the appropriate discharge coefficient. For uncertified rupture disks,
use a discharge coefficient of 0.62.

Relief Vent

If you select Emergency Relief Vent as the type of relief device, you must
complete the Relief Vent sheet to specify the emergency relief vent (ERV) to be
used in the simulation. Define the relief vent in the Manufacturer's Tables frame.
Once the Manufacturer, Style, and Nominal Diameter have been selected, a
unique ERV is described and Aspen Plus fills in the following data in:
• Recommended Setpoint
• Diameter

To complete the form, enter the differential setpoint for the relief vent. This
represents the pressure difference across the vent which is needed for the vent to
begin opening.

If you want to use an ERV not listed in the Manufacturer's Tables, you must type
in values for the diameter and differential setpoint in the Vent Parameters
frame. Note that if you select an ERV from the tables and then overwrite any of
the vent parameters, all Manufacturer's Tables fields will be blanked out.

ERVs are modeled so that they open gradually to a fully open position calculated
using the vent over-pressure factor.

Specifying the Vessel Neck
The vessel neck is a piece of pipe which connects the vessel to the first length of
inlet pipe or to the relief device if there are no inlet pipes. If you choose to specify
a vessel neck, enter the associated information on the Vessel Neck sheet of the
ReliefDevice form.

The following data are required to describe the vessel neck:
• Length
• Diameter
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Optional specifications on the Vessel Neck sheet are shown below with their
corresponding defaults:

Specification Default

Orientation Vertical

Connection Type Rounded

Reducer resistance coefficient (Reducer K) 0.04

Expander resistance coefficient (Expander K) 0.04

Roughness 0.00015 ft

Specifying the Inlet Pipe
For inlet pipe sections, use the Pressure Relief InletPipes form to describe the
inlet pipes which connect the vessel neck to the relief device. Up to two sections
of pipe with the same or different diameters may be used.

The InletPipes form contains four sheets:

Use this sheet To

Pipe Specify the pipe dimensions and optional pipe parameters

Fittings Describe the fittings in the pipe section such as pipe connections, butterfly or gate valves,
elbows, and tees

Valves Describe a general purpose valve or control valve in the pipe section

Thermal Specify heat transfer parameters for energy transfer with surroundings

The Pipe sheet is required for all sections of inlet pipe.

The remaining sheets are used for specification of optional input. Each sheet is
described below.

Pipe

Use the Pipe sheet to enter the pipe diameter and length for each pipe section.
Pipe diameter and length are required specifications for all pipe sections.
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Included with Aspen Plus are built-in Pipe Schedule Tables that aid in the
specification of common pipe sizes.

You can customize Aspen Plus by adding or modifying pipe schedule tables. For
more information on this, see the Aspen Plus System Management manual.

To choose a pipe diameter from the built-in Pipe Schedule Tables:

1. At the top of the Pipe sheet, select a pipe section from the Pipe Section field.

2. In the Pipe Schedule frame, choose a material of construction for the pipe
section, from the Material list. Available materials include carbon steel and
stainless steel.

3. Choose a pipe schedule in the Schedule field.

4. Choose a nominal pipe diameter from the Nominal Diameter field.

A unique pipe is described and the Inner Diameter is displayed in the Pipe
Parameters frame.

If you want to use a pipe not listed in Pipe Schedule Tables, you must manually
enter the pipe inner diameter in the Inner Diameter field of the Pipe Parameters
frame. Note that if you select a pipe from the tables and then overwrite the inner
diameter, all Pipe Schedule Tables fields will be blanked out.

Optional inputs on the Pipe sheet include:
• Absolute pipe roughness
• Pipe Rise (elevation change)
• Resistance coefficient ("K" factor) of reducer following the pipe section
• Resistance coefficient ("K" factor) of expander following the pipe section
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If you do not enter values for these optional inputs, the following default values
are used.

Specification Default

Roughness 0.00015 ft

Pipe Rise 0

Reducer K 0.04

Expander K 0.04

Fittings

Use the Fittings sheet to describe any fittings contained in the inlet pipe section.
Any number of the following fitting types may be specified:
• Gate Valves
• Butterfly Valves
• 90 degree Elbows
• Straight Tees
• Branched Tees

In addition a miscellaneous flow resistance may be specified by entering in the
number of pipe diameters equivalent to the resistance.

Valves

Use the Valves sheet to specify a general purpose valve to be used in a pipe
section. In the top section of the sheet, select a valve from the Manufacturer's
Tables frame. Once the Manufacturer, Style, and Nominal Diameter have been
selected, a unique valve is described and Aspen Plus fills in the following data in
the Valve Parameters frame:
• Flow Area
• Flow Coefficient

If you want to use a valve not listed in the Manufacturer's Tables, you must type
in values for the parameters listed above. Note that if you select a valve from the
tables and then overwrite any of the valve parameters, all Manufacturer's Tables
fields will be blanked out.

You may also specify the valve constant for a control valve contained in the pipe
section. To do this, enter a value in the Valve Constant field of the Control Valve
frame.
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Thermal

Use the Thermal sheet to specify energy balance parameters if you want to model
heat transfer between the pipe section and the surroundings. The following must
be specified:
• Inlet Ambient Temperature
• Outlet Ambient Temperature
• U-value (overall heat transfer coefficient)

Specifying the Tail Pipe
For tail pipe sections, use the Pressure Relief TailPipes form to describe the tail
pipes which connect the relief device to the discharge point. Up to two sections of
pipe with the same or different diameters may be used. The TailPipes form has
the same functionality as the InletPipes form, except that it applies to tail pipe
sections. For more details on specifying tail pipes, refer to Specifying the Inlet
Pipe, earlier in this chapter.

Specifying Dynamic Input

Use the DynamicInput form to describe the emergency event associated with a
dynamic scenario. Required data include a description of the vessel as well as the
event (fire or heat input) which is causing the release from the vessel.

The sheets contained on the DynamicInput form are listed below:

Use this sheet To specify

Vessel Vessel and vessel head geometry

Design Parameters Vessel design pressure and disengagement model

Fire Type of fire exposure engulfing the vessel

Fire Credits Credits you can claim if systems to fight fire or minimize vessel releases are present

Heat Input The rate of heat input into a vessel

The Vessel and Design Parameters sheets must be completed for all dynamic
scenarios. For heat input scenarios, the Heat Input sheet is also required. For
fire scenarios, the Fire sheet is required, and the Fire Credits sheet is optional.

The use of each sheet is described next.
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Vessel

Use this sheet to describe the vessel undergoing the emergency event by
specifying:
• Vessel type and head type
• Shell orientation if the vessel type is Heat Exchanger Shell
• Vessel length and diameter
• Vessel jacket volume if vessel type is Vessel Jacket
• Vessel volume if vessel is User Specified
• Head volume and head area if head type is User Specified

The following vessel types are available:
• Horizontal
• Vertical
• API Tank
• Sphere
• Heat Exchanger Shell
• Vessel Jacket
• User Specified

To complete vessel specifications:

1. On the Pressure Relief DynamicInput Vessel sheet, choose a vessel type from
the Vessel Type list in the Vessel Description frame.

2. For vessel types of Horizontal, Vertical, API Tank, or Heat Exchanger Shell,
select a head type in the Head Type list, and enter the length and diameter in
the Vessel Dimensions frame. Available options for head type are Flanged,
Ellipsoidal, or User Specified.

3. For Heat Exchanger Shell vessel types, enter the shell orientation (horizontal
or vertical) in the Shell Orientation list.

4. For Sphere vessel types, enter the sphere diameter in the Diameter field of
the Vessel Dimensions frame.

5. For Vessel Jacket vessel types, enter the jacket volume in the Vessel
Dimension frame.

6. For User Specified vessel types, enter the vessel volume and head volume in
the User Specifications frame.

7. If you choose a User Specified head type, enter the head volume and head
area in the User Specifications frame.



Chapter  33

Aspen Plus User Guide 33-23
Version 10.2

Design Parameters

Use the Design Parameters sheet to describe vessel design characteristics by
specifying:
• Maximum allowable working pressure (MAWP)
• Temperature corresponding to the MAWP
• Vessel disengagement model
• Homogeneous vapor fraction limit for user specified disengagement model
• Volume of vessel internals

Vessel disengagement models let you select how the phase behavior of fluid
leaving the vessel will be modeled. The following disengagement options are
available:

Option Description

Homogeneous Vapor fraction leaving vessel is the same as vapor fraction in vessel

All vapor All vapor leaving vessel

All liquid All liquid leaving vessel

Bubbly DIERS bubbly model

Churn-turbulent DIERS churn-turbulent model

User specified Homogeneous venting until vessel vapor fraction reaches the user-specified value, then
all vapor venting

To specify design parameters for your dynamic pressure relief scenario:

1. On the Pressure Relief DynamicInput Design Parameters sheet, first enter
the Maximum Allowable Working Pressure in the Vessel Design Pressure
frame.

2. In the MAWP Temperature field, enter the temperature corresponding to the
specified maximum allowable working pressure.

3. In the Vessel Disengagement frame, select a disengagement model from the
Disengagement Model list.

4. Enter any vessel disengagement parameters corresponding to the selected
disengagement model:

If you choose Enter

Bubbly Bubbly disengagement coefficient (default is 1.01)

Churn-turbulent Churn-Turbulent disengagement coefficient (default is 1)

User-specified Homogeneous vapor fraction limit (no default)
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Optionally, at the bottom of the sheet, you can enter the Volume of Vessel
Internals in the Vessel Dead Volume frame. This represents the volume of
internal structures such as mixers and baffles that will be subtracted from
the calculated vessel volume.

Fire

Use this sheet to characterize the fire engulfing the vessel. A Fire Standard must
be selected so that Aspen Plus can calculate the vessel wetted area, energy input,
and how the credit factor (Fire Credits sheet) is taken. Pressure Relief can base
its calculations on any of the following standards:
• NFPA 30
• API 520
• API 2000

Choose the desired standard from the Fire Standard list in the Fire Scenario
Parameters frame.

Optional specifications on the Fire sheet include:
• Fire duration
• Area of vessel surrounded by fire (relevant when Vessel Jacket or User

Specified is selected for vessel type on the Vessel sheet)
• Liquid level in the vessel at the start of the fire (for NFPA-30 fire standard

with Vessel Types of Horizontal, Vertical, API-Tank, or Heat Exchanger
Shell)

• Vessel elevation
• Extra heat transfer area
• Whether vessel is portable

The details of how wetted areas and energy inputs are calculated are described in
on-line help and in Aspen Plus Unit Operation Models.

Fire Credits

Pressure Relief assumes the calculated energy input is constant during the entire
venting transient. If appropriate, you can use the Fire Credits sheet to specify a
fire credit factor which Aspen Plus uses to reduce the energy input into the
vessel. You may specify a credit factor directly or allow Aspen Plus to calculate
the credit factor based on the presence of the following systems:
• Water spray equipment
• Drainage system
• Vessel insulation
• Both drainage and fire fighting equipment
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Credit for Drainage and Fire Fighting Equipment is not allowed unless Fire
Standard (Fire sheet) is API-520.

Insulation Protection Factor is not allowed when vessel is portable (Fire sheet),
Fire Standard (Fire sheet) is NFPA-30, or Credit for insulated vessel (Fire
Credits sheet) is not claimed.

The details of how credit factors are calculated are described in on-line help and
in Aspen Plus Unit Operation Models.

Heat Input

Use this sheet to specify the rate of heat input into the vessel, for dynamic heat
input scenarios. The method of heat input can be specified in three ways by
selecting one of the following options in the Heat Input Method frame on the
Heat Input sheet.
• Constant duty
• Calculated from heat source
• Time-varying duty profile

If a constant duty is chosen, simply enter the constant duty in the Heat Input
Method frame.

If you choose to calculate the duty from a heat source, you must specify the
temperature, heat transfer area, and heat transfer coefficient (U-value) in the
Heat Source frame.

If you choose to enter a time-varying duty profile, use the Duty Profile frame to
enter values of duty versus time.

Specifying Reactive Systems for Dynamic Scenarios
For the dynamic scenarios of fire or heat input, you can model a protected vessel
with reactions if the Vessel Type (DynamicInput Vessel sheet) is one of the
following:
• Vertical
• Horizontal
• API-Tank
• Sphere
• User-specified
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In the Reaction sheet of the Setup folder, specify which reactions occur within the
vessel. If there are any kinetic or equilibrium (other than electrolytic) type
reactions, you must create a Reaction ID through the Reactions folder of the Data
Browser. Electrolytic reactions specified through the Chemistry folder are
automatically included in the pressure relief calculations and need not be
specified in the Reactions sheet. See Chapter 27 for more information on how to
specify a Reaction ID.

To specify reactions to be used in a pressure relief calculation:

1. Make sure to select one of the dynamic scenarios (fire or heat input) on the
Setup Scenario sheet.

2. From the Pressure Relief Setup form, click the Reactions tab.

3. On the Reactions sheet, click the Include Chemical Reactions in Vessel check
box.

4. In the Vessel Reactions frame, select the desired reaction ID from the
Available list, and move them to the Selected list using the right arrow
button. To remove reactions from the Selected list, select them and click the
left arrow button. Use the double arrow buttons to move all reactions in a
selected list.

Specifying When to Stop Dynamic Calculations
When simulating the dynamic scenarios of fire or heat input, you must use the
Pressure Relief Operations form to describe the criteria that Aspen Plus will use
to terminate the dynamic simulation.
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On the Stop Criteria sheet of the Operations form, define one or more stop
criteria. You must define at least one stop criterion for the form to be complete. If
you define more than one stop criteria, the criterion reached first will end the
simulation.

You may select from the following variable types when defining a stop criterion:
• Simulation time
• Vapor fraction in the vessel
• Mole fraction of a specified component
• Mass fraction of a specified component
• Conversion of a specified component
• Total moles or moles of a specified component
• Total mass or mass of a specified component
• Vessel temperature
• Vessel pressure
• Vent mole flow rate or mole flow rate of a component
• Vent mass flow rate or mass flow rate of a component

You must:
• Select a specification type
• Enter a value for the specification at which the simulation will stop
• Select a component and substream for component-related specification types
• Specify which approach direction (above or below) to use in stopping the

simulation.

To specify when to stop calculations for dynamic pressure relief scenarios:
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1. Open the Pressure Relief Operations form.

2. On the Stop Criteria sheet, enter 1 in the Criterion No. field if this is the first
stop criterion. When entering multiple stop criteria, number them
sequentially, starting with 1.

3. From the Location list, choose a location (Vessel, Vent, or Vent Accumulator)
for calculating the variable that will be defined as the stop criterion.

4. In the Variable Type list, choose a stop criterion variable type from the list
shown above.

5. In the Stop Value field, enter the value of the variable at which to stop the
simulation.

6. For component-related specification types, select a component and a
substream from the Component ID list and the Substream ID list
respectively.

7. In the Approach From list, specify which approach direction (above or below)
to use in stopping the simulation.

8. Repeat steps 2 through 7 for each additional stop criterion.

9. When finished defining all stop criteria, click the Times tab.

10. On the Times sheet, specify an upper limit for the time of the scenario to be
simulated, in the Maximum Time field.

11. In the Time Intervals Between Result Points frame, enter the time interval to
report result for the scenario. Enter this value in the When Vent is Closed
field. Aspen Plus will report result profiles in the time interval you specify. If
you wish to use a different interval when the vent is open, enter this value in
the When Vent is Open field. If you do not enter a value for When Vent is
Open, the interval specified for When Vent is Closed will be used throughout
the entire scenario.

12. In the Optional frame at the bottom of the sheet, you can request to include
profile points when the relief system opens or closes. This option is checked
by default. Click this option to deselect it.

13. Also in the Optional frame, you can limit the maximum number of result
points in the profile by entering a value in the Maximum No. of Result Points
field. The default for this value is the specified maximum time divided by the
report time interval for results you have specified for When Vent is Closed.
If you have specified a results time interval for When Vent is Open that is
smaller than When Vent is Closed, you should increase the default value for
Maximum No. of Results Points.
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Examining Results of Pressure Relief
Calculations

To examine results of pressure relief calculations:

1. From the Data menu, point to Flowsheeting Options, then Pressure Relief.

2. On the Pressure Relief Object Manager, select the Pressure Relief ID of
interest, and click Edit.

3. In the left pane of the Data Browser, click the appropriate results form for
the selected Pressure Relief block.
For steady-state scenarios click the SteadyStateResults form.
For dynamic scenarios, click the DynamicResults form.

Steady-State Results
Use the SteadyStateResults form to view calculated results for steady state
simulations.

The SteadyStateResults form is comprised of two sheets:

Use this sheet To view

Summary Input summary, whether code requirements are met, and inlet and tail pipe pressure changes

Property Profiles Property profiles for points along the relief system

Summary

Use this sheet to view:
• Input summary (Scenario, Relief Device type, and Capacity option)
• Whether code requirements are met
• Actual flow rate through the emergency relief system as calculated by

Aspen Plus
• Estimated flow rate you provided on the Setup Scenario sheet.
• Actual and allowed pressure loss through the vessel neck and inlet pipes
• Actual and allowed backpressure in the tail pipes

If code requirements are not met, you should review the status messages. Your
system may not meet code requirements because:
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• Inlet pipe pressure loss is too high
• Tail pipe pressure loss is too high
• The 97% rule has been violated
• Choke point(s) do not occur at the relief device

For inlet piping, the actual (calculated) loss is the pressure loss through the
vessel neck and the inlet pipes computed at 10% overpressure. If this field is
blank, it means that the source pressure was greater than 10% overpressure. The
allowed pressure loss is the value calculated from the allowed inlet pipe pressure
loss as a percentage of differential set pressure as specified on the Setup Rules
sheet

For outlet piping, the actual (calculated) backpressure is computed at 10%
overpressure. If this field is blank, it means that the pressure was greater than
10% overpressure or the 97% rule was used instead. The allowed pressure loss is
the value computed from the maximum allowed percentage specified on the
Setup Rules sheet.

Property Profiles

Use this sheet to view property profiles for points along the emergency relief
system. The following properties are shown:
• Status (e.g., OK or Choked)
• Pressure
• Temperature
• Vapor Fraction

Dynamic Results
Use the DynamicResults form to view calculated results for dynamic simulations.
The DynamicResults form is comprised of seven sheets:

Use this sheet To view

Summary Input summary, whether code requirements are met, and inlet and tail pipe pressure changes

Parameters Summary of dynamic results and vessel pressures and temperatures

Vessel Vessel properties versus operation time

Vent Property profiles for points along the relief system versus operation time

Accumulator Accumulator properties versus operation time

X-Y-Z Vessel, vent, and accumulator mole fractions versus operation time

Vessel Mass Component mass amounts in vessel per substream versus operation time
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Each results sheet is discussed below.

Summary

Use this sheet to view:
• Input summary (Scenario, Relief Device type, and Capacity option)
• Whether code requirements are met
• Initial, final, maximum and allowed vessel pressures
• Initial, final, maximum and allowed vessel temperatures
• Actual and allowed pressure loss through the vessel neck and inlet pipes
• Actual and allowed backpressure in the tail pipes

If requirements are not met, you should review the status messages. If your
simulation fails to meet code requirements, possible causes are:
• Inlet pipe pressure loss at 10% over-pressure is too high
• Tail pipe pressure loss at 10% over-pressure is too high
• The 97% rule has been violated
• Choke point(s) do not occur at the relief device
• Vessel pressure goes above the maximum allowed

For inlet piping, the actual (calculated) loss is the pressure loss through the
vessel neck and the inlet pipes computed at 10% overpressure. If this field is
blank, it means that the source pressure was greater than 10% overpressure. The
allowed pressure loss is the value calculated from the allowed inlet pipe pressure
loss as a percentage of differential set pressure as specified on the Setup Rules
sheet

For outlet piping, the actual (calculated) backpressure is computed at 10%
overpressure. If this field is blank, it means that the pressure was greater than
10% overpressure or the 97% rule was used instead. The allowed pressure loss is
the value computed from the maximum allowed percentage specified on the
Setup Rules sheet

Parameters

Use this sheet to view:
• Operation time (the time for which the simulation ran)
• Calculated vessel volume
• Calculated vessel wetted area
• Fire heat input, based upon the wetted area and fire credit factors
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• Fire credit factor
• Vent maximum flow (the maximum flow rate through the emergency relief

system calculated during the simulation)

Allowed vessel conditions are based upon your input for vessel maximum
pressure on the Setup Rules sheet.

Vessel

This results sheet displays a table of vessel properties versus operation time. The
following vessel properties are shown:
• Status
• Vent flow
• Pressure
• Temperature
• Vapor fraction
• Total mass

The status column indicates where the choke is, if not at the device. Listed below
is an explanation of the possible status symbols:

Status Meaning

CL Vent closed

OK Acceptable choke location and pressure

N Choke at vessel neck

VF Choke at valve flange

I1 Choke at Inlet Pipe 1

I2 Choke at Inlet Pipe 2

T1 Choke at Tail Pipe 1

T2 Choke at Tail Pipe 2

SH Large static head

XT Excess tail pressure

Vent

This sheet lets you view profiles for points along the relief system versus
operation time for the following properties:
• Temperature
• Pressure
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• Vapor fraction
• Mass density

Accumulator

The Accumulator sheet lets you view accumulator properties versus operation
time. The following accumulator properties are shown:
• Pressure
• Temperature
• Vapor fraction
• Total mass in the accumulator

X-Y-Z

The X-Y-Z sheet lets you view component mole fractions versus operation time
for the following phases and locations:
• Overall contents of the vessel (Vessel Total)
• Vapor phase of vessel (Vessel Vapor)
• Overall contents of the relief system (Vent Total)
• Overall contents of the accumulator (Accumulator Total)
• Liquid phase of vessel (Vessel Liquid)

Vessel Mass

The Vessel sheet lets you view the component mass amounts in the vessel versus
operation time for the substream you select.
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Example of Dynamic Run of a Pressure Relief System

This example shows the results after a dynamic run of a pressure relief system. The first
screen shows the DynamicResults with the Summary sheet displayed:

This plot shows vessel pressure and temperature over time:
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34 Inserts

An insert is a partial backup file that you can import into a run at any time.
Aspen Plus provides special data packages as inserts which can be used as
starting points for building new simulations, or they can be imported into
existing simulations. You can create your own inserts for later use.

This chapter discusses this use of files including:
• What is an insert?
• Creating an insert
• Importing inserts
• Creating a property package
• Resolving ID conflicts
• Using electrolyte inserts from the Aspen Plus insert library
• Hiding objects

Creating an Insert

You can use an insert to create a:
• Property package, consisting of component and property definitions
• Standard process unit, such as a crude column and its preheat train

You can create your own inserts, or you can import inserts from the Aspen Plus
library of inserts. For more information, see Using Electrolyte Inserts From the
Aspen Plus Insert Library on page 34-6.

To create an insert, you need to save a backup file containing the information you
want in your insert:
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1. Begin with a run that has all of the input for the insert defined. (The run does
not have to be complete.) This can consist of any possible simulation input
such as components, properties, streams, blocks, flowsheeting options, model
analysis tools, etc.

2. From the File menu, click Export.

3. In the Save As Type box, select Aspen Plus Backup Files (*.bkp).

4. Enter a path and a filename for the backup file that you want to contain the
insert.

5. Click Save.
You can import the backup file you created into any run.

Importing Inserts
To import an insert into an existing Aspen Plus simulation:

1. With the existing simulation active in the Aspen Plus main window, from the
File menu, click Import.

2. In the Save As Type box, select Aspen Plus Backup Files (*.bkp).

3. On the Import dialog box, locate the insert, select it, and click Open.

4. If the Resolve ID Conflicts dialog box appears, see Resolving ID Conflicts on
page 34-2.
After importing the insert into your existing run, your simulation will contain
the input from both files.

Resolving ID Conflicts
When you import one file into another, some imported objects may have the same
IDs as objects in the existing run. When this happens, Aspen Plus displays the
Resolve ID Conflicts dialog box, which lists all objects that have matching IDs in
the two files.
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Use the Resolve ID Conflicts dialog box to resolve ID conflicts by one of the
following methods:

Method Procedure

Replace existing objects 1. Select one or more objects.
2. Click Replace.
Aspen Plus deletes the objects in the current run and replaces them
with the objects being imported.

Merge new objects with existing
objects

1. Select one or more objects.
2. Click Merge.
Aspen Plus merges specifications for inserted objects with those of
objects in the current run. If both objects have values for the same
specification, the inserted object overrides the object in the current run.

Edit IDs directly 1. Select one object at a time.
2. Click Edit ID.
3. In the Object Name dialog box, specify a new ID for the object.

Add a prefix or suffix to the
existing IDs

1. Select one or more objects.
2. Click Add Prefix or Add Suffix.
3. In the Prefix (or Suffix) dialog box, enter characters to be added to the IDs in the existing run.

Delete imported objects 1. Select one or more objects.
2. Click Delete.
Aspen Plus deletes the selected objects from the imported run,
leaving those objects in the existing run unchanged.

When finished resolving each ID conflict, click OK.

Merged objects must be of the same type. For example, you can merge two
RadFrac blocks, but not a RadFrac block with a Flash2 block.

Example of Importing an Insert and Resolving ID Conflicts

Simulate a distillation column with two different feeds in the same run. The
distillation column specifications are identical.

1. Create the flowsheet for the first feed and complete all specifications for the
problem.

2. From the File menu, click Save As.

3. In the Save As Type box, specify Aspen Plus Backup Files (*.bkp).  Specify a
name for the file in the File Name box. Click OK.

4. From the File menu, click Import.

5. In the Files of Type box, select Aspen Plus Backup Files (*.bkp).  Locate and
select the file you just saved. Click OK.

6. In the Resolve ID conflicts dialog box, select the block and streams. Hold
down the Ctrl key while clicking on each item. Then click Add Suffix.
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7. In the Suffix dialog box, enter -2, and click OK.

8. The Resolve ID Conflicts dialog box now shows the new IDs for the inserted
objects.

9. Select all the remaining objects in the Resolve ID Conflicts dialog box and
click Delete.

10. In the Resolve ID Conflicts dialog box, click OK.
Aspen Plus adds the new block, and streams to the flowsheet.

Example of Copying a Block from One Run to Another

This example assumes that two runs have identical Sep2 component splitters. The block ID
and the inlet and outlet stream IDs for Sep2 are the same in both runs. Replace Sep2 with an
identical RadFrac rigorous distillation model in both runs.

1. Replace Sep2 with RadFrac in the first run, and complete the specifications.

2. From the File menu, click Save As and save the file as an Aspen Plus Backup
File (*.bkp).

3. Open the second run.

4. From the File menu, click Import. Select the file you saved in step 2 and click
OK.

5. In the Resolve ID Conflicts dialog box, select the RadFrac block and all the
streams listed. Click on the Replace button.

6. Select all the remaining objects in the Resolve ID Conflicts dialog box and
click Delete.

7. In the Resolve ID Conflicts dialog box, click OK.
The new RadFrac block, with all of its specifications, now replaces the Sep2
block in the flowsheet.

Creating a Property Package

To create a property package:

1. Begin with a run that has all of the input for the property package defined,
including all components and properties specifications. (The run does not
have to be complete.)
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Typically this would include:
• Components specifications
• Henry-Comps specifications, if defined
• Chemistry specifications, if defined
• Properties specifications
• Property method definitions other than built-in property methods
• Any Properties Parameters objects with data specified
• Any units sets, other than SI, MET, or ENG, used by any of the forms in

the property package
• Any property sets you want to include

2. From the File menu, click Export.

3. In the Export dialog box, enter a path and a filename for the backup file that
you want to contain the property package.

4. Click Save.
You can import the backup file you created into any run.

For example, suppose you develop a property package for ethanol-water using the
NRTL property method. Specify the following information in Aspen Plus, and
save the specifications as a backup file:
• Components Specifications Selection sheet
• Properties Specifications Global sheet
• Properties Parameters Binary Interaction NRTL-1 form

Using Electrolyte Inserts From the Aspen
Plus Insert Library

To use an insert from the Aspen Plus library:

1. From the File menu, click Import.

2. On the Import dialog box, click the Favorites button on the toolbar.

3. In the Favorites folder, double-click the Elecins folder.

4. Select an insert from the list and click Open.

5. If the Resolve ID Conflicts dialog box appears, see Resolving ID Conflicts on
page 34-2.
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Tip  To see a description on the insert, use the Preview button on the Import
dialog box toolbar.
Tip  To view in detail the contents of an insert before using it, follow the
procedure above, except open the insert using File Open, instead of File
Import. Then use the Data Browser to see what input is defined in the insert
and to look at the insert contents.

Hiding Objects

You can use the Hide feature to temporarily remove optional objects from a
simulation, without deleting them. For example, you can hide a design
specification when you don't want it to be applied to the simulation.

You cannot hide:
• Global specifications, such as the Setup Specifications and Properties

Specifications forms
• Components
• Blocks and streams
• Properties Parameters and Molecular Structure objects

To hide objects:

1. Display the Object Manager for the type of object you want to hide.

2. Select one or more objects you want to hide. If the Hide button is dim, you
cannot hide this type of object.

3. Click the Hide button.
Aspen Plus removes the selected objects from the Object Manager list. They
are no longer part of the problem definition.

Revealing Objects
To reveal (unhide) objects:

1. Open the Object Manager for the type of object you want to reveal.

2. Click the Reveal button.
Note  The Reveal button will only be active if there are hidden objects.

3. On the Reveal dialog box, select the hidden objects you want to reveal, and
click OK.
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If there are no ID conflicts, Aspen Plus restores the objects to the problem
definition, and they are displayed on the Object Manager.
If the specifications for a hidden object are inconsistent with the current
problem definition (for example, if a referenced stream no longer exists), the
object will be incomplete. Use Next to find out what you must do to complete
the input.
If there are ID conflicts (if a hidden object has the same ID as an object in the
current problem definition), the Resolve ID Conflicts dialog box appears.
Tip  Use the Remove button on the Reveal dialog box to permanently delete
hidden objects from the simulation.

❖     ❖     ❖     ❖ 
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35 Creating Stream
Libraries

This chapter describes how to create stream libraries. For information on how to
retrieve information from a stream library for use in a simulation, see Chapter 9.
• Creating or modifying a stream library
• STRLIB command summary
• Description of STRLIB commands

You can retrieve information about stream composition and conditions from a
stream library, instead of entering this data on stream forms.

This table shows what you can do with the stream library capability:

To Do This

Create a library of frequently
used feed streams

Store the composition and conditions of frequently used feed streams
in a stream library. Retrieve this information from different models in
a simulation without re-entering it.

Transfer stream information from
one simulation to another

Simulate one section of your flowsheet, store the outlet streams in a library,
and retrieve the information in another simulation.
Or use a stream library to share information between two groups
that are simulating different sections of a process.

Initialize tear streams Store final tear stream values from a simulation in a library.
When you simulate another case, retrieve the desired values as an initial guess
for the tear stream. If you do not know which stream will be chosen
as the tear stream, store all the streams from the first simulation
and retrieve all the streams in the new run.

Isolate a block from a large
flowsheet

Store streams for a large flowsheet in a library.
Retrieve and analyze one block from the stored flowsheet and
simulate the block by itself, perhaps with higher diagnostics or
at different conditions. This eliminates re-entering the stream information
for the isolated block run.
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Creating or Modifying a Stream Library

You can:
• Create your own stream library
• Use a stream library created and maintained by your Aspen Plus system

administrator

To create or modify a stream library, use STRLIB, a program delivered with
Aspen Plus. Every Aspen Plus run produces a summary file, which contains all
the results of the simulation. STRLIB copies stream results from an Aspen Plus
summary file into a stream library. You can store data from any number of
Aspen Plus runs in one stream library.

A stream library is organized in cases. You identify a stream by the:
• Stream name
• Case to which it belongs

Each case usually corresponds to one Aspen Plus run. However, you can store
streams from more than one Aspen Plus run in a single case. You can also store
data from a single run in several cases.

Using STRLIB, you enter commands to create or modify a stream library. The
most common use of STRLIB involves these steps:

1. Opening a summary file using the OPEN command.

2. Establishing the case where you want to copy streams, using the OPEN or
CASE commands.

3. Adding or replacing streams in the library, using the ADD or REPLACE
commands.

Running STRLIB Interactively
To run STRLIB interactively, enter this command at the operating system
prompt:

strlib libname

Where libname is the stream library you want to create or modify. The stream
library name can be up to eight characters long.
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Library files have the extension *.slb.

When the STRLIB> prompt appears, you can enter commands.

STRLIB prompts you for each command.

Running STRLIB in Batch Mode
You can run STRLIB non-interactively to create or update a stream library.
Running STRLIB in batch mode automatically adds all the streams from the
summary file produced by an Aspen Plus run.

To run STRLIB in batch mode, enter this command at the operating system
prompt:

STRLIB libname runid [case]

libname is the name of the library you want to create or modify. If the library
does not exist, it will be created and initialized to contain 10 cases.

runid is the name of the Aspen Plus summary file from which you want to
transfer streams.

case is the case name where you want to add streams. If you do not specify the
case name, STRLIB uses the runid from the summary file as the case name.

The batch mode STRLIB command is equivalent to the following sequence of
commands when you run STRLIB interactively:
STRLIB> OPEN runid [case]
STRLIB> ADD ALL
STRLIB> EXIT

STRLIB CommandSummary

This table lists a summary of the commands you can use in STRLIB. The
commands are described in more detail in this chapter.

You can abbreviate any STRLIB command. Enter all commands at the STRLIB>
prompt, typing enough letters to identify the command as unique. The first one
or two letters are usually enough.
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STRLIB Commands

Command Description

ADD Add a stream to the library.

CASE Change the current case.

DELCASE Delete a case from the library.

DELSTREAM Delete a stream from the library.

DIRECTORY List the cases in the library and the streams in a case.

DUMP Write stream information to a file.

END End STRLIB and update the library.

EXIT End STRLIB and update the library.

HELP Display interactive help on STRLIB commands.

INITIALIZE Initialize a library.

LIST List streams in the summary file.

LOAD Load stream information from a dump file.

OPEN Open a summary file.

PACK Pack (compress) the library.

RENAME Rename a stream in the library.

REPLACE Replace a stream in the library.

QUIT End STRLIB without updating the library.

Description of STRLIB Commands

ADD

The ADD command copies a stream from an Aspen Plus summary file to the
library. The stream to be copied must not already exist in the current case of the
library. (Use the REPLACE command to replace streams that already exist.)

Specify ADD ALL to copy all streams from a summary file to the library.

Syntax:

ADD  
stream ID

ALL
−
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CASE

The CASE command changes the current case. Streams in the stream library are
organized into cases. You establish a case when you open a summary file (using
the OPEN command) or when you use the CASE command. For more information
about cases, see Creating or Modifying a Stream Library on page 35-2.

The ADD, DELSTREAM, DUMP, RENAME, and REPLACE commands apply to
streams in the current case.

Syntax:

CASE     casename

DELCASE

The DELCASE command deletes a case from the library. All streams in the case
are deleted.

Syntax:

DELCASE   casename

DELSTREAM

The DELSTREAM command deletes a stream from the current case.

If you delete many streams from a library, you should use the PACK command to
recover the deleted space. See the PACK command description, this section.

Syntax:

DELSTREAM   stream-id

DIRECTORY

The DIRECTORY command lists the cases and streams stored in the stream
library. If you do not specify a case in the DIRECTORY command, STRLIB lists
all the cases in the library and the number of streams in each case. If you specify
a case, STRLIB lists only the streams in that case.

Syntax:

DIRECTORY   [casename]
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DUMP

The DUMP command writes the information about a stream stored in the
library. STRLIB prompts you to specify whether you want to write to the
terminal or to a file. If you write to a file, STRLIB prompts you for the filename.
Specify DUMP ALL to dump all streams from all cases in a library.

Use DUMP if you want to:
• View the information for a stream
• Transfer information from one library to another

If you need to reinitialize a library to increase the maximum number of cases
that can be stored, use the DUMP ALL command first to save the contents of the
library. To restore the information, use the LOAD command.

Syntax:

DUMP  
stream ID

ALL
−�

�
�

�
�

END

The END command ends the STRLIB session. The stream library is updated
with all the changes you made during the session. The END and EXIT commands
are synonymous. (Use the QUIT command to end STRLIB without updating the
library, so changes made during the session are not saved.)

Syntax:

END

EXIT

The EXIT command ends the STRLIB session. The stream library is updated
with all changes you made during the session. The END and EXIT commands are
synonymous. (Use the QUIT command to end STRLIB without updating the
library, so changes made during the session are not saved.)

Syntax:

EXIT
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HELP

The HELP command activates the interactive help system, so you can obtain
help for STRLIB commands.

Syntax:

HELP   [command]

INITIALIZE

The INITIALIZE command destroys all data in a stream library. Use it only
when creating a library or after using the DUMP ALL command.

The INITIALIZE command initializes a new stream library. You must specify the
maximum number of cases the library will contain. Enter the INITIALIZE
command before performing any operations on a new stream library.

Syntax:

INITIALIZE   numcase

LIST

The LIST command lists the streams in the current summary file.

Syntax:

LIST

LOAD

The LOAD command loads information from a dump file created with the DUMP
command. STRLIB loads all cases and streams.

Syntax:

LOAD   filename

OPEN

The OPEN command opens a summary file, so that streams from an Aspen Plus
run can be transferred to the library. If you do not specify a case name, STRLIB
uses the RUNID from the summary file as the case name.

Syntax:

OPEN   filename   [casename]
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PACK

The PACK command packs the stream library to recover blank spaces created
when streams are deleted. The PACK command is necessary only if you delete
many streams from a library and want to recover unused file space.

Syntax:

PACK

RENAME

The RENAME command renames a stream in the library. RENAME applies only
to the current case.

Syntax:

RENAME   oldname   newname

REPLACE

The REPLACE command replaces a stream in the current case with a stream of
the same name from a summary file. If the stream does not exist in the library,
STRLIB adds it.

Specify REPLACE ALL to copy all streams from a summary file to the library,
overwriting any streams of the same name that exist in the library.

Syntax:

REPLACE  
stream ID

ALL
−�

�
�

�
�

QUIT

The QUIT command ends the STRLIB session. The stream library is not updated
with any changes made during the current STRLIB session. (Use the END or
EXIT commands to end STRLIB and update the stream library with the changes
made during the session.)

Syntax:

QUIT
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Example of Creating a Library with Two Cases

Create a stream library that can contain two cases. Add streams S1 and S2 from
summary file RUN1. Also add all the streams from summary file RUN2.
STRLIB> INITIALIZE 2
STRLIB> OPEN RUN1.SUM
STRLIB> ADD S1
STRLIB> ADD S2
STRLIB> OPEN RUN2.SUM
STRLIB> ADD ALL
STRLIB> END

The library will be organized in two cases, RUN1 and RUN2.

Example of Creating a Library with One Case

Create a stream library that can hold five cases. Create one case, PROJECT. Add
streams PROD1 and PROD2 from summary file RUN1, and stream FEED1 from
summary file RUN2.
STRLIB> INITIALIZE 5
STRLIB> OPEN RUN1.SUM
STRLIB> CASE PROJECT
STRLIB> ADD PROD1
STRLIB> ADD PROD2
STRLIB> OPEN RUN2.SUM
STRLIB> CASE PROJECT
STRLIB> ADD FEED1
STRLIB> END

The OPEN command creates a new case if a case name is not specified. The
library must be initialized to hold at least three cases. The preceding set of
commands will create two empty cases named RUN1 and RUN2.

To avoid creating the empty cases, use the case name in the OPEN command.
STRLIB> INITIALIZE 5
STRLIB> OPEN RUN1.SUM PROJECT
STRLIB> ADD PROD1
STRLIB> ADD PROD2
STRLIB> OPEN RUN2.SUM PROJECT
STRLIB> ADD FEED1
STRLIB> END



Creating
Stream
Libraries

35-10 Aspen Plus User Guide
Version 10.2

❖     ❖     ❖     ❖ 



Chapter  36

Aspen Plus User Guide 36-1
Version 10.2

36 Stream Summary
Formats

Aspen Plus allows you to customize stream reports and tables using Table Format
Files (TFFs). Using TFF language, you can customize the:
• Results Summary Streams form and block StreamResult sheets to your own

format, for analyzing your simulation results
• Stream table in a process flow diagram (PFD), to meet your company's

standards

A Table Format File contains easy-to-understand language that you can use to:
• Display a selected list of stream properties of interest, in a specified order
• Add or change labels for stream properties
• Manipulate the format of stream property values (for example, scaling,

normalization, units conversion, and trace cut-off)

This chapter explains how to create and use TFFs. Sample TFFs are provided.
Read this chapter if you plan to customize your stream summary form or the
stream table in your process flow diagram (PFD).

Topics include:
• About the Aspen Plus TFFs
• Creating a TFF
• Basic Stream Result Properties
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About the Aspen Plus TFFs

Aspen Plus provides several Table Format Files in your system directory. If you
installed Aspen Plus in the default directory, your system directory is Program
Files\AP10UI\xeq.

By default Aspen Plus displays the stream summary and stream table based on the
built-in TFF for the Application Type you chose when creating your simulation.

Choose a stream format to display your stream report from:
• The Stream Format fields on the Setup Specifications Stream Report
• The Format field on the ResultsSummary Streams Material sheet or the

block StreamResults Material sheet

All of the TFF files located in either the system directory or in the working
directory are displayed in the list. You can modify any Aspen Plus TFF or create
your own. TFF files should be placed either in your working directory or in the
system directory.

Aspen Plus uses the TFF you select in either field for all Results Summary
Streams sheets you display, until you select another TFF.

To select a stream format:

1. Move to the Stream Format field of the Setup Specifications Stream Report
sheet, the ResultsSummary Streams Material sheet, or the block
StreamResults Material sheet.

2. Click the list and scroll through the options, looking at the descriptions of
each TFF.

3. Select a TFF. If you are using built-in TFFs, it is recommended that you
select one of the TFFs for your Application Type. For example, if you are
using one of the Petroleum Application Types, choose a TFF beginning with
Petro.

It is not necessary to re-run the simulation in order to see the results in another
format.
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Creating a TFF
You can:
• Edit the TFFs provided with Aspen Plus to customize your stream summary

and stream tables. These files are located in the Program Files\AP10UI\xeq
directory if you installed Aspen Plus in the default directory.

• Use TFF language to create your own TFF.

The sections that follow describe how to edit or create a new TFF. You may also
want to refer to the example TFFs included at the end of the chapter.

TFF File Format and Options
Use TFF language to customize your stream summary or stream table. Follow
these rules:
• TFF sentences are not case sensitive.
• Any line beginning with a semi-colon in column 1 is treated as a comment

line.
• The ampersand (&) is used to continue a line.

The format for the TFF and a description of the format follow.

TITLE = value
STREAMS=value
STREAM-ID-LABEL = value
SOURCE-LABEL = value
DEST-LABEL = value
PHASE-LABEL = value
BEGLOOP    SUBSTREAM = value
ENDLOOP
DISPLAY qualifier optional qualifier=value     option=value

Qualifiers:
ALL    ONLY     REMAIN
Optional qualifiers:
SUBSTREAM   COMPS    PHASE     BASIS     TEMP     PRES     LVPCT     COMP-ATTR
SUBS-ATTR
Options:
FORMAT PPM     PPB     TRACE     TRACE-LABEL     ZERO-LABEL     MISSING-LABEL
PROP-HEADER     COMPS-HEADER     SUBSTREAM-HEADER     PB-HEADER
TEMP-HEADER     PRES-HEADER     LVPCT-HEADER     COMP-ATTR-HEADER
SUBS-ATTR-HEADER     COMP-ATTR-ELEM     SUBS-ATTR-ELEM

PROP     prop-name     qualifier=value     option=value
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Optional qualifiers:
SUBSTREAM     COMPS     PHASE     BASIS     TEMP     PRES     LVPCT
COMP-ATTR     SUBS-ATTR
Options:
FORMAT     PROP-LABEL     UNITS     UNITS-LABEL     NORMALIZE     SCALE
SCALE-LABEL     PPM     PPB     TRACE     TRACE-LABEL     ZERO-LABEL
MISSING-LABEL     MW     BP     MW-BP-FORMAT     HEADER     PROP-HEADER
COMPS-HEADER     SUBSTREAM-HEADER     PB-HEADER     TEMP-HEADER
PRES-HEADER     LVPCT-HEADER     COMP-ATTR-HEADER     SUBS-ATTR-HEADER
COMP-ATTR-ELEM     SUBS-ATTR-ELEM

TEXT "Text enclosed in double quotes"

TFF Sentences
This section describes each sentence that you can use in a TFF.

TITLE Title for the stream table. The TITLE line must be the first non-comment line in the TFF. If you
choose to wrap the stream table, TITLE is not repeated. TITLE is not displayed in the Results
Summary Streams form.

TITLE=YES ..................... The title you specified on the Setup Specifications form is used. If no title
is specified on Setup Specifications, the title Heat and Material Balance
Table is used.

TITLE=NO ....................... No title is displayed. (Default)

TITLE="string" ............... The string (up to 64 characters) enclosed in double quotes is used as the
title for the stream table.

STREAMS Use to define a set of streams and their order on the Results Summary Streams form and in the
stream table.

STREAMS=sid-list.......... List of stream IDs

If the STREAMS statement is not in your TFF, all streams are displayed
in alphanumeric order. (Default)

You can interactively select the streams and the order they are displayed
on the Results Summary Streams form.

STREAM-ID-LABEL Label for the stream ID row in the stream table. See Header Sentence Order in the Stream Table,
this chapter.

STREAM-ID-LABEL=......
YES

The label Stream ID is used.

STREAM-ID-LABEL=NO The Stream ID row is not displayed. (Default)

STREAM-ID-LABEL=......
"string"

The string (up to 20 characters) in double quotes is used as the label.
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SOURCE-LABEL Label for the source block row in the stream table. See Header Sentence Order in the Stream Table,
this chapter.

SOURCE-LABEL=YES ... The label From is used.

SOURCE-LABEL=NO ..... The source block row is not displayed. (Default)

SOURCE-
LABEL="string"..............

The string (up to 20 characters) enclosed in double quotes is used as the
label.

DEST-LABEL Label for the destination block row in the stream table. See Header Sentence Order in the Stream
Table, this chapter.

DEST-LABEL=YES ......... The label To is used.

DEST-LABEL=NO........... The destination block row is not displayed. (Default)

DEST-LABEL="string"... The string (up to 20 characters) enclosed in double quotes is used as the
label.

PHASE-LABEL Label for the phase row for the MIXED substream. See Header Sentence Order in the Stream
Table, this chapter.

PHASE-LABEL=YES ...... The label Phase is used.

PHASE-LABEL=NO ........ The phase row is not displayed. (Default)

PHASE-LABEL="string" The string (up to 20 characters) enclosed in double quotes is used as the
label.

BEGLOOP, ENDLOOP Optional sentences that enable you to control the display of properties when there are two or more
substreams. You can define groups of DISPLAY sentences by enclosing them between pairs of
BEGLOOP and ENDLOOP sentences. Aspen Plus displays properties specified by the enclosed
DISPLAY sentence for one substream at a time, looping through all requested substreams.

SUBSTREAM .................. List of substreams to loop through

SUBSTREAM=ssid-list... List of substream IDs

SUBSTREAM=ALL ......... All substreams

DISPLAY Used to control the display of the stream properties. DISPLAY is usually used in conjunction with
one or more PROP sentences. PROP sentences can control the order and display of individual
properties. You can have any number of DISPLAY sentences in a TFF.

DISPLAY ALL.................. Display all stream properties identified by the specified qualifiers. (See
Qualifier Descriptions for DISPLAY and PROP, this chapter.) Use the
format described by the options. (See Option Descriptions for DISPLAY
and PROP, this chapter.)

DISPLAY ONLY............... Display only the stream properties specified by the PROP sentences
following the DISPLAY ONLY sentence. Use the order of the PROP
sentences, with the specified qualifiers and options.

DISPLAY REMAIN .......... Display the remaining stream properties (those not already specified by
DISPLAY or PROP sentences). Identify stream properties by the specified
qualifiers, in the format described by the options.
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PROP Used to control the display of an individual property. When used in conjunction with
DISPLAY ONLY, PROP sentences specify the order in which the properties are displayed. See
Qualifier Descriptions for DISPLAY and PROP, and Option Descriptions for DISPLAY and PROP,
this chapter.

prop-name ...................... Stream property. This is the Prop-Set name for a stream property (for
example, MOLEFLMX for total mole flow). Prop-Set names are listed in
the Property field on the Prop-Sets form. A property  displayed in the
stream summary or a stream table must be one of the basic stream result
properties listed in the table on page 36-7 , or the property must be
included in a prop-set ID in the Property sets field on the Setup
Specification Stream Report form. All such properties appear in standard
stream reports for your run.

If your TFF requests a stream property that is not in listed in the table or
included in a prop-set ID, Aspen Plus does not display the property.

The options specified with the PROP sentence are combined with the DISPLAY options when
Aspen Plus displays the properties. If the same option is specified for PROP and the preceding
DISPLAY sentence, the PROP specification is used.

TEXT Allows you to insert a text line within the side label of your stream table. Enclose text in double
quotes. To insert a blank line, use a pair of double quotes with a space between them.
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The following table lists the basic stream result properties.

Basic Stream Result Properties

Prop-Name Description

MOLEFLOW† Component mole flow

MASSFLOW† Component mass flow

VLSTD† Component standard volume flow

MOLEFRAC† Component mole fraction

MASSFRAC† Component mass fraction

VLSTDFR† Component standard volume fraction

MOLEFLMX Total mole flow

MASSFLMX Total mass flow

VOLFLMX Total volume flow

TEMP Temperature

PRES Pressure

VFRAC Vapor fraction

LFRAC Liquid fraction

SFRAC Solid fraction

HMX Enthalpy (in mole, mass, and flow basis)

SMX Entropy (in mole and mass basis)

RHOMX Density (in mole and mass basis)

MWMX Average molecular weight

COMP-ATTR Component attributes

SUBS-ATTR Substream attributes

CMASS_TIME†† Component mass flow rate during actual operation

CMOLE_TIME†† Component mole flow rate during actual operation

CVOL_TIME†† Component standard volume flow rate during actual operation

CMASS_CYCLE†† Component mass per cycle

CMOLE_CYCLE†† Component mole per cycle

CVOL_CYCLE†† Component standard volume per cycle

CYCLE_TIME†† Cycle time

OPER_TIME†† Operation time
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Basic Stream Result Properties (continued)

Prop-Name Description

NTRAIN†† Number of trains

MASS_TIME†† Total mass flow rate during actual operation

MOLE_TIME†† Total mole flow rate during actual operation

VOL_TIME†† Total volume flow rate during actual operation

ENTH_TIME†† Total enthalpy flow rate during actual operation

MASS_CYCLE†† Total mass per cycle

MOLE_CYCLE†† Total mole per cycle

VOL_CYCLE†† Total volume per cycle

ENTH_CYCLE†† Total enthalpy per cycle

†
Property is available if the corresponding option is selected on the Setup.Main form.

††
Batch stream properties. Displayed only if you use the Report.Batch-Operation form.

Qualifier Descriptions for DISPLAY and PROP
This section describes the qualifiers you can use in both DISPLAY and PROP
sentences. You can think of the combined DISPLAY and PROP qualifiers as a
property filter. Any property in the stream report that passes the filter is
displayed.

The qualifiers listed are all possible specifications for a Prop-Set property, except
UNITS. See Option Descriptions for DISPLAY or PROP, this chapter. The only
qualifiers that apply to the basic stream report properties are SUBSTREAM and
COMPS. The basic stream result properties do not display if the PHASE or
BASIS qualifiers are set to any value other than the default (ALL).

SUBSTREAM .................. Substreams for which the property is to be displayed

SUBSTREAM=ssid-list... List of substream IDs

SUBSTREAM=ALL.......... All substreams (Default)

COMPS............................ Components for which the property is to be displayed

COMPS=cid-list .............. List of component IDs

COMPS=ALL................... All components (Default)
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PHASE............................. Phase for which the property is to be displayed

PHASE=V ........................ Vapor

PHASE=L......................... Total liquid

PHASE=L1....................... 1st liquid

PHASE=L2....................... 2nd liquid

PHASE=S ........................ Solid

PHASE=T......................... Total mixture

PHASE=ALL.................... All phases of the property in the stream report
(Default)

BASIS .............................. Basis for which the property is to be displayed

BASIS=WET .................... Includes water

BASIS=DRY..................... Excludes water

BASIS=ALL ..................... All bases of the property in the stream report
(Default)

TEMP............................... Temperatures for which the property is to be displayed

TEMP=list........................ List of temperatures

TEMP=ALL ...................... All temperature values of the property in the
stream report (Default)

PRES ............................... Pressures for which the property is to be displayed

PRES=list ........................ List of pressures

PRES=ALL ...................... All pressure values of the property in the
stream report (Default)

LVPCT ............................. Liquid volume percents for which the property is to be displayed

LVPCT=list ...................... List of liquid volume percents

LVPCT=ALL .................... All liquid volume percent property values in the
stream report (Default)

COMP-ATTR.................... Component attributes to be displayed

COMP-ATTR=cattr-list ... List of component attributes

COMP-ATTR=ALL........... All component attributes (Default)

SUBS-ATTR .................... Substream attributes to be displayed

SUBS-ATTR=sattr-list .... List of substream attributes

SUBS-ATTR=ALL ........... All substream attributes (Default)

Option Descriptions for DISPLAY and PROP
This section describes the options for the DISPLAY and PROP sentences. These
options control the display, side label, and units of a property value.
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FORMAT ......................... Stream property value display format string, enclosed in double quotes.
(Default=customized G format designed to show maximum precision) See
Formats for Numbers, this chapter. Applies to both DISPLAY and PROP
sentences.

PROP-LABEL ................. Stream property label to override the Aspen Plus property label.  Can be
used, for example, to replace the Aspen Plus property name MUMX with
the label Viscosity. Applies to PROP sentence only. May be truncated in
the stream summary, but displays in full in the stream tables.

UNITS.............................. Stream property value units of measurement (Setup.Units-Set1,
Setup.Units-Set2 and Setup.Units-Set3 forms), enclosed in double quotes.
Property value is converted to your specifications. A stream property may
be available in more than one type of unit. For example, enthalpy for a
stream may have units-types of mole-enthalpy, mass-enthalpy, and
enthalpy-flow. In this case the specified units define both the units and
the units types to be displayed. If no units are specified, the stream
property is displayed in all available units types. The units specification
is overridden if you select a units-set on the Results Summary Streams
form, but the units-types selection is sustained. Applies to PROP only.
(Default=global out-units for basic stream result properties and local
units for each additional prop-set).

UNITS-LABEL................. Label for units of measurement. The Units label is a character string
enclosed in double quotes. Overrides the Aspen Plus Units label.  Can be
used, for example, to print the units label in lowercase characters.
Applies to PROP sentence only, and only if the UNITS qualifier is used.

NORMALIZE ................... Normalization flag for component flow or fraction properties

NORMALIZE=YES .......... Normalize property values. See The
NORMALIZE Option, this chapter.

NORMALIZE=NO ............ Do not normalize values. (Default)

Applies to DISPLAY and PROP sentences

SCALE............................. Scale factor. Property value is divided by scale factor before it is
displayed. Used to reduce the magnitude of printed values. You must also
specify SCALE-LABEL. Applies to PROP sentence only.

SCALE-LABEL................ Scale factor label enclosed in double quotes. Appears in front of the units
label or UNITS-LABEL you supply. Applies to PROP sentence only.

PPM................................. Parts per million cut-off value. Property values below the specified
number are displayed as PPM. For example, if you specify PPM=1E-3,
any property values smaller than 0.001 are displayed as 1 PPM to 999
PPM. Applies only to component flow or fraction properties. See The
NORMALIZE Option and PPM, PPB and TRACE Options, this chapter.
Applies to both DISPLAY and PROP sentences.

PPB ................................. Parts per billion cut-off value. Property values below the specified
number are displayed as PPB. For example, by specifying PPB=1E-6,
property values smaller than 0.000001 are displayed as 1 PPB to 999
PPB. Applies only to component flow or fraction properties. See The
NORMALIZE Option and PPM, PPB, and TRACE Options, this chapter.
Applies to both DISPLAY and PROP sentences.

TRACE ............................ Trace cut-off value. Property values smaller than the specified cut-off
value are not displayed. The character string specified by TRACE-LABEL
is displayed instead. Applies to both DISPLAY and PROP sentences. See
PPM, PPB, and TRACE Options, this chapter.
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TRACE-LABEL................ Trace symbol for displaying trace value, enclosed in double quotes
(Default=blank). Applies to both DISPLAY and PROP sentences.

ZERO-LABEL.................. Label for zero value enclosed in double quotes (Default=0.0). Applies to
both DISPLAY and PROP sentences.

MISSING-LABEL............. Label for property values not calculated, enclosed in double quotes
(Default=blank). Applies to both DISPLAY and PROP sentences.

MW................................... Molecular weight display. Applies to component-dependent properties
only. Displays in the units column in the stream summary or stream
table.

MW=YES ......................... Display molecular weight next to the
component ID.

MW=NO ........................... Do not display molecular weight. (Default)

Applies to PROP sentence only.

BP.................................... Boiling point display. Applies to component-dependent properties only.
Displays in the units column in the stream summary or stream table.

BP=YES........................... Display boiling point next to the component ID.

BP=NO............................. Do not display boiling point. (Default)

Applies to PROP sentence only.

MW-BP-FORMAT............ Molecular weight or boiling point format string, enclosed in double quotes
(Default=%.0f). See Formats for Numbers, this chapter. Used when
MW=YES or BP=YES.

Applies to PROP sentence only.

HEADER.......................... Header above a property

HEADER="string"........... The specified string of up to 20 characters is
displayed in the line above the property side
label. (Default: no header)

Applies to PROP sentence only.

PROP-HEADER............... Property header

PROP-HEADER=YES...... Property label is displayed. (Default)

PROP-HEADER=NO ....... Property label is not displayed.

PROP-HEADER=.............
"string"

The specified string of up to 20 characters is
used as the property label and overrides the
PROP-LABEL specification. You can use the
TFF variables @PROP (property label) and
@UNITS (units label) within this string. Can be
truncated in the stream summary but displays
in full in the stream table.

Applies to both DISPLAY and PROP sentences.
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COMPS-HEADER ........... Component header. Used with component-dependent property only.

COMPS-HEADER=YES .. Component header, consisting of a component
ID, is used. The component ID is indented two
spaces. (Default)

COMPS-HEADER=NO .... The component ID is not displayed.

COMPS-
HEADER="string" ..........

The specified string of up to 20 characters is
used as the component header. The TFF
variable @COMPS (component ID) can be used
within this string. Can be truncated in the
stream summary but displays in full in the
stream table.

Applies to both DISPLAY and PROP sentences.

SUBSTREAM-HEADER.. Substream header

SUBSTREAM-
HEADER=YES.................

Substream header of the form "Substream: ssid"
is used. (Default)

SUBSTREAM-
HEADER=NO ..................

Substream header is not displayed.

SUBSTREAM-
HEADER="string"

The specified string of up to 20 characters is
used as the substream header. The TFF
variable @SUBSTREAM (substream ID) can be
used within this string. Can be truncated in the
stream summary but displays in full in the
stream table.

Applies to both DISPLAY and PROP sentences.

PB-HEADER ................... Phase-Basis header

PB-HEADER=YES .......... Phase-Basis header of the form "basis phase" is
used. (Default)

PB-HEADER=NO ............ Phase-Basis header is not displayed.

PB-HEADER="string" .... The specified string of up to 20 characters is
used as the Phase-Basis header. The TFF
variables @BASIS (basis) and @PHASE (phase)
can be used within this string. Can be truncated
in the stream summary but displays in full in
the stream table.

Applies to both DISPLAY and PROP sentences.

TEMP-HEADER .............. Temperature header. Used when the property is calculated at a specified
temperature.

TEMP-HEADER=YES ..... Temperature header of the form **Temperature
value**" is used. (Default)

TEMP-HEADER=NO ....... No temperature header is displayed.

TEMP-HEADER="string" The specified string of up to 20 characters is
used as the temperature header. You can use
the TFF variable @TEMP (temperature) within
this string. Can be truncated in the stream
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summary but displays in full in the stream
table.

Applies to both DISPLAY and PROP sentences

PRES-HEADER............... Pressure header. Used when the property is calculated at a specified
pressure.

PRES-HEADER=YES...... Pressure header of the form"**Pressure
value**" is used. (Default)

PRES-HEADER=NO........ No pressure header is displayed.

PRES-HEADER="string" The specified string of up to 20 characters is
used as the pressure header. You can use the
TFF variable @PRES (pressure) within this
string. Can be truncated in the stream
summary but displays in full in the stream
table.

Applies to both DISPLAY and PROP sentences.

LVPCT-HEADER............. Liquid volume percent header. Used with liquid volume percent
dependent properties only.

LVPCT-HEADER=YES.... Liquid volume percent header, consisting of a
liquid volume percent, is used. (Default)

LVPCT-HEADER=NO...... Liquid volume percent is not displayed.

LVPCT-
HEADER="string"...........

The specified string of up to 20 characters is
used as the liquid volume percent header. You
can use the TFF variable @LVPCT (liquid
volume percent) within this string. Can be
truncated in the stream summary but displays
in full in the stream table.

Applies to both DISPLAY and PROP sentences.

COMP-ATTR-HEADER ... Component attribute header

COMP-ATTR-
HEADER=YES.................

Component attribute header of the form "cid
cattr-id" is used. (Default)

COMP-ATTR-
HEADER=NO...................

Component attribute header is not displayed.

COMP-ATTR-
HEADER="string".............

The specified string of up to 20 characters is
used as the component attribute header. You
can use the TFF variable @COMPS (component)
and @COMP-ATTR (component attribute)
within this string.

Applies to both DISPLAY and PROP sentences.

SUBS-ATTR-HEADER .... Substream attribute header

SUBS-ATTR-
HEADER=YES.................

Substream attribute header of the form "ssid
sattr-id" is used. (Default)

SUBS-ATTR-
HEADER=NO...................

Substream attribute header is not displayed.

SUBS-ATTR- The specified string of up to 20 characters is
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HEADER="string" used as the substream attribute header. You
can use the TFF variable @SUBS-ATTR
(substream attribute) within this string.

Applies to both DISPLAY and PROP sentences.

COMP-ATTR-ELEM ........ Component attribute element to be displayed. For example, component
attribute SULFANAL has three elements:  PYRITIC, SULFATE, and
ORGANIC.

COMP-ATTR-ELEM=cattr-
elem-list

List of component attribute elements

COMP-ATTR-ELEM=ALL All elements (Default)

Applies to both DISPLAY and PROP sentences.

SUBS-ATTR-ELEM......... Particle size distribution interval number to be displayed.

SUBS-ATTR-ELEM=sattr-
elem-list ...........................

List of particle size distribution intervals

SUBS-ATTR-ELEM=ALL All intervals (Default)

Applies to both DISPLAY and PROP sentences.

Header Sentence Order in the Stream Table
The order of the header sentences (TITLE, STREAM-ID-LABEL, SOURCE-
LABEL, DEST-LABEL, PHASE-LABEL) in your TFF indicates the order of header
information in the stream table. The order of these sentences has no effect on the
stream summary form. You must specify YES or supply your own label to display a
header on the stream table.

You can specify up to 20 characters for STREAM-ID-LABEL, SOURCE-LABEL,
DEST-LABEL, and PHASE-LABEL. Your specified label does not appear on the
stream summary form.
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Formats for Numbers
There are three conversion formats (%-xx.yye, %-xx.yyf, %-xx.yyg). The conversion
format variables are:

Variable Explanation

% Percent character. Lead character for format specification.

– Optional minus sign, which left-justifies the number. Without the minus sign, the number is right-justified.

xx A digit string specifying a minimum field length for the converted number. The number takes at least this much
space to print, and more if necessary.

yy A digit string specifying the precision, (that is, the number of digits) to be printed to the right of the decimal point.

e Number is converted to the form [-]a.bbbbbbbe[+]cc. Length of b is specified by yy (Default is 6). Use uppercase E
in the format specification for uppercase E in the printed numbers.

f Number is converted to the form [-]aaa.bbbbbb. Length of b is specified by yy (Default is 6).

g The shorter of %e or %f is used. Use uppercase G in the format specification for uppercase G in the printed
numbers.

The recommended format is %10.2f. This format prints values with two digits to
the right of the decimal, if there is room. If the number is greater than 9,999,999,
Aspen Plus eliminates the fractional digits, then spills over the field range to the
left.

Other common formats used in stream tables are:

Stream table format Prints

%10.0f Whole numbers, with no decimal digits or exponents

%10.nf Numbers without exponents and with n digits to the right of the decimal point, if there is room.
Decimal points line up, unless decimal digits have been eliminated in some numbers.

%10.nE Numbers in exponential notation, with n+1 significant digits

The f format is most common in stream tables. You can use the SCALE option, or
"large units" (for example, MMBTU/HR instead of BTU/HR). This option reduces
the size of the value printed, so it fits in the table with the f format specification.

Any number forced to display as zero with the specified f format is displayed as
"< number", where number is the smallest number that can be displayed by that
format. For example, the number 0.002 displayed under the %10.2f format is
< 0.01
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The NORMALIZE Option
The NORMALIZE option is used with the component flows or fraction properties,
as shown in the following table:

If the component property is Then it is normalized to

Mole flow (MOLEFLOW) Total mole flow (MOLEFLMX) of the same substream

Mass flow (MASSFLOW) Total mass flow (MASSFLMX) of the same substream

Standard vapor volume (VVSTD) Total standard vapor volume (VVSTDMX) of the same substream

Standard liquid volume (VLSTD) Total standard liquid volume (VLSTDMX) of the same substream

Mole fraction (MOLEFRAC) 1

Mass fraction (MASSFRAC) 1

Standard vapor volume fraction (VVSTDFR) 1

Standard liquid volume fraction (VLSTDFR) 1

The component property displayed is forced to add up to exactly the
normalization value. For example, suppose you display mass fractions with two
digits (such as %10.2f) and NORMALIZE = YES. Aspen Plus adjusts the new
fractions to sum to exactly 1.00, even if the value of each mass fraction rounded
to 2 digits adds up to 0.99.

PPM, PPB, and TRACE Options
The options FORMAT, PPM, PPB, and TRACE are related when you specify a
format on the flow or fraction properties. For example, assume you have the
following specification:

PROP     MOLEFLOW     FORMAT="%10.3f"     PPM=1e-3     PPB=1e-6     TRACE=1e-9

This specification is shown in this diagram:

110-310-610-910-12

TRACE PPMPPB

0
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If MOLEFLOW is Then the value is displayed as

Not calculated Blank or string specified in MISSING-LABEL

0 0.0 or string specified in ZERO-LABEL

<10-9 Blank or string specified in TRACE-LABEL

10-9 < MOLEFLOW < 10-6 1 - 999 PPB

10-6 < MOLEFLOW < 10-3 1 - 999 PPM

< 10-3 < 0.001

> 10-3 Number as converted by the %10.3f format
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You should always maintain the following relationship:

TRACE     <     PPB     <     PPM     <     Format precision

Example of a Full TFF

The following is the system default TFF. The intent of this TFF is to mimic the Aspen Plus
stream report as closely as possible.
; This TFF mimics the Aspen Plus stream report and reports all
; calculated properties.
.;
title=yes
stream-id-label=yes
source-label=yes
dest-label=yes
phase-label=yes
;
begloop substream=all
display all
prop moleflow prop-label="Mole Flow"
prop massflow prop-label="Mass Flow"
prop vlstd prop-label="Liq Vol 60F"
prop molefrac prop-label="Mole Frac"
prop massfrac prop-label="Mass Frac"
prop vlstdfr prop-label="LiqVolFrac60F"
prop moleflmx prop-label="Total Flow"
prop massflmx prop-label="Total Flow"
prop volflmx prop-label="Total Flow"
prop vlstdmx prop-label="Liq Vol 60F"
prop temp prop-label="Temperature"
prop pres prop-label="Pressure"
prop vfrac prop-label="Vapor Frac"
prop lfrac prop-label="Liquid Frac"
prop sfrac prop-label="Solid Frac"
prop hmx prop-label="Enthalpy"
prop smx prop-label="Entropy"
prop rhomx prop-label="Density"
prop mwmx prop-label="Average MW"
;
; batch properties follow
;
; first, component-dependent properties
;
prop cmass_time prop-label = "Mass Flow"
prop cmole_time prop-label = "Mole Flow"
prop cvol_time prop-label = "Vol Flow"
prop cmass_cycle prop-label = "Mass/Cycle"
prop cmole_cycle prop-label = "Mole/Cycle"
prop cvol_cycle prop-label = "Vol/Cycle"
;
; overall stream properties
;
prop cycle_time prop-label = "Cycle Time"
prop oper_time prop-label = "Operat Time"
prop ntrain prop-label = "No. Trains"
prop mass_time prop-label = "Mass Flow"
prop mole_time prop-label = "Mole Flow"
prop vol_time prop-label = "Vol Flow"
prop enth_time prop-label = "Enthalpy"
prop mass_cycle prop-label = "Mass/Cycle"
prop mole_cycle prop-label = "Mole/Cycle"
prop vol_cycle prop-label = "Vol/Cycle"
prop enth_cycle prop-label = "Enthalpy/Cycle"
;
endloop
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This is a general TFF that handles any stream class and any number of property
sets. The BEGLOOP and ENDLOOP statements enclose the DISPLAY ALL
keyword, which instructs Aspen Plus to loop through all substreams and display
all properties found in each substream.

The header sentences (TITLE, STREAM-ID-LABEL, SOURCE-LABEL, DEST-
LABEL, and PHASE-LABEL) are specified to take on the default values. The
order of the header sentences dictates how they are printed in the stream table.
Since these sentences are specified before any DISPLAY sentences, the header
information is displayed above the stream values in the stream table.

Whenever Aspen Plus displays a property that is mentioned in the system
default TFF, the corresponding property label is used. For example, when
Aspen Plus displays density, the label "Density" is used. The default label is used
for any property without a specified label. For example, the label RHOMX is used
if PROP-LABEL="Density" is not specified.

All six combinations of component flow or fraction (mole, mass, standard volume)
are specified to anticipate your specifications. If Aspen Plus cannot find the
property you specify, nothing appears.

Example of Customizing a TFF for Generating a Stream Table

Create the following TFF file to customize your stream table:
title="Ethylene plant separation train - Section 105"
stream-id-label="Streams"
display only format="%10.2f" substream-header=no
prop molefrac prop-header="Comp mole fraction" &

comps-header=" @comps" mw=yes mw-bp-format="%6.1f" &
normalize=yes ppm=1e-3 trace=1e-7 trace-label="---"

text " "
prop moleflmx prop-label="Total Mole Flow" &

units="LBMOL/DAY" units-label="Lbmol/Day" &
scale=1e3 scale-label="M"

prop massflmx prop-label="Total Mass Flow" &
units="LB/DAY" units-label="Lb/Day" &
scale=1e3 scale-label="M"

text " "
prop temp prop-label="T" units="F" units-label="Deg F"
prop pres prop-label="P" units="PSI" units-label="Psi"
prop rhomx prop-label="Density" units="LB/CUFT" &

units-label="Lb/Cuft"

Notice the following in the stream table:
• The stream ID label is customized. The source and destination labels are not

printed.
• The DISPLAY ONLY sentence limits the display to the following properties:

component mole fractions, total mole flow, total mass flow, temperature,
pressure, and mass density. The format is 2-decimal-place precision.

• For the mole fraction section, the component IDs are indented two spaces.
The molecular weights are displayed next to the component IDs with 1-
decimal-place precision. The mole fractions are normalized to 1.
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• The possible mole fraction values are displayed according to FORMAT,
TRACE, PPM, and TRACE-LABEL specifications, as described in the
following table:

If MOLEFRAC is Then value is displayed as

Not calculated Blank

0 0.0

< 10-7 —

10-7 < MOLEFRAC << 10-6 < 1 PPM

10-6 < MOLEFRAC << 10-3 1 - 999 PPM

10-3 < MOLEFRAC << 10-2 < 0.01

> 10-2 Number as converted by the %10.2f format

• Total mole flow is requested with units of "LBMOL/DAY." Total massflow is
requested with units of "LB/DAY."

• Two blank rows are inserted for cosmetic purposes.
• Three properties (temperature, pressure, and mass density) are requested.

The property labels for these properties are customized.

❖     ❖     ❖     ❖ 
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37 Working with Other
Windows Programs

The Aspen Plus Windows user interface is built using Microsoft’s OLE
Automation (ActiveX™) technology. This technology enables you to transfer data
easily to and from other Windows® programs.  It enables you to access
simulation data and methods through an Automation client, such as Visual
Basic® (VB).

This chapter describes how to use the Windows interoperability features. Topics
include:
• About copying, pasting and OLE
• Copying and pasting simulation data
• Copying and pasting plots
• Creating active links between Aspen Plus and other Windows applications
• Using embedded objects in your flowsheet

Chapter 38 contains more information on the Aspen Plus OLE Automation server
and how to access it through Visual Basic.

About Copying, Pasting, and OLE

Because Aspen Plus Version 10 is a true Windows application, you can take
advantage of full Windows interoperability and object linking and embedding
(OLE). You can make your simulation work more productive by creating active
links between input/output fields in Aspen Plus and other applications such as
Word® and Excel®.
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For example, simulation results such as column profiles and stream results can
be pasted into a spreadsheet for further analysis, into a word processor for
reporting and documentation, into a design program, or into a database for case
storage and management.

Live data links can be established that update these applications as the process
model is changed to automatically propagate results of engineering changes. The
benefits to you are quick and error-free data transfer and consistent engineering
results throughout the engineering work process.

The subsequent sections of this chapter provide details about cutting, pasting,
and creating active links using OLE.

Copying and Pasting Simulation Data
In Aspen Plus, data contained in the fields of input and result forms can be
copied and pasted using the standard Copy and Paste commands on the Edit
menu. For example, you can copy information from a field or group of fields in
Aspen Plus, and then paste it into:
• Another location within the same Aspen Plus simulation
• Another Aspen Plus simulation
• Any other Windows application such as Word, Excel, or Access®

Copying Data

To copy information in Aspen Plus using the Copy command:

1. Select (or highlight) the information you wish to copy.
To select an individual field of data, simply click the mouse in the field.
To select multiple fields of data, hold down the Ctrl key while clicking the
mouse on multiple fields.
When copying values from a table, you can:
• Click-and-drag the mouse over a desired range of results
• Select an entire column of data by clicking the column heading
• Select an entire row of data by clicking the row selector button (on the left

of the row of data)
• Select the entire table by clicking the button on the top left corner of the

table

2. From the Edit menu, click Copy, or on the keyboard, press Ctrl + C.
The selected values are now contained in the Windows paste buffer, and can
be pasted into Aspen Plus, or another Windows application.
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Note  When selecting data to be copied from a field in Aspen Plus, the entire
field of information is copied, not just a selected portion of the field. For
example, if a field contains as its value the number “1234.567”, you cannot
use the mouse to highlight a portion of the value (such as “123”) for copying.
The Copy command always copies the whole field, with these exceptions:
• The Setup Specifications Description sheet
• Any Fortran or Declarations input sheet
• The Comments dialog box for individual forms
Use the text box on these sheets for entering information, and to select and
copy information.

Copying with Format

By default, the Copy command copies only the value (or values) of information.
Use the Copy with Format command from the Edit menu to request that the
label, units and basis for the values be included with the value.

To copy information in Aspen Plus using the Copy with Format command:

1. Select (or highlight) the information you wish to copy.
To select an individual field of data, click the mouse in the field.
To select multiple fields of data, hold down the Ctrl key while clicking the
mouse on multiple fields.
Tip  When copying values from a table, you can click-and-drag the mouse
over a desired range of results, or you can select an entire column or row of
data by clicking the column heading or row selector button.

2. From the Edit menu, click Copy with Format.

3. On the Copying dialog box that appears, click the check boxes representing
the type(s) of information that you want to be included in the copy buffer.

4. Click OK.
The selected information is now contained in the Windows paste buffer, and
can be pasted into Aspen Plus, or another Windows application.
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Note  You can change the default formats included with the standard Copy
command, by selecting options in the Copy Buffer Format frame of the
General sheet on the Tools Options dialog box. See Chapter 16 for more
details on the Tools Options dialog box.

Pasting

To paste information in Aspen Plus using the Paste command:

1. First, ensure that the paste buffer contains information that has been copied
from Aspen Plus, or another Windows application.

2. Click the mouse in the input field where you wish to paste the information.
For multiple fields of information, click in the upper-left most field.

3. From the Edit menu, click Paste or on the keyboard, press Ctrl + V.

4. If prompted with a message asking if you want to extend the grid, click Yes.
Aspen Plus needs to extend the grid if you are pasting more rows or columns
of data than are currently displayed.
The information contained in the paste buffer will now appear in the field, or
group of fields you selected with the cursor. This information remains in the
paste buffer, and can be pasted into additional locations by repeating steps 2
through 4.
Note  The Paste command has automatic filtering which prevents the pasting
of inconsistent or inappropriate information. For example, you cannot paste a
real value into an integer input field.

Example of Cutting and Pasting Within Aspen Plus

In this example, stream results are pasted into stream input fields. This is a
common task when you want to save final results as initial estimates for tear
streams.

1. Open stream results. To do this, click the tear stream to select it, then click it
with the right mouse button. On the popup menu that appears, click Results.

2. In the Data Browser, click the left mouse button on the molar flowrate of the
first component in the list, and drag the mouse down to select all the values
for component molar flowrates.
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Tip  If all the component flowrates are not displayed, you can expand the
Data Browser window to display more components. Or you can select the
component flowrates by holding down the Ctrl key and clicking with the
mouse.

3. From the Edit menu, click Copy.

4. Using the Data Browser, open the Streams Input Specifications sheet for the
tear stream.

5. In the Composition frame, click in the first cell in the Value column.

6. From the Edit menu, click Paste.
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The molar flowrates from the stream results have been copied into the stream
input specifications. You can now enter two state variables (you could also copy
these values if you wish) to complete the initial estimates for this tear stream.

Example of Pasting Aspen Plus Results Into Other Applications

This example shows the steps necessary to paste column profile results from a
RadFrac block in Aspen Plus into an Excel spreadsheet.

1. Open the column profile results. To do this, in the Process Flowsheet window,
click the RadFrac column to select it, then click it with the right mouse
button. From the menu that appears, click Results.

2. In the left pane of the Data Browser window, click the Profiles results form.

3. On the Profiles result form, click and drag over the results you wish to copy.
– or –
Hold down the Ctrl key while you click the column headings for the data you
wish to copy.

 

4. From the Edit menu, click Copy.

5. Open a spreadsheet in Excel.

6. Select a cell in the Excel spreadsheet where you want to paste the
information.
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7. From the Edit menu in Excel, click Paste.

The copied RadFrac results profile has been pasted into the spreadsheet,
where it can be manipulated, reformatted, combined with additional data,
and plotted using the features of Excel. This same data could also be pasted
into other applications such as a table in Word, or a database in Access.

Example of Pasting Data From Another Application Into Aspen Plus

In this example, atmospheric Txy data for ethyl acetate and ethanol will be
copied from an Excel spreadsheet and pasted into a Properties Data form in
Aspen Plus.

The Excel data is shown next:
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1. In the Aspen Plus simulation, create a properties data set of an appropriate
type to input the data. In this case, open or create a mixture Txy data set
(from the Properties Data Object Manager) for the components ethyl acetate
and ethanol, at a pressure of 1 atmosphere. For more information on creating
property data sets, see Chapter 31.
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2. Open the Properties Data mixture form for the newly created data set, and
examine the format for the columns of data. Modify units and standard
deviations if necessary.
Notice that there are columns for the compositions of ethanol, as well as ethyl
acetate.  The composition for the second component need not be entered, as it
will be calculated as the difference between 1 and the composition of the first
component. This means that you must use two copy and paste operations to
transfer the data from Excel to Aspen Plus:
• Firstly, copy the Temperature and X columns
• Then copy the Y column

3. Open the Excel spreadsheet containing the data.

4. Click and drag to select the data to be copied. For the first copy operation,
select the temperature and liquid composition data.
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5. From the Edit menu in Excel, click Copy.

6. In Aspen Plus, on the Data sheet for the newly created data set, select the
first empty cell in the Temperature column.

7. From the Aspen Plus Edit menu, click Paste.

8. In the Paste dialog box, click Yes to extend the data grid.
The temperature and liquid composition data is transferred into the Data
sheet
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9. Return to the Excel spreadsheet, and select the vapor composition data, by
clicking and dragging the mouse.

10. From the Edit menu in Excel, click Copy.

11. In Aspen Plus, on the Data sheet, select the first empty cell in the Y column
for ethyl acetate.

12. From the Aspen Plus Edit menu, click Paste.
The vapor composition data is transferred into the Data sheet.
You can now use this data set to estimate or regress property parameters in
Aspen Plus. For more information on Property Estimation or Property
Regression, see Chapters 30 and 31 respectively.

Copying and Pasting Plots and Other Images
After generating plots in Aspen Plus, you can copy the plots and paste them into
the process flowsheet or into other Windows applications as images. Plotted
results can be of column profiles, sensitivity analyses, batch profiles, property
analyses, and so on. You can also copy images created in other Windows
applications, such as graphs created in Excel, and paste them into the
Aspen Plus process flowsheet.

To copy a plot in Aspen Plus:

1. Generate the desired plot and format the appearance of the plot as you want
it to appear when pasted. For details on creating and formatting plots, see
Chapter 13



Working with
Other Windows
Programs

37-12 Aspen Plus User Guide
Version 10.2

2. Select the plot in the Aspen Plus main window.

3. From the Edit menu, click Copy.
The plot is copied to the paste buffer.
Use Paste to paste the plot into the process flowsheet, or into other Windows
applications.

To paste a plot into the process flowsheet:

1. Ensure that the paste buffer contains the desired plot or other image. Click
here for more information.

2. Click in an empty part of the process flowsheet.

3. From the Edit menu, click Paste.
The image appears as an icon in the process flowsheet.
You can move or resize the image, like any object in the flowsheet drawing. If
the image is a plot, you can also change its formatting. To do this, click the
plot with the right mouse button. From the menu that appears, click
Properties. For more information on formatting plots,  see Chapter 13.

Attaching Plots or Images to Flowsheet Blocks

When a plot or image has been pasted onto the process flowsheet, you can attach
(or associate) the image to a block on the flowsheet. Attaching an image to a
flowsheet block ensures that when the block is moved, the image will maintain is
location with respect to the block.

For example, if you paste a plot of column profiles onto the flowsheet, you
typically want this to be displayed near the column.

To attach an image to a flowsheet block:

1. Select the image that you wish to attach.

2. Click with the right mouse button on the image, and from the menu that
appears, click Attach.
The cursor changes to a cross-hair symbol.
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3. Click the flowsheet block to which you want to attach the image.
The image is now attached to the selected flowsheet block. If the block is later
moved to another location on the flowsheet, the image will maintain its
spatial arrangement with respect to the block.

Example of Copying a Plot and Pasting it onto the Process Flowsheet

In this example, a plot of RadFrac composition profiles will be copied and pasted
onto the process flowsheet.

1. First, use the Plot Wizard to generate the plot of composition profiles, and
format it as you wish.

2. Select the plot and from the Edit menu, click Copy.

3. Click in an empty area of the process flowsheet.

4. From the Edit menu, click Paste.

5. Position and size the plot as needed.
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Example of Pasting a Plot into Another Application

In this example, the plot copied in the previous example will be pasted into a
Word document.

1. First, use the Plot Wizard to generate the plot of composition profiles, and
format it as you wish. See Chapter 13 for details on generating plots.

2. Select the plot, then from the Edit menu, click Copy.

3. Start Word, and open the file in which you want to paste the plot.

4. Click in the Word document where you want to paste the plot.

5. From the Edit menu, click Paste.
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Example of Pasting Images From Other Windows Applications Onto the
Aspen Plus Process Flowsheet

In this example, an Excel graph will be placed onto the Aspen Plus process
flowsheet.

1. First, generate the desired graph or image in another application. In this
case, a pie chart is created in Excel.

2. In Excel, select the graph, and from the Edit menu, click Copy.

3. Open the Aspen Plus simulation where you want to paste the Excel graph.

4. Click on an empty area of the process flowsheet.

5. From the Edit menu in Aspen Plus, click Paste.

6. Move and resize the graph, and adjust the flowsheet view as necessary.
The Excel graph now appears on the process flowsheet.
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Creating Active Links Between
AspenPlus and Other Windows
Applications

When copying and pasting information, you can create active links between input
or results fields in Aspen Plus and other applications such as Word and Excel.
The links update these applications as the process model is modified to
automatically propagate results of engineering changes.
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Creating Active Links Between an AspenPlus Result
and another Windows Application

To create active links between a result in Aspen Plus and another Windows
application:

1. Make sure you have both applications open:
• Aspen Plus open with the completed simulation and results available
• Another Windows application open with the file where you wish to paste

the active link to Aspen Plus results

2. Open the Aspen Plus results form containing the information to be linked.

3. Select the desired results.
To select an individual field of data, simply click in the field.
To select multiple fields of data, hold down the Ctrl key while clicking the
mouse on multiple fields.
When copying values from a table, you can:
• Click-and-drag the mouse over a desired range of results
• Select an entire column of data by clicking the column heading
• Select an entire row of data by clicking the row selector button
• Select the entire table of data by clicking the button on the top left corner

of the table

4. From the Edit menu, click Copy (or Copy with Format). If you choose Copy
with Format, in the Copying dialog box, check the items you want included
with the value (Label, Units or Basis), and click OK.

5. Go to the appropriate location in another Windows application, where you
wish to paste the active link.

6. From the Edit menu in the other application, choose Paste Special.

7. In the Paste Special dialog box, click the Paste Link radio button and make
sure you are pasting as text by selecting Text in the As box:.

8. Click OK to close the Paste Special dialog box.
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Now an active link has been established between Aspen Plus (the source
document) and another application.

9. When you exit, be sure you save both the Aspen Plus file and the other
application file. If you do not, the link will not work when you open the files.
If you save the link source file (Aspen Plus in this case) with another name,
you must save the link container (other application file) after saving the
Aspen Plus run.

Example of Creating Active Links from Aspen Plus Results into Excel

In this example, RadFrac condenser duty results will be copied with units, and
pasted into an Excel spreadsheet as an active link.

1. Open the RadFrac ResultsSummary Summary sheet to view the results for
condenser duty.
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2. On the Summary sheet, click the result value for condenser duty.

3. From the Edit menu, click Copy with Format.

4. In the Copying dialog box, check the Unit checkbox, then click OK.

5. Open the Excel spreadsheet, and select the cell where you want to create the
link to the Aspen Plus results for condenser duty.
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6. From the Edit menu in Excel, choose Paste Special.

7. In the Paste Special dialog box, click the Paste Link radio button.

8. Select Text in the As: list, and click OK.
The condenser duty and units are copied into the specified location.
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The pasted value is an active link between Aspen Plus (the source document) and
the Excel spreadsheet (the destination document.) As inputs are changed in the
Aspen Plus model, and the simulation is rerun to generate new results, the active
link displayed in the Excel spreadsheet will reflect the changes.

You can review the source of the link in Excel by selecting the linked cell in
Excel. The source will display in the Excel Formula Bar below the toolbar.

You can view and modify the status of the link in Excel by selecting Links from
the Edit menu.

Creating Active Links from a Windows Application to
AspenPlus Input Fields

In addition to creating active links from Aspen Plus to other applications, you
can also create active links from other applications such as Word or Excel, to
input fields within Aspen Plus simulations. This can be used to create a simple
interface to your simulation models for non Aspen Plus users (e.g. operators or
other engineers.)

1. Make sure you have:
• Aspen Plus open at the completed simulation where you will add the

active link
• Another Windows application open at the source file from where you will

originate the active link to an Aspen Plus input field

2. In the source file of the other application, select the information to be linked.
For example, in Excel, click in the cell containing the data to be linked.

3. From the Edit menu in the other application, click Copy.

4. In Aspen Plus, open the appropriate input form, and select the field where
the information will be pasted to create the active link.

5. From the Edit menu in Aspen Plus, click Paste Special.

6. In the Paste Special dialog box, click the Paste Link button and ensure you
are pasting as text by selecting Text in the As list.

7. Click OK to close the Paste Special dialog box.
Now an active link has been established between another application (the
source document) and Aspen Plus (the destination document); if you change a
value in the source document, the change will be reflected on the appropriate
Aspen Plus input forms.
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8. When you exit, ensure you save both the Aspen Plus  file and the other
application file. If you do not, the link will not work when you open the files.
If you save the link source (the other application in this case) with a different
file name, you must save the link container (Aspen Plus) after saving the
other application file.

Example of Creating a Link from Excel to an Aspen Plus Input Field

In this example, an active link will be established from Excel that controls the
reflux ratio of a column in Aspen Plus.

1. Open the Excel spreadsheet to display the data from where you will establish
the link (the source file.)

2. Select the cell containing the information that will be linked.

3. From the Edit menu in Excel, click Copy.

4. In the Aspen Plus simulation, open the RadFrac Setup Configuration sheet,
and select the field for the value of Reflux Ratio.
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5. From the Edit menu in Aspen Plus, click Paste Special.

6. In the Paste Special dialog box, click the Paste Link radio button and make
sure you are pasting as text by selecting Text in the As list.

7. Click OK to close the Paste Special dialog box.
The reflux ratio displayed on the RadFrac Setup Configuration sheet is now
an active link to the source cell in the Excel spreadsheet. Any changes made
to the linked cell in the Excel spreadsheet will automatically be reflected in
the simulation input.

To illustrate the effect of the active link established in this example:

1. Open the Excel spreadsheet, and change the reflux ratio in the linked cell
from 8 to 10.
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2. Open the RadFrac Setup Configuration sheet again, and note that the value
for reflux ratio has been automatically changed.

Saving and Opening Files with Active
Links

If you create active links between Aspen Plus and other Windows programs, you
must follow a few rules to ensure that the links continue to work when you save
files and open them again.  You should understand the following terms:
• The link source is the program that is providing the data.
• The link container is the program into which you paste the link.

For example, if you copy data from Aspen Plus and use Paste Special to paste a
link into Excel, Aspen Plus is the link source and Excel is the link container.

Saving Files with Active Links
When you save files with active links:
• Be sure to save both the link source file and the link container file.  If you do

not, the link will not be there when you open the files again.
• If you save the link source with a different name (for example, using Save

As), you must save the link container after saving the link source.  This is
because the link container contains the file name of the link source.

• If you have active links in both directions between the two applications and
you change the name of both files, you must do three Save operations:
• Save the first application with a new name
• Save the second application with a new name
• Save the first application again
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Save the first application with a new name.
For example, if you have links in both directions between Aspen Plus and
Excel:
• Use Save As in Aspen Plus to save the run as MYRUN
• Go to Excel and use Save As
• Return to Aspen Plus and Save
Note Links are saved when you save in Aspen Plus Document format (.apw)

or Aspen Plus Backup format (.bkp).

Opening Files with Active Links
When you open the link source file, there is nothing special that you need do.

When you open the link container file, you will usually see a dialog box asking
you if you want to re-establish the links.  Applications will behave differently or
may show different dialog boxes.

If you:

Click Then And

No The link will not be active Any changes you make in the link source will not be reflected in
the link container.

Yes Windows will re-establish the link and open the link
source application in background. That is, the
application will be open and running, but there will be
no visible windows for the application.

You will not see the application on the Windows taskbar. You
might notice a pause as Windows activates the application.

In some cases, when the link source is running in background, you might want to
make the application visible (have its windows displayed) so that you can make
changes.

For example, you may be using Excel (as link source) to supply feed stream data
to an Aspen Plus simulation (the link container).  Normally, you can just open
Aspen Plus, re-establish the links, and run the simulation.  But if you want to
change the feed stream data or add links to a another piece of data in the Excel
spreadsheet, you need to make Excel visible.
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The method to make the link source application visible depends on the
application:
• For some applications, for example Aspen Plus and Microsoft Word, you can

open the file in the normal way using Open from the File menu or double-
clicking the file in Windows Explorer.

• For other applications, like Excel, if you try to open the file in the normal
way, you will receive a message that the file is locked or in use by another
user.  If you proceed and open the file, you are actually working on another
copy of the document and links will not work properly.

Because of problems with some applications, follow this procedure to make the
link source application visible:

1. From the Edit menu in the link container application, select Links.
The Links dialog box appears.

2. In the Links dialog box, select the source file and click Open Source.
Now the link source application is visible.  The application will appear on the
Windows taskbar.

Updating References in Excel

Microsoft Excel has an option which you must use to ensure that links are
correctly re-established when you open files with active links.  To check the
option:

1. In Excel, from the Tools menu, click Options.

2. In the Options dialog box, click the Calculations tab.

3. Ensure the Update Remote References checkbox is selected.
There is also an option to Save External Link Values.  This controls the
behavior of Excel when you have links but do not re-establish them when you
open the file or the links become broken.
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If this option is Excel will display

Selected The last value it had before the link was broken

Clear An error

Using Embedded Objects in the Process
Flowsheet Window

You can embed other applications as objects in the Process Flowsheet window.

For example, you can embed a Word document or an Excel spreadsheet into the
Process Flowsheet window.  There are two ways you can do this:
• Using Copy and Paste
• Using the Insert dialog box

Embedding an Object Using Copy and Paste
To embed an object using Copy and Paste:

1. In the source application, select the data, text, or other object you want to
embed.

2. From the Edit menu of the source application, click Copy.

3. Go to Aspen Plus and make sure that the Process Flowsheet Window is the
current window:

If you are using You should

Workbook mode Click the Process Flowsheet tab

Flowsheet as Wallpaper Click the flowsheet in the background

Normal View Select the Process Flowsheet window

4. In Aspen Plus, from the Edit menu, click Paste.
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Embedding an Object Using the Insert Object Dialog
Box

To embed an object using the Insert Object dialog box:

1. In Aspen Plus, ensure that the Process Flowsheet Window is the current
window.

2. From the Edit menu, point to Insert, then New Object.

3. To embed a new object, click Create New and in the Object Type list, select
the application or object.
To embed an object from an existing file, select Create From File and specify
the file.
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Modifying an Embedded Object
You can modify an embedded object:

To Do this

Edit the object using the source
application within Aspen Plus

Double-click on the object.
– or –
1. Click the object to select it
2. Click the right mouse button.
3. On the popup-menu, point to Objecttype† Object, then Edit.

The menus and toolbar in Aspen Plus are replaced with those of the source
application.  You can edit the object.  When you are done, click anywhere in
the Process Flowsheet Window to exit the application.

Activate the source application
to edit the object

1. Click the object to select it
2. Click the right mouse button.
3. On the popup-menu, point to Objecttype† Object, then Open.

The source application opens in another window.  You can edit the object.
When you exit the application, the object is updated in Aspen Plus.

Move the object 1. Click the object to select it.

The mouse pointer becomes the move shape 

2. Click and hold the left mouse button while dragging the object

Resize the object 1. Click the object to select it.
2. Move the mouse to the edge or corner of the object.
The mouse pointer becomes to the resize shape
3. Hold down the left mouse button and drag the cursor until the object is the
desired size.

Attach the object to a block or
stream in the flowsheet

1. Click the object to select it.
2. Click the right mouse button.
3. On the popup menu, click Attach.
4. Click the block or stream in the flowsheet.

The object is now attached to the selected block or stream.  If the block or
stream is later moved to another location in the flowsheet, the image will
maintain its spatial arrangement with respect to the block.

†
Objecttype will depend on the source application

Saving a Run With an Embedded Object
Embedded objects are saved as part of a run only when you save in Aspen Plus
Document format (.apw files).  When you save in Backup format (.bkp files), the
embedded object is not saved.
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38 Using the Aspen Plus
ActiveX Automation
Server

This chapter describes how to use the Aspen Plus ActiveX Automation Server.
The topics include:
• About the Automation server
• Viewing the properties and methods of Aspen Plus objects
• Objects exposed by the Automation server
• Using the Variable Explorer to navigate the tree structure
• Navigating the tree structure in the Automation interface
• Data values and Node attributes
• Physical quantities and Units of Measure
• Referencing non-scalar data
• Flowsheet connectivity and automation
• Controlling the user interface
• Controlling a simulation problem
• Exporting files
• Members of Aspen Plus classes

This chapter assumes that you are familiar with Visual Basic and understand
the concepts of object-oriented programming.

The examples in this chapter use Visual Basic 5.0 and Visual Basic for
Applications (VBA) as the Automation Client. Examples are based on the pfdtut
example problem which is provided with the standard Aspen Plus installation as
a backup file named pfdtut.bkp. If you installed Aspen Plus in the default
location, this file is in C:\Program Files\AspenTech\Aspen Plus 10.2\GUI\xmp.
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If you installed Aspen Plus in the default location, the Visual Basic examples in
this chapter are located in
C:\Program Files\AspenTech\Aspen Plus 10.2\GUI\vbexample.

About the Automation Server

The Aspen Plus Windows user interface is an ActiveX Automation Server. The
ActiveX technology (also called OLE Automation) enables an external Windows
application to interact with Aspen Plus through a programming interface using a
language such as Microsoft’s Visual Basic. The server exposes objects through the
COM object model.

With the Automation interface, you can:
• Connect both the inputs and the results of Aspen Plus simulations to other

applications such as design programs or databases.
• Write your own user interface to an Aspen Plus plant model. You can use this

interface to distribute your plant model to others who can run the Aspen Plus
model without learning to use the Aspen Plus user interface.

Using the Automation Server
In order to use the Aspen Plus Automation Server, you must:
• Have Aspen Plus installed on your PC
• Be licensed to use Aspen Plus

The type library for the server is happ.tlb, located in the Aspen Plus user
interface system directory. If you installed Aspen Plus in the default directory,
this will be Program Files\AspenTech\Aspen Plus 10.2\GUI\xeq. The server is
an out-of-process server, apwn.exe.

Before you can access the Aspen Plus type library from Visual Basic, in the
Visual Basic Project References dialog box, you must check the Aspen Plus GUI
10.2 Type Library box.
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Before you can access the Aspen Plus type library from Excel VBA, in the Excel
Tools>References dialog box, you must check the Aspen Plus GUI 10.2 Type
Library box.

If Aspen Plus GUI 10.2 Type Library does not exist in the list, click Browse and
find the Aspen Plus User Interface system directory. Select happ.tlb.

Error Handling

Errors may occur in calling methods or accessing properties of the Aspen Plus
objects. It is important to create an error handler for all code which accesses an
automation interface. An automation interface may return a dispatch error for
many reasons, most of which do not indicate fatal or even serious errors.

Unless there is an error handler in place any error will normally cause a dialog
box to be displayed on the user’s screen. In VB the error handler is in the form of
an On Error statement, e.g. On Error Goto <line>. It is usual to create an error
handling subroutine which will tidy up and exit the application cleanly if any
severe errors are encountered.

Viewing the Properties and Methods of
Aspen Plus Objects

The properties and methods of the Aspen Plus objects may be viewed in the
Automation Client Object Browser:

In Visual Basic 5 and Excel, from the View menu, click Object Browser.

In Excel, the Module sheet must be active for this menu item to be present.

Most of the properties of Aspen Plus objects may be set through the Automation
interface to modify the simulation problem. However some properties of
simulation objects are read-only. If a property is read-only this is shown in the
VB Object Browser, but not in the Excel VBA Object Browser.
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Objects Exposed by Aspen Plus
The object exposed by Aspen Plus is the HappLS or IHapp object. HappLS is the
only object type that the class Happ supports. An Aspen Plus application object
may be declared as an IHapp object or a HappLS object. Through this object, the
other objects and their properties and methods may be accessed.

The objects exposed by Aspen Plus are as follows:

Object Description

HappLS The Aspen Plus client object

IHNode The Aspen Plus problem input and results data are exposed as a tree structure composed of
IHNode objects

IHNodeCol Each IHNode object may own other nodes, and these are organized in an IHNodeCol collection
object

IHAPEngine This object provides an interface to the Aspen Plus simulation engine

The HappLS Object

The IHapp object is the principal object exposed by Aspen Plus. This object
provides methods and properties such as:
• Opening a simulation problem
• Controlling the visibility of the Aspen Plus GUI
• Saving a problem
• Outgoing events

Example of Opening A Simulation

The following VB example obtains the simulation object for an existing simulation problem
stored in the backup file pfdtut.bkp, and sets the Visible property to display the Aspen Plus
graphical user interface.
Function OpenSimulation() As HappLS
Dim ihAPSim As HappLS
On Error GoTo ErrorHandler
' open existing simulation
Set ihAPSim = _

GetObject("C:\Program Files\AspenTech\Aspen Plus 10.2\GUI\xmp\pfdtut.bkp")
' display the GUI
ihAPSim.Visible = True
Set OpenSimulation = ihAPSim
Exit Function
ErrorHandler:
MsgBox "OpenSimulation raised error " & Err & ": " & Error(Err)
End
End Function
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The effect of the GetObject reference is to create a process running the Apwn.exe object
server. Any references to the same problem file from the same or other processes will connect
to the same running instance of the Apwn server.

The Aspen Plus Tree Structure
The input and results data in an Aspen Plus simulation problem are organized in
a tree structure.

In order to access the data of interest in an Aspen Plus simulation, you need to
understand and navigate through the tree structure and locate and identify the
variables of interest. To do this, you can use the Variable Explorer in the
Aspen Plus User Interface.

Using the Variable Explorer to Navigate
the Tree Structure

Use the Variable Explorer to view and access variables associated with your
simulation. The Variable Explorer displays the attributes of each variable in the
simulation in a similar way to the Data Browser.

To open the Variable Explorer:

➤ From the Tools menu, click Variable Explorer.
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The Variable Explorer displays a tree view similar to the Data Browser. The
difference is that the Data Browser displays the variables conveniently grouped
and laid out on forms with prompt text, scrolling controls, selection boxes and
fields for data entry. The Variable Explorer exposes the underlying variables
within the simulation problem.

The Variable Explorer is important to the Automation user because it shows the
names and the structure of the variables which may be accessed through the
Automation interface.

Note  The Variable Explorer is read-only. You cannot use the Variable Explorer
to change values or other attributes of variables.

Note  If you navigate through the tree structure in the Variable Explorer, it is
possible to create new objects which you may not be able to delete. For this
reason, you should save your Aspen Plus run before using the Variable Explorer
and not save it after you use the Variable Explorer.

Example of Using the Variable Explorer

This example gives instructions for using the Variable Explorer to access data in
the RadFrac block (Block B6) in pfdtut.bkp.

1. From the Tools menu, click Variable Explorer to open the Variable Explorer.
The tree view on the left displays just the node labeled Root.

2. Double-click on the Root folder icon or click on the + icon to display the nodes
immediately below this: Data, Unit Table and Settings.
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3. Expand Data to display the next level of nodes: Setup through to Results
Summary.

4. Expand the Blocks icon to reveal a list of blocks on the flowsheet: B1 through
B6.

5. Expand B6 to display nodes labeled Input through to Work Results.

6. Expand Input to display a list of nodes labeled Unit Set through to Y_EST.
These nodes represent the simulation input data for the RadFrac block. For
example, below the Input node, the node labeled NSTAGE holds the input
value for the number of stages in the column.

7. Click on the Output node to display a list of nodes labeled Unit Set through
Y_MS.
These nodes represent the output data for the RadFrac block. For example,
below the Output node, the node labeled BU_RATIO holds the result value for
the boilup ratio.
The Path to Node field of the Variable Explorer displays the path to the node
which is currently open. From this field, you can copy and paste directly into
your program. To do this, complete these steps:

8. Select the text in the Path to Node field, then click the right mouse button.

9. From the menu that appears, click Copy.

10. Go to your application (for example, Visual Basic or the Excel Module sheet).

11. From the Edit menu, click Paste.

Navigating the Tree Structure in the
Automation Interface

The tree structure observed in the Data Browser is reflected in the Automation
interface.

The objects in an Aspen Plus simulation are exposed as a tree structure of
IHNode node objects. The root node of the tree is obtained by the Tree property of
HappLS.
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Each IHNode object may have zero or more offspring IHNode objects. Each
IHNode object has a Dimension property which determines how the offspring
nodes are organized. A leaf node (i.e. one with no offspring) has a Dimension of
zero.

The offspring nodes of a node object may be obtained as a collection object,
IHNodeCol from the Elements property of an IHNode object.

To illustrate this, consider the following example:
Sub GetCollectionExample(ihAPsim As HappLS)
' This example illustrates use of a collection object
Dim ihRoot As ihNode
Dim ihcolOffspring As IHNodeCol
Dim ihOffspring As ihNode
Dim strOut As String
On Error GoTo ErrorHandler
'get the root of the tree
Set ihRoot = ihAPsim.Tree
'now get the collection of nodes immediately below the Root
Set ihcolOffspring = ihRoot.Elements
For Each ihOffspring In ihcolOffspring

strOut = strOut & Chr(13) & ihOffspring.Name
Next
MsgBox "Offspring nodes are: " & strOut, , "GetCollectionExample"
Exit Sub
ErrorHandler:
MsgBox "GetCollectionExample raised error" & Err & ": " & Error(Err)
End Sub

The collection object ihcolOffspring contains the collection of nodes immediately
below the root, i.e. those nodes with the labels Data, Unit Table and Settings as
observed in the Variable Explorer.

Nodes within each collection object may be accessed in one of two ways:
• You can iterate through the collection object using a For Each … Next

structure, accessing each node in turn.
• You can access a node explicitly using the Item property of the IHNodeCol

object. In order to identify a particular item in a collection, the Item property
takes one or more arguments. Each argument is either a string specifying the
label or item name of an offspring node in the next level of the tree, or an
integer specifying the ordinal number of the node in the collection of offspring
nodes. The number of arguments required to the Item property is given by the
Dimension property of the parent.



Chapter  38

Aspen Plus User Guide 38-9
Version 10.2

Thus:
For Each ihOffspring In ihcolOffspring
.
.
.
Next

iterates through each node in the ihcolOffspring collection, and
Set ihDataNode = ihcolOffspring.Item("Data")

obtains the node with the label “Data”. Note that the item names are case
sensitive.

The Dimension property determines the number of arguments required:
if ihcolOffspring.Dimension = 1 then

Set ihDataNode = ihcolOffspring.Item("Data")
else if ihcolOffspring.Dimension = 2 then

Set ihDataNode = ihcolOffspring.Item("Data","id2")
endif

The Item property is the default property of IHNodeCol, so this statement may
be abbreviated simply by writing:
Set ihDataNode = ihcolOffspring(“Data”)

Dot Notation for Navigating the Tree
To navigate down the tree you can chain the Item property references together.
For example, to get to the node labeled NSTAGE which represents the number of
stages in a RadFrac block:
Set ihNStageNode = ihAPsim.Elements("Data"). _

Elements("Blocks").Elements("B6"). _
Elements("Input").Elements("NSTAGE")

A more concise notation is also available to navigate down the tree. This simply
allows the item names to be chained together, without specifying either the
Elements or the Item properties. For example, the above assignment may be
written:
Set ihNStageNode = ihAPSim.Tree.Data.Blocks.B6.Input.NSTAGE

However, although this ‘dot’ notation is convenient in many situations it has
some restrictions:
• It will only work if the item names are consistent with the syntax of an

identifier within the language used by the automation client, in this example
Visual Basic. So the item name must not contain embedded spaces or special
characters. For example the item name "Unit Table" would be invalid in this
notation.

• Certain node types do not support the dot notation. The node types that do
not support dot notation are connection, port, setting table, route, label, &
unit table.
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Data Values

Once you have the leaf node containing the data value of interest, you can obtain
the data value associated with the node from the Value property. Data values
have an associated data type which is held in the ValueType property.

ValueType returns one of the following:

ValueType Description Visual Basic Data Type

0 Value not defined

1 Integer Long

2 Real Double

3 String String

4 Node IHNode

Note that Aspen Plus returns 32bit integer and 64bit real values. Therefore when
using Visual Basic, integer and real valued properties should be assigned to Long
and Double variables respectively in order to avoid potential overflow errors.

Example of Accessing Data Values

Navigate to and display the number of stages in a RadFrac column (an input data value) and
the boilup ratio (a results data value) in a message box.
Sub GetScalarValuesExample(ihAPsim As HappLS)
' This example retrieves scalar variables from a block
Dim ihColumn As ihNode
Dim nStages As Long
Dim buratio As Double
On Error GoTo ErrorHandler
' navigate the tree to the RADFRAC block
Set ihColumn = ihAPsim.Tree.Data.Blocks.B6
' Get the number of stages
nStages = ihColumn.Input.Elements("NSTAGE").Value
' get the boilup ratio
buratio = ihColumn.Output.Elements("BU_RATIO").Value
MsgBox "Number of Stages is: " & nStages _

& Chr(13) & "Boilup Ratio is: " & buratio, , "GetScalarValuesExample"
Exit Sub
ErrorHandler:
MsgBox "GetScalarValuesExample raised error" & Err & ": " & Error(Err)
End Sub
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Node Attributes

You can obtain information called attributes about the node from the
AttributeValue and AttributeType properties. These take an attribute
number argument which is an enumerated value from the
HAPAttributeNumber class.

These tables show some commonly used attributes and their descriptions.

The Attribute Name corresponds to the field in the Variable Explorer.

You can see the full range of possible values and descriptions in the Object
Browser of your Automation client (e.g., VB5). In general, you will only need a
small subset of the attributes.

Each node typically only supports a subset of the attributes. You can check
whether an attribute is supported by querying the AttributeType for the
attribute. The attribute types returned are as shown above for ValueType. If the
AttributeType property returns a value of zero for an attribute then the attribute
is not defined for that node.

Value-related Attributes

Attribute Name HAP_AttributeNumber Description

Value HAP_VALUE The current value

Physical Quantity HAP_UNITROW The row in the Unit Table for the physical quantity of the value

Units of Measure HAP_UNITCOL The column in the Unit Table for the physical quantity of the value

Basis HAP_BASIS The basis e.g. MOLE or MASS for a value

Option List HAP_OPTIONLIST A node whose offspring contain the valid values for this node

Meta-data Attributes for Records

Attribute Name HAP_AttributeNumber Description

Record Type HAP_RECORDTYPE If the node is record structured, e.g. a block or a stream, this property is a
string containing the record type, e.g RADFRAC for a RADFRAC block
and MATERIAL for a material stream.

Completion Status HAP_COMPSTATUS Returns an integer code giving completion status. Bit masks for
interpretation are available in the enum HAPCompStatusCode.
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Attributes for Variable Nodes

Attribute Name HAP_AttributeNumber Description

Output HAP_OUTVAR Is the variable node a results variable (read-only)

Enterable HAP_ENTERABLE Can the value attribute be modified?

Upper Limit HAP_UPPERLIMIT The upper limit on the value attribute.

Lower Limit HAP_LOWERLIMIT The lower limit on the value attribute.

Default Value HAP_VALUEDEFAULT The default value for the value attribute.

Prompt HAP_PROMPT A descriptive prompt for the node.

Attributes for Multi-dimensioned Variables Nodes

Attribute Name HAP_AttributeNumber Description

First Scrolled Pair HAP_FIRSTPAIR If the variable uses paired scrolling, the 1 based index of the first
item of the pair.

Flowsheet Connectivity Port Attributes

Attribute Name HAP_AttributeNumber Description

In or Out HAP_INOUT Is the port node an inlet or outlet?

For blocks
0 = Inlet
1 = Outlet

For Streams:
0 = Outlet
1 = Inlet

Gender HAP_PORTSEX Block or Stream port type:
0 = Stream
1 = Block

Multiport HAP_MULTIPORT Can the port node be connected to multiple streams?
0=No
1=Yes

Port Type HAP_PORTTYPE The type of the port node.
1 = Material
2 = Heat
3 = Work
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Other Attributes

Attribute Name HAP_AttributeNumber Description

Has Children HAP_HASCHILDREN Returns True if the node has offspring nodes.

Example of Using AttributeValue

The following example subroutine uses AttributeValue to display a list of blocks showing the
block type, flowsheet section, and status for each block.
Sub ListBlocksExample(ihAPSim As HappLS)
' This example ilustrates retrieving a list of blocks and their attributes
Dim ihBlockList As IHNodeCol
Dim ihBlock As ihNode
Dim strOut As String
On Error GoTo ErrorHandler
Set ihBlockList = ihAPSim.Tree.Data.Blocks.Elements
strOut = "Block" & Chr(9) & "Block Type" _

& Chr(9) & "Section " & Chr(9) & "Results status"
For Each ihBlock In ihBlockList
strOut = strOut & Chr(13) & ihBlock.Name & Chr(9) & _

ihBlock.AttributeValue(HAP_RECORDTYPE) & " " & Chr(9) & _
ihBlock.AttributeValue(HAP_SECTION) & Chr(9) & _
Status(ihBlock.AttributeValue(HAP_COMPSTATUS))

Next ihBlock
MsgBox strOut, , "ListBlocksExample"
Exit Sub
ErrorHandler:
MsgBox "ListBlocksExample raised error" & Err & ": " & Error(Err)
End Sub

Function Status(CompStat As Integer) As String
' This function interprets a status variable and returns a string

If ((CompStat And HAP_RESULTS_SUCCESS) = HAP_RESULTS_SUCCESS) Then
Status = "Success"

ElseIf ((CompStat And HAP_RESULTS_ERRORS) = HAP_RESULTS_ERRORS) Then
Status = "Errors"

ElseIf ((CompStat And HAP_RESULTS_WARNINGS) = HAP_RESULTS_WARNINGS) Then
Status = "Warnings"

ElseIf ((CompStat And HAP_NORESULTS) = HAP_NORESULTS) Then
Status = "No results"

ElseIf ((CompStat And HAP_RESULTS_INCOMPAT) = HAP_RESULTS_INCOMPAT) Then
Status = "Incompatible with input"

ElseIf ((CompStat And HAP_RESULTS_INACCESS) = HAP_RESULTS_INACCESS) Then
Status = "In access"

End If
End Function
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This example displays the following message box.

Physical Quantities and Units of Measure

For a value which represents a physical quantity, there are two important
attributes:
• The physical quantity (for example, temperature or pressure)
• The units of measurement in which the physical quantity is expressed (for

example, degrees Kelvin or degrees Fahrenheit)

The following sections describe how to:
• Retrieve the physical quantity and the units for a value
• Convert a value to a different units of measurement
• Change the units in the Aspen Plus run

Retrieving Units of Measure
You can retrieve:
• Units of measure for a value as a string
• Physical quantity and units of measure as references to the Unit Table

Units of Measure as a String

The unit of measurement symbol for a value can be obtained from the
UnitString property.
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Example of Using Units of Measure

The following subroutine uses the UnitString property to display the outlet pressure of a flash
block together with the unit of measurement.
Sub UnitStringExample(ihAPSim As HappLS)
' This example retrieves the units of measurement symbol for a
' variable
Dim ihPresNode As ihNode
On Error GoTo ErrorHandler
Set ihPresNode = ihAPSim.Tree.Data.Blocks.B3.Output.B_PRES
MsgBox "Flash pressure is: " & ihPresNode.Value & Chr(9) & _

ihPresNode.UnitString, , "UnitStringExample"
Exit Sub
ErrorHandler:
MsgBox "UnitStringExample raised error " & Err & ": " & Error(Err)
End Sub

The Units Table

Physical quantities and the corresponding units of measurement are described in
Aspen Plus by references to a Unit Table. Sometimes it is convenient to use the
units table directly, instead of dealing with the UnitString of a particular value.

The unit table consists of  rows representing physical quantities and columns
representing the units of measurement in which the quantities can be expressed.
The unit table is exposed in the automation interface below the root node as a
node labeled “Unit Table”. The elements in the collection below the Unit Table
node represent the rows of the table i.e. physical quantities. The labels of these
nodes are the names of the physical quantities. Below each physical quantity
node is a collection of nodes whose labels are strings representing the symbols of
the units of measurement in which the owning physical quantity may be
expressed.

For a node in the tree containing a physical value, the physical quantity, or Unit
Table row number, is obtained by reference to the property
AttributeValue(HAP_UNITROW). The unit of measurement symbol, or Unit
Table column number, is referenced by the property
AttributeValue(HAP_UNITCOL). Note that the attribute values are actual row
and column numbers and that when referencing the row numbers with the Unit
Table collections, you must subtract one from these values.

Converting the Units of Measure for a Value
You can retrieve a value in a specific unit with the ValueForUnit property.  The
ValueForUnit property takes two arguments, the desired unit row and the
desired unit column.



Using the
Aspen Plus
ActiveX
Automation
Server

38-16 Aspen Plus User Guide
Version 10.2

Example of Converting Units of Measure

Retrieve the pressure of block B3, both in the units specified in the run (psi) and in atm. atm is
column 3 in the Unit Table.
Sub UnitsConversionExample(ihAPSim As HappLS)
' This example retrieves a value both in the display units and an alternative
Dim ihPres As ihNode
Dim nRow As Long
Dim nCol As Long
Dim strDisplayUnits As String
Dim strConvertedUnits As String
On Error GoTo ErrorHandler
Set ihPres = ihAPSim.Tree.Data.Blocks.B3.Output.B_PRES
' retrieve the attributes for the display units (psi)
nRow = ihPres.AttributeValue(HAP_UNITROW)
nCol = ihPres.AttributeValue(HAP_UNITCOL)
strDisplayUnits = UnitsString(ihAPSim, nRow, nCol)
'select the alternative unit table column (atm)
nCol = 3
strConvertedUnits = UnitsString(ihAPSim, nRow, nCol)
MsgBox "Pressure in Display units: " & ihPres.Value & _

" " & strDisplayUnits & Chr$(13) & _
"Pressure in Converted units: " & _
ihPres.ValueForUnit(nRow, nCol) & " " & strConvertedUnits, _
, "UnitsConversionExample"

Exit Sub
ErrorHandler:
MsgBox "UnitsConversionExample raised error " & Err & ": " & Error(Err)
End Sub
Public Function UnitsString(ihAPSim As IHApp, nRow As Long, nCol As Long)
' This function returns the units of measurement symbol given
' the unit table row and column
On Error GoTo UnitsStringFailed
UnitsString = ihAPSim.Tree.Elements("Unit Table"). _

Elements(nRow - 1).Elements.Label(0, nCol - 1)
Exit Function
UnitsStringFailed:
UnitsString = ""
End Function

Changing the Units of Measure for the Aspen Plus Run
You can use the HAP_UNITCOL attribute to directly change the units of
measurement in the Aspen Plus run.

Changing the HAP_UNITCOL attribute value has a different effect depending on
whether the value in an Input or Output value, as follows:
• Changing the HAP_UNITCOL attribute of an output value will convert the

retrieved output value into the selected unit of measurement.  This is
equivalent to changing the units on a Results sheet in the Aspen Plus GUI.

• Changing the HAP_UNITCOL attribute for an input value node will change
the input specification units. It does not convert the value into the selected
unit of measurement.  This is equivalent to changing the units on an Input
sheet in the Aspen Plus GUI.



Chapter  38

Aspen Plus User Guide 38-17
Version 10.2

Example of Changing Units of Measure
Sub UnitsChangeExample(ihAPsim As HappLS)
Dim ihPres As ihNode
On Error GoTo ErrorHandler
Set ihPres = ihAPsim.Tree.Data.Blocks.B3.Output.B_PRES
MsgBox "Pressure in default units: " _

& ihPres.Value _
& Chr(9) & ihPres.UnitString

' change units of measure to bar
ihPres.AttributeValue(HAP_UNITCOL, True) = 5
MsgBox "Pressure in selected units: " _

& ihPres.Value _
& Chr(9) & ihPres.UnitString

Exit Sub
ErrorHandler:
MsgBox "UnitsChangeExample raised error " & Err & ": " & Error(Err)
End Sub

Referencing Non-Scalar Variables in the
Automation Interface

Most of the data in a simulation problem is organized into arrays, lists or tables,
and therefore is contained in multi-valued variables.

Non-scalar data is accessed through the automation interface one value at a time
via the Value property of a leaf node. The organization of the nodes which yield
the values depends both upon on the number of identifiers required to identify
the value, and upon the context. For example:
• A value in a column temperature profile requires the variable name and one

additional identifier: the stage number.
• A value in a column composition profile requires the variable name and two

additional identifiers: the stage number and the component
• A reaction coefficient within a reactor requires the variable name and three

additional identifiers: the reaction number, the component and the substream

Once a multi-valued variable node is located, selection of identifiers to reach the
required individual value involves traversing down the tree. In some cases a
single node traversal represents selection of a single identifier. In other cases
traversal of a node represents selection of more than one identifier. Each node
has the property Dimension. If the value of Dimension is > 0 then the node has
offspring. The value of the Dimension property for a node determines the number
of identifiers associated with an offspring of that node. Dimensions are
referenced by an offset; the first dimension number is zero and the last
dimension number is the value of the Dimension property minus one.
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Offspring nodes are obtained in one of two ways:
• Using an iterator to loop through the collection object. For example, using a

For Each loop in Visual Basic
• Using the Item property of the collection object and specifying an argument

for each Dimension of the collection. The argument may be either:
• An integer Location (also known as RowNumber) which represents the

ordinal number within the dimension. The first Location in each
dimension is numbered zero.

• A string Label which identifies the offspring node within in the
Dimension

For each dimension you can obtain the number of valid locations or labels from
the RowCount property of the collection.

Accessing Variables With a Single Identifier: Column
Temperature Profile

The temperature profile in a RadFrac column is an example of a variable with a
single identifier. For the pfdtut simulation results, the temperature profile is
displayed in the Data Browser in tabular form under Blocks>B6>Profiles>TPFQ.

The same information is located in the Variable Explorer under the
Root>Data>Blocks>B6>Output>B_TEMP variable node. Under this node there
are fifteen leaf nodes labeled 1 through 15, corresponding to the temperatures on
the stages.



Chapter  38

Aspen Plus User Guide 38-19
Version 10.2

The structure of the information is shown schematically below:

Variable Name: B_TEMP

Identifier: Stage Number

Value Node

Example Showing How to Access Column Temperature Profile through
the Automation Interface

To obtain the B_TEMP variable node:
Set ihTVar =ihAPSim.Tree.Data.Blocks.B6.Output.B_TEMP

Next, create a simple iteration loop to access the offspring nodes representing the
stages.
For Each ihStage In ihTVar.Elements
.
.
Next ihStage
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The identifier representing the stage number is retrieved by the Name property
of the stage node. The temperature value is retrieved from the Value property of
the stage node.

Sub TempProfExample(ihAPsim As HappLS)
' This example retrieves values for a non-scalar variable with one identifier
Dim ihTVar As ihNode
Dim ihStage As ihNode
Dim strOut As String
On Error GoTo ErrorHandler
Set ihTVar = ihAPsim.Tree.Data.Blocks.B6.Output.B_TEMP
strOut = ihTVar.Elements.DimensionName(0) & Chr(9) & ihTVar.Name
For Each ihStage In ihTVar.Elements

strOut = strOut & Chr(13) & ihStage.Name _
& Chr(9) & Format(ihStage.Value, " ### .00") _
& Chr(9) & ihStage.UnitString

Next ihStage
MsgBox strOut, , "TempProfExample"
Exit Sub
ErrorHandler:
MsgBox "TempProfExample raised error " & Err & ": " & Error(Err)
End Sub

Accessing Variables with 2 Identifiers: Column
Composition Profile

The liquid composition profile for RadFrac is an example of a variable with two
identifiers. For the pfdtut simulation results, the variable X in the Variable
Explorer tree view is shown in this diagram.
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The first level of nodes below the variable X represents the stages in the column
and each node has the Name property set to the stage number. The second level
of nodes contains the nodes for each of the component compositions and the
Name property of these nodes is the component id. The Value property of the
second level node is the composition of the component in the stage represented by
the first level node. This is shown schematically below.

Variable Name: X

Second Identifier: Component

First Identifier: Stage Number

Value Node

The following code fragment illustrates how to retrieve the component
compositions from this structure. It contains two nested loops which iterate
through the levels to access the value nodes.
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Public Sub CompProfExample(ihAPsim As HappLS)
’ This example retrieves values for a non-scalar variable with two
’ identifiers
Dim ihTrayNode As ihNode
Dim ihXNode As ihNode
Dim ihCompNode As ihNode
Dim strOut As String
On Error GoTo ErrorHandler
Set ihXNode = ihAPsim.Tree.Data.Blocks.B6.Output.Elements("X")
For Each ihTrayNode In ihXNode.Elements

For Each ihCompNode In ihTrayNode.Elements
strOut = strOut & Chr(13) & ihTrayNode.Name & _

Chr(9) & ihCompNode.Name & Chr(9) & _
ihCompNode.Value

Next ihCompNode
Next ihTrayNode
MsgBox strOut, , "CompProfExample"
Exit Sub
ErrorHandler:
MsgBox "CompProfExample raised error " & Err & ": " & Error(Err)
End Sub

Accessing Variables With 3 Identifiers: Reaction
Coefficients

The following diagram shows the Variable Explorer tree view for the the RStoic
reactor block B2 in the pfdtut simulation.

In the RStoic reactor model, the stochiometric coefficients of the reactions are
held in the input variables COEF and COEF1 which represent the reaction
coefficients for the reactants and products, respectively.
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Both these nodes have a list of offspring nodes, each of which represents a
reaction equation.

As this block has only one reaction, both COEF and COEF1 have just one
offspring node labeled “1” representing the single reaction with the reaction
number “1”.

The reaction node has two dimensions so the Dimension property of this node
returns a value of 2. There are two identifiers associated with each offspring. The
identifier for the first dimension is the component of the reactant. The identifier
for the second dimension is the substream, in this case the MIXED substream.

This structure is shown schematically in the following diagram.
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Variable Name: COEFF

First identifier: Reaction Number

Second Identifier:Component
Third Identifier: Substream

Value Node

The reaction node is an example of a node which uses paired scrolling of
identifiers. Here the only significant offspring nodes are those with the same row
number in each dimension. The existence of paired scrolling may be determined
from the value of the property AttributeValue (HAP_FIRSTPAIR). If the node
uses paired scrolling of offspring, this property returns the 1-based index of the
first item of the scrolling pair.

The following example code shows how to retrieve the coefficients under the
COEF node together with the associated identifiers. Note that because paired
scrolling is used, only the nodes with the same value of location in each
dimension are accessed.

Sub ReacCoeffExample(ihAPsim As HappLS)
' This example illustrates retrieving values for a non-scalar variable
' with three identifiers
Dim ihReacNode As ihNode
Dim ihCoeffNode As ihNode
Dim intOff As Long
Dim strHeading As String
Dim strTable As String
Dim nReacCoeff As Integer
On Error GoTo ErrorHandler
Set ihCoeffNode = ihAPsim.Tree.Data.Blocks.B2.Input.COEF
' loop through reaction nodes
For Each ihReacNode In ihCoeffNode.Elements
strHeading = ihCoeffNode.Elements.DimensionName(0) _
& Chr(9) & ihReacNode.Elements.DimensionName(0) _
& Chr(9) & ihReacNode.Elements.DimensionName(1)

nReacCoeff = ihReacNode.Elements.RowCount(0)
' loop through coefficient nodes retrieving component and substream
' identifiers and coefficient values
For intOff = 0 To nReacCoeff - 1
strTable = strTable & Chr(13) & ihReacNode.Name & Chr(9) _
& Chr(9) & ihReacNode.Elements.Label(0, intOff) & Chr(9) _
& Chr(9) & ihReacNode.Elements.Label(1, intOff) & Chr(9) _
& Chr(9) & ihReacNode.Elements.Item(intOff, intOff).Value

Next intOff
MsgBox strHeading & strTable, , "ReacCoeffExample"

Next ihReacNode
Exit Sub
ErrorHandler:
MsgBox "ReacCoeffExample raised error " & Err & ": " & Error(Err)
End Sub
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Flowsheet Connectivity and Automation

The connections between blocks and streams in the flowsheet may be accessed
via the Automation server. In addition, these connections may be modified, and
blocks and streams may be added or deleted.

Accessing Flowsheet Connectivity
The Port and Connection nodes of both Block and Stream nodes hold information
about their ports and what is connected to the ports.

This code sample displays a table showing source and destination blocks and
ports for all streams in the flowsheet.
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Sub ConnectivityExample(ihAPsim As HappLS)
' This example displays a table showing flowsheet connectivity
Dim ihStreamList As ihNode
Dim ihBlockList As ihNode
Dim ihDestBlock As ihNode
Dim ihSourceBlock As ihNode
Dim ihStream As ihNode
Dim strHeading As String
Dim strTable As String
Dim strDestBlock As String
Dim strDestPort As String
Dim strSourceBlock As String
Dim strSourcePort As String
Dim strStreamName As String
Dim strStreamType As String

On Error GoTo ErrorHandler
Set ihStreamList = ihAPsim.Tree.Data.Streams
Set ihBlockList = ihAPsim.Tree.Data.Blocks

strHeading = "Stream" & Chr(9) & "From" _
& Chr(9) & Chr(9) & Chr(9) & "To" & Chr(13)

For Each ihStream In ihStreamList.Elements
strStreamName = ihStream.Name
strStreamType = ihStream.AttributeValue(HAP_RECORDTYPE)
' get the destination connections
Set ihDestBlock = ihStream.Elements("Ports").Elements("DEST")
If (ihDestBlock.Elements.RowCount(0) > 0) Then

' there is a destination port
strDestBlock = ihDestBlock.Elements(0).Value
strDestPort = ihBlockList.Elements(strDestBlock). _
Connections.Elements(strStreamName).Value

Else
' it's a flowsheet product
strDestBlock = ""
strDestPort = ""

End If
' get the source connections
Set ihSourceBlock = ihStream.Elements("Ports").Elements("SOURCE")
If (ihSourceBlock.Elements.RowCount(0) > 0) Then

' there is a source port
strSourceBlock = ihSourceBlock.Elements(0).Value
strSourcePort = ihBlockList.Elements(strSourceBlock). _
Connections.Elements(strStreamName).Value

Else
' it's a flowsheet feed
strSourceBlock = ""
strSourcePort = ""

End If

strTable = strTable & Chr(13) & strStreamName _
& Chr(9) & strSourceBlock _
& Chr(9) & strSourcePort & Chr(9) _
& Chr(9) & strDestBlock & Chr(9) _
& strDestPort

Next ihStream
MsgBox strHeading & strTable, , "ConnectivityExample"
Exit Sub

ErrorHandler:
MsgBox "ConnectivityExample raised error" & Err & ": " & Error(Err)

End Sub
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Manipulating Blocks and Streams
You can add and delete streams and blocks, and connect and disconnect streams
froms blocks, using the Add and Remove methods of Block, Stream, and Port
collection objects.

Adding and Deleting Blocks

To add a block, call the Add method of the Blocks collection, with an input
argument of "block name!block type". For example:
Dim problem as HappLS
Dim blocknode as IHNode
Set problem = CreateObject("Apwn.document")

set blocknode = problem.Tree.Elements("Data").Elements("Blocks")
blocknode.Elements.Add("B1!RADFRAC")

To delete a block, call the Remove method of the Blocks collection with an input
argument of the block name. For example:
blocknode.Elements.Remove("B1")
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Adding and Deleting Streams

To add a stream, call the Add method of the Streams collection with an input
argument of "stream name!stream type". The streamtype is optional; it defaults
to MATERIAL. For example:

Dim problem as HappLS
Dim streamnode as IHNode
Set problem = CreateObject("Apwn.document")

set streamnode = problem.Tree.Elements("Data").Elements("Streams")
streamnode.Elements.Add("S1!MATERIAL")
streamnode.Elements.Add("S2")
streamnode.Elements.Add("S3!HEAT")

To delete a stream, call the Remove method of the Streams collection with an
input argument of the stream name. For example:

streamnode.Elements.Remove(“S1”)

Connecting and Disconnecting Streams

To connect a stream, call the Add method of the Ports collection of the given
block. The element name should be the name of the stream to be connected. For
example:
blocknode.Elements("B1").Elements("Ports").Elements.Add("S1")

To disconnect a stream, call the Remove method of the Ports collection of the
block. For example:
blocknode.Elements("B1").Elements("Ports").Elements.Remove("S1")

Manipulating Libraries and Model Library Categories
The IHAPLibRef interface allows an automation client to access the libraries
associated with a problem and the categories shown on the Model Library, and to
add, delete, and rearrange libraries and categories. The LibRef method of the
problem (HappIP object) provides access to this interface. See Members of Class
IHAPLibRef, page 38-45, for details on the functions in this interface.

Example of Creating a Flowsheet via OLE

Get the IHAPLibRef interface from the problem:
Dim problem as HappLS
Dim libref as IHAPLibRef

Set problem = CreateObject("Apwn.document")
Set libref = problem.Libref
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List the referenced libraries:
For count = 0 To libref.CountLibs - 1

Debug.Print libref.LibraryName(count)
Debug.Print libref.LibraryPath(count)

Next count

Add a new reference as first referenced library
libref.InsertLibrary "f:\kessel\fcc.apm", 0

And show problem so that you can see the model library and library references:
problem.visible = TRUE

Controlling the User Interface from an
Automation Client

The HappLS object provides methods and events which allow the control of the
user interface from within an automation client. These methods and events allow
an automation client to:
• Handle Aspen Plus events
• Suppress dialog boxes
• Disable user interface features
• Automate the initial connection to the simulation engine

Handling Aspen Plus Events
The Aspen Plus application object, HappLS, supports an outgoing event
interface, IAPHappEvent, consisting of events for the HappLS class. See



Using the
Aspen Plus
ActiveX
Automation
Server

38-30 Aspen Plus User Guide
Version 10.2

The IAPHappEvent Event Interface, page 38-38, for details on each event.

In Visual Basic or VBA, the events are available by declaring a variable of type
HappLS using the WithEvents keyword. This must be done in a form or class
module. That variable is then set to the simulation problem. Be sure to release
this object with an appropriate termination method.

In C++, implement an object that supports the IAPHappEvent interface, which is
defined as a dispinterface. Use the connection point interfaces to connect this
outgoing interface to application object.

The following code fragment implements a Visual Basic automation client that
displays control panel messages.

Dim WithEvents sim As HappLS
Dim fCP As frmControlPanel ‘ a form with a text box

Private Sub LoadSimulation(fn As String)
On Error GoTo ErrorHandler
set fCP = new frmControlPanel
' a label control on the main form
LabelProblem.Caption = "loading " & fn
MousePointer = vbHourglass
' reset the ole message filter to get rid of annoying Server busy message
App.OleRequestPendingTimeout = 100000
Set sim = CreateObject("Apwn.Document")
Call sim.InitFromArchive2(fn, 0)
sim.Visible = false
App.OleRequestPendingTimeout = 10000
MousePointer = vbDefault
Exit Sub
ErrorHandler:
Debug.Print Err.Description
Err.Clear
labelProblem.Caption = "failed to load problem"
Set sim = Nothing
MousePointer = vbDefault
App.OleRequestPendingTimeout = 10000
End Sub

Private Sub Sim_OnControlPanelMessage(ByVal Clear As Long, ByVal msg As String)
If Clear Then

fCP.txtMsg.Text = ""
Else

fCP.txtMsg = fCP.txtMsg.Text & vbCrLf & msg
End If
On Error GoTo ErrHandler
Exit Sub
ErrHandler:

Debug.Print "Error " & Err.Description
Err.Clear

End Sub
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Suppressing Dialog Boxes
When starting Aspen Plus 10.2 as an automation server, the default behavior is
to display no messages or dialog boxes unless an automation method to
specifically meant to show a dialog is used or the GUI is visible and the user
selects an operation that shows a dialog, such as a menu item. This behavior can
turned off with the IHapp SuppressDialogs property. This property should
normally be set to false when the application is made visible for interactive use.

When dialogs are suppressed, the outgoing event OnDialogSuppressed() is
triggered whenever a warning message or a suppressed dialog is encountered
while dialogs are suppressed. See Handling Aspen Plus Events, above, for more
information.

Some automation interface methods explicitly show an interactive dialog, such as
ConnectDialog(). Some other automation methods show an interactive dialog only
sufficient arguments are not supplied. For example,

call IHapp.Engine.Reinit()

will show the reinit dialog while
call IHapp.Engine.Reinit(IAP_REINIT_SIMULATION)

will not show a dialog.

Disabling User Interface features
A method, UIDisable, has been added to the IHapp interface to allow the
automation client to disable user interface features before making the
automation server interactive.

To disable a menu item, call UIDisable with a string input argument containing
the slash-delimited path to the menu item. Once an item has been deactivated it
cannot be reactivated.

Example of Disabling Save and SaveAs

In this code fragment, a simulation is opened and the Save and SaveAs functions in
Aspen Plus are disabled.

Dim Sim As HappLS

Public Sub main()
On Error GoTo MainErrHandler

Set Sim = CreateObject("Apwn.Document")
Call Sim.InitFromArchive2("pfdtut.bkp", 0)
Call Sim.UIDisable("File/Save")
Call Sim.UIDisable("File/Save As")

' make interactive
Sim.SuppressDialogs = False
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Sim.Visible = True
Set Sim = Nothing
' and exit
Exit Sub
MainErrHandler:
Err.Clear
End Sub

Automating the Initial Connection to the Simulation
Engine

One set of user interactions that is not covered with dialog suppression is the
initial connection to the simulation engine when no activator is present. The
IHAPEngine Host and ConnectionDialog methods can be used when an activator
is present or for subsequent connections. The IHapp file loading routines
InitFromArchive2 and InitFromFile2 methods have optional arguments to supply
the information that normally might be shown in the connection dialog.

The Visual Basic GetObject() call always shows the connection dialog in this
situation. To avoid this use the Visual Basic CreateObject() call followed by an
InitFromArchive2() or an InitFromFile2() call. In C++, use CoCreateInstance()
followed by the Init call rather than a BindToObject() call. For testing a Visual
Basic client, using GetObject() to connect to a running Aspen Plus problem is
often the better solution.

The example under Handling Aspen Plus Events shows the CreateObject() call.
See Initialization Methods to be Used with CreateObject(), page 38-36, for more
information about the InitFromArchive2 and InitFromFile2 methods.

Controlling a Simulation from an
Automation Client

The Engine property of a Happ object returns a IHAPEngine object, which is an
interface to the simulation engine. The Happ and IHAPEngine objects provide
methods to enable an Automation client program to run and control a simulation.

The following code fragment illustrates how a user is prompted for a simulation
parameter, the simulation is re-run and the updated results are displayed to the
user.
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Public Sub RunExample(ihAPsim As HappLS)
' This example changes a simulation parameter and re-runs the simulation
Dim ihEngine As IHAPEngine
Dim nStages As Variant
Dim strPrompt As String
On Error GoTo ErrorHandler
Set ihEngine = ihAPsim.Engine
EditSimulation:
nStages = ihAPsim.Tree.Data.Blocks.B6.Input.Elements("NSTAGE").Value
strPrompt = "Existing number of stages for column B6 = " & nStages _

& Chr(13) & "Enter new value for number of stages."
nStages = InputBox(strPrompt)
If (nStages = "") Then GoTo finish
' edit the simulation
ihAPsim.Tree.Data.Blocks.B6.Input.Elements("NSTAGE").Value = nStages
' run the simulation
ihAPsim.Run
' look at the status and results
Call ListBlocksExample(ihAPsim)
Call TempProfExample(ihAPsim)
GoTo EditSimulation
finish:
Exit Sub
ErrorHandler:
MsgBox "RunExample failed with error " & Err & Chr(13) & Error(Err)
End Sub

Run2 Interface

The Run2 interface methods IHapp.Run2 and IHapp.Engine.Run2 take an
optional argument to make the simulation run asynchronous. This allows the
automation client to proceed with other tasks while waiting for the simulation
run to complete. Aspen Plus should always be run asynchronously if the
application is visible. Below is a simple example of running the engine
asynchronously. In this example the calling thread is put into a busy wait state.
In a real client this thread could continue to do work as well as any other threads
in the application.

Private Declare Sub Sleep Lib "kernel32" (ByVal dwMilliseconds As Long)
....
Set eng = MySim.Engine

' call run asynchronously
Call eng.Run2(True)
' busy wait until done , sleep 1/2 sec and poll if done
While (eng.IsRunning)

Call Sleep(500)
Wend
'continue
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Exporting Files from an Automation
Client

A new automation method,.Export, has been added to the IHapp interface to
export file formats other that Aspen Archive and Aspen Document formats.

Example of using the Export method

This code fragment illustrates the use of the Export method to export a report file.

Dim MySim As HappLS

Public Sub Main()
On Error GoTo MainErrHandler

Set MySim = CreateObject("Apwn.Document")
Call MySim.InitFromArchive2("pfdtut.bkp", 0)
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Call MySim.Export(HAPEXP_REPORT, "pfdtut.rep")
Set MySim = Nothing

Exit Sub
MainErrHandler:
Err.Clear

End Sub

Members of Aspen Plus Classes

This section lists the members of each of the exposed Aspen Plus classes.

Members of Class HappLS

Standard VB Properties and Properties to Manipulate the Main
Window

Name and Arguments Member Type Read-only Description

Activate() Sub Activate the application

Application As HappLS Property Yes Returns the application of the object

FullName As String Property Yes Returns the full name of the application

Name As String Property Yes Returns the name of the application

Parent As Happ Property Yes Returns the creator of the object

Visible As Boolean Property Returns the visible state of the application

Properties to Access Other Parts of the Object Model

Name and Arguments Member Type Read-only Description

Engine As IHAPEngine Property Yes Return the interface to the simulation engine

Tree As IHNode Property Yes Get top node of file
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Basic File Operations

Name and Arguments Member Type Read-only Description

Save() Sub Saves current file

SaveAs(filename As String,
[overwrite])

Sub Saves current file under new name

Restore2(filename As String) Property Yes Restores, or merges, an archive file into the current problem

WriteArchive2(filename As
String, savechildren as long)

Sub Exports an archive file.

Export(reptype as
HAPEXPType, filename as
String)

Sub Export a file of a type determined by reptype with the specified
name. Possible values of reptype:

HAPEXP_BACKUP
HAPEXP_REPORT
HAPEXP_SUMMARY
HAPEXP_INPUT
HAPEXP_INPUT_GRAPHICS
HAPEXP_RUNMSG
HAPEXP_REPORT_INPUT
HAPEXP_REPORT_SUMMARY
HAPEXP_FLOWDYN
HAPEXP_PDYN
HAPEXP_DXF

Backup file
Report file
Summary file
Input file
Input file with graphics
Run Message file
Report and input files
Report and summary files
Flow Driven Dynamic Simulation
P Driven Dynamic Simulation
Flowsheet Drawing

Initialization Methods to be Used with CreateObject()

Name and Arguments Member Type Read-only Description

InitFromArchive2(
filename as String,
host_type as Integer,
node as String,
username as String,
password as String,
working_directory as String,
failmode as Integer)

Sub Open an Aspen Plus archive file and connect to the simulation
engine.

filename is the name of the problem to open,
host_type is a zero-based index of the entry of the host in the
initialization file,
node is the name of the remote machine to connect to,
username, password, and working_machine are the account name,
password, and working directory to use to connect to the remote
machine,
failmode is 0 (default) if connection failure show show the connect
dialog, or non-zero if failure exits the automation server.

All arguments but filename are optional.

InitFromTemplate2 (filename As
String, …)

Sub Opens a template and initializes

InitFromTemplate2 has the same arguments as InitFromArchive2.

InitFromFile2(
filename as String, ...)

Sub Open an Aspen Plus document and connect to the simulation
engine.

InitFromFile2 has the same arguments as InitFromArchive2.
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Basic Run Operations

Name and Arguments Member Type Read-only Description

Reinit() Sub Reinitialize the simulation case. To reinitialize specific blocks or
streams, use the Reinit member of the IHAPEngine class.

Run2([asynchronous]) Sub Run the simulation case, asynchronously if the argument is True. If
the user interface is visible, simulations should always be run
asynchronously.

Selection Buffer Operations Used to do Cut and Paste Strictly Via
Automation

Name and Arguments Member Type Read-only Description

DeleteSelection(Key As String) Sub Delete a selection buffer.

NewSelection(Key As String) As
IHSelection

Function Create and return a new selection buffer.

SaveSelection(Key As String) Sub Save a selection buffer.

Selection(Key As String) As
IHSelection

Property Yes Retrieve a selection buffer.

Disabling User Interface Items

Name and Arguments Member Type Read-only Description

UIDisable(key as String) Sub Disable user interface item denoted by key.

Key is a slash-delimited path of the menu item, such as File/Save.

Once an item has been deactivated it cannot be reactivated.
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The IAPHappEvent Event Interface

These items are members of the HappLS class.

Events in the Event Interface

Name and Arguments Member Type Read-only Description

OnDialogSuppressed(msg as
String, result as String)

Event Indicates that a warning message was generated and not shown in
a message box, or that a dialog would be shown if the application
was interactive.

Msg is the text of the warning or a message describing the dialog.
In some cases, this might be a message indicating that an
interactive action is not possible when dialogs are being
suppressed.

Result is the default choice for the message box or the dialog
option.

OnControlPanelMessage(clear
as Boolean, msg as string)

Event Indicates a control panel message was generated. Clear is true if
the message indicates to clear the control panel. Otherwise, msg
contains the text of the message sent to the control panel.

OnGUIClosing() Event Indicates the user interactively closed the application. May be used
to notify an automation client that it should disconnect from the
automation server. Note this does not indicate that the automation
server is closing, that will not occur until both the GUI is closed and
automation client release any objects that they hold from the
automation server.

OnDataChanged(pObj as
Object)

Event Indicates a data entry value is changed. Used to notify clients that
they may need to check the completion status of the simulation
problem or an object within the simulation.

pObj is the object that was modified, usually an IHNode

Property related to the Event Interface

Name and Arguments Member Type Read-only Description

SuppressDialogs as Boolean Property Specifies whether Aspen Plus suppresses most messages and
dialog boxes, normally True when Aspen Plus is started as an
automation server. Should be set False is such an invocation is
subsequently made available for interactive use.
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Members of Class IHNode

Standard VB Properties

Name and Arguments Member Type Read-only Description

Application As HappLS Property Yes Returns the application of the object.

Parent As HappLS Property Yes Returns the creator of the object.

Properties to Access Other Parts of the Object Model

Name and Arguments Member Type Read-only Description

Dimension As Long Property Yes Return the number of dimensions in the directory (0 for scalar).

Elements As IHNodeCol Property Yes Return a collection object containing the node’s offspring nodes
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Access Data Values

Name and Arguments Member Type Read-only Description

AttributeType (attrnumber As
Integer) As Integer

Property Yes Get type of attribute for attrnum:
1=int
2=real
3=string
4=node
5=memory block
(see Enum HAPAttributeNumber for possible values).

AttributeValue (attrnumbe As
Integer, [force])

Property Get the value of the attribute for attrnum (see Enum
HAPAttributeNumber for possible values).

HasAttribute (attrnumber As
Integer) As Boolean

Property Yes Checks whether attribute is defined for attrnum (see
HAPAttributeNumber for possible values).

SetValueAndUnit(Value, unitcol
As Integer, [force])

Sub Store the value attribute and the Unit of Measurement attribute of
the object simultaneously.

SetValueUnitAndBasis (Value,
unitcol As Integer, basis As
String, [force])

Sub Store the value attribute, the Unit of Measurement attribute, and the
basis for the object simultaneously.

Value([force]) Property Get the value attribute of the object.

ValueForUnit(unitrow As Integer,
unitcol As Integer)

Property Gets the value in the specified units.

ValueType As Integer Property Yes Get type of value attribute:
0=not defined
1=int
2=real
3=string
4=node
5=memory block
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Helper Methods

Name and Arguments Member Type Read-only Description

FindNode(path As String) As
IHNode

Function Navigate to a different node.

Name([force]) As String Property Returns the name of the object (force argument is unused).

UnitString As String Property Yes Returns the unit of measurement symbol of the node value as a
string.

Methods Used to Manipulate the Data

Name and Arguments Member Type Read-only Description

Clear() Sub Clear contents of the node.

Delete() Sub Delete element.

RemoveAll() Sub Remove all elements.

Members of Class IHNodeCol

Standard VB Properties

Name and Arguments Member Type Read-only Description

Application As HappLS Property Yes Returns the application of the object.

Parent As HappLS Property Yes Returns the creator of the object.

Main Navigation Method

Name and Arguments Member Type Read-only Description

Item(loc_or_name,
[loc_or_name2], [loc_or_name3],
[loc_or_name4],
[loc_or_name5]) As IHNode

Property Yes Given a set of indices or names, returns an element in the
collection
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Principal Data Manipulation Methods

Name and Arguments Member Type Read-only Description

Add([loc_or_name],
[loc_or_name2], [loc_or_name3],
[loc_or_name4],
[loc_or_name5]) As IHNode

Function Creates and adds a child of type:
1 = scalar
4 = list
5 = named list, with value type of:
0=not defined
1=int
2=real
3=string
4=node
5=memory block.

Insert(element As IHNode,
[loc_or_name], [loc_or_name2],
[loc_or_name3], [loc_or_name4],
[loc_or_name5])

Sub Inserts an element into collection.

InsertRow(dimension As Long,
location As Long)

Sub Inserts a new row at location in the specified dimension, dim.

Remove(loc_or_name,
[loc_or_name2], [loc_or_name3],
[loc_or_name4],
[loc_or_name5]) As IHNode

Function Removes an element.

RemoveRow(dimension  As
Long, location As Long)

Sub Removes a row at location in the specified dimension, dim.

Important Properties About the Data

Name and Arguments Member Type Read-only Description

Dimension As Long Property Yes Returns the number of dimensions in the directory.

Label(dimension As Long,
location As Long, [force]) As
String

Property Returns the row label for the specified row location in the specified
dimension (force argument is unused).

LabelLocation(Label As String,
dimension As Long) As Long

Property Yes Returns the location, or row number, of the label along the
dimension, dim.

RowCount(dimension As Long)
As Long

Property Yes Returns the number of elements in the dimension.
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Other Properties About the Data

Name and Arguments Member Type Read-only Description

Count Property Yes Returns total number of object slots in collection.

DimensionName(dimension  As
Long) As String

Property Yes Gets a display name for the given dimension for variable or table.

LabelNode(dimension As Long,
location As Long, [Label]) As
IHNode

Property Yes Returns a node for manipulating the label.

IsNamedDimension ([dim]) As
Boolean

Property Yes Returns whether the rows for this dimension of the collection are
named.

ItemName(location As Long,
[dim], [force]) As String

Property Returns name or row name for element at location (force argument
is unused).

LabelAttribute(dimension  As
Long, location As Long, attrnum
As Integer, [force])

Property Returns the value of an attribute for the label in the row, location,
along the dimension, dim, for attrnum (see HAPAttributeNumber for
possible values), (force argument is unused).

LabelAttributeType(dimension
As Long, location As Long,
attrnum As Integer) As Integer

Property Yes Returns the type of an attribute for the label in the row, location,
along the dimension, dim, for attrnum (see HAPAttributeNumber for
possible values).

Members of Class IHAPEngine

Basic Run Operations

Name and Arguments Member Type Read-only Description

MoveTo(object_type As
IAP_MOVETO_TYPE,
[object_id])

Sub Move current simulation step to object or begining of sequence.

Reinit([object_type], [object_id]) Sub Reinitialize all or portion of simulation (if object_type is used it must
be an IAP_REINIT_TYPE.)

Run2([asynchronous]) Sub Run simulation problem, asynchronously if the argument is True. If
the user interface is visible, simulations should always be run
asynchronously.

Stop() Sub Stop simulation run.
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Manipulate Stop Points

Name and Arguments Member Type Read-only Description

AddStopPoint(type As
IAP_STOPPOINT_TYPE,
object_id As String,
before_or_after As Long)

Sub Add a stop point, before_or_after:
1 = before
2 = after.

ClearStopPoints() Sub Clear all stop points.

DeleteStopPoint(index As Long) Sub Delete stop point based on 1-based index.

StopPointCount As Long Property Yes How many stop points are set?

GetStopPoint(index As Long,
type As
IAP_STOPPOINT_TYPE,
object_id As String,
before_or_after As Long)

Sub Retrieve information about a stop point, index: 1-based index of
stop point before_or_after: 1 = before , 2 = after.

Manipulate the Client-Server Communications

Name and Arguments Member Type Read-only Description

Host(host_type As Long, [node],
[username], [password],
[working_directory]) As Boolean

Function Connect to host specified by host_type (0-based index of available
host types).

HostCount As Long Property Yes Returns the number of host types available to connect to.

HostDescription (host_type As
Long) As String

Function Returns a description for the host type specifed by the host_type
index (0-based).

Miscellaneous Option Settings

Name and Arguments Member Type Read-only Description

EngineFilesSettings(file As
IAP_ENGINEFILES) As String

Property Retrieve setting for engine files.

OptionSettings(type As
IAP_RUN_OPTION) As
Boolean

Property Retrieve setting for simulation run options.
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Members of Class IHAPLibRef

Manipulate the Libraries Associated with a Problem

Name and Arguments Member Type Read-only Description

CountLibs() as Integer Property Yes Returns the number of libraries currently referenced by a problem

LibraryName(index as Integer)
as String

Property Yes Returns the library name of the library specified by the index.
In all these methods, the index is zero-based (first library is
specified by 0).

LibraryPath(index as Integer) as
String

Property Yes Returns the full path and filename of the library specified by index

InsertLibrary(path as String,
location as Integer) as String

Function Inserts a library into the reference list at a location specified by
index. Returns displayname of library

RemoveLibrary(location as
Integer)

Sub Removes the library location specified by index from reference list

MoveLibrary(fromloc as Integer,
toloc as Integer)

Sub Moves a library in search path

Manipulate the Categories Shown on the Model Library

Name and Arguments Member Type Read-only Description

CategoryName(index as Integer)
as String

Property Yes Returns the name of the category specified by the index.
In all these methods, the index is zero-based (first category is
specified by 0).

CategorySelected(name as
String) as Integer

Property Is 1 if specified category has been selected to display on the Model
Library

CategoryLocSelected(index as
Integer) as Integer

Property Is 1 if specified category (by 0 based index) has been selected to
display on the Model Library

MoveCategory(fromloc as
Integer, toloc as Integer)

Sub Moves a category in the category list
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39 Heat Exchanger Design
Program Interface

This chapter describes how to use the Aspen Plus heat exchanger design program
interface (HTXINT) to transfer heating/cooling curve data from an Aspen Plus
run to a heat exchanger design program.

The topics in this chapter include:
• Generating property data
• Starting HTXINT
• Selecting heating/cooling curve results
• Generating the interface file
• Using the interface in a design program

About the Heat Exchanger Design
Program Interface

You can use the heat exchanger design program interface (HTXINT) to select
heating/cooling curve data from an Aspen Plus run and transfer it to a file in a
format that can be read by these heat exchanger design programs:
• B-JAC's HETRAN
• HTFS's TASC, ACOL, and APLE
• HTFS's M-series programs, including M-TASC, M-ACOL, and M-APLE
• HTRI's ST, CST, ACE, PHE, and RKH
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You can extend the default data produced by the heating/cooling curves to include
all of the properties each design program needs.

Run HTXINT after completing an Aspen Plus run and before starting the design
program. HTXINT guides you through a series of prompts. Select the
heating/cooling curves for the design program.

HTXINT is an application written using the Aspen Plus summary file toolkit.

Generating Property Data in a Simulation

HTXINT uses property data from heating/cooling curves that can be generated by
many Aspen Plus unit operation models. To use HTXINT, you must first use
Aspen Plus to generate the required heating/cooling curves. Create one or more
heating/cooling curves for each block of interest. For details on specifying heating
and cooling curves, see Requesting Heating/Cooling Curve Calculations in
chapter 10. On the Hcurve form for the block:

1. Specify HXDESIGN in the Property Sets field.

2. Select the required number of points. See Specifying the Number of
Heating/Cooling Curve Points, this chapter.

3. Specify the pressure drop.

The following sections describe each step.

Specifying the Property Set

To generate the property data required for all supported heat exchanger program
interfaces, select the built-in property set HXDESIGN on the Hcurve forms.

Specifying the Number of Heating/Cooling Curve Points

The Aspen Plus default of ten intermediate points is generally acceptable. You
can increase or decrease this number. If the number of points exceeds the
maximum number that the heat exchanger program accepts, HTXINT selects the
points to include the end-points and any dew or bubble points in the
heating/cooling curve. Since Aspen Plus adds extra points for dew or bubble
points, more points may be generated than you request.
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Specifying Pressure Drops

HETRAN is the only design program that accepts non-isobaric property curves. A
heating/cooling curve with a pressure drop cannot be copied to the interface files
for the other programs.

HTRI programs accept up to three curves per side at different pressures. For
maximum accuracy, define three heating/cooling curves for:
• Inlet pressure
• Outlet pressure
• Intermediate pressure where phase change occurs

Starting HTXINT

To run HTXINT interactively, select the appropriate command:

Version Command

Windows HTXINT runid

Where:

runid is the ID of the Aspen Plus run

HTXINT reads the data from the summary file named runid.SUM. If runid.SUM
does not exist, HTXINT reads the data from the backup file named runid.BKP.

The program guides you with a series of prompts. To leave the HTXINT program
at any time, type EXIT or QUIT.

HTXINT asks for the name of the target design program:
Please enter the required interface. (BJAC, HTFS, M-HTFS or HTRI) >

Enter the vendor's name for the target design program:

Enter To write data for

BJAC HETRAN

HTFS TASC, ACOL, and APLE

M-HTFS M-TASC, M-ACOL, and M-APLE

HTRI ST, CST, ACE, PHE, and RKH
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HTXINT prompts for the units of measure:
Please select the units to display the data. (SI, ENG or MET) >

Select the units to use for displaying the heating/cooling curve data on the screen.
The options are Aspen Plus units sets.

The B-JAC, HTFS, and HTRI interfaces use the vendor-specific units set closest
to the selected Aspen Plus units set, when writing data to the interface file.
Different vendors use slightly different combinations of units in their units of
measure. The interface uses the most appropriate one. See Using the Interface
File in your Heat Exchanger Design Program, this chapter, for a list of the
corresponding units of measurement. The M-HTFS interface is always written in
SI units.

HTXINT prompts you for the name of the output file:
Please enter the output file name (Default is runid.ext) >>

The default output file is created in your default directory with the same filename
as the summary file. The extension depends on the target program. See Using the
Interface File in Your Heat Exchanger Design Program, this chapter, for
examples of the file extensions.

If you choose the name of a file that already exists, HTXINT asks if you want to
overwrite it or choose another filename.

Selecting Heating/Cooling Curve Results
to Export

To select the heating/cooling curve:

1. Enter the block ID.

2. Enter the heating/cooling curve number.

3. Choose whether to view or write the data for the heating/cooling curve.

When you complete Step 3, you are returned to Step 1. You can continue to select
and copy further heating/cooling curve data, up to the maximum number of
heating/cooling curves allowed by the heat exchanger design program.

The following sections describe each step.
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Entering the Block ID

HTXINT lists on the screen all blocks that have heating/cooling curves. Enter a
block ID to display the list of heating/cooling curves for that block. For example,
the screen displays:

The following blocks have Hcurves.
+----------------------------+
| Block ID | Model type |
+-----------+----------------+
| E01 | HEATX |
| T01 | RADFRAC |
+----------------------------+

Please select a block ID from the list. >

Entering the Heating/Cooling Curve Number

Enter the heating/cooling curve number from the list of heating/cooling curves for
the block. The screen displays:
The Hcurves for block E01 are as follows.
+--------------------------------------------------------------------+
|NUMBER|Side | Type| Pressure range | Temp. range | Vfrac range|
| | | | (N/SQM) | (K) | |
+------+-----+-----+--------------------+---------------+------------+
| 1 | HOT | HOT |0.410E+07 0.410E+07 |322.039 207.039|1.000 0.639 |
| 2 |COLD |COLD |0.445E+07 0.445E+07 |183.150 200.656|0.000 0.000 |
+--------------------------------------------------------------------+
Please select an Hcurve from the list by entering its number. > 2

Viewing and Writing the Data for the Heating/Cooling
Curve

HTXINT asks:
Do you wish to view data points for this curve? (Y/N) >

If you enter N, the data for this heating/cooling curve is written to the interface
file.

If you enter Y to view the data, the heating/cooling curve points appear. For
example:
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+----------+--------------+---------------+---------+
| TEMP | DUTY | PRES | VFRAC |
| (K) | (WATT) | (N/SQM) | |
+----------+--------------+---------------+---------+
| 322.039 | 0.31907E+04 | 0.41024E+07 | 1.000 |
| 317.775 | -0.71198E+05 | 0.41024E+07 | 1.000 |
| 311.584 | -0.21327E+06 | 0.41024E+07 | 0.994 |
| 301.130 | -0.46122E+06 | 0.41024E+07 | 0.980 |
| 290.675 | -0.72166E+06 | 0.41024E+07 | 0.963 |
| 280.221 | -0.99223E+06 | 0.41024E+07 | 0.941 |
| 269.766 | -0.12693E+07 | 0.41024E+07 | 0.916 |
| 259.312 | -0.15503E+07 | 0.41024E+07 | 0.888 |
| 248.857 | -0.18344E+07 | 0.41024E+07 | 0.857 |
| 238.403 | -0.21230E+07 | 0.41024E+07 | 0.822 |
| 227.948 | -0.24205E+07 | 0.41024E+07 | 0.779 |
| 217.493 | -0.27370E+07 | 0.41024E+07 | 0.724 |
| 207.039 | -0.30963E+07 | 0.41024E+07 | 0.639 |
+----------+--------------+---------------+---------+

Indicate whether you want to write the data for the heating/cooling curve by
responding to this prompt:
Do you want this Hcurve to be written to the interface file? (Y/N) >

If you enter Y, the heating/cooling curve data is written to the output file. If you
enter N, you can enter another heating/cooling curve number.

If the heating/cooling curve contains calculation errors, any points with errors are
indicated with an asterisk (*) and the following prompt appears:
Do you want data for the points with the calculation errors to be suppressed?
(Y/N) >

If you enter Y, the points with errors will be excluded.

Generating the Interface File

After you choose a heating/cooling curve to write to the interface file, HTXINT
provides prompts for descriptive data for the target design program. Examples of
information you may want to provide are a problem description, case name, and
hot or cold fluid name. HTXINT indicates when the number of characters you can
use is restricted, and validates your data entry.

HTXINT generates the input, then asks you if you want to select another
heating/cooling curve.
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The following text shows an example of providing descriptive data for the HTRI
interface.
Please provide a one line description of the problem up to 70 characters.
> HCURVE DATA COPIED FROM HEAT EXCHANGER E01
Please provide a one line case description of up to 70 characters.
> BASE CASE
Enter the cold fluid name. 12 characters maximum > C1
Data for curve has been written to the interface file.
Do you want to select another Hcurve? (Y/N) > N

Using the Interface File in Your Heat
Exchanger Design Program

The interface program creates a file containing heating/cooling curve data. This
file includes the descriptive data you entered at the prompts. The file format,
name, and how the file is used depends on the design program. The input file that
HTXINT produces contains only heating/cooling curve data. It does not contain
the complete data necessary to run the design program.

Design
Program

Interface
Filename

Units of
Measure†

Maximum Number
of Heating/Cooling
Curves

Maximum Number
of Heating/Cooling
Curve Points How to Use

B-JAC filename.bji SI, US,
metric

Hot side = 1
Cold side = 1

13 (inlet, outlet, dew
point, bubble point, and
up to 9 others)

Run B-JAC. Select Shell&Tube Heat
Exchanger Programs, then Thermal Design,
then Establish the Filename, then Create or
Modify Input File.

HTFS filename.dat SI, British,
metric

Hot side = 1
Cold side = 1

12 Edit and complete the data in the input file.

HTFS M-
Series

filename.psf†† SI only Hot side = 1
Cold side = 1

12 Run DOS program. Select Input Data Editor.
Then either create or edit input and import the
interface file, using function key F5.
Or
Run Windows program. Select Import
Simulator Input File from File menu.

HTRI filename.dat SI, US, MKH Hot side = 3
Cold side = 3

10 Edit and complete the data in the input file.
Or
Enter the program and select the input file.

†
These are the vendors' names for units of measurement sets that correspond approximately to the SI, ENG, and METRIC sets in Aspen Plus.

††
Use this file in the way described in this table. The format and units of a process simulator file are different from the usual HTFS input file.



Heat
Exchanger
Design
Program
Interface

39-8 Aspen Plus User Guide
Version 10.2



Aspen Plus User Guide 1
Version 10.2

Index

A

Accounting report information 5-7
Accuracy

evaluating of parameters 31-15
ACM

using with Aspen Plus 10-38
ACM flowsheets

modifying 10-39
Active links 37-16

saving files 37-24
ActiveX automation

using 38-1
Activity coefficient models

binary parameters 8-7
AD

using with Aspen Plus 10-38
ADA/PCS

about 32-1
Add New Curve 13-16
Adding

components to lists 6-14
text 13-8

Air separation
template 2-18

Algorithms
optimization 22-10
sequencing 17-21

Ambient pressure
changing default 5-5

Analysis
light ends 32-6

Annotations
adding to plots 13-7
specifying text attributes 14-5

Appearance

changing for flowsheets 4-15
Applications

examples 2-28
Aspen Custom Modeler

using with Aspen Plus 10-38
Aspen Dynamics

using with Aspen Plus 10-38
Aspen Modeler flowsheets

modifying 10-39
Aspen Modeler products

using with Aspen Plus 10-38
Aspen Plus

and process simulation 2-1
automation server 38-1
document files 15-2

Assay Data Analysis
run type description 2-5
using 32-2

Assays
creating 32-3
creating blends 32-8

Atom numbers 30-8
Attaching images 37-12
Attributes

changing plot 13-9
node 38-11

AttributeType 38-11
AttributeValue 38-11
Automation

about 38-2
accessing column temperature profiles 38-19
classes 38-35
clients 38-32
connecting to the engine 38-32
controlling simulation 38-32
dialog boxes 38-30
error handling 38-3
events 38-29
example 38-24
exporting files 38-34
flowsheet connectivity 38-25
libraries 38-28
model library 38-28
non scalar data 38-17
objects 38-35
tree structure 38-7
user interface 38-29, 38-31
using 38-2

Automation server
setting up 38-2
using 38-1, 38-2



2 Aspen Plus User Guide
Version 10.2

Axis mapping 13-11

B

Backup files
about 15-3

Balance blocks
convergence 25-5
creating 25-3
defining 25-2
overview 25-2
sequencing 25-6

Batch Operation button 5-21, 5-24
Batch runs 11-2

starting 11-10
status 11-10

Batch stream results 5-21, 5-24
Binary components

databanks search order 16-9
Binary data

generating 31-9
Binary parameters

list of available 8-6
Blends

creating 32-8
specifying 32-10

Blocks
aligning 4-18
attaching images 37-12
balance 25-2
Calculator 19-1
changing icons 4-17–4-18
convergence results 12-5
creating pressure relief 33-2
Excel Calculator 19-1, 19-5
finding 4-9
Fortran 19-1, 19-3, 19-4
IDs 4-17
moving 4-16, 4-17
moving between sections 4-25
naming 4-12
placing in flowsheet 4-2
reinitializing 20-6, 26-3
renaming 4-12
requesting heating/cooling curves 10-43
resizing icons 4-18
rotating icons 4-18
sensitivity 20-3
transfer 24-2
user defined 17-10

BLOCK-VEC variable type 18-17, 18-27

Bookmarks
using 4-10

Bracketing 17-13
Browse buttons 1-12
Broyden method 17-14

C

Calculate sheet
using 19-7

Calculations
checking status 11-7
defining order 17-19
iterative 5-11
molar volume 5-15
molecular weight 5-11
Pressure Relief 33-29
prop-set 5-12
reinitializing 5-11
sheet 5-9
stopping 33-26

Calculator
blocks 19-1
execution time 19-9
Export Variables 19-10
loops 19-10
specifying execution 19-9
specifying tear variables 19-10
Write Variables 19-10

CAPE-OPEN
DAIS Trader (CORBA) 10-38
unit operation models 10-37

CCD
about 10-36

CFuge
about 10-35

Checking
fortran syntax 19-14

Chemicals template 2-19
CISOLID substream 18-14
ClChng

about 10-32
Client server

file management 15-12
Column profiles

accessing 18-17
COM

unit operation models 10-37
Commands

controlling simulations 11-3
Comments



Aspen Plus User Guide 3
Version 10.2

entering 1-22
Compattr-Vec and PSD-Vec variable types to access

18-17
complete dissociation reactions 27-7
Completeness

checking 4-11
checking flowsheet 4-11
entire flowsheet 2-7, 4-11
flowsheet 4-11
forms 2-7
messages 12-3, 12-4
status 2-7

Completion status 2-7
checking 12-2
displaying 1-11
forms 2-7

Complex method 17-17
COMPLEX method 22-11
Component attributes 6-21
Components

adding to list 6-14
attributes 6-21
Component Data tab 16-8
composition 6-21
concentrations 9-5
conventional 6-9, 6-22
databank 6-4
defining 6-9, 6-13, 6-24
defining groups 6-26
deleting 6-15
electrolyte 6-16
generating required 6-16
groups 6-26
Henry's 6-24
identifying as solids 6-20
IDs 6-15
list 6-14
nonconventional 6-23, 7-22
nondatabank 6-7
properties 7-22
renaming 6-14
search order 16-9
solid 6-13
specifying 6-4, 6-7
supercritical 6-24, 7-15, 8-3

Composition
streams 9-5

Connecting to the engine
automation 38-32

Connectivity
changing 4-11

incompleteness 4-11
Constraints

about 22-6
defining 22-6
specifying expression 22-8

Control Panel
about 11-2
messages 12-3
status messages 11-7
viewing 12-3

Control Panel messages 17-28
Controls

commands 11-3
Conventional components

assigning attributes 6-22
defining 6-9

Conventional solids
about 6-20

Convergence
defining blocks 17-10
defining order 17-19
diagnostics 17-28
methods 17-11, 17-13
numerical methods 17-5
obtaining final sequence 17-22
optimization 22-2
options 17-2
overriding defaults 22-2
problems 17-13, 17-35
results 12-5, 17-26
sheets 17-2
special options 17-23
specifying parameters 17-3
strategies 17-30

Convergence blocks
results 12-5

Convergence methods
DIRECT 17-13

Conversion formats 16-13
Copy with Format command 37-3
Copying

about 37-2
Copy with Format 37-3
data 37-2
plots 37-11

CORBA
use with CAPE-OPEN models 10-38

Crusher
about 10-34

Crystallizer
about 10-33



4 Aspen Plus User Guide
Version 10.2

Cursor
changes 4-2
shapes 4-2

Curves
additional reports for blends 32-10
gravity 32-5
molecular weight 32-6
petroleum property 32-7
viscosity 32-7

Customizing
toolbars 16-5

Cutting and pasting
from applications to Aspen Plus 37-7
into other applications 37-6
within Aspen Plus 37-4

Cyclone
about 10-34

D

DAIS Trader
use with CAPE-OPEN models 10-38

Data
adding curves to plots 13-16
copying 37-2
definition 8-2
deleting from plots 13-17
displaying for plots 13-2
global 14-6
lines 13-9
packages 34-1
pasting 37-4
points 13-17

Data Browser 1-8
finding blocks in flowsheet 4-9
opening 1-8
status indicators 1-11

Data Fit
troubleshooting 23-17

Data Fit regression
defining 23-8

Data Fit results 23-16
Data regression

about 31-1
accuracy of model parameters 31-15
deviations of measurement 31-10
phase equilibrium 31-5
problems 31-17
property methods 31-3
results 31-16, 31-17
setting up 31-2

Data Regression
run type description 2-5

Data values
obtaining 38-10

Databanks
about 6-2
components 6-4
molecular weight 5-11
search order 16-9
searching 16-10
viewing list 6-2

Defaults
calculation reinitializing 5-11
changing for plots 13-18
for diagnostic information 5-8
overriding simulation option 5-8
restoring on sheets 1-14
setting 16-5
stream class 4-25, 5-4
system options 5-15

Define sheet
using 18-4, 19-5, 20-3, 21-3, 22-4, 22-7, 23-3

Deleting
objects 34-7

Descriptions
viewing 2-29

Design rules
Pressure Relief 33-11

Design specifications
creating 21-3

Diagnostics
changing level for convergence 17-28
messages 5-8
sheet 5-8

Dialog boxes
automation 38-30

Direct method 17-13
dissociation reactions 27-7
Documents

Aspen Plus 15-2
Dot notation

using 38-9
DSTWU

about 10-15
DynamicInput form 33-21
DynamicResults form 33-30

E

Editor
specifying 15-13



Aspen Plus User Guide 5
Version 10.2

ELECNRTL property method 2-21
electrolyte chemistry 27-3

equilibrium constants 27-7
specifying 27-4

Electrolyte Wizard
about 6-16
generated electrolyte reactions 6-19

Electrolytes
generated reactions 6-19
rules for modeling 7-18
systems 6-16
template 2-20

Embedded objects are saved as part of a run 37-29
Embedding

objects 37-27, 37-29
Emergency events

describing 33-21
Energy balance equations 25-7
Energy balances

specifying 25-4
stream variables 25-5

Engine connection
automation 38-32

Equations of state
binary parameters 8-6
specifying extrapolation threshold 5-15

equilibrium ionic reactions 27-5
equilibrium reactions 27-20
Equilibrium reactors

restricting 10-29
Errors

automation 38-3
messages 12-3, 12-4

ESP
about 10-35

Estimation
binary parameters 30-16
comparing with experimental data 30-22
parameters 30-24
results 16-11, 30-23
temperature dependent properties 30-15
turning off 30-25

Estimation Compare form 30-22
Events

automation 38-29
Excel

copying data from 37-7
unit operation models 10-37
updating links 37-26

Excel Calculator
blocks 19-1, 19-5

creating blocks 19-5
Expert system

using 1-15
Export Variables

about 19-9
Exporting

files 15-9
Exporting files

automation 38-34
Extrapolation threshold

equations of state 5-15

F

FabFl
about 10-34

Files
active links 37-24
Aspen Plus 15-2
backup 15-3
descriptions 2-29
exporting 15-9
formats 15-2
generating 15-9
history 15-7
importing 15-9
managing 15-12
report 15-5
saving 15-8
summary 15-6
types 15-2
with active links 37-25
with embedded objects 37-29
with links 37-26

Fillage
specifying 33-10

Filter block
about 10-36

Finding
blocks 4-9

Flash Convergence sheet 5-14
Flash specifications

entering 24-6
Flash2

about 10-6
Flashes

specifying global options 5-14
Floating palettes

using 1-6
Flow basis

selecting 5-5



6 Aspen Plus User Guide
Version 10.2

Flowsheet connectivity
automation 38-25

Flowsheet tab 16-13
Flowsheet variables

accessing 18-2
determining between 18-7
identifying 19-5, 20-3, 23-3–23-4
identifying manipulated 21-5
types 18-3

Flowsheets
aligning objects 14-12
attaching objects 14-13
changing layout 4-15
completeness 4-11
connectivity 4-11, 38-25
convergence 17-30
defining 4-1
displaying global data 14-6
embedding objects 37-27
global data 14-6
graphics 14-3
large 4-8
optimization 17-18
printing 14-15
property methods 7-13
recycles 17-1
runs 2-6
saving views 4-10
scrollbars 4-9
sections 4-23, 4-24, 4-25, 4-26, 7-13, 9-20, 14-15
sequencing 17-21
Snap to Grid option 14-12
stream tables 14-2
unattaching objects 14-13
viewing 4-8, 4-9
working with large 14-16
zooming 4-8

Forms
definition 1-10
displaying 1-8, 1-10
for entering property parameters 8-10

Fortran
about 19-2
blocks 19-1, 19-3, 19-4
Calculator blocks 19-1
creating blocks 19-4
entering 19-7, 20-7, 21-6, 22-9
hints 19-14
interpreting 19-17
rules 19-14
statements 19-7, 20-7, 21-6, 22-10

syntax checking 19-14
unit operation models 10-37
user models 19-19
using 19-2
writing 19-2

Fortran sheet
using 20-7, 21-6, 22-9

Free water
calculations 5-6, 7-16
phase 7-16
property method 7-16

G

Gas Processing template 2-16
General method

using 30-7
General tab 16-8
General template 2-10
Global data

controling the display 16-13
customizing 16-12
flowsheets 14-6

Global information
about 5-1
entering 5-2
specifying for flash 5-14

Global property method 7-12
Global settings

changing 5-6, 5-12
GLOBAL stream class 4-25
Global units sets

specifying 5-4
Go Back button 1-12
Go Forward button 1-12
Graphics

adding to flowsheets 14-3
aligning in flowsheets 14-12

Gravity curves
entering 32-5

Grid options
changing 13-14
size 14-12

Grid size 14-12
Groups

method specific functional 30-10
permanent 14-11
specifying 6-25
UNIFAC 6-25

Guidelines
for choosing variables 18-7



Aspen Plus User Guide 7
Version 10.2

H

HAP_UNITCOL attribute 38-16
HappLS object 38-4
Heat exchanger design program interface

overview 39-1
Heat streams

defining 4-7
results 12-8

Heater model
about 10-8

Heating/cooling curves
requesting 10-43

Help
on parts of the screen 3-5

Henry's components
defining 6-24

Henry's Law
parameter requirements 7-15, 8-3

Hetran
about 10-13

Hiding
objects 34-7

History file
about 15-7
copying 15-12
messages 12-4
viewing 12-4

Host computer
changing 11-8
copying history file 15-12
specifying working directory 15-12

HTXINT
overview 39-1

HyCyc
about 10-35

Hydrometallurgy template 2-23

I

ID conflicts
resolving 34-2

Ideal property methods 7-2
IHapp object 38-4
Import Variables

about 19-9
Importing

files 15-9
Infinite dilution activity coefficient data

using 30-21
Information

file descriptions 2-29
Initial guesses

using 17-21
Input

dynamic 33-21
specifications 2-6

Input file
editing 11-11

Insert mode 1-7
Inserts

about 34-1
creating 34-2
electrolyte 34-6
importing 34-2
using library 34-6

Interactive runs 11-2
Interactively Load Results

changing 11-14
Interoperability

about 37-1
Interpreting

Fortran 19-17
Intervals

particle size distribution 9-23
ionic reactions 27-5
Ionic reactions

generating 6-16

K

kinetics
user defined subroutines 27-28

L

Langmuir-Hinshelwood-Hougen-Watson reactions
27-16

Layout
flowsheet 4-15

LHHW rate-controlled reactions 27-17
LHHW reactions 27-16
Libraries

application examples 2-28
automation 38-28
inserts 34-6
Model Library 1-6
stream 35-1

Link container
definition 37-24

Link source
definition 37-24
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visibility of applications 37-26
Linking

applications 37-16
Linking results 37-17
Links

saving files 37-24
updating in Excel 37-26

Live data links
about 37-2

LLE data
generating 31-9

Loops
converging 19-10

M

Mass balance only simulations
calculations 9-4
unit operation models 5-10

Mass balances
specifying 25-4
stream variables 25-5

Material balance equations 25-7
Material streams

specifying 9-2
Messages

control panel 17-28
diagnostic 5-8
progress 5-8
setting levels 5-8

Method specific functional groups 30-10
MIXED substream 18-12
Model library

automation 38-28
Model Library

about 1-6
undocking 1-6

Modes
PFD 14-7
Workbook 16-19

Molecular structure
defining 30-7, 30-10

Molecular weight 5-11
Molecular weight curves

entering 32-6
Mouse pointer

changes 4-2
shapes 4-2

Mult
about 10-32

N

Naming options
setting 16-13
specifying 4-12

NC substream 18-16
Newton method 17-16
Next button 1-12
Node attributes

about 38-11
Node objects

tree structure 38-7
Nodes

offspring 38-18
Non scalar data

accessing 38-17
Nonconventional components

attributes 6-23
physical properties 7-22
solids 6-21

Nondatabank components 6-7
Numerical methods

parameters 17-7
specifying 17-5

O

Object Browser 38-3
Object Manager 1-13
Objects

attaching to flowsheets 14-13
collection 38-8
embedding 37-27, 37-29
error handling 38-3
HappLS 38-4
hiding 34-7
IHapp 38-4
revealing 34-7
tree structure 38-7
unattaching 14-13
viewing properties 38-3

Offspring nodes
obtaining 38-18

OLE automation
about 37-1, 37-2

Online applications library 2-28
Optimization

about 22-1
algorithms 22-10
constraints 22-6
convergence 22-2



Aspen Plus User Guide 9
Version 10.2

creating 22-3
problems 17-17
recommendations 22-2
troubleshooting 22-12

Optimization problems 22-2
Options

setting default 16-5
specifying general 16-8

P

Paired scrolling 38-24
Parameter variables

about 18-8
Parameters

activity coefficient 8-7
automatic sequencing 17-6
binary 8-6
definition 8-2
equations of state 8-6
forms 8-10
Henry's Law requirements 8-3
mass and energy balance 8-3
numerical methods 17-7
requirements 8-2
tear stream selection 17-6
ternary 8-22

Parameters Electrolyte Ternary form 8-22
Particle size distribution

creating 9-23
specifying intervals 9-23

Pasting
about 37-2
Aspen Plus data into applications 37-6
data 37-4
from other applications 37-7
plots 37-12

Permanent groups
creating 14-11

PetroFrac
about 2-14, 10-22

Petroleum mixtures
defining 32-1

Petroleum properties
defining 32-19

Petroleum property curves
entering 32-7

Petroleum template 2-13
PFD mode

using 14-7
Pharmaceuticals template 2-23

phase qualifiers
specifying 28-4

Phases
specifying valid 5-6

Pipe model
diameters 33-19

Pipe Schedules tables 33-19
Pitzer

ternary parameters 8-22
Place

using 4-21
Plot Text Settings dialog box 13-8
Plot Wizard

using 13-2
Plots

adding text 13-8
annotating 13-7
attaching to blocks 37-12
attaching to flowsheets 37-12
attributes 13-9
axes 13-13
axis mapping 13-11
changing defaults 13-18
changing grid options 13-14
changing properties 13-9
changing text 13-12
comparing results 13-16
copying to other applications 37-11
curves 13-16, 13-17
deleting data 13-17
displaying data 13-2
experimental data 31-11
generating 13-2
legends 13-10
modifying text 13-8
pasting onto flowsheet 37-12
printing 13-18
range of data 13-17
regression results 31-18
scale options 13-13
selecting variables 13-6
titles 13-12
updating 13-15
zooming 13-17

Point Data data sets
creating 23-3

Polar nonelectrolyte systems (diagram) 7-12
Polynomials

adjusting for pressure 8-31
adjusting reference states 8-30

Ports
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changing 4-13
power law expressions 27-12, 27-22
power law reactions 27-9
precipitation reactions 27-6

for RadFrac 27-27
pressure qualifiers

specifying 28-4
Pressure Relief

about 33-1
calculations 33-29
creating block 33-2
devices 33-14
results 33-29
rules 33-11
scenarios 33-3, 33-5
specifying 33-25
stopping calculations 33-26
streams 33-6
venting systems 33-13

Printing
flowsheet sections 4-26, 14-15
flowsheets 14-15
large flowsheets 14-16
plots 13-18

Process flow diagrams
creating 14-9

Process Flowsheet window 1-4, 16-3
about 1-5

Process simulation
about 2-1

Profile Data data sets
creating 23-6

Profile variables
identifying 23-7

Progress
messages 5-8
viewing simulation 11-2

properties
searching for 28-3
user-defined 28-7

Properties Parameters Pure Components USRDEF-1
form 6-9

Properties PLUS
run type description 2-5

Property analysis
run type description 2-5
streams 9-10

Property Analysis
about 29-2

Property Estimation
run type description 2-5

Property methods
about 7-1
activity coefficient (diagram) 7-12
base 7-20
choosing 7-5
choosing (diagram) 7-10, 7-12
data regression 31-3
ELECNRTL 2-21
flowsheet sections 7-13
free water phase 7-16
global 7-12
ideal 7-2
lists of all 7-2
modifying 7-18, 7-19, 7-20
overriding global 7-14
pseudocomponent 2-13, 32-18
specifying for flowsheet section 7-13
specifying local 7-14

Property package
creating 34-5

Property parameters
forms 8-10
requirements 8-2

property sets
about 28-1
defining 28-2
phase qualifiers 28-4
pressure qualifiers 28-4
temperature qualifiers 28-4

Prop-set calculations
flash fails 5-12

Pseudocompoents
temperature dependent 32-16

Pseudocomponents
about 32-12
generating 32-13
naming options 32-14
property methods 2-13, 32-18
user defined 32-15

Pseudoproduct streams 4-7, 9-26
Pump model

about 10-30
Pure components

databanks search order 16-9
Pyrometallurgy template 2-25

R

rate-controlled reactions 27-22
RateFrac

about 10-25
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RBatch
about 10-29

Reaction stoichiometry 5-12
reactions

complete dissociation 27-7
electrolyte chemistry 27-3, 27-4
equilibrium 27-20
equilibrium constants 27-7
equilibrium ionic 27-5
equilibrium, for RCSTR only 27-10, 27-16
ionic 27-5
Langmuir-Hinshelwood-Hougen-Watson (LHHW)

27-16
non-electrolyte equilibrium 27-3
power law 27-9
power law expressions 27-12, 27-22
rate-based 27-3
rate-controlled 27-3, 27-12, 27-22
rate-controlled, for LHHW 27-17
reactive distillation 27-19
salt precipitation 27-6
salt precipitation, for RadFrac only 27-27
types 27-2

reactive distillation
specifying reactions 27-19

Reactive systems
specifying 33-25

Reactors
about 10-27

Read Variables
about 19-9

Recycles
about 17-1

Redrawing
flowsheet with Place and Unplace 4-21

Reference states
adjusting for tabular data 8-30
ionic species 8-5

Regression
formulating case 31-12
problems 31-17
results 16-11, 31-16
specifying parameters 31-13

Regression cases
defining 23-8

Reinitializing
about 11-5

Relief devices
specifying 33-14

Reorder Comps button 6-14
Reports

accounting 5-7
exporting 12-9
files 15-5
generating 8-6, 12-8, 12-9
saving 12-9
specifying options 5-20
stream 5-23
supplementary streams 5-25
viewing 12-10

Resolve ID Conflicts dialog box 34-2
Restoring

defaults on sheets 1-14
Results

Assay Data Analysis 32-20
batch stream 5-21, 5-24
comparing on a plot 13-16
completeness 12-3
copying regression and estimation 16-11
data fit 23-16
data regression 31-16
displaying 12-6
dynamic 33-30
estimation 16-11, 30-23
examining 33-29
formatting stream 12-7
heat and work streams 12-8
linking 37-17
Pressure Relief 33-29
regression 16-11
steady state 33-29
stream 12-6
Summary sheet 11-7
updating plots 13-15
viewing 12-2, 17-26, 33-30
viewing steady state 33-29

Results View tab 16-12
Revealing

objects 34-7
RGibbs

about 10-29
Root finder 5-15
Routes

sheet 7-20
RPlug

about 10-29
RStoic

about 10-27
Rules

Pressure Relief 33-11
Run accounting information 5-7
Run descriptions
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specifying 5-7
Run Settings dialog box 11-13
Run Type

changing 5-3
choosing 2-5

Runs
accounting information 5-7
batch 11-10
changing type 5-3
completeness 12-3, 12-4
completing input specifications 2-6
creating new 2-2, 2-3
descriptions 5-7
flowsheet 2-6
interactive 11-2, 12-8
naming 5-4
saving 15-8
specifying a run description 5-7
types 2-5, 11-2

S

salt precipitation reactions 27-6
for RadFrac 27-27

Saving
files 15-8
files with embedded objects 37-29
links 37-24
runs 15-8

Scenarios
dynamic 33-8, 33-12, 33-25
pressure relief 33-3
steady state 33-6

SCFrac
about 10-16

Scrolling
paired 38-24

Secant method 17-13
Sensitivity

blocks 20-3
Sep2

about 10-7
Separators

about 10-5
Sequence

calculation 17-19
Sequencing

problems 17-35
specifying parameters 17-6

Setup forms
accessing 5-2

Setup ReportOptions form 5-20
Setup Simulation Options form

about 5-8
Setup Specifications form

entering global information 5-2
Setup Units Set sheets 5-17
Sheets

definition 1-10
displaying 1-8, 1-10

Simuations
controlling from automation client 38-32

Simulation engine 15-12
running separately 11-11

Simulation engine connection
automation 38-32

Simulation Run toolbar 11-3
Simulation status

displaying 1-11
Simulations

commands 11-3
completeness 12-3, 12-4
deleting objects 1-14
overriding history messages 5-8
reinitializing 11-5
running interactively 11-2
running on host 11-8
selecting flow basis 5-5
types of run 11-2
viewing current 12-2
viewing history 12-4
viewing progress 11-2
viewing status 11-6, 11-7

Snap to Grid option 14-12
Solids

conventional 6-20
defining 6-13
identifying 6-20
nonconventional 6-21

Solids templates 2-26
Special data packages 34-1
Specialty Chemicals template 2-21
Specifications

creating 21-3
design 17-1
flash 24-6
thermodynamic condition 9-4

SQP convergence method 17-18
SQP method 22-11
Standalone

runs 11-11
Standard deviation
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definition 23-6, 23-8
Starting

new run 2-3
Startup tab 16-18
State variables

specifying 9-2
Status

indicators 1-11
messages 11-6, 11-7

SteadyStateResults form 33-29
Stoichiometry

mass balance checking 5-12
Stream libraries

about 35-1
creating 35-2
modifying 35-2

StreamClass form 9-21
Streams

accessing 18-12
analysis types 9-10
analyzing properties 9-11
changing ports 4-13
classes 4-25, 5-4, 9-17, 9-18, 9-19, 9-20, 9-21
composition 9-5
copying 24-3
displaying properties interactively 9-11
heat and work 4-7
IDs 4-21
including in report 5-23
moving 4-19
moving corners 4-20
moving segments 4-20
placing on flowsheet 4-4
property analysis 9-10
pseudoproduct 4-7, 9-26
reinitializing 20-6, 26-4
renaming 4-12
reports 5-23, 5-25
rerouting 4-21
results 12-6, 12-7, 12-8
specifying 9-2, 9-4, 9-21, 33-6
tables 14-2
thermodynamic conditions 9-4
types 1-7
work 9-25

STREAM-VEC 18-12
STRLIB

about 35-2
commands 35-3
running in batch mode 35-3
running interactively 35-2

Subsreams
copying 24-4

Substreams
accessing 18-12
creating 9-19, 9-21
defining 9-21
modifying 9-19

Summary files 15-6
Supercritical components

Henry's law 7-15, 8-3
parameter requirements 8-3

SUSTRM-VEC 18-12
SWash

about 10-36
Symbols

definition 1-11
explaning status 1-11

System options
overriding defaults 5-15

Systems sheet 5-15

T

Table Format Files
about 36-1
location 36-2
selecting 12-7

Tabular data
adjusting for pressure 8-31
adjusting reference states 8-30
entering 8-27

Tabulate sheet
using 20-5

Tear convergence
parameters 17-3
specifying parameters 17-3

Tear Convergence sheet 17-4
Tear Specifications sheet

about 17-8
Tear streams

convergence 17-8
initial estimates 17-9

Tearing
specifying parameters 17-6

Temperature
specifying limits for flash 5-14

temperature qualifiers
specifying 28-4

Templates
about 2-4
Air Separation 2-18
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Chemicals 2-19
choosing 2-4
creating your own 16-20
Electrolytes 2-20
Gas Processing 2-16
General 2-10
Hydrometallurgy 2-23
Petroleum 2-13
Pharmaceutical 2-23
Pyrometallurgy 2-25
Solids 2-26
Specialty Chemicals 2-21

Ternary parameters 8-22
Text

adding 13-8
adding to plots 13-7
changing 13-8
modifying 13-8

Text editor
specifying 15-13

TFF
about 36-1
choosing 12-7
location 36-2

Thermodynamic condition specifications 9-4
Toolbars

available 16-4
customizing 16-4
default 1-5
description 1-5
moving 16-5
Simulation Run 11-3

Tools Options Startup tab 16-18
Transfer blocks

creating 24-2
defining 24-2
specifying execution 24-5

Tree structure
about 38-5
automation interface 38-7
dot notation 38-9
Variable Explorer 38-5

Troubleshooting
convergence problems 17-35
Data Fit 23-17
ID conflicts 34-2
optimization 22-12
sequence problems 17-35

Types
of run 11-2
of stream analysis 9-10

U

UNIFAC groups
specifying 6-25

Unit operation blocks
specifying 10-41

Unit operation models
in mass balance only runs 5-10
placing in flowsheet 4-2
selecting 1-6, 1-7

Unit Sets form 5-16
Unit Table

about 38-15
units of measure

changing 38-16
Units of measure

about 5-16
user-defined 5-16
viewing 5-17

Units sets
defining your own 5-17–5-18
example of defining 5-18
viewing 5-17

UnitString property
using 38-15

Unplace
using 4-21

used-defined properties 28-7
User Defined Component Wizard

opening 6-8
User interface

automation 38-29, 38-31
User models

types 19-19
User Models

about 10-36
user-defined kinetics subroutines 27-28

V

Valid phases
changing 5-6

ValueForUnit property 38-15
ValueType property 38-10
Variable Definition dialog box 18-4, 19-5, 20-3, 21-3,

22-4, 22-7, 23-3
Variable Explorer

about 38-5
example of using 38-6
using 38-5, 38-6

Variables
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accessing 18-2
block 18-17, 18-27
choosing 18-7
defining 18-4, 19-5, 20-3, 21-3, 22-4, 22-7, 23-3
determining between 18-7
identifying 19-5, 20-3, 23-3–23-4
identifying manipulated 21-5
manipulated 20-4
parameter 18-8
profile 23-7
PSD-Vec 18-17
selecting for plots 13-6
specifying 18-4, 19-5, 20-3, 21-3, 22-4, 22-7, 23-3
tabulated 20-5
types 18-3
vector 18-11, 18-18

Vary sheet 21-5
using 20-4

Vectors
block 18-17
variable types 18-11

Venting systems
specifying 33-13

Venturi scrubbers
about 10-35

Vessel Neck
specifying 33-17

Viewing
flowsheets 4-8, 4-10
forms and sheets 1-8

Views
bookmarks 4-10

Viscosity curves
entering 32-7

Visual Basic
about 37-1

VLE data
generating 31-9

Vscrub
about 10-35

W

Warnings
requesting 5-13

Wegstein convergence method 17-11
What's This button 3-5
Work streams

defining 4-7
results 12-8
specifying 9-25

Workbook mode 16-19
Working directory

specifying 15-12
Workspace 1-4
Write Variables

about 19-9
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